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Cloud-based solution that standardizes, streamlines, and automates the contract lifecycle 
management process.
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CLM Release Notes
Discover what's new in the latest release of Conga Contract Lifecycle Management.

December21.08.24 Release Notes
December21.08.05 Release Notes
December21.07.22 Release Notes
December21.06.27 Release Notes
December21.06.17 Release Notes
December21.06.03 Release Notes
December21.05.20 Release Notes
December21.05.06 Release Notes
December21.04.22 Release Notes
December21.03.25 Release Notes
December21.03.11 Release Notes
December21.02.11 Release Notes
December21.01.28 Release Notes
December21.01.13 Release Notes
December21.12.17 Release Notes
December '21 Release Notes

December21.08.24 Release Notes
In these release notes, you can find packages, requirements, features, enhancements, fixed 
issues, and known issues for the CLM December21.08.24 release. For documentation 
updates, see What's New in CLM Documentation.

Packages
The following packages and dependencies are required to upgrade to this release and use 
its new features. These are the minimum required versions; later versions are also 
supported. Prerequisites for each feature can be found in its documentation. Packages 
marked (New) are new for this release.

This documentation may describe optional features for which you have not 
purchased a license; therefore your solution or implementation may differ from 
what is described here. Contact your Customer Success Manager (CSM) or Account 
Executive (AE) to discuss your specific features and licensing.



https://documentation.conga.com/clm/december-21/what-s-new-in-clm-documentation-165940547.html
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Package Latest Certified Version (Name | Number)

Conga Base Library  2.2.225.4 | 2.225.4

Conga Contract Lifecycle Management (New) 12.2.0654.24 | 12.654.24

Conga Content Integration  8.1.0020 | 8.20

Conga DocuSign API 

(Required if you are using DocuSign)

7.2.116 | 7.116

Conga CLM DocuSign Integration 

(Required if you are using DocuSign)

4.2.48.1 | 4.48.1

Adobe Sign 

(Required if you are using Adobe Sign)

23.14 | 23.14

Conga CLM Adobe Integration

(Required if you are using Adobe Sign)

9.2.69.1 | 9.69.1

Conga Sign Integration 

(Required if you are using Conga Sign)

1.2.6 | 1.6

You can register your org for the Conga Push Upgrade. Conga Push Upgrade is an 
automated tool that upgrades packages available in your Salesforce org 
(Production or Sandbox) to the latest versions. In addition, it also ensures all the 
Conga published managed packages are on the latest versions for your registered 
orgs. For more information, see Registering for Conga Push Upgrade.



For more information on installing CLM managed packages, see Installing Conga 
CLM. For more information on upgrading CLM managed packages, see Upgrading 
Conga CLM.
If you use CLM in Salesforce Lightning, you must enable the Enable Files Comply 
System Property.



https://documentation.conga.com/clm/latest/registering-for-conga-push-upgrade-165938326.html
https://documentation.conga.com/clm/december-21/installing-conga-clm-161155922.html
https://documentation.conga.com/clm/december-21/upgrading-conga-clm-152572123.html
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System Requirements and Supported Platforms 
For requirements and recommendations to consider before installing the Conga product 
suite, see System Requirements and Supported Platforms Matrix.

New Features
There are no new features in this release. Keep checking the Conga Documentation Portal 
for new updates.

Enhancements
There are no enhancements in this release.

Data Model Changes 
There are no data model changes in this release.

Fixed Issues 
The following table lists the issue fixed in this release. If any actions are required, they will 
be listed in this table.

Case 
Numb 
er

Conga 
Internal ID

Description

008069 
53

CLM-8138 When you add additional reviewers to the in-progress review cycle, you 
observe the following issues:

the newly added reviewers do not receive the review email 
notification
the review status of the reviewer stays in the "Not Started" status
the contract administrator cannot cancel or end the review 
request as the Cancel and End Review buttons are disabled

https://documentation.conga.com/technotes/system-requirements-and-supported-platforms-matrix


CLM

18 Copyright ©2022 Apttus Corporation. All rights reserved.
 

Known Issues 
The following table provides the cumulative list of known issues up to this release.

Conga 
Internal 
ID

Description

CLM-7792 You can view the Insert Read Only button in the X-Author Contracts Playbook 
(Clause library) during contract negotiation but you cannot click the button.

CLM-7710 You encounter an error when you click in the TO field while sending a document for 
review using the Safari browser.

Workaround: Use Chrome or Microsoft Edge to send documents for review.

CLM-7204 If a validation rule fails, the duplicate agreement is marked as transient.

CLM-6792 If you see the Import Large File button in the Additional Actions section of the action 
panel, you must not use it to import files. This option is disabled in Spring '21 release.

CLM-5367 In the Console tab, when you click Cancel, the tab does not close while sending for 
signatures and sending for review.

CLM-5359 When you choose any value instead of the first value in the wizard lookup field in 
Salesforce Classic, the value resets to the first value.

CLM-5988 When you use a checkbox object field in input rules condition, checked and unchecked 
options are not visible.

CLM-5917 If the Set This Control Value rule is set on an input field, you cannot modify the input 
in the wizard.

CLM-5976 When you open a wizard in the Classic mode with rules on a Lookup field, you 
encounter an error.

CLM-5367 The console app tab remains open on canceling sending for signatures and review.

CLM-5207 The console app displays the Generate button even after the user has generated the 
document.
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Conga 
Internal 
ID

Description

XA-2718 On Partner Community portals, when you try to upload an offline agreement or 
check in an existing template to agreements in FX2 format from X-Author Contracts, 
an error message is displayed for version-aware and non-version-aware file or 
attachment type document.

CLM-3212 The Work Order custom object is not enabled for a template object of the Pre FX2 
format.

CLM-3211 Agreement flow does not work for Communities in the Salesforce Lightning mode.

CLM-2730 In the Salesforce One app, when a user clicks the Agreement Actions from the Action 
panel once, the user stays on the same page. To go to the next page, the user must 
click twice. This is a Salesforce limitation for embedded Visualforce pages.

CLM-2690 In the Salesforce One app, clicking the lookup option does not open a new pop-up 
window.

December21.08.05 Release Notes
In these release notes, you can find packages, requirements, features, enhancements, fixed 
issues, and known issues for the CLM December21.08.05 release. For documentation 
updates, see What's New in CLM Documentation.

Packages
The following packages and dependencies are required to upgrade to this release and use 
its new features. These are the minimum required versions; later versions are also 
supported. Prerequisites for each feature can be found in its documentation. Packages 
marked (New) are new for this release.

This documentation may describe optional features for which you have not 
purchased a license; therefore your solution or implementation may differ from 
what is described here. Contact your Customer Success Manager (CSM) or Account 
Executive (AE) to discuss your specific features and licensing.



https://documentation.conga.com/clm/december-21/what-s-new-in-clm-documentation-165940547.html


CLM

20 Copyright ©2022 Apttus Corporation. All rights reserved.
 

Package Latest Certified Version (Name | Number)

Conga Base Library  2.2.225.4 | 2.225.4

Conga Contract Lifecycle Management (New) 12.2.0654.21 | 12.654.21

Conga Content Integration  8.1.0020 | 8.20

Conga DocuSign API 

(Required if you are using DocuSign)

7.2.116 | 7.116

Conga CLM DocuSign Integration 

(Required if you are using DocuSign)

4.2.48.1 | 4.48.1

Adobe Sign 

(Required if you are using Adobe Sign)

23.14 | 23.14

Conga CLM Adobe Integration

(Required if you are using Adobe Sign)

9.2.69.1 | 9.69.1

Conga Sign Integration 

(Required if you are using Conga Sign)

1.2.6 | 1.6

You can register your org for the Conga Push Upgrade. Conga Push Upgrade is an 
automated tool that upgrades packages available in your Salesforce org 
(Production or Sandbox) to the latest versions. In addition, it also ensures all the 
Conga published managed packages are on the latest versions for your registered 
orgs. For more information, see Registering for Conga Push Upgrade.



For more information on installing CLM managed packages, see Installing Conga 
CLM. For more information on upgrading CLM managed packages, see Upgrading 
Conga CLM.
If you use CLM in Salesforce Lightning, you must enable the Enable Files Comply 
System Property.



https://documentation.conga.com/clm/latest/registering-for-conga-push-upgrade-165938326.html
https://documentation.conga.com/clm/december-21/installing-conga-clm-161155922.html
https://documentation.conga.com/clm/december-21/upgrading-conga-clm-152572123.html
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System Requirements and Supported Platforms 
For requirements and recommendations to consider before installing the Conga product 
suite, see System Requirements and Supported Platforms Matrix.

New Features
There are no new features in this release. Keep checking the Conga Documentation Portal 
for new updates.

Enhancements
There are no enhancements in this release.

Data Model Changes 
There are no data model changes in this release.

Fixed Issues 
The following table lists the issues fixed in this release. If any actions are required, they will 
be listed in this table.

Case Number Conga Internal ID Description

00788484 CLM-7940 When you complete the send for signature 
flow in the Lightning Console app, the 
agreement's main tab and sub tabs close.

00803541 CLM-8100 When you send agreement documents for 
signature, the email template does not 
include related attachments from the custom 
email template record.

Known Issues 
The following table provides the cumulative list of known issues up to this release.

https://documentation.conga.com/technotes/system-requirements-and-supported-platforms-matrix
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Conga Internal ID Description

CLM-7792 You can view the Insert Read Only button in the X-Author 
Contracts Playbook (Clause library) during contract 
negotiation but you cannot click the button.

CLM-7710 You encounter an error when you click in the TO field while 
sending a document for review using the Safari browser.

Workaround: Use Chrome or Microsoft Edge to send documents 
for review.

CLM-7204 If a validation rule fails, the duplicate agreement is marked as 
transient.

CLM-6792 If you see the Import Large File button in the Additional Actions 
section of the action panel, you must not use it to import files. 
This option is disabled in Spring '21 release.

CLM-5367 In the Console tab, when you click Cancel, the tab does not 
close while sending for signatures and sending for review.

CLM-5359 When you choose any value instead of the first value in the 
wizard lookup field in Salesforce Classic, the value resets to the 
first value.

CLM-5988 When you use a checkbox object field in input rules condition, 
checked and unchecked options are not visible.

CLM-5917 If the Set This Control Value rule is set on an input field, you 
cannot modify the input in the wizard.

CLM-5976 When you open a wizard in the Classic mode with rules on a 
Lookup field, you encounter an error.

CLM-5367 The console app tab remains open on canceling sending for 
signatures and review.

CLM-5207 The console app displays the Generate button even after the 
user has generated the document.
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Conga Internal ID Description

XA-2718 On Partner Community portals, when you try to upload an 
offline agreement or check in an existing template to 
agreements in FX2 format from X-Author Contracts, an error 
message is displayed for version-aware and non-version-aware 
file or attachment type document.

CLM-3212 The Work Order custom object is not enabled for a template 
object of the Pre FX2 format.

CLM-3211 Agreement flow does not work for Communities in the 
Salesforce Lightning mode.

CLM-2730 In the Salesforce One app, when a user clicks the Agreement 
Actions from the Action panel once, the user stays on the same 
page. To go to the next page, the user must click twice. This is a 
Salesforce limitation for embedded Visualforce pages.

CLM-2690 In the Salesforce One app, clicking the lookup option does not 
open a new pop-up window.

December21.07.22 Release Notes
In these release notes, you can find packages, requirements, features, enhancements, fixed 
issues, and known issues for the CLM December21.07.22 release. For documentation 
updates, see What's New in CLM Documentation.

Packages
The following packages and dependencies are required to upgrade to this release and use 
its new features. These are the minimum required versions; later versions are also 
supported. Prerequisites for each feature can be found in its documentation. Packages 
marked (New) are new for this release.

This documentation may describe optional features for which you have not 
purchased a license; therefore your solution or implementation may differ from 
what is described here. Contact your Customer Success Manager (CSM) or Account 
Executive (AE) to discuss your specific features and licensing.



https://documentation.conga.com/clm/december-21/what-s-new-in-clm-documentation-165940547.html
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Package Latest Certified Version (Name | Number)

Conga Base Library  2.2.225.4 | 2.225.4

Conga Contract Lifecycle Management (New) 12.2.0654.20 | 12.654.20

Conga Content Integration  8.1.0020 | 8.20

Conga DocuSign API 

(Required if you are using DocuSign)

7.2.116 | 7.116

Conga CLM DocuSign Integration 

(Required if you are using DocuSign)

4.2.48.1 | 4.48.1

Adobe Sign 

(Required if you are using Adobe Sign)

23.14 | 23.14

Conga CLM Adobe Integration

(Required if you are using Adobe Sign)

9.2.69.1 | 9.69.1

Conga Sign Integration 

(Required if you are using Conga Sign)

1.2.6 | 1.6

You can register your org for the Conga Push Upgrade. Conga Push Upgrade is an 
automated tool that upgrades packages available in your Salesforce org 
(Production or Sandbox) to the latest versions. In addition, it also ensures all the 
Conga published managed packages are on the latest versions for your registered 
orgs. For more information, see Registering for Conga Push Upgrade.



For more information on installing CLM managed packages, see Installing Conga 
CLM. For more information on upgrading CLM managed packages, see Upgrading 
Conga CLM.
If you use CLM in Salesforce Lightning, you must enable the Enable Files Comply 
System Property.



https://documentation.conga.com/clm/latest/registering-for-conga-push-upgrade-165938326.html
https://documentation.conga.com/clm/december-21/installing-conga-clm-161155922.html
https://documentation.conga.com/clm/december-21/upgrading-conga-clm-152572123.html
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System Requirements and Supported Platforms 
For requirements and recommendations to consider before installing the Conga product 
suite, see System Requirements and Supported Platforms Matrix.

New Features
There are no new features in this release. Keep checking the Conga Documentation Portal 
for new updates.

Enhancements
There are no enhancements in this release.

Data Model Changes 
There are no data model changes in this release.

Fixed Issues 
The following table lists the issue fixed in this release. If any actions are required, they will 
be listed in this table.

Case Number Conga Internal ID Description

00796274 CLM-8088 While sending an agreement document for 
review, you cannot select an email address in 
To, Cc, and Bcc fields when you have a 
platform encryption policy on the contact's 
email field.

Known Issues 
The following table provides the cumulative list of known issues up to this release.

https://documentation.conga.com/technotes/system-requirements-and-supported-platforms-matrix
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Conga Internal ID Description

CLM-7792 You can view the Insert Read Only button in the X-Author 
Contracts Playbook (Clause library) during contract 
negotiation but you cannot click the button.

CLM-7710 You encounter an error when you click in the TO field while 
sending a document for review using the Safari browser.

Workaround: Use Chrome or Microsoft Edge to send documents 
for review.

CLM-7204 If a validation rule fails, the duplicate agreement is marked as 
transient.

CLM-6792 If you see the Import Large File button in the Additional Actions 
section of the action panel, you must not use it to import files. 
This option is disabled in Spring '21 release.

CLM-5367 In the Console tab, when you click Cancel, the tab does not 
close while sending for signatures and sending for review.

CLM-5359 When you choose any value instead of the first value in the 
wizard lookup field in Salesforce Classic, the value resets to the 
first value.

CLM-5988 When you use a checkbox object field in input rules condition, 
checked and unchecked options are not visible.

CLM-5917 If the Set This Control Value rule is set on an input field, you 
cannot modify the input in the wizard.

CLM-5976 When you open a wizard in the Classic mode with rules on a 
Lookup field, you encounter an error.

CLM-5367 The console app tab remains open on canceling sending for 
signatures and review.

CLM-5207 The console app displays the Generate button even after the 
user has generated the document.
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Conga Internal ID Description

XA-2718 On Partner Community portals, when you try to upload an 
offline agreement or check in an existing template to 
agreements in FX2 format from X-Author Contracts, an error 
message is displayed for version-aware and non-version-aware 
file or attachment type document.

CLM-3212 The Work Order custom object is not enabled for a template 
object of the Pre FX2 format.

CLM-3211 Agreement flow does not work for Communities in the 
Salesforce Lightning mode.

CLM-2730 In the Salesforce One app, when a user clicks the Agreement 
Actions from the Action panel once, the user stays on the same 
page. To go to the next page, the user must click twice. This is a 
Salesforce limitation for embedded Visualforce pages.

CLM-2690 In the Salesforce One app, clicking the lookup option does not 
open a new pop-up window.

December21.06.27 Release Notes
In these release notes, you can find packages, requirements, features, enhancements, fixed 
issues, and known issues for the CLM December21.06.27 release. For documentation 
updates, see What's New in CLM Documentation.

Packages
The following packages and dependencies are required to upgrade to this release and use 
its new features. These are the minimum required versions; later versions are also 
supported. Prerequisites for each feature can be found in its documentation. Packages 
marked (New) are new for this release.

This documentation may describe optional features for which you have not 
purchased a license; therefore your solution or implementation may differ from 
what is described here. Contact your Customer Success Manager (CSM) or Account 
Executive (AE) to discuss your specific features and licensing.



https://documentation.conga.com/clm/december-21/what-s-new-in-clm-documentation-165940547.html
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Package Latest Certified Version (Name | Number)

Conga Base Library  2.2.225.4 | 2.225.4

Conga Contract Lifecycle Management (New) 12.2.0654.19 | 12.654.19

Conga Content Integration  8.1.0020 | 8.20

Conga DocuSign API 

(Required if you are using DocuSign)

7.2.116 | 7.116

Conga CLM DocuSign Integration 

(Required if you are using DocuSign)

4.2.48.1 | 4.48.1

Adobe Sign 

(Required if you are using Adobe Sign)

23.14 | 23.14

Conga CLM Adobe Integration

(Required if you are using Adobe Sign)

9.2.69.1 | 9.69.1

Conga Sign Integration 

(Required if you are using Conga Sign)

1.2.6 | 1.6

You can register your org for the Conga Push Upgrade. Conga Push Upgrade is an 
automated tool that upgrades packages available in your Salesforce org 
(Production or Sandbox) to the latest versions. In addition, it also ensures all the 
Conga published managed packages are on the latest versions for your registered 
orgs. For more information, see Registering for Conga Push Upgrade.



For more information on installing CLM managed packages, see Installing Conga 
CLM. For more information on upgrading CLM managed packages, see Upgrading 
Conga CLM.
If you use CLM in Salesforce Lightning, you must enable the Enable Files Comply 
System Property.



https://documentation.conga.com/clm/latest/registering-for-conga-push-upgrade-165938326.html
https://documentation.conga.com/clm/december-21/installing-conga-clm-161155922.html
https://documentation.conga.com/clm/december-21/upgrading-conga-clm-152572123.html
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System Requirements and Supported Platforms 
For requirements and recommendations to consider before installing the Conga product 
suite, see System Requirements and Supported Platforms Matrix.

New Features
There are no new features in this release. Keep checking the Conga Documentation Portal 
for new updates.

Enhancements
There are no enhancements in this release.

Data Model Changes 
There are no data model changes in this release.

Fixed Issues 
The following table lists the issue fixed in this release. If any actions are required, they will 
be listed in this table.

Case Number Conga Internal ID Description

00792298 CLM-8074 When you send an agreement document for 
review, you cannot see the attachments from 
the email template under Activity History.

Known Issues 
The following table provides the cumulative list of known issues up to this release.

https://documentation.conga.com/technotes/system-requirements-and-supported-platforms-matrix
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Conga Internal ID Description

CLM-7792 You can view the Insert Read Only button in the X-Author 
Contracts Playbook (Clause library) during contract 
negotiation but you cannot click the button.

CLM-7710 You encounter an error when you click in the TO field while 
sending a document for review using the Safari browser.

Workaround: Use Chrome or Microsoft Edge to send documents 
for review.

CLM-7204 If a validation rule fails, the duplicate agreement is marked as 
transient.

CLM-6792 If you see the Import Large File button in the Additional Actions 
section of the action panel, you must not use it to import files. 
This option is disabled in Spring '21 release.

CLM-5367 In the Console tab, when you click Cancel, the tab does not 
close while sending for signatures and sending for review.

CLM-5359 When you choose any value instead of the first value in the 
wizard lookup field in Salesforce Classic, the value resets to the 
first value.

CLM-5988 When you use a checkbox object field in input rules condition, 
checked and unchecked options are not visible.

CLM-5917 If the Set This Control Value rule is set on an input field, you 
cannot modify the input in the wizard.

CLM-5976 When you open a wizard in the Classic mode with rules on a 
Lookup field, you encounter an error.

CLM-5367 The console app tab remains open on canceling sending for 
signatures and review.

CLM-5207 The console app displays the Generate button even after the 
user has generated the document.
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Conga Internal ID Description

XA-2718 On Partner Community portals, when you try to upload an 
offline agreement or check in an existing template to 
agreements in FX2 format from X-Author Contracts, an error 
message is displayed for version-aware and non-version-aware 
file or attachment type document.

CLM-3212 The Work Order custom object is not enabled for a template 
object of the Pre FX2 format.

CLM-3211 Agreement flow does not work for Communities in the 
Salesforce Lightning mode.

CLM-2730 In the Salesforce One app, when a user clicks the Agreement 
Actions from the Action panel once, the user stays on the same 
page. To go to the next page, the user must click twice. This is a 
Salesforce limitation for embedded Visualforce pages.

CLM-2690 In the Salesforce One app, clicking the lookup option does not 
open a new pop-up window.

December21.06.17 Release Notes
In these release notes, you can find packages, requirements, features, enhancements, fixed 
issues, and known issues for the CLM December21.06.17 release. For documentation updates, 
see What's New in CLM Documentation.

Packages
The following packages and dependencies are required to upgrade to this release and use 
its new features. These are the minimum required versions; later versions are also 
supported. Prerequisites for each feature can be found in its documentation. Packages 
marked (New) are new for this release.

This documentation may describe optional features for which you have not 
purchased a license; therefore your solution or implementation may differ from 
what is described here. Contact your Customer Success Manager (CSM) or Account 
Executive (AE) to discuss your specific features and licensing.



https://documentation.conga.com/clm/december-21/what-s-new-in-clm-documentation-165940547.html
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Package Latest Certified Version (Name | Number)

Conga Base Library  2.2.225.4 | 2.225.4

Conga Contract Lifecycle Management (New) 12.2.0654.17 | 12.654.17

Conga Content Integration  8.1.0020 | 8.20

Conga DocuSign API 

(Required if you are using DocuSign)

7.2.116 | 7.116

Conga CLM DocuSign Integration 

(Required if you are using DocuSign)

4.2.48.1 | 4.48.1

Adobe Sign 

(Required if you are using Adobe Sign)

23.14 | 23.14

Conga CLM Adobe Integration

(Required if you are using Adobe Sign)

9.2.69.1 | 9.69.1

Conga Sign Integration 

(Required if you are using Conga Sign)

1.2.6 | 1.6

You can register your org for the Conga Push Upgrade. Conga Push Upgrade is an 
automated tool that upgrades packages available in your Salesforce org 
(Production or Sandbox) to the latest versions. In addition, it also ensures all the 
Conga published managed packages are on the latest versions for your registered 
orgs. For more information, see Registering for Conga Push Upgrade.



For more information on installing CLM managed packages, see Installing Conga 
CLM. For more information on upgrading CLM managed packages, see Upgrading 
Conga CLM.
If you use CLM in Salesforce Lightning, you must enable the Enable Files Comply 
System Property.



https://documentation.conga.com/clm/latest/registering-for-conga-push-upgrade-165938326.html
https://documentation.conga.com/clm/winter-21/installing-conga-clm-161155922.html
https://documentation.conga.com/clm/winter-21/upgrading-conga-clm-152572123.html
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System Requirements and Supported Platforms 
For requirements and recommendations to consider before installing the Conga product 
suite, see System Requirements and Supported Platforms Matrix.

New Features
There are no new features in this release. Keep checking the Conga Documentation Portal 
for new updates.

Enhancements
There are no enhancements in this release.

Data Model Changes 
There are no data model changes in this release.

Fixed Issues 
The following table lists the issues fixed in this release. If any actions are required, they will 
be listed in this table.

Case Number Conga Internal ID Description

00793411 CLM-8050 You encounter an error when you try to send a 
parent agreement with several child 
agreements for review.

00793114 CLM-8047 An email is not sent to the admin after a Lite 
user exceeds 30 logins.

Resolution info: An email is sent to the admin 
after a Lite user exceeds 30 logins. 

https://documentation.conga.com/technotes/system-requirements-and-supported-platforms-matrix
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Case Number Conga Internal ID Description

00792479 CLM-8044 The Lite user login report shows an incorrect 
login count.

Resolution info: When the 
LiteUserReportScheduler job is running and at 
the same time a Lite user logs in, the total login 
count may get affected if the user is not 
processed by the LoginHistoryScheduler job.

Example: When the LoginHistoryScheduler job 
runs at 6:00 AM and the 
LiteUserReportScheduler job runs at 6:10 AM and 
a Lite user logs in between 6:00 - 6:10 AM then 
the login is not considered when calculating the 
total login count.

00795190 CLM-8043 When you click the BCC hyperlink while sending 
an agreement document for review, the BCC 
field is not auto-populated with the logged-in 
user email id.

Known Issues 
The following table provides the cumulative list of known issues up to this release.

Conga Internal ID Description

CLM-7792 You can view the Insert Read Only button in the X-Author 
Contracts Playbook (Clause library) during contract 
negotiation but you cannot click the button.

CLM-7710 You encounter an error when you click in the TO field while 
sending a document for review using the Safari browser.

Workaround: Use Chrome or Microsoft Edge to send documents 
for review.

CLM-7204 If a validation rule fails, the duplicate agreement is marked as 
transient.
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Conga Internal ID Description

CLM-6792 If you see the Import Large File button in the Additional Actions 
section of the action panel, you must not use it to import files. 
This option is disabled in Spring '21 release.

CLM-5367 In the Console tab, when you click Cancel, the tab does not 
close while sending for signatures and sending for review.

CLM-5359 When you choose any value instead of the first value in the 
wizard lookup field in Salesforce Classic, the value resets to the 
first value.

CLM-5988 When you use a checkbox object field in input rules condition, 
checked and unchecked options are not visible.

CLM-5917 If the Set This Control Value rule is set on an input field, you 
cannot modify the input in the wizard.

CLM-5976 When you open a wizard in the Classic mode with rules on a 
Lookup field, you encounter an error.

CLM-5367 The console app tab remains open on canceling sending for 
signatures and review.

CLM-5207 The console app displays the Generate button even after the 
user has generated the document.

XA-2718 On Partner Community portals, when you try to upload an 
offline agreement or check in an existing template to 
agreements in FX2 format from X-Author Contracts, an error 
message is displayed for version-aware and non-version-aware 
file or attachment type document.

CLM-3212 The Work Order custom object is not enabled for a template 
object of the Pre FX2 format.

CLM-3211 Agreement flow does not work for Communities in the 
Salesforce Lightning mode.
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Conga Internal ID Description

CLM-2730 In the Salesforce One app, when a user clicks the Agreement 
Actions from the Action panel once, the user stays on the same 
page. To go to the next page, the user must click twice. This is a 
Salesforce limitation for embedded Visualforce pages.

CLM-2690 In the Salesforce One app, clicking the lookup option does not 
open a new pop-up window.

December21.06.03 Release Notes
In these release notes, you can find packages, requirements, features, enhancements, fixed 
issues, and known issues for the CLM December21.06.03 release. For documentation 
updates, see What's New in CLM Documentation.

Packages
The following packages and dependencies are required to upgrade to this release and use 
its new features. These are the minimum required versions; later versions are also 
supported. Prerequisites for each feature can be found in its documentation. Packages 
marked (New) are new for this release.

This documentation may describe optional features for which you have not 
purchased a license; therefore your solution or implementation may differ from 
what is described here. Contact your Customer Success Manager (CSM) or Account 
Executive (AE) to discuss your specific features and licensing.



You can register your org for the Conga Push Upgrade. Conga Push Upgrade is an 
automated tool that upgrades packages available in your Salesforce org 
(Production or Sandbox) to the latest versions. In addition, it also ensures all the 
Conga published managed packages are on the latest versions for your registered 
orgs. For more information, see Registering for Conga Push Upgrade.



https://documentation.conga.com/clm/december-21/what-s-new-in-clm-documentation-165940547.html
https://documentation.conga.com/clm/latest/registering-for-conga-push-upgrade-165938326.html
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Package Latest Certified Version (Name | Number)

Conga Base Library  2.2.225.4 | 2.225.4

Conga Contract Lifecycle Management (New) 12.2.0654.14 | 12.654.14

Conga Content Integration  8.1.0020 | 8.20

Conga DocuSign API 

(Required if you are using DocuSign)

7.2.116 | 7.116

Conga CLM DocuSign Integration 

(Required if you are using DocuSign)

4.2.48.1 | 4.48.1

Adobe Sign 

(Required if you are using Adobe Sign)

23.14 | 23.14

Conga CLM Adobe Integration

(Required if you are using Adobe Sign)

9.2.69.1 | 9.69.1

Conga Sign Integration 

(Required if you are using Conga Sign)

1.2.6 | 1.6

System Requirements and Supported Platforms 
For requirements and recommendations to consider before installing the Conga product 
suite, see System Requirements and Supported Platforms Matrix.

For more information on installing CLM managed packages, see Installing Conga 
CLM. For more information on upgrading CLM managed packages, see Upgrading 
Conga CLM.
If you use CLM in Salesforce Lightning, you must enable the Enable Files Comply 
System Property.



https://documentation.conga.com/technotes/system-requirements-and-supported-platforms-matrix
https://documentation.conga.com/clm/winter-21/installing-conga-clm-161155922.html
https://documentation.conga.com/clm/winter-21/upgrading-conga-clm-152572123.html


CLM

38 Copyright ©2022 Apttus Corporation. All rights reserved.
 

New Features
There are no new features in this release. Keep checking the Documentation Portal for new 
updates.

Enhancements
There are no enhancements in this release.

Data Model Changes 
There are no data model changes in this release.

Fixed Issues 
The following table lists the issue fixed in this release. If any actions are required, they will 
be listed in this table.

Case Number Conga Internal ID Description

00794239 CLM-8025 When you send the agreement document for 
review using the new Salesforce Lightning UI, the 
Send for Review page becomes unresponsive and 
displays a timeout error after selecting the 
documents and clicking Next.

Known Issues 
The following table provides the cumulative list of known issues up to this release.

Conga Internal ID Description

CLM-7792 You can view the Insert Read Only button in the X-Author 
Contracts Playbook (Clause library) during contract 
negotiation but you cannot click the button.
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Conga Internal ID Description

CLM-7710 You encounter an error when you click in the TO field while 
sending a document for review using the Safari browser.

Workaround: Use Chrome or Microsoft Edge to send documents 
for review.

CLM-7204 If a validation rule fails, the duplicate agreement is marked as 
transient.

CLM-6792 If you see the Import Large File button in the Additional Actions 
section of the action panel, you must not use it to import files. 
This option is disabled in Spring '21 release.

CLM-5367 In the Console tab, when you click Cancel, the tab does not 
close while sending for signatures and sending for review.

CLM-5359 When you choose any value instead of the first value in the 
wizard lookup field in Salesforce Classic, the value resets to the 
first value.

CLM-5988 When you use a checkbox object field in input rules condition, 
checked and unchecked options are not visible.

CLM-5917 If the Set This Control Value rule is set on an input field, you 
cannot modify the input in the wizard.

CLM-5976 When you open a wizard in the Classic mode with rules on a 
Lookup field, you encounter an error.

CLM-5367 The console app tab remains open on canceling sending for 
signatures and review.

CLM-5207 The console app displays the Generate button even after the 
user has generated the document.

XA-2718 On Partner Community portals, when you try to upload an 
offline agreement or check in an existing template to 
agreements in FX2 format from X-Author Contracts, an error 
message is displayed for version-aware and non-version-aware 
file or attachment type document.
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Conga Internal ID Description

CLM-3212 The Work Order custom object is not enabled for a template 
object of the Pre FX2 format.

CLM-3211 Agreement flow does not work for Communities in the 
Salesforce Lightning mode.

CLM-2730 In the Salesforce One app, when a user clicks the Agreement 
Actions from the Action panel once, the user stays on the same 
page. To go to the next page, the user must click twice. This is a 
Salesforce limitation for embedded Visualforce pages.

CLM-2690 In the Salesforce One app, clicking the lookup option does not 
open a new pop-up window.

December21.05.20 Release Notes
In these release notes, you can find packages, requirements, features, enhancements, fixed 
issues, and known issues for the CLM December21.05.20 release. For documentation 
updates, see What's New in CLM Documentation.

Packages
The following packages and dependencies are required to upgrade to this release and use 
its new features. These are the minimum required versions; later versions are also 
supported. Prerequisites for each feature can be found in its documentation. Packages 
marked (New) are new for this release.

This documentation may describe optional features for which you have not 
purchased a license; therefore your solution or implementation may differ from 
what is described here. Contact your Customer Success Manager (CSM) or Account 
Executive (AE) to discuss your specific features and licensing.



https://documentation.conga.com/clm/december-21/what-s-new-in-clm-documentation-165940547.html
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Package Latest Certified Version (Name | Number)

Conga Base Library (New) 2.2.225.4 | 2.225.4

Conga Contract Lifecycle Management (New) 12.2.0654.13 | 12.654.13

Conga Content Integration  8.1.0020 | 8.20

Conga DocuSign API 

(Required if you are using DocuSign)

7.2.116 | 7.116

Conga CLM DocuSign Integration 

(Required if you are using DocuSign)

4.2.48.1 | 4.48.1

Adobe Sign 

(Required if you are using Adobe Sign)

23.14 | 23.14

Conga CLM Adobe Integration

(Required if you are using Adobe Sign)

9.2.69.1 | 9.69.1

Conga Sign Integration 

(Required if you are using Conga Sign)

1.2.6 | 1.6

You can register your org for the Conga Push Upgrade. Conga Push Upgrade is an 
automated tool that upgrades packages available in your Salesforce org 
(Production or Sandbox) to the latest versions. In addition, it also ensures all the 
Conga published managed packages are on the latest versions for your registered 
orgs. For more information, see Registering for Conga Push Upgrade.



For more information on installing CLM managed packages, see Installing Conga 
CLM. For more information on upgrading CLM managed packages, see Upgrading 
Conga CLM.
If you use CLM in Salesforce Lightning, you must enable the Enable Files Comply 
System Property.



https://documentation.conga.com/clm/latest/registering-for-conga-push-upgrade-165938326.html
https://documentation.conga.com/clm/winter-21/installing-conga-clm-161155922.html
https://documentation.conga.com/clm/winter-21/upgrading-conga-clm-152572123.html
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System Requirements and Supported Platforms 
For requirements and recommendations to consider before installing the Conga product 
suite, see System Requirements and Supported Platforms Matrix.

New Features
There are no new features in this release. Keep checking the Documentation Portal for new 
updates.

Enhancements
There are no enhancements in this release.

Data Model Changes 
There are no data model changes in this release.

Fixed Issues 
The following table lists the issue fixed in this release. If any actions are required, they will 
be listed in this table.

Case Number Conga Internal ID Description

00788938 CLM-7969  In a cloned document, the sorting order of 
agreement documents in the Documents tab 
is incorrect.

Known Issues 
The following table provides the cumulative list of known issues up to this release.

https://documentation.conga.com/technotes/system-requirements-and-supported-platforms-matrix
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Conga Internal ID Description

CLM-7792 You can view the Insert Read Only button in the X-Author 
Contracts Playbook (Clause library) during contract 
negotiation but you cannot click the button.

CLM-7710 You encounter an error when you click in the TO field while 
sending a document for review using the Safari browser.

Workaround: Use Chrome or Microsoft Edge to send documents 
for review.

CLM-7204 If a validation rule fails, the duplicate agreement is marked as 
transient.

CLM-6792 If you see the Import Large File button in the Additional Actions 
section of the action panel, you must not use it to import files. 
This option is disabled in Spring '21 release.

CLM-5367 In the Console tab, when you click Cancel, the tab does not 
close while sending for signatures and sending for review.

CLM-5359 When you choose any value instead of the first value in the 
wizard lookup field in Salesforce Classic, the value resets to the 
first value.

CLM-5988 When you use a checkbox object field in input rules condition, 
checked and unchecked options are not visible.

CLM-5917 If the Set This Control Value rule is set on an input field, you 
cannot modify the input in the wizard.

CLM-5976 When you open a wizard in the Classic mode with rules on a 
Lookup field, you encounter an error.

CLM-5367 The console app tab remains open on canceling sending for 
signatures and review.

CLM-5207 The console app displays the Generate button even after the 
user has generated the document.
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Conga Internal ID Description

XA-2718 On Partner Community portals, when you try to upload an 
offline agreement or check in an existing template to 
agreements in FX2 format from X-Author Contracts, an error 
message is displayed for version-aware and non-version-aware 
file or attachment type document.

CLM-3212 The Work Order custom object is not enabled for a template 
object of the Pre FX2 format.

CLM-3211 Agreement flow does not work for Communities in the 
Salesforce Lightning mode.

CLM-2730 In the Salesforce One app, when a user clicks the Agreement 
Actions from the Action panel once, the user stays on the same 
page. To go to the next page, the user must click twice. This is a 
Salesforce limitation for embedded Visualforce pages.

CLM-2690 In the Salesforce One app, clicking the lookup option does not 
open a new pop-up window.

December21.05.06 Release Notes
In these release notes, you can find packages, requirements, features, enhancements, fixed 
issues, and known issues for the CLM December21.05.06 release. For documentation 
updates, see What's New in CLM Documentation.

Packages
The following packages and dependencies are required to upgrade to this release and use 
its new features. These are the minimum required versions; later versions are also 

This documentation may describe optional features for which you have not 
purchased a license; therefore your solution or implementation may differ from 
what is described here. Contact your Customer Success Manager (CSM) or Account 
Executive (AE) to discuss your specific features and licensing.



https://documentation.conga.com/clm/december-21/what-s-new-in-clm-documentation-165940547.html
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supported. Prerequisites for each feature can be found in its documentation. Packages 
marked (New) are new for this release.

Package Latest Certified Version (Name | Number)

Conga Base Library  2.2.225.3 | 2.225.3

Conga Contract Lifecycle Management (New) 12.2.0654.12 | 12.654.12

Conga Content Integration  8.1.0020 | 8.20

Conga DocuSign API 

(Required if you are using DocuSign)

7.2.116 | 7.116

Conga CLM DocuSign Integration 

(Required if you are using DocuSign)

4.2.48.1 | 4.48.1

Adobe Sign 

(Required if you are using Adobe Sign)

23.14 | 23.14

Conga CLM Adobe Integration

(Required if you are using Adobe Sign)

9.2.69.1 | 9.69.1

Conga Sign Integration 

(Required if you are using Conga Sign)

1.2.6 | 1.6

You can register your org for the Conga Push Upgrade. Conga Push Upgrade is an 
automated tool that upgrades packages available in your Salesforce org 
(Production or Sandbox) to the latest versions. In addition, it also ensures all the 
Conga published managed packages are on the latest versions for your registered 
orgs. For more information, see Registering for Conga Push Upgrade.



For more information on installing CLM managed packages, see Installing Conga 
CLM. For more information on upgrading CLM managed packages, see Upgrading 
Conga CLM.
If you use CLM in Salesforce Lightning, you must enable the Enable Files Comply 
System Property.



https://documentation.conga.com/clm/latest/registering-for-conga-push-upgrade-165938326.html
https://documentation.conga.com/clm/winter-21/installing-conga-clm-161155922.html
https://documentation.conga.com/clm/winter-21/upgrading-conga-clm-152572123.html
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System Requirements and Supported Platforms 
For requirements and recommendations to consider before installing the Conga product 
suite, see System Requirements and Supported Platforms Matrix.

New Features
There are no new features in this release. Keep checking the Documentation Portal for new 
updates.

Enhancements
The following enhancement is new in this release.

Set Default Header and Footer Options
You can use the APTS_DefaultHeaderFooterOptionForMerge admin entry to select the 
Retain Header and Footer or Custom Header and Footer checkbox by default on the Merge 
Documents page. For more information, see Merging Documents in Lightning.

Data Model Changes 
There are no data model changes in this release.

Fixed Issues 
The following table lists the issues fixed in this release. If any actions are required, they will 
be listed in this table.

https://documentation.conga.com/technotes/system-requirements-and-supported-platforms-matrix
https://documentation.conga.com/clm/december-21/merging-documents-in-lightning-179208998.html
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Case Number Conga Internal ID Description

NA CLM-8003 The Edit Amended page width was not 
consistent with the New or Edit Agreement 
page.

Resolution: The Edit Amended page width is 
consistent with the New or Edit Agreement 
page.

00792644 CLM-7994 You cannot configure or reorder the 
columns on the Agreement Document tab.

Known Issues 
The following table provides the cumulative list of known issues up to this release.

Conga Internal ID Description

CLM-7792 You can view the Insert Read Only button in the X-Author 
Contracts Playbook (Clause library) during contract 
negotiation but you cannot click the button.

CLM-7710 You encounter an error when you click in the TO field while 
sending a document for review using the Safari browser.

Workaround: Use Chrome or Microsoft Edge to send documents 
for review.

CLM-7204 If a validation rule fails, the duplicate agreement is marked as 
transient.

CLM-6792 If you see the Import Large File button in the Additional Actions 
section of the action panel, you must not use it to import files. 
This option is disabled in Spring '21 release.

CLM-5367 In the Console tab, when you click Cancel, the tab does not 
close while sending for signatures and sending for review.

CLM-5359 When you choose any value instead of the first value in the 
wizard lookup field in Salesforce Classic, the value resets to the 
first value.
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Conga Internal ID Description

CLM-5988 When you use a checkbox object field in input rules condition, 
checked and unchecked options are not visible.

CLM-5917 If the Set This Control Value rule is set on an input field, you 
cannot modify the input in the wizard.

CLM-5976 When you open a wizard in the Classic mode with rules on a 
Lookup field, you encounter an error.

CLM-5367 The console app tab remains open on canceling sending for 
signatures and review.

CLM-5207 The console app displays the Generate button even after the 
user has generated the document.

XA-2718 On Partner Community portals, when you try to upload an 
offline agreement or check in an existing template to 
agreements in FX2 format from X-Author Contracts, an error 
message is displayed for version-aware and non-version-aware 
file or attachment type document.

CLM-3212 The Work Order custom object is not enabled for a template 
object of the Pre FX2 format.

CLM-3211 Agreement flow does not work for Communities in the 
Salesforce Lightning mode.

CLM-2730 In the Salesforce One app, when a user clicks the Agreement 
Actions from the Action panel once, the user stays on the same 
page. To go to the next page, the user must click twice. This is a 
Salesforce limitation for embedded Visualforce pages.

CLM-2690 In the Salesforce One app, clicking the lookup option does not 
open a new pop-up window.
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December21.04.22 Release Notes
In these release notes, you can find packages, requirements, features, enhancements, fixed 
issues, and known issues for the CLM December21.04.22 release. For documentation 
updates, see What's New in CLM Documentation.

Packages
The following packages and dependencies are required to upgrade to this release and use 
its new features. These are the minimum required versions; later versions are also 
supported. Prerequisites for each feature can be found in its documentation. Packages 
marked (New) are new for this release.

Package Latest Certified Version (Name | Number)

Conga Base Library (New) 2.2.225.3 | 2.225.3

Conga Contract Lifecycle Management (New) 12.2.0654.11 | 12.654.11

Conga Content Integration  8.1.0020 | 8.20

Conga DocuSign API 

(Required if you are using DocuSign)

7.2.116 | 7.116

Conga CLM DocuSign Integration (New)

(Required if you are using DocuSign)

4.2.48.1 | 4.48.1

This documentation may describe optional features for which you have not 
purchased a license; therefore your solution or implementation may differ from 
what is described here. Contact your Customer Success Manager (CSM) or Account 
Executive (AE) to discuss your specific features and licensing.



You can register your org for the Conga Push Upgrade. Conga Push Upgrade is an 
automated tool that upgrades packages available in your Salesforce org 
(Production or Sandbox) to the latest versions. In addition, it also ensures all the 
Conga published managed packages are on the latest versions for your registered 
orgs. For more information, see Registering for Conga Push Upgrade.



https://documentation.conga.com/clm/december-21/what-s-new-in-clm-documentation-165940547.html
https://documentation.conga.com/clm/latest/registering-for-conga-push-upgrade-165938326.html
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Package Latest Certified Version (Name | Number)

Adobe Sign 

(Required if you are using Adobe Sign)

23.14 | 23.14

Conga CLM Adobe Integration

(Required if you are using Adobe Sign)

9.2.69.1 | 9.69.1

Conga Sign Integration 

(Required if you are using Conga Sign)

1.2.6 | 1.6

System Requirements and Supported Platforms 
For requirements and recommendations to consider before installing the Conga product 
suite, see System Requirements and Supported Platforms Matrix.

New Features
There are no new features in this release. Keep checking the Documentation Portal for new 
updates.

Enhancements
There are no enhancements in this release.

Data Model Changes 
There are no data model changes in this release.

For more information on installing CLM managed packages, see Installing Conga 
CLM. For more information on upgrading CLM managed packages, see Upgrading 
Conga CLM.
If you use CLM in Salesforce Lightning, you must enable the Enable Files Comply 
System Property.



https://documentation.conga.com/technotes/system-requirements-and-supported-platforms-matrix
https://documentation.conga.com/clm/winter-21/installing-conga-clm-161155922.html
https://documentation.conga.com/clm/winter-21/upgrading-conga-clm-152572123.html


CLM

51
 

Copyright ©2022 Apttus Corporation. All rights reserved.
 

Fixed Issues 
The following table lists the issue fixed in this release. If any actions are required, they will 
be listed in this table.

Case Number Conga Internal ID Description

00788369 CLM-7959 When you send a document for review using the 
new UI for parallel review, the email subject 
gets overwritten by the default email subject 
provided in the Salesforce Classic email 
template.

Known Issues 
The following table provides the cumulative list of known issues up to this release.

Conga Internal ID Description

CLM-7792 You can view the Insert Read Only button in the X-Author 
Contracts Playbook (Clause library) during contract 
negotiation but you cannot click the button.

CLM-7710 You encounter an error when you click in the TO field while 
sending a document for review using the Safari browser.

Workaround: Use Chrome or Microsoft Edge to send documents 
for review.

CLM-7204 If a validation rule fails, the duplicate agreement is marked as 
transient.

CLM-6792 If you see the Import Large File button in the Additional Actions 
section of the action panel, you must not use it to import files. 
This option is disabled in Spring '21 release.

CLM-5367 In the Console tab, when you click Cancel, the tab does not 
close while sending for signatures and sending for review.
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Conga Internal ID Description

CLM-5359 When you choose any value instead of the first value in the 
wizard lookup field in Salesforce Classic, the value resets to the 
first value.

CLM-5988 When you use a checkbox object field in input rules condition, 
checked and unchecked options are not visible.

CLM-5917 If the Set This Control Value rule is set on an input field, you 
cannot modify the input in the wizard.

CLM-5976 When you open a wizard in the Classic mode with rules on a 
Lookup field, you encounter an error.

CLM-5367 The console app tab remains open on canceling sending for 
signatures and review.

CLM-5207 The console app displays the Generate button even after the 
user has generated the document.

XA-2718 On Partner Community portals, when you try to upload an 
offline agreement or check in an existing template to 
agreements in FX2 format from X-Author Contracts, an error 
message is displayed for version-aware and non-version-aware 
file or attachment type document.

CLM-3212 The Work Order custom object is not enabled for a template 
object of the Pre FX2 format.

CLM-3211 Agreement flow does not work for Communities in the 
Salesforce Lightning mode.

CLM-2730 In the Salesforce One app, when a user clicks the Agreement 
Actions from the Action panel once, the user stays on the same 
page. To go to the next page, the user must click twice. This is a 
Salesforce limitation for embedded Visualforce pages.

CLM-2690 In the Salesforce One app, clicking the lookup option does not 
open a new pop-up window.
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December21.03.25 Release Notes
In these release notes, you can find packages, requirements, features, enhancements, fixed 
issues, and known issues for the CLM December21.03.25 release. For documentation 
updates, see What's New in CLM Documentation.

Packages
The following packages and dependencies are required to upgrade to this release and use 
its new features. These are the minimum required versions; later versions are also 
supported. Prerequisites for each feature can be found in its documentation. Packages 
marked (New) are new for this release.

Package Latest Certified Version (Name | Number)

Conga Base Library  2.2.224 | 2.224

Conga Contract Lifecycle Management (New) 12.2.0654.9 | 12.654.9

Conga Content Integration  8.1.0020 | 8.20

Conga DocuSign API 

(Required if you are using DocuSign)

7.2.116 | 7.116

Conga CLM DocuSign Integration 

(Required if you are using DocuSign)

4.2.48 | 4.48

This documentation may describe optional features for which you have not 
purchased a license; therefore your solution or implementation may differ from 
what is described here. Contact your Customer Success Manager (CSM) or Account 
Executive (AE) to discuss your specific features and licensing.



You can register your org for the Conga Push Upgrade. Conga Push Upgrade is an 
automated tool that upgrades packages available in your Salesforce org 
(Production or Sandbox) to the latest versions. In addition, it also ensures all the 
Conga published managed packages are on the latest versions for your registered 
orgs. For more information, see Registering for Conga Push Upgrade.



https://documentation.conga.com/clm/december-21/what-s-new-in-clm-documentation-165940547.html
https://documentation.conga.com/clm/latest/registering-for-conga-push-upgrade-165938326.html
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Package Latest Certified Version (Name | Number)

Adobe Sign 

(Required if you are using Adobe Sign)

23.14 | 23.14

Conga CLM Adobe Integration

(Required if you are using Adobe Sign)

9.2.69.1 | 9.69.1

Conga Sign Integration 

(Required if you are using Conga Sign)

1.2.6 | 1.6

System Requirements and Supported Platforms 
For requirements and recommendations to consider before installing the Conga product 
suite, see System Requirements and Supported Platforms Matrix.

New Features
There are no new features in this release. Keep checking the Documentation Portal for new 
updates.

Enhancements
The following enhancement is new to Conga CLM in this release.

For more information on installing CLM managed packages, see Installing Conga 
CLM. For more information on upgrading CLM managed packages, see Upgrading 
Conga CLM.
If you use CLM in Salesforce Lightning, you must enable the Enable Files Comply 
System Property.



https://documentation.conga.com/technotes/system-requirements-and-supported-platforms-matrix
https://documentation.conga.com/clm/winter-21/installing-conga-clm-161155922.html
https://documentation.conga.com/clm/winter-21/upgrading-conga-clm-152572123.html
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Retain Existing Header and Footer or Add Custom 
Header and Footer in the Merged Document
When you merge documents, you can select Retain Header and Footer to retain the header 
footer of the original document in the merged documents. You can select Custom Header 
and Footer to see Header and Footer fields and add custom header and footer. For more 
information, see Merging Documents in Lightning. 

Data Model Changes 
There are no data model changes in this release.

Fixed Issues 
There are no issues fixed in this release. 

Known Issues 
The following table provides the cumulative list of known issues up to this release.

Conga Internal ID Description

CLM-7792 You can view the Insert Read Only button in the X-Author 
Contracts Playbook (Clause library) during contract 
negotiation but you cannot click the button.

CLM-7710 You encounter an error when you click in the TO field while 
sending a document for review using the Safari browser.

Workaround: Use Chrome or Microsoft Edge to send documents 
for review.

CLM-7204 If a validation rule fails, the duplicate agreement is marked as 
transient.

CLM-6792 If you see the Import Large File button in the Additional Actions 
section of the action panel, you must not use it to import files. 
This option is disabled in Spring '21 release.

https://documentation.conga.com/clm/december-21/merging-documents-in-lightning-179208998.html
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Conga Internal ID Description

CLM-5367 In the Console tab, when you click Cancel, the tab does not 
close while sending for signatures and sending for review.

CLM-5359 When you choose any value instead of the first value in the 
wizard lookup field in Salesforce Classic, the value resets to the 
first value.

CLM-5988 When you use a checkbox object field in input rules condition, 
checked and unchecked options are not visible.

CLM-5917 If the Set This Control Value rule is set on an input field, you 
cannot modify the input in the wizard.

CLM-5976 When you open a wizard in the Classic mode with rules on a 
Lookup field, you encounter an error.

CLM-5367 The console app tab remains open on canceling sending for 
signatures and review.

CLM-5207 The console app displays the Generate button even after the 
user has generated the document.

XA-2718 On Partner Community portals, when you try to upload an 
offline agreement or check in an existing template to 
agreements in FX2 format from X-Author Contracts, an error 
message is displayed for version-aware and non-version-aware 
file or attachment type document.

CLM-3212 The Work Order custom object is not enabled for a template 
object of the Pre FX2 format.

CLM-3211 Agreement flow does not work for Communities in the 
Salesforce Lightning mode.

CLM-2730 In the Salesforce One app, when a user clicks the Agreement 
Actions from the Action panel once, the user stays on the same 
page. To go to the next page, the user must click twice. This is a 
Salesforce limitation for embedded Visualforce pages.
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Conga Internal ID Description

CLM-2690 In the Salesforce One app, clicking the lookup option does not 
open a new pop-up window.

December21.03.11 Release Notes
In these release notes, you can find packages, requirements, features, enhancements, fixed 
issues, and known issues for the CLM December21.03.11 release. For documentation updates, 
see What's New in CLM Documentation.

Packages
The following packages and dependencies are required to upgrade to this release and use 
its new features. These are the minimum required versions; later versions are also 
supported. Prerequisites for each feature can be found in its documentation. Packages 
marked (New) are new for this release.

Package Latest Certified Version (Name | Number)

Conga Base Library  2.2.224 | 2.224

Conga Contract Lifecycle Management (New) 12.2.0654.8 | 12.654.8

Conga Content Integration  8.1.0020 | 8.20

This documentation may describe optional features for which you have not 
purchased a license; therefore your solution or implementation may differ from 
what is described here. Contact your Customer Success Manager (CSM) or Account 
Executive (AE) to discuss your specific features and licensing.



You can register your org for the Conga Push Upgrade. Conga Push Upgrade is an 
automated tool that upgrades packages available in your Salesforce org 
(Production or Sandbox) to the latest versions. In addition, it also ensures all the 
Conga published managed packages are on the latest versions for your registered 
orgs. For more information, see Registering for Conga Push Upgrade.



https://documentation.conga.com/clm/december-21/what-s-new-in-clm-documentation-165940547.html
https://documentation.conga.com/clm/latest/registering-for-conga-push-upgrade-165938326.html
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Package Latest Certified Version (Name | Number)

Conga DocuSign API 

(Required if you are using DocuSign)

7.2.116 | 7.116

Conga CLM DocuSign Integration 

(Required if you are using DocuSign)

4.2.48 | 4.48

Adobe Sign 

(Required if you are using Adobe Sign)

23.14 | 23.14

Conga CLM Adobe Integration

(Required if you are using Adobe Sign)

9.2.69.1 | 9.69.1

Conga Sign Integration 

(Required if you are using Conga Sign)

1.2.6 | 1.6

System Requirements and Supported Platforms 
For requirements and recommendations to consider before installing the Conga product 
suite, see System Requirements and Supported Platforms Matrix.

New Features
There are no new features in this release. Keep checking the Documentation Portal for new 
updates.

For more information on installing CLM managed packages, see Installing Conga 
CLM. For more information on upgrading CLM managed packages, see Upgrading 
Conga CLM.
If you use CLM in Salesforce Lightning, you must enable the Enable Files Comply 
System Property.



https://documentation.conga.com/technotes/system-requirements-and-supported-platforms-matrix
https://documentation.conga.com/clm/winter-21/installing-conga-clm-161155922.html
https://documentation.conga.com/clm/winter-21/upgrading-conga-clm-152572123.html
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Enhancements
There are no enhancements in this release.

Data Model Changes 
There are no data model changes in this release.

Fixed Issues 
The following table lists the issue fixed in this release. If any actions are required, they will 
be listed in this table.

Case Number Conga Internal ID Description

00780414 CLM-7851 The document tab does not load for non- 
English users.

Known Issues 
The following table provides the cumulative list of known issues up to this release.

Conga Internal ID Description

CLM-7792 You can view the Insert Read Only button in the X-Author 
Contracts Playbook (Clause library) during contract 
negotiation but you cannot click the button.

CLM-7710 You encounter an error when you click in the TO field while 
sending a document for review using the Safari browser.

Workaround: Use Chrome or Microsoft Edge to send documents 
for review.

CLM-7204 If a validation rule fails, the duplicate agreement is marked as 
transient.
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Conga Internal ID Description

CLM-6792 If you see the Import Large File button in the Additional Actions 
section of the action panel, you must not use it to import files. 
This option is disabled in Spring '21 release.

CLM-5367 In the Console tab, when you click Cancel, the tab does not 
close while sending for signatures and sending for review.

CLM-5359 When you choose any value instead of the first value in the 
wizard lookup field in Salesforce Classic, the value resets to the 
first value.

CLM-5988 When you use a checkbox object field in input rules condition, 
checked and unchecked options are not visible.

CLM-5917 If the Set This Control Value rule is set on an input field, you 
cannot modify the input in the wizard.

CLM-5976 When you open a wizard in the Classic mode with rules on a 
Lookup field, you encounter an error.

CLM-5367 The console app tab remains open on canceling sending for 
signatures and review.

CLM-5207 The console app displays the Generate button even after the 
user has generated the document.

XA-2718 On Partner Community portals, when you try to upload an 
offline agreement or check in an existing template to 
agreements in FX2 format from X-Author Contracts, an error 
message is displayed for version-aware and non-version-aware 
file or attachment type document.

CLM-3212 The Work Order custom object is not enabled for a template 
object of the Pre FX2 format.

CLM-3211 Agreement flow does not work for Communities in the 
Salesforce Lightning mode.
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Conga Internal ID Description

CLM-2730 In the Salesforce One app, when a user clicks the Agreement 
Actions from the Action panel once, the user stays on the same 
page. To go to the next page, the user must click twice. This is a 
Salesforce limitation for embedded Visualforce pages.

CLM-2690 In the Salesforce One app, clicking the lookup option does not 
open a new pop-up window.

December21.02.11 Release Notes
In these release notes, you can find packages, requirements, features, enhancements, fixed 
issues, and known issues for the CLM December21.02.11 release. For documentation updates, 
see What's New in CLM Documentation.

Packages
The following packages and dependencies are required to upgrade to this release and use 
its new features. These are the minimum required versions; later versions are also 
supported. Prerequisites for each feature can be found in its documentation. Packages 
marked (New) are new for this release.

Package Latest Certified Version (Name | Number)

Conga Base Library  2.2.224 | 2.224

This documentation may describe optional features for which you have not 
purchased a license; therefore your solution or implementation may differ from 
what is described here. Contact your Customer Success Manager (CSM) or Account 
Executive (AE) to discuss your specific features and licensing.



You can register your org for the Conga Push Upgrade. Conga Push Upgrade is an 
automated tool that upgrades packages available in your Salesforce org 
(Production or Sandbox) to the latest versions. In addition, it also ensures all the 
Conga published managed packages are on the latest versions for your registered 
orgs. For more information, see Registering for Conga Push Upgrade.



https://documentation.conga.com/clm/december-21/what-s-new-in-clm-documentation-165940547.html
https://documentation.conga.com/clm/latest/registering-for-conga-push-upgrade-165938326.html
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Package Latest Certified Version (Name | Number)

Conga Contract Lifecycle Management (New) 12.2.0654.6 | 12.654.6

Conga Content Integration  8.1.0020 | 8.20

Conga DocuSign API 

(Required if you are using DocuSign)

7.2.116 | 7.116

Conga CLM DocuSign Integration 

(Required if you are using DocuSign)

4.2.48 | 4.48

Adobe Sign 

(Required if you are using Adobe Sign)

23.14 | 23.14

Conga CLM Adobe Integration (New)

(Required if you are using Adobe Sign)

9.2.69.1 | 9.69.1

Conga Sign Integration 

(Required if you are using Conga Sign)

1.2.6 | 1.6

System Requirements and Supported Platforms 
For requirements and recommendations to consider before installing the Conga product 
suite, see System Requirements and Supported Platforms Matrix.

New Features
There are no new features in this release. Keep checking the Documentation Portal for new 
updates.

For more information on installing CLM managed packages, see Installing Conga 
CLM. For more information on upgrading CLM managed packages, see Upgrading 
Conga CLM.
If you use CLM in Salesforce Lightning, you must enable the Enable Files Comply 
System Property.



https://documentation.conga.com/technotes/system-requirements-and-supported-platforms-matrix
https://documentation.conga.com/clm/winter-21/installing-conga-clm-161155922.html
https://documentation.conga.com/clm/winter-21/upgrading-conga-clm-152572123.html
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Enhancements
There are no enhancements in this release.

Data Model Changes 
There are no data model changes in this release.

Fixed Issues 
The following table lists the issues fixed in this release. If any actions are required, they will 
be listed in this table.

Case Number Conga Internal ID Description

00785193 CLM-7871 When you cancel a review for a reviewer 
during the parallel review, the review 
cancellation email is sent to all the reviewers.

Resolution info: When you cancel a review for 
a reviewer during the parallel review, the 
review cancellation email is sent only to that 
reviewer.

00781093 CLM-7841 When you set up Wizard as a related tab, the 
Wizard related tab does not show the Wizard 
records.

00768845 CLM-7856 When you click the Send button multiple times 
while sending agreement documents for 
parallel review, multiple review cycles are 
created.

Resolution info: When you click the Send 
button once, the Send button is disabled and 
only one review cycle is created.

Known Issues 
The following table provides the cumulative list of known issues up to this release.
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Conga Internal ID Description

CLM-7792 You can view the Insert Read Only button in the X-Author 
Contracts Playbook (Clause library) during contract 
negotiation but you cannot click the button.

CLM-7710 You encounter an error when you click in the TO field while 
sending a document for review using the Safari browser.

Workaround: Use Chrome or Microsoft Edge to send documents 
for review.

CLM-7204 If a validation rule fails, the duplicate agreement is marked as 
transient.

CLM-6792 If you see the Import Large File button in the Additional Actions 
section of the action panel, you must not use it to import files. 
This option is disabled in Spring '21 release.

CLM-5367 In the Console tab, when you click Cancel, the tab does not 
close while sending for signatures and sending for review.

CLM-5359 When you choose any value instead of the first value in the 
wizard lookup field in Salesforce Classic, the value resets to the 
first value.

CLM-5988 When you use a checkbox object field in input rules condition, 
checked and unchecked options are not visible.

CLM-5917 If the Set This Control Value rule is set on an input field, you 
cannot modify the input in the wizard.

CLM-5976 When you open a wizard in the Classic mode with rules on a 
Lookup field, you encounter an error.

CLM-5367 The console app tab remains open on canceling sending for 
signatures and review.

CLM-5207 The console app displays the Generate button even after the 
user has generated the document.
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Conga Internal ID Description

XA-2718 On Partner Community portals, when you try to upload an 
offline agreement or check in an existing template to 
agreements in FX2 format from X-Author Contracts, an error 
message is displayed for version-aware and non-version-aware 
file or attachment type document.

CLM-3212 The Work Order custom object is not enabled for a template 
object of the Pre FX2 format.

CLM-3211 Agreement flow does not work for Communities in the 
Salesforce Lightning mode.

CLM-2730 In the Salesforce One app, when a user clicks the Agreement 
Actions from the Action panel once, the user stays on the same 
page. To go to the next page, the user must click twice. This is a 
Salesforce limitation for embedded Visualforce pages.

CLM-2690 In the Salesforce One app, clicking the lookup option does not 
open a new pop-up window.

December21.01.28 Release Notes
In these release notes, you can find packages, requirements, features, enhancements, fixed 
issues, and known issues for the CLM December21.01.28 release. For documentation updates, 
see What's New in CLM Documentation.

All Conga customers have FREE access to getting started content and release training in 
the Conga Learning Center. To take your training further, ensure your organization has 
access to the Conga Learning Pass, which is a training subscription service. Click here to 
learn more.

Packages

This documentation may describe optional features for which you have not 
purchased a license; therefore your solution or implementation may differ from 
what is described here. Contact your Customer Success Manager (CSM) or Account 
Executive (AE) to discuss your specific features and licensing.



https://documentation.conga.com/clm/winter-21/what-s-new-in-clm-documentation-152571999.html
https://community.conga.com/s/learning-center
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The following packages and dependencies are required to upgrade to this release and use 
its new features. These are the minimum required versions; later versions are also 
supported. Prerequisites for each feature can be found in its documentation. Packages 
marked (New) are new for this release.

Package Latest Certified Version (Name | Number)

Conga Base Library  2.2.224 | 2.224

Conga Contract Lifecycle Management (New) 12.2.0654.5 | 12.654.5

Conga Content Integration  8.1.0020 | 8.20

Conga DocuSign API 

(Required if you are using DocuSign)

7.2.116 | 7.116

Conga CLM DocuSign Integration 

(Required if you are using DocuSign)

4.2.48 | 4.48

Adobe Sign 

(Required if you are using Adobe Sign)

23.14 | 23.14

Conga CLM Adobe Sign Integration 

(Required if you are using Adobe Sign)

9.2.69 | 9.69

Conga Sign Integration 

(Required if you are using Conga Sign)

1.2.6 | 1.6

You can register your org for the Conga Push Upgrade. Conga Push Upgrade is an 
automated tool that upgrades packages available in your Salesforce org 
(Production or Sandbox) to the latest versions. In addition, it also ensures all the 
Conga published managed packages are on the latest versions for your registered 
orgs. For more information, see Registering for Conga Push Upgrade.



For more information on installing CLM managed packages, see Installing Conga 
CLM. For more information on upgrading CLM managed packages, see Upgrading 
Conga CLM.



https://documentation.conga.com/clm/latest/registering-for-conga-push-upgrade-165938326.html
https://documentation.conga.com/clm/winter-21/installing-conga-clm-161155922.html
https://documentation.conga.com/clm/winter-21/upgrading-conga-clm-152572123.html
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System Requirements and Supported Platforms 
For requirements and recommendations to consider before installing the Conga product 
suite, see System Requirements and Supported Platforms Matrix.

New Features
The following feature is new to CLM.

Apply Version Number to Merged Document
When the value of the APTS_AppendVersionNumberToMergedDocs admin entry is true and 
the Document Versioning Properties are enabled, the name of the merged documents will be 
suffixed with a version number. For more information, see Admin Entries.

Enhancements
There are no enhancements in this release.

Data Model Changes 
There are no data model changes in this release.

Fixed Issues 
There are no fixed issues in this release.

Known Issues 
The following table provides the cumulative list of known issues up to this release.

If you use CLM in Salesforce Lightning, you must enable the Enable Files Comply 
System Property.

https://documentation.conga.com/technotes/system-requirements-and-supported-platforms-matrix
https://documentation.conga.com/display/CLM/.Admin+Entries+vDecember-21
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Conga Internal ID Description

CLM-7792 You can view the Insert Read Only button in the X-Author 
Contracts Playbook (Clause library) during contract 
negotiation but you cannot click the button.

CLM-7710 You encounter an error when you click in the TO field while 
sending a document for review using the Safari browser.

Workaround: Use Chrome or Microsoft Edge to send documents 
for review.

CLM-7204 If a validation rule fails, the duplicate agreement is marked as 
transient.

CLM-6792 If you see the Import Large File button in the Additional Actions 
section of the action panel, you must not use it to import files. 
This option is disabled in Spring '21 release.

CLM-5367 In the Console tab, when you click Cancel, the tab does not 
close while sending for signatures and sending for review.

CLM-5359 When you choose any value instead of the first value in the 
wizard lookup field in Salesforce Classic, the value resets to the 
first value.

CLM-5988 When you use a checkbox object field in input rules condition, 
checked and unchecked options are not visible.

CLM-5917 If the Set This Control Value rule is set on an input field, you 
cannot modify the input in the wizard.

CLM-5976 When you open a wizard in the Classic mode with rules on a 
Lookup field, you encounter an error.

CLM-5367 The console app tab remains open on canceling sending for 
signatures and review.

CLM-5207 The console app displays the Generate button even after the 
user has generated the document.
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Conga Internal ID Description

XA-2718 On Partner Community portals, when you try to upload an 
offline agreement or check in an existing template to 
agreements in FX2 format from X-Author Contracts, an error 
message is displayed for version-aware and non-version-aware 
file or attachment type document.

CLM-3212 The Work Order custom object is not enabled for a template 
object of the Pre FX2 format.

CLM-3211 Agreement flow does not work for Communities in the 
Salesforce Lightning mode.

CLM-2730 In the Salesforce One app, when a user clicks the Agreement 
Actions from the Action panel once, the user stays on the same 
page. To go to the next page, the user must click twice. This is a 
Salesforce limitation for embedded Visualforce pages.

CLM-2690 In the Salesforce One app, clicking the lookup option does not 
open a new pop-up window.

December21.01.13 Release Notes
In these release notes, you can find packages, requirements, features, enhancements, fixed 
issues, and known issues for the CLM December21.01.13 release. For documentation updates, 
see What's New in CLM Documentation.

All Conga customers have FREE access to getting started content and release training in 
the Conga Learning Center. To take your training further, ensure your organization has 
access to the Conga Learning Pass, which is a training subscription service. Click here to 
learn more.

Packages

This documentation may describe optional features for which you have not 
purchased a license; therefore your solution or implementation may differ from 
what is described here. Contact your Customer Success Manager (CSM) or Account 
Executive (AE) to discuss your specific features and licensing.



https://documentation.conga.com/clm/winter-21/what-s-new-in-clm-documentation-152571999.html
https://community.conga.com/s/learning-center
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The following packages and dependencies are required to upgrade to this release and use 
its new features. These are the minimum required versions; later versions are also 
supported. Prerequisites for each feature can be found in its documentation. Packages 
marked (New) are new for this release.

Package Latest Certified Version (Name | Number)

Conga Base Library  2.2.224 | 2.224

Conga Contract Lifecycle Management (New) 12.2.0654.4 | 12.654.4

Conga Content Integration  8.1.0020 | 8.20

Conga DocuSign API 

(Required if you are using DocuSign)

7.2.116 | 7.116

Conga CLM DocuSign Integration 

(Required if you are using DocuSign)

4.2.48 | 4.48

Adobe Sign 

(Required if you are using Adobe Sign)

23.14 | 23.14

Conga CLM Adobe Sign Integration 

(Required if you are using Adobe Sign)

9.2.69 | 9.69

Conga Sign Integration 

(Required if you are using Conga Sign)

1.2.6 | 1.6

You can register your org for the Conga Push Upgrade. Conga Push Upgrade is an 
automated tool that upgrades packages available in your Salesforce org 
(Production or Sandbox) to the latest versions. In addition, it also ensures all the 
Conga published managed packages are on the latest versions for your registered 
orgs. For more information, see Registering for Conga Push Upgrade.



For more information on installing CLM managed packages, see Installing Conga 
CLM. For more information on upgrading CLM managed packages, see Upgrading 
Conga CLM.



https://documentation.conga.com/clm/latest/registering-for-conga-push-upgrade-165938326.html
https://documentation.conga.com/clm/winter-21/installing-conga-clm-161155922.html
https://documentation.conga.com/clm/winter-21/upgrading-conga-clm-152572123.html
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System Requirements and Supported Platforms 
For requirements and recommendations to consider before installing the Conga product 
suite, see System Requirements and Supported Platforms Matrix.

New Features
The following feature is new to CLM.

Unsubscribe from Parallel Review Emails
When the value of the APTS_SuppressAutoReviewEmails admin entry is true, users will be 
unsubscribed from parallel review emails (review completion, review error, and review cycle 
completion). as the emails are sent from the user's domain for review cancellation and 
ending review from CLM, the admin entry is not applicable. For more information, see Admin 
Entries.

Enhancements
There are no enhancements in this release.

Data Model Changes 
There are no data model changes in this release.

Fixed Issues 
There are no fixed issues in this release.

Known Issues 
The following table provides the cumulative list of known issues up to this release.

If you use CLM in Salesforce Lightning, you must enable the Enable Files Comply 
System Property.

https://documentation.conga.com/technotes/system-requirements-and-supported-platforms-matrix
https://documentation.conga.com/display/CLM/.Admin+Entries+vDecember-21
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Conga Internal ID Description

CLM-7792 You can view the Insert Read Only button in the X-Author 
Contracts Playbook (Clause library) during contract 
negotiation but you cannot click the button.

CLM-7710 You encounter an error when you click in the TO field while 
sending a document for review using the Safari browser.

Workaround: Use Chrome or Microsoft Edge to send documents 
for review.

CLM-7204 If a validation rule fails, the duplicate agreement is marked as 
transient.

CLM-6792 If you see the Import Large File button in the Additional Actions 
section of the action panel, you must not use it to import files. 
This option is disabled in Spring '21 release.

CLM-5367 In the Console tab, when you click Cancel, the tab does not 
close while sending for signatures and sending for review.

CLM-5359 When you choose any value instead of the first value in the 
wizard lookup field in Salesforce Classic, the value resets to the 
first value.

CLM-5988 When you use a checkbox object field in input rules condition, 
checked and unchecked options are not visible.

CLM-5917 If the Set This Control Value rule is set on an input field, you 
cannot modify the input in the wizard.

CLM-5976 When you open a wizard in the Classic mode with rules on a 
Lookup field, you encounter an error.

CLM-5367 The console app tab remains open on canceling sending for 
signatures and review.

CLM-5207 The console app displays the Generate button even after the 
user has generated the document.
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Conga Internal ID Description

XA-2718 On Partner Community portals, when you try to upload an 
offline agreement or check in an existing template to 
agreements in FX2 format from X-Author Contracts, an error 
message is displayed for version-aware and non-version-aware 
file or attachment type document.

CLM-3212 The Work Order custom object is not enabled for a template 
object of the Pre FX2 format.

CLM-3211 Agreement flow does not work for Communities in the 
Salesforce Lightning mode.

CLM-2730 In the Salesforce One app, when a user clicks the Agreement 
Actions from the Action panel once, the user stays on the same 
page. To go to the next page, the user must click twice. This is a 
Salesforce limitation for embedded Visualforce pages.

CLM-2690 In the Salesforce One app, clicking the lookup option does not 
open a new pop-up window.

December21.12.17 Release Notes
In these release notes, you can find packages, requirements, features, enhancements, fixed 
issues, and known issues for the CLM December21.12.17 release. For documentation updates, 
see What's New in CLM Documentation.

All Conga customers have FREE access to getting started content and release training in 
the Conga Learning Center. To take your training further, ensure your organization has 
access to the Conga Learning Pass, which is a training subscription service. Click here to 
learn more.

Packages

This documentation may describe optional features for which you have not 
purchased a license; therefore your solution or implementation may differ from 
what is described here. Contact your Customer Success Manager (CSM) or Account 
Executive (AE) to discuss your specific features and licensing.



https://documentation.conga.com/clm/winter-21/what-s-new-in-clm-documentation-152571999.html
https://community.conga.com/s/learning-center
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The following packages and dependencies are required to upgrade to this release and use 
its new features. These are the minimum required versions; later versions are also 
supported. Prerequisites for each feature can be found in its documentation. Packages 
marked (New) are new for this release.

Package Latest Certified Version (Name | Number)

Conga Base Library  2.2.224 | 2.224

Conga Contract Lifecycle Management (New) 12.2.0654.3 | 12.654.3

Conga Content Integration  8.1.0020 | 8.20

Conga DocuSign API 

(Required if you are using DocuSign)

7.2.116 | 7.116

Conga CLM DocuSign Integration 

(Required if you are using DocuSign)

4.2.48 | 4.48

Adobe Sign 

(Required if you are using Adobe Sign)

23.14 | 23.14

Conga CLM Adobe Sign Integration 

(Required if you are using Adobe Sign)

9.2.69 | 9.69

Conga Sign Integration 

(Required if you are using Conga Sign)

1.2.6 | 1.6

You can register your org for the Conga Push Upgrade. Conga Push Upgrade is an 
automated tool that upgrades packages available in your Salesforce org 
(Production or Sandbox) to the latest versions. In addition, it also ensures all the 
Conga published managed packages are on the latest versions for your registered 
orgs. For more information, see Registering for Conga Push Upgrade.



For more information on installing CLM managed packages, see Installing Conga 
CLM. For more information on upgrading CLM managed packages, see Upgrading 
Conga CLM.



https://documentation.conga.com/clm/latest/registering-for-conga-push-upgrade-165938326.html
https://documentation.conga.com/clm/winter-21/installing-conga-clm-161155922.html
https://documentation.conga.com/clm/winter-21/upgrading-conga-clm-152572123.html
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System Requirements and Supported Platforms 
For requirements and recommendations to consider before installing the Conga product 
suite, see System Requirements and Supported Platforms Matrix.

New Features
The following feature is new to CLM.

CLM Supports Conga AI for Intelligent Discovery
You can use Conga AI with CLM to intelligently extract data from agreement documents. 
Conga AI is available for only new users. You cannot migrate Intelligent Data Discovery 
mappings from Kira to Conga AI. For more information, see the Managing Offline 
Agreements section.

Conga AI supports 41 provisions. For more information, see Provisions Supported by Conga 
AI.

The following table lists the time taken to extract data from each file type. For more 
information, see Supported File Sizes in Lightning.

File Type File Size No. of Pages in the 
Document

No. of Provisions in 
the Document

Data Extraction 
Time

DOCX 176KB 20 20 13 mins

PDF 227KB 20 20 13 mins

Enhancements
There are no enhancements in this release.

Data Model Changes 
There are no data model changes in this release.

If you use CLM in Salesforce Lightning, you must enable the Enable Files Comply 
System Property.

https://documentation.conga.com/technotes/system-requirements-and-supported-platforms-matrix
https://documentation.conga.com/clm/december-21/managing-offline-agreements-169284267.html
https://documentation.conga.com/clm/december-21/provisions-supported-by-conga-ai-169285028.html
https://documentation.conga.com/clm/december-21/supported-file-sizes-in-lightning-161154705.html
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Fixed Issues 
The following table lists the issue fixed in this release. If any actions are required, they will 
be listed in this table.

Case 
Numbe 
r

Conga 
Internal 
ID

Description

007806 
66

CLM-7805 In a generated document, values of picklist fields are added instead of the 
API name.

Resolution info: When an administrator sets the 
APTS_TranslatePickValuesInDocs admin entry to true, the field value gets 
added in the generated document. If a conditional segment is set, the 
condition takes both API and values. You can either use API names or 
Values but not both.

When an administrator sets the APTS_TranslatePickValuesInDocs admin 
entry to false or does not add the admin entry, the API Name gets added in 
the generated document by default.

For more information, see Admin Entries.

Known Issues 
The following table provides the cumulative list of known issues up to this release.

Conga Internal ID Description

CLM-7792 You can view the Insert Read Only button in the X-Author 
Contracts Playbook (Clause library) during contract 
negotiation but you cannot click the button.

CLM-7710 You encounter an error when you click in the TO field while 
sending a document for review using the Safari browser.

Workaround: Use Chrome or Microsoft Edge to send documents 
for review.

CLM-7204 If a validation rule fails, the duplicate agreement is marked as 
transient.

https://documentation.conga.com/clm/december-21/admin-entries-161153470.html#id-.AdminEntriesvDecember21-APTS_TranslatePickValuesInDocs
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Conga Internal ID Description

CLM-6792 If you see the Import Large File button in the Additional Actions 
section of the action panel, you must not use it to import files. 
This option is disabled in Spring '21 release.

CLM-5367 In the Console tab, when you click Cancel, the tab does not 
close while sending for signatures and sending for review.

CLM-5359 When you choose any value instead of the first value in the 
wizard lookup field in Salesforce Classic, the value resets to the 
first value.

CLM-5988 When you use a checkbox object field in input rules condition, 
checked and unchecked options are not visible.

CLM-5917 If the Set This Control Value rule is set on an input field, you 
cannot modify the input in the wizard.

CLM-5976 When you open a wizard in the Classic mode with rules on a 
Lookup field, you encounter an error.

CLM-5367 The console app tab remains open on canceling sending for 
signatures and review.

CLM-5207 The console app displays the Generate button even after the 
user has generated the document.

XA-2718 On Partner Community portals, when you try to upload an 
offline agreement or check in an existing template to 
agreements in FX2 format from X-Author Contracts, an error 
message is displayed for version-aware and non-version-aware 
file or attachment type document.

CLM-3212 The Work Order custom object is not enabled for a template 
object of the Pre FX2 format.

CLM-3211 Agreement flow does not work for Communities in the 
Salesforce Lightning mode.
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Conga Internal ID Description

CLM-2730 In the Salesforce One app, when a user clicks the Agreement 
Actions from the Action panel once, the user stays on the same 
page. To go to the next page, the user must click twice. This is a 
Salesforce limitation for embedded Visualforce pages.

CLM-2690 In the Salesforce One app, clicking the lookup option does not 
open a new pop-up window.

December '21 Release Notes
In these release notes, you can find packages, requirements, features, enhancements, fixed 
issues, and known issues for the CLM December '21 release. For documentation updates, 
see What's New in CLM Documentation.

All Conga customers have FREE access to getting started content and release training in 
the Conga Learning Center. To take your training further, ensure your organization has 
access to the Conga Learning Pass, which is a training subscription service. Click here to 
learn more.

Packages
The following packages and dependencies are required to upgrade to this release and use 
its new features. These are the minimum required versions; later versions are also 
supported. Prerequisites for each feature can be found in its documentation. Packages 
marked (New) are new for this release.

This documentation may describe optional features for which you have not 
purchased a license; therefore your solution or implementation may differ from 
what is described here. Contact your Customer Success Manager (CSM) or Account 
Executive (AE) to discuss your specific features and licensing.



https://documentation.conga.com/clm/winter-21/what-s-new-in-clm-documentation-152571999.html
https://community.conga.com/s/learning-center
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Package Latest Certified Version (Name | Number)

Conga Base Library (New) 2.2.224 | 2.224

Conga Contract Lifecycle Management (New) 12.2.0654 | 12.654

Conga Content Integration  8.1.0020 | 8.20

Conga DocuSign API (New)

(Required if you are using DocuSign)

7.2.116 | 7.116

Conga CLM DocuSign Integration (New)

(Required if you are using DocuSign)

4.2.48 | 4.48

Adobe Sign (New)

(Required if you are using Adobe Sign)

23.14 | 23.14

Conga CLM Adobe Sign Integration (New)

(Required if you are using Adobe Sign)

9.2.69 | 9.69

Conga Sign Integration (New)

(Required if you are using Conga Sign)

1.2.6 | 1.6

You can register your org for the Conga Push Upgrade. Conga Push Upgrade is an 
automated tool that upgrades packages available in your Salesforce org 
(Production or Sandbox) to the latest versions. In addition, it also ensures all the 
Conga published managed packages are on the latest versions for your registered 
orgs. For more information, see Registering for Conga Push Upgrade.



For more information on installing CLM managed packages, see Installing Conga 
CLM. For more information on upgrading CLM managed packages, see Upgrading 
Conga CLM.
If you use CLM in Salesforce Lightning, you must enable the Enable Files Comply 
System Property.



https://documentation.conga.com/clm/latest/registering-for-conga-push-upgrade-165938326.html
https://documentation.conga.com/clm/winter-21/installing-conga-clm-161155922.html
https://documentation.conga.com/clm/winter-21/upgrading-conga-clm-152572123.html
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System Requirements and Supported Platforms 
For requirements and recommendations to consider before installing the Conga product 
suite, see System Requirements and Supported Platforms Matrix.

New Features
The following features are new to Conga CLM in this release.

Integrate CLM with Conga Sign
You can use Conga Sign to send for eSignatures from CLM. For more information, see Conga 
Sign-CLM Custom Settings, Using Conga Sign with Conga CLM, and Sending Transactions 
from Conga CLM.

New User Interface for Send for Review Flow
By default, you will see the new send for review UI when you send documents for review. For 
more information, see Sending an Agreement Document for Parallel Review.

Enhancements
The following enhancements are new to Conga CLM in this release.

Removed User Experience Analysis Component
CLM has removed the User Experience Analysis component that collected product usage 
data. 

Clone, Amend, or Renew Agreements with Large Files
You can clone, amend, or renew agreements with up to 2GB file size. When you clone, 
amend, or renew agreements with large files, the original files are duplicated and it 
impacts the storage space. For more information, see Supported File Sizes in Lightning.

https://documentation.conga.com/technotes/system-requirements-and-supported-platforms-matrix
https://documentation.conga.com/sign/december-21/clm-conga-sign-custom-settings-165938347.html
https://documentation.conga.com/sign/december-21/using-conga-sign-with-conga-clm-163938766.html
https://documentation.conga.com/sign/december-21/sending-transactions-from-conga-clm-165938094.html
https://documentation.conga.com/clm/december-21/sending-an-agreement-document-for-parallel-review-158343529.html
https://documentation.conga.com/clm/december-21/supported-file-sizes-in-lightning-161154705.html
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You can copy documents from Document Version Detail using Clone Spec. For more 
information, see Configuring APTS_ComplyConfig.

Update an Existing Document Version by Importing 
Offline Documents 
When the Ancestor selection for Import Offline comply system property is enabled, you can 
view the Import Documents popup. You can update the existing document version by 
importing a document so that the document versioning can be tracked as a single 
document version. For more information, see Comply System Properties and Importing an 
Offline Document.

Introduced New Clause Approval Status
If you have integrated CLM with Online Contract Collaboration and Approvals, you can 
see the In Clause Approvals status when a clause approval process is initiated from OCC. 
For more information, see Status and Status Categories.

Change Agreement Status After Clause Approval 
If you need to define the status and status category of an agreement to update after all 
clauses are approved, canceled, or rejected in the agreement, You can configure the 
APTS_AgreementStatusOnClauseApproval admin entry. For more information, see Admin 
Entries.

Restrict Users from Sending Non-Essential Documents 
for Review
You can restrict users from sending non-essential agreements or documents for review by 
passing Agreement IDs or Document IDs as parameters in the formula field. You can add 
document IDs of the related, parent, sibling, or child agreements. If any document IDs of 
documents mentioned in the formula field are in review, those documents are not listed 
when a user sends agreement documents for review. For more information, see Configuring 
the Send for Review Custom Button.

https://documentation.conga.com/clm/december-21/configuring-apts_complyconfig-165937953.html
https://documentation.conga.com/clm/latest/comply-system-properties-161155670.html
https://documentation.conga.com/clm/december-21/importing-an-offline-document-161155663.html
https://documentation.conga.com/display/CLM/.Status+and+Status+Categories+vWinter-21
https://documentation.conga.com/clm/december-21/admin-entries-161153470.html
https://documentation.conga.com/clm/december-21/configuring-the-send-for-review-custom-button-161155967.html
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Availability of the Upload Reviewed Document Button
When you send a document for parallel review and the review cycle for the document is in 
Not Started or In Progress status, you can view the Upload Reviewed Document button on 
the Agreement Detail page. For more information, see Sending an Agreement Document for 
Parallel Review.

View Review Cycle of Each Document
When you send more than one document for parallel review, you can see the progress of 
the review cycle of each document on the Agreement Detail page or on the Review Cycle 
page. For more information, see Sending an Agreement Document for Parallel Review.

Set Field and Clause Level Permissions During Parallel 
Review
When the Enable document permissions for review comply system property is enabled, 
users can view the Set field and clause permission toggle in the second step of the parallel 
review and set the field or clause level permissions for each reviewer in the third step of the 
parallel review. At the second step, you can toggle the Set field and clause permission off 
to send the documents for review without customizing user permissions for smart fields and 
clauses. For more information, see Comply User Properties and Sending an Agreement 
Document for Parallel Review.

View Review Cycle Details on the Agreement Detail 
Page
You can view the review cycle details in the Review Status section on the Agreement Detail 
page. You can refresh the review status to view the latest review status. You can navigate 
to the Review Cycle page without navigating to the Document Versions page. For more 
information, Adding the Review Status Panel on the Agreement Detail Page.

https://documentation.conga.com/clm/december-21/sending-an-agreement-document-for-parallel-review-158343529.html
https://documentation.conga.com/clm/december-21/sending-an-agreement-document-for-parallel-review-158343529.html
https://documentation.conga.com/clm/december-21/comply-user-properties-165937178.html
https://documentation.conga.com/clm/december-21/sending-an-agreement-document-for-parallel-review-158343529.html
https://documentation.conga.com/clm/december-21/adding-the-review-status-panel-on-the-agreement-detail-page-165940300.html
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Configure Columns in the Documents Tab
When you configure the registration setting and remote site setting, you can configure the 
columns that are visible on the Documents tab. For more information, see Working with 
Documents.

Restrict Supporting Documents During Review
Administrators can use the Show Add More Button During Review comply user property to 
allow users to view the Add more button while sending documents for review to add 
supporting documents from their local or shared drive. You can configure the comply user 
property to customize permissions for specific profiles or users. For more information, see 
 Comply User Properties and Sending an Agreement Document for Parallel Review.

No Dependency on Track Activities 
To send documents for parallel review, you do not have to select the Track Activities 
checkbox on the Document Version Detail page. 

Admin Entries Updates for Send for Review
The APTS_DefaultEmailContactName and APTS_DefaultEmailTemplateFolder admin 
entries are not applicable in the new send for review flow in Salesforce Lightning. For more 
information, see Prerequisites for Parallel Review.

Update Email Body While Sending for Review
You can update the email body when you send documents for review. For more information, 
see Sending an Agreement Document for Parallel Review.

Data Model Changes 
The following objects and fields are introduced to or changed in the system or data model 
in this release.

https://documentation.conga.com/clm/december-21/working-with-documents-163940207.html
https://documentation.conga.com/clm/december-21/comply-user-properties-165937178.html
https://documentation.conga.com/clm/december-21/sending-an-agreement-document-for-parallel-review-158343529.html
https://documentation.conga.com/clm/december-21/prerequisites-for-parallel-review-163938969.html
https://documentation.conga.com/clm/december-21/sending-an-agreement-document-for-parallel-review-158343529.html
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Object Field Description Syste 
m/ 
User

New/ 
Chang 
ed

AgreementInsi 
ght__c

  System New

 CalculationCriter 
iaResults__c

The calculated values on which the 
criteria was satisfied

System New

 CalculationCriter 
ia__c

The formula for the calculation done on 
the defined criteria

System New

 CriteriaFieldValu 
es__c

The existing values for the criteria fields System New

 Criteria__c Criteria for deriving the risk score on the 
insight

System New

 DocumentVersion 
DetailId__c

Document Version on which the Insight 
rating is defined

System New

 Guidance__c Guidance of the Insight System New

 IDEProvisionId__c Provision on which the insight was found System New

 Rating__c Rating of the Insight System New

 Type__c Type of the Insight/Provision Name System New

ComplySyste 
mProperties__ 
c

  User Chang 
ed

 EnableDocPermis 
sionsForReview__ 
c

Indicates whether a user can set field 
level or clause level permissions for each 
reviewer.

User New

ComplyUserPr 
operties__c

  User New
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Object Field Description Syste 
m/ 
User

New/ 
Chang 
ed

 ShowAddMoreBut 
tonDuringReview_ 
_c

Allows users to view the Add more button 
while sending documents for review to 
add supporting documents from their 
local or shared drive.

User New

DocumentVer 
sionDetail__c

  User Chang 
ed

 TotalInsightScore 
__c

Total Risk Score of Insights on a 
document

System New

DocumentVer 
sion__c

  User Chang 
ed

 LatestInsightScor 
e__c

Total Risk Score of the latest Document System New

Fixed Issues 
The following table lists the issue fixed in this release. If any actions are required, they will 
be listed in this table.

Case 
Numbe 
r

Conga 
Internal 
ID

Description

0045311 
9

CLM-7558 On generating a document using a template containing merge fields, the 
merge fields do not populate according to the translation language 
selected in the translation workbench.

0011424 
7

CLM-7287 You cannot amend agreements when the file type is File and documents in 
the agreements are large files.

Known Issues 
The following table provides the cumulative list of known issues up to this release.
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Conga 
Internal ID

Description

CLM-7710 You encounter an error when you click in the TO field while sending a document for 
review using the Safari browser.

Workaround: Use Chrome or Microsoft Edge to send documents for review.

CLM-7204 If a validation rule fails, the duplicate agreement is marked as transient.

CLM-6792 If you see the Import Large File button in the Additional Actions section of the 
action panel, you must not use it to import files. This option is disabled in Spring '21 
release.

CLM-5367 In the Console tab, when you click Cancel, the tab does not close while sending for 
signatures and sending for review.

CLM-5359 When you choose any value instead of the first value in the wizard lookup field in 
Salesforce Classic, the value resets to the first value.

CLM-5988 When you use a checkbox object field in input rules condition, checked and 
unchecked options are not visible.

CLM-5917 If the Set This Control Value rule is set on an input field, you cannot modify the 
input in the wizard.

CLM-5976 When you open a wizard in the Classic mode with rules on a Lookup field, you 
encounter an error.

CLM-5367 The console app tab remains open on canceling sending for signatures and review.

CLM-5207 The console app displays the Generate button even after the user has generated 
the document.

XA-2718 On Partner Community portals, when you try to upload an offline agreement or 
check in an existing template to agreements in FX2 format from X-Author 
Contracts, an error message is displayed for version-aware and non-version- 
aware file or attachment type document.

CLM-3212 The Work Order custom object is not enabled for a template object of the Pre FX2 
format.
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Conga 
Internal ID

Description

CLM-3211 Agreement flow does not work for Communities in the Salesforce Lightning mode.

CLM-2730 In the Salesforce One app, when a user clicks the Agreement Actions from the 
Action panel once, the user stays on the same page. To go to the next page, the 
user must click twice. This is a Salesforce limitation for embedded Visualforce 
pages.

CLM-2690 In the Salesforce One app, clicking the lookup option does not open a new pop-up 
window.

DOC ID: CLMDEC21RNREVA20211203
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About CLM
A contract or an agreement is a legally binding arrangement between two or more entities. 
Contract Management (CM) or Contract Lifecycle Management (CLM) is the process of 
managing contract creation, analysis, execution, and maintenance. Conga Contract 
Lifecycle Management (Conga CLM) is a cloud-based solution that standardizes, 
streamlines, and automates the contract lifecycle management process—from the initial 
request through drafting, redlining, sending for signatures, securing documents, managing 
obligations, and renewing contracts.

Conga CLM runs on the Salesforce platform and all the contract data is stored in 
Salesforce. Conga CLM data-handling practices are the same for Conga CLM as they are 
for any Salesforce implementation: cross-border data exchange, data transmission 
methods, data storage and encryption, and logical and physical separation of data. 

As an administrator, you can design the user interface of Conga CLM by creating page 
layouts, customizing agreement actions, adding custom links, and customizing the action 
panel. Conga CLM lets you manage user profiles by configuring user permissions and secure 
the agreement documents by implementing document protection. With X-Author for 
Contracts, you can create agreement templates and agreement clauses and use Conga 
CLM to manage them. You can design workflows and agreement lifecycles in Conga CLM. 
You can integrate Conga CLM with eSignature solutions—Adobe Sign and DocuSign. You 
can also track agreement versions and secure agreement documents. Conga CLM allows 
you to schedule jobs to automate recurring tasks, such as refreshing agreement data, 
setting the expiration date for the links used to download multiple agreements, extracting 
intelligent data, and generating reports. 

The following flowchart depicts the Contract Management process:

As a user, you can create a contract from pre-loaded templates or import a third-party 
document as an offline agreement document. Contract Management works with optical 
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character recognition software to scan imported third-party papers and convert them to a 
searchable PDF. You can send your agreement documents for eSignatures if Contract 
Management is integrated with eSignature solutions—Adobe Sign and DocuSign. Contract 
Management is able to provide a set of standard or customized, reports to track activity 
status, expirations, non-standard terms, etc. You can also use Agreement Explorer to 
configure and reuse searches and reports. 

An agreement goes through the contract management lifecycle according to the workflow 
defined by the application administrator. Your access to all the features of CLM depends 
on the roles and permissions assigned to you by the application administrator.

The following table lists the tasks that administrators and users can perform using CLM.



CLM

90 Copyright ©2022 Apttus Corporation. All rights reserved.
 

•
•

•

•
•

•
•

•

•
•

•
•
•
•
•
•
•

•

•
•

•
•

•
•
•

•

•

•
•
•
•
•
•
•
•

•

•
•
•
•

•
•
•
•
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Administrator Administrator/User

Manage user profiles
Create, edit, and delete a user 
profile
Add single or multiple users to a 
user profile
Assign a license to a user
Apply security and permissions to 
a user profile

Configure user interface 
Create and edit page layouts and 
record types
Configure custom links on the home 
page
Add the action panel
Configure an offline agreement 
window

Manage templates
Set up a template object 
Secure documents
Organize agreement clauses
Manage template versions
Configure term exceptions
Configure dynamic document 
assembly
Configure auto and manual 
template publishing
Set up template filtering rules 
Configure query templates

Manage agreements
Set up an agreement request 
process
Set up agreement record types
Customize agreement actions
Schedule jobs to refresh agreement 
data
Set up an agreement output 
format
Track clauses used in agreement 
documents

Work with agreements
Create 
Generate 
Send for review
Negotiate 
Finalize 
Sign/Execute
Activate

Manage agreement lifecycle post- 
activation

Amend
Renew
Terminate
Expire

Work with offline agreements 
Create 
Import 
Review an agreement created by 
intelligent import
Store an executed agreement

Manage document and template 
versioning
Run the contract wizard to automate 
agreement creation
Create, run, and delete an Agreement 
Explorer report
Execute SOAP and REST APIs

For end-user functionality, see CLM for 
Users, CLM for SOAP API Developers, 
and CLM for REST API Developers.
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•

•

•

•
•
•
•

•
•

•

•
•

•
•

Administrator Administrator/User

Control access permissions for 
agreements
Route documents to content 
libraries
Configure agreement rules to route 
content
Configure intelligent import 
Configure agreement versioning
Implement agreement protection
Configure contract wizard

Manage workflow
Create, edit, delete, and validate 
workflow rules
Configure workflow and approval 
email alerts
Configure retention policies

Configure reports
Manage cycle time reports
Configure Agreement Explorer

Key Terminology
It is important to understand how terms are used when working with Conga CLM.

Term Definition

Action panel A collection of agreement action buttons on the user 
interface that can be enabled for the Agreement Record page 
in the Classic mode for community portals.

Agreement A set of terms and conditions agreed upon by two or more 
parties.

For administrator functionality, see 
CLM for Administrators.
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Term Definition

Agreement actions The actions available at various stages of the agreement 
such as Preview Agreement, Generate Agreement, Regenerate 
Agreement, Generate Supporting Document, Send for Review, 
Send for Signatures, Import Offline Document, Activate, 
Amend, Renew, Expire, Terminate, and Cancel Request.

Agreement document A document generated by merging information stored in a 
record with an existing template.

Agreement Document Protection A feature that helps protect your documents when they are 
generated in Microsoft Word format.

Contract administrators can configure document protection 
rules so that a contract user can perform any of the lifecycle 
actions, depending on the protection rules that are applied to 
specific user roles. There are four document protection types 
such as ignore, unprotect, prompt, and automatic.

Agreement Explorer A search and reporting feature that allows you to search for 
records in the Agreement object using configurable and 
reusable search reports.

Agreement Line Item A product or service line item that is associated with an 
agreement.

Agreement Lock A feature that represents a lock on the agreement. The 
agreement is locked by the logged-in user automatically 
after the user checks out the agreement document.

Only users with UnlockCheckedInDocument action permission 
can unlock the locked agreement.

Agreement Protection A tab in the Apttus Contract Management application that 
specifies protection settings (available on the Agreement 
Wizard) for agreements.
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•

Term Definition

Agreement Rule A condition that allows you to configure how an agreement 
request is processed when the user clicks Submit Request.

Based on the administrator-defined criteria for a specific 
agreement record type, agreement rules can dictate if:

A document is generated automatically when the 
agreement is submitted for processing.
An agreement is sent to a queue for review and 
processing.

Agreement versioning A solution framework for document versioning at the 
agreement record level. 

Amend An action that enables you to modify the terms of an active 
agreement.

It creates a new version of the agreement record with an 
"amended" relationship to the original agreement. The new, 
amended record shares the same base agreement number as 
the original, with the decimal point incremented by one.

Apttus Retention Policy Schema An XML schema that describes the retention policy 
specification.

A retention policy determines the length of time a record must 
be stored. Generally, organizations apply retention policies to 
all records sharing certain characteristics, such as record 
type, region, and owner.

You can edit the specification of a retention policy to define 
the date until which the agreement is retained.

Clause A modular block of text that is used frequently across 
multiple templates.

Content libraries An alternative contract repository option to organize files 
and manage user permissions.

Contract An agreement between two or more entities, with specific 
terms.
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Term Definition

Contract wizard A wizard that prompts the end user to answer a series of on- 
screen questions, and then creates the Agreement record.

Contract Document Versions A solution framework used for document versioning at the 
Agreement record level. Contract Document Versioning 
divides the version of an Agreement document into three 
parts: Major, Minor, and Revision. Each version of an 
agreement document is represented as a period-delimited 
numeric value in the Document Version Details object (for 
example, "1.0.0").

The first version of the document is created after you have 
created and generated an agreement. Subsequent versions 
are added during the review and negotiation phases. Version 
values are numerically incremented as various actions are 
taken on the document by different users.

Contract Management The process of systematically and efficiently managing 
contract creation, execution, and analysis.

Cycle Time Reporting A feature that enables organizations to track the elapsed 
time between any two statuses or status categories.

Custom link Allows you to add a customized link to internal or external 
URLs.

Document A dynamically generated output through merging 
information stored in an agreement record with the static 
text of an existing template. Output documents can be sent 
for review, approval, or signature.

Dashboard A user interface that organizes and presents key statistics in 
an easy to understand format

Agreement records that you own or have permission to access 
are displayed in the Agreements dashboard. You can 
customize the dashboard by configuring a ribbon that 
provides a quick view of the agreements and their 
corresponding status categories.
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Document Finder A feature that helps contract managers, sales persons, and 
legal teams to easily filter and find agreement documents 
directly from an agreement record.

Document output format Document format (file type) to be used for generating an 
agreement document.

Dynamic Document Assembly A feature that enables you to configure filter rules that drive 
a sequence of prescribed dynamic clause or attachment 
insertions in a generated document.

Expire An action that marks the agreement as Expired after the 
agreement term ends.

Intelligent import Intelligent data extraction functionality lets you import a 
third-party paper. Conga CLM works with optical character 
recognition software to scan the imported third-party paper 
and convert the document to a searchable PDF.

Merge web Service Merge Web Service APIs for generating and manipulating 
documents.

Object A definition of a specific type of information that you can 
store in Salesforce. Some objects are native to Salesforce, 
such as Contacts or Accounts, while others are specific to 
Apttus functionality, such as Templates or Agreements.

Offline agreement A third-party paper that you want to use as a basis for your 
contract.

Organization/Org An organization (org) is a Salesforce instance with a defined 
set of licensed users. An org is the virtual space provided to 
Conga CLM by Salesforce. Your org includes all of your data 
and applications, and is separate from all other orgs.

Note

You need to have an Intelligent Import license to 
process third-party paper in Conga CLM.
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Page layout A UI element that allows you to organize the layout on an 
object detail or edit page. You can use Page Layout to 
organize the following elements for your users:

Fields, related lists, and custom links
Field properties (visible, read-only, and required)
Page section customizations

Query template This feature allows you to narrow down the list of templates 
available for document generation.

Record A collection of fields with information about a specific item of 
a specific type (represented by an object), such as a Contact, 
an Account, or an Opportunity.

Record Type An element that allows you to offer different business 
processes, picklist values, and page layouts to different users.

A record type defines which page layouts users see when they 
view agreement records, based on their user profile. For 
example, you can create record types to differentiate your 
regular sales deals from your professional services 
engagements, offering different picklist values for each.

Redlining Allows you to identify the changes made by reviewers and 
accept or reject changes according to your business 
requirement.

Renew An action that enables users to create a new version of the 
agreement.

Reports Salesforce delivers standard report folders that contain 
reports for each record type. For example, Accounts, 
Opportunities, Leads, and so on.

Retention Policy A rule that determines the length of time a record must be 
stored.

Template A blueprint to generate a variety of document types when 
merged with data from agreements or quotes.
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Template filtering rules The Template Selection page can be configured to set up 
user-defined filters to narrow the list of Templates displayed 
to the user for Preview/Generate/Generate Supporting 
Document/Regenerate tasks.

Template versioning A solution framework of document versioning at the Template 
level to track template versions against generated 
documents.

Term exception An exception clause or term is a stipulated condition in your 
agreement to grant or prevent certain allowances to or from 
a particular group of users in your agreement.

Terminate Action on the Agreement Details page that enables users to 
terminate an active contract.

User profile A set of permissions granted to a group of users for the 
purpose of limiting feature accessibility. According to a user's 
role in an organization, Conga CLM Administrator can assign 
a profile to the user. There are five basic profiles associated 
with Conga CLM—Administrator, Contract Manager/ 
Template Admin, Read Only, Requester/Approver, 
and Contract Creator/Negotiator.

Wizard A wizard that prompts the end-user to answer a series of on- 
screen questions and then creates the Agreement record.

Wizard Component Library A tab that enables you to create reusable inputs and steps 
for your wizard designs.

Workflow rule Enforcement of key business processes, allowing you 
to automate tasks, email alerts, field updates, and outbound 
messages without the need to write any code.

For more information about terms used with Conga products, see Conga Product Glossary.

https://documentation.conga.com/display/CPG/Conga+Product+Glossary
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What's New in CLM Documentation
The following section lists changes in the documentation to support each release.

December '21

Document Publication 
Date

Topic Description

December '21 (Rev 
D)

22 Apr 2022   Generating Registration 
Setting

Modified topic. Added a 
prerequisite and updated 
contact information. 

Configuring Trusted CSP 
Sites

Modified topic. Updated 
contact information.

December '21 (Rev 
C)

24 Mar 
2022  

Merging Documents in 
Lightning

New topic. A new feature 
for this release.

December '21 (Rev 
B) 
 

27 Dec 2021

 

Provisions Supported by 
Conga AI

New topic. A new feature 
for this release.

Supported File Sizes in 
Lightning

Modified topic. Added file 
size limits for Conga AI

Managing Offline 
Agreements

Modified topic. Added 
details about Conga AI

December '21 (Rev 
A)

17 Dec 2021   Admin Entries Modified topic. Added 
details about 
APTS_TranslatePickValuesI 
nDocs.
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Document Publication 
Date

Topic Description

December '21 
 
 
 
 
 
 
 
 
 
 
 
 
 

29 Oct 2021  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Adding the Review Status 
Panel on the Agreement 
Detail Page

New topic. A new feature 
for this release.

Prerequisites for Parallel 
Review

Modified topic. Added 
prerequisites.

Configuring the Send for 
Review Custom Button

New topic. A new feature 
for this release.

Supported File Sizes in 
Lightning

Modified topic. Added file 
size limit for the cloned, 
amended, and renewed 
agreements.

Importing an Offline 
Document

Modified topic. Added 
details about importing an 
offline document by 
updating an existing 
document version.

Comply System Properties Modified topic. Added the 
Ancestor selection for 
Import Offline comply 
system property.

Status and Status 
Categories

Modified topic. Added 
details about In Clause 
Approval status.

Admin Entries Modified topic. Added 
details about 
APTS_AgreementStatusOnC 
lauseApproval.

Enabling and Customizing 
the Action Panel

Modified topic. Added 
details about Upload 
Reviewed Document and 
Send for Conga Sign.
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Document Publication 
Date

Topic Description

Sending an Agreement 
Document for Parallel 
Review

Modified topic. Added 
details about the new UI for 
sending documents for 
review.

Installing Conga CLM Modified topic. Removed 
details about user 
experience analysis.

Working with Documents Modified topic. Added 
details about configuring 
the columns.

Configuring Documents 
Tab in Lightning

Modified topic. Added a 
prerequisite. 

Comply User Properties New topic. A new feature 
for this release.

Configuring 
APTS_ComplyConfig

Modified topic. Added 
details about copying 
documents to the cloned, 
amended, or renewed 
agreement.

Summer '21

Document Publication 
Date

Topic Description

Summer '21 (Rev B) 22 Apr 2022   Generating Registration 
Setting

Modified topic. Added a 
prerequisite and updated 
contact information. 

Configuring CSP Trusted 
Sites

Modified topic. Updated 
contact information.



CLM

101
 

Copyright ©2022 Apttus Corporation. All rights reserved.
 

Document Publication 
Date

Topic Description

Summer '21 (Rev A) 09 Aug 2021   Registering for Conga 
Upgrade Program

New topic.

Installing Conga CLM Modified topic. Added details 
about registering for push 
upgrade.

Upgrading Conga CLM Modified topic. Added details 
about registering for push 
upgrade.

Configuring Notification 
Email for Review Cycle 
Cancellation

New topic. 

Summer '21 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

05 Jul 2021  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Setting Up Quick Search 
on the Home Page

New topic. A new feature for 
this release.

Populating the File Size 
Field

New topic. A new feature for 
this release.

Configuring Documents 
Tab in Lightning

New topic. A new feature for 
this release.

Generating Registration 
Setting

New topic. A new feature for 
this release.

Configuring Old 
Activation UI

New topic. A new feature for 
this release.

Configuring the Send for 
Review Custom Button

New topic. A new feature for 
this release.

Working with Documents New topic. A new feature for 
this release.
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Document Publication 
Date

Topic Description

Using Smart Search to 
Search Content in 
Agreement Documents in 
Lightning

Modified topic. Added details 
about Smart Search 
enhancements.

Configuring Intelligent 
Discovery Settings

Modified topic. Added details 
about deleting intelligent 
data discovery settings.

Migrating Mappings 
from Salesforce to 
Intelligent Data 
Discovery

Modified topic. Added details 
about migrating mappings 
from Salesforce to intelligent 
data discovery.

Mapping Provisions to 
Project-Record Type

Modified topic. Added details 
about delete mappings from 
the AI engine.

Sending an Agreement 
Document for Review

Modified topic. Added details 
about new UI.

Sending an Agreement 
Document for Parallel 
Review

Modified topic. Added details 
about the following 
enhancements:

New UI for sending 
documents for parallel 
review
Sending multiple 
documents for parallel 
review
Character limit for end 
review comments
Adding multiple 
contacts to a review 
cycle
Configuring email 
notifications for review 
cycle cancellation
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Document Publication 
Date

Topic Description

Activating an 
Agreement

Modified topic. Added details 
about publishing options.

Reviewing an Agreement 
Created by Intelligent 
Discovery

Modified topic. Added details 
about the new UI.

Supported File Sizes in 
Lightning

Modified topic. Added details 
about file sizes supported by 
Smart Search.

Admin Entries Modified topic. Added details 
about 
APTS_SkipFileSplitWhileSavin 
gFile.

Comply System 
Properties

Modified topic. Added details 
about the following 
properties:

Parallel Review for 
related agreements
Filter By The Primary 
Agreement Status

Spring '21

Document Topic Description

Spring 2021 (Rev C) Custom Permissions Modified topic. Added a note 
about default permission.

Assigning Custom Permissions to 
User Profiles

Modified topic. Added a note 
about default permission.

Spring 2021 (Rev B) Migrating Attachments to Files Modified topic. Added a 
prerequisite.

https://documentation.conga.com/clm/spring-21/custom-permissions-152570717.html
https://documentation.conga.com/clm/spring-21/assigning-custom-permissions-to-user-profiles-152570721.html
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Admin Entries Modified topic. Added 
APTS_SkipFileSplitWhileSavingFile  
admin entry.

Spring 2021 (Rev A) Upgrading Conga CLM Modified topic. Added a post- 
upgrade task.

Spring 2021 Upgrading Conga CLM Modified topic. Added details 
about upgrading CLM.

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Setting Up Organization-Wide 
Email Address

New topic. A new feature for this 
release.

Comply System Properties Modified topic. Added the 
following comply system 
properties:

Organization-Wide Email 
Address Display
Use Organization-Wide 
Email Address

Deprecated Enable Online 
Contract Collaboration property.

Admin Entries Modified topic. Added the 
following admin entry:

APTS_ExcludedNamespaces

Configuring Wizards as Self- 
Service with Salesforce Sites and 
Communities

Updated section. Removed content 
related to guest users.

With the Spring ’21 release, 
Salesforce has removed the View 
All, Modify All, edit, and delete 
permissions for guest users in all 
orgs. Hence, Conga CLM does not 
support guest user access. 

Configuring the Availability of 
Custom Buttons

Modified topic. Added details 
about configuring custom buttons.
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Enabling and Customizing the 
Action Panel

Modified topic. Added details 
about configuring custom buttons.

Editing Classic Email Templates New topic. A new feature for this 
release.

Configuring New Activation UI New topic. A new feature for this 
release.

Configuring In-Effect View Page 
Header

New topic. A new feature for this 
release.

Configuring MS Teams Setting Modified topic. Added details 
about MS Teams job.

Configuring Smart Search New topic. A new feature for this 
release.

Online Contract Collaboration Removed content related to 
Online Contract Collaboration. 
See the Online Contract 
Collaboration (OCC) 
Administrator Guide for 
information related to OCC.

Mapping Clauses and Fields to 
Provisions

Removed page. Deprecated 
feature.

Reviewing an Agreement 
Created by Intelligent Discovery

Modified topic. Added details 
about tracking the document 
upload progress and viewing large 
processed documents in the 
document viewer.

Accessing In-Effect View Modified topic. Added details 
about configuring In-Effect View 
header fields.

Activating an Agreement Modified topic. Added details 
about the new activation UI.

https://documentation.conga.com/display/CLM/.Reviewing+an+Agreement+Created+by+Intelligent+Discovery+vSpring-21
https://documentation.conga.com/display/CLM/.Activating+an+Agreement+vSpring-21
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Sending an Agreement Document 
for Parallel Review

Modified topic. Added details 
email notifications.

Using Smart Search to Search 
Content in Agreement 
Documents in Lightning

New topic. A new feature for this 
release.

Online Contract Collaboration Removed content related to 
Online Contract Collaboration. 
See the Online Contract 
Collaboration (OCC) User Guide 
for information related to OCC.

Sending a Document for 
Signatures

Added details about the 
sendForSignature API.

Winter '20

Document Topic Description

Winter 2020 (Rev E) Configuring Wizards as Self- 
Service with Salesforce Sites 
and Communities

Updated section. Removed content 
related to guest users.

With the Spring ’21 release, Salesforce 
has removed the View All, Modify All, 
edit, and delete permissions for guest 
users in all orgs. Hence, Conga CLM 
does not support guest user access. 

Winter 2020 (Rev D) Managing Alternate Clauses New topic. A new feature for this 
release.

Configuring OCC Permissions New topic. A new feature for this 
release.

Winter 2020 (Rev C) Configuring Email Templates in 
Lightning

Modified topic. Changed the temporary 
folder name.

Winter 2020 (Rev B) 
 

Installing Conga CLM Modified topic. Added details about the 
new theme.

https://documentation.conga.com/display/CLM/.Sending+an+Agreement+Document+for+Parallel+Review+vSpring-21
https://documentation.conga.com/display/CLM/.Using+Smart+Search+to+Search+Content+in+Agreement+Documents+in+Lightning+vSpring-21
https://documentation.conga.com/display/CLM/.Configuring+OCC+Permissions+vSpring-21
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Configuring Intelligent 
Discovery Settings

Modified topic. Added details about 
useAnalytics.

Enabling and Customizing the 
Action Panel

Modified topic. Added the following 
custom buttons:

In Effect View
View Hierarchy 

Winter 2020 (Rev A) Tracking Agreement Clause 
Versions

Modified topic. Updated clause actions.

Reviewing an Agreement 
Created by Intelligent 
Discovery

Modified and renamed the topic. 
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Winter 2020 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Contract Lifecycle 
Management with Salesforce 
Lightning

Modified topic. Added details about the 
new action panel.

Enabling and Customizing the 
Action Panel

Modified topic. Added details about 
configuring the action panel.

Admin Entries Modified topic. Added the following 
admin entries:

Added 
APTS_SkipContentSearchForActiv 
ation
APTS_SkipRemoveDraftDocument 
OnActivation
APTS_RetainFileNameForParallel 
ReviewMergedDocument

Updated the following admin entries:

APTS_AsyncMergeEmail
APTS_ContentRepositoryType

Removing the Path Field New topic. A new feature for this 
release.

Configuring Email Templates in 
Lightning

New topic. A new feature for this 
release.

Configuring OCC Access Modes 
and Sharing Settings

New topic. A new feature for this 
release.

Configuring Intelligent 
Discovery Settings

Modified topic. Added new 
configuration steps. Renamed 
Intelligent Import as Intelligent 
Discovery.

Configuring Intelligent 
Discovery Status Panel in 
Lightning

New topic. A new feature for this 
release.

https://documentation.conga.com/display/CLM/.Configuring+OCC+Access+Modes+and+Sharing+Settings+vSpring-21


CLM

109
 

Copyright ©2022 Apttus Corporation. All rights reserved.
 

•
•

•
•
•
•
•
•

Document Topic Description

Conga CLM on Salesforce 
Lightning

Modified topic. Added details about the 
new action panel.

Reviewing an Agreement 
Created by Intelligent 
Discovery in Classic

Modified topic. Added details about:

Importing large files
Accessing highlighted, non- 
highlighted, and processed 
documents that are retrieved 
from Kira.

Activating an Agreement Modified topic. Added details about 
skipping steps during activation.

Sending an Agreement 
Document for Parallel Review

Modified topic. Added details about:

Canceling review
Uploading a reviewed document
Refreshing review cycle status
Ending review
Sending large files for review
Retaining file name for the 
merged document

Sending an Agreement 
Document for Review

Modified topic. Updated configuration 
steps.

Activating an Agreement Modified topic. Added details about 
skipping steps during activation and 
updated configuration steps.

Importing an Offline Document Modified topic. Updated configuration 
steps.

Importing Supporting 
Documents

Modified topic. Updated configuration 
steps.

Working with Different UI Modes New topic. A new feature for this 
release.

https://documentation.conga.com/display/CLM/.Reviewing+an+Agreement+Created+by+Intelligent+Discovery+in+Classic+vSpring-21
https://documentation.conga.com/display/CLM/.Working+with+Different+UI+Modes+vSpring-21


CLM

110 Copyright ©2022 Apttus Corporation. All rights reserved.
 

Document Topic Description

Launching Documents Modified topic. Added details about 
access modes. Removed content 
related to document protection.

Accepting or Rejecting 
Suggestions in Documents

Modified topic. Renamed the 
topic. Added details about access 
modes. Removed content related to 
document protection.

Working with Comments Modified topic. Added details about 
access modes. Removed content 
related to document protection.

Working with Smart Data Modified topic. Added details about 
access modes. Removed content 
related to document protection.

Working with Clause Library Modified topic. Added details about 
access modes. Removed content 
related to document protection.

Publishing Documents Modified topic. Added details about 
access modes. Removed content 
related to document protection.

Limitations Modified topic. Added new limitations.

FAQs Modified topic. Added new FAQs.

Searching Agreement 
Documents

Modified topic. Updated configuration 
steps.

Uploading Signed Documents Modified topic. Updated configuration 
steps.

Finalizing an Agreement Modified topic. Updated configuration 
steps.

https://documentation.conga.com/display/CLM/.Launching+Documents+vSpring-21
https://documentation.conga.com/display/CLM/.Accepting+or+Rejecting+Suggestions+in+Documents+vSpring-21
https://documentation.conga.com/display/CLM/.Working+with+Comments+vSpring-21
https://documentation.conga.com/display/CLM/.Working+with+Smart+Data+vSpring-21
https://documentation.conga.com/display/CLM/.Working+with+Clause+Library+vSpring-21
https://documentation.conga.com/display/CLM/.Publishing+Documents+vSpring-21
https://documentation.conga.com/display/CLM/.Limitations+vSpring-21
https://documentation.conga.com/display/CLM/.FAQs+vSpring-21
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Generating an Agreement Modified topic. Updated configuration 
steps.

Reviewing an Agreement 
Created by Intelligent 
Discovery

New topic. A new feature for this 
release.

Reviewing an Agreement 
Created by Intelligent 
Discovery in Classic

Modified topic. Updated configuration 
steps. Renamed Intelligent Import as 
Intelligent Discovery.

Working with Offline 
Agreements

Modified topic. Renamed Intelligent 
Import as Intelligent Discovery.

Creating an Offline Agreement Modified topic. Renamed Intelligent 
Import as Intelligent Discovery.

Importing an Offline Document Modified topic. Renamed Intelligent 
Import as Intelligent Discovery.

Storing an Executed Agreement Modified topic. Renamed Intelligent 
Import as Intelligent Discovery.

Supported File Sizes in Lightning New topic. A new feature for this 
release.

Supported File Sizes in Classic Modified topic. Renamed topic.

Summer '20

Document Topic Description

Summer '20 (Rev A) Admin Entries   Modified topic. 
Added APTS_XAAddInLoadType 
admin entry. 

Package Multiple Documents Modified topic. Added details about 
RetainInputHeaderFooter and 
CumulativePageNumber 
parameters.

https://documentation.conga.com/display/CLM/.Reviewing+an+Agreement+Created+by+Intelligent+Discovery+in+Classic+vSpring-21
https://documentation.apttus.com/display/CMSFSUM20AG/Admin+Entries
https://documentation.conga.com/display/CLM/Package+Multiple+Documents
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Summer '20 
 
 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 
 
 
 

Configuring Documents Tab in 
Lightning

New topic. A new feature for this 
release.

Configuring Document Action 
Column in Classic

New topic. A new feature for this 
release.

Admin Entries Modified topic. Added the following 
admin entries:

APTS_CustomLinksForActionP 
anel
APTS_TemplateSelectionGuid 
ance

Comply System Properties Modified topic. Added the following 
comply system properties:

Enable Online Contract 
Collaboration
Intelligent Import for Signed 
Document

Mapping Clauses and Fields to 
Provisions

New topic. A new feature for this 
release.

Configuring Intelligent Import 
Settings

Modified topic. Added details about 
new fields.

Mapping Provisions to Project- 
Record Type

New topic. A new feature for this 
release.

Configuring Columns in the 
Template Selection Page in 
Lightning

New topic. A new feature for this 
release.

Configuring the Availability of 
the Upload Signed Document 
Button

New topic. A new feature for this 
release.

https://documentation.apttus.com/display/CMSFSUM20AG/Configuring+Documents+Tab+in+Lightning
https://documentation.apttus.com/display/CMSFSUM20AG/Configuring+Document+Action+Column+in+Classic
https://documentation.conga.com/display/CLMSPR21/Admin+Entries
https://documentation.apttus.com/display/CMSFSUM20AG/Comply+System+Properties
https://documentation.conga.com/display/CLM/.Mapping+Clauses+and+Fields+to+Provisions+vSpring-21
https://documentation.apttus.com/display/CMSFSUM20AG/Configuring+Intelligent+Import+Settings
https://documentation.conga.com/display/CLMSPR21/Mapping+Provisions+to+Project-Record+Type
https://documentation.apttus.com/display/CMSFSUM20AG/Configuring+Columns+in+the+Template+Selection+Page+in+Lightning
https://documentation.apttus.com/display/CMSFSUM20AG/Configuring+the+Availability+of+the+Upload+Signed+Document+Button
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Prerequisites Modified topic. Added details 
about:

Configuring email templates 
for intelligent import
Order of configuring IDE 
objects

Online Contract Collaboration New section. A new feature for this 
release.

Importing Supporting Document New topic. A new feature for this 
release.

Merging Documents in Lightning New topic. A new feature for this 
release.

Generating an Agreement Modified topic. Added details about 
Document Type.

Importing an Offline Agreement Modified topic. Added details 
about:

Document Type
Agreement status

Creating an Offline Agreement Modified topic. Added details 
about:

Document Type
Agreement status

Storing an Executed Agreement Modified topic. Added details about 
Document Type.

Finalizing an Agreement Modified topic. Added details about 
Document Type.

Running Wizards in Lightning Modified topic. Added details about 
Document Type.

https://documentation.apttus.com/display/CMSFSUM20AG/Prerequisites
https://documentation.conga.com/display/CMSFSUM20UG/Online+Contract+Collaboration
https://documentation.conga.com/display/CMSFSUM20UG/Importing+Supporting+Document
https://documentation.conga.com/display/CMSFSUM20UG/Merging+Documents+in+Lightning
https://documentation.conga.com/display/CMSFSUM20UG/Generating+an+Agreement
https://documentation.conga.com/display/CMSFSUM20UG/Importing+an+Offline+Document
https://documentation.conga.com/display/CMSFSUM20UG/Creating+an+Offline+Agreement
https://documentation.conga.com/display/CMSFSUM20UG/Storing+an+Executed+Agreement
https://documentation.conga.com/display/CMSFSUM20UG/Finalizing+an+Agreement
https://documentation.conga.com/display/CMSFSUM20UG/Running+Wizards+in+Lightning
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Reviewing an Agreement 
Created by Intelligent Import

Modified topic. Added details about 
enhancements to:

Document viewer
Agreement status

Uploading Signed Documents Modified topic. Added details 
about:

Version update after 
uploading the signed 
document
Intelligently importing signed 
documents

Activating an Agreement Modified topic. Added details about 
restrictions on deleting executed 
documents.

Sending an Agreement 
Document for Parallel Review

Modified topic. Added the details 
about:

Email notification after 
canceling review
Ending a parallel review 
without document
Restriction for parallel review

Subscribing to Document Lock 
Release Notification

New topic. Added the details 
about subscribeToDocumentLock  
API.

Merging Documents New topic. Added the details about 
the mergeDocuments API.

Sending a Document for 
Signatures

New topic. Added the details about 
the sendForSignature API.

https://documentation.conga.com/display/CMSFSUM20UG/Reviewing+an+Agreement+Created+by+Intelligent+Import
https://documentation.conga.com/display/CMSFSUM20UG/Activating+an+Agreement
https://documentation.conga.com/display/CMSFSUM20UG/Sending+an+Agreement+Document+for+Parallel+Review
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Integrating Conga CLM with 
External Systems

A new topic for external 
integrations using the Conga 
CLM SOAP API.

Activating Agreements Updated topic to include API 
signature and SOAP Response/ 
Request XML for API integration.

Publishing Document Outside of 
Salesforce 

Updated topic to include API 
signature and SOAP Response/ 
Request XML for API integration.

Publishing the Document to 
Chatter

Updated topic to include API 
signature and SOAP Response/ 
Request XML for API integration.

Publishing the Document to Files 
and Attachments

Updated topic to include API 
signature and SOAP Response/ 
Request XML for API integration.

Selecting a Template for the 
Agreement Document

Updated topic to include API 
signature and SOAP Response/ 
Request XML for API integration.

Terminating Agreements Updated topic to include API 
signature and SOAP Response/ 
Request XML for API integration.

Updating Smart Fields Updated topic to include API 
signature and SOAP Response/ 
Request XML for API integration.

Adding Header and Footer Text 
with Document Protection

Updated topic to include API 
signature and SOAP Response/ 
Request XML for API integration.

Adding Header and Footer Text 
without Document Protection

Updated topic to include API 
signature and SOAP Response/ 
Request XML for API integration.

https://documentation.conga.com/display/CLM/Activating+Agreements
https://documentation.conga.com/display/CLM/Updating+Smart+Fields
https://documentation.conga.com/display/CLM/Adding+Header+and+Footer+Text+with+Document+Protection
https://documentation.conga.com/display/CLM/Adding+Header+and+Footer+Text+without+Document+Protection
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Document Topic Description

Applying Security Parameters to 
a PDF

Updated topic to include API 
signature and SOAP Response/ 
Request XML for API integration.

Converting a Word Document 
into a given output format

Updated topic to include API 
signature and SOAP Response/ 
Request XML for API integration.

Converting a Word Document 
into a PDF

Updated topic to include API 
signature and SOAP Response/ 
Request XML for API integration.

Converting a Word Document 
into a PDF for Standard Objects

Updated topic to include API 
signature and SOAP Response/ 
Request XML for API integration.

Enabling Authoring for 
Agreement Documents

Updated topic to include API 
signature and SOAP Response/ 
Request XML for API integration.

Generating a Document Updated topic to include API 
signature and SOAP Response/ 
Request XML for API integration.

Generating a Document for a 
Standard Object

Updated topic to include API 
signature and SOAP Response/ 
Request XML for API integration.

Generating a Document on 
Submit Request

Updated topic to include API 
signature and SOAP Response/ 
Request XML for API integration.

Generating a Document on 
Submit Request for a Standard 
Object

Updated topic to include API 
signature and SOAP Response/ 
Request XML for API integration.

Generating a Supporting 
Document

Updated topic to include API 
signature and SOAP Response/ 
Request XML for API integration.

https://documentation.conga.com/display/CLM/Applying+Security+Parameters+to+a+PDF
https://documentation.conga.com/display/CLM/Converting+a+Word+Document+into+a+given+output+format
https://documentation.conga.com/display/CLM/Converting+a+Word+Document+into+a+PDF
https://documentation.conga.com/display/CLM/Converting+a+Word+Document+into+a+PDF+for+Standard+Objects
https://documentation.conga.com/display/CLM/Enabling+Authoring+for+Agreement+Documents
https://documentation.conga.com/display/CLM/Generating+a+Document
https://documentation.conga.com/display/CLM/.Generating+a+Document+for+a+Standard+Object+vWinter-20
https://documentation.conga.com/display/CLM/Generating+a+Document+on+Submit+Request
https://documentation.conga.com/display/CLM/Generating+a+Document+on+Submit+Request+for+a+Standard+Object
https://documentation.conga.com/display/CLM/Generating+a+Supporting+Document
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Agreement Web Service

Document Topic Description

Generating a Supporting 
Document on Submit Request

Updated topic to include API 
signature and SOAP Response/ 
Request XML for API integration.

Merging Multiple Documents to 
a PDF with PDF Protection

Updated topic to include API 
signature and SOAP Response/ 
Request XML for API integration.

Merging Multiple Documents to 
a PDF without PDF Protection

Updated topic to include API 
signature and SOAP Response/ 
Request XML for API integration.

Creating PDF Updated topic to include API 
signature and SOAP Response/ 
Request XML for API integration.

Merging Proposal Documents 
into a single PDF Document

Updated topic to include API 
signature and SOAP Response/ 
Request XML for API integration.

Package Multiple Documents Updated topic to include API 
signature and SOAP Response/ 
Request XML for API integration.

Initiating Parallel Review Updated topic to include API 
signature and SOAP Response/ 
Request XML for API integration.

Ending Parallel Review Updated topic to include API 
signature and SOAP Response/ 
Request XML for API integration.

Getting Word Document 
Information for Parent with Files

Updated topic to include API 
signature and SOAP Response/ 
Request XML for API integration.

Updated topic to include 
namespace information for 
Contract Management Web 
Services.

https://documentation.conga.com/display/CLM/Generating+a+Supporting+Document+on+Submit+Request
https://documentation.conga.com/display/CLM/Merging+Multiple+Documents+to+a+PDF+with+PDF+Protection
https://documentation.conga.com/display/CLM/Merging+Multiple+Documents+to+a+PDF+without+PDF+Protection
https://documentation.conga.com/display/CLM/Creating+PDF
https://documentation.conga.com/display/CLM/Merging+Proposal+Documents+into+a+single+PDF+Document
https://documentation.conga.com/display/CLM/Package+Multiple+Documents
https://documentation.conga.com/display/CLM/Initiating+Parallel+Review
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Merge Web Service

Author Web Service

Document Topic Description

Updated topic to include 
namespace information for 
Contract Management Web 
Services.

Updated topic to include 
namespace information for 
Contract Management Web 
Services.

Spring '20

Document Topic Description

Spring 2020 (Rev E) Assigning Custom 
Permissions to User 
Profiles

New topic.

Admin Entries   Modified topic. Added the following admin 
entries:

APTS_ProfilePermissions
APTS_DoNotCopyOpportunityToAd 
obeAgreement.

Spring 2020 (Rev D) Configuring Email Service 
for Ending Review by 
Email

Updated configuration steps.

Spring 2020 (Rev C) PDF Security for 
Agreement Documents

Modified topic. Added PDF security details 
when the document is checked-in from X- 
Author Contracts.

Admin Entries   Modified topic. 
Added APTS_ComplyConfig .

Intelligently Importing 
Large Files in Lightning

Modified topic. Added details about 
storing executed documents.

https://documentation.conga.com/display/CMSFSPR20AG/Assigning+Custom+Permissions+to+User+Profiles
https://documentation.conga.com/display/CMSFSPR20AG/Admin+Entries
https://documentation.conga.com/display/CMSFSPR20AG/Configuring+Email+Service+for+Ending+Review+by+Email
https://documentation.conga.com/display/CMSFSPR20AG/PDF+Security+for+Agreement+Documents
https://documentation.conga.com/display/CMSFSPR20AG/Admin+Entries
https://documentation.conga.com/display/CMSFSPR20UG/Intelligently+Importing+Large+Files+in+Lightning
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Document Topic Description

  

Spring 2020 (Rev B) 
 
 
 
 
 

Installing Contract 
Management

Minor updates to this topic.

Configuring Wizard as a 
Related Tab

New topic.

Supported File Size New topic. 

Creating Steps from the 
Wizard Designer

Modified topic. Added information about 
the two-column layout. 

Configuring Two Column 
Layout

New topic. A new feature for this release.

Running Wizards in 
Lightning

Modified topic. Added a prerequisite about 
configuring Wizard as a Related Tab.

Uploading Signed 
Documents in Lightning

Modified topic. Added a note for Document 
Version Support for Signed Documents.

Finalizing an Agreement Modified topic. Added a note for Document 
Version Support for Signed Documents.

Spring 2020 (Rev A) Configuring Intelligent 
Import Settings

Modified topic. Added the information that 
the Kira setting name is case sensitive. 

Comply System 
Properties

Modified topic. Added URL for the XAJS 
Endpoint property.

Supported File Size New topic.

Spring 2020 Setting Up Salesforce 
and Kira Single Sign-on

New topic. A new feature for this release.

Creating Steps from the 
Wizard Designer

Modified topic. Added information 
regarding the two-column layout.

https://documentation.conga.com/display/CMSFSPR20AG/Installing+Contract+Management
https://documentation.conga.com/display/CMSFSPR20AG/Configuring+Wizard+as+a+Related+Tab
https://documentation.conga.com/display/CMSFSPR20AG/Supported+File+Size
https://documentation.conga.com/display/CMSFSPR20AG/Creating+Steps+from+the+Wizard+Designer
https://documentation.conga.com/display/CMSFSPR20AG/Configuring+Two+Column+Layout
https://documentation.conga.com/display/CMSFSPR20UG/Running+Wizards+in+Lightning
https://documentation.conga.com/display/CMSFSPR20UG/Uploading+Signed+Documents+in+Lightning
https://documentation.conga.com/display/CMSFSPR20UG/Finalizing+an+Agreement
https://documentation.conga.com/display/CMSFSPR20AG/Configuring+Intelligent+Import+Settings
https://documentation.conga.com/display/CMSFSPR20AG/Comply+System+Properties
https://documentation.conga.com/display/CMSFSPR20UG/Supported+File+Size
https://documentation.conga.com/display/CLMSPR21/Setting+Up+Salesforce+and+Kira+Single+Sign-on
https://documentation.conga.com/display/CLMSPR21/Creating+Steps+from+the+Wizard+Designer
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Document Topic Description

Providing Access to Run 
Wizards

New topic. Added missing information.

Adding Wizard Launcher 
Tab in Lightning

New topic. A new feature for this release.

Installing Conga CLM Modified topic. Added a prerequisite about 
Apttus Base Library.

Upgrading Conga CLM New topic. Added information about how 
to upgrade Contract Management.

Translating X-Author 
Contracts User Interface

New topic. A new feature for this release.

Use Case: Translating X- 
Author Contracts User 
Interface

New topic. A new feature for this release.

Setting Up Lite User 
License

New topic. A new feature for this release.

Configuring Intelligent 
Import Fields

New topic. Added missing topic.

Comply System 
Properties

Added the following comply system 
properties:

CLM Lite License Profile(s)
CLM Lite License Admin Email
Email Lite Monitoring Report to 
Apttus?
Inactivate Non-Compliant Lite User
Ancestor Selection For Import 
Offline
Asynchronous Checkin Recipient
Auto Enable Asynchronous Checkin
XAJS End Point

https://documentation.conga.com/display/CLMSPR21/Providing+Access+to+Run+Wizards
https://documentation.conga.com/display/CLMSPR21/Adding+Wizard+Launcher+Tab+in+Lightning
https://documentation.conga.com/display/CLMSPR21/Installing+Conga+CLM
https://documentation.conga.com/display/CLMSPR21/Upgrading+Conga+CLM
https://documentation.conga.com/display/CLMSPR21/Translating+X-Author+Contracts+User+Interface
https://documentation.conga.com/display/CMSFSPR20AG/Use+Case%3A+Translating+X-Author+Contracts+User+Interface
https://documentation.conga.com/display/CMSFSPR20AG/Setting+Up+Lite+User+License
https://documentation.conga.com/display/CMSFSPR20AG/Configuring+Intelligent+Import+Fields
https://documentation.conga.com/display/CMSFSPR20AG/Comply+System+Properties
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Document Topic Description

Configuring Intelligent 
Discovery Settings

Updated navigation per Lightning UI. 
Added details 
about retrieveHighlightedDocument 
and DeleteDocumentFromKira.

Mapping Provisions to 
Project-Record Type

Updated navigation per Lightning UI

Uploading Signed 
Documents 

New topic. A new feature for this release.

Clause Versioning Modified topic. Added a table for clause 
status after each agreement action.

Intelligently Importing 
Large Files in Lightning

New topic. A new feature for this release.

Reviewing an Agreement 
Created by Intelligent 
Discovery in Classic

Modified topic. Add details regarding date 
and currency fields,

Running Wizards in 
Lightning

New topic. A new feature for this release.

Package Multiple 
Documents

Modified topic. Added the following 
parameters:

RetainInputHeaderFooter
CumulativePageNumber

Winter '19

https://documentation.conga.com/display/CLMSPR21/Configuring+Intelligent+Discovery+Settings
https://documentation.conga.com/display/CMSFSPR20AG/Mapping+Provisions+to+Record+Types
https://documentation.conga.com/display/CMSFSPR20UG/Uploading+Signed+Documents+in+Lightning
https://documentation.conga.com/display/CMSFSPR20UG/Clause+Versioning
https://documentation.conga.com/display/CMSFSPR20UG/Intelligently+Importing+Large+Files+in+Lightning
https://documentation.conga.com/display/CLM/.Reviewing+an+Agreement+Created+by+Intelligent+Discovery+in+Classic+vSpring-21
https://documentation.conga.com/display/CLM/Package+Multiple+Documents
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Document Topic Description

Winter 2019 
 
 
 
 
 
 
 
 
 

Admin Objects Modified topic. Added the following admin 
objects:

APTS_AccountHierarchyFields
APTS_DocumentSearchBasicFilter
APTS_InEffectViewMetadataFields

Contract Management 
with Salesforce Lightning

Modified topic. Added content for 
Salesforce Lightning Console support.

Comply System Properties Modified topic. Added Override Playbook 
default filter comply system property.

Adding Custom Locale New topic. A new feature for this release.

Configuring MS Teams 
Setting

New topic. A new feature for this release.

Adding Agreement 
Hierarchy Button for 
Accounts

New topic. A new feature for this release.

Adding Agreement 
Hierarchy Button

New topic. A new feature for this release.

Adding In-Effect View 
Button

New topic. A new feature for this release.

Configuration to Email 
Multiple Agreement 
Documents in Lightning

New topic. A new feature for this release.

Agreement Fields Modified topic. Added Executed Date field 
details.

Configuring 
APTS_ComplyConfig

Modified topic. Added new cloning 
specifications for Renew, Amend, and 
Clone.
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Document Topic Description

Sending an Agreement 
Document for Parallel 
Review

Modified topic. Added a prerequisite for 
tracking review status from X-Author 
Contracts.

Sending an Agreement 
Document for Microsoft 
Teams Review

New topic. A new feature for this release.

Emailing Multiple 
Agreement Documents

Modified topic. Added a note for the 
recommended maximum file size.

Searching Agreement 
Documents

Modified topic. Added new Basic Search 
filters.

Agreement Fields Modified topic. Added new field details.

Generating an Agreement Modified topic. Added content for changes 
in agreement clauses status.

Reviewing an Agreement 
Created by Intelligent 
Import

Modified topic. Added content for changes 
in agreement clauses status.

Finalizing an Agreement Modified topic. Added content for changes 
in agreement clauses status.

Contract Management 
with Salesforce Lightning

Modified topic. Added content for 
Salesforce Lightning Console support.

Accessing In-Effect View New topic. A new feature for this release.

Activating an Agreement Modified topic. Added a restriction for 
activating an agreement.

Clause Versioning New topic. A new feature for this release.

Merging Multiple 
Documents to a PDF

Modified topic.

Terminating Agreements New topic.
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Summer '19

Document Topic Description

Summer 2019 (Rev A) Managing Agreement Lifecycle Post- 
Activation 

Modified topic.

Summer 2019 
 
 
 

Configuring Agreement Hierarchy 
Page Header

New topic. 

Custom Permissions Modified topic.

Comply System Properties Modified topic.

Configuring Email Service for Ending 
Review by Email

New topic.

Admin Objects Modified topic.

Viewing Agreement Hierarchy New topic.

Searching Agreement Documents New topic.

Sending an Agreement Document for 
Parallel Review

New topic.

Finalizing an Agreement Modified topic.

Initiate Parallel Review New topic.

End Parallel Review New topic.

Spring '19

Document Topic Description

Spring 2019 
 
 

Scheduling Expiration Date for 
Email Downloadable Link

Added a new topic for scheduling the 
expiration date for email 
downloadable link
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Document Topic Description

Admin Objects Added the following admin objects:

APTS_RecordTypeUpdateOnAme 
nd 
APTS_EnableValidationForEmail 
WithoutUserContact 

Comply System Properties Added the Allow Regenerate From XAC 
comply system property

Managing Offline Agreements Updated the topic with  uploading 
offline documents in any file format

Reviewing an Agreement Created 
by Intelligent Import

Updated the topic with:

Sending highlighted or 
unhighlighted documents for 
review
Details on the OCR Quality field 
on the Document Viewer
Information on Review Offline 
Document Status Popup
Adding a clause when reviewing 
an offline document

Emailing Multiple Agreement 
Documents

Added a new topic for sending a 
downloadable link for downloading 
multiple documents.

Callback Classes Added Contract Management 
callback classes.

Winter '18

Document Topic Description

Winter 2018 
 

Managing Offline Agreements Added new section for intelligent data 
extraction feature
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Document Topic Description

Configuring 
APTS_ComplyConfig

Updated topic with how to configure 
separate clone specifications for each 
record type

Defining Naming Convention for 
Different Record Types

Added a new topic for defining the 
naming convention for different record 
types feature

Working with Offline 
Agreements

Added a new section for the intelligent 
data extraction feature.

Summer '18

Document Topic Description

Summer 2018 
 

Adding and Defining Action Panel New topic. New feature for this 
release.

Admin Objects Updated the topic with the new 
admin object 
APTS_CustomLinksforActionPanel.

Comply System Properties Updated the topic with the new 
system property Unlock Smart 
Elements.

Creating an Agreement Updated the topic with information 
on the action panel in classic mode 
for community portals.
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CLM for Administrators
This section describes how Conga Contract Lifecycle Management (Conga CLM) works and 
how to manage your organization's and your customers' contracts.

Topic Description

What's Covered This section is designed to provide administrators, involved with the 
contracting process in your organization, with information on 
configuring and setting up Conga CLM. This section covers the most 
common use cases for the Conga CLM Administration and assumes 
a level of familiarity with basic Salesforce. See Salesforce 
documentation for details on standard Salesforce functionality.

Primary Audience Conga CLM Administrator, Contract Manager, Legal Team, 
Contracts Administrator, Template Administrator, Template 
Designer

IT Environment Refer to the latest Conga CLM Release Notes for information on 
System Requirements and Supported Platforms.

Updates For a comprehensive list of updates to this section for each release, 
see the What's New in CLM Documentation topic.

Other Resources Refer to the X-Author for Contracts documentation for detailed 
instructions on setting up templates and editing agreement 
documents.

Before using Contract Management, you must be familiar with the following:

Basic Salesforce administration
Salesforce and Conga CLM terms and definitions

This section describes the following tasks: 

Setting up the Conga CLM application
Managing agreement lifecycle
Configuring agreement document protection
Versioning contract documents
Securing agreement documents
Reporting using agreement explorer
Configuring contract wizard

Select one of the following topics for more information:
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1.

Setting Up Conga CLM
Configuring the CLM User Interface
User Profile Management
Application Management Settings
Managing Templates
Agreement Lifecycle Management
Managing Workflow
Migrating Attachments to Files
Configuring Agreement Document Protection
Versioning Contract Documents
Retention Policies
Contract Wizard
Contract Lifecycle Management with Salesforce Lightning
Appendices

Setting Up Conga CLM
Select one of the following topics for more information:

Pre-installation Settings
Installing Conga CLM
Registering for Conga Upgrade Program
Post-installation Settings
Upgrading Conga CLM
Logging in to Contract Management

Pre-installation Settings
Before you install Conga CLM package, you must enable Salesforce CRM content in your 
organization.

To enable Salesforce CRM content
Conga CLM uses Chatter Files functionality, which requires Salesforce CRM Content to be 
enabled before installing the Contract Management package. Ensure this setting is 
enabled before installing the Conga CLM package because it impacts migration.

Login to Salesforce.com.

http://salesforce.com/
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2.

3.
4.

Go to Setup > Customize > Salesforce Files > Settings > Salesforce CRM Content and 
click Edit.
Select the Enable Salesforce CRM Content checkbox.
Click Save. Salesforce CRM Content is enabled. 
You can now install the Contract Management package.

Installing Conga CLM
You can install Conga CLM from the Customer Success Portal.

Install the packages in the following order:

Order Package Required?

1 Conga Base Library  Yes

2 Conga Contract Management  Yes

3 Conga Content Integration  Yes

Install the following packages if you use Adobe Sign:

4 Adobe Sign  Yes, if you are using Adobe Sign.

5 Conga Contract EchoSign Integration  Yes, if you are using Adobe Sign.

Install the following packages if you use DocuSign:

4 Conga DocuSign API  Yes, if you are using DocuSign.

5 Conga Contract DocuSign Integration  Yes, if you are using DocuSign.

If you are installing CLM for the first time, you can see the new logo and icons that 
are part of rebranding from Apttus to Conga.



The Conga Upgrade Program is an automated tool that upgrades packages 
available in your Salesforce org (Production or Sandbox) to the latest versions. In 
addition, it ensures all the Conga published managed packages are on the latest 
versions for the registered orgs. To register your org for push upgrade, 
see Registering for Conga Upgrade Program.
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2.

3.
4.

•
•

5.
6.
7.

8.

•

•

9.
10.

To install Conga CLM packages
You must have login credentials.

Go to the Resources > Install Center tab on the Community Portal.
In My Packages navigation window, you can see Conga Contract Lifecycle 
Management. Click the Details link to access the VERSION drop-down and select the 
version that you want to install.
Click Install Version.
Select the environment in which you want to install the packages. 

Click Install in Production to install the packages in your production org.
Click Install in Sandbox to install the packages in your sandbox org.

In the Salesforce login screen, enter your login credentials and click Log In.
Enter the Password provided.
Select the profile for which you want to install the package. You are recommended to 
select Install for All Users.
To Install for Specific Profiles, you must define the access level for all profiles. Select 
from one of the following options.

No Access - This is the default setting. Apply this access level to disable all 
object permissions.
Full Access - Apply this access level to assign users permissions to Read, Create, 
Edit, Delete, View All, and Modify All for all objects.

Click Set. 
Click Install. 

A message is displayed indicating the installation is underway. Once installed, repeat this 
procedure for each of the packages.

Conga CLM is successfully installed in your selected environment. Complete the post- 
installation settings.

While installing a Conga package, if you see an “Approve Third-Party Access” 
prompt, select the Yes, grant access to these third-party web sites check box and 
click Continue.
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9.
10.

11.

Registering for Conga Upgrade Program
You can register your org for Conga Upgrade Program to auto-upgrade Conga managed 
packages. Conga Upgrade Program supports upgrading from the Spring '18 release or later 
to the latest major release (n) or previous two major releases (n – 1 or n – 2). 

To register your org with Conga Upgrade Program for 
auto-upgrade
This section provides a high-level flow of the org registration process and early feedback 
programs. Refer to Conga Upgrade Program documentation for a comprehensive overview 
of features.

Launch the Conga Upgrade Program's registration page. 
Select your Salesforce org type (Production or Sandbox). The Salesforce login page is 
displayed.
Enter your credentials and click Login. You are redirected to the connected app 
called Conga Push Upgrade CA, which prompts you to allow access to the org 
information.
Click Allow. The org registration form is displayed. 
Click Set Package Access Control to set the accessibility for Conga packages to be 
upgraded with Conga Upgrade Program.
Click Submit.  
The Early Feedback pop-up is displayed. In addition, Conga sends an email 
notification to the system administrator on successful registration with a list of 
packages (including dependent packages, if any) handled in the upgrade process. 

Click Try Now. A Conga Automation Dashboard is displayed with a Quick Guide pop- 
up. Click Yes to go through the quick tour of the dashboard.
Click Click to see the test to view a list of tests to be executed for your org, A List of 
Tests pop-up is displayed.
Enter your Email ID and Organization Name. You can enter multiple email ids. 
Click Trigger Welcome Email. Conga sends a welcome email to the email ids entered 
in the previous step with a list of tests performed in the early feedback program.
Click Proceed. A Conga Services Test Automation Execution Page is displayed. 

The early feedback program executes a test suite to check if the 
customizations in your org are compatible with the upgrade. For more 
information, see the Conga Automation Early Feedback program.



https://pushupgrades.congacloud.com
https://documentation.conga.com/push-upgrade/summer-21/conga-automation-early-feedback-program-152572477.html
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2.

Click the checkbox next to the Job ID and click Begin Test Execution to run the 
predefined automated test suite against your org. 

For the latest information on Conga Upgrade Program, see Conga Upgrade Program 
documentation.

Post-installation Settings
After installing Conga CLM, configure admin settings and system properties to meet the 
business objectives of your implementation.

Admin Custom Object Entries
Customize the Comply System Properties settings

If there are any issues with your installation, verify all of the objects were installed as 
expected. If you have too many agreement records, you can index the agreement number.

Creating or Verifying Administration Entries

Admin entries have different values and you can use them for different purposes. See 
Appendix A for a list of all the admin settings available in the system. The fields that are 
displayed in the Recent Admin list are determined by the following view settings:

Recent Admin Entry View Setting Description

Recently Viewed The most recent custom Admin entries or records you 
viewed, with the most recently viewed item listed first. 
This list is derived from your recent items and includes 
records owned by you and other users.

Recently Created The last ten or twenty-five Admin entries or records you 
created, with the most recently created item listed first. 
This list only includes records owned by you.

Recently Modified The last ten or twenty-five Admin entries or records you 
updated, with the most recently updated item listed first. 
This list only includes records owned by you.

 To create or verify admin entries

Click + and click Admin. All the out-of-the-box Admin entries are displayed on the 
Admin home page. Based on your organizations' requirement, you may want to add or 
create new Admin entries.
To create a new Admin entry, click New.

https://documentation.conga.com/push-upgrade/2022.4.0/conga-upgrade-program-193698855.html


CLM

133
 

Copyright ©2022 Apttus Corporation. All rights reserved.
 

3.

1.
2.
3.
4.

1.
2.

•
•

•
•

•
•

•

Type Name, Value, and Code for the Admin entry and click Save.

Your new Admin entry is saved and added.

Customizing the Comply System Properties Settings

System Properties describes the configuration of the working environment and allows you 
to customize your system settings. Use custom settings to create and manage custom data 
at the organization, profile, and user levels. Custom settings data is stored in the 
application cache that you can access efficiently, without the cost of repeated queries.

To use the Comply System Properties custom setting, create a dataset named System 
Properties.

To customize the comply system properties settings

Go to Setup > App Setup > Develop > Custom Settings.
Click Manage for Comply System Properties and click New.
In Name, type System Properties as the data set name.
Enter details in one or more of the required fields and click Save.

You have customized the comply system properties settings.

Verifying Conga CLM Package Objects

Conga CLM is installed with several objects which are used to control the behavior of an 
application.

Go to Setup > Create > Objects.
Verify that the Conga CLM objects are displayed on the Custom Objects page.

Indexing Agreement Number

If there are too many agreement records in your org environment and you query excessive 
amount of data (for example, 100000 agreement records), or initiate actions such as 
Amend/Renew, theSOQL_EXECUTE_BEGINerror is displayed. This is because the Agreement 
Number field is not indexed.

Contact SFDC support to index Agreement_Number__c field on the Agreement object, as 
you cannot index any field out-of-the-box except for those indexed by Salesforce. By 
default, Salesforce indexes the following fields:

Primary Keys
For example, ID, Name, and Owner.

Foreign Keys
For example, look-up, or master-detail relationship fields.

Audit Dates
For example, LastModifiedDate.

Custom Fields
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For example, External ID, Unique.

Upgrading Conga CLM
This section provides information on upgrading Conga CLM to the latest version from the 
previous two releases. 

Preparing for Upgrade
Before you upgrade to Conga CLM December '21, you must ensure the following:

You go through Conga CLM on Salesforce Feature by Release to know about the new 
features, enhancements, and deprecated features in Conga CLM since your 
existing release. After you upgrade Conga CLM to December '21, you cannot roll back 
to any previous release.
You have System Requirements and Supported Platforms. 
You have access to the Install Center on the Community Portal.
You have administrator privileges to your Salesforce org.
It is recommended that you back up all your configurations. 

Upgrading to Conga CLM December '21
This section describes step-by-step instructions to upgrade from Spring '21 and Summer '21 
to December '21.

Regardless of your current Conga CLM version, you can upgrade to the latest 
version. If you have not installed Conga CLM, you can contact Support to request 
an installation link, then perform the standard installation as described in Installing 
Conga CLM. 



The Conga Push Upgrade is an automated tool that upgrades packages available 
in your Salesforce org (Production or Sandbox) to the latest versions. In addition, it 
ensures all the Conga published managed packages are on the latest versions for 
the registered orgs. To register your org for push upgrade, see Registering for Conga 
Push Upgrade.



https://documentation.conga.com/display/CLM/.Winter+%2720+Release+Notes+vSummer-21
https://community.conga.com/
https://documentation.conga.com/display/CLM/.Registering+for+Conga+Push+Upgrade+vWinter-20
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Upgrading Conga CLM from Summer '21 to December '21
Go to Setup > Installed Packages and ensure that your current Salesforce org has the 
following Summer '21 packages installed. Also, ensure that you have the following 
packages and dependent packages to upgrade to December '21. These packages are 
required to utilize the new features and enhancements of December '21.

Order Product Summer '21

Upgrade Version 
(Name | Number)

December '21

Upgrade Version 
(Name | Number)

1 Conga Base Library  2.1.0203 | 2.203  2.2.223 | 2.223

2 Conga Contract Lifecycle 
Management 

12.1.0630 | 12.630 12.2.0654 | 12.654

3 Conga Content 
Integration

8.1.0020 | 8.20 8.1.0020 | 8.20

Upgrade the following packages if you use DocuSign:

4 Conga DocuSign API  7.1.0115 | 7.115 7.2.116 | 7.116

5 Conga Contract 
DocuSign Integration

4.1.0046 | 4.46 4.2.48 | 4.48

Upgrade the following packages if you use Adobe Sign:

4 Adobe Sign  23.8 | 23.8 23.14 | 23.14

5 Conga Contract EchoSign 
Integration 

9.1.0066 | 9.66 9.2.69 | 9.69

Perform the upgrade. The upgrade procedure is the same as the installation 
procedure. For detailed information on installing Conga CLM managed packages, see 
Installing Conga CLM.

Upgrading Conga CLM from Spring '21 to December '21
Go to Setup > Installed Packages and ensure that your current Salesforce org has the 
following Spring '21 packages installed. Also, ensure that you have the following 
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packages and dependent packages to upgrade to December '21. These packages are 
required to utilize the new features and enhancements of December '21.

Order Product Spring '21

Upgrade Version 
(Name | Number)

December '21

Upgrade Version 
(Name | Number)

1 Conga Base Library  2.0.150 | 2.150 2.2.223 | 2.223

2 Conga Contract Lifecycle 
Management 

12.0.0605 | 12.605 12.2.0654 | 12.654

3 Conga Content 
Integration

7.0.0016 | 7.16 8.1.0020 | 8.20

Upgrade the following packages if you use DocuSign:

4 Conga DocuSign API  7.0.0110 | 7.110 7.2.116 | 7.116

5 Conga Contract 
DocuSign Integration

4.1.0042 | 4.42 4.2.48 | 4.48

Upgrade the following packages if you use Adobe Sign:

4 Adobe Sign  22.11 | 22.11 23.14 | 23.14

5 Conga Contract EchoSign 
Integration 

9.0.0056 | 9.56 9.2.69 | 9.69

Perform the upgrade. The upgrade procedure is the same as the installation 
procedure. For detailed information on installing Conga CLM managed packages, see 
Installing Conga CLM.

Logging in to Contract Management

Note

It is recommended not to use the Back button of your browser during the entire Contract 
Management Lifecycle.
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To log in 
Apttus Contract Management package must have been installed. You must have Apttus 
provided login credentials.

Go to http://www.salesforce.com/. If your organization is using a sandbox or test 
environment to access Apttus Contract Management, for example, as part of your 
User Acceptance Testing (UAT) process, go to http://test.salesforce.com/.
Click Login.
Type your User Name and Password, and click Login in to Salesforce.

You are successfully logged in to Apttus Contract Management. Navigate to the 
Salesforce.com App Menu, select Apttus Contract Management to access the Contract 
Management tabs. Navigate to the Opportunities or Accounts tab.

 

Configuring the CLM User Interface
Select one of the following topics for more information:

Creating a Page Layout
Creating a Record Type
Configuring a Custom Link for Opportunity
Configuring Custom Links on the Home Page
Customizing Agreement Actions
Adding Agreement Hierarchy Button
Adding In-Effect View Button
Adding the Email Agreement(s) Document(s) Button in Classic
Configuring Agreement Hierarchy Page Header
Configuring the Availability of Custom Buttons
Adding Agreement Hierarchy Button for Accounts
Configuring Documents Tab in Lightning
Configuring Document Action Column in Classic
Hiding Contracts and Templates Tabs in X-Author Contracts for Cloud
Translatable Customizations
Translating X-Author Contracts User Interface
Removing the Path Field
Configuring In-Effect View Page Header
Configuring New Agreement Form Fields
Populating the File Size Field
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Setting Up Quick Search on the Home Page

Creating a Page Layout
A page layout allows you to control the layout and organization of detail and edit pages. 
It also enables you to control which fields, related lists, and custom links users see, on 
detail and edit pages only. Page layouts control the layout and organization of buttons, 
fields, s-controls, Visualforce, custom links, and related lists.

To create a standard page layout, refer to the standard Salesforce Help.

Creating a Record Type
Record types allow you to offer different business processes, picklist values, and page 
layouts to different users. After saving the new record type, you will be able to customize 
the picklist values.

To create a standard record type, refer to the standard Salesforce Help.

User Permissions Needed

To create record types for custom objects: "Customize Application"

Creating an Agreement Record Type
Agreement records type setup allows support for creating and maintaining multiple types 
of agreements.

To Create Agreement Record Types
Go to Setup > Create > Objects.
Click Agreement under the Label column to edit the custom Agreement object. The 
custom object definition details are displayed.
Scroll down to the Record Types objects. To create a new record type, click New.
Select Master from the Existing Record Type drop-down list to copy all available 
picklist values, or select an existing record type to clone its picklist values.
Enter a unique Record Type Label.

https://help.salesforce.com/articleView?id=customize_layoutcreate.htm&type=5
https://help.salesforce.com/articleView?id=creating_record_types.htm&type=5
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Enter a Record Type Name. The Record Type Name refers to the component when 
using the Web services API and prevents naming conflicts on package installation in 
managed packages.
Enter a description.
Select Active to activate the record type.
Select Enable for Profile next to a profile to make the record type available to users 
with that profile. Select the check box in the header row to enable it for all profiles. If 
each profile is associated with a single record type, you will not be prompted to 
select a record type when creating new records.
For enabled profiles, select Make Default to make it the default record type for users 
of that profile. Select the check box in the header row to make it the default for all 
profiles.
Click Next.
Choose a page layout option to determine what page layout displays for records 
with this record type: 

To apply a single page layout for all profiles, select Apply one layout to all 
profiles and choose the page layout from the drop-down list.
To apply different page layouts based on user profiles, select Apply a different 
layout for each profile and choose a page layout for each profile.

Click Save to edit the values of the standard and custom picklists available for the 
record type. Optionally, click Save & New to create another record type. 

A new record type is created and a layout is assigned to profiles.

Configuring a Custom Link for Opportunity
Setting up the custom link allows you to quickly create an agreement from an existing 
opportunity. This is beneficial to Legal Users or Contract Managers.

To set up Opportunity links
User Permissions Needed

To add custom links to the Opportunity page layout: Customize Application

Go to Setup > Customize > Opportunities > Page Layouts.
Click Edit beside the Page Layout Name to which you want to add the Create 
Agreement From Opportunity custom link. The Page Layout Edit screen is displayed.
On the top-left, click Custom Links.
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Drag the Create Agreement custom link to the Custom Links section in the 
Opportunity Details related list.
To review the page layout, click Preview As. Select a profile to see how the pages will 
look for users with different profiles. Ensure that the Create Agreement custom link is 
displayed under the Custom Links section. Most related lists’ columns preview without 
data.
To save your changes, click Save. If you navigate away from your page layout 
without saving the changes, you will lose your changes. To create a copy of your 
page layout, click Save and select Save As. When you copy a page layout, any 
actions assigned to it are also copied to the new layout. Here are a few points to 
keep your page layouts well-organized and easy to use: 

Do not include unnecessary fields.
Keep the minimum number of required fields.
Check your layouts in Read and Edit modes.
To optimize related lists, adjust their overall order, the sorting of the records, 
and display of relevant columns and buttons.

A customized opportunity link is created and you have customized your organization’s page 
layouts. If required, add the Create Offline Agreement custom link.

Configuring Custom Links on the Home Page
Setting up Home page links allows quick and easy access to common functions of the 
applications from the Home page. The following steps are involved to set up a home page.

Create New Agreement Component
Create New Home Page Layout (alternatively, you may further customize your own 
home page layout, if any)
Assign New Layout to Appropriate User Profile

User Permissions Needed

To create or change home page layouts: Customize Application

Creating a New Agreement Component
Go to Setup > Customize > Home > Home Page Components.
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To create a custom component, click New. You can use custom components to tailor 
the Home page to different user profiles. Also, you can add your own components to 
your Home page.
Provide your own component name, for example My Custom Links, and select the 
Links custom type. Click Next.
From the left column, select NewAgreementRequest, CreateOfflineAgreement, 
StoredExecutedAgreement custom links, and add it to the Custom Links to show 
column. To select multiple elements individually, use CTRL+click. To select multiple 
elements as a group, use SHIFT+click.
Click Save.

A new Agreement component has been successfully created. Create a new Home page 
layout.

Creating a New Home Page Layout
Go to Setup > Customize > Home > Home Page Layouts.
To create new home page layout, click New.
From the Existing Home Page Layout list, select the layout on which you want to base 
the new layout. For example, Home Page Default.
Provide your own layout name in the Custom Home Page text area. For example, My 
Custom Page.
Click Save.
From the Narrow Components to Show list, select My Custom Links, and click Next. A 
custom component is added to the Home Page Layout. Use the arrow keys to move a 
new component up or down in the list to display in the desired order. Typically this 
component is at the top, under Search.
Click Save.
Optionally, to display the home page layout, click Preview. Click Save & Assign to 
save the page layout and assign it to a profile. Initially, all users, including Customer 
Portal users, are assigned to the Home Page Default layout.

A new Home Page layout has been created. After you have created a new Home page 
layout, assign the new layout to an appropriate user profile.

Assigning a New Layout to an Appropriate User Profile
Go to Setup > Customize > Home > Home Page Layouts.
Click Page Layout Assignment.
Click Edit Assignment.
Select the newly created home page layout for the appropriate user profile.
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A new layout has been assigned to the user and new customized links have been created to 
enable quick and easy access of the application from the Home page.

Customizing Agreement Actions
You can customize the standard agreement actions and override their default behaviour. 
The following agreement actions can be customized by using the code mentioned in their 
respective Visualforce pages:

Action Name Description

create_new_agreement Create New agreement

create_offline_agreement Create Offline Agreement

create_oppty_agreement Create Agreement From Opportunity

create_child_agreement Create New Child Agreement

store_executed_agreement Store Executed Agreement

clone_agreement Clone Agreement

amend_agreement Amend Agreement

renew_agreement Renew Agreement

Customization is achieved by using the exisiting Visualforce page containing javascript 
code and configuring the action to invoke the javascript code in a new Visualforce page 
before displaying the agreement to the user for editing. Ajax javascript libraries supplied by 
Salesforce are available for use in the javascript code.

Adding Agreement Hierarchy Button
You need to add the Agreement Hierarchy button on the Agreement Detail page to view the 
agreement hierarchy.
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To add the Agreement Hierarchy button 
Go to Setup > Build > Create > Objects.
In the Custom Objects page, click the Agreement hyperlink.
Navigate to the Page Layouts section and click the Edit hyperlink for Agreement 
Layout.
From the Buttons category in the palette, drag Agreement Hierarchy (New) into the 
Custom Buttons section of the Agreement Detail.
Click Save.

Adding In-Effect View Button
You need to add the In-Effect View button on the Agreement Detail page to view the In- 
Effect agreement details.

To add the In-Effect View button 
Go to Setup > Build > Create > Objects.
In the Custom Objects page, click the Agreement hyperlink.
Navigate to the Page Layouts section and click the Edit hyperlink for Agreement 
Layout.
From the Buttons category in the palette, drag In-Effect View into the Custom Buttons 
section of the Agreement Detail.
Click Save.

Adding the Email Agreement(s) Document(s) 
Button in Classic
You can configure the Email Agreement(s) Document(s) button in Classic to email multiple 
documents of multiple agreements to selected contacts or to a user group.

To configure the Email Agreement(s) Document(s) 
button

Go to Setup > Build > Create > Objects > Agreement



CLM

144 Copyright ©2022 Apttus Corporation. All rights reserved.
 

2.

3.

4.

5.

1.
2.
3.
4.
5.
6.

Under the Search Layouts section, click the Edit link before the Agreements List 
View layout.  
This displays the Edit Search Layout page.
Under the Custom Buttons section, in the Available Buttons column, select Email 
Agreement(s) Document(s).
Click the Add  icon.  
This displays Email Agreement(s) Document(s) in the Selected Buttons column.
Click Save. 
This adds the Email Agreement(s) Document(s) button on the Agreements List page.

Configuring Agreement Hierarchy Page Header
You can configure the fields that are displayed in the header section of the Agreement 
Hierarchy page.

To configure fields on the Agreement Hierarchy page
Go to Setup > Create > Objects.
Click Agreement.
Navigate to Field Sets section.
Click the Edit link before Agreement Hierarchy Fields.
Drag and drop fields into the In the Field Set section.
Navigate to the Agreement Hierarchy page to view the configured fields.

Configuring the Availability of Custom Buttons
In this topic, the configuration Upload Signed Document custom button is considered as an 
example. You can follow the same steps to configure other custom buttons.

By default, users can view the Upload Signed Document button after sending a document 
for signatures (manual or wet signatures). You can also make the Upload Signed 
Documents buttons available for different Statuses and Status Categories of agreements. 
If you configure a custom field, the configuration in the field is given priority over the default 
configuration.
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To configure the availability of the upload signed 
document button

Navigate to Object Manager > Agreement > Fields & Relationships.
Click New.
Select Data Type as Formula and click Next.
Enter the Field Name as UploadSignedDocument_Custom2 and enter Field Label 
as Upload Signed Document Custom.
Select Formula Return Type as Text and Click Next.
In the Upload Signed Document (Text) field, enter the formula and click Next.

Sample

IF(AND( ISPICKVAL(Apttus__Status_Category__c,"Request"), 

(ISPICKVAL(Apttus__Status__c,"Request") ) ), IF (OR ($User.UIThemeDisplayed == 

'Theme4d', $User.UIThemeDisplayed == 'Theme4t', $User.UIThemeDisplayed == 

'Theme4u') , HYPERLINK("/apex/Apttus__LightningOfflineDocumentImport? 

action=UploadSignedDocument&id=" &Id, IMAGE("/resource/ 

Apttus__Button_UploadSignedDocument", "Upload Signed Document"),"_self" ) , 

HYPERLINK("/apex/Apttus__OfflineDocumentImport?action=UploadSignedDocument&id=" 

 &Id, IMAGE("/resource/Apttus__Button_UploadSignedDocument", "Upload Signed 

Document"),"_self") ) ,NULL)

According to your requirement, set Field-Level Security for Profile and click Next.
Select the page layouts that should include the Upload Signed Document field and 
click Save.

Adding Agreement Hierarchy Button for Accounts
You need to add the Agreement Hierarchy button on the Account Detail page to view the 
agreement hierarchy.

To add the Agreement Hierarchy button for Accounts
Go to Setup > Accounts > Buttons, Links, and Actions.
Click New.
Enter the following details:

Label: Agreement Hierarchy.
Name: Agreement_Hierarchy.
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Display Type: Detail Page Button.
Behavior: Display in existing window with sidebar.
Content Source: Visualforce Page.
Content: AgreementHierarchyByAccount 
[Apttus__AgreementHierarchyByAccount].

Click Save.
Go to Setup > Build > Customize > Accounts > Page Layouts.
Click the Edit hyperlink for Account Layout.
From the Buttons category in the palette, drag Agreement Hierarchy into the Custom 
Buttons section of the Account Detail.
Click Save.

Configuring Documents Tab in Lightning
You need to configure the Documents tab in Lightning to view the documents. You can 
enable or disable the Delete button on the Documents tab for selected user profiles to 
prevent the deletion of documents.

Prerequisites
You must configure the registration setting to allow users to configure columns on the 
Documents tab. For more information, see Generating Registration Setting.

To configure the Documents tab
Navigate to the Agreement Detail page.
Click the Setup icon and select the Edit Object option. 
This displays the Agreement Object page.

Click Lightning Record Pages > Agreement Record Page. 
This displays the Lightning Page Detail page.

a.
b.
c.

If you want to permit users to use Online Contract Collaboration only for 
certain record types, you need to perform the following tasks:

Navigate to an agreement that contains the desired record type.
Click the Setup icon and select the Edit Page option.
Follow the steps mentioned below from 3 to 13. 
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Click Edit. 
This displays the Agreement Record page.
In the layout, click the Details tab. 
This displays a tabs component in the right panel.
Click the Add Tab button. 
This adds another Details tab in the layout.
 In the tabs component, select the newly added Details tab. 

 
From the Tab Label, select Custom. 
This displays the Custom Label text field.
In the Custom Label field, enter Documents.
In the layout click the Documents tab.
In the left panel, search for Agreement Documents.
Drag Agreement Documents from the left panel and drop in the Add Component(s) 
here section. 
This displays all the documents available in the agreement.
Click Save. 
If you are configuring the page layout for the first time in your org, then you need to 
activate the page.

To disable the Delete button on the Documents tab
Go to Setup > Users > Profiles.
Select a user profile.
Click Object Settings and then click Document Version.
Under the Object Permissions section, unselect the Delete checkbox. 
All the users assigned to the selected user profile cannot see the Delete button on the 
Documents tab.
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Configuring Document Action Column in Classic
You need to configure the Document Action column to open the Online Contract 
Collaboration view in classic. 

To configure the Document Action column
Go to Setup > Build > Create > Objects > Document Version Detail.
In the Document Version Detail, click the Edit Action in the Page Layout section. 
This displays the Document Version Detail Layout page.
In the Related Lists section for Version Details, click the wrench icon ( ). 
This displays the Related List Properties - Version Details popup.
In the Available Fields column, select and add the Document Action column.
Click Ok and click Save. 
The Document Action column is added in the Document Version Detail page.

Hiding Contracts and Templates Tabs in X-Author 
Contracts for Cloud
This feature allows you to hide contracts or templates tab in X-Author Contracts using 
custom permissions. 

Prerequisites
Refer Salesforce documentation to understand how to create custom permissions.

To Hide Contracts or Templates Tab:
Create XA_Template and XA_Contracts custom permissions in the Contract 
Management application.
Navigate to Setup>Manage Users>Profiles.
Click a profile name to hide the Contracts or Template tab for that profile. This 
displays the Profile Overview page.
In the Apps section, click Custom Permissions. This displays the Custom Permissions 
page.
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Click Edit.  
When the XA_Template and XA_Contracts custom permissions are in Available 
Customer Permissions section, the user will not be able to view Template and 
Contracts tabs in the X-Author Contracts for Cloud. When the XA_Template and 
XA_Contracts custom permissions are in Enabled Customer Permissions section, the 
user will be able to view Template and Contracts tabs in the X-Author Contracts for 
Cloud.
Move the XA_Template or XA_Contracts custom permissions from Enabled Custom 
Permissions section to Available Custom Permission to hide Contracts or Templates 
tab.
Logout and log in each time after you disable or enable a custom permission.

Translatable Customizations
To view the translatable customizations, click Translation Workbench > Translate. If 
needed, select the Setup Component.

You can translate the following components:

Apex Sharing Reasons
Button and Link Labels
Custom App Labels
Custom Field Help
Custom Fields
Custom Report Types
Data Categories
Data Category Groups
Divisions
Layout Sections
Lookup Filters

•

•

•

•

When you login into the X-Author Contracts for Cloud:
If you have only XA_Template custom permission, you will only see the 
Templates tab.
If you have only XA_Contract custom permission, you will only see the 
Contracts tab.
If you have both XA_Template and XA_Contract custom permission, you will 
see both Templates tab and Contracts tab.
If you do not have both XA_Template and XA_Contract custom permission, you 
will get a message and will be logged out.
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Picklist Values
Record Types
Related List Labels
S-Controls
Solution Categories
Standard Field Help
Validation Error Messages
Web Tabs
Workflow Tasks

Translating X-Author Contracts User Interface
X-Author Contracts supports data translation to multiple languages. This allows you to 
use X-Author Contracts in your native language. You need to configure Contract 
Management to view X-Author Contracts in your native language. To view X-Author 
Contracts in your native language, you need to configure locale related settings in 
Contract Management. You need to change the locale settings in Contract Management 
and translate labels of Visualforce pages that are used in X-Author Contracts. You also 
need to translate the XML resource file and upload it to the required locale. You can use 
default locales available in Contract Management or add a custom locale.

To change locale settings 
Go to Setup > My Personal Information > Edit your personal information > Edit.
Navigate to the Locale Settings section and update the following fields according 
to your translation requirement.

Time Zone
Locale
Language
Currency

Click Save. 
You can now view all the Salesforce objects in the language you selected.

To set up language translation 
Go to Setup > Translation Workbench > Translation Language Settings.
Click Add.
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In the Language Translation Edit page, select a language from the Language 
dropdown.
To permit few users to edit translations, move those usernames from the Available 
List to Selected List.

Click Save.
Go to Setup > Develop > Visualforce Pages.
Select a visualforce page.
In the Visualforce Markup section, search for the word Label and make a note of all 
the labels on the page.
Repeat the above step for all the following visualforce pages.

The labels in the following visualforce pages need to be translated as they are used in the 
X-Author Contracts:

CreateTemplateSO
UpdateTemplateSO
CreateTemplateClauseSO
UpdateTemplateClauseSO
SelectTemplateForCheckout
SelectTemplateForLoad
SelectLibraryComponent
SelectMergeField
CreateMergeCondition
CreateMergeDataSet
CompareTemplateVersions
BrowseAttachments
CreateOfflineAgreement
BrowseTemplates
BrowseAgreements
DocumentFinder
AddProducts
BrowseGroups
BrowsePeople
ChatterPage
ChatterUserPage

Note

Ensure that the language is active.
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To translate custom labels
Go to Setup > Create > Custom Labels.
Select one of the labels.
In the Custom Label Detail page, click New Local Translations / Overrides.
Select the localization language.
In the Translation field, enter the translation text for that label.
Click Save.

To translate custom fields 
Go to Setup > Translation Workbench > Translate.
In the Select the filter criteria section, select the following options:

Language: select localization language
Setup Component: Custom Field
Object: Agreement
Aspect: Field Label

In the Field Label Translation column, double-click on the field space next to a field 
you need to translate available in the Master Field Label column.
Click Save.

To download the resource file
Navigate to the Locale tab.
Click the English (United States) hyperlink. 
This displays the Template Locale Detail page.
In the Files section, click the Download hyperlink. 
TheXAResource.resx file is downloaded to your system. 
Open the file and translate the UI text into your local language.

To upload the updated resource file
Navigate to the Locale tab.

Note

Do not rename the XAResource.resx file (resource file).
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Click the <locale name> hyperlink. 
This displays the Template Locale Detail page.
In the Files section, click Upload Files and select the updated XAResource file from 
your system.
Click Close on the Upload to <locale name> window. 
When you open X-Author Contracts, you can view the UI in your local language.

Use Case: Translating X-Author Contracts User 
Interface
This use case describes how to translate the X-Author Contracts user interface from English 
(United States) to Spanish. You might use this functionality differently, depending on your 
localization language. For more information about the functionality, see Translating X- 
Author Contracts User Interface.

To translate the X-Author Contracts user interface to Spanish
Go to Setup > My Personal Information > Edit your personal information > Edit.
Navigate to the Locale Settings section and select the following options. 

Click Save. 
You can now view all the Salesforce objects in the language you selected.
Go to Setup > Translation Workbench > Translation Language Settings and click 
Add.
In the Language Translation Edit page, select Espanol from the Language dropdown.

Note

If you need to update the resource file, ensure that you delete the existing resource 
file and upload the updated resource file. If no resource file is available for the 
locale you have selected in Salesforce, the default English (United States) is used to 
display the content in X-Author Contracts. 
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To permit few users to edit translations, move those user names from the Available 
List to Selected List.  

Click Save.
Go to Setup > Develop > Visualforce Pages.
Click the DocumentFinder hyperlink.
Search for the word Label and make a note of the LoadingPage label.  
Only one label is considered in this demonstration. You need to configure all the 
labels for the visualforce pages mentioned in the Translating X-Author Contracts 
User Interface. 

Go to Setup > Create > Custom Labels.
Click the LoadingPage hyperlink.
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In the Custom Label Detail page, click New Local Translations / Overrides.
Select the localization language and enter the translation text for the label. 
When a page loads in X-Author Contracts, the loading page label is displayed in 
Spanish. 

Click Save.
Go to Setup > Translation Workbench > Translate.
In the Select the filter criteria section, select the following options:
In the Field Label Translation column, double-click on the field space next to a field 
you need to translate available in the Master Field Label column. 
When you view agreement object fields in X-Author Contracts after translation, you 
can view the field names in Spanish. 

Click Save.
Navigate to the Locale tab.
Click the English (United States) hyperlink. 
This displays the Template Locale Detail page.
In the Files section, click the Download hyperlink. 
The XAResource.resx file is downloaded to your system. 
Open the file and translate the UI text into your local language. 
Before translation: 
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After translation: 

Navigate to the Locale tab.
Click the Spanish hyperlink. 
This displays the Template Locale Detail page.
In the Files section, click Upload Files and select the updated XAResource.resx file 
from your system.
After the resource file is uploaded, click Close on the Upload to Spanish window. 
When you open X-Author Contracts, you can view the UI in Spanish. 

Removing the Path Field
You can remove the path field from the Agreement Document Detail page.
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To remove the path field
Navigate to an Agreement Detail page.
Go to the Agreement Documents section.
Click the Name of an Agreement Document.  
This displays the Agreement Document Detail page.
Click the Edit Layout hyperlink. 
This displays the page layout.
In the Agreement Detail section, click the remove icon ( ) next to the Path field.
Click Save.  
The Path field is now removed from the Agreement Document Detail page.

Configuring In-Effect View Page Header
You can configure the fields that are displayed in the header section of the In-Effect View 
page.

To configure fields on the In-Effect View page
Go to Setup > Create > Objects.
Click Agreement.
Navigate to Field Sets section.
Click the Edit link before Agreement In Effect Fields.
Drag and drop fields into the In the Field Set section.

Navigate to the In-Effect View page to view the configured fields.

Configuring New Agreement Form Fields
When a user starts creating a new agreement, a new agreement form is displayed after 
you select a record type. This new agreement form is displayed only when the fields for the 
form are configured. 

You can add a maximum of 15 fields in the header. If you add more than 15 
fields, you can encounter errors.
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To configure fields on the new agreement form
Go to Setup > Object Manager > Agreement > Field Sets > Agreement New Field Set.
Drag the fields from the object palette and drop them into the In the Field Set 
container.
To make a field as required, double click the field or click the wrench icon ( ) next to 
the field.
Select the Required checkbox and click OK.
Click Save.

Populating the File Size Field
To populate the File Size field for existing data, you must run the following script.

List<ApttusDocumentVersionDetailc> documentVersionDetails = [select id, 

ApttusContentIdc from ApttusDocumentVersionDetailc where ApttusContentIdc != null AND 

(ApttusFileSizec = 0 OR ApttusFileSize_c = null) limit 1];

if(documentVersionDetails.size() > 0) {

Apttus.DocumentFileSizeUpdateBatch documentFileSizeUpdateBatch = new 

 Apttus.DocumentFileSizeUpdateBatch();

// Execute DocumentFileSizeUpdateBatch

Database.executeBatch(documentFileSizeUpdateBatch);

}

Setting Up Quick Search on the Home Page
To allow users to search content from the Home page, you can set up the quick smart 
search box on the home page in Lightning.

To configure the quick smart search box
Navigate to the Home page.
Click the Setup icon and select the Edit Object option.
In the Components search box, enter smartSearchHome and search.
Drag and drop the smartSearchHome component at any position on the Home page.
Click Save.
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User Profile Management
This section covers the following topics:

Managing User Profile
Creating a User Profile
Adding a Single User
Assigning Conga CLM License to a User
Assigning Users to Queues
Providing Read Access
Profile Settings and Security
Setting Up Lite User License
Folder Security and Sharing Permissions
Assigning Custom Permissions to User Profiles

Managing User Profile
A profile contains user permissions and access settings. There are five basic profiles used 
with Conga CLM:

Profile Name Available Permissions Description

Conga CLM Administrator Can configure and customize the application. Has access 
to all Conga CLM functionality that does not require an 
additional license.

Contract Manager/Template Admin Can create, edit, execute, and approve contracts. This 
profile can also delete contracts as long as they are not 
executed. Can manage clause and language template 
library. Has access to X-Author for Contracts functionality

Read Only Can view the organization's setup, run and export reports, 
and view, but not edit other records.

Requester/Approver Can initiate new contract requests and use the Contract 
Wizard to assemble standard contracts, but does not 
have access to X-Author for Contracts. Can perform some 
limited searches and reporting.
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Profile Name Available Permissions Description

Contract Creator/Negotiator Can create, edit, execute, and approve contracts. This 
profile cannot delete agreements and does not have any 
permissions to manage clauses or templates. Has access 
to X-Author for Contracts in a negotiator role.

CLM User Roles & Tasks 
The following table presents the broad view of some of the key CLM roles and their 
descriptions:

Role Description

Legal function Design, creation, maintenance of 
contract template contents
Review, negotiation, and contract legal 
content assurance
Legal admin, Internal counsel, External 
counsel

Finance function Evaluation and validation of contract’s 
financial impact and risks
Approval of the commitment of 
resources per the contract
Financial analyst, Controller, CFO, 
Treasurer

SMEs Evaluation and validation of specific 
areas of contract commitments
Approval of their functional area of the 
contract’s deliverables
VP / Director for Products, Procurement, 
Sales, Partner Management

Contract Facilitator Definition of non-standard, complex, or 
global contract components
Assignment of contributors, scoring, 
approval, and strategic aspects
VP Strategic Accounts, CEO, CFO, COO

For details on profile settings and related securities, see Profile Settings and 
Security.
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Role Description

Admin General definition of process, 
contributors, contract elements
Configuration of applications and tools 
required by the process
Application admin, system analyst, 
business analyst

Creating a User Profile 
Profile is essentially a definition of a set of permissions granted to a group of users.
Adding a Single User 
The maximum number of users you can create is determined by your Salesforce 
Edition.
Adding Multiple Users 
The maximum number of users you can create is determined by your Salesforce 
Edition. Depending on the number of available licenses, you can create up to 10 users.
Assigning Conga CLM License to a User 
In addition to Salesforce licensing, a user profile must be assigned to the Conga CLM 
license.
Assigning Users to Queues 
Queues allow groups of users to manage a shared workload more effectively. A 
queue is a location where records can be routed to await processing by a group 
member. If the sharing model for all objects in the Queue is Public Read/Write/ 
Transfer, you do not need to assign users to the queue, as all users already have 
access to the records for those objects.
Providing Read Access 
This allows preview and generate agreement actions to read the document password 
from the Admin object without allowing them to view it. You can set the permissions 
and page layouts for the selected profile. The permissions defined here control access 
at the object level. Set access levels based on the functional requirements for the 
profile. For example, create different groups of permissions for individual contributors, 
managers, and administrators.

Creating a User Profile
Profile is essentially a definition of a set of permissions granted to a group of users.



CLM

162 Copyright ©2022 Apttus Corporation. All rights reserved.
 

1.
2.
3.
4.
5.
6.
7.

8.

1.
2.

3.

To create a user profile
You must have administrative privileges.

Click Setup > Manage Users > Profiles.
Click New.
From Existing Profile, select a mandatory profile. For example: System Administrator.
Type a mandatory Profile Name.
Click Save. If this profile already exists, examine the settings or permissions.
Click Edit.
Use the available settings to ensure the profile settings correspond to the custom 
profile.
If needed, repeat the steps for other profiles.

Adding a Single User
The maximum number of users you can create is determined by your Salesforce Edition. To 
add a single user, refer to the standard Salesforce Help.

Adding Multiple Users
The maximum number of users you can create is determined by your Salesforce Edition. 
Depending on the number of available licenses, you can create up to 10 users. To add a 
single user, refer to the standard Salesforce Help.

Assigning Conga CLM License to a User
In addition to Salesforce licensing, a user profile must be assigned to the Conga 
CLM license.

To assign Conga CLM license to a user
Before you assign Conga CLM license to a user, you must first add a user.

Click Setup > Deploy > Installed Packages.
Locate the Apttus Contract Management installed package and click Manage 
Licenses.
To assign the license, click Add Users.
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4. Select the user that you wish to assign a license and click Add.

The user has been assigned Conga CLM license.

Assigning Users to Queues
Queues allow groups of users to manage a shared workload more effectively. A queue is a 
location where records can be routed to await processing by a group member. If the 
sharing model for all objects in the Queue is Public Read/Write/Transfer, you do not need to 
assign users to the queue, as all users already have access to the records for those objects.

To assign a user to a queue

When you create a queue, Salesforce automatically creates a corresponding list view. You 
can now access the queue list view from the Cases, Leads, Service Contracts or custom 
object tabs. Only queue members and users above them in the role hierarchy have access 
to the queue list view depending on your sharing settings.

Set up lead or case assignment rules to automatically reassign ownership of leads and 
cases to the queue.

Providing Read Access
This allows preview and generate agreement actions to read the document password from 
the Admin object without allowing them to view it. You can set the permissions and page 
layouts for the selected profile. The permissions defined here control access at the object 
level. Set access levels based on the functional requirements for the profile. For example, 
create different groups of permissions for individual contributors, managers, and 
administrators.

To allow documents to be protected correctly when the Preview Agreement or Generate 
Agreement actions are taken, the field level security needs to be setup so the Value field is 
Read Only for any profile you want to create protected documents for. You must follow the 
below process for each profile you want to hide the document protection password from.

Before you assign a user to a queue, you must add the user.To assign a user to a 
queue, refer to the standard Salesforce Help.
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To provide users unviewable read access
Go to Setup > Manage Users > Profiles, and select the Requester or other appropriate 
profile.
Click Edit next to the left of the profile you want to edit. Scroll down to the Custom 
Object Permissions related list, and for Admin custom object, select Read. 
 

 

 
Click Save and then click on the Requestor profile link. Scroll down to the Field-Level 
Security Settings and find the Admin object in the Custom Field-Level Security area.
Click View. Ensure that all the fields are visible and the read-only attributes for the 
Value field are set to the following fields: 

Created By
Last Modified By
Value

Go to Setup > Security Controls > Sharing Settings.
Click Edit and locate the Admin entry to Public Read-Only for all the users in the 
organization. 

This ensures the Contract Wizard can read the password from Salesforce and 
protect generated documents with it.
Other users can read the Admin password values but cannot set or see them 
when the Admin tab is hidden for that profile. Furthermore, layouts can be 
modified to hide the Value field, if required.

To hide the Admin tab from all users except for Administrators, click the Requester 
profile and find the Tab Settings.
From the Admin drop down list, select the Tab Hidden option.
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Profile Settings and Security
Use the following settings to ensure the profile settings correspond to the custom profile.

See also Sharing Security.

Profile Read 
Only

Requestor/ 
Approver

Contract 
Creator/ 
Negotiator

Contract 
Manager/ 
Template Admin

Administr 
ator

Custom App Settings

Apttus Contract 
Management

Yes Yes Yes Yes Yes

      

Enabled Apex Class Access

Apttus.* Yes Yes Yes Yes Yes

      

Enabled Visualforce Page Access

Apttus.* Yes Yes Yes Yes Yes

      

Standard Tab Settings

Accounts Use 
Existing 
Setting

Use Existing 
Setting

Use Existing 
Setting

Use Existing 
Setting

Use 
Existing 
Setting

Contacts Use 
Existing 
Setting

Use Existing 
Setting

Use Existing 
Setting

Use Existing 
Setting

Use 
Existing 
Setting

Conga CLM recommends checking field-level security for corresponding 
objects when configuring profiles.
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Profile Read 
Only

Requestor/ 
Approver

Contract 
Creator/ 
Negotiator

Contract 
Manager/ 
Template Admin

Administr 
ator

Dashboards Use 
Existing 
Setting

Use Existing 
Setting

Use Existing 
Setting

Use Existing 
Setting

Use 
Existing 
Setting

Reports Use 
Existing 
Setting

Use Existing 
Setting

Use Existing 
Setting

Use Existing 
Setting

Use 
Existing 
Setting

      

Apttus Custom Tab Settings

Admin Tab 
Hidden

Tab Hidden Tab Hidden Tab Hidden Default 
Off

Agreement 
Protection

Tab 
Hidden

Tab Hidden Tab Hidden Tab Hidden Default 
Off

Agreement Rules Tab 
Hidden

Tab Hidden Tab Hidden Tab Hidden Default 
Off

Agreements Tab 
Hidden

Default On Default On Default On Default 
On

Agreement 
Document 
Output Formats

Tab 
Hidden

Tab Hidden Tab Hidden Tab Hidden Default 
Off

Configurable 
Wizard

Tab 
Hidden

Tab Hidden Tab Hidden Default On Default 
On

Cycle Time 
Groups

Tab 
Hidden

Tab Hidden Tab Hidden Tab Hidden Default 
Off

Doc Assembly 
Rulesets

Tab 
Hidden

Tab Hidden Tab Hidden Default On Default 
On
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Profile Read 
Only

Requestor/ 
Approver

Contract 
Creator/ 
Negotiator

Contract 
Manager/ 
Template Admin

Administr 
ator

Query Templates Tab 
Hidden

Tab Hidden Tab Hidden Tab Hidden Default 
Off

Retention Policies Tab 
Hidden

Tab Hidden Tab Hidden Tab Hidden Default 
Off

Search Filters 
(Comply)

Tab 
Hidden

Tab Hidden Tab Hidden Tab Hidden Default 
On

Publish 
Templates

Tab 
Hidden

Tab Hidden Tab Hidden Default On Default 
On

Purge 
Agreements

Tab 
Hidden

Tab Hidden Tab Hidden Tab Hidden Default 
On

Templates Tab 
Hidden

Tab Hidden Tab Hidden Default On Default 
On

Term Exceptions Tab 
Hidden

Tab Hidden Tab Hidden Tab Hidden Default 
Off

      

Administrative Permissions

Manage Users No (Use 
Existing 
Setting)

No (Use 
Existing 
Setting)

No (Use Existing 
Setting)

No (Use Existing 
Setting)

Yes

Customize 
Application

No (Use 
Existing 
Setting)

No (Use 
Existing 
Setting)

No (Use Existing 
Setting)

No (Use Existing 
Setting)

Yes

View Setup & 
Configuration

Yes Yes Yes Yes Yes
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Profile Read 
Only

Requestor/ 
Approver

Contract 
Creator/ 
Negotiator

Contract 
Manager/ 
Template Admin

Administr 
ator

Manage Public 
Reports

No (Use 
Existing 
Setting)

No (Use 
Existing 
Setting)

No (Use Existing 
Setting)

No (Use Existing 
Setting)

Yes

Manage 
Dashboards

No (Use 
Existing 
Setting)

No (Use 
Existing 
Setting)

No (Use Existing 
Setting)

No (Use Existing 
Setting)

Yes

Edit HTML 
Templates

No (Use 
Existing 
Setting)

No (Use 
Existing 
Setting)

No (Use Existing 
Setting)

No (Use Existing 
Setting)

Yes

      

General User 
Permissions

     

Create and 
Customize 
Reports

Use 
Existing 
Setting

Use Existing 
Setting

Use Existing 
Setting

Yes Yes

Edit Events Use 
Existing 
Setting

Yes Yes Yes Yes

Edit Tasks Use 
Existing 
Setting

Yes Yes Yes Yes

Export Reports Use 
Existing 
Setting

Use Existing 
Setting

Use Existing 
Setting

Yes Yes

Run Reports Use 
Existing 
Setting

Use Existing 
Setting

Use Existing 
Setting

Yes Yes
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Profile Read 
Only

Requestor/ 
Approver

Contract 
Creator/ 
Negotiator

Contract 
Manager/ 
Template Admin

Administr 
ator

Send email Use 
Existing 
Setting

Use Existing 
Setting

Yes Yes Yes

Folder Permissions

See Folder Security

 

Custom Object Permissions

Admin Read Read Read Read Read, 
Create, 
Edit, 
Delete

Agreement Read Read, 
Create, Edit

Read, Create, 
Edit

Read, Create, Edit Read, 
Create, 
Edit, 
Delete

Agreement 
Clause

Read Read, 
Create, Edit

Read, Create, 
Edit

Read, Create, Edit, 
Delete

Read, 
Create, 
Edit, 
Delete

Agreement 
Document

Read Read, 
Create, Edit

Read, Create, 
Edit

Read, Create, Edit, 
Delete

Read, 
Create, 
Edit, 
Delete

Agreement 
Document 
Output Format

Read Read, 
Create, Edit

Read, Create, 
Edit

Read, Create, Edit Read, 
Create, 
Edit, 
Delete
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Profile Read 
Only

Requestor/ 
Approver

Contract 
Creator/ 
Negotiator

Contract 
Manager/ 
Template Admin

Administr 
ator

Agreement Line 
Item

Read Read Read Read, Create, Edit, 
Delete

Read, 
Create, 
Edit, 
Delete

Agreement Lock Read Read Read Read, Create, Edit, 
Delete

Read, 
Create, 
Edit, 
Delete

Agreement 
Protection

Read Read Read Read Read, 
Create, 
Edit, 
Delete

Agreement Rule Read Read Read Read Read, 
Create, 
Edit, 
Delete

Agreement Rule 
Condition

Read Read Read Read Read, 
Create, 
Edit, 
Delete

Agreement Term 
Exception

Read Read Read Read, Create, Edit Read, 
Create, 
Edit, 
Delete

AsyncMergeCall Read Read, 
Create, Edit

Read, Create, 
Edit

Read, Create, Edit Read, 
Create, 
Edit, 
Delete
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Profile Read 
Only

Requestor/ 
Approver

Contract 
Creator/ 
Negotiator

Contract 
Manager/ 
Template Admin

Administr 
ator

Content Event Read Read, 
Create, Edit

Read, Create, 
Edit

Read, Create, Edit Read, 
Create, 
Edit, 
Delete

Clause Approval Read Read Read Read, Create, Edit Read, 
Create, 
Edit, 
Delete

Cycle Time Field Read Read Read Read, Create, Edit Read, 
Create, 
Edit, 
Delete

Cycle Time Field 
Data

Read Read, 
Create, Edit

Read, Create, 
Edit

Read, Create, Edit Read, 
Create, 
Edit, 
Delete

Cycle Time Group Read Read Read Read, Create, Edit Read, 
Create, 
Edit, 
Delete

Cycle Time Group 
Data

Read Read, 
Create, Edit

Read, Create, 
Edit

Read, Create, Edit Read, 
Create, 
Edit, 
Delete

Doc Assembly 
Component

Read Read Read Read, Create, Edit, 
Delete

Read, 
Create, 
Edit, 
Delete
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Profile Read 
Only

Requestor/ 
Approver

Contract 
Creator/ 
Negotiator

Contract 
Manager/ 
Template Admin

Administr 
ator

Doc Assembly 
Rule

Read Read Read Read, Create, Edit, 
Delete

Read, 
Create, 
Edit, 
Delete

Doc Assembly 
Ruleset

Read Read Read Read, Create, Edit, 
Delete

Read, 
Create, 
Edit, 
Delete

Document 
Version

Read Read, 
Create

Read, Create, 
Edit

Read, Create, Edit Read, 
Create, 
Edit, 
Delete

Document 
Version Detail

Read Read, 
Create

Read, Create, 
Edit

Read, Create, Edit Read, 
Create, 
Edit, 
Delete

Formula Field 
(Comply)

Read Read Read Read, Create, Edit, 
Delete

Read, 
Create, 
Edit, 
Delete

Locale Read Read Read Read, Create, Edit, 
Delete

Read, 
Create, 
Edit, 
Delete

Merge Event Read Read Read Read, Create, Edit, 
Delete

Read, 
Create, 
Edit, 
Delete
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Profile Read 
Only

Requestor/ 
Approver

Contract 
Creator/ 
Negotiator

Contract 
Manager/ 
Template Admin

Administr 
ator

Merge Event 
Detail

Read Read Read Read, Create, Edit, 
Delete

Read, 
Create, 
Edit, 
Delete

Query Template Read Read Read Read Read, 
Create, 
Edit, 
Delete

Query Template 
Filter

Read Read Read Read, Create, Edit Read, 
Create, 
Edit, 
Delete

Query Template 
Qualifier

Read Read Read Read, Create, Edit Read, 
Create, 
Edit, 
Delete

Related 
Agreement

Read Read Read Read, Create, Edit, 
Delete

Read, 
Create, 
Edit, 
Delete

Retention Policy Read Read, 
Create, Edit

Read, Create, 
Edit

Read, Create, Edit Read, 
Create, 
Edit, 
Delete

Search Filter 
(Comply)

Read Read Read Read, Create, Edit, 
Delete

Read, 
Create, 
Edit, 
Delete
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Profile Read 
Only

Requestor/ 
Approver

Contract 
Creator/ 
Negotiator

Contract 
Manager/ 
Template Admin

Administr 
ator

Temp Object 
(Comply)

Read Read, 
Create, Edit, 
Delete

Read, Create, 
Edit, Delete

Read, Create, Edit, 
Delete

Read, 
Create, 
Edit, 
Delete

Template Read Read Read Read, Create, Edit Read, 
Create, 
Edit, 
Delete

Template Clause 
Reference

Read Read Read Read, Create, Edit Read, 
Create, 
Edit, 
Delete

Template 
Datasource Filter

Read Read Read Read, Create, Edit Read, 
Create, 
Edit, 
Delete

Template 
Dynamic Section

Read Read Read Read, Create, Edit Read, 
Create, 
Edit, 
Delete

Template Version Read Read Read Read, Create, Edit Read, 
Create, 
Edit, 
Delete

Term Exception Read Read Read Read, Create, Edit Read, 
Create, 
Edit, 
Delete
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Profile Read 
Only

Requestor/ 
Approver

Contract 
Creator/ 
Negotiator

Contract 
Manager/ 
Template Admin

Administr 
ator

Wizard Design Read Read Read Read, Create, Edit Read, 
Create, 
Edit, 
Delete

Wizard Input 
Control

Read Read Read Read, Create, Edit Read, 
Create, 
Edit, 
Delete

Wizard Ruleset Read Read Read Read, Create, Edit Read, 
Create, 
Edit, 
Delete

Wizard Read Read Read, Create, 
Edit, Delete

Read, Create, Edit Read, 
Create, 
Edit, 
Delete

Wizard Step Read Read Read Read, Create, Edit Read, 
Create, 
Edit, 
Delete

      

Custom Record 
Type Settings for 
Agreements

     

Record Types 
(Create 
Permission) 
Permission for the 
Record Types 
needs to be 
provided.

No Yes Yes Yes Yes
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Setting Up Lite User License
Lite user license is helpful when a user accesses Contract Management, occasionally, just 
to view or edit certain contracts. A Lite user can login to Contract Management up to 30 
times. You can add a set of users to Apttus_Lite user profile that can log in to Contract 
Management up to 30 logins. You also track their usage by reviewing the usage monitoring 
report.

Prerequisites
You must configure the following Comply System Properties. For more information, see 
 Comply System Properties. 

CLM Lite License Profile(s)
CLM Lite License Admin Email
Email Lite Monitoring Report to Apttus?
Inactivate Non-Compliant Lite User

When you configure the above-mentioned properties, the user login data (Login History 
Name, Login Time, and User) is captured in LoginHistory__c.

To set up Apttus_Lite user profile
Click Setup > Users > Profiles.
Click New Profile.
From Existing Profile, select an existing user profile to clone from. 
For Profile Name, enter Apttus_Lite_Users.
Click Save. 
Click Assigned Users.
If you need to create a single user, click New User.  
(or) 
If you need to create multiple users, click Add Multiple Users.
Enter the required details and click Save.



CLM

177
 

Copyright ©2022 Apttus Corporation. All rights reserved.
 

•
•
•

Lite License Usage Report
When you add a user to the Apttus_Lite user profile and the user creates or updates an 
agreement, the LoginHistoryScheduler and LiteUserReportScheduler jobs are automatically 
created. These jobs enable Lite User Usage Monitoring.

LoginHistoryScheduler: It cleans up the history of login data if it is older than 1 year and 
captures the login details in the loginHistory custom object. The job is scheduled to run 
daily at 6 AM (timezone dependent).

LiteUserReportScheduler: When a Lite user exceeds the allowable limit, this job sends the 
compliance report to the configured admins. The job is scheduled to run daily at 6:10 AM 
(timezone dependent).

The above-mentioned jobs ensure the following:

If you assign a user to Apttus_Lite user profile, the user is tracked as a Lite User.
The Lite License Compliance Report is sent to configured admins.
Prevent non-compliant users from creating or updating an agreement record.

When the scheduled jobs are run, you will receive an email with the following details:

Lite User License FAQs
This page lists the frequently asked questions and their answers.

If a lite user approves an agreement, will it be counted as a login?

If an entry is added in the login history table, it will be considered as a login.

When is the lite license start date?

When you add the first profile to the APTS_ lite custom system property.
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Folder Security and Sharing Permissions
This reference goes into more detail regarding typical permission settings for Folders used 
by Conga CLM and provides guidelines for enforcing Sharing settings within your 
organization.

Folder Security
The following table represents typical Profile-based permission settings for folders used by 
Conga CLM. Security of any folder should be set according to the needs of your business 
and is independent of Agreement record security. Read further on this page for more 
discussion on security considerations for your folders, content repositories and records.

Profile Requestor/ 
Approver

Contract Creator/ 
Negotiator

Contract 
Manager

Administrator

Apttus 
Documents

Read Read Read Read, Create, 
Edit, Delete

Apttus Images Read Read Read Read, Create, 
Edit, Delete

Apttus Email 
Templates

Read Read Read Read, Create, 
Edit, Delete

Apttus 
Temporary Email 
Templates

Read Read Read Read, Create, 
Edit, Delete

Agreement 
Report

Read Read Read Read, Create, 
Edit, Delete

Agreement 
Dashboard

Read Read Read Read, Create, 
Edit, Delete

Content Repositories
Following activation of an agreement, documents designated for content search are routed 
to a content repository. The default content repository for Apttus agreement documents is 
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the Documents folder, but you can also configure the system to route these documents to 
any of the following:

Content Libraries
Chatter Feed (File Feed data store)

See Routing Documents to Content Libraries for more information on setting up alternate 
content repositories for your activated agreement documents.

Email Folders
Email templates and temporary email templates with Agreement attachments are stored 
in the Apttus Email Templates and Apttus Temporary Email templates folders. If you have 
integrated electronic signature functionality into your Apttus solution, the respective 
custom objects store the request and response information which might contain the 
contract documents. Because of this, access should be restricted to specified users and user 
groups, and external portal users should be explicitly restricted from accessing these 
folders. 

Sharing Security
Permissions associated with User Profiles are not always sufficient when determining 
access to specific records. Profile security is granted at the Object level. If a particular User 
Profile has Read/Edit permissions for an Object, by default they have the same permissions 
at the record level. Sharing security allows you to enforce permissions at the Record level.

Creating Your Private Sharing Model
The default Sharing setting (controlled by Organization-Wide Defaults) is always Public 
Read/Write for all custom objects. You can restrict any of these defaults by changing 
settings to Private or Public Read Only. Then use Sharing Rules to allow specific users or 
groups of users additional access. Rules are typically based on the record owner or Field 
values on the records in the Object (e.g. for Agreements, "Agreement Type"). You can also 
decide to grant access using Role hierarchies, meaning access is automatically given to 
users above the record owner in your organization's hierarchy.

For more information on determining Organization-Wide Defaults and creating Sharing 
Rules, please refer to Salesforce Documentation here.

https://help.salesforce.com/apex/HTViewHelpDoc?id=security_data_access.htm&language=en_US
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Assigning Custom Permissions to User Profiles
You can define custom permissions for user profiles that allow the users to access the 
following X-Author Contracts features:

Contracts tab
Templates tab
Check-in as final
Check-in without redlines
Check-in with redlines
Unprotect document
Unlock read-only clause
Open and Open and Update option
Auto check out option

You need to perform one of the following actions for all the user profiles in your org to 
permit users to access X-Author Contracts features:

Define the APTS_ProfilePermissions admin entry.
Assign custom permissions to a user profile and enable the View Setup & 
Configuration permission.

The admin entry is given first priority and the next priority is given to custom permissions 
along with the View Setup & Configuration permission. If the admin entry is configured, the 
system does not check for custom permissions.

The following conditions apply when a user accesses the X-Author Contracts features:

If all the user profiles are included in the admin entry, users can access the 
features according to the feature access defined in the admin entry.
If only a few user profiles are included in the admin entry:

Users with included user profiles can access the features according to the 
feature access defined in the admin entry.
Users with excluded user profiles cannot access any of the features.

If the admin entry is not defined and all the user profiles have custom permissions 
along with the View Setup & Configuration permission, users can access the 
features according to the custom permissions available for the user profile.

Irrespective of the user profile permissions, any user can check-in a document with 
redlines using X-Author for Contracts 1.0.
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If the admin entry is not defined and only a few user profiles have custom permissions 
along with the View Setup & Configuration permission:

Users with user profiles for which all the custom permissions are available can 
access all the features.
Users with user profiles for which only a few custom permissions are available 
can access only the features related to the available custom permissions.
Users with user profiles for which no custom permissions are available cannot 
access any of the features.

If the admin entry is not defined and all the user profiles have no custom permissions, 
users cannot access any of the features.

To configure APTS_ProfilePermissions admin entry
The APTS_ProfilePermissions admin entry allows you to define custom permissions for user 
profiles. 

Navigate to Admin tab.
Click New.
Enter APTS_ProfilePermissions in the Name field.
Enter JSON in the Value field.
In the Code field, you need to define the following parameters.

Parameters: 

Name Type Description

id ID The id of a user profile.

name string The name of a user profile.

Permission string The X-Author Contracts feature name.

 Val 
ue

boole 
an

Indicates whether the user profile has the feature access.

You must not define some user profiles in the admin entry and the remaining profiles 
in the custom permissions.
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Code

{

   "profiles":[

      {

         "id":"<UserProfileID>",

         "name":"<UserProfileName>",

         "permission":{

            "xa_contracts":"<value>",

            "xa_template":"<value>",

            "xa_checkinasfinal":"<value>",

            "xa_checkinwithredlines":"<value>",

            "xa_checkinwithoutredlines":"<value>",

            "xa_unlockreadonlyclause":"<value>",

            "xa_unprotectdocument":"<value>",

            "xa_hidecheckoutmenu":"<value>",

            "xa_disableautocheckout":"<value>"

         }

      }

Sample

{

   "profiles":[

      {

         "id":"00eW0000000EKg8",

         "name":"System Administrator 1",

         "permission":{

            "xa_contracts":"true",

            "xa_template":"false",

            "xa_checkinasfinal":"true",

            "xa_checkinwithredlines":"false",

            "xa_checkinwithoutredlines":"true",

            "xa_unlockreadonlyclause":"true",

            "xa_unprotectdocument":"true",

            "xa_hidecheckoutmenu":"false",

            "xa_disableautocheckout":"true" 

         }

      },

      {
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         "id":"00eA0000000nWXj",

         "name":"System Administrator N",

         "permission":{

            "xa_contracts":"true",

            "xa_template":"true",

            "xa_checkinasfinal":"true",

            "xa_checkinwithredlines":"true",

            "xa_checkinwithoutredlines":"true",

            "xa_unlockreadonlyclause":"true",

            "xa_unprotectdocument":"true",

            "xa_hidecheckoutmenu":"false",

            "xa_disableautocheckout":"true"  

         }

      }

   ]

}

To assign custom permissions to a user profile
Create custom permissions. For more information, see Custom Permissions.
Go to Setup > Manage Users > Profiles.
In the Enabled Custom Permissions section, click Edit.
Add required Custom Permissions and click Save.

To configure View Setup & Configuration Permission
For information on how to configure View Setup & Configuration permission, see Profile 
Settings and Security.

Configuration Priority
The following table provides the details about which configuration is given priority:

If the Code field has multiple entries for the same user profile, the first entry will be 
considered for feature access.
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APTS_ProfilePer 
missions 

Custom 
Permissions 

View Setup & 
Configuration 

User Access

Yes Yes Not applicable User is able to access the 
features according to 
the APTS_ProfilePermissions 
configuration. 

Yes No Not applicable User is able to access the 
features according to 
the APTS_ProfilePermissions 
configuration.

No No Not applicable User is unable to access the 
features.

No Yes Yes User is able to access the 
features according to the 
custom permission.

No Yes No User is unable to access the 
features.

Application Management Settings
Before you use the Conga CLM application to manage contracts, you must define the 
agreement record types. An agreement record type is a way of categorizing agreements 
and allows us to provide different page layouts to users based on their profile. The page 
layout provides a canvas for adding fields and related lists.

The following are some of the agreement record types:

Non-Disclosure Agreement (NDA)
Master Subscription Agreement (MSA)
Software License Agreement (SLA)
Statement of Work (SOW)

To enable a new agreement type,
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Define a new Page Layout
Create a new Record Type and associate it with the page layout
Enable the Record Type for Template Authoring

Enabling Record Type for Template Authoring
After you create a new record type, you must add it to the list of available X-Author for 
Contracts agreement types.

To Assign Agreement Record Types to Template 
Agreement Types

Click Setup > Create > Objects > Template.
Under the Custom Fields & Relationships section, click Agreement Types.
Scroll-down to the Picklist Values section and click New.
In the Agreement Types box, add one or more Agreement type picklist values and 
click Save.

If you have installed X-Author for Contracts, you can view the record type in the list of 
available options.

Populating Contract and Template Picklists
Templates are contract language templates available in the system. A template is a 
common set of sections, clauses, text, and placeholders for terms and conditions. 
Templates can be merged with structured data to generate agreements or proposals. 
Templates are stored within an Apttus template repository, and are used to create quotes 
and contracts. You can create distributable documents with Conga CLM templates.

Templates can include standard and non-standard language. Contract and template 
picklists are populated to define subtypes for contracts, categories, subcategories, and 
supported contract types for templates.

The following topics will provide you information about creating contract picklists and 
template picklists.

Populating Picklist Values for Contract Object
Go to Setup > Create > Objects.
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Under the Label column, click Agreement to edit the custom Agreement object. The 
custom object definition is displayed.
Scroll down to the Custom Fields & Relationships related list and click the Record 
Types Field Label. The Subtype custom field definition is displayed.
Scroll to the Picklist values section and click New.
Add one or more picklist values. For example, for an NDA agreement, you can add 
One Way Inbound NDA, One Way Outbound NDA, Mutual NDA, Subcontractor picklist 
values. These picklist values can be applied to any type of agreement.
Select the Record Type Names for the picklist values and click Save.
To sort the picklist items in the desired order, click Reorder. You can sort the list 
alphabetically and select one of the values as the default value by choosing one of 
the values from the Default Value list. To keep the changes, click Save.

Picklist values for the contract object is populated.

Populating Picklist Values for Template Contract 
Types

Go to Setup > Create > Objects.
Under the Label column, click Template to edit the custom Template object. The 
custom object definition is displayed.
Scroll down to the Custom Fields & Relationships related list and click the Agreement 
Types Field Label.
Click New to define a picklist value for each and every record type you have defined 
in the system. If you add a new contract record type, you must also add the type to 
this set of picklist values for the system to work properly. In other words, the values in 
this picklist and the record types defined for the system must be kept in sync. For 
example, if you have defined an NDA agreement record type, add it to the picklist 
values.
Add one or more picklist values and click Save. You can reorder the picklist values and 
select one as the default value. The default value selected must be the same as the 
default record type. Also, you can sort and define the default.            

Picklist values for the template contract types is populated.

Populating Picklist Values for Template Subcategory
Go to Setup > Create > Objects.
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Under the Label column, click Template to edit the custom Template object. The 
custom object definition is displayed.
Scroll down to the Custom Fields & Relationships related list.
Click the Subcategory Field Label.
Click New to create subcategory picklist values. Create subcategory picklist values 
similar to the way you created picklist values for the category.
Assign subcategory values to the appropriate categories.
Scroll to the Field Dependencies related list and click the Edit action to the left of the 
Subcategory dependent field. Follow the instructions to include or exclude 
subcategory values for a particular category.
Click Save.

Picklist values for the template subcategory is populated.

Creating Formula Fields for an Agreement Rule 
Criteria
You may use the Formula Fields tab to create relationship fields which may be used in the 
Agreement Rule conditions.

 

To create a formula field
Click  and click Formula Fields (Comply) and to create a new formula field, click 
New.   
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Type a mandatory Field Name, and select a mandatory Business Object. For 
example, to create a new Formula Field for the Opportunity Stage field from the 
Agreement object using the Related Opportunity lookup, type Field Name = 
Opportunity Stage, and select Business Object = Agreement.
Type a mandatory Formula, and type a Description and click Save. For example: 
Formula = Apttus__Related_Opportunity__c.StageName.  

 
To create a new Formula Field for the Opportunity Type field from the Agreement 
object using the Related Opportunity lookup, type Field Name = Opportunity Type 
and Formula = Apttus__Related_Opportunity__c.Type.
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Click Save. 

 

The Formula Fields are added and displayed in the Field list as a Related Field. 

          

Saving Agreement Data
The Is Transient feature ensures the safety of your agreement data against the following 
unexpected events:

Hardware failure. For example, network or system break-down.
Human error. For example, the user suddenly abandons the record creation process 
midway, without knowing the impact or consequence.

The above-mentioned cases could cause agreement data loss, resulting in time-consuming, 
costly, and long contract cycles making monitoring and managing agreements a 
challenge.
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Is Transient feature keeps records in a transient state as a precautionary measure. This 
allows you to retain or retrieve your data at any stage in the contract life cycle until you 
save the data.

This field is displayed as a checkbox on the agreement record. By default, the Is Transient 
checkbox is selected, signifying the agreement data is safe and retainable until you 
explicitly save it.

Conga CLM application treats all such freshly created agreements as transient data and 
displays the Is Transient checkbox as selected. This helps you (System Administrator) easily 
identify, run a report, and delete all the transient agreements (or such agreements which 
are not explicitly saved).

This is the standard behavior of the application and a critical facet to the design, 
implementation, and usage of any system which stores, processes or retrieves data.

If this field is not displayed, you can add it by editing the page layout.

Overriding Base Clone Specifications
Configuring clone specification indicates which custom objects need to be cloned as part of 
the agreement clone operation.

Use the clone specifications to override the base configuration for cloning the agreement. 
The base clone specifications are defined in the APTS_ComplyConfig admin entry.
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The APTS_ComplyConfig XML admin property is used to override base clone specifications 
for agreements. The base clone specification and the custom clone specification are 
merged in to a single clone specification to determine the objects to clone.

Overriding Clone Behavior of Custom Objects
 
By default, all custom objects related to an agreement are automatically cloned. If one or 
more custom objects are to be excluded, it can be accomplished by creating a custom clone 
specification listing the custom objects in the excludes element.

By default only the base objects listed in the includes element are cloned. If one or more 
base objects are to be included, it can be accomplished by creating a custom clone 
specification and listing the base objects in the includes element. If one or more base 
objects are to excluded, they can be listed in the excludes element, provided the base clone 
specification allows the override (or, the isOverridable property is set to true).

Configure Clone Specifications Based on Record Types
You can configure separate clone specifications for each record type. If there are no clone 
specifications configured for a record type the default setting (APTS_ComplyConfig) is 
selected during clone operation.

Clearing Cloned Agreement Field Values
You can configure the clone feature to automatically clear certain field values for the 
cloned agreement.When you clone an agreement and go to the Agreement Edit page, any 
fields that have been configured to be cleared will have their values removed. This 
eliminates the need to have to go through the edit page clearing values before you save 
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the agreement. Clearing field values applies to all your agreements, regardless of their 
agreement type.

You must add code to APTS_ComplyConfig to indicate which fields you want to clear after 
cloning an agreement.

Configuring APTS_ComplyConfig
Configuring clone, amend, and renew specifications indicate which custom objects need to 
be cloned as part of the agreement clone, amend, and renew operation. You can create 
specifications according to your requirement. Following are the sample specifications:

Clone: APTS_ComplyConfig_Clone
Amend: APTS_ComplyConfig_Amend
Renew: APTS_ComplyConfig_Renew

If all the specifications are deleted or no specifications are configured, then all the field 
values are cloned when you clone, amend or renew an agreement. When the default 
APTS_ComplyConfig specification is configured and separate clone, amend, or renew 
specifications are not available, the default specification will apply when you clone, 
amend, and renew an agreement.

You can add Document Version Detail, Document Version, Note, and Attachment in the 
clone spec to copy documents to the cloned, amended, or renewed agreement (new 
agreement). The following table lists the various scenarios and their outcome when you use 
clone spec to clone, amend, or renew an agreement.

This property can be used when you renew an agreement and want to control the 
fields which should be excluded during the cloning process.
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Document 
Version

Document 
Version Detail

Note Attachment/ 
Files

Documents copied to the 
cloned, amended, and 
renewed agreement (new 
agreement)

True True True/False True/False All the document details 
and documents from the 
document version are copied 
from Document Version and 
Document Version Detail to 
the new agreement.

By default, Note and 
Attachment/Files are copied 
to the new agreement. If 
excluded, documents are not 
copied to the new 
agreement.

 

False False True/False True/False No documents are copied 
from Document Version and 
Document Version Detail to 
the new agreement.

By default, Note and 
Attachment/Files are copied 
to the new agreement. If 
excluded, documents are not 
copied to the new 
agreement.

Conga recommends 
using this 
configuration.
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Document 
Version

Document 
Version Detail

Note Attachment/ 
Files

Documents copied to the 
cloned, amended, and 
renewed agreement (new 
agreement)

True False True/False True/False Only the document details 
from the document version 
(the first level of the 
document version) are 
copied to the new 
agreement.

By default, Note and 
Attachment/Files are copied 
to the new agreement. If 
excluded, documents are not 
copied to the new 
agreement.

 

To configure APTS_ComplyConfig
Click ( ) and click Admin.
From the Recent Admin relation list, select APTS_ComplyConfig. Optionally, if the 
property is not listed on the page, click Go and then select APTS_ComplyConfig. 
 

Conga does not 
recommend this 
configuration.
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Click Edit and between the<ComplyConfig><AgreementSpec><CloneSpec> </ 
CloneSpec></AgreementSpec></ComplyConfig>tags, enter the 
new<ClearFields>tags and then enter the API name for each agreement field that 
you want to clear.

<ClearFields>

<ClearField>

<Name>Apttus__Company_Signed_By__c</Name>

</ClearField>

<ClearField>

<Name>Apttus__Company_Signed_Date__c</Name>

</ClearField>

</ClearFields>

The above code snippet example, the Company Signed By and Company Signed Date 
fields are be cleared from the Agreement record when you clone any agreement

<ComplyConfig>

   <AgreementSpec>

      <CloneSpec>

         <Includes>

            <ChildObject>

               <Name>Apttus__APTS_Agreement__c</Name>

               <IsOverridable>true</IsOverridable>

            </ChildObject>

            <ChildObject>

You can add various items that can be configured in the XML.
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               <Name>Apttus__DocumentVersion__c</Name>

               <IsOverridable>true</IsOverridable>

            </ChildObject>

            <ChildObject>

               <Name>Apttus__DocumentVersionDetail__c</Name>

               <IsOverridable>true</IsOverridable>

            </ChildObject>

            <ChildObject>

               <Name>Apttus__AgreementLineItem__c</Name>

               <IsOverridable>true</IsOverridable>

            </ChildObject>

            <ChildObject>

               <Name>Note</Name>

               <IsOverridable>true</IsOverridable>

            </ChildObject>

            <ChildObject>

               <Name>Attachment</Name>

               <IsOverridable>true</IsOverridable>

            </ChildObject>

         </Includes>

         <ClearFields>

            <ClearField>

               <Name>Apttus__Special_Terms__c</Name>

            </ClearField>

         </ClearFields>

      </CloneSpec>

   </AgreementSpec>

</ComplyConfig>

Add all the required fields and click Save. 
A full list of fields to be cleared is included in APTS_Config. 
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Configuring Clone Specifications Based on Record Types
You can configure separate clone specifications for each record type. 

To configure clone specifications based on record types:
Navigate to Admin Home page.
Click New. This displays Admin Edit page.
Enter the following details: 
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Name: APTS_ComplyConfig_<Action>_<RecordType> 
Sample value: APTS_ComplyConfig_Renew_MSA 
Ensure that you create a single clone specification for each record type.
Value: XML
Code: Enter clone specification

Click Save.

Creating Validation Rules
Validation rules verify the data entered by a user in a record meets the specified standards 
before the user can save the record. A validation rule can contain a formula or expression 
that evaluates the data in one or more fields and returns a value of True or False.

The following task creates a validation rule for evaluating the agreement start and end 
dates. It will ensure you cannot save an agreement record with a start date that begins 
after the end date.

To create a validation rule
Go to Setup > Create > Objects > Agreement.
Scroll-down to the Validation Rules related list and click New.
Type End Date after Start Date in the Rule Name box and select Active.
Type a logical description for the validation rule.
Click Insert Field to select the Apttus Agreement and Agreement Start Date and click 
Insert.
Click Insert Operator to select the > Greater Than operator.
Click Insert Field again to select the Apttus Agreement and Agreement End Date.
In the Error Message box, type an appropriate error message and click Save.

Adding and Defining Action Panel
The Action Panel is a collection of agreement action buttons that can be enabled for the 
Agreement Record page in the Classic mode for community portals. The Action Panel is 
created as a Visualforce Page component and you can include it in your page layout from 
admin objects. Each button in the action panel can be customized to meet your design 
requirements. The buttons have a default image and you can also use a custom image for 
buttons.
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Prerequisites
Make sure that the required buttons are created. For more information, see Customizing 
Agreement Actions.

To add Action Panel from Salesforce Classic
Click + and click Admin. All the out-of-the-box Admin entries are displayed on the 
Admin home page. Based on your organizations requirement, you may want to add or 
create new Admin entries.
Click APTS_CustomLinksforActionPanel.
In the Value field, enter the API names of required buttons separated by comma.
Click Save.

Conga CLM Objects
Conga CLM objects contain fields that are maintained in the corresponding tables for the 
objects.

 

 

 

Object Purpose of the Object

Account Hierarchy This defines a single instance of an account hierarchy 
relationship. It contains the leaf Id, the parent Id, the root 
Id, and the level.

Agreement Action Condition Represents conditions to enable agreement actions

Agreement Explorer A reusable, unique combination of Field Sets and Filter 
Sets.

Note

Check organization-wide defaults set for the objects. This table is intended for guidance 
purpose only.
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Object Purpose of the Object

Agreement Hierarchy This defines a single instance of an agreement hierarchy 
relationship. It contains the leaf Id, the parent Id, the root 
Id, and the level.

Agreement Line Item Represents a product or service line item associated with 
an agreement

Agreement Lock Represents a lock on the agreement

Agreement Clause Represents a clause associated with an agreement

Agreement Document Links to agreement documents that are not stored in 
Conga CLM 

Agreement Protection Specifies protection settings for agreements generated by 
the Contract Wizard and maintained by the Contract 
Author

Agreement Rule Condition Specifies a condition used to evaluate an agreement rule

Agreement Rule Specifies a rule used to evaluate various agreement 
actions such as submit request

Agreement Term Exception Term Exceptions associated with a given Agreement

Admin Store admin preferences and metadata

Agreement Represents an agreement in the system

Related Agreement To identify the different types of relationships between 
agreements

Template Contract language templates available in the system. 
These templates specify guidance, language, local 
setitngs, and include Word attachment templates 
representing the bulk of actual contracts that can be used 
when creating a first draft . Templates can include 
standard and non-standard language.
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Object Purpose of the Object

Async Merge Call Holds asynchronous merge calls

Content Event Holds content events for subscribers to handle

Cycle Time Field Data Holds the data captured on fields for cycle time reporting

Cycle Time Field Holds the fields monitored for cycle time data capture

Cycle Time Group Data Holds the data captured on groups for cycle time reporting

Cycle Time Group Holds the groups monitored for cycle time data capture

Doc Assembly Component Represents a single component in a document assembly 
rule

Doc Assembly Ruleset Represents a rule set that contains a list of rules to 
determine the sections to include in a dynamic template.

Doc Assembly Rule Represents a single rule in a document assembly ruleset

Document Agreement Clause Agreement clauses in an agreement document

Document Version Detail Holds the version details of a document

Document Version Represents a document version

Agreement Document Output 
Format

Holds default output format preferences by user profile 
and agreement type for use in the agreement document 
generation process.

Formula Field (Comply) Represents a formula field used in agreement rules

Merge Event Detail Holds document merge event details

Merge Event Holds document merge events for subscribers to handle

Query Template Filter Filter expression used in a query

Query Template Qualifier Filter used to select a query template
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Object Purpose of the Object

Query Template Query Template for bulding soql queries and filters

Retention Policy Holds object retention policies

Search Filter (Comply) Represents a search filter

Template Clause Reference Version Holds Template Clause References for this version

Template Clause Reference Represents a clause reference in a template or a library

Template Datasource Filter Represents a datasource filter associated with a template

Template Dynamic Section Version Holds the template dynamic section details for a given 
template version

Template Dynamic Section Represents a dynamic section in a template

Template Version Holds various versions of this template and is a Master- 
detail to Template

Temp Object (Comply) A container for temporary objects and attachments

Term Exception Term Exceptions master table

Wizard A runtime instance of the wizard design

Wizard Design Holds all the wizard design records

Wizard Input Control The individual question, instruction statements and 
associated field attributes

Wizard Input Control 
Runtime(Deprecated)

Input Control instance within a runtime wizard

Wizard Input Control (Deprecated) The individual question, instruction statements and 
associated field attributes

Wizard Input Group (Deprecated) Groups input controls within a step
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Object Purpose of the Object

Wizard Rule Individual rules which are applied within a ruleset.

Wizard Ruleset A collection of rules that are applied to input control and 
steps. The system determines a ruleset at the level of input 
control expression formula, determine focus objects, record 
type and step navigation rules.

Wizard Ruleset Runtime 
(Deprecated)

A runtime instance of the ruleset provided by the wizard 
design

Wizard Ruleset (Deprecated) A collection of rules that are applied to input control and 
steps. The system determines a ruleset at the level of input 
control expression formula, determine focus objects, record 
type and step navigation rules.

Wizard Rule (Deprecated) Individual rules which are applied within a ruleset.

Wizard Runtime Input Input Control instance within a runtime wizard

Wizard Runtime (Deprecated) A runtime instance of the wizard design

Wizard Step The step that is designed and used in Wizard designs.

Wizard Step Runtime (Deprecated) A runtime instance of a wizard step design.

Wizard Step (Deprecated) The step that is designed and used in Wizard designs.

Wizard Design (Deprecated) Main Wizard Object, each record represents a Wizard 
design

Objects Supporting Document Generation
For any object to support Document Generation, there can be 2 options.

For any object, if the value is Yes, the system supports Document Generation for that 
object but certain setup needs to be done.
The value No indicates that the Document Generation is not supported for that 
object.
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The following table contains the summary of whether Document Generation feature is 
supported for the specific objects or not:

Feature Description Agreement 
Object

Quote/ 
Proposal 
Object

Standard 
Salesforce 
Objects

Other Custom 
Objects

Merge service endpoint Yes Yes Yes Yes

Controlling Merge Call 
Time out (default 60sec)

Yes Yes Yes Yes

Publish Merge Events Yes No No No

Generate Document from 
Record

Yes Yes Yes Yes

PDF security on 
generated document

Yes Yes Yes Yes

Protection on generated 
Word document

Yes No No No

Versioning. Word 
document protection

Yes Yes Yes SR

Async mode of Merge Yes Yes   

Template setup for 
default system filtering 
on generate and other 
Template functionality 
from X-Author

Yes Yes Yes Yes

Auto Enabling Checking 
In for Final version in PDF 
format

Yes Yes Yes Yes

Auto Enable 
Reconciliation

Yes Yes Yes Yes
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Feature Description Agreement 
Object

Quote/ 
Proposal 
Object

Standard 
Salesforce 
Objects

Other Custom 
Objects

Header / Footer Stamp Yes No No No

Enabling Term 
Exceptions In Author

Yes No No No

Create New Template

Check-in Template

Yes Yes Yes Yes

Check-out Template Yes Yes Yes Yes

Clone Template Yes Yes Yes Yes

Template Playbook: 
default Search, Select, 
Insert Clause inline / as 
reference

Yes Yes Yes Yes

Insert Merge Fields for 
corresponding Objects

Header
Lookups
Related - In 
Section
Related - In Table

Yes Yes Yes Yes

Insert Smart Merge Fields 
for corresponding 
Objects

Header
Lookups
Related - In 
Section
Related - In Table

Yes Yes Yes Yes

Document Assembly 
Rules 

Yes No No No
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Feature Description Agreement 
Object

Quote/ 
Proposal 
Object

Standard 
Salesforce 
Objects

Other Custom 
Objects

Filtered Rows Yes Yes Yes Yes

Conditional content Yes Yes Yes Yes

Auto-publish Yes Yes Yes Yes

Output Format (Doc, 
Docx, RTF, PDF) and add 
Watermark Support for 
the generated document

Yes Yes Yes Yes

Support Controlled 
Preferences for Output 
Format and 
Watermark *pairs: 
Record Type / User Profile

Yes Yes No No

Check-in third-party 
document. Import Offline 
– Create a record and 
attach

Yes No No No

Check-In third-party 
document. Import Offline 
– Attach to an existing 
record

Yes No No No

Check-In document, 
attachment of the 
record. Versioning of the 
Documents, such as

With Redlines
Without Redlines
Final to be Signed
Watermark
Naming Override

Yes Yes Yes Yes
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Feature Description Agreement 
Object

Quote/ 
Proposal 
Object

Standard 
Salesforce 
Objects

Other Custom 
Objects

Check-out document, 
attachment of the record

Yes No No No

Compare documents, 
attachments of the 
record

Yes Yes Yes Yes

Locking: Refresh Lock Yes No No No

Create Section: Save 
selection as agreement 
clause

Yes No No No

Playbook: Insert Clause 
into the Document on the 
records

Yes No No No

Reconcile documents

Highlight Smart 
Fields
Reconciliation of 
the values

Yes Yes Yes Yes

Tag Smart Fields Yes Yes Yes Yes

Update Document from 
Salesforce

Yes No No No

Multicurrency support by 
the products of the 
system:

Merge-Comply- 
Proposals
X-Author

Yes
Yes 
 

No
Yes

No
Yes

No
Yes

Chatter with Record Yes Yes Yes Yes
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Temporary Email Template Cleanup
You may find in some cases that contents in your Apttus Temporary Email Templates 
folder contain sensitive contractual data as attachments to offline agreements. To remedy 
this, you can use the following APEX job and associated Comply System Property to clean 
up temporary email templates that are older than a configured period. When this job runs 
it checks for all temporary email templates older than the period configured by the new 
Comply System Property and deletes them.

Step 1: Configure APEX Scheduler Job
Schedule a new job using the Apex Scheduler using the standard Salesforce process.

From Setup, enter "Apex Classes" into the Quick Find box, select Apex classes, and 
click the Schedule Apex button.
Enter a Job Name and click the lookup button to choose CleanupJobScheduler as the 
Apex Class.
Choose the job Frequency and other execution options for the class.
Click Save.

Step 2: Configure Comply System Property
Use the Temp Email Template Inactive Hours Comply System Property to set the orphan 
period of temporary email templates to use in conjunction with the CleanupJobScheduler 
APEX class. The default value of this property is set to 4 hours.

Navigate to Setup > Develop > Custom Settings.
Click Manage next to Comply System Properties.
Click Edit.
Specify a value for the property Temp Email Template Inactive Hours. This sets the 
number of hours after which a temporary email template is considered inactive. When 
the CleanupJobScheduler job runs (Step 1), any temporary email templates which are 
older will be deleted.
Click Save.

Note: You cannot set this property value to zero (0) as it will interfere with the 
execution of your email templates. Please set the property to 1 or higher if you intend 
to configure temporary email cleanup.
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Schedule Jobs to Refresh Agreement Data
Because the Agreement Explorer works off data stored in the most recent cache for the 
Agreement object, users may find that more recently created agreement records are not 
being listed in their reports. Users must use the Refresh Data button in Report Settings to 
refresh the data pool extracted from object tables in the database. Instead, you 
can schedule a job using the Apex Scheduler to refresh data such as agreement hierarchy 
and account hierarchy, in the background.

Agreement Hierarchy
Perform the following steps to schedule a job to refresh agreement hierarchy.

Go to Setup.
Under Develop, click Apex Classes.
Click Schedule Apex. 
Enter a name in the Job Name field.
Click the lookup button next to the Apex Class field and select the 
AgreementHierarchySchedulableBatch class.
In the Schedule Apex Execution section, select the job frequency, start date, end date, 
and preferred start time for the class.
Click Save.

Accounts Hierarchy
Perform the following steps to schedule a job to refresh accounts hierarchy.

Go to Setup.
Under Develop, click Apex Classes.
Click Schedule Apex. 
Enter a name in the Job Name field.
Click the lookup button next to the Apex Class field and select the 
AccountHierarchySchedulableBatch class.
In the Schedule Apex Execution section, select the job frequency, start date, end date, 
and preferred start time for the class.
Click Save.
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Scheduling Expiration Date for Email 
Downloadable Link
You can send a downloadable link for downloading multiple documents of multiple 
agreements through email, to selected contacts or to a user group without downloading 
the agreement documents and sending them through email individually.

Step 1: Configure an APEX Scheduler Job
Go to Setup > Develop > Apex Classes > Schedule Apex.
Enter the following information to configure the job parameters.

Job Name: Enter a job name.
Apex Class: Click the  icon. Enter AgreementDocumentEmailCleanupJob and 
select AgreementDocumentEmailCleanupJob. 
Frequency: Select Weekly or Monthly based on your requirement.

If you select Weekly, you must specify one or more days of the week the 
job needs to run (such as Monday and Wednesday).
If you select Monthly, you must specify the date the or the day (such as 
the second Saturday of every month)

Start: Select a start date.
End: Select an end date.
Preferred Time: Select a preferred time for the dropdown.

Click Save.

Step 2: Configure the Admin Object
Go to the Admin tab (click + and choose the Admin tab.) Click Go to view all Admin 
objects (your list can vary depending on which objects are already created).
Click New Admin. This displays the Admin Edit page.
Enter the name as APTS_DownloadableLinkExpiration.
Enter the value according to your requirement. The value field corresponds to the 
number of days to expire the downloadable link.
Click Save.
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Adding Custom Locale
To create a custom locale, you need to first add a custom locale name and then add 
relevant locale code for the locale name. You can then set up custom locales to create 
localized templates or contracts in X-Author Contracts. You can select the number 
precision and currency precision according to your requirement, but the date format and 
number format are displayed based on the Locale Code.

Prerequisite
Ensure to format the Locale Names and Locale Codes correctly as there is no system 
validation on these values.
You cannot create duplicate locales or create locales with the standard Locale 
Names which come available with the Contract Management application (refer to 
 Standard Locale Names and Locale Codes).
You must provide the Locale Code in <ISO Language code>-<ISO Country code> 
format. The locale code is not case sensitive.

To add a custom locale 
Go to Setup > Build > Create > Objects.
Click the Template Locale hyperlink.
In the Custom Fields & Relationships section, click the Locale Code hyperlink.
In the Values section, click New.
Enter the locale code.
Click Save.
Navigate back to Template Locale.
In the Custom Fields & Relationships section, click the Locale Name hyperlink.
In the Values section, click New.
Enter the locale name.
Click Save.
In the Locale Name page, navigate to the Field Dependencies section and click Edit 
before Locale Code.
Click Next and find the locale name that you have added.
Select the locale code that you have added.
Click the Include Values button.
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To make a custom locale available for X-Author 
Contracts

Navigate to the Locale tab. 
This displays the Locale Home page.
Click New. 
This displays the Locale Edit page.
Select a locale name from the Locale Name dropdown. 
The Locale Code field is auto-populated based on Locale Name input.
Select Number Precision and Currency Precision from the Default Number Precision 
and Default Currency Precision dropdown respectively.
Click Save to save your locale setting or click Save & New to save the current locale 
setting and add a new locale setting.

Standard Locale Names and Locale Codes
The following table lists the standard locale names and locale codes that are available in 
Contract Management:

Locale Name Locale Code

Chinese zh-CN

English (Canada) en-CA

English (Ireland) en-IE

English (United Kingdom) en-GB

English (United States) en-US

German de-DE

Greek (Greece) el-GR

Italian it-IT

Japanese ja-JP
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Locale Name Locale Code

Korean ko-KR

Norwegian nb-NO

Polish pl-PL

Portuguese pt-BR

Russian ru-RU

Russian ru-RU

Spanish es-ES

Swedish sv-SE

Thai th-TH

Configuration to Email Multiple Agreement 
Documents in Lightning
You need to whitelist your domain for cross-origin resource sharing (CORS) in Salesforce 
Lightning to email multiple agreement documents in lightning.

To configure CORS
Go to Setup > Security > CORS.
In the Whitelisted Origins section, click New.
In the Origin URL Pattern field, add <yourdomainname>.lightning.force.com 
Sample value: https://testclm.lightning.force.com.
Click Save.
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Configuring Email Templates in Lightning
You can create separate email templates for Lightning that you can view while submitting 
request, sending documents for review, and signatures in Lightning. You can also restrict the 
availability of these email templates to a group of users.

You must create a temporary folder to save temporary templates. If you do not create the 
temporary folder, the temporary email templates are added to the folder that contains 
Lightning email templates. 

You can add merge fields in the subject as well as the body. To add a merge field in the 
subject, you need to add the merge field in the body then copy the merge field to the 
subject.

You can also configure agreement rules to autoselect an email template when you 
are submitting request, sending documents for review, and signatures in Lightning. For more 
information on configuring agreement rules, see Setting Up Rule-based Agreement Request 
Process Parameters.

To configure email templates in lightning
Go to Setup > Email > Lightning Email Templates.
Enable Folders and Enhanced Sharing.
Go to the Email Templates tab.
In the Folders section, click All Folders.
Click the New Folder button.
Enter the Folder Label and Folder Unique Name according to your requirement and 
click Save. 
Navigate to the All Folder page and click the New Email Template button.
Enter the template’s name.
From the Related Entity Type dropdown list, select Agreement.
(Optional) Enter a description.
Click the Select Folder button and select the folder that you created in Step 6.
If you want, select a letterhead from the Enhanced Letterhead dropdown list.
In the HTML Value field, compose the email to use as your template.
Add any images you want in the template. Use the Insert Images icon or copy and 
paste the image.
Click the Merge icon and use the merge picker to insert merge fields.
Click the Source icon to add HTML code.
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Add any attachments you want in the template.
Click Save.

To share the email template folder with other users
In the Folders section, click All Folders.
Click   next to the folder you want to share.
Select Share.
Enter the required details and click Done.

To configure a temporary folder 
Navigate to the Email Templates tab.
In the Folders section, click All Folders.
Click the New Folder button.
Enter the Folder Label as ApttusLightningTempEmailTemplate.
Enter the Folder Unique Name as ApttusLightningTempEmailTemplate.
Click Save. 

Setting Up Organization-Wide Email Address
The organization-wide email address allows you to associate an email address to user 
profiles. When you assign an organization-wide email address for all the user profiles or 
selected user profiles, users can use the common email address while sending emails. You 
can set up multiple organization-wide email addresses, but you can use only one 
organization-wide email address to send emails. When an organization-wide email 
address is not set up then the logged-in user email address is used to send emails.

Prerequisites
You must configure the following comply system properties: 

Organization-Wide Email Address Display
Use Organization-Wide Email Address

For more information, see Comply System Properties.

To set up or organization-wide email address
Go to Setup > Email > Organization-Wide Email Addresses.
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Click New.
Enter a display name and email address.

According to your requirement, select one of the following options.
Allow All Profiles to Use this From Address
Allow Only Selected Profiles to Use the From Address

Select profiles for which you want to allow the users to select the organization-wide 
address.
Click Save.

Generating Registration Setting
Smart search is part of the base package. Conga recommends that the Registration 
Setting must be available for only Admin users.

Registration setting is required to use the Smart Search feature. If you are a Conga licensed 
user, you can automatically Generate the registration setting by using an authentication 
code sent to your email address. If the domain of your email address matches with the 
domain of the contact email address maintained in Conga's LMA system, the Registration 
Setting is generated. If you are a licensed user and encounter any errors or do not receive 
an authentication code while generating registration setting automatically, within 72 hours 
you will receive an email with registration details from maxcustomersupport@conga.com 
and you can add registration details manually by using the Add Details button. 

When you generate registration setting details automatically, the Registration URL is 
added by default. If you need to use any other URL, you need to configure CSP Trusted Site 
and Remote Site Setting for the URL.

Contact the Conga Support team if you:

You need assistance in generating registration setting.
You need to change any registration setting details (Registration URL, API Token, or 
Tenant). 
You are not a licensed user and want to use the Smart Search feature.

Prerequisite
You must have an enterprise license for any of the Conga products.

The display name that you add here must also be added in the Organization- 
Wide Email Address Display comply system property.



mailto:maxcustomersupport@conga.com
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You have activated remote site settings (IntegrationSettingProd and 
IntegrationSettingSandbox), and CSP trusted sites (IntegrationSettingsProdURL and 
IntegrationSettingsSandboxURL). For more information, see Connecting to External 
APIs.

Restriction
You can configure only one registration setting per org.

To generate registration setting details automatically
Go to the Registration Setting tab.
Click Generate. 
The Generate Registration Setting popup is displayed.
In the Customer Name field, enter your organization name.

(Optional) Enter a new registration URL.  
The Registration URL is automatically added based on the org (production or 
sandbox) you are using. You can update it according to your requirement.
Select Search Content in Large File checkbox to allow users to searching content in 
large files. 

Click Generate. 
An email with Tenant, SmartSearch Endpoint URL, and One-time key is sent to your 
email address if you are a licensed user. The validity of the authentication code is 10 
minutes.
(Optional) If you do not receive the authentication code in 15 seconds, the Send 
Authentication Code again hyperlink is enabled and you can click the hyperlink to 
generate a new authentication code.  
If you still do not receive the authentication code or encounter any errors, you can 
revisit the Registration Setting page after 72 hours and add the registration setting 
details manually or or contact the Conga Support team. 

In the Customer Name field, you can only add alphanumeric characters 
without any space.



Ensure that you select the checkbox only if you need to search content in large 
files (file size greater than 10 MB). Users might observe an increase in page 
loading time after selecting the checkbox.
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Enter the One-time key from the email in the Authentication Code field and click 
Verify. 
The Registration Setting is generated.

To add registration setting details manually
Prerequisite: Ensure that you have received an email with registration setting details from 
the Conga Support team. 

Go to the Registration Setting tab.
Click Add Details.
Enter Tenant, Registration URL, API Token from the email.
Select Search Content in Large File checkbox to allow users to searching content in 
large files. 

Click Save.

To edit registration setting details
Prerequisite: You have requested and received a new API token and registration details 
from the Conga Support team. The Conga Support team will share the new registration 
details via email. 

Go to the Registration Setting tab.
Click Edit.
Update the required details.
Click Save.

If you click the Send Authentication Code again hyperlink, the previously 
generated one-time key will not be valid.



If you cancel the generation process and restart the generation process, you cannot 
enter the same customer name that you used the first time as the name is locked for 
15 minutes. To use the same name, you can retry with the same name after 15 
minutes.



Ensure that you select the checkbox only if you need to search content in large 
files (file size greater than 10 MB). Users might observe an increase in page 
loading time after selecting the checkbox.





CLM

219
 

Copyright ©2022 Apttus Corporation. All rights reserved.
 

1.
2.
3.
4.

5.
6.
7.

8.

Configuring Notification Email for Review Cycle 
Cancellation
You must create a classic email template to notify reviewers when a review cycle is 
cancelled.

To create the parallel review cycle cancellation email 
template

Go to Setup > Email > Classic Email Templates > New.
Select HTML and click Next.
Enter ParallelReviewCycleCancelNotification in the Email Template Name field.
Select remaining options according to your requirement and click Next.  
For more information, see Salesforce documentation.
Add a subject for the message and add an HTML message.
Click Next.
Click Copy text from the HTML version to automatically paste the text from your 
HTML version without the HTML tags.
Click Save.

Managing Templates
Conga CLM template is a common set of sections, clauses, text, and placeholders for terms 
and conditions. Templates can be merged with structured data to generate agreements or 
proposals. Templates are stored within an Apttus template repository, and are used to 
create quotes and contracts. A template can be termed as a blueprint or mold for creating 
distributable documents.

X-Author for Contracts is a Microsoft add-in designed to work with Microsoft Word. It 
allows users to dynamically interact with Salesforce data and updates Word with two 
Apttus-specific ribbons. In a typical scenario where an agreement/proposal document is 
sent to an external party for negotiation, the external party makes changes to the 
document as part of the negotiation.

Template Administrators maintain and manage contract and clause templates. These 
templates contain merge fields, which pull the respective field values to create 
distributable documents the template is generated. Template Administrators can perform 
the following tasks:

https://help.salesforce.com/articleView?id=sf.creating_custom_html_email_templates.htm&type=5
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Create complex contract templates from existing Word documents or other contract 
templates kept in Salesforce
Apply conditional clauses or text to display if the condition is met
Insert smart fields enabling reconciliation with the agreement/proposal
Insert clauses from clause libraries which get resolved during the generation of the 
contract agreement
Translate contracts from one language to another 
 

If the changes to the document involve data belonging to the agreement/proposal record, 
then the reconciliation provides the mechanism to ensure the values in the document and 
the agreement/proposal records are reconciled.

For details, see X-Author for Contracts.

Setting Up Template Object for Contract Management
Securing Documents 
Word Trust Center/Protected View options can impact your ability to see generated 
documents and should be disabled before you begin using X-Author Contracts.
Agreement Clause 
Clauses have embedded merge fields contained within them that get auto-populated 
during agreement creation time.
Agreement Clause Subcategories 
Subcategory picklists display values based on what was selected in the Category 
picklist. The picklists also now behave the same for both the Playbook and Create 
Section dialog, in that they both have Category and Subcategory drop-down lists.
Creating Offline Agreements 
You can create offline agreements directly in X-Author by taking an existing Word 
document that was created outside of Salesforce and has not previously been 
associated with an agreement.
Auto Publishing 
Publishing templates improves document generation performance by taking 
referenced clauses in a template and 'publishing' them before the template is used to 
generate a document. This takes the content of the clause and enters it into the 
template body as static text, as if it was another part of the main template. Auto- 
publishing enhances this by enabling you to schedule a batch job, which will 

Ensure that the API name of the smart fields you insert in your template do not end 
with start or end.



https://documentation.conga.com/x-author-for-contracts/latest/x-author-for-contracts-154927679.html
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automatically complete the publishing task that previously needed to be completed 
manually.
Document Generation for Templates with Nested Clauses 
The Autopublishing features improve document generation performance, but some 
Contract Management customers choose to generate documents without using the 
Autopublishing features.
Query Template 
Using template filtering rules, you can set up user-defined filters to narrow the list of 
templates that display for tasks that involve previewing or generating documents. 
For example, for agreement templates created for multiple regions, you should only 
be able to select templates for the region to which they belong. The template filter 
uses agreement fields and related child object fields to select the templates to 
display.
Template Datasource Filter 
Template Datasource Filter enables you to filter the records of various business 
objects in your Agreement document based upon the filter criteria.
Dynamic Document Assembly 
Dynamic Document Assembly enables you to preconfigure filter rules that drive a 
sequence of prescribed dynamic clause insertions in a generated document. This 
results in a complete and well-formed agreement using a combination of contract 
field values. These contract field values are expressed as a user-configured key that 
determine the desired contract clause content during document generation.
Setting Up Template Filtering Rules 
By setting up the template filtering rules, the Template selection page can be 
configured to set up user-defined filters to narrow the list of Templates displayed to 
the user for Preview/Generate/Generate Supporting Document/Regenerate tasks. The 
template filter is set up by an administrator and allows agreement fields and related 
child object fields to be used in selecting the templates.
Agreement Term Exception 
An exception clause or term is a stipulated condition in your agreement that may 
need approval from management, to grant or prevent certain allowances to or from 
a particular group of users in your agreement. Contract Management enables you to 
associate such exception clauses or terms to your agreement document as a 
separate agreement term exception record.

About Agreement Phases
The contract process goes through typical sequences of events, or phases. The following 
phases encompass the various options for managing the Agreement life cycle:

Amendment
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Renewal
Termination
Expire

For details, refer to Status Categories and Statuses.

Amendment

User Permissions Needed

To amend an agreement: Agreement: Create, Edit

During the term of the agreement you may need to modify the contract. For example, the 
language or terms of the contract. The Amend action is used for this functionality. The 
Amend action creates a new version of the agreement record. The new, amended record 
shares the same base agreement number as the original with the decimal point 
incremented by one. All the data from the original version is copied into the new version. The 
new version can then go through the same agreement process as described above. On 
execution of the amendment, the status category of the original version of the agreement is 
changed to Amended from In Effect.

Renewal

User Permissions Needed

To renew an agreement: Agreement: Create, Edit

Towards the end of the term of the agreement, you may want to renew the agreement for 
a further period of time. In such a scenario, the Renew action would create a new version of 
the agreement. The agreement can then be executed after updating the term of the 
agreement. You can quickly identify contract renewal candidates, allowing plenty of time 
to act, and create new contract drafts based on the previous contract. You may refer 
Clearing Cloned Agreement Fields Values to understand how to control which fields to 
clone during renewal process.

Termination

User Permissions Needed

To terminate an agreement: Agreement: Edit

If you decide to terminate or end a contract, you can click on the Terminate action. The 
agreement status is changed to Terminated.
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Expiration

User Permissions Needed

To mark an agreement as expired: Agreement: Edit

After the agreement term ends, use the Expire action to mark the agreement as expired.

Configuring Agreement Clause Categories and 
Subcategories
Clauses have embedded merge fields contained within them that get auto-populated 
during agreement creation time.

To organize agreement clauses, it may be useful to create categories and sub-categories. 
These can also be used for reporting purposes. The Subcategory pick-list displays values 
based on Category pick-list selection.

These picklists display when you perform the following actions:

Creating new agreement clauses in Salesforce
Using the Playbook in X-Author for templates and generated documents
Creating new agreement and clause templates in X-Author
Creating sections in a generated document

To set up a clause:

Match Agreement Clause and Template categories and subcategories.
Associate categories and subcategories.

Agreement Clause Subcategories
Subcategory picklists display values based on what was selected in the Category picklist. 
The picklists also now behave the same for both the Playbook and Create Section dialog, in 
that they both have Category and Subcategory drop-down lists. 
Subcategories can be selected when you choose to save part of a document as an 
agreement clause in Author, as well as when you create a clause in Salesforce.
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To maintain consistency, the Category and Subcategory values for the Agreement Clause 
custom object must match the Category and Subcategory values for the Template custom 
object. The Apttus__Category__c and Apttus__Subcategory__c  API names refer to 
different objects though.

If the values do not match and you add an agreement clause to an agreement using the 
Playbook, an unexpected category and subcategory is added in Salesforce to the 
Agreement Clause related list's categories and subcategories.

To match Agreement Clause and Template Categories 
and Subcategories
The values of the category and subcategory fields for Agreement Clause and Template 
objects must match. You must sync the picklist values between the two objects and then 
ensure the same association of categories and subcategories.

Navigate to Setup > Build > Create > Objects, right-click Agreement Clause and open 
link in a new window.
Navigate to Setup > Build > Create > Objects and click Template to display the 
Template object page.
For both, Agreement Clause and Template, go to the Custom Fields & Relationships 
section and click Category.  
Observe the values for both Category picklists. If the values are not the same, they 
should be modified so they match between the two objects. 
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Return to the Custom Fields & Relationships section for both objects and click 
Subcategory. Similar to the previous step, modify mismatching picklist values so they 
are the same for both objects.

The categories and subcategories for the Agreement Clause and Template objects match.

You must associate the same categories and subcategories.

To Associate Categories and Subcategories
The Agreement Clause and Template objects require matching category and subcategory 
values.

Navigate to Setup > Build > Create > Objects > Agreement Clause and click 
Subcategory to display the field details.
Click New in the Picklist Values section.
Enter all of the required picklist values for all of the categories and click Save.
Click Back to Agreement Clause and then click Category to display the field details.
Click Edit beside Subcategory in the Field Dependencies section.
Double-click the sub-categories required for each Category column, when highlighted 
it indicates they will be associated with that category. 
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Click Preview to ensure the categories are associated correctly.
Click Save.

When you create an Agreement Clause in Salesforce or a section in X-Author, the 
subcategories created above will be available for selection. You should repeat this 
procedure for the Template object categories and subcategories to ensure they align with 
the Agreement Clause values.

Configuring Agreement Term Exception
An exception clause or term is a stipulated condition in your agreement that may need 
approval from management, to grant or prevent certain allowances to or from a 
particular group of users in your agreement. Contract Management enables you to 
associate such exception clauses or terms to your agreement document as a separate 
agreement term exception record.

For example, if your customer requires certain extended payment terms for an agreement, 
other than what is mentioned in your agreement document, you can associate such 
exception clause to your agreement as a term exception, named Extended Payment Terms.

To insert Agreement term exception in your agreement document, you must configure the 
following:

Creating an Admin Entry for Term Exception
Creating a Term Exception
Associating a Term Exception with a Clause 

After you follow the above-mentioned procedures and generate an agreement document, 
the generated agreement document reflects the agreement term exception. You can also 
view the agreement term exceptions associated to your agreement record in the Agreement 
Term Exception related list. You can also associate an approval process (Term Exception 
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Approval) with the term exception record if your exception clause or term has to be 
approved by a higher authority before being inserted in your agreement document. For 
more information, see Approvals.

Creating an Admin Entry for Term Exception
User Permissions Needed

To create a new admin entry or edit an existing entry: Admin: Read, Create, Edit

Click   and search for Admin.
Click New to create a new admin entry.
In the Name field, type APTS_EnableTermExceptionsInAuthor and in the Value field, 
type True.
Click Save.

You have created an admin entry to enable term exceptions for your records. You must now 
create a term exception record to implement term exception in your documents.

Creating a Term Exception
User Permissions Needed

To create, edit an Agreement term exception: Agreement Term Exception: Read, Create, Edit

Agreement: Read, Edit

Click  and search for Term Exceptions.
Click New to create a term exception record.
Enter details in one or more of the following fields, as required:

Option Description

Is Active This checkbox enables you to set the term exception record 
as active. By default, it is set to true.

Exception Type None, Corporate, Other, Procurement, Sales. This indicates 
the type of exception record.

The approval process is triggered when you check-in a clause with a term exception 
associated to it.



https://documentation.conga.com/approvals/latest/approvals-143896463.html
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Approval Required This checkbox indicates whether an approval process 
should be associated with this term exception record. By 
default, it is set to true.

Exception This textbox indicates the title for which this term exception 
record is created. For example, if your customer requires a 
different clause for payment terms, you may enter 
Extended Payment Terms in this field.

Agreement Types This is a multi-select picklist field. Selecting different values 
from this picklist enables your term exception record for 
multiple agreement record types. You may have to 
navigate to Setup > Create > Objects > Term Exception > 
Agreement Types picklist and add new values like NDA, 
MSA, and more to map the Term Exception > Agreement 
Types with your Agreement > Record Types.

Description  Type a description for your term exception record to give a 
brief idea about the usage of this record.

Click Save.

You have created a term exception record. You must associate your term exception record 
with a clause.

Associating a Term Exception with a Clause
Prerequisites

You must ensure that you have an existing term exception record in your Salesforce 
org.
You must also ensure that you have a clause record checked in using X-Author for 
Contracts Templates in Microsoft Word.

Steps

Click the Templates tab and navigate to your existing clause record.
Look for the Term Exception look up field.
Use the look-up icon to search for your term exception and select it. You can also 
associate the term exception with a clause when you check-in your clause from X- 
Author for Contracts Templates in Microsoft Word.
Click Save.
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You have associated a term exception record with a clause and can see the changes in the 
Sections/Clauses related list under your term exception record. You can insert this term 
exception clause in your existing template and use it further for agreement document 
generation.

Configuring Dynamic Document Assembly
Dynamic Document Assembly enables you to preconfigure filter rules that drive a sequence 
of prescribed dynamic clause or attachment insertions in a generated document. This 
results in a complete and well-formed agreement:

Clause insertions use a combination of contract field values to drive document 
assembly rules. These contract field values are expressed as a user-configured key 
that determine the desired agreement or proposal clause content during document 
generation.
Attachment insertions rely on configuration of document assembly rule components 
and operate at the line-item level. Document assembly component definitions refer to 
attachments on objects that are a lookup from the line item object. These component 
references and condition expressions defined in X-Author for Contracts determine 
attachment content during document generation.

Dynamic Document Assembly Rulesets are enabled for the Agreement and Quote/Proposal 
objects.

Filter rules are enabled through the Document Assembly Rulesets tab and X-Author for 
Contracts objects, for Rule Sets, Rules, and Components, which are maintained externally 
from templates. Rulesets can contain many rules, and each Rule can be applied to many 
Components, with each Component assigned to an attachment or clause template for 
insertion when the Rule filter values are found. Document Assembly Rulesets can be used in 
any template through the Insert Dynamic Sections option in X-Author for Contracts. These 
Dynamic Sections in the template are the link to the associated Ruleset, and therefore to 
the prescribed content.

Support for the Agreement at the line-item level is only enabled for users of Conga 
CLMand X-Author for ContractsNovember 2016 release or later (versions 8.335 (CM) 
and 8.508 (XAC) respectively). Prior versions only support the Agreement object 
header level and clauses as dynamic components (not attachments). Support for 
the Proposal object at the Header (clause insertions) and line-item level 
(attachments) is only enabled for users of Apttus Proposal Management November 
2016 release or later (versions 8.104 (PM) and the above-mentioned versions of 
the Conga CLM Product suite.
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The Template object can be configured to display Related Lists identifying where a clause 
template has been used as a Ruleset component, or where the Template contains assigned 
dynamic sections (either clause or attachment).

Dynamic Document Assembly Elements
The following elements comprise Dynamic Document Assembly.

Doc Assembly Ruleset
Dynamic Document Assembly uses the Doc Assembly Ruleset as the container object for 
the functionality as shown in the following figure:

Doc Assembly Ruleset is the main object that contains all of the sub-objects and 
components required for document assembly. This object contains fields, such as Business 
Object and Record Types (A). These fields control which object record and which specific 

A note on Record Types: In the modeling of your system, it is recommended to make 
every effort to ensure that any Template Agreement Types that make use of 
dynamic segments also be included in the Document Assembly Ruleset object 
Record Types picklist. For example, if you have NDA templates that make use of 
dynamic segments, the "NDA" Agreement Type should be present in both the 
Template Object Agreement Types picklist and the Document Assembly Ruleset 
Record Types picklist. It is recommended to design your approach in this way, 
especially for Rulesets that do not make use of Document Assembly Rule filter 
criteria.
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record types of that object can use the rules. There can be one or more Doc Assembly Rules 
(B) for each ruleset.

Doc Assembly Rules

Doc Assembly Rules contain all of the components including all of the content that will be 
included in the document:

For Doc Assembly Rules at the Header-level, only components that reference clause 
content can be used. These rules fire based on contract field values identified in Doc 
Assembly Rule Field Sets.
For Doc Assembly Rules at the Line-item level, attachments components can be used 
(along with clause components, if necessary). The rules fire automatically as long as 
component attachments can be found, and are further filtered by expressions defined 
in the template document.

Document Assembly Components
Clause
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Each Doc Assembly Component contains a reference to a single template or clause that 
has been created in X-Author for Contracts. This provides the actual content that is 
inserted into the agreement document at generation time.

Attachment

Each Doc Assembly Component contains a reference to one or more attachments 
(depending on the Component Type) on an object referenced by an Agreement Line Item or 
Proposal Line Item object record.

Dynamic Document Assembly Workflows
The configuration and workflow process for creating Dynamic Document Assembly 
Rulesets, Rules and Components is different depending on where the Ruleset focus brings 
Clause content or Attachments. Refer to the Workflow that best supports your individual 
use case. In the event that you intend to create Rulesets that bring both clauses and 
attachments, refer to the Clause Workflow for initial configuration, then the Attachment 
Workflow to enhance functionality.

Dynamic Document Assembly Workflow: Clauses 
The Conga CLM enables you to merge independent clause templates into a single 
Master Agreement or Proposal template using a set of predefined rules within a 
ruleset.
Dynamic Document Assembly Workflow: Attachments 
Merge independent attachments on lookup objects from Agreement Line Item or 
Proposal Line Items using a set of pre-defined rules within a ruleset.
Configuring Dynamic Document Assembly 
Learn how to clone Document Assembly Rulesets, Document Assembly Rules, and all 
the associated components.
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Creating Custom Fields
You can create a custom field and configure where you want it to appear in the 
application.

To create custom fields
From Setup, go to Create > Objects > Agreement. 
From Custom Fields & Relationships, click New. Dynamic Document Assembly 
supports custom fields of all data types, except Picklist (Multi-Select) and Text Area 
(Long).
Follow the standard Salesforce instructions for creating a field.
After you have created all the fields on the Agreement object, go to Create > Objects 
> Doc Assembly Rule.
From Custom Fields & Relationships, click New.
Create the exact same fields that you did for the Agreement object and you must use 
the same API names to ensure the correct auto mapping of fields between the 
agreement object and the rule.

The fields required for auto mapping and the field set are available.

Create fieldsets to be used as static and dynamic fieldsets for the Doc Assembly Rule using 
the fields created in steps 4 to 6. The fields in the static fieldset are a subset of the fields in 
the dynamic fieldset.

Dynamic Document Assembly Workflow: Clauses
Using Dynamic Document Assembly, you can merge independent clause templates into a 
single Master Agreement template using a set of predefined rules within a ruleset.

Use the following workflow to configure and define Doc Assembly Rulesets, Rules and 
Components for Agreement and Proposal templates using dynamic segments to insert 
clauses:

Note

Packaged fields cannot be added to a FieldSet as custom fields pointing toward the 
same namespace (e.g., "Apttus"). Also, if you omit the namespace when you create 
the field, you will get an error on generate. If you want to include fields from a 
package you will need to create a custom formula field that points to the packaged 
field.



https://help.salesforce.com/HTViewHelpDoc?id=adding_fields.htm
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Configuring Dynamic Document Assembly

Create custom fields for an agreement using which an agreement will be filtered. For 
example if you want to filter agreements by language, create a custom field for 
language for an agreement.
Create Document Assembly Field sets: The field sets comprise the fields used to filter 
an agreement. The field should have the same API name as that of the custom fields 
for the Agreement object.
Specify the API name of the fieldset in Comply Custom Properties.
Enable Document Assembly Rulesets for the Quote/Proposal object.

Creating Dynamic Document Assembly Rulesets

Define a Doc Assembly Ruleset: You have to create a ruleset that comprises the rules 
using which an agreement is filtered.
Define Doc Assembly Rules: Define a set of filter criteria by which an agreement is 
filtered and available. The filter by fields should have the same API name as the 
fields of the Agreement object. For example you want to filter all agreements having 
language as English. The Language custom field in the Agreement object has the API 
name as Language_c. The filter by criteria field for a Document rule should have the 
same API name Language_c.
Specify Doc Components: If an Agreement satisfies the filter criteria, you can specify 
the doc components(templates) and the sequence in which they are included in the 
master agreement template.
Navigate to X-Author and checkout an existing template or create a new blank 
template and check it in. Once the blank template is checked in successfully, insert a 
dynamic section in the template. For an existing template insert the dynamic section 
in the required location and specify the ruleset. The Dynamic section allows you to 
define the ruleset for which the template is applicable for an agreement. This blank 
template is used as the master agreement template.
Once you click Generate or Preview, if the agreement satisfies the rules defined in the 
document ruleset, the corresponding master agreement template for that ruleset is 
shown. Select the master agreement template and click Generate. All the 
components defined in the Document Rule set are inserted in the sequence by which 
they are defined.
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Doc Assembly Rule Filter Logic
The following table shows the summary of system behavior based on various conditions:

Value in 
Agreement 
field

Value in Filter by 
field of Doc 
Assembly Rule

Match between the 
values of Agreement 
field and Filter by 
field

System evaluation

Has value Has value Yes System will fire the Doc 
Assembly Rule and the 
corresponding template will 
be displayed for document 
generation or preview.

Has value Null No System will skip the 
evaluation for this filter 
field and will fire the Doc 
Assembly Rule based on the 
match in other Rule filters.

Null Has value No System does not fire the Doc 
Assembly Rule.

Creating a Document Assembly Fieldset
Complete To create custom fields so you have all of the fields you want to use in the 
fieldset available on the Doc Assembly Rule object.

From Setup, go to Create > Objects > Doc Assembly Rule.
From the Fields Sets Related List, click New and enter a mandatory Field Set Label, 
Field Set Name, and info on where it is used and click Save.
Drag and drop the desired fields onto the field set and click Save.
Repeat steps 2 and 3 to create a separate Static fieldset. The fields in the static field 
set will be a subset of the fields in the dynamic field set.

The field set object, with its field has been saved.

This page only includes instructions for configuring and create Dynamic Document 
Assembly Rulesets for Clause components. If you intend to create Rulesets that also 
include attachment components at the line item level, refer to Dynamic Document 
Assembly Workflow: Attachments for additional configuration.
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You can now add the fields defined in the field sets to a specific page layout. To call 
out the static and dynamic field sets, create separate Static and Dynamic sections 
on the page layout and drag and drop the requisite fields accordingly.
Go to Develop > Custom Settings > Comply Custom Properties and click Manage and 
then Edit for Apttus__APTS_Agreement__c. Enter the API name of the field set you 
created in the Doc Assembly Rule FieldSet Name field. Enter the API name of the 
static field set you created in the Doc Assembly Static FieldSet Name.

 

 

Populating a Doc Assembly Component Type picklist
From Setup, go to Create > Objects > Doc Assembly Component.
From Custom Fields & Relationships, click Type.
From Picklist Values, click New and add the required type values and save them.

These values are now available from the Type picklist when creating a Doc Assembly 
Component.

Adding the Related Lists
From Setup, go to Create > Objects > Template.
From the Page Layouts section, click Edit beside the layout you want to add the 
Related List to.
Select Related Lists and drag and drop the following Related Lists onto the page. 

Doc Assembly Components: When you create a Doc Assembly Component and 
use it in your template, this Related List will have a new record added to it.
Template Dynamic Sections: When you add a dynamic section to a template 
using Insert Dynamic Sections ribbon from X-Author Templates, this Related 
List will have a new record added to it.
Template References: When use a template as a doc assembly component 
using Insert Dynamic Sections ribbon from X-Author Templates, this Related 
List will have a new record added to it.

Click Save.

The Related Lists will now be displayed on that Template page layout.

If there is no Apttus__APTS_Agreement__c entry, you should create one first and then 
enter the field set name.
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Adding DAR for the Proposal Object
By default, a custom property is created for the Quote/Proposal object when you upgrade 
or install the Apttus Proposal Management package, but you still need to manually add 
the Quote/Proposal object to the picklist when creating a new Doc Assembly Ruleset.

From Setup, go to Create > Objects > Doc Assembly Ruleset.
Under Custom Fields & Relationships, click on the Business Object field label link.
Scroll to Picklist Values and click New.
Enter Apttus_Proposal__Proposal__c as a new Picklist option. 
 

 

 
Click Save. The Proposal object is now available as an option when you are creating 
DAR Rulesets.

Creating Doc Assembly Rulesets

User Permissions Needed

To create a Doc Assembly Ruleset: Doc Assembly Ruleset: Read, Create, Edit.

Agreement: Read, Create, Edit.

Template: Read, Create, Edit

Doc Assembly Rule: Read

Doc Assembly Component: Read

You must have created templates that you want to use as the Content of your Doc 
Assembly Components.
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You must ensure that you add the fields created in the fieldset in the page layout for 
Doc Assembly Rule by using Edit Layout option.

Go to the Doc Assembly Rulesets tab and click New.
Enter the following values for the ruleset:

Option Description

Ruleset Name Enter the name used to reference the ruleset in the template.

Sequence Enter the order in which the ruleset will be evaluated, when 
you Preview or Generate an agreement document.

Business Object Choose the Business Object context for the Ruleset. Select 
Apttus__APTS_Agreement__c for Agreements, 
orApttus_Proposal__Proposal__c for Proposals.

Record Types Choose one or more record types associated with the 
business object (Agreement or Proposal). To restrict the 
Ruleset to specific record types select them from the list and 
move them from Available to Chosen, otherwise leave the 
default of All.

Active  Select this checkbox to make the Ruleset available when you 
generate a document.

Description Enter details about the Ruleset that describe its business 
purpose.

Once the settings are configured, click Save to display the Doc Assembly Ruleset 
record.
Click New Doc Assembly Rule and enter values for the following options:

Option Description

Rule Name Enter the name used to reference the Rule in the template.

Sequence Enter the order in which the Rule will be evaluated, when you 
Preview or Generate an agreement document.

Description Optional field to enter details about the rule.
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Active Enter details about the Rule in the context of your Ruleset.

Filter By Choose values for fields in this section to control whether the 
rule will be applicable to the Agreement or Proposal, based on 
the filter criteria defined. If it matches then the rule may be 
applied; however, if it does not match then the rule is skipped.

Once the settings are configured, click Save to display the Doc Assembly Ruleset 
record.
Click New Doc Assembly Component and enter values for the following options:

Option Description

Sequence Enter the order in which the component is inserted in the master 
agreement template, when you Preview or Generate an 
agreement document.

Type Choose the Doc Assembly Component Type. Type is a 
configurable field that is used to help indicate what the 
component is used for; however, it is only an indicator and does 
not have any impact on the generation process.

Content Use the lookup to choose the clause template that will provide 
the content for the document. This is referenced when you Insert 
Dynamic Section in X-Author.

Click Save.

The components of active Rulesets and Rules can now be used when you insert dynamic 
sections into agreement templates.

To create new templates or edit existing templates and include Dynamic Sections in them, 
see Setting Segments in Templates.

Dynamic Document Assembly Workflow: Attachments
Using Dynamic Document Assembly, you can merge independent attachments from lookups 
(e.g., Products) to line-item level Objects (Agreement Line Items, Proposal Line Item) into a 
single Master Agreement template using a set of predefined Rules within a Ruleset.

Use the following workflow to configure and define Doc Assembly Rulesets, Rules and 
Components for Agreement and Proposal templates containing dynamic segments to insert 
attachments:

https://documentation.conga.com/x-author-for-contracts/latest/setting-segments-in-templates-143901650.html
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Configuring Dynamic Document Assembly
Specify the API name of the Child Object Types for the Agreement and/or Quote/ 
Proposal objects in Comply Custom Properties.
Populate the Doc Assembly Component Type Picklist.
Add Attachments fields to the Doc Assembly Ruleset and Doc Assembly Component 
page layouts.
Add Related Lists to the Template Object page layout.
Enable Document Assembly Rulesets for the Quote/Proposal object (optional).

Creating Dynamic Document Assembly Rulesets
Define a Doc Assembly Ruleset: Create a Ruleset that comprises the Rules that define 
the Components to be inserted into the generated document.
Define Doc Assembly Rules: Define a Rule to serve as a container for Doc Assembly 
Components that reference attachments on line item objects.
Specify Doc Components: Define the doc components (attachments) and the sequence 
in which they are included in the master agreement or proposal template.
Navigate to X-Author and checkout an existing template or create a new blank 
template and check it in. Once the blank template is checked in successfully, insert a 
dynamic section in the template. For an existing template, insert the dynamic section 
in the required location and specify the Ruleset. The Dynamic section allows you to 
define the Ruleset for which the template is applicable for an agreement. This blank 
template is used as the master agreement template.
Once you click Generate or Preview, if the agreement satisfies the Rules defined in the 
document Ruleset, the corresponding master agreement template for that Ruleset is 
shown. Select the master agreement template and click Generate. All the 
components defined in the Document Ruleset are inserted in the sequence by which 
they are defined.

This page only includes instructions for configuring and create Dynamic Document 
Assembly Rulesets for attachment components at the line-item level. If you intend 
to create Rulesets that also include Clause template components, refer to Dynamic 
Document Assembly Workflow: Clauses for additional configuration that requires 
Field Sets to filter identified clause components.
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Configuring Dynamic Document Assembly Custom Properties
To enable support for Line Item attachments in Dynamic Document Assembly, you must 
create or modify existing Comply Custom Properties to identify the Child Objects of the 
Agreement and/or Proposal object that you want to include in your Rulesets.

Go to Develop > Custom Settings > Comply Custom Properties.
Click Manage to display Custom Properties for Agreements and Proposals. 
 

 

 
If the Properties displayed above appear in the list, continue to the next step. 
Otherwise, create the Custom Properties entries as shown above, then continue to 
complete the configuration.
Click Edit next to Apttus__APTS_Agreement__c to display the Custom Properties 
information form. 
 

 

 
In the Child Object Types field, enter comma-separated values identifying the API 
name of the Child Objects you want to support in your Rulesets: 
"Apttus__AgreementLineItem__c,Agreement_Product__c"
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Click Save.
If you have the Apttus Proposal Management package installed and want to create 
Rulesets for the Proposal object, click Edit next to Apttus_Proposal__Proposal__c. 
 

 

 
Enter the API name of the Proposal Line Item child object: 
"Apttus_Proposal__Proposal_Line_Item__c" 
 

Populating the Doc Assembly Component Type Picklist

Each defined Doc Assembly Component requires a "Type" to identify its purpose in the 
generated document. Follow these steps to populate the Doc Assembly Component Type 
picklist with desired values.

From Setup, go to Create > Objects > Doc Assembly Component.
From Custom Fields & Relationships, click Type.
From Picklist Values, click New and add the required type values and save them.

These values are now available from the Type picklist when creating a Doc Assembly 
Component.

Adding Context Fields to the Doc Assembly Ruleset Page Layout

In order to use line item objects as the context for a Doc Assembly Ruleset, you must add 
two (2) fields to the Doc Assembly Ruleset Page Layout.

From Setup, go to Create > Objects > Doc Assembly Ruleset.

You do not need to include any "Doc Assembly Rule Field Set" properties unless you 
are planning to include Clause templates as components in your Rulesets. For 
instructions on configuring and creating Doc Assembly filter fields, refer to Dynamic 
Document Assembly Workflow: Clauses.





CLM

243
 

Copyright ©2022 Apttus Corporation. All rights reserved.
 

2.
3.

4.

1.
2.
3.

From Page Layouts, click Edit.
From the Layout editor, drag and drop the Child Object and Parent Reference Field 
into the Information or System Information sections of the layout. 
 

 

 
Click Save. Repeat this process for each Ruleset Layout you have created.

Adding Attachment Fields to the Doc Assembly Component Page Layout

In order to configure Doc Assembly Component for line item attachment support, you must 
add three (3) fields to the page layout.

From Setup, go to Create > Objects > Doc Assembly Component.
From Page Layouts, click Edit.
From the Layout editor, drag and drop the Component Type, Field Name, and 
Attachment ID fields into the Information section. 
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Click the configuration icon next to the Content field to display Field Properties.
Click the Required check box to make the Content field no longer required. You must 
make this field optional because you may not include Clause template components in 
your Ruleset. 
 

 

 
Click Save. 
Repeat this process for each Ruleset Layout you have created.
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Including the Related Lists
From Setup, go to Create > Objects > Template.
From the Page Layouts section, click Edit beside the layout you want to add the 
Related List to.
Select Related Lists and drag and drop the following Related Lists onto the page. 

Doc Assembly Components: When you create a Doc Assembly Component and 
use it in your template, this Related List will have a new record added to it.
Template Dynamic Sections: When you add a dynamic section to a template 
using Insert Dynamic Sections ribbon from X-Author Templates, this Related 
List will have a new record added to it. 
 

 

 
Click Save. The Related Lists are now displayed on that Template page layout. 
 

Enabling DAR for the Proposal Object (Optional)

By default, a custom property is created for the Quote/Proposal object when you upgrade 
or install the Apttus Proposal Management package, but you still need to manually add 
the Quote/Proposal object to the picklist when creating a new Doc Assembly Ruleset.

From Setup, go to Create > Objects > Doc Assembly Ruleset.
Under Custom Fields & Relationships, click on the Business Object field label link.
Scroll to Picklist Values and click New.
Enter Apttus_Proposal__Proposal__c as a new Picklist option. 
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Click Save. The Proposal object is now available as an option when you are creating 
DAR Rulesets.

Creating Doc Assembly Rulesets

User Permissions Needed

To create a Doc Assembly Ruleset: Doc Assembly Ruleset: Read, Create, Edit.

Agreement: Read, Create, Edit.

Template: Read, Create, Edit

Doc Assembly Rule: Read

Doc Assembly Component: Read

Go to the Doc Assembly Rulesets tab and click New. The Doc Assembly Ruleset form 
is displayed. 
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Enter the following values for the Ruleset:

Option Description

Ruleset 
Name

Enter the name used to reference the Ruleset in the template.

Sequenc 
e

Enter the order in which the Ruleset will be evaluated, when you Preview or 
Generate an agreement document.

Business 
Object

Choose the Business Object context for the Ruleset. Select 
Apttus__APTS_Agreement__c for Agreements, orApttus_Proposal__Proposal__c 
for Proposals.

Record 
Types

Choose one or more record types associated with the business object 
(Agreement or Proposal). To restrict the Ruleset to specific record types select 
them from the list and move them from Available to Chosen, otherwise leave 
the default of All.

Active Select this checkbox to make the Ruleset available when you generate a 
document.

Descripti 
on

Enter details about the Ruleset that describe its business purpose.
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Child 
Object

Enter the child object API name of the specified Business Object to define as the 
Ruleset context. This will be a line item object and is restricted to the following 
objects;

Apttus__AgreementLineItem__c
Agreement_Product__c
Apttus_Proposal__Proposal_Line_Item__c

These API names must also be represented in the Comply Custom Properties as 
described in the previous section on this page.

Parent 
Referenc 
e

Field Enter the API name of the field on the Child Object you specified that 
references the parent. For example, if your Child Object is Agreement Line Item 
enter Apttus__AgreementId__c as the Parent Reference field. This is the API 
name of the Custom Field on the Agreement Line Item object that references its 
parent: Agreement.

After entering field information, your Ruleset will be looking something like the 
following. 

Click Save to display the Doc Assembly Ruleset record.

Creating Doc Assembly Rules

Click New Doc Assembly Rule. The New Doc Assembly Rule form is displayed. 
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Enter the following values for the Rule:

Option Description

Rule Name Enter the name used to reference the Rule in the template.

Sequence Enter the order in which the Rule will be evaluated, when you 
Preview or Generate an agreement document.

Description Enter details about the Rule in the context of your Ruleset.

Active You must select this to make the Rule available for the Ruleset 
when you generate a document.

Filter By  Ignore fields in this section unless you are including a Clause 
component as part of your rule. Fields in this section control 
whether the Rule will be applicable to the Agreement, based on 
the filter criteria defined. If it matches the Rule may be applied; 
however, if it does not match then the Rule will be skipped. Note: 
If you are filtering the Rule using these values, you must have 
configured a Field Set as described in Dynamic Document 
Assembly Workflow: Clauses.

Click Save to display the Doc Assembly Ruleset record.

Creating Doc Assembly Components
Click New Doc Assembly Component. The New Doc Assembly Component form is 
displayed. 
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Enter the following values for the Component:

Option Description

Sequence Enter the order in which the component is inserted in the 
master agreement template, when you Preview or Generate 
an agreement document.

Type  Choose the Doc Assembly Component Type. Type is a 
configurable field that is used to help indicate what the 
component is used for; however, it is only an indicator and 
does not have any impact on the generation process.

Content Only applicable if the Component Type = Clause. Use the 
lookup to choose the clause template that will provide the 
content for the document. This is referenced when you Insert 
Dynamic Section in X-Author.
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Component Type Choose the Component Type to determine the specific content 
that is inserted into the generated document for this 
component. Component Types can be:

Clause – use this Component Type when you 
want the inserted content to be the clause 
specified by the Content field.
Attachment (Id) – use this Component Type when 
you want the inserted content to be an 
attachment with a specific Attachment ID into 
the generated document. The Attachment ID can 
be from any Header or Line Item-level object. Use 
the Attachment ID field to identify the specific 
Attachment ID.
Attachment (Object/Field) – use this Component 
Type when you want the inserted content to be 
an attachment specified through a field on the 
context record or through one of its relationships. 
This can be a formula field that returns the 
Attachment ID as a text string, or a field 
relationship from the context object that holds 
an Attachment ID string. Use the Field Name field 
with this Component Type (see below).
Parent (Object/Field) – use this Component Type 
when you want the inserted content to be an 
attachment residing in the Notes & Attachments 
related list of a lookup from the context object 
(e.g. an attachment on a Product lookup from 
Agreement Line Item). Use the Field Name field 
with this Component Type (see below). Note: This 
Component only brings the first attachment on 
the lookup record and is determined by Last 
Modified Date.
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Field Name Only applicable if the Component Type = Attachment 
(Object/Field) or Parent (Object/Field). Enter the API Field 
Name that refers to an attachment on a line item through a 
field on the line item record, a Salesforce relationship, or a 
parent record.

Attachment (Object/Field) – Field Name can refer 
to an attachment through a field on the context 
record (e.g. Agreement Line Item) or through a 
relationship. Examples:

ProductId__r.ShortDescription__c, where 
ShortDescription__c is a field on the Product 
that points to an attachment.
ProductSpec__c is a formula field on the 
Agreement Line Item object. The 
Attachment ID is pulled from the formula 
field value (the formula value can be a 
relationship, as above, or any other 
formula that returns text in the form of an 
Attachment ID).

Parent (Object/Field) – Field Name should be the 
API name of the Parent Reference field that points 
to the record where the attachment resides. For 
example, if the context object for the Ruleset is 
Agreement Line Item, then the parent reference 
field could be Apttus__ProductId__c.

Attachment Id Only applicable if the Component Type = Attachment (Id). 
Enter the Attachment ID of a specific attachment on any 
object.

Click Save. Repeat these to create additional components to be used with the same 
Doc Assembly Rule.

The components of active Rulesets and Rules can now be used when you insert dynamic 
sections into agreement templates.

To create new templates or edit existing templates and include Dynamic Sections in them, 
see Setting Segments in Templates.

https://documentation.conga.com/x-author-for-contracts/latest/setting-segments-in-templates-143901650.html
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Cloning Dynamic Document Assembly

With Dynamic Document Assembly, you can now clone Document Assembly Rulesets, 
Document Assembly Rules, and all the associated components.

Doc Assembly Rulesets can be cloned with all active rules and components. Similarly, a 
Doc Assembly Rule can be cloned with all components.

Cloning Doc Assembly Ruleset
The newly cloned ruleset record requires that you must enter the mandatory sequence, 
enter a unique name and activate it (A).

The Update Rule Criteria (B) section contains the dynamic fields which the system identifies 
in the field sets.

The instructions for cloning Document Assembly Rulesets, Rules and Components on 
this page only applies to Rulesets that contain clause components. Cloning for 
Rulesets that contain attachment components is planned for future releases.



The Conga CLM Clone action button overrides the standard Salesforce Clone action 
button. The new Clone action button redirects you to the DocAssemblyRulesetClone 
or DocAssemblyRuleClone Visualforce pages to clone the Doc Assembly Ruleset and 
Doc Assembly Rule respectively. In the previous releases, the Clone action button 
used to redirect you to the standard Salesforce Visualforce page.
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One of the field in the Update Rule Criteria section is the Match Rule field, which updates 
the new value of a field and works as follows:

If the field contains equal to, the Match Rule updates the new value of that field if the 
current value for that particular field matches the old value. 
If the field contains not equal to, the Match Rule updates the new value of that field if the 
current value for that particular field does not match the old value. 
If the field contains any, the Match Rule updates to the new value without checking the 
current value.

Cloning Doc Assembly Rule
The Clone button on the Doc Assembly Rule detail page clones the existing Doc Assembly 
Rule, generates a sequence, and then activates the newly cloned rule (A).

The Update Rule Criteria (B) section allows you to enter a new value or select an existing 
value for each filter field.

Cloning Doc Assembly Component
The deep cloning of a component clones the current version and lets you select the content 
to place in the new component.

If you clone a clause template to replace an existing clause template with the Clone 
functionality of X-Author Contracts, while the original clause template is used as a 
component on the Doc Assembly Rule, then the system will identify the UUID of the new 
clone template on the original cloned clause template record.
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The fields, such as Cloned From and Cloned From Reference, on the Template detail page 
enable you to track the cloning information of the content in a component, which can be a 
clause or template. These fields are populated by X-Author Contracts when checking in a 
cloned template.

Configuring Offline Agreement Window
You can create offline agreements directly in X-Author by taking an existing Word 
document that was created outside of Salesforce and has not previously been associated 
with an agreement.

When a document is open in X-Author Contracts and has not previously been kept in 
Salesforce, the Check-In option can be used for creating an offline agreement. There are 
some mandatory fields that must be completed before you generate a new agreement. The 
results are the same as creating an offline agreement from the Agreements tab in 
Salesforce.

There is a new Visualforce page that users must have access to and optionally you can 
change the fields that are displayed in the Create Offline Agreement window.

From Administration Setup > Manage Users, you must enable Visualforce Page Access for 
the page Apttus. CreateOfflineAgreement, for any user profiles or permission sets that 
control user's access to Apttus Author. You can accept the default Create Offline 
Agreement window fields or you can change which fields are included by configuring the 
Offline Agreement FieldSet.

Agreement Name, Account, and Primary Contact can be removed from the fieldset, but 
when they are included they will be mandatory. You can make all other fields mandatory 
or optional.

The New Offline Agreement window is not designed to contain a large number of fields, but 
just key fields for initially creating the agreement.

Configuring Offline Agreement Window Fields
Go to App Setup > Create > Objects > Agreement.
From the FieldSets section, click Edit for Offline Agreement FieldSet. 
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In the FieldSet frame displays the current fields used for the Create Offline Agreement 
window. This is a mandatory field.
From the Agreement fields list, drag and drop the desired fields, select whether to 
make them mandatory and reorder them as necessary. Lookup fields cannot be used 
with Field Sets.
Click Save. 
The selected fields are now included in the New Offline Agreement window.

Permissions to Create Offline Agreement
User Permissions Needed

To create an offline agreement Agreement: Create, Edit, Delete

 

Click the Agreements tab.
Select an agreement record type for the new agreement and click Continue.
Perform the following:

To select the file, type the path of the file or click Browse to select a document 
to attach to the agreement.
To create the offline agreement with the selected document attached to the 
agreement, click Attach File.

The agreement is added to the system, with the Word doc used to create the 
agreement available in the Notes & Attachments related list.

Agreement Number/Header Configuration
For both generating and checking in offline documents, a solution to inserting the type of 
agreement number is available. These changes can be made in the Comply System 
Properties. The configuration for automatically inserting header/footer data and the 
specified agreement number is as follows:

When the Auto Insert Header Footer Data system property is NOT checked (set to 
false), the header will be left blank.
If the Auto Insert Header Footer Data system property is checked (set to true),
AND the Agreement Number Field For Imported Docs is left empty (no value entered), 
then the header will be set to the internal agreement number value.
If the Auto Insert Header Footer Data system property is checked (set to true),
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AND the Agreement Number Field For Imported Docs contains an API field name 
value, then the value of header will be set to that field's value.

Setting the Date and Time Format for the Footer
From Setup, go to Develop > CustomSettings and click Manage beside Comply 
System Properties.
Click Edit and for Footer Datetime Format For Imported Docs enter the format you 
want to use.
Click Save.

The following date and time formats are supported:

Supported DateTime Format Example

MM/dd/yyyy 08/22/2006

dddd, dd MMMM yyyy Tuesday, 22 August 2006

dddd, dd MMMM yyyy HH:mm Tuesday, 22 August 2006 06:30

dddd, dd MMMM yyyy hh:mm:tt Tuesday, 22 August 2006 06:30 AM

dddd, dd MMMM yyyy H:mm Tuesday, 22 August 2006 6:30

dddd, dd MMMM yyyy h:mm tt Tuesday, 22 August 2006 6:30 AM

dddd, dd MMMM yyyy HH:mm:ss Tuesday, 22 August 2006 06:30:07

MM/dd/yyyy HH:mm 08/22/2006 06:30

MM/dd/yyyy hh:mm tt 08/22/2006 06:30 AM

MM/dd/yyyy H:mm 08/22/2006 6:30

MM/dd/yyyy h:mm tt 08/22/2006 AM

MM/dd/yyyy HH:mm:ss 08/22/2006 06:30:07

MMMM dd August 22
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Supported DateTime Format Example

yyyy'-'MM'-'dd'T'HH':'mm':'ss 2006-08-22T06:30:07

yyyy'-'MM'-'dd HH':'ss'Z' 2006-08-22 06:30:07Z

dddd, dd MMMM yyyy HH:mm:ss Tuesday, 22 August 2006 06:30:07

 
When a new document is imported into the system, it will include the Date in the bottom 
left corner of the footer on each page, in the format selected above.

Configuring Import Offline Button 
User Permissions Needed

To create an offline agreement Agreement: Create, Edit, Delete

Document Version: Create, Edit, Delete

Document Version Detail: Create, Edit, Delete

In Microsoft Word, select the X-Author ribbon and login.
Open the agreement document, currently kept outside of Salesforce, to be used to 
create the offline agreement.
Click Check-In.
Enter values for the mandatory fields.
Enter any remaining details for the agreement and click Save. 
The agreement is added to the system, with the Word doc used to create the 
agreement available in the Notes & Attachments related list.

Adding Document Info Type Field in an Agreement
From Setup, go to Create > Objects > Merge Event.
Under Custom Fields & Relationships, click Action and for Picklist Values click New.

Note

The value of the latest timestamp for the footer is taken from the User Account 
Timezone field on Salesforce.
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Enter Create Offline Agreement and Import Offline Agreement on separate lines and 
click Save.
From Setup, go to Create > Objects > Agreement Protection.
Under Custom Fields & Relationships, click Action and for Picklist Values click New.
Enter Import Offline Agreement and click Save. 
Document protection can now be extended to documents that were imported.

Document Info Type Included at Check-in
Document Info is a new value that gets applied to a checked in document, which describes 
the type of document. This value is applied to the document when it is checked in through X- 
Author.

Please note that this document info is only applied when using X-Author Contracts and can 
only be used after your system administrator has included the Import Offline Agreement 
Actions and the Check-in Action within your Conga CLM environment.

The Document Info field is located on the Merge Event Table.

Configuring Template DataSource Filter
Template Datasource Filter enables you to filter the records of various business objects in 
your Agreement document based upon the filter criteria. It serves as a bridge between the 
Templates and Search Filters (Comply).

Scenario: Define Template Datasource Filter in a scenario when you want to filter 
Agreement Line Items in your agreement document based upon the filter criteria such as the 
records of a specific Charge Type, and the records having Net Price equal to 50. To enable 
a filter on the various business objects in your document, define the following:

Define custom objects for Search Filter (Comply): It provides the list of custom objects 
upon which you can create a Search Filter (Comply).
Create a Search Filter (Comply): It provides the filtering criteria for the Template 
Datasource Filter.
Create a Template Datasource Filter: It is applied to the Template on which the filter 
criteria is available.

The template which contains the Template Datasource Filter entry reflects the filtered 
records in the generated Agreement Document.
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User Permissions Needed

To create, edit or delete a search filter: Search Filter (Comply): Read, Create, Edit, 
Delete

Template: Read

To create, edit or delete a Template 
Datasource filter:

Template Datasource Filter: Read, Create, Edit, 
Delete

Search Filter (Comply): Read

Template: Read

Agreement Term Exception: Read (Optional)

To define custom objects for Search Filter (Comply)
Navigate to Setup > Create > Objects > Search Filter (Comply).
Click Business Object.
Go to the Picklist Values related list and click New.
Type the API names of custom objects, each on a diferent line.  
If you want to add Agreement Term Exception custom object in the picklist value for 
Search Filter (Comply), type Apttus__Agreement_Term_Exception__c.
Click Save. 
The various custom objects appear in the drop-down list for Business Object. You can 
now create Search Filter (Comply).

To create a Search Filter (Comply)
Click  and click Search Filters (Comply).
Click New to create a new Search Filter (Comply).
Select the business object from the drop-down list and click Next.
Type a mandatory Filter Name and a description.
In the Filter Criteria section, select the fields and expressions you want to use to 
control which records will be filtered in your agreement document.  
You can have a standard AND relationship between the expressions or use Advanced 
Options to the fields together in a more complex formula. The available fields are 
based on the Business Object.
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Click Save. 
The Search Filter (Comply) is created to filter agreement line item records. You can 
now create a Template Datasource Filter.

To create a Template Datasource Filter
You must have a Search Filter (Comply) created for Agreement Line Item records.

On the Template detail page, navigate to the Template Datasource Filters related 
list and click New Template Datasource Filter.
Select a Template for this filter using the lookup icon.
Select a Search Filter (Comply) using the lookup icon.
Click Save. 
A record is created under the Template Datasource Filters. You can now use this 
template to generate an agreement document and see the filtered agreement line 
item records in it.

Configuring Template Versioning
Template Versioning provides a solution framework of document versioning at the 
Template level to track template versions against generated documents. Your 
organization's policies, requirements, legal and business practices may change over time, 
requiring templates to be updated. Rather than manually keeping track of template 
iterations, you can use template versioning to track and manage every version of your 
template throughout its lifecycle. Template versioning maintains those different versions as 
the template changes, giving template admins the ability to activate specific template 
versions based on their needs, and to observe how the template looked at every stage in 
the authoring process. Template versioning applies to both agreement and clause 
templates in your library.

In short, template versioning allows template admins to:

Survey older contracts by viewing their associate template version to understand 
what was in the template at generation.
Revert to previous template versions.
Clone template versions to begin a new template lifecycle.
Publish updated clauses and nested clauses across specific template versions.
Understand the growth and evolution of a given template.
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How Template Versioning Works
Each agreement or clause template in your org (with or without template versioning 
enabled) always consists of one template, and multiple child references to clauses and 
sections contained in that template. For every instance of that template, there is always 
only one template which can be considered active (the version selected by the user to 
generate the contract or the version of the clause inserted into an agreement template).

More specifically, whenever a new template is created by any means, one instance of the 
template is created, stored in the Template object in Salesforce, and any clauses or 
dynamic sections nested in the template are stored in the Template Clause Reference and 
Template Dynamic Section objects respectively. The Template object has a master-detail 
relationship to both child objects, as shown in the following figure.

What Template Versioning does is preserve the same template, we'll call it the "Header 
Template," which has a one-to-one relationship with the Active Version of the template and 
its child objects, and a one-to-many relationship with other versions of the template, which 
also have versioned clause and section references, but are considered inactive.
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Template Versioning introduces three new objects:

Template Version – a detail object of the master Template object
Template Clause Reference Version – a child object of Template Version that stores 
nested clause references
Template Dynamic Section Version – a child object of Temple Version that stores 
dynamic section references

When a user creates a new version of a template, the version information is incremented 
(e.g. from "1.0" to 2.0") but stored in the Template Version object and its child objects, NOT 
the Template object, creating a separate record of that template version. After creation, 
when and if a template version becomes the active version, data from the Template 
Version objects are copied to the Header Template objects and that template version 
becomes the new active version of the Header Template.

Enabling Template Versioning
Template Versioning is disabled by default in all orgs. If you want to enable it to allow 
template administrators to create and manage multiple versions of agreement and clause 
templates, you must make changes to your org.

The following steps are required:

Enable Template Versioning in Comply System Properties
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Add the Versions Related List to the Template Layout.

The following steps are optional:

Add "Activate Version" and "Active Version" Fields to the Template Layout.

Enabling Template Versioning
Go to Setup > Develop > Custom Settings.
Click Manage next to Comply System Properties.
Click Edit next to System Properties. The System Properties form is displayed. 
 

 

 
Check Enable Template Versioning.
Click Save. Template Versioning is now enabled in your org.

Adding the Version Related List to the Templates Layout
Follow standard Salesforce instructions for editing the Template object layout (e.g., 
click "Edit Layout" from the Template details page).
From the Template layout console, click on Related Lists. 
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Drag the Versions Related List into your Template layout. 
 

 

 
Click Save.
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Adding Optional Activate fields to the Template layout
Follow standard Salesforce instructions for editing the Template object layout (e.g., 
click "Edit Layout" from the Template details page).
From the Template layout console, click on Fields. 
 

 

 
Drag the Activate Version and Active Version fields into your Template layout. 
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Click Save. 
Template Details should now display the active version of the current template 
record and provide an "Activate Version" button for activating templates from within 
Contract Management. 
 

Managing Template Versions in X-Author Contracts
Template administrators primarily use X-Author for Contracts to create, check-out, check- 
in and make changes to agreement and clause templates. With Template Versioning, this 
practice should not change, and it is recommended that most template-related tasks be 
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completed using the X-Author contracts add-in for Microsoft Word. Using X-Author for 
Contracts, you can:

Create new templates
Check-in new template versions
Check-out template versions
Clone template versions
Activate template versions
Publish template versions which contain nested clauses

For full step-by-step instruction on managing template versions using X-Author for 
Contracts, see X-Author Contracts documentation.

Managing Template Versions in Contract Management
The following sections in this section explain how to accomplish some of the above tasks in 
Conga CLM, including:

Activating Template Versions
Cloning Template Versions
Publishing Template Versions

Activating Template Versions
When you want to change the active version of an agreement or clause template, you can 
activate it from the template record in Conga CLM.

Prerequisites
Before you can activate a template version from the Template record:

the "Activate Version" button must be added to the Template Detail page in 
Salesforce.
the template must be in an inactive state.

It is highly recommended that template versions be activated strictly from X-Author 
for Contracts.



https://documentation.conga.com/x-author-for-contracts/summer-21/x-author-for-contracts-154927679.html
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To activate a template version
Navigate to the Templates tab. View the current active template version in the 
"Active Version" field under Template Detail. 
 

 

 
Click Activate Version. The Activate page is displayed. 
 

 

 
Search for a template version using any of the following filters: 
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Version number
Modified by (User)
Last modified after Date
Last modified before Date

Click Activate next to the version you want to activate. The following page is 
displayed on successful activation. 
 

 

 

Cloning Template Versions

You can clone a template when the need arises to have a template with similar language 
or elements. When you clone a template version, a new template record is created as 
version 1.0. Remember the following when cloning a template version:

You can only clone the active version of a template.
Cloning a template record is just like creating a new one except a copy of the 
document you are cloning is attached to the new record as the first version.

To clone a template version
Go to the Templates tab to view the Template record.

When a template version is successfully activated, every template above it will be 
flagged as "Needs Publishing." For example, if you change the active version of a 
Payment Terms clause which is used in three templates, all three templates will be 
flagged. For information on publishing template versions, refer to Publishing 
Template Versions.



Hint: Click on an image to enlarge the view.
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From the Template record details, click the Clone button. 
 

 

 
On the next screen, click Continue.
Make changes as needed to Template header information. 
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Click Save. The Template record is cloned.  

The Active Version is set to 1.0 and the active version of the template document from 
the record that was cloned is attached to the cloned record in the Notes & 
Attachments section. 
 

To View Parent Template Version
You can clone a template from another template version and can track the version of the 
parent template from which the current template was cloned. To view the parent version of 
the current template:

Go to Templates tab to view the template record.
Go to Versions related list.
In the versions related list you can see the parent version of the current template in 
the Parent Version column. You can also see the active version from the Active 
Version field in the Publish Templates related list. The parent version of the new 
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template created is blank because it does not have a parent template. 

Publishing Template Versions
Publishing templates improves document generation performance by taking referenced 
clauses in a template and "publishing" them before the template is used to generate a 
document. In Pre-FX2, this takes the content of the clause and enters it into the template 
body as static text, as if it was another part of the main template. In FX-2 format, updated 
clauses are inserted into the template.

Template Versioning allows you to be more selective when publishing templates. You can 
choose which versions to publish, updating nested clauses in some versions while preserving 
older versions of your clauses in other templates. In template versioning, publishing adopts 
a "bottom-up" approach. You publish the main template with nested clauses, but the 
process actually travels up from the updated clause to the main template itself. For 
example, consider a template with a nested clause that contains an updated clause. First, 
the clause is updated, next its parent clause is updated, and finally the main template is 
updated. For every update, each template version is incremented by 1.

To view parent version, make sure to add the Parent Version column to the Versions 
related list using Edit Layout option from Salesforce.
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The process for both manually and automatically publishing templates in Contract 
Management is unchanged. Refer to Publishing for step-by-step instructions to publish your 
templates.

Consider the following scenario for publishing templates when a clause has been updated:

Sam Sales works for Tier One Systems, and is managing two different master templates, 
and MSA and MCA. Both templates contain the same Net Payment Terms clause (version 
1.0). The figure below represents the template and clause hierarchy for both templates. 
Note the Net Payment Terms clause is nested under both.

If a template has note yet been versioned and is published, the template is 
published with two versions: a pre-published version and the published version.
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Sam is given instructions to update the Net Payment Terms clause to a Net 45 from Net 30 
for MSA contracts only. Sam updates the clause to version 2.0 and activates it. This flags 
both parent clauses and master templates as "needs publishing." Because only the MSA 
contracts need to reflect the updated Net Payment Terms clause, Sam elects to publish just 
the MSA master template to a new version.

When the template is published, the Net Payment Terms nested in the MSA template, the 
Net Payment Terms clause, the MSA Payment Terms clause above it, and the MSA master 
template are all updated to version 2.0. MSA template 2.0 is now the active template 
version. The MCA template is not published and still contains version 1.0 of the Net Payment 
Terms clause.



CLM

276 Copyright ©2022 Apttus Corporation. All rights reserved.
 

All MSA contracts using this template will now use the updated clause version.
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Document Generation for Templates with Nested 
Clauses
The Autopublishing features improve document generation performance, but some 
Contract Management customers choose to generate documents without using the 
Autopublishing features.

The improvements to document generation resolve:

Merge fields from agreement child or grandchild objects
Merge fields within nested clauses

The improvements can be initiated in the new release version as follows:

Using Migration Manager, which updates all of the content and mergefields in one 
process
Using X-Author Contracts Check-out/-in functionality to update all mergefields as 
they are encountered
Using Contract Management for generation of an agreement as it is initiated in 
Contract Management

Publishing Templates
Publishing templates improves document generation performance by taking referenced 
clauses in a template and 'publishing' them before the template is used to generate a 
document. This takes the content of the clause and enters it into the template body as 
static text as if it was another part of the main template. Auto-publishing enhances this by 
enabling you to schedule a batch job, which will automatically complete the publishing 
task that previously needed to be completed manually.

Note

Please note that the document generation time performance benefits realized using 
Autopublishing in advance of document generation will not be available to those 
customers who choose to forego Autopublishing and just rely on the document 
generation action.
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About Auto-Publishing
Auto-publishing requires an apex scheduled job and then entering a username and 
password and selecting the Enable Auto Publish option on the Publish Template page to 
work. After that the system automatically handles the process. Even when you have auto 
publish enabled, you can always manually publish templates on an ad hoc basis. Auto 
Publishing automates an administrative task, that previously must have been completed 
manually. There are a number of new fields added to the Template object for this feature 
that you may or may not want to add to the templates page layout when upgrading. With 
new installations, by default, the publish fields will be included on the page layout.

 
You may want the fields visible and editable for system admin users for troubleshooting 
and for testing in a sandbox org; however, for typically business users there is no need to 
display these fields.

The new fields are:

Needs Publishing - this Checkbox field is automatically selected whenever the 
referenced clause of a template has been changed and a new version is checked in, 
since the template was last published. This serves as a flag, which will add the 
template to the list of templates to be auto-published.
Number of Clauses - this Roll up Summary field indicates how many referenced 
clauses are associated with the template.
Published Date - this Date/Time field indicates the last time the template was 
published.
Publish Status - this Picklist field indicates the status of the template in relation to 
going through the publishing process. The available values are Pending, Published, 
and Submitted.
Published Doc ID - This is a unique identifier field, cons assigned to the published 
template automatically after it is published. You can search for the details of the 
published template in Salesforce using this ID.

Note

The fields are automatically updated by the actions you take in X-Author Contracts 
and Contract Management, so there is no need to display them for the functionality 
to work as expected. Including them may actually hinder the functionality. For 
instance, someone could manually uncheck the Needs Publishing flag for an 
updated template.
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A scheduled apex job is used to set the frequency of your auto-publish jobs, while the 
Publish Templates page is where you can initiate publishing.

 
Configuring Auto-Publishing

Go to App Setup > Develop > Apex Classes and click Schedule Apex.
Enter a Job Name and then click lookup icon for Apex Class and enter 
TemplatePublishJobScheduler.
Enter the Frequency, Start Date, End Date, and Preferred Start Time.
Click Save.
Click + and select Publish Template to display the Publish Template page. It includes 
a list of templates that have changed or had their associated clauses change, 
resulting in their Needs Publishing flag being checked, are displayed.
Enter the username and password details for the user who's credentials will be used 
to run the auto-publish, according to the schedule that was configured in the apex job 
in Steps 1-4.

The auto-publish process stores the credentials in a custom setting in encrypted form. 
When the Apex batch job executes, the credentials are passed to the merge service 
similar to the process in manual publishing.
Check the Enable Auto Publish option. This is all that is required, there is no Save 
button. All template records that have the Needs Publishing flag checked will be 
published. They do not need to be selected from the Templates list. All templates on 
the list will be published.

•
•

Note

From Contract Management and X-Author Contracts February 2015 release 
onwards, auto-publishing can be done from the X-Author Templates in Microsoft 
Word by clicking any of the following ribbons:

Publish
Check-In



Note

There is no validation for the user's password. If it is entered incorrectly the 
auto-publish job will fail.
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Once the auto-publish has begun, the templates will have a publish status of Submitted, 
Pending, or Completed while they go through the process. The Batch Jobs list and a 
separate log file will indicate which templates were published successfully or not.

You can return to the scheduled apex job as required to change the timing and you can 
uncheck Enable Auto-publish on the Publish Templates page when you do not want to 
auto-publish.

To manually publish templates using the Publish 
Templates tab

Click + and select Publish Template and a list of templates that have changed or 
had their associated clauses change, resulting in their Needs Publishing flag being 
checked, are displayed. 
If you are going to manually publish a template it does not matter if the Auto-publish 
option is checked. 
The manual template publish process does not store the credentials. The credentials 
are retained in memory and passed to the merge service which uses it to login and 
establish a session with Salesforce.
Select the templates you want to publish and click Publish.  
The status for the template changes to Submitted and an entry is added to the Batch 
Jobs list for each selected template that is published.

Once the template is published the Batch Jobs list status will change to Completed.

If the job failed, the Batch Jobs list will provide a message you can use to troubleshoot.

If a job failed, you can try publishing the template again. If it published successfully, you 
can use the template with its updated clause references, for generating agreement 
documents.

Using Merge Service
Merge Service and the Contract Management package work together as follows, to auto- 
publish templates.

A username and password must be provided each time you publish, whether you are 
initiating an Auto (scheduled) or Manual run. The current session ID is not used, so the 
user may choose to log out during the process.
Contract Management uses the AES-256 (Advanced Encryption Standard with a 256- 
bit key length) protocol.
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When the publish job is submitted, Contract Management calls Merge Service to 
initiate the publishing process.
Merge Service does a complete cycle of publishing within each session. This includes 
fetching the template document and referenced clauses from Contract Management, 
in-lining the referenced clauses within the Template, and saving the published 
template document to the Contract Management template record.
As each template publish cycle is completed, Contract Management updates the 
Auto publish job status regarding the template as completed, and initiates the next 
Merge Service template publish cycle. There is never any persistent data retained by 
Merge Service.
Each template publish cycle is executed as a separate session with its own unique 
Session ID.
When the last template has been published, Contract Management updates the job 
complete status.

Handling Auto Publishing Security Considerations
Merge Service is hosted in the Amazon EC2 cloud, where service instances may be brought 
online dynamically to handle demand loads. This means their IP address may change, 
which precludes the ability to add a static IP address to a whitelist and instead requires 
the use of a security token.

The template publish process is run through Merge Service, outside the customer’s firewall. 
The initial service action is to call back into Salesforce to initiate the publish process and 
pull data from Salesforce. For this, a mechanism is needed to initiate a Salesforce session 
by providing user credentials to the org, which includes a user name, password, and 
security token.

In a Single Sign-On (SSO) environment, the user logs into the environment once and passes 
the token to other applications seamlessly. But in the SSO environment, the security token 
link is hidden, which then requires additional steps to get a security token for publishing. 
The SSO token is not available to jobs scheduled to run in the future. Both the current 
Manual and Auto publishing processes are treated in this way.

Note

SSO does not work for auto-publishing. The process requires specific login 
credentials for a user with access to publish documents.
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Security Handling Options
The typical solution for Salesforce integration jobs is to have a specific profile assigned to 
a small number of system administrator users, to carefully control who has access to the 
objects required to complete tasks. So there are three possible ways to approach this 
security challenge if running a publishing job is desired:

It is recommended that you create a specific API user profile, with the minimum 
privileges required to publish templates. Then create a specific API user and assign 
the profile to this user for all template publishing tasks. For more details, see this 
Salesforce help topic.
Another option is to enable Two Factor Authentication for the user profile, which 
makes the security token link available. After the security token is secured, the Two 
Factor Authentication may be turned off. The security token will remain valid until the 
password is changed.
This additional option is suggested for those who do not want to use a Salesforce 
license, which is required for our recommended option. You can bypass auto- 
publishing and use the current user session to manually publish the templates. This 
would be set up similarly to the method used by Salesforce for Workflow Outbound 
Messaging, that allows a remote web service to call back into Salesforce, as 
described in this Salesforce help topic.

Query Template
Using template filtering rules, you can set up user-defined filters to narrow the list of 
templates that display for tasks that involve previewing or generating documents. For 
example, for agreement templates created for multiple regions, you should only be able to 
select templates for the region to which they belong. The template filter uses agreement 
fields and related child object fields to select the templates to display.

User Permissions Needed

To create, edit or delete a query template: Query Template: Read, Create, Edit, Delete

Agreement: Read

Template: Read

http://developer.force.com/cookbook/recipe/setting-up-your-salesforce-com-web-services-api-applications
https://help.salesforce.com/articleView?id=workflow_managing_outbound_messages.htm&type=0
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Limitation
You cannot define more than 44 query templates. If you define more than 44 query 
templates, the Template Selection page that appears while generating documents does 
not display templates.

To insert an amendment template
You can insert an Amendment Template in the available choice of templates while 
generating an agreement in the state: In Amendment=In Amendment status.

Create an Agreement type template to be used in amendment situations.  
Use any keyword in the keywords field. For example, Amendment.
Using the Query Template tab, create a Query Template.
The Query Template has two Related Lists: Qualifiers and Filters. 
Add a new Query Template Qualifier, provide the following information, and click 
Save.
 

Field Value Description

Sequence 1 <provide an integer value here. The 
number 1 is used as an example. In case 
you are using more than one Filter, then 
the same will be applied according to the 
sequence number>

Field Apttus__Keywords__c <API name of the field in the specified 
object>

Comparison  Operator not equal to <select from the drop down list>

Value Amendment  

Generate an agreement, which is in the state: In Amendment=In Amendment state. 
The desired Amendment template is displayed as one of the options along with other 
templates. For more information on setting up Template filtering rules, refer to To 
setup template filtering rules.
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Use Case for Creating Query Template
This topic describes the use case for creating a query template.

This use case describes how you can filter templates while previewing, generating or re- 
generating documents by using query template filtering. For example, if agreement 
templates are created for multiple regions, a user should only be able to select templates 
appropriate for the region they belong to.  

In this case, a Sales Representative can select NDA English and NDA Spanish templates for 
generating or regenerating an agreement. The user has to manually select which template 
they want to use.

Prerequisite:

The Query Template will look for a match between fields on the Agreement and Template 
records.  The Agreement record contains a Language field with the possible values of 
English or Spanish, while the Template record contains a similar Language field. By 
comparing and finding a match between the Language field values on the Agreement 
record and Template records, the Query Template will present the appropriate template 
for document generation.

To create a query template, perform the following steps:

Select the Query Templates tab. 
Click New. 
On the Query Template Edit screen, enter 1 as Sequence. 
Retain all other default values and Save.
Click New Query Template Qualifier from the Qualifiers related list.
Enter 1 as Sequence.
Retain Agreement as Object.
Type RecordType.Name for the Field value.
Retain Comparison Operator as equal to.
Type NDA-yourinitials in the value field. This must be an exact match to your record 
type label.

Standard Statement

This use case gives one example on, by creating query template filtering rules, 
System Administrators can define which templates display when previewing, 
generating or re-generating documents. You might use this functionality differently, 
depending on your business case.
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Retain Apttus__APTS_Agreement_c in the SObject Type.
Click Save.  Click QT-#### (top right of page) to navigate back to your query 
template record.
Click New Query Template Filter from the Filters related list.
Enter 1 as Sequence.
Type (or copy) Apttus__Language__c  for the Field value.
Retain Comparison Operator as equal to.
Type (or copy) Apttus__APTS_Agreement__c.Language__c in the Value field.
Click Save.

Result:

When a specific language is selected on the agreement record, the associated template is 
automatically used for document generation.

Next Step:

Similarly, you can create query template for other languages, to generate your agreement 
for a specific region. 

Securing Documents
Word Trust Center/Protected View options can impact your ability to see generated 
documents and should be disabled before you begin using X-Author for Contracts. Clearing 
the protected view settings will remove the ribbon displayed when you view a document. If 
you do not clear these settings, when you click Enable Editing, the generated document 
closes and a new blank Word document is displayed in its place.

Prerequisites
You must have a valid Salesforce (SFDC) account with an Conga CLM license.
X-Author for Contracts must be installed on your local machine with an X-Author for 
Contracts license.

To secure and control documents
Start Word and click File > Options to display the Word Options dialog.
Select the Trust Center sidebar option and then click Trust Center Settings.
Select the Protected View sidebar option and then clear the three Protected View 
3.options.
Click OK for each of the two dialog boxes to complete the procedure.
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Setting Up Template Filtering Rules
By setting up the template filtering rules, the Template selection page can be configured to 
set up user-defined filters to narrow the list of Templates displayed to the user for Preview/ 
Generate/Generate Supporting Document/Regenerate tasks. The template filter is set up by 
an administrator and allows agreement fields and related child object fields to be used in 
selecting the templates.

The template selection page for the agreement generation actions displays only the 
templates that are applicable for the agreement. For example: For the Agreements of Type 
Other, show the templates that are defined for a region.

Setting Up Template Filtering Rules
Click  and click Query Templates.
Click New.
To create a query template sequence, enter the Sequence (numeric). If there is more 
than one query template defined for a template object then sequence is the order in 
which the query templates are applied.
Enter the description for the query template and click Save.
To create a qualifier, click New Query Template Qualifier.Qualifier is as a condition 
on the Agreement object.
Enter the Sequence. If there are several template qualifiers, then the qualifiers are 
applied in the order of the sequence number.
Enter the API name of the agreement Field. For example, RecordType.Name.
Select the Comparison Operator. For example, equal to.
Enter the Value. For example, Other.
Click Save.
To define Query template Filter, click the associated query template link next to the 
Query Template. The Query Template Details page is displayed.
Click New Query Template Filter.
Enter appropriate values in the Sequence, Field, Comparison Operator, and Value 
fields and click Save.
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Getting the ID of a Template Used to Generate a 
Document

Go to Setup > Build > Develop > Custom Settings > Comply System Properties > 
System Properties and click Edit.
Select Publish Merge Events.
After generate, select the rows in Merge Event based on agreement id & timing to get 
the template id.
Perform a query on the Template object and get the template information based on 
template id. 
The template ID is received.

About Universal Unique IDs
Universal unique identifier (UUID) fields of the agreement templates, clause templates, and 
term exceptions in Contract Management support the functionality available with the X- 
Author Migration Manager.

The UUIDs help provide the ability to update and migrate templates from one org to 
another. These IDs are unique and once an ID is assigned to a template or term exception 
object record, it cannot be changed.

To use the templates with the UUID field, you must have X-Author Contracts 7.0 or higher.

Setting Up Template Object for Contract 
Management

Click +  > Customize My Tabs. 
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Scroll down the available options and select Templates.
Click Add. 
 

 

 
Click Save.

The Templates tab is added to the Contract Management application selection.

Document Generation Capabilities
The capabilities of Document Generation, or DocGen, are made completely visible in Conga 
CLM. Conga CLM has extended document generation beyond the Agreement and Quote/ 
Proposal object to cover the standard Salesforce objects and custom objects.

The Conga CLM Suite uses the following components in the generation of documents:

Conga CLM application is 100% native on the Salesforce platform – Includes custom 
objects, tabs, Apex classes and Visual force pages on the Salesforce platform.
Merge Web Service hosted on Amazon EC2 (Elastic Compute Cloud) stacks – A 
stateless service which includes .NET components for generating Word and PDF 
documents using data from Salesforce. No data is persistent in this component.
X-Author for Contracts Add-in to Microsoft Word – A .NET-based add-in to Microsoft 
Word used for creating and managing merge templates and for generating and 
managing contract documents throughout the negotiation stage of the cycle.
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The following steps are performed during the document generation process:

The document generation process is initiated when you use the Conga CLM 
application in the following scenarios.

Select the document attributes, such as output format, protection type, and a 
template (including defined structured data fields in clauses with terms and 
conditions).
Click Generate for the supported objects. To view the list of supported objects, 
refer Document Generation Features List.

The Conga CLM application uses Apex code in Salesforce to make an HTTPS Web 
Service call to the Merge Service endpoint using the REST API .
The Apex controller passes to the Merge Service the current user’s session ID and the 
endpoint server URL obtained using the {!$Api.Session_ID} and {! 
$Api.Partner_Server_URL_250} Visualforce variables.
No logging occurs on the Merge Service which would capture the information, such as 
SessionId or agreement details, moving through the Merge Service.
The Merge Service uses the session ID and endpoint server URL to establish a session 
with Salesforce. The mechanism is similar to Salesforce Workflow Outbound 
Messaging, allowing session information to be passed for a callback.
The Merge Service retrieves from the Conga CLM application the contract object 
record’s user-selected Microsoft Word template and the data for the merge fields 
embedded in the template.
The Merge Service merges the data and produces the contract document in the user- 
selected format: DOC, RTF, DOCX, or PDF.
The generated contract document is stored in Salesforce as an attachment to the 
agreement record.
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Errors encountered in the document generation process are displayed to the user from 
the contract management application in Salesforce, where you initiated the 
generation command for the document.
All details are removed from the Amazon EC2 web servers when the document 
generation process has been completed. No data is stored in the Merge Service since 
all data is stored only in Salesforce.

Document Generation Features List
The following table includes a list of functions that are related to document generation, or 
"DocGen". Each column in this table represents either the Agreement, Quote/Proposal, 
standard Salesforce, and Custom objects. While every function is completely supported for 
the Agreement object, there are limitations for the Quote/Proposal, standard Salesforce, 
and Custom objects.

This list is a representation of all document generation features by Object Type.

 

The following list is a representation of the notation used:

X = supported out of the box
NSP = not supported
CSP - Comply System Properties
PSP - Proposal System Properties

 

Note
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For example, to use the Merge Service Endpoint feature for document generation on a 
custom object, you must configure Remote Site - Salesforce Admin Setting and CSP 
Endpoint.

 

 Setup required for a 
Feature

Agreement 
Object

Quote/ 
Proposal 
Object

Std. 
Salesforce 
Objects

Other Custom 
Objects

1 Merge Webservice 
Endpoint
Setup Steps:

1. Salesforce Admin 
setting: Remote Site 
Settings > 
ApttusMergeServer

2. Comply System 
Properties > Merge 
Webservice Endpoint

3. Proposal System 
Properties > Merge 
Webservice Endpoint

For more information, 
refer Appendix B > 
Custom Settings > 
Proposal System 
Properties in CPQ 
documentation.

*Admin - for 
backward 
compatibility

Setup 1 & 2 Setup 1 & 3 Setup 1 & 2 Setup 1 & 2

The table below provides the required setup, if there is a necessary configuration for a 
document generation feature. In order to see what you must configure for a particular 
object, the configuration settings are noted under that corresponding object in the table.

https://documentation.conga.com/cpq/latest/conga-configure-price-quote-cpq-143197195.html
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 Setup required for a 
Feature

Agreement 
Object

Quote/ 
Proposal 
Object

Std. 
Salesforce 
Objects

Other Custom 
Objects

2 Controlling Merge 
Call Time-out 
(default 60 secs)
Setup Steps:

1. Comply System 
Properties > Merge 
Call Timeout Millis

2. Proposal System 
Properties > Merge 
Call Timeout Millis

For more information, 
refer Appendix B > 
Custom Settings > 
Proposal System 
Properties in CPQ 
documentation.

*Admin - for 
backward 
compatibility

Max 60,000; 
Recommended 30,000

Setup 1 Setup 2 Setup 1 Setup1

3 Publish Merge Events
Comply System 
Property > Publish 
Merge Events

X NSP NSP NSP

https://documentation.conga.com/cpq/latest/conga-configure-price-quote-cpq-143197195.html
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 Setup required for a 
Feature

Agreement 
Object

Quote/ 
Proposal 
Object

Std. 
Salesforce 
Objects

Other Custom 
Objects

4 Generation Document 
from Record
Generate Action 
button setup:

1. Create an action 
formula field on the 
Object, and then add 
it to the layout. Refer 
to Generating on a 
Custom Object.

X X Setup 1 Setup 1
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 Setup required for a 
Feature

Agreement 
Object

Quote/ 
Proposal 
Object

Std. 
Salesforce 
Objects

Other Custom 
Objects

5 Generation PDF 
Security
Setup steps:

1a. Select Comply 
System Properties > 
Enable PDF Security

1b. Enter a password 
value for Comply 
System Properties > 
PDF Owner Password

1c. Create/Modify 
APTS_ComplyConfig 
Admin object for PDF 
security defaults 
(optional) 

See Enabling PDF 
Security for 
Agreement 
Documents for 
details.

2a. Proposal System 
Properties > Enable 
PDF Security

2b. Proposal System 
Properties > PDF 
Owner Password

2c. Create/Modify 
APTS_ProposalConfig 
Admin object for PDF 
security defaults 
(optional)

Setup 1(a,b,c) Setup 2 (a,b,c) Setup 1 (a,b, c) Setup 1 (a,b,c)
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 Setup required for a 
Feature

Agreement 
Object

Quote/ 
Proposal 
Object

Std. 
Salesforce 
Objects

Other Custom 
Objects

See Enabling PDF 
Security on 
Generated Quote/ 
Proposal Document in 
CPQ documentation.

6 Generation Word 
Document Protection
Setup steps:

1. Create Admin > 
APTS_Protection

2. Create Admin > 
APTS_Password

3. Create Agreement 
Protection table 
entries for the 
following pairs:

User Profile / Preview

User Profile / 
Generate

User Profile / 
Regenerate

User Profile / 
Generate Supporting 
Document

Setup 1, 2, & 3 NSP NSP NSP

https://documentation.conga.com/cpq/latest/conga-configure-price-quote-cpq-143197195.html
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 Setup required for a 
Feature

Agreement 
Object

Quote/ 
Proposal 
Object

Std. 
Salesforce 
Objects

Other Custom 
Objects

7 Versioning Word 
Document Protection

Setup steps:

1. Create Admin > 
APTS_Protection

2. Create Admin > 
APTS_Password

3. Create Agreement 
Protection table 
entries for the 
following pairs:
User Profile / Save 
Initial Version

User Profile / Save 
External Version

User Profile / Save 
Final Version

Setup 1,2, & 3 Setup 1,2, & 3 Setup 1,2, & 3 Setup 1,2, & 3

8 Async Mode of Merge
Setup steps:

1. Create Admin > 
APTS_AsyncMergeCal 
l

2. Create Admin > 
APTS_AsyncMergeEm 
ail

Calls over 60 seconds 
are processed.

*Custom objects with 
related lists are not 
supported

Setup 1 & 2 Setup 1 & 2 *Setup 1 & 2 *Setup 1 & 2
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 Setup required for a 
Feature

Agreement 
Object

Quote/ 
Proposal 
Object

Std. 
Salesforce 
Objects

Other Custom 
Objects

9 Template setup for 
default system 
filtering on Generate 
and other Template 
functionality from X- 
Author Contracts
Setup steps:

1. Agreement Object > 
Record Types picklist 
values

2. Template Object > 
Agreement Type 
picklist values

3. Template Object > 
Business Object 
picklist values

*Template Object 
setup - For internal 
use only

1. X

2. Add Object 
record types 
Values 
3. X

1. X

2. Add Object 
record types 
Values 
3. X 

1. Add Object 
Value

2. Add Object 
record Types 
Values 
3. X 

1. Add Object 
Value

2. Add Object 
record types 
Values 
3. Add API name 
of Custom 
Business Object 

1 
0

Auto Enabling 
Checking In for Final 
version in PDF format
Setup steps:

Comply System 
Properties > 
Auto Enable 
PDF Final Docs
Comply System 
Properties > 
Allow PDF 
Select Override

X NSP NSP NSP
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 Setup required for a 
Feature

Agreement 
Object

Quote/ 
Proposal 
Object

Std. 
Salesforce 
Objects

Other Custom 
Objects

1 
1

Auto Enable 
Reconciliation
Setup steps:

Comply System 
Properties > 
Auto Enable 
Reconciliation
Comply System 
Properties > 
Allow Reconcile 
Override

X NSP NSP NSP

1 
2

Header / Footer 
Stamp
Setup steps:

Comply System 
Properties > 
Auto Insert 
Header Footer
Comply System 
Properties > 
Agreement 
Number Field 
For Imported 
Docs
Comply System 
Properties > 
Footer 
Datetime 
Format For 
Imported Docs

X NSP NSP NSP
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 Setup required for a 
Feature

Agreement 
Object

Quote/ 
Proposal 
Object

Std. 
Salesforce 
Objects

Other Custom 
Objects

1 
3

Enabling Term 
Exceptions in Author

Create Admin > 
EnableTermExc 
eptionsInAuthor

* Available for all 
Template types (valid 
association with TE - 
only for Agreement 
Clause Template)

X NSP NSP NSP

1 
4

Create New 
Template & Check-In 
Template

Setup #9 required 
prior

X X X X

1 
5

Check-out Template
Setup #9 required 
prior

X X X X

1 
6

Clone Template
Setup #9 required 
prior

X X X X

1 
7

Template
Playbook: default 
Search, Select, Insert 
Clause inline or as a 
reference

Setup #9 required 
prior

X X X X
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 Setup required for a 
Feature

Agreement 
Object

Quote/ 
Proposal 
Object

Std. 
Salesforce 
Objects

Other Custom 
Objects

1 
8

Insert Merge Fields for 
corresponding 
Objects
- Header

- Lookups

- Related - In Section

- Related - In Table

Setup #9 required 
prior

X X X X

1 
9

Insert Smart Merge 
Fields for 
corresponding 
Objects
- Header

- Lookups

- Related - In Section

- Related - In Table

Setup #9 required 
prior

X NSP NSP NSP

2 
0

Document Assembly 
Rules
Insert Dynamic 
Sections in X-Author 
for Contracts

*Available for 
Agreement object 
only

X NSP NSP NSP

2 
1

Filtered Rows
Apply Filter in X- 
Author

X X X X
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 Setup required for a 
Feature

Agreement 
Object

Quote/ 
Proposal 
Object

Std. 
Salesforce 
Objects

Other Custom 
Objects

2 
2

Conditional Content
Make Conditional in 
X-Author for 
Contracts

X X X X

2 
3

Auto-publish X X X X

2 
4

Generate. Output 
Format and add 
Watermark Support
DOC, DOCX, PDF, RTF

X X X X

2 
5

Support Controlled 
Preferences for 
Output Format and 
Watermark
*pairs: Record Type / 
User Profile

1. Agreement Output 
Format Tab

2. Proposal Output 
Format Tab

X X NSP NSP

2 
6

Check-in Third Party 
Document. Import 
Offline - Create 
record and attach

X NSP NSP NSP

2 
7

Check-in Third Party 
Document. Import 
Offline - Attach to 
existing record

X NSP NSP NSP
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 Setup required for a 
Feature

Agreement 
Object

Quote/ 
Proposal 
Object

Std. 
Salesforce 
Objects

Other Custom 
Objects

2 
8

Check-in Document, 
attachment of the 
record
- With Redlines

- Without Redlines

- Final to be Signed

- Watermark

- Naming Override

X NSP NSP NSP

2 
9

Check-out Document, 
attachment of the 
record

X NSP NSP NSP

3 
0

Compare Documents, 
attachments of the 
record

X NSP NSP NSP

3 
1

Locking
Refresh Lock

X NSP NSP NSP

3 
2

Create Section
Save selection as 
Agreement Clause

X NSP NSP NSP

3 
3

Playbook: Insert 
Clause into the 
Document on the 
records

X NSP NSP NSP

3 
4

Reconcile Documents
- Highlight Smart 
Fields

- Reconciliation of the 
values

X NSP NSP NSP
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 Setup required for a 
Feature

Agreement 
Object

Quote/ 
Proposal 
Object

Std. 
Salesforce 
Objects

Other Custom 
Objects

3 
5

Tag Smart Fields X NSP NSP NSP

3 
6

Update Document 
from Salesforce

X NSP NSP NSP

3 
7

Multi-currency 
support by the 
products of the 
system
1. Merge - Comply - 
Proposals

2. X-Author Contracts

*Functionality 
related to Smart 
Field: Reconciliation, 
Tagging currency 
fields is affected

1. X

2. X

NSP NSP NSP

3 
8

Chatter with Record
Setup steps:

1. Select Enable 
Chatter Feeds for the 
object

Setup 1 NSP NSP NSP

      

 Admin > 
AutoContentSearcha 
ble *for activation 
only

X    

 eSignature support X NSP NSP NSP

 - EchoSign X NSP NSP NSP

 - DocuSign X NSP NSP NSP
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6.

1.

Generating on a Custom Object
Conga CLM provides a solution for configuring document generation on Custom Objects. 
Configuration for this feature creates a slightly different flow than for Agreements and 
utilizes a separate Visualforce page and class to facilitate document generation. Follow 
the steps in this section to configure your custom object for document generation. In this 
section, the Custom Object "Invoice" is considered in the examples.

Setting up Template: Object Type
Before you can generate on any object, it must first be associated with the Template 
object.

Go to Setup > Create > Objects
Click on the link for the Template object.
Under "Custom Fields & Relationships", click on Type.
Under "Picklist Value Set", click New.
Enter the label name of the custom business object you want to associate with the 
template (e.g., "Invoice").
Click Save. On the next page, check the picklist values to verify your entries were 
saved. 
 

 

Setting up Template: Agreement Type
The next step requires you to create record types for your custom object.

Go to Setup > Create > Objects.
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2.
3.
4.
5.

6.

1.
2.
3.
4.
5.
6.

Click on the link for the Template object.
Under "Custom Fields & Relationships", click on Agreement Types.
Under "Picklist Value Set", click New.
Enter record types for your custom object templates, with each entry on a separate 
line. In this example, consider 3 record types for Invoice (Pro Forma, Credit Memo, and 
Debit Memo).
Click Save. On the next page, check the picklist values to verify your entries were 
saved. 
 

Setting up Template: Business Object
Complete template setup by finalizing the association of your custom object with the 
template.

Go to Setup > Create > Objects.
Click on the link for the Template object.
Under "Custom Fields & Relationships", click on Business Object.
Under "Picklist Value Set", click New.
Enter the API name of your custom object as a new picklist entry. (e.g., "Invoice__c")
Click Save. On the next page, check the picklist values to verify your entries were 
saved.  
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7.

8.

9.

10.

11.

 
Next, create associations between your new Business Object and template Types 
using dependent picklists. Go back to the Template object and click on the Type field.
Under "Field Dependencies," click Edit next to the "Business Object" dependent field. 
 

 

 
Create a dependency between the Template Type for your custom object and the 
Business Object you defined in Step 5. Click on the Business Object API name in the list 
under your custom object type and click Include Values. In the below 
example, "Invoice__c" is included in the "Invoice" dependent picklist. 
 

 

 
If you intend to define clauses to use in your custom object templates, you also need 
to add your custom business object to the Clause dependent picklist. Click on the 
Business Object API name in the list under "Clause" and click Include Values. In the 
below example, "Invoice__c" is included in the "Clause" dependent picklist. 
 

 

 
Click Save to save your dependencies.
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5.

Setting up Custom Object: Generate Action
The final step required to configure your custom object for document generation is to create 
the field or button on your custom object and add it to the object layout. Custom objects 
use a specific Visualforce page and controller class for generating documents. Pay 
attention to the format in the steps below. In the following example, a custom "Generate" 
field is created for the Invoice object. You can also make this a button or a link if you want– 
the action is controlled by a formula in every case.

Go to Setup > Create > Object > Your Custom Object. (this example is for "Invoice")
Under "Custom Fields & Relationships," click New.
For "Data Type," select Formula. Click Next.
Enter the label you want to use for your Generate action ("Generate Invoice" is used 
here). For "Formula Return Type," choose Text. Click Next. 
 

 

 
Enter the formula for your custom Generate action. In your formula, define the 
template type as the label for your custom object (e.g., "Invoice"). Be sure to check your 
syntax. The following is an example: 
 
HYPERLINK("/apex/Apttus__DocumentGenerate?id="&Id & 
"&action=Generate_Document&templateType=Invoice", IMAGE("/resource/ 
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7.

8.

Apttus__Button_Generate", "Generate"),"_self") 
 

 

 
Click Next when you are satisfied with your formula. 
 
On the next page, specify field-level security for profiles to use the Generate action. 
Click Next.
Specify which page layouts should include this field. You can always add the field to 
new layouts as you need to in the future.
Click Save. You are finished!

Creating Templates for your Custom Object
Follow the same instructions found in the X-Author for Contracts documentation to create 
and check-in your custom object templates for document generation. Remember that Rules 
and Document Protection are not supported for any object other than Agreements. The 
Generate flow for your custom objects will have a single step and resemble the page 
displayed in the below image.

https://documentation.conga.com/x-author-for-contracts/latest/x-author-for-contracts-154927679.html
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Agreement Document Output Formats
Documents are often set up to allow you the option of specifying a document output 
format upon generation. In some cases, you may want to restrict these options.

You can set up company-wide default formats to be used for generating documents, at 
User Profile and Agreement Type levels. Along with specifying the format, one can also 
indicate whether the end-user can override the default format. This is indicated by the 
Allow Override checkbox shown in the setup UI. Supported formats are DOC, DOCX, PDF, 
RTF, and PDF/A. If you select the Prompt option, you will be prompted to select a format at 
the time of document generation/preview.

To set up an agreement output format
You must have the Apttus Administrator profile.

Click   and click Agreement Document Output Formats.
Select a profile and click Edit.  
For example, Conga Administrator.
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1.

For agreement type, select the required output format option. 
 

To add or remove a watermark, select or clear Allow Override (Watermark).
Click Save.

You have configured the output-controlling parameters to generate an agreement 
document in a required format.

Use Case for Setting Up Document Output Format
This topic describes the use case for setting up document output format. This use case gives 
one example on how to set up default document output format for publishing your 
agreement. You might use this functionality differently, depending on your business case. In 
this case, a System Administrator configures the default document output format settings 
which allow users to automatically generate an agreement in the desired output format. In 
addition, Allowable Output Formats option, allows users to select a different format if 
necessary.This use case describes how to set up default document output format which 
fulfills users’ specific needs.

Prerequisite:

You must have the System Administrator profile access permission.

To set up output formats for your agreement, perform the following steps:

Select the Agreement Document Output Formats tab. 
Setup Agreement Document Output Formats page is displayed.

When you select the document format and any of the other settings at the 
<<Profile Level>>, it is saved as the setting for any record type where you 
select Prompt. 
The setting at <<Profile Level>> does not override record types where a 
specific format is selected as default.
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4.
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6.
7.
8.
9.

10.
11.

Select System Administrator from the Select Profile drop-down list.
Click Edit.
Select PDF radio button, if you want pdf for the output document in the Agreement 
Type Formats for Profile: System Administrator section. 
Supported formats are PDF, PDF/A, DOC, DOCX, and RTF.
Click Save.

Result:

Your agreement record will display PDF by default when you preview, generated, and re- 
generate the document.

Next Step:

Similarly, you can set up other types of Agreement Document Output Formats based on 
your specific need.

Configuring PDF/A as a Document Output Format
You need to manually configure PDF/A as a document output format only if you upgrade to 
Summer '21 release or a later release. You need to add the PDF/A document output format 
in the Agreement Output Format object and the Allowable Output Formats field in the 
Agreement object.

To configure PDF/A as a document output format
Go to Setup > Object Manager > Agreement > Fields & Relationships > Allowable 
Output Formats.
Click New.
Enter PDF/A and click Save. 
When you navigate to the Agreement Detail page and edit the Allowable Output 
Formats field, you can see the PDF/A in the Available column.
Go to Setup > Object Manager > Agreement Document Output Format > Fields & 
Relationships > Output Format.
Click New.
Enter PDF/A and click Save.
Go to the Agreement Document Output Formats tab.
Select a profile from the Select Profile drop-down list.
Click Edit.
Select the PDF/A radio button for an Agreement Type according to your requirement.
Click Save. 
When you generate an agreement, regenerate an agreement, or generate a 
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5.
6.

1.
2.

supporting document, you can see PDF/A as an output format option. 

Managing Alternate Clauses
Alternate clauses are substitutes for the main clause. You can create an alternate clause 
or change the clause type of the main clause in X-Author for Contracts. You can add 
alternate clauses as a substitute for the main clause. You can also replace the main 
clause in the agreement with an alternate clause. 

Prerequisite
Ensure that you have created alternate and main clauses.

Restrictions
You can add alternate clauses to the main clause, but you cannot add alternate 
clauses for an alternate clause.
You must not create an alternate clause from CLM.

To add alternate clauses to the main clause
Navigate to the Templates tab.
Select a main clause.
Click the Alternate Clauses tab.
Click the Select Alternatives button.
Select the alternate clauses.
Click Add.

To remove an alternate clause from the main clause
Click the icon.
Select Remove.
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Agreement Lifecycle Management
This section describes how to request an agreement, manage it through the Agreement 
Lifecycle and which actions are available to manage your agreement after it goes into 
effect. Here is a brief summary of the following sections:

Requesting and Drafting Agreement

Requesting for an agreement is the first stage of the contract management process. At this 
stage, users initiate agreements and find apposite documents.

 

Generating An Agreement

Conga CLM enables you to generate an agreement using an existing template.

 

Configurable Wizard

This feature makes it possible to create your own agreement-creation wizards. These 
wizards can then be used by your sales representatives, purchasing agents, HR managers 
and other users to quickly create their own agreements.

 

Negotiating An Agreement

This stage is designed for you to manage the agreement negotiation process. You can 
manage redlined versions of agreements in various formats side-by-side, Lock / send 
document, insert clauses, respond, chat, and compare versions. This also allows you to 
quickly observe any discrepancies and reduce negotiation time.

 

Marking an Agreement Document as Private

Conga CLM now allows you mark your agreement document as private.

 

Finalizing An Agreement

This stage covers the process for sending agreements for executing, gathering signatures 
and logging into the repository.

 

Routing Documents to Content Libraries
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The Libraries tab has several publishing-related options at the top of the page that allows 
you to upload, classify, and publish files in the Salesforce CRM Content repository.

 

Managing Templates

Conga CLM template is a common set of sections, clauses, text, and placeholders for terms 
and conditions. Templates can be merged with structured data to generate agreements or 
proposals. Templates are stored within an Apttus template repository, and are used to 
create quotes and contracts. Conga CLM template can be termed as a blueprint or mold 
for creating distributable documents.

 

Agreement Phases

The contract process goes through typical sequences of events, or phases.

 

Managing Obligations

Obligation management refers to email alerts and reminders that ensure internal and 
external obligations in connection to your agreements are properly fulfilled.

 

Searching and Reporting

Conga CLM provides the default set of capabilities for searching, views, dashboards, and 
reporting. This is one of the key benefits from a Contract Management system. The ability 
to get the key information out, for example, dates, amounts and number of contracts to 
make business decisions is crucial. Modifying the search and reports is based on standard 
Salesforce functionality.

About Agreement Lifecycle Management Process
Contract Lifecycle Management includes processes that contribute, create or utilize 
contract data. Conga CLM has defined the contract lifecycle to encompass everything 
from the initial request right through to the settlements of financial transactions around 
the agreement and enables you to have complete visibility and control over any given 
contract. Conga CLM covers multiple business functions that can be managed seamlessly 
through a single application across the enterprise.

Contract Management process includes the following stages.
Requesting and Drafting an Agreement
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Agreement Negotiation
Agreement Finalization
Agreement Phases
Obligation Management
Searching and Reporting

Conga CLM allows you to do the following actions.

Leverage Salesforce as a central repository for all corporate contractual 
agreements.
Set up a central repository, which provides visibility into contractual commitments, 
and reduces the risk of litigation and revenue leakage.
Setup alerts and notifications around predefined trigger points.

The following diagram provides an example of a typical agreement process flow.

 

Agreement Actions and Corresponding Behaviors
The diagram provides the flow of typical Agreement Actions and behaviors, based on 
Agreement Status Categories and Statuses and requirements.
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Requesting and Drafting an Agreement
Requesting for an agreement is the first stage of the contract management process. At this 
stage, users initiate agreements and find apposite documents. This capability is designed 
with the idea of having the contract requestor fill out necessary information around an 
agreement and have it auto-populated into the relevant Agreement template to create an 
Agreement Document for presenting to trading partner. For details, refer to CLM for Users.

Setting Up Agreement Request Process 
Setting up an agreement request process enables the default process for managing 
and fulfilling Agreement Requests submitted by Requesters.
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Setting Up Rule-based Agreement Request Process Parameters 
The Agreement Request process requires parameters to identify the Auto Agreement 
Generation (Self Service Mode), Agreement Type, Queue for assigning, Agreement 
Template, and email template for notification. If the parameters are identified based 
on the values in the agreement record, Agreement Rules can be defined to identify 
these parameters.

Drafting an Agreement 
While drafting an agreement, Conga CLM can accommodate any Agreement 
template type (Sales, Procurement, Services, Intellectual Property, etc.). The Out-of- 
the-box system does not have default Agreement types.

Setting Up Agreement Request Process
Setting up an agreement request process enables the default process for managing and 
fulfilling Agreement Requests submitted by Requesters. The following are the examples of a 
typical agreement request process.

Requester enters relevant details for the Agreement and clicks on Submit Request.
Based on the information provided by requester, system decides if an agreement is a 
Standard self-service agreement or a non-standard agreement requiring authoring 
and negotiations.
In case of a Standard Agreement, system creates an agreement document from the 
configured template and sends an email containing the agreement document as an 
attachment to the requester, agreement owner and the primary contact. Requester 
obtains the signatures on the agreement document, scans the hard copy, and 
attaches it to the agreement record. Clicking Activate puts the agreement In Effect.
In case of non-standard Agreement, the agreement owner is changed to the 
configured queue. Members of the queue will take ownership of the agreement, author 
the contract, and negotiate with the other party. After finalization of the contract 
they click Return to Requester link to inform the requester that the contract is ready 
for printing and getting the signatures. Requester obtains the signatures on the 
agreement document, scans the hard copy and attaches it to the agreement record. 
Clicking Activate puts the agreement In Effect.

To set up an agreement request process

User Permissions Needed

To create a new admin entry or edit an existing 
entry:

Admin: Read, Create, Edit.
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Click + and click Admin.
Click New.
Enter the APTS_SubmitRequestConfig property and XML value, and paste the 
following code into the Code area:

The defaults specified in the above code is:
Agreement Template = ComplyAgmtTemplate
Agreement Type = Other
Email Template(sent when standard or self service contract is generated by 
system) = Agreement Review Notification
Queue to which request is sent in case of request for Non Standard Agreement = 
Reviewers

This is the minimum override with which you must enable the Agreement Request 
process functionality so that defaults are defined for Agreement types, templates, 
and queues if rules are not fired during the process.

<SubmitRequest>  1
<Defaults> 2
  <RequestMode>Manual</RequestMode>3
  <SendEmail>true</SendEmail>4
  <UpdateAgreementType>false</UpdateAgreementType>  5
  <AutoMode>   6
    <AgreementType>Other</AgreementType> 7
        <Template>ComplyAgmtTemplate</Template>     8
        <EmailTemplate>Agreement Review Notification (Auto)</ 

EmailTemplate>

9

        <DocumentFormat>DOC</DocumentFormat>10
  </AutoMode>11
  <ManualMode>12
        <Queue>Reviewers</Queue>13
     <EmailTemplate>Agreement Review Notification</EmailTemplate> 14
  </ManualMode>15
 </Defaults>16
 </SubmitRequest>17

•

•

Ensure that the default values in the above code piece are replaced with 
values applicable to your implementation, if necessary.
A sample SubmitRequestConfigSampleXML file is in the Static Resources as 
part of the standard Conga CLM. The contents of this XML file can be copied, 
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Setting Up Rule-based Agreement Request Process 
Parameters
The Agreement Request process requires parameters to identify the Auto Agreement 
Generation (Self Service Mode), Agreement Type, Queue for assigning, Agreement Template, 
and Email Template for notification. If the parameters are identified based on the values in 
the agreement record, Agreement Rules can be defined to identify these parameters.

A rule filter criteria is evaluated in memory using the Apttus expression library and is not 
dependent on SOQL. All the configurations to create an agreement rule is done from the 
Agreement Rules tab and you can use Filter Criteria to set conditions based on the field, 
operator, and corresponding values.

Parameters (Rule Types) and respective description.

Parameters Description

Submit Request Mode If the value for this parameter is set to Auto, this mode triggers 
the automatic generation of agreement document. If the value 
for this parameter is set to Manual, the next Agreement Rule in 
the sequence is executed.

Agreement Type This parameter is used to identify the type of agreement to be 
created for this request. In case the Agreement Type is already 
identified by the requester, this parameter can be skipped.

Agreement Template This parameter is used to identify the agreement template to be 
used for automatic generation of the agreement document. This 
parameter can be skipped if there is no requirement for 
automatic agreement generation.

Queue This parameter identifies the queue to which the agreement 
ownership is transferred to process the agreement request.

customized and pasted into the above Admin entry to enable additional 
processing logic.
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Parameters Description

Email Template This parameter is used to identify the template used for sending 
email with automatically generated agreement document to 
predefined set of recipients. In non-Auto mode of agreement 
request processing the template identifies the email format sent 
to the Queue members processing the agreement request. For 
example, if Agreement Category is Sales, send the Agreement 
Request to Legal – Procurement Queue.

Document Folder The default repository to store executed contracts is Apttus 
Documents folder. If you want to use the custom folder to store 
published contracts, specify the folder name by selecting 
'Document Folder' rule type with required conditions. In this way 
you can store your published contracts in multiple folders.

To setup Agreement Rules to identify Agreement Request 
Process parameters

User Permissions Needed

To create, edit or delete an Agreement Rule: Agreement Rule: Read, Create, Edit, 
Delete.Agreement: ReadTemplate: Read

Click + and select Agreement Rules.
Click New and type a mandatory Sequence for the rule to determine the order in 
which the agreement rules are evaluated. 
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3.

4.

5.

6.

7.

 

 
Select a mandatory Rule Type and enter a correct Rule Value. For example, if you 
select Queue Assignment as Rule Type, enter a valid Queue name for Rule Value.
Select the Active check box to activate an agreement rule.

Inclusion Criteria and Filter Criteria sections for an agreement rule are optional, so 
you may skip Step 5 and Step 6.
In the Inclusion Criteria section, select the field and expression you want to use as 
entry criteria for the filter. For example, if you want to use agreement records of MSA 
record type, it can be included in the Inclusion Criteria.
In the Filter Criteria section, select the fields and expressions you want to use to 
control which agreement records will be visible when the inclusion criteria is met. For 
example, if you want to filter only the agreement records whose Start Date is after 
May 21,  
2015, enter this condition in the Filter Criteria. If you use multiple fields, you can have 
a standard AND relationship between the expressions, meaning each expression must 
evaluate as true or use Advanced Options to the fields together in a more complex 
formula.
Click Save.

Similarly, you can setup the rules for the other parameters using the Rule Type field in step 
3 for Email Template, Agreement Type, Agreement Template, Submit Request Mode, and 
Document Folder parameters.

By default, the Active check box is selected.
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Drafting an Agreement
You must set up the agreement type. Conga CLM can accommodate any Agreement 
template type (Sales, Procurement, Services, Intellectual Property, etc.). The Out-of-the-box 
system does not have default Agreement types. If agreement types are not setup or if you 
have access to only one agreement type, then the step 2 is skipped and you will be 
navigated to the next step.

Click Agreements > New.
 

 

In the Select Agreement Record Type page, choose the desired Agreement Record 
Type and click Continue.
The New Agreement page is displayed. This is an intermediate page that allows you 
to enter values for certain important fields in your agreement record. Fill all the 
required fields (marked in red) and click Continue.

If the default Agreement type is not set up for your org or you see only one 
agreement type, you will be navigated to the New Agreement page.



Fields included on this page are configured in the Agreement New Field Set. Go 
to Setup > Create > Objects > Agreement > Field Sets to edit the set of fields 
displayed on this page.
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5.

6.

In the Agreement Edit form fill out various data fields relevant to this agreement to 
complete the agreement. Fields marked in red are required fields. For the complete list 
of agreement fields, see Agreements Fields.

 

 

Fill in the Agreement details form applicable for the selected Agreement Type and 
click Save.
You can search and report the created draft agreement. The following table 
describes the usage of available buttons.

The Status Category and Status fields are system fields, which help in 
identifying which step of the agreement process is currently in the agreement 
lifecycle. Agreement Status Category is a group of various Statuses. You can 
select the Status based on their respective process steps. The combination of 
Status Category and Status determines the actions available for a particular 
agreement. See Agreement Status Categories and Agreement Actions for 
details on various Status categories, corresponding Status and the Actions 
available at the respective Statuses respectively. Each agreement type can 
have data fields that are specific to an agreement type.
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Button Description

Save Click Save to keep and retain your agreement details. 
If you need to change or modify the agreement details, click 
Edit, and continue working without any risk of losing your work 
until the point of your last save.

Save & New Click Save & New to save your work and start creating a new 
Agreement Record. The system navigates you to the 
intermediary screen to select a new Agreement Type. 
This is useful if you need to create a master and subordinate 
agreement or related agreements, such as the primary 
agreement and a related Non-Disclosure Agreement (NDA), and 
want to save time by jumping right from creating the first 
agreement record to creating another one.

Cancel Click Cancel to adjourn the process of editing the Agreement 
Record and discard all the changes made since the last edit. 
Click Yes to confirm your selection.

 
After you save the agreement, the following new sections are enabled on the 
agreement page (depending on your configuration, there may be additional sections 
and/or Related Lists displayed).

Agreement Section Description

Actions Lists the various actions you can execute for a particular 
stage of the agreement process. 
For details on agreement actions with the description of 
their respective functions, see Appendix H: Agreement 
Actions.

Notes & Attachments Enables you to attach any reference document or file 
relevant to a particular agreement. The agreement 
document when generated from the template is stored 
by the application in this section.
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Agreement Section Description

Agreement Documents Enables you to store reference to external URL or files. 
Common uses for this functionality is to store the URL 
reference to a document stored within the computer 
firewall.

Agreement Clauses System store for any clauses that you choose to identify 
for reference and reporting purpose. For example, during 
negotiation if you add any clause, which may be 
considered non-standard and high risk, select that 
clause and makes it into a Agreement Clause to enable 
higher visibility for other users who are accessing this 
agreement, and also reporting on High Risk contracts.

Child Agreements Enables you to initiate and store references to child 
agreements for the current agreement.

Open Activities Enables you to create and assign new task 
corresponding to a particular agreement. On completion 
of a task, the user marks the activity closed by clicking 
the Cls link.

Approval History Initiate and track approvals corresponding to the 
agreement.

Activity History Lists an audit history of significant changes during the 
life of the agreement.

Related Agreements (To and 
From)

Enables users to relate other agreements in the 
repository for reference purposes. For example, the NDA 
with a particular vendor can be associated to the 
Master Services Agreement with the same vendor to 
enable a single point of access for all relevant 
information for this account. The To and From refers to 
the relationship direction.

Approvals can be initiated only if the 
corresponding approval rules or process has 
been setup by the System Administrator.





CLM

326 Copyright ©2022 Apttus Corporation. All rights reserved.
 

•

•

 
 

 To preview the agreement document, click Preview. For details, see Preview 
Agreement in Appendix H.
To send the agreement document to the third party for review, click Send For Review. 
This button is available if the Status for the Agreement Record is In Authoring or In 
Signatures. The button allows you to specify the attachment to send and then either 
look up or type in the other individuals to receive the Agreement Document. Use the 
lookup item to add contacts from within the system, and/or use the Additional To: 
field to enter email addresses of recipients manually. Once completed, click Send and 
the activity is logged in the Activity Log allowing others to see that the step has been 
taken, by whom, along with a time/date stamp.

Generating An Agreement - User Permissions
Conga CLM enables you to generate an agreement using an existing template.

User Permissions Needed

To preview an agreement: Agreement: ReadTemplate: ReadAsyncMergeCall: 
Read, Create, Edit (Field Access: Read, Edit)

To generate/regenerate an agreement: Agreement: EditTemplate: ReadAsyncMergeCall: 
Read, Create, Edit (Field Access: Read, Edit)

Templates can be created using X-Author for Contracts. For each agreement record type, a 
different template can be created in Microsoft Word. For more information on creating a 
template using X-Author for Contracts, see X-Author Contracts documentation.

Configuring Columns in the Template Selection 
Page in Lightning
In the Template Selection page, you can configure the template attributes that must be 
displayed as columns in the template selection section available when you preview 
documents, generate documents, regenerate documents, and generate supporting 
documents. By default, Name, Guidance, Category, and SubCategory template attributes 
are available. You can add as many columns as required. The order of the columns is 
determined by the order of the template attributes in the field set.

https://documentation.conga.com/x-author-for-contracts/latest/x-author-for-contracts-154927679.html
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To add columns in the template selection page
Navigate to the Template Object > Field Sets > Template List Field Set.
Drag and drop template attributes In the Field Set section.
Reorder the template attributes in the order that must be displayed in the Template 
Selection section.
Click Save. 
When you navigate to the Template Selection section, you can view the new columns 
appear in the configured order.

Negotiating An Agreement
This stage is designed for you to manage the agreement negotiation process. You can 
manage redlined versions of agreements in various formats side-by-side, Lock/ Send a 
document, insert clauses, respond, chat, and compare versions. This also allows you to 
quickly observe any discrepancies and reduce negotiation time.

Typically, this part of the process is handled by the following key roles (Agreement 
Negotiators):

Agreement Facilitator
Legal admin, counsel
Financial analyst, controller
VP/Director/Sales manager, sales operations, procurement, partners

Key Tasks Associated With the Negotiation Phase
The following key tasks are involved to complete the negotiation:

Timely internal collaboration in the negotiation process
Maintenance of persistent repository of predefined agreement clauses
Reconcile redline / compare negotiated changes to terms, clauses, lines
Retention of artifacts throughout the negotiation

You can secure documents during the negotiation cycle.

As an Agreement Negotiator, you coordinate changes to the agreement that might occur 
over the course of agreement negotiation. They are generally involved in finalizing the 
process in accordance with company policies and legal requirements. Agreement 
Negotiators can perform the following:

Amend and save agreements/proposals in Salesforce
Highlight reconcilable data
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3.
4.

Reconcile agreement/proposal records
View chatter feeds from within Microsoft Word
Share content and document to Salesforce Chatter
Translate agreement/proposal documents from one language to another
Create reminder tasks or schedule appointment events in relation to the opened 
agreement/proposal document
Redline and store versions of the document during negotiations
Compare different versions of agreements/proposals side by side

To create and negotiate an agreement, the X-Author Contracts Word add-in is designed for 
agreement administrators and legal users to help streamline the process of maintaining 
agreements and associated agreement and clause templates. Using the X-Author for 
Contracts, agreement administrators can manage complex negotiation cycles, clause and 
agreement template easily. 

The add-in provides support for versioning of agreements, and agreement administrators 
can save redlined, clean and final versions of non-standard language in a Word document 
opened either from Salesforce or locally. When saving final versions, the add-in also helps 
the user to reconcile any terms that might have changed during the approval process. 
Agreement and Clause templates can also be managed, including the ability to insert, 
save as, and replace them to and from Conga CLM. Finally, users can compare versions of 
an agreement document.

For details on the X-Author for Contracts functions, see X-Author for Contracts 
documentation.

To negotiate an agreement
Next, to the Agreement Document in the Notes & Attachments area, click View. Save 
the document to any location on your computer.
Open the document using Microsoft Word.
On the toolbar, click X-Author for Contracts.
Login with your credentials.

To use X-Author Contracts, you do not need to login directly via Salesforce. 
You only need to connect from the X-Author ribbon in Word. For details, see 
Connecting to Contracts section in X-Author for Contracts documentation.
Using Alternate and Fallback Provisions During the negotiation process, you 
may wish to incorporate existing alternate and fallback provisions that have 
been stored in your clause library. To perform this function, click X-Author 
Contracts, and then click the Playbook option. At the top of the new search 



https://documentation.conga.com/x-author-for-contracts/latest/x-author-for-contracts-154927679.html
https://documentation.conga.com/x-author-for-contracts/latest/x-author-for-contracts-154927679.html
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When the agreement document is open and ready to be edited, go to X-Author for 
Contracts X-Author and choose Save as Final Version.
If you are prompted to Reconcile, click No. 
 

Click View Refresh in browser. This action updates the agreement version in the 
repository and activity history.

window which opens on the right, you will be able to select from various filters 
to locate desired clauses that you may want to insert. You may insert the 
selected clauses as a reference or as inline text in your template When 
querying the Clause Library, you can elect to query the full language that will 
be included in your agreement or only the guidance. You can control this 
option by selecting X-Author, and then clicking Options > Template tab. Select 
or clear Store Template / Clause Content as Text. Add new text and delete a 
clause anywhere in the document. The X-Author plug-in provides the following 
options:

Save as Internal Version Save to Conga CLM and preserve redlines. You can 
use the default name that comes up or overrides 
and enters one of your own.

Save as External Version Save to Conga CLM and remove redlines. All 
changes are automatically accepted and the 
redlines are removed. You can use the default name 
provided by the plug-in when you enter this option 
or override and enter one of your own.

Save as Final Version Save to Conga CLM, remove redlines, and prepare 
for obtaining signatures. The Save as Final Version 
initiates the process of finalizing an Agreement by 
accepting all changes and changing the Status 
Category to In Signatures.

By using consistent naming conventions in your organization, you can simplify 
the process of keeping everyone on the same page in terms of what is 
happening in a negotiation and provide an easy-to-follow historical record of 
activities.



If the variables (for example, start date, end date) were modified, ensure the 
same change has been made on the agreement detail page.
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Go to X-Author for Contracts in Microsoft Word and click Compare, and select two versions 
of the agreement that you need to compare. The two versions of the agreement are 
presented side by side and you can quickly see any differences.

About Tracking Clauses in your Agreement
Conga CLM provides two solutions for tracking the clauses used in your agreement 
documents.

Tracking Agreement Clause Activity – Track Agreement Clause activity using the 
Agreement Clause Related list. Whenever an agreement clause is inserted, modified 
or deleted during negotiation, agreement activity is recorded in the list at check-in 
and reconciliation. Use this data for reference or reporting purposes to track how non- 
standard language changes over the lifecycle of an agreement. This is the default 
means for tracking clause activity in your agreement. 
 
Tracking Agreement Clause Versions – Add the Master Clause Listing section to your 
agreement layouts to provide a comprehensive list of clauses referenced in the 
current/final agreement document, from first check-out to activation. Drill down into 
each clause listing to view a list of all Clause Iterations present in the document 
throughout the negotiation, as well as Clause Iteration Details. Generate reports on 
agreements that contain specific clauses or clause language.

 

Tracking Agreement Clause Activity
The Agreement Clauses related list on the Agreement record is used to capture clause 
activity for associated agreement documents during contract negotiation. When an 
agreement is checked out by a negotiator using X-Author for Contracts, changes can be 
made to the document that insert, modify or delete clauses. When the agreement document 
is checked back in, new records are created in the Agreement Clauses related list that 
reflect these changes. You can use this data for reference or reporting purposes to track 
how non-standard language changes over the lifecycle of an agreement.

Note

Tracking of Agreement Clause Versions is only available in Conga CLM version 
8.359 or higher when using X-Author for Contracts version 8.5.1010. Only 
agreement documents using FX2 format are supported.





CLM

331
 

Copyright ©2022 Apttus Corporation. All rights reserved.
 

•
•

•
•
•

•

•

Below is an example of Agreement Clause data recorded in the related list after several 
sessions of negotiation (NDA agreement):

  

Clause activity during negotiation and subsequent check-in captured in Agreement Clauses 
include:

Inserting a clause into an agreement document using Playbook
Marking a clause in the document and replacing its content with clause content from 
Playbook.
Marking a clause in the document to adopt the properties of a clause from Playbook.
Modifying a clause in the agreement document.
Marking a clause for deletion.

Agreement Clause Records
Two factors determine how Agreement Clause activity is recorded in the related list during 
negotiation:

The clause was inserted, modified or deleted in the initial session or a subsequent 
session. A session can be defined as the time between Check-Out and Check-In of the 
same agreement document.
The clause was or was not reconciled to the agreement record.

The following tables describe how clause actions taken during a session affect Agreement 
Clause information on the Agreement record.

Initial Session (1st Check-Out)

Note

If you are using Conga CLM 8.359 or higher with X-Author for Contracts 8.5.1010 or 
higher: After the agreement document is generated and checked out for the first 
time, a record is created in the Related List for all smart clauses present in the 
generated document with the Action as Original. 





CLM

332 Copyright ©2022 Apttus Corporation. All rights reserved.
 

•

•

Clause Actions before 
Check-In

Example At Check-In 
without 
Reconciliation

At Check-In with 
Reconciliation

You insert a clause using 
the Playbook or Mark 
Clause, without making 
any changes to the 
clause content.

"Housing Rent 
Allowance" clause is 
inserted from the 
Playbook.

Creates a single 
record in Agreement 
Clause related list 
with Action as 
Inserted.

Creates a single 
record in Agreement 
Clause related list 
with Action as 
Inserted.

After inserting a clause 
using Playbook or Mark 
Clause, you make 
changes to the clause 
content.

Contract negotiator 
changes a warranty 
period from 1 year to 2 
years in the same 
session “Housing Rent 
Allowance” is inserted.

Creates a single 
record in Agreement 
Clause related list 
with Action as 
Inserted.

Creates 2 records in 
Agreement Clause 
related list:

One with 
Action as 
Inserted.
One with 
Action as 
Modified.

Once you insert a clause 
using the Playbook or 
Mark Clause, you decide 
to remove the entire 
clause or Unmark the 
clause from the Mark 
Clause Panel.

Contract negotiator 
decides that “Housing 
Rent Allowance”  
clause does not belong 
in the contract and 
chooses to remove it in 
the same session it has 
been inserted.

No record in the 
Agreement Clause 
related list.

No record in the 
Agreement Clause 
related list.

 
Subsequent Sessions 

Actions taken on the 
Clause before Check-In

Example At Check-In 
without 
Reconciliation

At Check-In with 
Reconciliation

You do not make any 
changes to the clause 
content.

"Housing Rent Allowance" 
clause is not modified in a 
session after it is inserted.

No update to the 
Agreement 
Clause related 
list.

No update to the 
Agreement Clause 
related list.
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Actions taken on the 
Clause before Check-In

Example At Check-In 
without 
Reconciliation

At Check-In with 
Reconciliation

After checking out the same 
document, you make 
changes to the clause 
content.

"Housing Rent Allowance" 
is changed in a session 
after it has been inserted.

 

No update to the 
Agreement 
Clause related 
list.

Creates a single 
record in 
Agreement Clause 
related 
list with Action as 
Modified.

Once you Check-Out the 
same agreement 
document, you, as a Legal 
counsel, decide to 
permanently delete a 
clause from the document. 
You mark that clause for 
deletion from the Mark 
Clause Panel and Check-In 
the agreement document 
to Salesforce.

Contract negotiator 
decides that “Housing 
Rent Allowance” ought to 
be struck from the 
contract in a session 
after it had been inserted. 
Contract negotiator 
marks the clause for 
deletion.  

No update to the 
Agreement 
Clause related 
list.

Creates a single 
record in the 
Agreement Clause  
related list with 
Action as Deleted. 

 

Tracking Agreement Clause Versions
Agreement Clause Versioning enhances existing document control by introducing a solution 
framework of clause versioning at the Agreement record level. Using this feature, you can 
easily view a comprehensive list of clauses referenced in the current agreement 
document. Agreement Clause Versioning is intended to complement standard agreement 
clause tracking through the Agreement Clause Related List. The primary purpose of 
Agreement Clause Versioning is to give users a means to track negotiation of clauses 
through the entire lifecycle of an agreement up to and including activation.

Using Agreement Clause Versioning you can:

Add a Master Agreement Clauses section to the Agreement record layout that 
provides a listing of all clauses referenced in the primary agreement document from 
initial check-out to activation. 
Drill down into the list to view all Clause Iterations for a specific clause.
Drill down into each clause iteration to Clause Iteration Details to review changes to 
clause language.
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Customize reports (using standard Salesforce functionality) to locate agreements by 
clause and/or clause language.

What is the difference between the Master Clause List and the 
Agreement Clause Related List?
While the two lists seem to be tracking the same information, both lists are unique and 
used for different purposes:

List Description Deleted 
Clauses?

Changes to a single 
clause

Master Agreement 
Clauses (Clause 
Versioning)

Provides a "bird's eye view" 
of what currently exists in 
the agreement document

No Multiple changes to a 
single clause are stored 
in Clause Iterations.

Agreement Clause 
Related List (Default 
Clause Tracking)

Captures every change 
made to every clause that 
ever existed in the 
agreement document.

Yes Multiple changes to a 
single clause are 
represented as separate 
entries.

Adding Master Agreement Clauses to the Agreement Layout
Viewing Master Agreement Clauses
Viewing Clause Iterations

Clause Iteration Records
How Clause Iterations are Recorded
Use Case: Clause Versioning Scenario (SOW)

Adding Master Agreement Clauses to the Agreement Layout
The Agreement Clauses Visualforce page is automatically enabled for all user profiles.

To make it visible on the agreement record, you must add it to the appropriate agreement 
layout. 

Go to Setup > Create > Objects > Agreement

Note

Tracking of Agreement Clause Versions is only available in Contract Management 
version 8.359 or higher when using X-Author for Contracts version 8.5.1010. Only 
agreement documents using FX2 format are supported.
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Under Page Layouts, click the Edit link next to the layout you want to modify. 
 

 

 
Drag-and-drop the Section field onto the area below the Actions section of the 
Agreement layout. 
 

 

 
Enter Agreement Clauses as the section name and choose a 1-Column layout. 
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Click OK. The Agreement Clauses section is created.
From the Layout Designer menu, choose Visualforce Pages. 
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Drag-and-drop the AgreementClauses Visualforce page onto the section you just 
created. 
 

 

 
In the upper-right hand corner of the AgreementClauses section, click the   icon to 
change the Visualforce Page Properties. Select the Show scrollbars option and click 
OK.
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Click Save to save the Agreement page layout.
Repeat these steps for all Agreement layouts that will use Agreement Clause 
versioning.

Viewing Master Agreement Clauses
You can view a snapshot of each clause used in the agreement on the Master Agreement 
Clauses section on the Agreement record. You can drill down to view clause iterations from 
each master agreement clause record.

The important fields to note and what actions you can take are summarized in the 
following table.

Field Name Description

Name The name of the clause template OR the name given to the 
clause by the user if it was marked. Click on the link to view 
the Clause Iteration list for this clause.

Clause Text A preview of the text of the Original clause (pre-activation) or 
Final clause (post-activation).

Iteration Count The number of iterations the clause has undergone during 
negotiation.

Action Original or Inserted (pre-activation); Final (post-activation).

Viewing Clause Iterations
You can drill down into each master clause from the previous list to view a list of iterations 
the clause has gone through during negotiation. Sorted by action, if the agreement is 
activated, clause iterations will be listed from the "Final" version descending to the 
"Original" version. The following example shows a Payment Terms clause that has gone 
through several iterations, ending with the Final version.
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Click on any link under the Number column to view the Clause Iteration Details for a 
specific iteration. This allows you to review the full Current Text of the clause, the Previous 
Text and the Diff Text (redlined combination of current previous text).

Clause Iteration Records

First Check-out: Iterations of a an agreement clause begin after the agreement document 
is generated and checked out for the first time. All clauses that exist in the document at 
this point are recorded as separate entries in the Master Clause Listing. The Action record in 
the Clause Iteration list is "Original" for these clauses. This helps you keep track of which 
clauses were present in the original version of the document.

During the course of negotiation, changes are made to the agreement document that insert, 
or modify clauses. When any of these actions occur, they are recorded as in the Master 
Agreement Clauses list or Clause Iterations.
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Clause activity during negotiation and subsequent check-in includes:

Inserting a clause into an agreement document using Playbook.
Marking a clause in the document and replacing its content with clause content from 
Playbook.
Marking a clause in the document to adopt the properties of a clause from Playbook.
Modifying a clause in the agreement document.
Checking in the document as "Final - to be signed."

How Clause Iterations are Recorded

Two factors determine how clause activity is recorded during negotiation:

The clause was inserted or modified in the initial session or a subsequent session. A 
session can be defined as the time between Check-Out and Check-In of the same 
agreement document.
The clause was or was not reconciled to the agreement record.

The following tables describe how clause actions taken during a session affect Agreement 
Clause information on the Agreement record.

Initial Session (1st Check-Out)

Clause Actions before 
Check-In

Example At Check-In 
without 
Reconciliation

At Check-In with 
Reconciliation

You insert a clause using 
the Playbook or Mark 
Clause, without making 
any changes to the 
clause content.

"Housing Rent 
Allowance" clause is 
inserted from the 
Playbook.

Creates a single 
record in Master 
Agreement Clauses 
& Clause Iterations 
with Action as 
Inserted.

Creates a single 
record in Master 
Agreement Clauses 
& Clause Iterations 
with Action as 
Inserted.

Note

Deleted clauses are never recorded in the Master Agreement Clauses list or Clause 
Iterations because it is intended to represent the agreement document in its current 
state. All deleted clauses are tracked using the Agreement Clause Related List.
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Clause Actions before 
Check-In

Example At Check-In 
without 
Reconciliation

At Check-In with 
Reconciliation

After inserting a clause 
using Playbook or Mark 
Clause, you make 
changes to the clause 
content.

Contract negotiator 
changes a warranty 
period from 1 year to 2 
years in the same 
session “Housing Rent 
Allowance” is inserted.

Creates a single 
record in Master 
Agreement Clauses 
& Clause Iterations 
with Action as 
Inserted.

Creates a single 
record in Master 
Agreement Clauses 
with Action as 
Inserted.

Creates 2 records in 
Clause Iterations:

One with 
Action as 
Inserted.
One with 
Action as 
Modified.

Once you insert a clause 
using the Playbook or 
Mark Clause, you decide 
to remove the entire 
clause or Unmark the 
clause from the Mark 
Clause Panel.

Contract negotiator 
decides that “Housing 
Rent Allowance”  
clause does not belong 
in the contract and 
chooses to remove it in 
the same session it has 
been inserted.

No record in Master 
Agreement Clauses.

No record in Master 
Agreement Clauses.

 
Subsequent Sessions 

Actions taken on the 
Clause before Check-In

Example At Check-In 
without 
Reconciliation

At Check-In with 
Reconciliation

You do not make any 
changes to the clause 
content.

"Housing Rent 
Allowance" clause is not 
modified in a session 
after it is inserted.

No update to 
Master 
Agreement 
Clauses.

No update to Master 
Agreement Clauses.
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Actions taken on the 
Clause before Check-In

Example At Check-In 
without 
Reconciliation

At Check-In with 
Reconciliation

After checking out the 
same document, you make 
changes to the clause 
content.

"Housing Rent 
Allowance" is changed in 
a session after it has 
been inserted.

 

No update to 
Master 
Agreement 
Clauses.

Creates a single 
record in Clause 
Iterations with Action 
as Modified.

Once you Check-Out the 
same agreement 
document, you, as a Legal 
counsel, decide to 
permanently delete a 
clause from the document. 
You mark that clause for 
deletion from the Mark 
Clause Panel and Check- 
In the agreement 
document to Salesforce.

Contract negotiator 
decides that “Housing 
Rent Allowance” ought 
to be struck from the 
contract in a session 
after it had been 
inserted. Contract 
negotiator marks the 
clause for deletion.  

No update to 
Clause 
Iterations.

Clause record is 
removed from Master 
Clause Listing 
("Deleted" change 
recorded in Agreement 
Clause Related List)

Use Case: Clause Versioning Scenario (SOW)

Sam Sales created a Statement of Work for his customer, Venture Industries.

The agreement contains all standard fields, and the SOW agreement contains standard 
language. He generates the SOW agreement.

Mary Manager, the contract manager for this agreement, logs in to X-Author and checks 
out the document.

The Master Agreement Clauses listing on the agreement record is updated to list all smart 
clauses in the document. Because they were present in the document as of the first check- 
out, all clauses are listed as Original.

Mary decides to mark text in the agreement document as a Payment Terms clause. She 
then checks the document in and reconciles it to the agreement record. The marked clause 
is added to Master Agreement Clauses with the action Inserted.
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On a subsequent check-out, Mary Manger adds an Indemnification clause from Playbook 
and modifies the clause language in the same session. She checks the document back in to 
Salesforce and reconciles it. Two entries are created in the Clause Iterations listing, one for 
the initial insertion of the clause, and another for the modification.

The agreement now goes to legal. During the process, the Governing Law clause is removed 
from the document. The clause is removed from Master Agreement Clauses, but the deletion 
is still tracked in the Agreement Clauses related list.

After negotiation concludes, Mary checks in the document as "Final - to be signed," and 
reconciles it. The Payment Terms clause below demonstrates a complete tracking of 
versions, from initial insertion to Final check-in. Mary can drill down into the details for any 
iteration to view the Diff in clause text and other details.

Controlling Access Permissions for Agreements
Contract Management now allows you to mark your agreement document as private from 
Conga CLM.

User Permissions Needed

To enable agreements as private: Agreement: Edit

.You can select the Make this document private checkbox for any agreement document at 
the following actions in X-Author Contracts:

Checking in an agreement document to Salesforce.
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Creating an offline agreement.
Importing an Offline document.

Marking a document as private is a feature that must be extended by custom 
implementations to have any practical impact on the security of your agreement 
documents.

When you mark a document as private it sets the Is Private field for a specific record/action 
(Check In or Import Offline Agreement) of the Merge Event object to true. You can then use 
this flag to create custom triggers on the Agreement record for controlling permissions to 
your documents. You are encouraged to work with Professional Services to develop a 
solution for your private documents.

Private Indicator Properties
There are two Comply System Properties that control the availability and behavior of the 
option to make documents private from X-Author:

Auto Enable Private Indicator – When this property is enabled, the Make this 
document private check box is automatically selected and cannot be deselected.
Allow Private Selection Override – When this property is enabled, the Make this 
document private check box option can be overridden when Auto Enable Private 
Indicator is set to true.

Depending on how the above properties are configured, when you check-in or create offline 
agreements, you may notice the Make this document private option is already enabled and 
can or cannot be changed. The following table describes how the combination of properties 
affects your ability to make documents private during one of these actions.

Auto Enable Private 
Indicator

Allow Private Selection 
Override

Available Action

FALSE FALSE Make this document private is not 
automatically enabled. You can 
enable this option during check-in or 
creation of an offline agreement.

TRUE FALSE Make this document private is 
automatically enabled. You cannot 
override the option for any document 
version.
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Auto Enable Private 
Indicator

Allow Private Selection 
Override

Available Action

TRUE TRUE Make this document private is 
automatically enabled. You can 
override the selected option for each 
document version.

For more information on this feature, refer to Marking Agreement Documents as Private in 
the X-Author for Contracts documentation.

Routing Documents to Content Libraries
When you activate an agreement, executed agreement documents are stored in the 
Document Folder Apttus Documents. This option will be sufficient for some users but may 
prove to be too basic a solution. Conga CLM offers an alternative contract repository 
option that takes advantage of Salesforce CRM Content by allowing you to publish 
executed agreements to content libraries. There are many advantages to using content 
libraries:

Multiple content libraries can be created by administrators to store agreements by 
any number of classifications.
Library content can be tagged with labels and libraries are fully searchable and 
allow you to create filters to locate agreements.
Content access can be restricted based on member groups that are configured when 
libraries are created.
Users can subscribe to specific libraries to get notifications when content has been 
changed or added.

To publish activated agreements to the Salesforce CRM content repository:

The Apttus Content Integration package must be installed in your Salesforce 
organization.
Salesforce CRM Content must be enabled.
The Libraries tab and other settings must be configured.

You can also create "Content Workspace" Agreement Rules to route activated agreements 
to different libraries based on expressions you define.

Installing Apttus Content Integration
Navigate to the Community Portal > Resources> Install Center.

https://documentation.conga.com/x-author-for-contracts/latest/x-author-for-contracts-154927679.html
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In the left-hand navigation, click the Integrations tab.
In the Integrations packages page go to Apttus Content Integration, click Install 
Now, and follow the instructions to install the package in your Org.
Choose the type of org where you will install the package (Production or Sandbox).

Enabling Salesforce CRM Content
To properly route agreements to your content libraries, you must first enable Salesforce 
CRM Content in your Salesforce Org. To enable Salesforce CRM content:

Go to Setup > Customize > Salesforce Files > Settings > Salesforce CRM Content or 
enter "Salesforce CRM" into the Quick Search dialog and select Salesforce CRM 
Content. 
 

 

 
Click Edit on the Salesforce CRM Content page and select Enable Salesforce CRM 
Content and Autoassign feature licenses to existing and new users. 
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Click Save.
(Optional) Go to Setup > Customize > Salesforce Files > Settings > Content Deliveries 
and Public Links.
Click Edit and select Content Deliveries feature can be enabled for users and Public 
Links can be enabled for users.
Select Choose password defaults option per your requirement. 

 

 
Users who are activating agreements must also have Salesforce CRM Content 
enabled. Turn on Salesforce CRM Content for all users who will be activating or 
managing agreement documents published to your content libraries. Go to Setup > 
Administer > Manage Users > Users. 
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Configuring Admin Properties
Several Admin Objects (properties) must be created or modified to identify the type of 
content to be routed and the default workspace to use for activated agreements.

Go to the Admin tab (click '+' and choose the Admin tab.) Click Go to view all Admin 
objects (your list will vary depending on which objects have already been created). 
 

 

 
Create the following four Admin properties to enable content delivery for your 
activated agreements. Set values as required:

APTS_ContentRepositoryType – Set this property value to "content." The default 
setting is "document," which routes ALL activated documents to an Apttus 
folder. Changing this setting tells the system to use content repository settings 
for routing documents.
APTS_ContentRecordTypeName – Set this property value to "Agreements."
APTS_DefaultContentWorkspaceName – Set the default workspace name for 
your content library to "Agreements." This is the default content library that will 
store all activated agreements that are not routed to other content libraries 
defined in your Agreement Rules.
APTS_UIPageConfig – Set up a UIPage Config for the content repository type. 
Enter "XML" as the value and the following chunk of XML under Content:  

<UIPageConfig> 

<UIAction name="publish_document"> 

<CustomPage> <Name>Apttus__PublishDocument</Name> 

</CustomPage> 
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</UIAction><UIAction name="publish_content"> 

<CustomPage> 

<Name>Apttus_Content__PublishContent</Name> 

</CustomPage> 

</UIAction> 

<UIAction name="publish_chatter"> 

<CustomPage> <Name>Apttus__PublishChatter</Name> 

</CustomPage> 

</UIAction> 

</UIPageConfig> 

APTS_AutoContentSearchable – (Optional) Set this property to "True" to skip the 
optional step when activating an agreement that allows a user to determine 
which agreement documents are available for content search. This property is 
not required but recommended when you are routing content to ensure that all 
relevant agreement documents make it into the library and are searchable.
APTS_ContentConfig – (Optional) Set this property to override the default field 
mappings used by the Apttus Content Integration package. The default field 
mapping only maps the Agreement name field to the same field in the Content 
Version object and is found as a Static Resource in the Contract Management 
package labeled "ContentConfig" (Go to Setup --> Quick Search --> Static 
Resources --> ContentConfig to view the static resource).

Copy the XML contents from the ContentConfig static resource into your 
new Admin Object (APTS_ContentConfig).
Any custom fields you add to the Content Version object and layout 
(detailed in the next section) which you want to be displayed in Content 
Version details for any stored agreement document must be mapped as 
part of this Admin property. 
For example, if you want the values of the Account and Opportunity for 
the document's related Agreement automatically added to Content 
Version details, you would create the Admin Object and code as shown in 
the following image: 
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After an agreement document is activated and routed to the proper 
library, mapped fields will pull data from the document's associated 
agreement record and be displayed on the Content Version Details page. 
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Setting Up Salesforce Files for Content
Before you can configure the content libraries which will store your activated agreements, 
you must create a custom field lookup relationship to Agreement on the Content Version 
object, to associate Content Version records with Agreement records and to allow for 
related records to appear on Agreement layouts. You can also create different page 
layouts to display content version data, depending on the library where your documents 
are stored.

Configuring Content Permissions for Libraries
 
You can define content permissions for managing your libraries. Each library's permission 
represents a set of user privileges.

Go to Setup > Customize > Salesforce Files > Content Permissions to view, edit, or add 
library permissions.

 

Users who will be activating agreements must have "Author" permission for content 
libraries. When you configure the libraries and edit members you will be able to 
assign permission to users.
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Adding Custom Fields to the Content Version Object
 
To properly view information and navigate to your contract repository from the Content 
Versions related list on your Agreements, you must add "Agreement" as a custom lookup 
field to the Content Version object. The following configuration is required for configuring 
email agreement documents if you have installed the Apttus Content Integration package 
and if you have not created a lookup field for Agreement object.

Go to Setup > Customize > Salesforce Files > Fields.
Click New in the Custom Fields & Relationships related list.
Choose the type of field to create, and click Next.
For relationship fields, associate an object with the field and click Next.
Enter a field label. The field name is automatically populated based on the field 
label you enter. 

Choose the page layout that should display the field as an editable field.

The field name can contain underscores and alphanumeric characters and 
must be unique in your organization. It must begin with a letter, not include 
spaces, not end with an underscore, and not contain two consecutive 
underscores. Ensure the custom field name is not identical to any standard 
field name for that object.



If you want any custom fields beyond Agreement to map field data from the 
Agreement record to your content library, you need to configure the optional 
APTS_ContentConfig Admin object, as detailed in Set Admin Properties.
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Assigning Custom Fields to Page Layouts
Now that you have created custom fields for your content, you must assign them a page 
layout. Which page layout is used determines which fields are displayed when for the 
content you are storing. You can use the pre-existing General layout, or you can create 
additional layouts to display Content Version data.

Go to Setup > Customize > Salesforce Files > Record Types.
Click New to create a new record type with its own Library Content Version Layout. 
 

 

 
Create the record type "Agreements" and assign it to profiles you want to give access 
to Content Version data.
Ensure that you select the Active checkbox.
Repeat steps 2 – 4 to create additional Content Version Record Types as needed.
Go to Setup > Customize > Salesforce Files > Page Layouts.
Click New to create a custom layout and name it "Agreements."
Click Edit next to the General layout. 
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Add the new Agreement lookup field and any other Content Version fields you want 
to add to the General layout. 
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Click Save.
Repeat steps 7 – 9 for the Agreements layout.

Configuring the Libraries Tab
You now need to create the content libraries that will hold your documents. You can create 
as many content libraries as you want. Your initial content library will be the default 
library for stored agreements when no agreement rules are applied. You can create 
additional libraries for content routed using agreement rules.

Go to the Libraries tab (click + and click Libraries).
From "My Libraries," click New to launch the New Library Wizard. 
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Enter the name you want to use for your library (e.g., "Agreements") and a description 
(e.g., "Repository for activated agreement documents") and click Save and Close.
From "My Libraries," click on the library name.
Click Tagging Rules to edit tagging rules for your library. Click Save to save any 
changes. 
 

 

 
Click Record Types to assign content version record type restrictions to your library. 
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Choose which record types to restrict to your library. Be sure to add the Record Type 
you defined in the previous section.
Click Save.

Configuring Library Permissions
Go to Setup > Customize > Salesforce Files > Content Permissions.
Click the Edit action for the Author Library Permission Name. Ensure that the 
following permissions are selected: 
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Click the Edit action for the Viewer Library Permission Name. Ensure that the 
following permissions are selected: 

Click the Edit action for the Library Administrator Library Permission Name. Ensure 
that the following permissions are selected: 

Go to the Libraries tab.
From "My Libraries," click on the library name.
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Click Edit Members to choose which members have access to this library.  

Add a user and click Next to choose which permission profile to apply to the library 
members you added. Remember, members must at least have "Author" permissions to 
publish documents to the library. 

 

 
Click Save. Your content library is now ready to use! Repeat the process to create 
additional libraries. Route content to specific libraries using Agreement Rules to Route 
Content.

Using Agreement Rules to Route Content
One of the advantages to setting up Content Libraries for your activated agreement 
documents is the ability to develop agreement rules to route your content to specific 
libraries. By default, when you have content repositories configured your content will all 
route to the default content library. You can create additional libraries and rules which 
send your documents to these libraries based on the criteria you define. Follow the 
instructions in this section to set up Agreement Rules for content delivery.
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Setting up a Formula Field on the Agreement Object
Go to Setup > Create > Objects and click on the Agreement object.
Under Customer Fields & Relationships click New. 
Choose Formula and click Next. 
 

 

 
Enter "Contract Routing Formula" into the Field Label field and press tab to 
automatically create the Field Name. 
Choose Text as the Formula Return Type. Click Next. 
 

 

 
For the formula, enter "$RecordType.Name" and click Next. 
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Make the formula available to the appropriate user profiles and available to page 
layouts as needed and click Save in the final step.

Extending the Agreement Rule Object to Include Content
In order to allow users to create rules to route content to specific libraries, you must first 
extend the Agreement Rule object to create a new "Content Workspace" Rule Type.

Go to Setup > Create > Objects and click on the Agreement Rule object.
Under Custom Fields & Relationships, click on the Rule Type field. 
 

 

 
Scroll down to Picklist Values for the field and click New. 
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Add the picklist value "Content Workspace" and click Save. 
 

 

 
Return to the Agreement Rules Object Details page and click on the Rule 
Object Custom Field. 
 

 

 
Add the value "Content" to the Rule Object picklist. 
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Now that you have added new picklist options, you need to edit field dependencies. 
From the Rule Object detail, click Change under Picklist Options. 
 

 

 
Click Next to display the last column in the picklist.
Under the Content Workspace column, click on Content and click Include Values.  
 



CLM

364 Copyright ©2022 Apttus Corporation. All rights reserved.
 

10.

•
•

 

 
Click Save.

Creating a Content Workspace Agreement
Now that you have extended the Agreement Rule object for document routing, you can 
begin creating Agreement Rules to route your content to specific libraries. For example, if 
you have created a library for all your agreements of record type SOW, you can create a 
new rule to move all documents for records that match the Contract Routing Formula 
(RecordType.Name) to this library.

When you create a Content Workspace Agreement Rule, observe the following:

Rule Type must equal "Content Workspace"
Rule Value must be the name of the Content Library where you want to route the 
documents (e.g., "AgreementSOW").

For full instructions on creating Agreement Rules, refer to Setting Up Rule-based Agreement 
Request Process Parameters.

The following image shows an example of an Agreement Rule to route all SOW agreement 
documents to the appropriate library.
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Finding Content After Activation
Using the above rule, following activation, any SOW agreement is routed to the 
appropriate library. Go to Libraries to access stored documents.

Click on a Library Name to view content stored in the library.
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You can also search for your activated agreements by going to Content.

Content Versions Related List 
After an agreement is activated, the attached documents are displayed in the Content 
Versions Related List (these examples use the above SOW Agreement Rule). 
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Drill down into the Content Version details for a document by clicking on the Title in the 
Content Versions Related List.

From this page you can download the document, view libraries the document is shared 
with, go to the Content Detail page to view more information or upload new versions. For 
more information on working with content, refer to Salesforce help on Salesforce CRM 
Content.

Managing Offline Agreements
If you have a third-party paper that you want to use as a basis for your contract, Conga 
CLM provides you with the ability to create or import it as an offline agreement 

https://help.salesforce.com/apex/HTViewHelpDoc?id=content_about.htm&language=en_US
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document. After an offline document is uploaded, Conga CLM tags it with metadata so 
that it can be checked out with X-Author for Contracts.

Conga CLM along with intelligent data extraction software enables you to run intelligent 
discovery on a third-party paper. The intelligently imported third-party paper is scanned 
by the optical character recognition method and converts the document to a searchable 
PDF.

For information on creating an offline document using intelligent discovery, see Working 
with Offline Agreements.

Prerequisites
Kira is an intelligent data extraction software that enables you to intelligently import a 
third-party paper into Conga CLM. Before configuring Kira with Conga CLM, review the 
following topics:

Terms of Service 
Response Data and Rate Limiting (you need to have Kira credentials to access this 
page)

 

To process a document using intelligent data extraction, users or user profiles must have 
access to the following objects in Conga CLM:

IDE Job
IDE Job Clause Extraction
IDE Job Field Extraction
IDE Map Clause Provision
IDE Map Field Provision
IDE Map Project Record Type
IDE Map Provision Record Type
IDE Provision

This documentation is created considering Kira and Conga AI as intelligent data 
discovery software.
Intelligent Discovery features need add-on licenses. Please write to integration- 
support@conga.com for more information.



Ensure you delete previously scheduled jobs related to Intelligent Discovery. If you 
do not delete previously scheduled jobs, duplicate extractions are visible.



https://kirasystems.com/terms-of-service/
https://support.kirasystems.com/aspx/developer/?Id=00b00000000008A00cV
mailto:integration-support@conga.com
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You can edit the following email templates that are available in Conga CLM to notify a 
user about intelligent discovery:

Intelligent Discovery Processing Error Notification
Intelligent Discovery Processing Status Update

Configuring Intelligent Discovery Settings
Intelligent discovery settings must be configured to process documents using Intelligent 
Data Discovery (IDD). You must first configure remote site settings and then configure 
intelligent discovery settings.

Prerequisite
Please write to integration-support@conga.com for the Remote Site URL, IDE Service URL, 
Logo URL, Tenant, Token, API URL, and API Token.

To configure intelligent discovery remote site settings 
Go to Setup > Security > Remote Site Settings.
Click New Remote Site.
Enter the Remote Site Name as IDD.
Provide the Remote Site URL for IDD.
Leave the Disable Protocol Security checkbox unselected.
(Optional) Enter a description for the remote site setting.
Select the Active checkbox.
Click Save.

To configure XAJS and Merge Service remote site settings  
Ensure that you have configured XAJS End Point and Merge Webservice Endpoint 
comply system properties. For more information, see Comply System Properties.
(Optional) Navigate to the Remote Site Settings page and ensure that XAJS and 
Merge Webservice endpoints are available.

To configure intelligent discovery settings for Kira
Go to App Launcher > Intelligent Discovery Admin Console > Settings.

Intelligent Discovery features need add-on licenses. Please contact Conga Sales 
Team for more information.



mailto:integration-support@conga.com


CLM

370 Copyright ©2022 Apttus Corporation. All rights reserved.
 

2.
3.

a.

b.

c.

d.

Click New.
Enter the following details:

Name: KIRA 

IDE Service URL: Enter the URL provided by Kira. 
Sample: https://ca.app.kirasystems.com/platform-api
Logo URL: Enter the URL provided by Kira. 
Sample: https://ca.app.kirasystems.com/images/logos/kira-dark-on-light-54.svg

Additional Setting: Add Kira API-related information in JSON or XML format. 
Sample:
{
"Version":"v1",
"DefaultProjectId":120,
"retrieveHighlightedDocument":false,
"DeleteDocumentFromKira":true,
“useAnalytics”:false 
}
 

The Name field value is case-sensitive.

The Kira logo is displayed during Intelligent Import.

•

•

Project ID
The version may vary based on the Kira API. Default Project ID in KIRA is 
mapped to the default record type in Conga CLM.
retrieveHighlightedDocument

If retrieveHighlightedDocument is set to true (case sensitive) then 
both processed and highlighted documents are retrieved to Conga 
CLM. If retrieveHighlightedDocument is set to false (case sensitive) 
then only the processed document is retrieved to Conga CLM. By 
default, the value for retrieveHighlightedDocument is considered as 
true. 
The retrieveHighlightedDocument property is applicable only for 
documents less than 10 MB. If the document size is greater than 10 
MB, both highlighted and processed documents are not retrieved to 
Conga CLM.

DeleteDocumentFromKira



https://ca.app.kirasystems.com/platform-api
https://ca.app.kirasystems.com/images/logos/kira-dark-on-light-54.svg
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Quick Study URL: Provide URL to launch Kira Quick Study when a user clicks 
Custom Provisions on the Intelligent Import Admin Console page.
Active: Select the checkbox.
Token: Add the Kira token.
Show Token: Select the checkbox to view the token.
API URL: Add the IDD URL.
API Token: Add the IDD token.
Show API Token: Select the checkbox to view the API token.
Tenant: Enter the tenant name for IDD.
Use Normalization: Select the checkbox to see the extracted values in the 
standard format.

Click Test Connection to verify the accuracy of the above details that you have 
provided. If any details provided for a particular field are incorrect, you will see an 
error message related to that field. You can rectify the error and click Test 
Connection. If all the details provided are correct, you will see a message that the 
test was successful. 
Click Sync Provisions to sync IDE Provision checkbox to synchronize all provisions from 
the Intelligent server and save them in Conga CLM. If you click Sync Provision before 
clicking Test Connection, first the connection is tested and then the provisions are 
synced.
Click Save.

To configure intelligent discovery settings for Conga AI
Go to App Launcher > Intelligent Discovery Admin Console > Settings.

•

•

If DeleteDocumentFromKira is set to true, the processed document is 
deleted from Kira. If DeleteDocumentFromKira is set to false, the 
processed document is not deleted from Kira. By default, the value 
for DeleteDocumentFromKira is considered as true.
useAnalytics

useAnalytics is a User Experience Analysis component that collects 
product usage data. No action is required on your part and there is 
no impact to any existing product features, system functionality, or 
configured workflows. No personally identifiable information (PII), 
nor any other proprietary, confidential, or sensitive data will be 
collected. 
If useAnalytics is set to true, the product usage data is collected. If 
useAnalytics is set to false, the product usage data is not 
collected. If useAnalytics value is not set, the value is considered 
false.
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Click New.
Enter the following details:

Name: CONGAAI 

IDE Service URL: Enter the URL provided by Conga. 
Sample: https://cw-api-public-docusign-decp.services.cwacloud.net/auth/ 
congaclm/api
Logo URL: Enter the URL provided by Conga. 
Sample: https://conga.com/themes/custom/themeskit/images/branding/logo- 
conga.svg

Additional Setting: Add Conga API-related information in JSON or XML format.}
Sample: 
{
"Version":"v1",
"retrieveHighlightedDocument":false,
"DeleteDocumentFromKira":false,
} 

 
Quick Study URL: Provide URL to launch Conga AI Quick Study when a user clicks 
Custom Provisions on the Intelligent Import Admin Console page.
Active: Select the checkbox.
Token: Add the Conga AI token.
Show Token: Select the checkbox to view the token.
API URL: Add the IDD URL.
API Token: Add the IDD token.
Show API Token: Select the checkbox to view the API token.
Tenant: Enter the tenant name for IDD.
Use Normalization: Select the checkbox to see the extracted values in the 
standard format.

Click Test Connection to verify the accuracy of the above details that you have 
provided. If any details provided for a particular field are incorrect, you will see an 
error message related to that field. You can rectify the error and click Test 

The Name field value is case-sensitive.

The Conga logo is displayed during Intelligent Import. 

Conga recommends the values of retrieveHighlightedDocument and 
DeleteDocumentFromKira must be false.



https://cw-api-public-docusign-devcp.services.cwrcloud.net/auth/congaclm/api
https://conga.com/themes/custom/themekit/images/branding/logo-conga.svg
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Connection. If all the details provided are correct, you will see a message that the 
test was successful. 
Click Sync Provisions to sync IDE Provision checkbox to synchronize all provisions from 
the Intelligent server and save them in Conga CLM. If you click Sync Provision before 
clicking Test Connection, first the connection is tested and then the provisions are 
synced.
Click Save.

To delete intelligent discovery settings
Go to App Launcher > Intelligent Discovery Admin Console > Settings.
Click Delete. 
A confirmation is displayed.
Click OK. 
The IDD setting is deleted from the IDD database.

Mapping Provisions to Project-Record Type
This section provides you with information about how to map provisions to the project- 
record type in Lightning.

Prerequisites
Ensure that you create project-record type mappings only in Lightning.
Ensure that the clause and field type IDE provisions are created.
Ensure that record types are available in Contract Management.

Restriction
You must not create project-record type mappings in Classic.

To add a project 
Go to Intelligent Discovery Settings > Intelligent Discovery Data Mapping > Map 
Project-Record Type. 
This displays the IDE Map Project Record Types page.
Click New.   
This displays the Map Provisions page.
Enter the Project Name and Record Type Name. 
The Clauses tab is highlighted by default.
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(Optional) Enter the Project ID if you have already created a project in Kira or Conga 
AI. 
If you leave the Project ID field blank, CLM creates a project in Kira or Conga AI, 
obtains the Project ID, and populates the Project ID field. 
Click Add. 
This displays the Add Provision Clauses popup that contains a list of clause type 
provisions and also the provisions which are neither clause nor field type provisions.
Use the search box to search for a particular clause or select multiple clauses and 
click Add.

Scroll to the end of the page and click Save.
Select the Fields tab. 
Click Add.  
This displays the Add Provision Fields popup that contains a list of field type 
provisions and also the provisions which are neither clause nor field type provisions.
Use the search box to search for a particular field or select multiple fields and click 
Add.

Scroll to the end of the page and click Save.
Select the Sync IDE Provision checkbox to update the provision details (base object, 
template reference, and metadata) in the default provisions list.  
All the clause and field provisions are selected by default. You can unselect the 
clause and field provisions that you do not want to sync to the default provisions list. 
If you do not select the Sync IDE Provision checkbox before saving the mapping, the 
changes to the provisions are not updated in the default provision mapping.

Click Save on the top-right corner of the page.

If the value of the Template Reference field is blank, you need to enter the 
appropriate value before saving the clause provision or you will encounter an 
error. 



If the values of the Meta Data Field and Base Object field are blank, you need 
to enter the appropriate value before saving the field provision or you will 
encounter an error. 



When you select the Sync IDE Provision checkbox, clauses and fields are 
mapped to provisions.
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To edit a project or provision details
Go to the IDE Map Project Record Types page.

Next to the project name, click   and select Edit. 

This displays the Map Provisions page.
Hover on any field and click the edit icon ( ) beside any editable field. 
This makes the field editable.
Update the field and press Enter or click anywhere on the page. 
This updates the field. 
Perform one of the following tasks according to your requirement:

Click Save on the top-right corner of the page. 
This saves the mapping but does not sync the provisions to the default 
provisions list.
Select the Sync IDE Provision checkbox and click Save on the top-right corner of 
the page. 
This syncs all the provision details in the default provisions list and saves the 
mapping.

To clone the provisions to project-record type mapping
Go to the Map Provisions page.
Click Clone. 
This displays a confirmation message.
Click Ok. 
This clones the provisions to the project-record type mapping. The Record Type is not 
cloned.

To delete provisions
Go to the Map Provisions page.
Select the checkboxes beside the field provisions or clause provisions you need to 
delete.
Click Delete. 
This displays a confirmation message.
Click Delete.
Scroll to the end of the page and click Save.

When you select the Sync IDE Provision checkbox, clauses and fields are 
mapped to provisions.
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To delete the provisions from project-record type mapping
Go to the IDE Map Project Record Types page.

Next to the project name, click   and select Delete. 

This displays the Delete IDE Map Project Record Type popup.
(Optional) Select the Delete mapping from the AI Engine checkbox to delete mappings 
from Kira or Conga AI/Conga AI. 
If you leave the Delete mapping from the AI Engine checkbox unselected and click 
Delete, the mappings are deleted only from IDD.
Click Delete.

Provisions Supported by Conga AI
Conga AI supports 41 provisions. The following table lists the supported provisions.

Fundamental Terms Standard Terms - Fields Standard Terms - Clauses

Agreement Title
Parties
Effective Date
Commencement Date
Original Expiration Date
Termination Notice
Renewal Type
Renewal Period
Renewal Notice
Renewal Limit 
Signatures
Notice
Notice Address
Related Master 
Agreement Name
Total Contract Value

Audit Rights
pricing/Billing Frequency
Data Security Breach 
Notification
Dispute Resolution
Exclusivity/Not granted
Exclusivity/Required
Governing Law
Indemnification Provision
Non-Solicitation Period
Pricing/Payment Model
Pricing/Payment Terms

Confidentiality
Assignment
Contract Rate
Compensation
Indemnification 
Insurance
Intellectual Property
Licenses
Productivity
Publicity
Reps and Warranties
Force Majeure
Integration
Notice Section Clause
Dispute Resolution 
Clause

Setting Up Salesforce and Kira Single Sign-on
You can set up single sign-on to authorize users to access Salesforce and Kira with one 
login.
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Prerequisite 
You must have a Kira Enterprise Edition license.

To set up single sign-on
Set up Salesforce as an Identity Provider. For more information, see Salesforce 
documentation.
Set up Kira as a Service Provider. For more information, contact Kira Support. 

Configuring Intelligent Discovery Status Panel in 
Lightning
You must configure the intelligent discovery status panel in lightning to view intelligent 
discovery processing status.

Prerequisite
You must configure Intelligent Discovery settings. For more information, see Configuring 
Intelligent Discovery Settings. 

To configure the Intelligent Discovery Status panel
Navigate to the Agreement Detail page.
Click the Setup icon and select the Edit Page option.
In the left panel, search for Intelligent Discovery Status.

https://help.salesforce.com/articleView?id=identity_provider_enable.htm&type=5
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Drag Intelligent Discovery Status from the left panel and drop on top of the 
Agreement Actions panel. 

(Optional) If you add the Intelligent Discovery Status panel other than top, select the 
Intelligent Discovery Status panel and unselect the Intelligent Discovery Status Panel 
on Top checkbox in the Pages section on the right-side.
Click Save.

Migrating Mappings from Salesforce to Intelligent 
Data Discovery

 

You can migrate existing mappings and settings from Salesforce to Intelligent Data 
Discovery (IDD). After you have migrated the existing mappings, you can perform any of the 
following tasks according to your requirement:

You can leave Project ID in the mapping as it is.
If you need to use a different project that you have created in Kira, you must edit the 
mapping and manually enter the project ID from Kira in the Project ID field in CLM. 
The Project ID field cannot be left blank after you edit a mapping.
If you create a new mapping in CLM, CLM creates a project in Kira, obtains the Project 
ID from Kira, and populates the Project ID field in CLM automatically.  
For information regarding editing mappings, see Mapping Provisions to Project-Record 
Type.

This topic is applicable only for Kira users. You cannot migrate mappings from Kira 
to Conga AI.
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To migrate mappings
Go to App Launcher > Intelligent Import Admin Console > Settings.
Click the Edit hyperlink of an existing configuration.
Update the following details:

API URL: Add the IDD URL.
API Token: Add the IDD token.
Tenant: Enter the tenant name for IDD.

Click Test Connection.
Click Sync Provisions.
Click Save.
Go to Intelligent Discovery Settings > Intelligent Discovery Data Mapping > Map 
Project-Record Type.
Select a mapping.
Click the Edit button.
Click Save.

Configuring Intelligent Discovery Fields
You can configure fields displayed on the Agreement Detail tab when you review a third- 
party agreement document imported through Intelligent discovery.

To configure fields on the Agreement Detail tab
Go to Setup > Object Manager > Agreement > Field Sets > Update Fields Intelligent 
Import Field Set.
Drag the fields from the object palette and drop them into the In the Field Set 
container.
To make a field as required, double click the field or click the wrench icon ( ) next to 
the field.
Select the Required checkbox and click OK.
Click Save.

Configuring Obligation Management
Obligation management refers to email alerts and reminders that ensure internal and 
external obligations in connection to your agreements are properly fulfilled.

The Obligation Management stage ensures that deliverables must be met. This includes:

Maximize contract value with fulfillment tracking
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Alerts linked to expirations, renewals, and key events, post-execution workflows
Searching and reporting

Organizations typically set up common business rules that allow groups and users to 
receive email alerts 30, 60 and 90 days before agreements expire. Other rules can be 
configured based upon your needs. Check with your system administrator for more details. 
You can also set up tasks and events for specific agreements on a case-by-case basis. An 
example of another common business rule is a pricing change, where modifications to 
pricing and financial terms trigger a notification to interested parties.

New Task
The New Task feature is available within an Agreement Record and allows you to create a 
new task related to a specific agreement. Click New Task to enter key pieces of information 
that need to be tracked in connection with a date, event or milestone. The key fields are as 
follows:

Assigned to – Allows you to identify the recipient. Use the lookup icon to identify this 
individual.
Subject – A pre-defined list is available through a lookup icon and can be configured 
for your organization.
Status – The status field is a drop-down or picklist and provides visibility into whether 
the task has not been started, is in progress, has been completed, etc.
Comments – Add any comments about the date, event or milestone that requires 
action.
Send Notification Email – The send notification email is critical to ensure timely 
notification of relevant individuals and make sure the task is properly managed.

Once you have completed the New Task window, click Save to complete the process. Other 
options include Save & New Task or Save & New Event if you want to create another Task 
or Event.

New Event
The New Event process is the same as the New Task process except that instead of 
assigning a task to an individual, the event is logged and managed as an Event on the 
individual's Conga and regular corporate email calendar. A status category is not included 
to manage whether the task has been completed or not, since for an event, status is not 
relevant.
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Searching and Reporting
Conga CLM provides the default set of capabilities for searching, views, dashboards, and 
reporting. The ability to get the key information out, for example, dates, amounts and 
number of contracts to make business decisions is crucial. Modifying the search and reports 
is based on standard Salesforce functionality.

About Search
Search enables all contracts to be retrieved via a keyword search that searches all the key 
elements and is extremely easy to use.

 
This is a search functionality which enables you to quickly search for various items like 
Agreement, Templates, Accounts, Contacts, and so on.

You can further refine your search for specific objects by clicking on the Advanced Search 
link. You can search for records and tags using the following search options:

Note

Global search and feed search are automatically enabled when Chatter is enabled. 
However, enabling Chatter disables sidebar search and advanced search.
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Sidebar Search Advanced Search Global Search

You can search a 
subset of Agreement 
objects and fields and 
use wildcards and 
filters to refine your 
search.
Sidebar search 
depends on the 
following:

Search options 
Sidebar search 
searches only a 
subset of 
records and 
fields. If the 
sidebar search 
drop-down list is 
available, you 
can limit your 
search to only 
tags or the 
records for a 
single object. If 
the sidebar 
search Limit to 
items I own 
checkbox is 
available, you 
can select this 
box to limit your 
search to 
records you own.

Advanced Search 
allows more 
granularity, enabling 
you to search for Exact 
Phrases and against 
specific elements. For 
example, Agreements, 
Suppliers or Contacts.
Use Advanced Search 
option in the sidebar to 
search a subset of 
objects in combination 
and more fields than 
sidebar search, 
including custom fields 
and long text fields 
such as descriptions, 
notes, and task and 
event comments. You 
can use wildcards, 
operators, and filters 
to refine your search.

Global search finds more 
record types, including 
articles, documents, 
products, solutions, and 
Chatter feeds, files, groups, 
topics, and people. Global 
search also searches more 
field types, including custom 
fields and long text fields 
such as descriptions, notes, 
and task and event 
comments. The global 
search keeps track of which 
objects you use and how 
often you use them and 
arranges the search results 
accordingly. Search results 
for the objects you use most 
frequently appear at the 
top of the list. If the global 
search does not have 
enough information about 
which objects you use, you 
see results for all objects 
until it has more 
information.
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Sidebar Search Advanced Search Global Search

Search Terms 
Searches are 
conducted as a 
phrase search 
and match 
terms in the 
exact sequence 
that they 
appear. For 
example, 
searching for 
agreement_1 
returns items 
withagreement_ 
1in a single 
string.
Wildcards and 
Operators 
Use the * 
(asterisk) and ? 
(question mark) 
wildcards to 
refine results. 
Use * to match 
one or more 
characters, or ? 
to match a 
single character. 
An * is 
automatically 
appended to 
your search 
string. You 
cannot use 
operators to 
refine results in 
sidebar search.

Contextual Feed Search 
Global search is helpful 
when you want to look for 
information in feeds posts 
and comments across the 
organization. Use feed 
search (feed search icon) to 
find information in a feed in 
a specific context. Click feed 
search magnifying glass 
above the feed to look for 
information in that feed. For 
example, use the feed 
search on a group’s page to 
find information in that 
group. You can search for 
information in feeds on a 
user’s profile, a record, in a 
public or private group (if 
you are a member), and on 
the Chatter and Home tabs. 
A contextual feed search is 
helpful when you want to 
confirm or check if 
something was once 
discussed in that specific 
feed. You can search for 
hashtag topics, mentions, 
and files posted in the feed, 
or refine your search using 
wildcards, operators, and 
quotation marks to match 
on exact phrases.

Document Search
Use the Find Document button on the documents home page to find specific documents.
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The Find Document action searches the following fields:

Document Name
Keywords
Description

To search a document
Click the Documents tab.
Enter your search terms and click Find Document. 
The search returns a list of documents that match all your search terms. The search 
results are listed in order of the closest matches. The Keywords and Document Name 
fields are used to determine the closest matches. The fields you see are predefined 
and cannot be changed.

About Reports and Dashboards
Salesforce enables you to create reports and dashboards.

Reports
You can access the reports through the Reports Tab. Conga CLM provides standard reports 
based upon the most common reporting needs for Contract Management.

You can find contracts by the following parameters:

Renewal date
Value
Stage
Risk

The default reports included with Conga CLM are:

Reports Description

Agreement Expiration - This Quarter Lists all agreements expiring in current fiscal 
quarter

Agreement Expiration - This Year Lists all agreements expiring in current fiscal year

Agreement Search Helps you easily find your agreements
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Reports Description

Agreement Value by Type Lists all agreements by the type along with 
contract value

Agreement Value Report Lists all agreements by their contract value along 
with the account

Agreements by Account Lists all agreements by the account name

Agreements by Stage The present stage of agreements

Agreements of High Value due Renewal Time when the high-value agreements are due for 
renewal

Agreement with Non-Standard Terms Lists all non-standard Agreements

Contract Activity Report Shows recent contract activity report

Contracts Expiring This Year by Value Expiring contracts with values

Contracts with Non Standard Language Lists all agreements containing non-standard 
language

High Risk Contracts List highly risky agreements

You can create new reports by either starting from scratch or taking a report containing 
the desired results, modifying it, and changing the reports name using the Save As feature.

Salesforce delivers standard report folders containing reports for each record type. For 
example: Accounts, Opportunities, Leads, and more. These reports are used as a starting 
point for your organizations reporting efforts. Salesforce allows all users to run, customize, 
and create reports. For more information on setting up and managing reports within Conga 
CLM, see salesforce.com information related to creating and customizing reports.

Conga CLM provides you a set of out-of-the-box reports. You may create new reports or 
customize existing reports. To modify an existing report, run the report and click Customize. 
For more information, see Create a custom report.

Dashboards
Dashboards organize and present rich and enhanced information in a format that is easy 
to read and interpret. Dashboards give you a real-time snapshot of corporate metrics and 

http://salesforce.com
https://help.salesforce.com/HTViewHelpDoc?id=reports_custom.htm
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key performance indicators. A dashboard is a group of different charts (or components) 
that graphically display your custom report data.

Dashboards help you identify trends, sort out quantities, and measure the impact of the 
activities.

Conga CLM provides dashboard views for the following three most common profiles:

Contract Performance Dashboard
Executive Dashboard
Legal Performance Dashboard

Conga CLM provides a robust Dashboard capability at your fingertips, adding an edge to 
your business solutions. Navigate to the Dashboards tab to customize the page by 
designating which dashboard type you would like to see from a list. For more information, 
see Working with Dashboards.

Structure
A dashboard shows data from source reports as visual components, which can be charts, 
gauges, tables, metrics, or Visualforce pages. The components provide a snapshot of key 
metrics and performance indicators. A report returns a set of records that meets certain 
criteria, and displays it in organized rows and columns. Report data can be filtered, 
grouped, and displayed graphically as a chart. Reports are stored in folders, which control 
who has access. A report type defines the set of records and fields available to a report 
based on the relationships between a primary object and its related objects. Reports 
display only records that meet the criteria defined in the report type. As an Administrator, 
you can control access to reports and dashboards by storing them in folders, which can be 
public, hidden, or shared.

Here's a typical representation of the relation between Report Type, Report and 
Dashboard. Source: Visualforce.

Unleashing Reports and Dashboards
The Unleashing Reports and Dashboards section provides you the basic concepts and an 
understanding to enable you to use data to create dashboards and reports.

Use the available facts to present the information important to you—from the big picture to 
the data point. Let us consider a few use cases that suggest what reports and dashboards 
can do for you and how you can take advantage of built-in tools to share the information 
with others. This section also introduces you to some cool features, like combination charts 

https://help.salesforce.com/htviewhelpdoc?id=dashboard_builder_editing.htm
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and custom table components, conditional highlighting, cross filters, buckets, and custom 
summary formulas.

You can also try hands on more advanced topics, such as merging multiple reports into 
joined reports and embedding report charts in record detail pages.

Cycle Time Reporting
The system does not provide the UI to select just fields for tracking time. You have to select 
a field and set up a dummy cycle time group. Once a group is set up for a field the system 
will start capturing duration every time the field value changes.

To access, go to the Cycle Time Group Tab. If the tab does not exist, select the Admin tab 
and click the Cycle Time Group link. Ensure that the APTS_CycleTimeReportingEnabled 
admin setting value is set to true.

Cycle Time Groups must be with the following details:

Field Label Name Description From 
Value

To Value Active

Status 
Category

Request to In 
Effect

This will measure time 
from request being 
created in the system, 
to the time it went to 'In 
Effect' status

Request In Effect  

Status 
Category

Request to In 
Signatures

This will measure the 
time it took from a 
record being created in 
the system to status 'In 
Signatures'

Request In 
Signatures

 

Status 
Category

Request to In 
Authoring

This will measure the 
time it took a user from 
creating Request to 'In 
Authoring' (Generating a 
contract)

Request In Authoring  

Status 
Category

Authoring to 
Signatures

This will measure the 
time it took from status 
'In Authoring' to 'In 
Signatures'

In Authoring In 
Signatures
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Field Label Name Description From 
Value

To Value Active

Status 
Category

Authoring to In 
Effect

This will measure the 
time it took from 'In 
Authoring' (generating 
contract) to 'In Effect'

In Authoring In Effect  

Status 
Category

Signatures to In 
Effect

This will measure time 
from 'In Signatures' to 'In 
Effect'

In 
Signatures

In Effect  

To maintain Cycle Time Groups
Click Cycle Time Group > New.
Select the agreement field and click Next.
Enter Name, From, To and Description and click Save. Optionally, click Save & New to 
save the current groups and create a new group.

To view, edit, activate, or delete Cycle Time Group

Prerequisites
Groups must be in the Active state for the system to start capturing time.
Groups must be in the Inactive state, to be eligible for deletion.

On the Cycle Time Group tab, access the saved Cycle Time Group.
As required, use Edit, Delete or Activate options.

To view, edit, or deactivate Cycle Time Group
Deactivating a group deletes all existing summary (CycleTimeGroupData) data for 
the group. Also, if this happens to be the last active group for the field, then the 
system deletes all detail (CycleTimeFieldData) data also for the field.
Groups must be in the Active state.
On the Cycle Time Group tab, access the saved Cycle Time Group.

Note

Make sure all the groups are in the Active state.
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4. As required, use Edit, or Deactivate options.

Managing Cycle Time Report Definitions
You can define the Cycle Time Report using the two options- Using Summary Data or Using 
Detail Data.

Using Summary Data
Select Agreements with Cycle Time Group Data object to define reports. Also, select Cycle 
Time Group and Duration fields.

Using Detail Data
Select Agreement with Cycle Time Field Data object to define reports. Also, select Cycle 
Time Field and Duration fields.

Excluding work-in-progress Records
Keep the following filter criteria for all of the reports:

Searching and Reporting Agreement Explorer Reports
Agreement Explorer is a powerful search and reporting feature that allows you to search 
for records in the Agreement object through the use of configurable and reusable search 
reports. This feature complements standard reporting views to satisfy the demands of 
many Conga CLM customers who require more powerful, specific search results and related 
exports to Excel to satisfy their business needs. Agreement Explorer expands your access to 
agreements by providing reusable searches with configurable fieldsets and filtered lists for 
multiple contexts associated with agreements. You can use these reports to discover and 
expose record lists for agreement searches, the hierarchies of agreements and accounts, 
and a combination of account hierarchies and the individual account’s related agreement 
hierarchies. Users can create published lists of available reports, which can then be 
complemented by users creating and saving their own public or private ad-hoc reports. The 
resulting reports can be exported to Excel.



CLM

390 Copyright ©2022 Apttus Corporation. All rights reserved.
 

1.
2.
3.

Understanding Agreement Explorer Report Types
The key to understanding how to create and use Agreement Explorer reports effectively is 
to understand the application types assigned to each report. When you create an 
Agreement Explorer report as an administrator, you are required to define the context 
(type). The type determines the list of records and hierarchy displayed in the results 
available to the user. There are three types available for reports:

Report Type Report Location Description

Agreement Search Agreement Explorer Tab Returns a filtered list of agreement 
records. For example, return all the 
agreements filtered by Status 
Category and Status. These results do 
NOT display Agreement Hierarchy.

Agreement Agreement Record, 
Agreement Explorer Tab

Returns a filtered, hierarchical list of 
agreements with the current record 
highlighted. Records in this list 
represent a hierarchy of parent and 
child agreements with the current 
record as context.

Agreement Hierarchy by 
Account(s)

Agreement Record, Account 
Record, Agreement Explorer 
tab

Returns a filtered, hierarchical list of 
agreements associated with one or 
more chosen account records. Records 
in this list represent a hierarchy of 
parent and child agreements for all 
specified accounts.

For more detailed information on how to run, use and maintain Agreement Explorer reports, 
see About Agreement Explorer Reports.

Configuring Admin Settings for Agreement Explorer
The APTS_AdminProfiles admin entry should be configured to use Agreement Explorer.

To configure APTS_AdminProfiles:

Navigate to Admin Home page. 
Click New. This displays Admin Edit page.
Enter the following details:
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a.
b.

2.

1.
2.
3.

Name: APTS_AdminProfiles
Value: Enter profile names as comma separated values.

Click Save.

 

Adding Agreement Explorer Buttons to Page Layouts
To enable default Agreement Explorer reports to be run from Agreement or Account records, 
an administrator must add custom buttons to the Agreement and Account object page 
layouts. Users and administrators use these custom buttons to run existing reports or to 
create "ad hoc" reports as required.

The following custom buttons must be added to their respective layouts:

Add two (2) buttons to the Agreements page (Agreement Page Layout): 
View Agreement Hierarchy
View Hierarchy for Account

Add one (1) button to the Accounts page (Account Page Layout): View Hierarchy for 
Account

All custom buttons are already provided with installation of the Apttus Contract 
Management package. For information on how to add Custom Links and/or Buttons to 
object page layouts, please refer to Salesforce documentation on Customizing Page 
Layouts and Customizing Search Layouts.

Editing Classic Email Templates
You can update the available activation and review cycle classic email templates 
according to your requirement.

To edit a classic email template
Go to Setup > Email > Classic Email Templates.
According to your requirement, click Edit for an email notification template.
Update the details and click Save.

Ensure that you do not delete the notification email templates.

https://help.salesforce.com/articleView?id=customize_layoutcustomize_ple.htm&type=0
https://help.salesforce.com/apex/HTViewHelpDoc?id=customize_searchlayout.htm&language=en_US
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Configuring Old Activation UI
You can opt to use the old activation UI instead of the new activation UI. 

To configure old activation UI
Go to Setup > Object Manager > Agreement > Fields & Relationships.
Click New and select Formula.
Click Next.
Enter Activate_Old in the Field Label field and select Text.
Click Next.
Enter a formula.

Sample

IF (OR(ISPICKVAL(Apttus__Status_Category__c,"In Signatures"), 

ISPICKVAL(Apttus__Status_Category__c,"In Filing"), 

AND(ISPICKVAL(Apttus__Status_Category__c,"In 

Authoring"),ISPICKVAL(Apttus__Source__c,"Other Party Paper"))), 

IF(OR($User.UIThemeDisplayed == 'Theme4d', $User.UIThemeDisplayed == 'Theme4t') 

, HYPERLINK("/apex/Apttus__LightningAgreementActivate?id=" &Id, IMAGE("/ 

resource/Apttus__Button_Activate", "Activate"),"_self") , HYPERLINK("/apex/ 

Apttus__AgreementActivate?id=" &Id, IMAGE("/resource/Apttus__Button_Activate", 

"Activate"),"_self")),NULL)

Configure the APTS_CustomLinksforActionPanel admin entry to view the new activate 
button in the Additional actions section of an agreement. For more information, see 
Admin Entries.

Connecting to External APIs
You must configure integration settings, remote site settings, and CSP trusted sites to use 
the new activation UI and smart search features.

For more information, see the following topics.

Smart search is a limited availability feature. Please write to integration- 
support@conga.com to explore the feature.



mailto:integration-support@conga.com
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Configuring CSP Trusted Sites
Configuring Integration Settings
Configuring Remote Site Setting

Configuring CSP Trusted Sites
You must configure CSP trusted sites for CORS communication and to access external APIs.

To configure CSP Trusted Sites
Go to Setup > Security > CSP Trusted Sites.
Click New Trusted Site.
Enter the following details in the General Information section:

Trusted Site Name: Enter a site name.
Trusted Site URL: Enter the trusted site URL.

Description: Enter a description.
Active: Select the checkbox.
Context: Select All.

Select all the checkboxes in the CSP Directives section.
Click Save.

Configuring Integration Settings
You must configure integration settings to connect to external APIs and to enable content 
search in large files.

To configure integration settings
Navigate to the Integration Settings tab.
Enter the following details:

Name: Enter a name.
End point URL: Enter an endpoint URL.
API Token: Enter an API token.
Tenant: Enter the tenant name.

Please contact the Conga Support team for Trusted Site URL details.

Please write to integration-support@conga.com for End Point URL, API 
Token, and Tenant details.



mailto:integration-support@conga.com
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Search Content in Large Files?: Select the checkbox to allow searching content 
in large files.

Personalize: Select the checkbox to search content only in the agreements that 
you have created or own.

Click Save.

Configuring Remote Site Setting
You must configure the remote site setting to connect to an external (third-party) API.

To configure remote site settings
Go to Setup > Security > Remote Site Settings.
Click New Remote Site.
Enter the following details:

Remote Site Name: Enter a remote site name.
Remote Site URL: Enter the remote site URL.

Disable Protocol Security: Leave the checkbox unselected.
Description: Enter a description.
Active: Select the checkbox.

Click Save.

Managing Send for Review
Select one of the following topics for more information:

Prerequisites for Parallel Review
Configuring the Send for Review Custom Button
Configuring MS Teams Setting
Configuring Email Service for Ending Review by Email
Adding the Review Status Panel on the Agreement Detail Page

Ensure that you select the checkbox only if you need to search content in 
large files. Users might observe an increase in page loading time after 
selecting the checkbox.



Please write to integration-support@conga.com for Remote Site URL 
details.



mailto:integration-support@conga.com
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• Disabling Clickjack Protection

Prerequisites for Parallel Review
The following table lists the configurations that you must perform to allow users to use 
parallel review. For more information on the parallel review, see Sending an Agreement 
Document for Parallel Review.

Configuration Description

Comply system properties See Comply System Properties.

Parallel Review Required to send documents for parallel review.

Enable Document Versioning Required to send documents for parallel review.

Parallel Review for related 
agreements 

Required to send related agreements for parallel review.

Filter By The Primary Agreement 
Status

Required to filter Related, Sibling, Parent, or Child agreement 
documents based on the primary agreement status.

Enable document permissions for 
review

Required to view the Set field and clause permission toggle in 
the second step.

Comply user properties See Comply User Properties. 

Show Add More Button During 
Review

Required to customize the visibility of Add more button for 
specific profiles or users.

Admin entries See Admin Entries.

APTS_RetainFileNameForParallel 
ReviewMergedDocument

Required to retain the name of the imported document in the 
merged document.

When a parallel review ends for an imported document, the 
reviewed document is merged with the latest reviewed 
document. 
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Configuration Description

APTS_EmailTemplateForReviewSi 
gnatures or 
APTS_EmailTemplateForReview

Required to configure default email template to send 
documents for review.

If the admin entries 
(APTS_EmailTemplateForReviewSignatures or 
APTS_EmailTemplateForReview) are not configured, the 
default email template is set to the template provided by 
Conga.

If no Email Template is selected and no default email 
template has been configured (using 
APTS_EmailTemplateForReview), the Email Template "Email 
Template For Review Signature" is used. In most cases, this 
template is not configured as "Available for Use" and must be 
manually set to true or an error will occur. In the case of a 
new installation of the package (non-upgrade), this Email 
Template is automatically configured as "Available for Use."

APTS_DefaultEmailTemplateFold 
er 

Not applicable for send for review flow from the Dec '21 
release.

APTS_SkipEmailTemplateSelectio 
n 

Required if you need to disable the selection of email 
templates.

APTS_EnableValidationForEmail 
WithoutUserContact

Required if you need users to enter valid email IDs or contacts 
in the To or Additional To fields. Applicable in Salesforce 
Classic mode.

APTS_DefaultEmailContactName Required to update activity history. Applicable in Salesforce 
Classic mode.

APTS_EnableCustomEmailAddres 
sLookup

Required to view the custom pop-up page; otherwise, the 
standard Salesforce pop-up page is displayed.

APTS_SuppressAutoReviewEmails Required to unsubscribe review emails (review completion, 
review error, and review cycle completion).

Email templates See Editing Classic Email Templates.
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Configuration Description

The following email templates 
can be customized for the review 
cycle notifications.

Parallel Review Cycle 
Complete Notification
Parallel Review Cycle 
Complete Without 
Document Notification
Parallel Review Incorrect 
File Upload Notification
Parallel Review Submission 
Failure Notification

If you delete an email template from CLM, the document 
reviewers do not receive the email notification related to the 
deleted email template.

ParallelReviewCycleCancelNotifi 
cation

Required to notify reviewers when a review cycle is canceled. 
For more information, see .Prerequisites for Parallel Review 
vDecember-21.

Email Service for Ending Review 
by Email

See Configuring Email Service for Ending Review by Email.

Agreement protection Required to apply protection to the documents being sent for 
review.

When you select any of the document protection options 
except Ignore, the document protection selected while sending 
for review is given priority irrespective of the document 
protection applied while generating the document. For 
configuring document protection, see Configuring Agreement 
Document Protection.

You can see the Set Document Permissions page if Agreement 
Document Protection rules for "Send to Other Party for Review" 
are specified and properties for document protection are 
enabled. For more information, see Configuring Agreement 
Document Protection.

Custom button - Send For Review 
Custom

Required to use the old Send for Review UI. For more 
information, see Configuring Send for Review Custom Button.

https://documentation.conga.com/display/CLM/.Configuring+the+Send+for+Review+Custom+Button+vSummer-21
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Configuration Description

Review Status Panel Required to view the review status panel on the agreement 
detail page. For more information, see Adding Review Status 
Panel on the Agreement Detail Page

Configure Agreement Documents 
and Related Documents columns

You must configure registration settings to allow users to 
configure Agreement Documents and Related Documents 
columns on the first step of review. For more information, see 
Generating Registration Setting.

Configuring the Send for Review Custom Button
You can opt to use the old send for review UI by configuring the Send For Review Custom 
button. You can restrict users from sending non-essential agreements or documents for 
review by passing Agreement IDs or Document IDs as parameters in the formula field. You 
can add document IDs of the related, parent, sibling, or child agreements. If any document 
IDs of documents mentioned in the formula field are in review, those documents are not 
listed when a user sends agreement documents for review. For more information on sending 
documents for review, see Sending an Agreement Document for Parallel Review and Sending 
an Agreement Document for Review.

To configure the send for review custom button
Go to Setup > Object Manager > Agreement > Fields & Relationships.
Click New and select Formula.
Click Next.
Enter Send For Review Custom in the Field Label field and select Text.
Click Next.
Enter a formula.

Sample

IF (OR(ISPICKVAL(Apttus__Status_Category__c,"In Signatures"), 

ISPICKVAL(Apttus__Status_Category__c,"In 

Authoring")),IF(OR($User.UIThemeDisplayed == 'Theme4d', $User.UIThemeDisplayed 

== 'Theme4t', $User.UIThemeDisplayed == 'Theme4u'), HYPERLINK("/apex/ 

Apttus__SendForReview?id="&Id & 

"&action=Send_To_Other_Party_For_Review&documentIdsCsv=0693h000009t9pdAAA,0693h 
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00000AKhjOAAT,0693h00000AKhjTAAT,0693h00000AKhk2AAD", IMAGE("/resource/ 

Apttus__LightningResource/images/actions/sendforreview.svg", "Send For Review") 

, "_self"), HYPERLINK("/apex/Apttus__SendEmail?id="&Id & 

"&action=Send_To_Other_Party_For_Review", IMAGE("/resource/ 

Apttus__LightningResource/images/actions/sendforreview.svg", "Send For Review") 

, "_self")), NULL)

Configure the APTS_CustomLinksforActionPanel admin entry to view the new Send for 
Review Custom button in the Additional actions section of an agreement. For more 
information, see Admin Entries.

Configuring MS Teams Setting
This section provides you information about how to configure MS Teams settings and also 
how to configure remote site settings. You need to gather client Id and client secret from the 
Azure portal to configure MS team setting in Contract Management.

Prerequisite
You must have MS teams and OneDrive or SharePoint license to integrate MS teams 
with Contract Management.
You can schedule the MSTeamsJobScheduler job to create an MS Teams channel 
according to your expected frequency.

To collect the Azure Client ID and Client Secret from the Azure 
portal

Log in to the Azure portal as an Administrator.
Select Azure Active Directory.
Select App registrations.
Select New registration and enter Apttus CLM Application.
Click Register.
From the left navigation, select Overview.
Copy Application (Client) ID.
From the left navigation, select Certificates & secrets.
Click New client secret. 
Add a description, select the validity duration, and select Add.
Copy the value.
On the left panel select API Permission.
Click the Add Permission button.
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Provide the following permissions for Microsoft Graph API.

Type Permission

Delegated Files.ReadWrite

Delegated Files.ReadWrite.All

Delegated Group.Read.All

Application Group.Read.All

Delegated Group.ReadWrite.All

Application Group.ReadWrite.All

Delegated Sites.ReadWrite.All

Application Sites.ReadWrite.All

Delegated User.Read

Delegated User.Read.All

Application User.Read.All

Delegated Directory.AccessAsUser.All

Application Directory.ReadWrite.All

On the Reporting API Application - API Permissions page, click Grant admin consent.

To configure MS teams setting in Contract Management
Navigate to MS Teams Setting tab.
Click New.
Enter the following details to connect to the MS teams:

Name: MS Teams
MS Teams Login URL: Enter MS Teams login URL to connect to the service.  
Sample value: https://login.microsoftonline.com/clmdev-eng.apttuscloud.io/ 
oauth2/v2.0/

https://login.microsoftonline.com/clmdev-eng.apttuscloud.io/oauth2/v2.0/
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MS Graph URL: Enter MS Teams graph URL to connect to the service.  
Sample value: https://graph.microsoft.com/v1.0/
Scope: Enter scope to be used in MS teams graph API. 
Sample value: https://graph.microsoft.com/.default
Client Id: Enter the client Id. (Refer step 7 in the previous configuration) 
Sample value: 8m7r4**d-****-4c**-b4d8-e4a6b***79b
Client Secret: Enter the client secret. (Refer step 11 in the previous configuration) 
Sample value: taiLWUY*****38&7B%400$5234c***UY%
Show Client Secret: Select the checkbox to expose the Client Secret field value.
Team Name Format: Enter a team name format to be used while creating a 
team in MS teams. 
Sample value: %Name% (Name of the Agreement)
Channel Name Format: Enter a channel name format to be used while creating 
a channel in MS teams. 
Sample value: %Title% (Name of the document version detail)
Active: Select the checkbox to activate the MS teams setting.

Click Save.

To configure remote settings in Contract Management
Go to Setup > Security Controls > Remote Site Settings.
Click New Remote Site.
Enter a Remote Site Name and the Remote Site URL as https:// 
login.microsoftonline.com for MS Teams Login.
Select the Active checkbox.
Click Save & New.
Enter a Remote Site Name and the Remote Site URL as https:// 
graph.microsoft.com for MS Graph URL.
Select the Active checkbox.
Click Save & New.
Enter a Remote Site Name and the Remote Site URL for SharePoint URL. 
The SharePoint URL is specific to your domain and Microsoft license. 
Select the Active checkbox.
Click Save.

Note

You can activate only one MS team setting at a time.



https://graph.microsoft.com/v1.0/
https://graph.microsoft.com/.default
https://login.microsoftonline.com/
https://graph.microsoft.com/


CLM

402 Copyright ©2022 Apttus Corporation. All rights reserved.
 

1.
2.

a.
b.

c.
•

•

d.
e.
f.

3.

1.
2.

3.

1.
2.
3.

a.

To schedule the MS Teams job via Schedule Apex
Click Setup > Develop > Apex Classes > Schedule Apex.
Enter the following information to configure the job parameters.

Job Name: Enter a job name.
Apex Class: Click the  icon. Set search to MSTeamsJobScheduler and select 
MSTeamsJobScheduler. 
Frequency: Select either Weekly or Monthly based on your requirement.

If you select Weekly, you need to specify one or more days of the week the 
job needs to run (such as Monday and Wednesday).
If you select Monthly, you need to specify either the date the job is to run 
or the day (such as the second Saturday of every month.)

Start: Select the start date.
End: Select the end date.
Preferred Time: Select a preferred time for the dropdown.

Click Save.

To schedule the MS Teams job via Developer Console
Navigate to Developer Console. This displays the Developer Console window.
Select Debug tab and select Open Execute Anonymous Window. This displays the 
Enter Apex Code window.
Add the code in the following format:

Apttus.MSTeamsJobScheduler c1 = new Apttus.MSTeamsJobScheduler();

String sch1 = '0 5 * * * ?'; 

System.schedule('MSTeamsJobScheduler - Schedule Job 5 mins', sch1, c1); 

Configuring Email Service for Ending Review by Email
This configuration allows a user to end a parallel review by email.

To configure email service
Go to Setup > Build > Develop > Email Services.
Click New Email Service.
Enter the following details:

Email Service Name: Enter AgreementEndParallelByEmail.



CLM

403
 

Copyright ©2022 Apttus Corporation. All rights reserved.
 

b.
c.
d.
e.
f.

4.
5.

6.
a.
b.
c.
d.

e.
7.

8.
9.

10.
11.

a.
b.

12.

1.
2.
3.
4.

5.

Apex Class: Enter AgreementEndParallelReviewByEmail.
Accept Attachments: Select Binary Attachments Only.
Advanced Email Security Settings: Leave the checkbox unselected.
Accept Email From: Leave it blank.
Active: Select the checkbox.

In the Failure Response Settings section, leave the options as is. 
In the Email Addresses section, click the New Email Address button. 
This displays the Email Service Address page.
Enter the following details:

Email Address Name: ApttusEndReviewByEmail
Email address: Leave the value as is.
Active: Select the checkbox.
Context User: Logged in user name is provided by default. Leave the user name 
as is.
Accept Email From: Delete the default email address and leave it blank.

Click Save. 
This displays the Email Service: ApttusEndReviewByEmail page.
From the Email Addresses section, copy the email address.
Navigate to the Admin Home page. 
Click New. This displays the Admin Edit page.
Enter the following details:

Name: Enter APTS_EndReviewEmailServiceAddress.
Value: Paste the email address from the email service.

Click Save.

Adding the Review Status Panel on the Agreement 
Detail Page
You must configure the Review Status panel on the Agreement Detail page to view the 
parallel review status.

To configure review status panel
Navigate to the Agreement Detail page.
Click the Setup icon and select the Edit Page option.
In the left panel, search for reviewStatus.
Drag reviewStatus from the left panel and drop it on above the Agreement Actions 
panel.
Click Save.
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Disabling Clickjack Protection
When you send a document for review in Salesforce Lightning, you must disable clickjack 
protection (if enabled) to view Visualforce pages in Lightning.

To disable Clickjack Protection
Go to Setup > Security > Session Settings.
Unselect:

Enable clickjack protection for customer Visualforce pages with standard 
headers
Enable clickjack protection for customer Visualforce pages with headers 
disabled

Click Save.

Routing Documents to Content Libraries in 
Salesforce Lightning
When you activate an agreement, executed agreement documents are stored in the 
Document Folder Apttus Documents. This option will be sufficient for some users but may 
prove to be too basic a solution. Conga CLM offers an alternative contract repository 
option that takes advantage of Salesforce CRM Content by allowing you to publish 
executed agreements to content libraries. There are many advantages to using content 
libraries:

Multiple content libraries can be created by administrators to store agreements by 
any number of classifications.
Library content can be tagged with labels and libraries are fully searchable and 
allow you to create filters to locate agreements.
Content access can be restricted based on member groups that are configured when 
libraries are created.
Users can subscribe to specific libraries to get notifications when content has been 
changed or added.

To publish activated agreements to the Salesforce CRM content repository:

The Apttus Content Integration package must be installed in your Salesforce 
organization.
Salesforce CRM Content must be enabled.
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The Libraries tab and other settings must be configured.

You can also create "Content Workspace" Agreement Rules to route activated agreements 
to different libraries based on expressions you define.

Installing Apttus Content Integration
Navigate to the Community Portal > Resources> Install Center.
In the left-hand navigation, click the Integrations tab.
In the Integrations packages page go to Apttus Content Integration, click Install 
Now, and follow the instructions to install the package in your Org.
Choose the type of org where you will install the package (Production or Sandbox).

Enabling Salesforce CRM Content 
To properly route agreements to your content libraries, you must first enable Salesforce 
CRM Content in your Salesforce Org. To enable Salesforce CRM content:

Go to Setup > Feature Settings > Salesforce Files > Salesforce CRM Content or enter 
"Salesforce CRM" into the Quick Search dialog and select Salesforce CRM Content. 
Select Enable Salesforce CRM Content and Autoassign feature licenses to existing 
and new users. 
Click Save.
(Optional) Go to Setup > Feature Settings > Salesforce Files >  Content Deliveries and 
Public Links.
Select Content Deliveries feature can be enabled for users and Public Links can be 
enabled for users.
Select Choose password defaults option per your requirement.
Users who are activating agreements must also have Salesforce CRM Content 
enabled. Turn on Salesforce CRM Content for all users who will be activating or 
managing agreement documents published to your content libraries. Go to Setup > 
Users > Users.

Configuring Admin Properties
Several Admin Objects (properties) must be created or modified to identify the type of 
content to be routed and the default workspace to use for activated agreements.

Go to the Admin tab. 
Create the following four Admin properties to enable content delivery for your 
activated agreements. Set values as required:
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APTS_ContentRepositoryType – Set this property value to "content." The default 
setting is "document," which routes ALL activated documents to an Apttus 
folder. Changing this setting tells the system to use content repository settings 
for routing documents.
APTS_ContentRecordTypeName – Set this property value to "Agreements."
APTS_DefaultContentWorkspaceName – Set the default workspace name for 
your content library to "Agreements." This is the default content library that will 
store all activated agreements that are not routed to other content libraries 
defined in your Agreement Rules.
APTS_UIPageConfig – Set up a UIPage Config for the content repository type. 
Enter "XML" as the value and the following chunk of XML under Content:

<UIPageConfig> 

<UIAction name="publish_document"> 

<CustomPage> <Name>Apttus__PublishDocument</Name> 

</CustomPage> 

</UIAction><UIAction name="publish_content"> 

<CustomPage> 

<Name>Apttus_Content__PublishContent</Name> 

</CustomPage> 

</UIAction> 

<UIAction name="publish_chatter"> 

<CustomPage> <Name>Apttus__PublishChatter</Name> 

</CustomPage> 

</UIAction> 

</UIPageConfig> 

APTS_AutoContentSearchable – (Optional) Set this property to "True" to skip the 
optional step when activating an agreement that allows a user to determine 
which agreement documents are available for content search. This property is 
not required but recommended when you are routing content to ensure that all 
relevant agreement documents make it into the library and are searchable.
APTS_ContentConfig – (Optional) Set this property to override the default field 
mappings used by the Apttus Content Integration package. The default field 
mapping only maps the Agreement name field to the same field in the Content 
Version object and is found as a Static Resource in the Contract Management 
package labeled "ContentConfig" (Go to Setup --> Quick Search --> Static 
Resources --> ContentConfig to view the static resource).
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Copy the XML contents from the ContentConfig static resource into your 
new Admin Object (APTS_ContentConfig).
Any custom fields you add to the Content Version object and layout 
(detailed in the next section) which you want to be displayed in Content 
Version details for any stored agreement document must be mapped as 
part of this Admin property.
After an agreement document is activated and routed to the proper 
library, mapped fields will pull data from the document's associated 
agreement record and be displayed on the Content Version Details page.

Setting Up Salesforce Files for Content
Before you can configure the content libraries which will store your activated agreements, 
you must create a custom field lookup relationship to Agreement on the Content Version 
object, to associate Content Version records with Agreement records and to allow for 
related records to appear on Agreement layouts. You can also create different page 
layouts to display content version data, depending on the library where your documents 
are stored.

Configuring Content Permissions for Libraries
You can define content permissions for managing your libraries. Each library's permission 
represents a set of user privileges.

Go to Setup > Feature Settings > Salesforce Files > Content Permissions to view, edit, or 
add library permissions.
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Adding Custom Fields to the Content Version Object
 
To properly view information and navigate to your contract repository from the Content 
Versions related list on your Agreements, you must add "Agreement" as a custom lookup 
field to the Content Version object. The following configuration is required for configuring 
email agreement documents if you have installed the Apttus Content Integration package 
and if you have not created a lookup field for Agreement object.

Go to Setup > Feature Settings > Salesforce Files > Fields.
Click New in the Custom Fields & Relationships related list.
Choose the type of field to create, and click Next.
For relationship fields, associate an object with the field and click Next.
Enter a field label. The field name is automatically populated based on the field 
label you enter. 

Choose the page layout that should display the field as an editable field.

Users who will be activating agreements must have "Author" permission for content 
libraries. When you configure the libraries and edit members you will be able to 
assign permission to users.



The field name can contain underscores and alphanumeric characters and 
must be unique in your organization. It must begin with a letter, not include 
spaces, not end with an underscore, and not contain two consecutive 
underscores. Ensure the custom field name is not identical to any standard 
field name for that object.



If you want any custom fields beyond Agreement to map field data from the 
Agreement record to your content library, you need to configure the optional 
APTS_ContentConfig Admin object, as detailed in Set Admin Properties.





CLM

409
 

Copyright ©2022 Apttus Corporation. All rights reserved.
 

1.
2.

3.

4.
5.
6.
7.
8.

Assigning Custom Fields to Page Layouts
Now that you have created custom fields for your content, you must assign them a page 
layout. Which page layout is used determines which fields are displayed when for the 
content you are storing. You can use the pre-existing General layout, or you can create 
additional layouts to display Content Version data.

Go to Setup > Customize > Salesforce Files > Record Types.
Click New to create a new record type with its own Library Content Version Layout. 
 

 

 
Create the record type "Agreements" and assign it to profiles you want to give access 
to Content Version data.
Ensure that you select the Active checkbox.
Repeat steps 2 – 4 to create additional Content Version Record Types as needed.
Go to Setup > Customize > Salesforce Files > Page Layouts.
Click New to create a custom layout and name it "Agreements."
Click Edit next to the General layout. 
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Add the new Agreement lookup field and any other Content Version fields you want 
to add to the General layout. 
 

 

 
Click Save.
Repeat steps 7 – 9 for the Agreements layout.

Configuring the Libraries Tab
You now need to create the content libraries that will hold your documents. You can create 
as many content libraries as you want. Your initial content library will be the default 
library for stored agreements when no agreement rules are applied. You can create 
additional libraries for content routed using agreement rules.

Go to the Libraries tab (click + and click Libraries).
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From "My Libraries," click New to launch the New Library Wizard. 
 

 

 
Enter the name you want to use for your library (e.g., "Agreements") and a description 
(e.g., "Repository for activated agreement documents") and click Save and Close.
From "My Libraries," click on the library name.
Click Tagging Rules to edit tagging rules for your library. Click Save to save any 
changes. 
 

 

 
Click Record Types to assign content version record type restrictions to your library. 
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Choose which record types to restrict to your library. Be sure to add the Record Type 
you defined in the previous section.
Click Save.

Configuring Library Permissions
Go to Setup > Customize > Salesforce Files > Content Permissions.
Click the Edit action for the Author Library Permission Name. Ensure that the 
following permissions are selected: 
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Click the Edit action for the Viewer Library Permission Name. Ensure that the 
following permissions are selected: 

Click the Edit action for the Library Administrator Library Permission Name. Ensure 
that the following permissions are selected: 

Go to the Libraries tab.
From "My Libraries," click on the library name.
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Click Edit Members to choose which members have access to this library.  

Add a user and click Next to choose which permission profile to apply to the library 
members you added. Remember, members must at least have "Author" permissions to 
publish documents to the library. 

 

 
Click Save. Your content library is now ready to use! Repeat the process to create 
additional libraries. Route content to specific libraries using Agreement Rules to Route 
Content.

Managing Workflow
Workflow is a series of activities that automate tasks, email alerts, field updates, and 
outbound messages. This section covers the following topics:

Creating New Workflow Rules
Automating the Process Through Workflow Rules



CLM

415
 

Copyright ©2022 Apttus Corporation. All rights reserved.
 

•
•
•
•

1.
2.
3.
4.

Creating a Workflow Task
Creating Email Alerts
Defining Field Updates
Validating Workflows

Creating New Workflow Rules
Workflow rules give you the ability to enforce key business processes easily without needing 
to write any code. You can automate your organization’s standard processes by 
configuring workflow rules.

To create new rules, refer to the following standard Salesforce Help:

Selecting the Agreement object to which the workflow rule applies
Configuring the workflow rule settings and criteria
Configuring the workflow actions
Activating the workflow rule

Watch a demo: Creating a new workflow rule.

Automating the Process Through Workflow Rules
In this fast-paced world time is money for your organization. You can save time by 
automating the processes by configuring workflow. Also, you can help make operations 
more efficient with standardized internal procedures and automated business processes.

To automatically perform the procedures and processes, you must do settings based on 
your workflow requirements.

Design workflow actions, and then configure workflow rules, and approval processes that 
determine the conditions under which actions are executed.

Workflow is a series of activities that automates the following types of actions:

Actions Description

Tasks A task is a type of workflow action by which you can determine 
the details of an assignment given to a specified user by a 
workflow rule or approval process. Create tasks and then 
associate them with the workflow rules or approval processes 
that will trigger them. When a workflow rule or approval process 
meets the business conditions that you set up, any tasks 
associated with it are assigned to designated users with the 
Subject, Status, Priority, and Due Date of the workflow task.

https://help.salesforce.com/HTViewHelpDoc?id=creating_workflow_rules_select_object.htm
https://help.salesforce.com/articleView?id=workflow_rules_new.htm&type=0
https://help.salesforce.com/HTViewHelpDoc?id=creating_workflow_rules_configure_actions.htm
https://help.salesforce.com/HTViewHelpDoc?id=creating_workflow_rules_activate.htm
http://www.salesforce.com/_app/video/workflow/help/create_workflow_rule.jsp
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Actions Description

Email Alerts Email alerts are emails generated by a workflow rule or approval 
process and sent to intended recipients whenever specific business 
actions trigger the workflow rule or approval process. Email alerts 
contain the standard text and list of recipients for an email. It is 
recommended that you specify an email template for email 
alerts.

Field Updates Field updates are actions associated with workflow rules or 
approval processes. With Field updates, you can automatically 
specify a field value.

Outbound Messages Outbound messages send a secure configurable API message in 
XML format to a designated listener. For example, automatically 
initiate the reimbursement process for an approved expense report 
by triggering an outbound API message to an external HR system.

Creating a Workflow Task
Click Create > Workflow & Approvals > Tasks.
Click New Task.
Select a record type and click Next.

Perform the following steps to configure the task:
Select an Assignee.
Enter a subject for the task.
Enter a Unique Name.
Specify a due date, status, and priority.
Check Notify Assignee to send an email notification when the task is assigned.
Check Protected Component to mark the task as protected.
Enter any comments to add to the task.
Click Save.

Note

You can associate Task with workflow rules or approval processes for the 
same object type.
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Creating Email Alerts
Click CreateWorkflow & ApprovalsEmail Alerts.
Click New Email Alert.
Perform the following steps to configure the email alert:

Enter a Description.
Enter a Unique Name.
Select the Object for the email alert. 

Choose an email template from the lookup.
If required, select the Protected Component check box to mark the alert as 
protected if it is part of a Managed - Released package.
From the Recipient Type list, select who all (type of users) should get your email 
alerts.
From the Available Recipients list, select the recipients who should receive this 
email alert in the Available Recipients list and click Add to include in the 
Selected Recipients list.
Enter up to five additional email addresses.
Use the From Email Address field to the email address of the default workflow 
user. 

Click Save.

Defining Field Updates
Click CreateWorkflow & Approvals Field Updates.
Click New Field Updates.
Perform the following steps to configure the field update and complete the workflow:

Note

This is used when you generate merge field values for email templates 
with workflow rules and approval processes. Also, you can define the 
recipients of this email alert using contact and user lookup fields that 
are relevant to that object.



Note

Selecting Make this address the default From email address for this 
object's email alerts overrides the From Email Address for all email 
alerts associated with that object.
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Enter a Name and Unique Name for this field update.
Type the Description for the filed that you need to update.
Select the object for the associated field to update and click Next.
To re-evaluate the workflow rules on the selected object after the field update 
is done, select the Re-evaluate Workflow Rules After Field Changecheck box.
Under the Specify New Field Value section, select an appropriate options from 
the list of available options based on the Field to Update selection.
Click Save.

Validating Workflows
After creating a new workflow rule, you must validate the workflow. Once validated, you 
will receive a confirmation email.

To validate a workflow
Navigate to the Agreements tab and click New.
Select a record type for the new agreement and click Continue.
Type a mandatory Agreement Name and enter a mandatory Account.
From Select Category, select In Effect. Based on your selection from the Select 
Category, the Status pick list is auto-populated.
From Status, select Activated.
Click Save.  

This saves the edited values and triggers the workflow. If your email is set for the Owner of 
the agreement type, you will receive an email.

Migrating Attachments to Files
Attachments to Files Migration feature enables users to convert all the documents, which 
are available as Attachments format, to the File format. You can either convert a single 
Attachment or bulk Attachments type to the File type.

Migration process consists of the following two tasks:

Converting Attachments to File
Deleting Converted Attachments
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Prerequisites
For converting attachments to files and deleting attachments, ensure you have met the 
following requirements:

Set the APTS_SkipFileSplitWhileSavingFile admin entry to true when all of the 
following conditions are met. 

You are upgrading to Spring '21 or a later version of CLM, and
You are migrating Attachments that are greater than 10 MB in size to Files. 
For more information, see Admin Entries.

The migration tool is installed.

The following latest versions are installed:
Contract Management
Docusign/Echosign
XAC
ContentSearch

Key Points To Remember
You must remember the following key points, before starting the migration:

The current implementation does not support user-level flag Files Enable. It is the Org 
wide flag.
The current version does not support Template in files, it should be in Attachments.
Attachment Migration trigger needs to be created before running the Migration Tool.

You can use the free Magic Mover for Notes and Attachments tool from 
Salesforce to do bulk conversions of attachments to Salesforce Files. For more 
information see the Magic Mover Help page. Note that the tool is provided by 
Salesforce and can be used with Conga CLM to migrate notes and 
attachments.



Note

After Files are migrated, you cannot switch back to the Attachment mode.



https://appexchange.salesforce.com/listingDetail?listingId=a0N3A00000EHAmyUAH
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Converting Attachments to Files
Converting Attachments to Files feature enables a user to convert documents, which are 
saved as attachments, to files.

Restrictions
 

The migration process has the following limitations:

 

You can convert only 2,00,000 attachments per day per Production Org.
Existing customer can start migration only after upgrading to the Contract 
Management new release version and before selecting the Enable File setting.
Time to complete migration depends on the number of attachments getting converted 
to files.
If the number of agreements is greater than 2,00,000 then migration and downtime 
should be planned accordingly. 

 To convert attachments to files
Go to the Salesforce.com App Menu and select Attachments and Notes migrator.
Click Attachments to Files. The Attachments to Files page appears.
Figure: Attachments to Files Page

http://salesforce.com/
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Select the required object from the Filter by object drop-down list as shown in the 
below figure.
Figure: Filter by object

 

 



CLM

422 Copyright ©2022 Apttus Corporation. All rights reserved.
 

4.

5.

Select the Bulk conversion by object type radio button, as shown in the below image, 
from the Public and Private Attachments to Convert section.
Figure: Bulk Conversion

You can also convert attachments to files by selecting the followings:

Convert by 
related record 
ID

You can convert attachments using Record ID. Users can enter multiple 
IDs separated by commas or each ID in a separate line.

Convert by 
attachment ID

You can convert attachments using Attachment ID. Users can enter 
multiple IDs separated by commas or each ID in a separate line.

 

Click Convert.
Figure: Convert

Note

Users can also filter attachments created in a specific time period using Show 
items created between, by Created Date, and by Last Modified Date options
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A pop-up appears displaying the below message as shown in the below figure.
Figure: Convert Attachment

 
 
Click Convert Attachment to convert the attachments or click Cancel to cancel the 
conversion.
After attachments are converted to files, you will get an email which displays a 
message as highlighted in the below figure. 
Figure: Email Message 

 

 
The conversion of attachments to files is completed.
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Deleting Attachments
Delete attachments option enables users to delete the attachments which are converted 
to files. 

To delete attachments
Go to the Salesforce.com App Menu and select Attachments and Notes migrator.
Click Attachments to Files. The Attachments to Files page appears.
Figure: Attachments to Files Page

 
Click Refresh in the Converted Public and Private Attachments section, as shown in 
the below figure. 
 

http://salesforce.com/
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Converted attachments appear with details as shown in the below figure. 
Figure: Converted Attachments with Details 
 

 
Click Delete icon to delete the attachments.
A pop-up appears displaying a message given in the below figure. 
Figure: Delete Converted Attachments  
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Click Delete to delete converted attachments or click Cancel to cancel it. 
Your selected attachments are deleted.

Migrating from Notes and Attachments to Files in 
Lightning
When you switch to Lightning, any files you upload to a record will be saved as Salesforce 
Files, rather than as attachments.

To ensure that your org is using Files, enable the following settings:

Go to Setup > General Settings. Select Files uploaded to the Attachments related list 
on records are uploaded as Salesforce Files, not as attachments.
Go to Setup > Custom Settings > Comply System Properties. Select Enable Files.

Please note the following:

After you enable Files, uploads are stored on both the "Files" and "Notes And 
Attachments" related lists.
The "Files uploaded to the Attachments related list on records are uploaded as 
Salesforce Files, not as attachments" setting causes files that are uploaded to be 
stored as the "File" type rather than the "Attachment" type.

Configuring Agreement Document Protection
The document protection has following three phases:

Enabling Document Protection 
To enable document protection, you must first create a custom object record. A 
custom object record stores information that is unique and important to you and your 
organization. For example, your organization may use a custom object called Quotes 
to store data for your company's sales quotes.
Defining Protection Password 
Create a custom object record to define password protection for your document.

Note

Ensure Enable File setting is selected after the migration process is 
completed.   
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Setting Up Agreement Protection 
To restrict what specific profiles can and cannot do with generated documents, you 
can protect it either by making it read-only or enabling track changes to capture any 
updates on the generated document. For example, specify a Sales User who can 
generate or re-generate a document but when editing or forwarding it to a customer, 
track changes are enabled.

User Permissions Needed

To enable document protection: Admin: Create, Edit

To create an agreement protection: Agreement Protection: Create, Edit

Enabling Document Protection
To enable document protection, you must first create a custom object record. A custom 
object record stores information that is unique and important to you and your organization. 
For example, your organization may use a custom object called Quotes to store data for 
your company's sales quotes.

To enable document protection
Click + and click Admin.
Click New and type APTS_Protection in the name field.
In the Value field, enter 1 and click Save.

A new custom object record APTS_Protection is created. After you have created a new 
custom object record, you can automatically associate the new custom object with 
another record if your administrator has defined relationships to other types of records.

Defining Protection Password
Create a custom object record to define password protection for your document.

When using Agreement Document Protection, inserting a clause via the Playbook will 
not be tracked as a redline in the document. However, when the document is checked 
in and reconciled, the added clause will be tracked via the Agreement Clauses 
related list.
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To define protection password
Click + and click Admin.
Click New and type APTS_Password in the Name field.
In the Value field, enter the password that you want to set to protect the document 
and click Save.

A new APTS_Password custom object record is created with the password that you entered 
as its value.

Setting Up Agreement Protection
To restrict what specific profiles can and cannot do with generated documents, you can 
protect it either by making it read-only or enabling track changes to capture any updates 
on the generated document.

For example, specify a Sales User who can generate or re-generate a document but when 
editing or forwarding it to a customer, track changes are enabled.

When the protection levels are setup at for different actions, the document is protected 
according to the protection type and the specified level.

To setup agreement protection
Click + and click Agreement Protection.
Click New.
Enter Description and Profile Name.
Select an Action from the picklist.

Select one of the following protection types: 
Ignore: With this option, protection settings can be by-passed.

To enable Agreement Protection, ensure that you set up the Admin entries for 
APTS_Protection and APTS_Password prior to defining the Agreement Protection.



You need to configure the Merge Documents option. It is not available by 
default in the Action picklist. Navigate to Setup > Object Manager > 
Agreement Protection > Fields & Relationships > Action. In the Values section, 
click New and enter Merge Documents. 
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Prompt: With this option, protection level can be selected at the generation 
time.
Automatic: With this option, protection level has to be selected at the 
configuration time. 
You can define protection level for the Automatic option. Following are the 
protection levels for the Automatic protection type:

Full access: This option provides complete access to a user's profile to 
perform the selected action.
Insert comments and tracked changes only: This option allows a user's 
profile to insert comments in the agreement document along with tracking 
the changes made by any other user.
Insert comments only: This option allows a user's profile to insert only 
comments in the agreement document.
Fill in form fields only: This option allows a user's profile to only fill in the 
form fields inside the agreement document.
Read only: This option gives only the read access to the user of the entered

Unprotect: With this option for the selected action, the password protected 
document can be unprotected for certain actions, provided the password is 
same as the one set in the admin object properties. 
 

Click Save.

Use Case for Setting Up Agreement Document 
Protection
This topic describes the use case for setting up an agreement document protection.

This use case describes how to set up protection level for a document and restrict action 
levels of a specific user. For example, the Read Only protection level provides read-only 
access, while the Insert Comments and Track Changes Only level captures modifications 
made in the document generated by a specific user.

This option is not available for Generate/Regenerate actions.

This use case gives one example on how to set up protection level for a document 
and restrict action levels of a specific user. You might use this functionality 
differently, depending on your business case.
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In this case, a System Administrator can specify that a user with the Sales profile is 
allowed full document access when generating or re-generating a document, but Track 
Changes is enabled when the user sends a document for review.

Prerequisites:

System Administrator must apply the appropriate settings before enabling the Agreement 
Protection; protection should be turned on and an unlock password must be created.

To set up protection or restrict access to your document, please perform the following 
steps:

Select the Agreement Protection tab. 
Agreement Protection page is displayed.
Click New. 
Agreement Protection Edit page is displayed.
Enter a description in the Description field.
Enter profile name in the Profile Name field.
Select an action from the Action drop-down list.
Select Automatic from the Protection Type drop-down list.
Select Insert comments and tracked changes only in the Protection Level picklist.
Click Save.

 
Result:

You have enabled Track Changes for the generated Word document, which cannot be 
disabled by a user who will edit the agreement document unless the user enters the Unlock 
password which is set by the Administrator.

PDF Security for Agreement Documents
Conga CLM uses Agreement Document Protection to help you protect your documents when 
they are generated in Microsoft Word format, but when you need to generate a PDF you 
may also wish to restrict editing. Fortunately, you can use a combination of Comply 
System and Admin properties to finely control restriction for agreement documents:

Generated in PDF format.
Checked-in from X-Author for Contracts as Final-to be signed with Create PDF 
attachment option selected. 
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Understanding PDF Security
When you enforce security on a PDF document, you typically have the option of enabling or 
disabling certain restrictions. To view the set of possible restrictions for a PDF from Acrobat 
Reader, go to File > Properties. You can view the current restrictions under "Document 
Restrictions Summary."

You can control the following document restrictions for PDFs generated in Conga CLM:

Printing
Changing the document 
Content Copying 
Document Assembly
Commenting
Filling of form fields

Defining Comply System Properties 
Go to Setup > Develop > Custom Settings. 

All generated PDFs user 128-bit AES encryption.
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4.

Click Manage next to Comply System Properties
Click Edit next to System Properties and do the following:

Select Enable PDF Security.
Enter the desired value for PDF Owner Password.
Click Save.

Defining Admin Properties
Click the Admin tab.
Select APTS_ComplyConfig and click Edit.
Enter the following code between the <ComplyConfig> and </ComplyConfig> tags. 

<PDFSecurityDefault>

<CanPrint>false</CanPrint>

<CanCopy>false</CanCopy>

<CanChange>false</CanChange>

<CanAddNotes>true</CanAddNotes>

<CanFillFields>true</CanFillFields>

<CanAssemble>true</CanAssemble>

</PDFSecurityDefault>

By using the above code example, you can restrict the user from printing, copying, and 
modifying the PDF. To print, copy, and modify the PDF, the user must provide the 
password that you have configured in the comply system property. Depending on 
your requirement, you can adjust the field values.  
Click Save.

All generated PDFs will now have security enabled. 

Versioning Contract Documents
Contract Document Versioning enhances existing version control by introducing a solution 
framework of document versioning at the Agreement record level. Without Contract 
Document Versioning, all agreement documents are included in the Notes & Attachments 
related list, requiring that the agreement owner or other parties determine the proper 
document version or versions for review, signature, finalization, and activation. Document 
Versioning adds two new child objects with relationships to the Agreement 
object: Document Version (child object to Agreement) and Document Version Detail (child 
object to Document Version).
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With Document Versioning enabled for your organization, rather than all the documents 
being attached to an agreement's Notes & Attachments Related List, each major version of 
a document is instead populated in the Document Versions Related list, with individual 
version information tracked using Document Version Details.

Understanding Document Versions
Contract Document Versioning divides the version of an Agreement document into three 
parts: Major, Minor, and Revision. Each version of an agreement document is represented as 
a period-delimited numeric value in the Document Version Details object (e.g., "1.0.0"). 
Version values are numerically incremented as various actions are taken on the document 
by different users. The following table describes each version type represented by the 
version value and how it is created.

To take advantage of the full functionality of Contract Document Versioning, your 
organization should also be using X-Author for Contracts.
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Version Type Document Action User Role Example 
Value

Major A major version type is created 
every time a user:

Generates a document.
Regenerates a document.
Creates an Offline 
document.
Imports an Offline 
document.
Generates a supporting 
document.
Checks in a Clean document 
or a document without 
Redlines.
Checks in a document as 
Final.

A MAJOR version can be either a 
new document instance or an 
incremented version of a pre- 
existing document. For further 
explanation, see New Document 
Versus Incremented Version

Contract Requestor / 
Owner

1.0.0

2.0.0

3.0.0

Minor (Negotiator) A minor version is created every 
time a Negotiator makes changes 
to the document and checks it in 
using X-Author for Contracts with 
the following exceptions:

The Negotiator checks in the 
document as Clean or Final 
(creates a MAJOR version).
The Negotiator checks in a 
document on behalf of a 
Reviewer (creates a 
REVISION–see below).

Negotiator 1.1.0

2.1.0

1.2.0
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Version Type Document Action User Role Example 
Value

Revision (Reviewer) A revision is created every time a 
document is returned by a reviewer 
to the Negotiator. The document is 
either returned by the reviewer as 
an email attachment and checked 
in using the X-Author Contracts for 
Outlook plug-in, or checked in on 
their behalf by the Negotiator (for 
both internal and external 
reviewers) using X-Author 
Contracts for Word. For more 
information on Send for Review 
using X-Author, see X-Author for 
Contracts documentation.

Reviewer 1.0.1

2.0.2

 

To enable Contract Document Versioning for your organization, see Enabling Contract 
Document Versioning.

To learn how to work with Contract Document Versioning, see Contract Document 
Versioning.

Document Version Properties
For agreement documents, Conga CLM follows the X.Y.Z pattern of document versioning 
where X denotes the major document version, Y denotes the minor document version and Z 
denotes the revision version. The Document Version Properties let you set the version 
increment factor and set the initial version number for your agreement documents.

Configuring document version properties
To use and configure Document Version Properties in your org:

Navigate to Setup > Develop > Custom Settings.
Click the Manage link next to Document Version Properties. Click Edit to edit 
Document Version Properties. The Document Version Properties form is displayed.

https://documentation.conga.com/x-author-for-contracts/latest/x-author-for-contracts-154927679.html
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You can enter following property details in Document Version Properties:

Setting Description

Initial 
Version

This property specifies the initial version number of a newly generated or uploaded 
document. If you want the document versioning to start from 0.0.0, specify 0 and if 
you want to start the document versioning to start from 1.0.0, specify 1. Default 
value of this field (if left blank) is 1.

Document 
Regenerate

This property specifies the document version increment factor when the document is 
regenerated with the same template as of the original agreement, from Contract 
Management. Specify Major if you want to increment the major version of the 
document and specify Minor if you want to increment the minor version of the 
document. Default value of this field (if left blank) is Major.

 

Increment 
Checkin 
Final

This property specifies the document version increment factor when the document is 
checked in as Final- to be signed from X-Author Contracts for Microsoft Word. 
Specify Major if you want to increment the major version number of the document 
and specify Minor if you want to increment the minor version number of the 
document. Default value of this field (if left blank) is Major.

Note

Regenerating an agreement document with a different template than the 
one used for generating the original agreement, restarts the version 
numbering of the document.
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Setting Description

Increment 
Checkin 
with 
Redlines

This property specifies the document version increment factor when the document is 
checked in using the option With Redlines from X-Author Contracts for Microsoft 
Word. Specify Major if you want to increment the major version number of the 
document and specify Minor if you want to increment the minor version number of 
the document. Default value of this field (if left blank) is Minor.

Increment 
Checkin 
without 
Redlines

This property specifies the document version increment factor when the document is 
checked in using the option Without Redlines from X-Author Contracts for Microsoft 
Word. Specify Major if you want to increment the major version number of the 
document and specify Minor if you want to increment the minor version number of 
the document. Default value of this field (if left blank) is Major.

Trim 
Document 
Version

This property specifies whether the document version number in the Document 
Naming Convention would of 3 digits or 2 digits. Selecting this property, trims the 
last decimal and number from the document version number in the Document 
Naming Convention. For example, version 1.2.0 would become 1.2 in the name of the 
document. By default, this property is not selected.

Enabling Contract Document Versioning
To enable Contract Document Versioning for your org, consider the following 
implementation options:

Enable Comply System Properties for Versioning
Add Version-Related Merge Event Actions
Add the Document Version Related List to Agreement Layouts
Add the Document Version to Document Naming Convention

To enable Contract Document Versioning for select agreements or based on conditions 
(without applying versioning globally):

Add the Version Aware field to Agreement Layouts
Add Workflow Rules to make Agreements Version Aware (optional)

To configure Comply System Properties for Versioning
Use Comply System Properties settings to enable Contract Document Versioning for 
agreements in your Org.

Navigate to Setup > Develop > Custom Settings.
Click on the Manage link next to Comply System Properties.
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Click Edit to edit System Properties. The System Properties form is displayed. 
 

 

 
Configure the System Properties described in the following table.
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# Property Description

1 Enable Version Control Check this box to enforce a check-in/check-out 
policy for agreement documents. This setting must 
be enabled when "Enable Document Versioning" is 
checked. Note: This property existed in Contract 
Management versions prior to 8, so this property 
may already be enabled.

2 Enable Document Versioning Check this box to enable Document Versioning. All 
new agreement records created in your org will 
use Document Versioning after this setting is 
enabled. Enable Version Control must be enabled 
for Document Versioning to work properly.

Enabling Document Versioning changes the value 
of the Version Aware Agreement field to TRUE for 
all new agreements after the property is 
activated. The Version Aware field is a flag that 
tells Conga CLM to use Document Versioning for a 
specific record.

Important Note: It is recommended that once a 
record is flagged as Version Aware, you do not 
disable this field, as versioning will become 
undefined for the agreement record in question. 
Instead, ensure that records which should not use 
Document Versioning do not have the field enabled 
when they are created (see the section 
on Workflow Rules below.)

To enable/disable Document Versioning for 
specific Agreement records, see To add the Version 
Aware field to Agreement Layouts.
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# Property Description

3 Use Agreement Locks for 
Versioning

Check this box to use Agreement locks for 
versioning instead of document-level locking:

If enabled, all agreement documents are 
locked (by the user checking out) when any 
one of them is checked out. 
If disabled, only checked out documents are 
locked (by the user checking out)–any other 
agreement documents which have not yet 
been checked out can be checked out for 
editing.

4 Document Naming Convention Specify a value to apply a custom naming 
convention for all agreement documents at 
generation, check-in and signature events.

The following attributes permitted when 
formulating a document naming convention are:

%checkintype%
%action%
%templatename%
%user%
%timestamp%
%version%
Agreement attributes such as %:Name%. 
Note: any variable prefixed by ':' represents 
a field on the Agreement object.

If the property contains a null value (i.e., if left 
blank), the current default naming convention will 
be used: 
%:Name%_%action%_%templatename%_%times 
tamp%

Example agreement document name using the 
default naming convention: 
SOW_Regenerated_SOW ABC_2015-08-07
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# Property Description

5 Document Structure FX2 For 
Imported Docs

Check this box to make document structure FX2 
format for all Offline documents (created or 
imported). If not checked, all offline documents are 
created in the "pre-existing" format.

To add document version in document naming 
convention
You can append the document version to the document name by leveraging the 
 %version% attribute of the document naming convention property. To configure this:

Navigate to Setup> Develop> Custom Settings> and click Manage link next to 
Comply System Properties.
Click Edit.
Configure the document naming convention field value as: 
%:Name%_%templatename%_%timestamp%_%version% 
Click Save.

An example agreement document name using above setting would be: Apttus 
NDA_NDA_2017-05-14_1.0.0. Here the '1.0.0' appended at the end refers to the document 
version.

This property only applies to Offline 
agreements created from the Agreement 
or user Home page links in Salesforce. The 
format of Offline agreements created 
using X-Author for Contracts will still 
depend on user-input from X-Author.



If you have configured %version% attribute in the Document Naming Convention 
property but the Enable Document Versioning property is disabled, the agreement 
document name shall contain an empty string in place of the version attribute.
For example- If you have configured Document Naming Convention field as 
%:Name%_%templatename%_%timestamp%_%version%, but you have disabled 
Enable Document Versioning property, the generated sample agreement name shall 
be Apttus NDA_NDA_2017-05-14.
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To add Version-Related Merge Event Actions
For Document Versioning to work properly, the picklist values for the Merge Event Action 
must be updated.

Navigate to Setup > Create > Objects > Merge Event.
Go to the Action Custom Field.
Add the following two values to the picklist: 

Check Out
Revert Check Out

After adding values, your Merge Action picklist should appear as shown in the 
following image:

 

To add the Document Version Related List to 
Agreement Layouts
To view Document Version details for your agreement documents, the Document 
Version Related List must be added to your Agreement Page Layouts. To add the Related 

To trim the third decimal and number from the document version attribute in the 
Document Naming Convention property, select Trim Document Version checkbox in 
Document Version Properties. For more details on Trim Document Version, refer to 
Document Version Properties.
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List to your page layouts, refer to Salesforce documentation for Edit Page Layouts for 
Custom Objects.

To add the Version Aware field to Agreement Layouts
The Version Aware field is a flag that tells Conga CLM if a specific record is using 
Document Versioning. When the Comply System Property Enable Document Versioning is 
enabled, the value of the Version Aware field is set to TRUE for all new agreements org- 
wide at the time of record creation. You can add the Version Aware flag to your Agreement 
layouts as a field which allows agreement editors to turn Document Versioning on or off for 
a specific agreement record.

Important Note: It is recommended that once a record is flagged as Version Aware, you do 
not disable this field, as versioning will become undefined for the agreement record in 
question. Instead, ensure that records which should not use Document Versioning do not 
have the field enabled when they are created (see the section on Workflow Rules below.)

To add this field to your custom Agreement layout, refer to Salesforce documentation for 
 Edit Page Layouts for Custom Objects.

To make Agreements Version Aware using Workflow 
Rules
You can create one or more Workflow Rules to set the Version Aware flag value in certain 
records based on the value of other record fields.

Create a new Workflow Rule for Document Versioning. See the section on Managing 
Workflow for assistance with setting up a Workflow Rule in Salesforce.
Specify your Workflow Rule Action as a "Field Update" (the rule will update the 
Version Aware field).
Use Apttus__APTS_Agreement__c.Apttus__VersionAware__c as the field value in your 
rule.

The Document Version Related List is included in the default Agreement Layout 
included with the Apttus Contract Management package.



The Version Aware field is included in the default Agreement Layout included with 
the Apttus Contract Management package. 



https://help.salesforce.com/HTViewHelpDoc?id=accessing_layout_custom.htm&language=en_US
https://help.salesforce.com/HTViewHelpDoc?id=accessing_layout_custom.htm&language=en_US
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Example: Enable Version Aware Field for all Statement 
of Work (SOW) Agreements
Scenario: Your organization has decided not to enable Contract Document Versioning 
globally. However, you do want all new SOW agreements to be Version Aware.

Solution:  Create a new Workflow Rule as detailed above.

Define your criteria as "Agreement: Record Type equals SOW." 
 

 

 
Specify your Workflow Rule Action to make the Version Aware flag true when the 
criteria are met. 
 

 

 
Validate your rule. When you create a new SOW, the Version Aware field should be 
checked.
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Example: Disable Version Aware Field for Renewal of 
Non-Version Aware Agreements
Scenario: Your organization has decided to enable Contract Document Versioning globally. 
As versioning will only apply to new agreements going forward, you have many 
agreements that are not Version Aware. By default, when an agreement is renewed and 
Document Versioning is enabled, the renewed agreement is automatically made Version 
Aware. You would prefer non-Version Aware documents remain non-Version Aware upon 
renewal.

Solution:  Create a new Workflow Rule as detailed above.

 

Define your criteria as "Agreement: Version Number GREATER than 0." 
 

 

 
Specify your Workflow Rule Action to make the Version Aware flag false when the 
criteria are met. 
 

 

 
Validate your rule. When you renew an agreement, the Version Aware field should 
NOT be checked. 
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Configuring Document Finder
Document Finder helps your contract managers, salespersons and legal teams to easily 
filter and find agreement documents directly from an agreement record. Follow the 
instructions on this page to set up Document Finder for use with your agreements.

Enable Contract Document Versioning
To use keywords/tags defined in your org or created from check-in actions in X-Author 
Contracts requires Contract Document Versioning be enabled. When you are working with 
version aware records, you can take full advantage of search by keywords/tags and by 
document versions. 

To learn how to enable Contract Document Versioning, refer to Enabling Contract 
Document Versioning.

Add Document Finder Visualforce Page to User Profiles
To grant Document Finder access to a user, you must add the Visualforce Page to the list of 
Enabled Visualforce Pages on their corresponding User Profile.

Go to Setup > Administer > Manage Users > Profiles.
Click on the Profile corresponding to the user who needs access.
Click Edit under Enabled Visualforce Page Access.
Add Apttus.DocumentFinder to the list of Enabled Visualforce Pages.
Click Save.

Add Document Finder to the Agreement Layout
As Document Finder is a custom Visualforce page, it must be added to the Agreement 
layout inside of a section.

Go to Setup > Create > Objects > Agreements.
Hover over Page Layouts and click Edit next to the layout you want to modify. In this 
example, consider modifying the Agreement layout page for the SOW record type.

You can do this more quickly for multiple profiles by going to Setup > Build > 
Develop > Visualforce Pages and changing the Security for the Document Finder 
Visualforce page.
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Click-and-drag the Section field to the area below the Actions section of the 
Agreement Layout.
Enter "Document Finder" as the Section Name and choose a 1-Column layout. 
Click OK. The Document Finder section is created.
From the Layout Designer menu, choose Visualforce Pages.
Click-and-drag the Document Finder Visualforce Page onto the section you just 
created.
Click Save to save the Agreement page layout.
Repeat these steps for all Agreement layouts that will use Document Finder.

(Optional) Configure Default Tags
You can configure the Comply System Property Default Document Tags to define a set of 
comma-separated tags which will be automatically available to users who perform a 
search in Document Finder. X-author users can also choose from the same set of tags at 
document check-in, applying any of these default tags to an agreement document as part 
of the check-in process.

To configure the Default Document Tags system property:

Go to Setup > Develop > Custom Settings.
Click Manage next to Comply System Settings.
Click Edit next to System Properties.
Enter your desired default tags as comma-separated values for the Default 
Document Tags system property.
Click Save to update the system with your default tags. Now, when you place your 
cursor into the Document Name/Keywords search in Document Finder, you can choose 
from a list of default tags defined by the property. 
X-Author users can also make use of these tags during check-in. For more information, 
see X-Author for Contracts documentation.

Retention Policies
A retention policy determines the length of time a record must be stored. Generally, 
organizations will apply retention policies to all records sharing certain characteristics. 
These characteristics can include but are not limited to, record type, region, and owner.

The following sections describe how to create Retention Policies for your agreement records 
and how to configure record purges based on your business needs:

Retention Policies

https://documentation.conga.com/x-author-for-contracts/latest/x-author-for-contracts-154927679.html
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The Retention Policy object contains the policy details. The policy specifications are 
contained in an XML format and maintained using a Visualforce page. The policy header 
information is maintained using a standard Salesforce page. For details on the Retention 
Policy XML schema, refer Retention Policy Schema.

Retention Date

The retention date calculation is done periodically using a batch apex class. The batch 
apex sequences through all the active retention policies, select applicable business objects 
using the filters, compute the retention date and update the object.

Record Retention Authorized Users

You can use the RecordRetentionUsers public group to identify the users who are recipients 
of the purge notification report and authorized to selectively purge records.

Purge Notification

You can schedule a report to run periodically to identify records eligible for purging. The 
retention date field in the agreement provides the selection criteria. A sample report is 
provided which can use be used as the basis for creating the report.

Purge Agreements

The Purge Agreements Visualforce page allows the authorized user to search records 
eligible to be purged based on the retention date combined with other filter criteria. It also 
provides a scrollable record set to view.

Creating Retention Policies
The Retention Policy object contains the policy details. The policy specifications are 
contained in an XML format and maintained using a Visualforce page. The policy header 
information is maintained using a standard Salesforce page. For details on the Retention 
Policy XML schema, refer to Retention Policy Schema.

A Retention Policy contains several fields (see table), which store information about the 
policy specifications to support agreements and business objects.

Field Name Description Values/Notes

Policy Name Policy name Required – user entered

Description Description of the policy Optional
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Field Name Description Values/Notes

Business Object Indicates the business object 
governed by the policy

Required – 
Apttus__APTS_Agreement__c

Policy Spec The policy specification Maintained by a VF page

Sequence The policy sequence Required

Active Indicates whether the policy is 
active

Inactive policies are ignored. This is 
selected by default

 
The policy specification is maintained using a Visualforce page. The policy header fields 
such as Name, Description, Sequence, Active indicator and so on, can be maintained using a 
standard Salesforce page.

To create a retention policy
User Permissions Needed

To create and edit retention policies: Retention Policy: Create, Edit.

Agreement: Edit.

Click Retention Policies > New.
Enter details in one or more required fields and click Save. Optionally, you can click 
Save & New to save and create a new retention policy.

Name: Policy for NDA, CDA contracts
Sequence: 2
Business Object: APTS_Agreement__c

A retention policy is created and added to the Recent Retention Policies list.

To edit a retention policy
A retention policy must have been already created.

Click Retention Policies and select the policy which you need to edit by clicking on the 
policy name link.
To edit the retention policy specifications, click Edit Spec in the policy detail page to 
open the Edit Policy Specification page.
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In the Filter section, select the following options. 
From the Field dropdown, select a field, select an operator, and enter a value 
for the field.
(Optional) If required, add more filters.
(Optional) Click Add Row to add more rows.
Click Advanced Options to add advanced filter conditions. 
For example, (1 OR 2) AND 3 AND NOT 4.

In the Rule section, select the following options.
Select the Retain Forever checkbox to retain the agreements matching the filter 
criteria forever. When you select the checkbox other options in the Rule section 
are not visible.
In the Period field, enter the number of years. You can also select Days or 
Months according to your requirement.
In the After Date dropdown, select a date after which the retention period 
starts.

Click Ok. 
 

 

Note

The RetentionPolicyEdit Visualforce page enables the filter creation and a rule 
according to the Retention Policy Schema.
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Calculating Retention Date
The retention date calculation is done periodically using a batch apex class. The batch 
apex sequences through all the active retention policies, select applicable business objects 
using the filters, compute the retention date and update the object.

An activity history record is written to the agreement with the policy information. The 
process terminates on two conditions- when either there are no more business objects to 
process, or all the policies have been applied. The process is scheduled using the 
RetentionDateCalcJobScheduler Apex scheduler class. Due to governor limits, each policy 
processes a maximum of 5000 records during each invocation.

To calculate a retention date
A Retention Policy must have been created.

Click Setup > Develop > Apex Classes > Schedule Apex.
Enter the following information to configure the job parameters.

Job Name: Retention Calc Job
Apex Class: RetentionDateCalcJobScheduler
Frequency: Specify how often the Apex class is to run: 
For Weekly—specify one or more days of the week the job is to run (such as 
Monday and Wednesday). 
For Monthly—specify either the date the job is to run or the day (such as the 
second Saturday of every month.)

Specify the start and end dates for the Apex scheduled class. If you specify a single 
day, the job only runs once.
Specify a preferred start time. The exact time the job starts depends on service 
availability.
Click Save.

After you have done the job of calculating a retention date, you can monitor the progress 
of the job on the All Scheduled Jobs page.

Once the job has completed, you can see specifics about the job (such as whether it passed 
or failed, how long it took to process, the number of records process, and so on) on the Apex 
Jobs page.

https://help.salesforce.com/HTViewHelpDoc?id=data_monitoring_jobs.htm
https://help.salesforce.com/HTViewHelpDoc?id=code_apex_job.htm
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Recording Retention Authorized Users
You can use the RecordRetentionUsers public group to identify the users who are recipients 
of the purge notification report and authorized to selectively purge records.

Sending Purge Notification
You can schedule a report to run periodically to identify records eligible for purging. The 
retention date field in the agreement provides the selection criteria. A sample report is 
provided which can use be used as the basis for creating the report.

The report can be emailed to Record Retention Authorized Users to allow them to 
selectively purge records.

User Permissions Needed to Build a Report

To create, edit, and delete reports Create and Customize Reports

 AND

 Report Builder

To send purge notification, perform the following:
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2.
3.
4.

1.
2.
3.
4.

5.

6.

7.
8.

9.

10.

Create a public folder to hold the purge notification report
Create a new report using the report builder
Edit report properties and save the report
Schedule the report and send notification

Creating a Public Folder
User Permissions Needed

To create, edit, or delete public document folders: “Manage Public Documents”

To create, edit, and delete public email template 
folders:

“Manage Public Templates”

To create, edit, and delete public report folders: “Manage Public Reports”

To create, edit, and delete public dashboard 
folders:

“Manage Dashboards” AND “View All Data”

Go to the Reports tab.
Click New Report Folder.
Enter a Report Folder Label. For example, Record Retention Report.
The Folder Unique Name is entered automatically when you type the folder label. If 
you have the Customize Application permission, enter a unique name to be used by 
the API and managed packages.
Choose a Public Folder Access option. Select read/write if you want users to be able 
to change the folder contents. A read-only folder can be visible to users but they 
cannot change its contents.
Select an unfiled report, dashboard, or template and click Add to store it in the new 
folder. Skip this step for document folders.
Choose a folder visibility option.
Choose Public Groups from the Search drop-down list.

If the Available for Sharing list does not immediately display the desired value, enter 
search criteria and click Find.
Select the desired value from the Available for Sharing list and click Add to move the 
value to the Shared To list.

Note

When you share a folder with a group, managers of the group members have 
no access to the folder unless those managers are also members of the group.
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1.
2.
3.

1.
2.
3.

1.
2.

3.

4.

Click Save. 
A folder is created. You can create a new report using Report Builder.

Creating a New Report Using the Report Builder
On the Reports tab, select the report type and click Create.
Enter the Filters and Fields.
Add, reorder, and remove columns, summary fields, formulas, groupings, and blocks to 
customize and preview your report. Change the report format and display options, or 
add a chart. The preview shows only a limited number of records. Run the report to 
see all your results. 
You have created report fields and filters, and previewed your report with some of the 
data. You can edit report properties.

Editing Report Properties
On the Reports tab, select the report and click Edit.
Click the Report Properties tab.
Edit the report properties and click Save. 
A report is edited and saved. You can also schedule the report.

Scheduling a Report
You must have the Schedule Reports permission to schedule reports.

On the Reports tab, click an existing report name.
From the Run Report drop-down, click Schedule Future Runs. If you’re creating a new 
report, you are asked to save the report with a name and in a folder before 
scheduling.
On the Schedule Report page, specify a Running User who has access to the folder 
where the report is stored. 
If the running user becomes inactive, the report is not run. The system administrator 
receives an email notification to either activate the user, delete the report schedule, 
or change the running user to an active one in the scheduled report. 
The access level of the running user determines what other users, including portal 
users, see when they receive the scheduled report run results. You need the “View All 
Data” permission to specify a running user other than yourself.
Select an email setting:
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6.

Select To

To me Send the report to your email address specified on 
your user profile.

To me and/or others Email the report to additional users.

 
You can send reports only to email addresses included on Salesforce user records. 
When portal users receive emailed reports, they see the same data as the running 
user set in the report schedule. If you have the information you’d rather not share, 
schedule the report to run with a portal user as the running user.

Set the frequency, duration, and time for running the report.
In the Frequency field, select Daily, Weekly, or Monthly and then refine the 
frequency criteria.
Using the Start and End fields, specify the dates during which you want to 
schedule the report. To enter the current date, click the link showing the date.
Next to Preferred Start Time, click Find available options to choose a start time.

Your preferred start time might not be available if other users have already selected 
that time to schedule a report.
Click Save Report Schedule. You can choose the following:

Choose To

Save report modifications with this 
schedule

Save both the report schedule and changes you 
made to the report.

Discard report modifications Save the schedule only. Changes you made to 
the report are discarded.

 
Report recipients can click the report name in emailed reports to log in to Salesforce 
and view the report directly.

A report is scheduled to run every Friday at midnight, and its results are emailed to a 
selected group and user.

Note

Portal users receive report and dashboard refresh email notifications when the 
Allow Reports and Dashboards to Be Sent to Portal Users option is enabled.
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4.
5.

All users, including portal users, viewing the scheduled report see the report data that 
Running User’s access level allows.
Report run results are set to be emailed to a public user group called All Internal 
Users and the admin user.
The report is scheduled to run every Friday.
The report run is scheduled to start on the current date.
The schedule is saved without saving prior changes made to the report.

About Purge Agreements
The Purge Agreements Visualforce page allows the authorized user to search records 
eligible to be purged based on the retention date combined with other filter criteria. It also 
provides a scrollable record set to view. To access the page, click + and select Purge 
Agreements.

Retention Policy Schema
An XML schema describing the policy specification is provided as a static resource named 
RetentionPolicySchema.

The policy specification contains filters and retention rules. The filters are used to constrain 
the set of agreements to which the policy applies. The retention rule specifies how to 
compute the retention date based on existing date fields in the agreement. The sequence 
field may be used to establish the order in which the policies should be applied. Here is the 
schema for the retention policy:

 

 

<-- Description:1
    Defines schema RetentionPolicy2
-->3
<xs:schema xmlns:xs="http://www.w3.org/2001/XMLSchema" elementFormDefault=" 

unqualified" attributeFormDefault="unqualified">

4

    <xs:element name="RetentionPolicy" type="RetentionPolicyType">5
        <xs:annotation>6
            <xs:documentation>Retention Policy</xs:documentation>7
        </xs:annotation>8
    </xs:element>9
    <!-- retention policy -->10
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    <xs:complexType name="RetentionPolicyType">11
        <xs:sequence>12
            <xs:element name="Filter" type="FilterType" minOccurs="0">13
                <xs:annotation>14
                    <xs:documentation>The record filter</xs:documentation>15
                </xs:annotation>16
            </xs:element>17
            <xs:element name="Rule" type="RuleType" minOccurs="0">18
                <xs:annotation>19
                    <xs:documentation>The retention rule</ 

xs:documentation>

20

                </xs:annotation>21
            </xs:element>22
        </xs:sequence>23
    </xs:complexType>24
    <!-- filter -->25
    <xs:complexType name="FilterType">26
        <xs:sequence>27
            <xs:element name="Predicates" type="PredicateCollType">28
                <xs:annotation>29
                    <xs:documentation>The filter predicates</ 

xs:documentation>

30

                </xs:annotation>31
            </xs:element>32
            <xs:element name="ConditionExpr" type="xs:string">33
                <xs:annotation>34
                    <xs:documentation>The filter expression</ 

xs:documentation>

35

                </xs:annotation>36
            </xs:element>37
        </xs:sequence>38
    </xs:complexType>39
    <!-- rule type -->40
    <xs:complexType name="RuleType">41
        <xs:sequence>42
            <xs:element name="RetainForever" type="xs:boolean">43
                <xs:annotation>44
                    <xs:documentation>Retain forever indicator</ 

xs:documentation>

45

                </xs:annotation>46
            </xs:element>47
            <xs:element name="RetainFor" type="RetainForType" minOccurs="0 

">

48

                <xs:annotation>49
                    <xs:documentation>Retain for</xs:documentation>50
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                </xs:annotation>51
            </xs:element>52
        </xs:sequence>53
    </xs:complexType>54
    <!-- retain for -->55
    <xs:complexType name="RetainForType">56
        <xs:sequence>57
            <xs:element name="Period" type="RetentionPeriodType">58
                <xs:annotation>59
                    <xs:documentation>The retention period</ 

xs:documentation>

60

                </xs:annotation>61
            </xs:element>62
            <xs:element name="AfterDate" type="AfterDateType">63
                <xs:annotation>64
                    <xs:documentation>The after date</xs:documentation>65
                </xs:annotation>66
            </xs:element>67
        </xs:sequence>68
    </xs:complexType>69
    <!-- retention period -->70
    <xs:complexType name="RetentionPeriodType">71
        <xs:simpleContent>72
            <xs:extension base="xs:nonNegativeInteger">73
                <xs:attribute name="uom" type="PeriodUOMType">74
                    <xs:annotation>75
                        <xs:documentation>Retention period</ 

xs:documentation>

76

                    </xs:annotation>77
                </xs:attribute>78
            </xs:extension>79
        </xs:simpleContent>80
    </xs:complexType>81
    <!-- after date -->82
    <xs:complexType name="AfterDateType">83
        <xs:sequence>84
            <xs:element name="FieldName" type="xs:string">85
                <xs:annotation>86
                    <xs:documentation>Field name</xs:documentation>87
                </xs:annotation>88
            </xs:element>89
            <xs:element name="FieldLabel" type="xs:string">90
                <xs:annotation>91
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                    <xs:documentation>Field label</xs:documentation>92
                </xs:annotation>93
            </xs:element>94
        </xs:sequence>95
    </xs:complexType>96
    <!-- predicate collection -->97
    <xs:complexType name="PredicateCollType">98
        <xs:sequence>99
            <xs:element name="Predicate" type="PredicateType" maxOccurs="u 

nbounded">

100

                <xs:annotation>101
                    <xs:documentation>The predicate</xs:documentation>102
                </xs:annotation>103
            </xs:element>104
        </xs:sequence>105
    </xs:complexType>106
    <!-- predicate -->107
    <xs:complexType name="PredicateType">108
        <xs:sequence>109
            <xs:element name="RowNum" type="xs:positiveInteger">110
                <xs:annotation>111
                    <xs:documentation>Row number</xs:documentation>112
                </xs:annotation>113
            </xs:element>114
            <xs:element name="FieldName" type="xs:string">115
                <xs:annotation>116
                    <xs:documentation>Field name</xs:documentation>117
                </xs:annotation>118
            </xs:element>119
            <xs:element name="FieldLabel" type="xs:string">120
                <xs:annotation>121
                    <xs:documentation>Field label</xs:documentation>122
                </xs:annotation>123
            </xs:element>124
            <xs:element name="FieldType" type="xs:string">125
                <xs:annotation>126
                    <xs:documentation>Field type</xs:documentation>127
                </xs:annotation>128
            </xs:element>129
            <xs:element name="CompOper" type="xs:string">130
                <xs:annotation>131
                    <xs:documentation>Comparison operator</ 

xs:documentation>

132

                </xs:annotation>133
            </xs:element>134
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Contract Wizard
Use the Contract Wizard to design and deploy custom user-friendly Wizards based on 
Accounts, Opportunities, Quotes/Proposals, Agreements and other custom Salesforce 
objects. These Wizards are intended to be used by your sales representatives, purchasing 
agents, HR managers and other users to quickly create their own records by entering 
responses to criteria-based inputs that follow a logical series of steps.  Wizards can also 
be used to collect data from customers to be posted to internal systems or for other 
business use.

As an administrator, the wizards you create are stored as Wizard Designs. Wizard Designs 
are comprised of a series of Inputs and Steps, governed by rules that determine the flow 
and resultant values of the Wizard.

The Contract Wizard is comprised of three tabs:

Wizard Designs – Use this tab to create new Wizard designs or edit existing Wizard 
designs. You assemble Wizards using the Wizard Designer tool, adding Inputs and 
Steps from the Wizard Component Library or creating instances for use with specific 
designs. You can design rules for your Inputs based on criteria or values from other 

            <xs:element name="FieldValue" type="xs:string">135
                <xs:annotation>136
                    <xs:documentation>Field value</xs:documentation>137
                </xs:annotation>138
            </xs:element>139
            <xs:element name="BoolOper" type="xs:string">140
                <xs:annotation>141
                    <xs:documentation>Boolean operator</xs:documentation>142
                </xs:annotation>143
            </xs:element>144
        </xs:sequence>145
    </xs:complexType>146
    <!-- period uom -->147
    <xs:simpleType name="PeriodUOMType">148
        <xs:restriction base="xs:string">149
            <xs:enumeration value="Days"/>150
            <xs:enumeration value="Months"/>151
            <xs:enumeration value="Years"/>152
        </xs:restriction>153
    </xs:simpleType>154
</xs:schema>155
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Inputs, configure the flow for your Steps by creating and organizing Wizard Steps 
rules, and preview Steps and Inputs as needed while finalizing the Wizard Design. 
When you are finished with a design, you can activate it for use from the Wizards tab. 
 

 

 
Wizard Component Library – Use this tab to create reusable Inputs and Steps for 
your Wizard Designs. Separate, searchable libraries for both Inputs and Steps can be 
created and maintained. Metadata on Inputs and Steps in the library allow you to 
categorize and keep track of when Inputs and Steps are created or modified. 
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Wizards – Use this tab to run Wizards created from the Wizard Designer. Your end- 
users will be able to easily search and select from Wizard designs to create well- 
formed records. Wizards are presented to users in a questionnaire style, allowing 
them to view and preview their progress with sidebar navigation and a review 
summary, returning to previous Inputs and Steps to make changes or corrections. 
Users can also use the tab to resume completion of in-progress Wizards or review 
completed or aborted Wizards. 
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Getting Started with the Wizard Designer
A Wizard Design can be as complex or simple as required, allowing your users to create a 
basic records or populate second and third-level items conditionally based on input or step 
rules. 

A Wizard Design is comprised of the following key components:

Inputs – Input are the primary wizard component of any wizard. They are the 
questions and instructions that you provide to the end users of the wizard at runtime. 
The values received from the end user are stored as Inputs. For example, you might 
create an input that requires users to select options from a picklist, such as a Business 
Function or Agreement Start and End dates. Inputs are reusable, so you can use them 
in as many steps as you want to.
Steps – Inputs are placed in Steps in the desired sequence for runtime use. Steps will 
also contain rules which are used to designate the navigation flow, the object and 
submission actions, which are determined and executed based on the end user 
responses at runtime.
Step Input Rules – These rules allow you to configure rules and expressions for your 
Inputs at Wizard runtime. Input rule types can be configured to enable/disable or 
show/hide Inputs, or to conditionally determine the focus object of the Wizard (e.g., 
Agreement) or conditionally determine the record type for the focus object's record to 
be created (e.g., SOW, NDA, MSA, etc.), or to set the value of one input based on the 
value of other inputs.
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Wizard Step Rules – These rules control the flow of Wizard steps at runtime. You can 
create "GoTo" rules for your steps which determine step order in the Wizard based on 
runtime user responses. The rules you create can be assigned as default for individual 
steps and can be made conditional based on expressions you create for each rule, 
using values from Inputs to determine whether or not rules are fired for any given step.

The following sections describe the Wizard design process, from initial settings to input and 
steps, including guidance on how to create your own Inputs and Steps during design and 
how to use and maintain the Wizard Component Library. The Agreement object is used as 
the focus object in most Wizard examples, but the same instructions can be used to create 
a Wizard based on Account, Opportunity or any custom Salesforce object.

Creating a New Wizard Design
The following sections describe the Wizard Design process. The process is comprised of 
several steps:

Configure Wizard Settings and Add Steps
Create Steps for the Wizard (optional)
Configure Step Input Rules
Configure Wizard Design Step Rules
Activate the Wizard

Configuring Wizard Settings
The first step in designing a Wizard is to define the basic settings for your Wizard, including 
the name, description and other search properties, as well as the Context (for one Object or 
All Objects) and the Start Step.

In this step you also define the Static Resource location and CSS file for any branding and/ 
or banner logo you want to add to your Wizard (see the table below). For information on 
how to add static resources to your Salesforce org, refer to Salesforce documentation on 
 Using Static Resources. Any Static Resource used with the Contract Wizard must contain 
all files in an application/zip format.

Hint: Click an image on this page to enlarge the view.

https://developer.salesforce.com/docs/atlas.en-us.pages.meta/pages/pages_resources.htm
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1.

2.

3.

4.

To configure Wizard Settings
From the Salesforce application menu, choose Apttus Contract Wizard. The 
application displays the Home tab and three tabs unique to the Contract Wizard: 
Wizards, Wizard Designs and Wizard Component Library.
Navigate to the Wizard Designs tab (click + and add the tab if it does not already 
exist).
 Click New Wizard Design to open a new Wizard Design form displaying fields for 
Wizard Settings. 
 

 

 
Enter the following search properties into the form:

Setting Description

Design Name Enter a name for your Wizard Design. This name can be 
internal but is used in the runtime banner for the Wizard 
steps when the user is interacting with the Wizard if Banner 
Statement (below) is not defined. Note: You cannot add any 
steps to your Wizard Design until you choose a Design 
Name.

Banner Statement Enter a Banner Statement to display at Wizard runtime 
when the user is interacting with the Wizard. If left blank, 
the Wizard Design Name will be used instead.
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Setting Description

Description Enter a description for your Wizard Design which describes 
its intended use (for example, "Use this Wizard to create 
MSA Agreements for Acme.")

Keywords Enter a list of keywords which can be used to search for this 
Wizard Design.

Category Choose an option from a drop-down list of pre-defined 
Wizard Categories (define picklist values on the Wizard 
Design object).

Sub Category Choose an option from a drop-down list of pre-defined 
Wizard Sub Categories (define picklist values on the Wizard 
Design object).

Context Type Define whether your Wizard Design context will apply to All 
objects or a specific Object.

Context Object Choose the specific context Object for your Wizard. This 
option is only available if you specified "Object" for Context 
Type. (e.g., "Agreement")

Static Resource Name Enter the static resource name where your banner logo 
(must be named "logo.png"), foreground images (for 
branding of any steps) and your CSS file reside. Banner 
height is 50 pixels. The CSS file you provide can override any 
style present in the runtime wizard–the margin-left of the 
Title/Breadcrumbs in the banner can be modified to allow 
for more breathing room from where the logo is placed. How 
to create your static resource:  
 
1) Place all images and .css files inside a single folder and 
compress them into a ZIP.  
2) Go to Salesforce Setup and enter "Static Resources" into 
the Quick Search box.  
3) Create a new Public Static Resource and upload the ZIP 
file.



CLM

467
 

Copyright ©2022 Apttus Corporation. All rights reserved.
 

5.

6.
•

•
•

7.

Setting Description

CSS File Name The name of the CSS file located in the static resource (e.g., 
"style.css").

DataSource Callback Enter the name of the Callback Resource that will store 
values to pre-populate runtime input responses when this 
design is used to create a new Wizard. This resource holds 
the implementation class name for the callback interface. 
The interface contains a getData() method and returns a 
JSON string to pre-populate fields in the Wizard.

Allow Review Edit Select this checkbox to enable the Wizard runtime user to 
edit steps during the Wizard review prior to submission.

Drag-and-drop a step from the Steps Library to the Steps in Wizard pane. If you do 
not see your Step listed, use the type-ahead feature in the Search box to locate the 
step you want to use.

You can take the following actions on steps you have added:
Hover over a step in the list and click Edit to edit the step settings and inputs 
for this wizard design only.
Hover over a step in the list and click Delete to remove a step from the Wizard.
Click and drag steps in the Steps in Wizard pane to reorder them. If you have a 
more complex flow to your wizard, click on Wizard Step Rules to configure 
condition-based rules for your steps (see Configuring Wizard Step Rules).

Add more steps from the Step Library as described in the general sequence you want 
them to appear in the Wizard. 

When you determine a specific Context Object for a Wizard Design, the 
available steps listed in the Steps Library to the right of the form will be 
refreshed. Only Steps which match the Object type you selected will be 
displayed for use.



You cannot add steps to a Wizard unless the Design Name has been entered.

The Submit and Abort steps system-provided and are always included 
in every Wizard design and cannot be modified, removed or reordered. 
Condition expressions can be defined to go to either step as part of a 
rule.
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9.

1.

If you do not find the correct step in the library and need to create a new one for your 
wizard, see Creating Steps from the Wizard Designer.
Click Save And Exit to save your changes or click Cancel to discard the Wizard and 
return to the Wizard Designs tab. 
 

Creating Steps from the Wizard Designer
Steps are used to designate the actions that occur when end-users use the Wizard. Steps 
use common elements, like actions and rules, to define the flow of your Wizard. Each step 
represents a screen in the wizard runtime.

If the step you want to use in a Wizard design does not exist in the Steps Library, you can 
create one and use it with your Wizard from the Wizard Designer. Steps created in this way 
can be saved for use in the current Wizard design only. 

To create a new Step from a Wizard design
From the Wizard Designer, click on New Step. (Note: Your Wizard design must have a 
Design name before you can create a new step.) 
 

 

 
The Step Settings form is displayed. 
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2.

 

 
Enter the following properties into the form:

Step Setting Description

Step Name Enter a name for your Step. This name can be internal but 
is used in the runtime banner when the user is interacting 
with the Wizard if Banner Statement (below) is not 
defined. Note: You cannot add any inputs to your step until 
you choose a Step Name

Banner Statement Enter a Banner Statement to display at Wizard runtime 
when the user is interacting with the Wizard. If left blank, 
the Step Name will be used instead.

Description Enter a description for your step which describes its 
intended use (for example, "Define business details in this 
step.")

Keywords Enter a list of keywords which can be used to search for 
this step.

Category Choose an option from a drop-down list of pre-defined 
Step Categories (define picklist values on the Wizard Step 
object).
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Step Setting Description

Sub Category Choose an option from a drop-down list of pre-defined 
Step Sub Categories (define picklist values on the Wizard 
Step object).

Runtime Help Text Enter text to display when the user clicks the help icon at 
the top of the Step page.

Context Type Define whether your Step will apply to All objects or a 
specific Object.

Context Object Choose the specific context Object for your Step. This 
option is only available if you specified "Object" for 
Context Type. (e.g., "Agreement")

Input Group Option Select an option from the drop-down list to choose how 
Inputs will be displayed in the Step (as groups):

None – Select this option to display all Inputs for the step 
in the sequence listed in the Inputs pane.

Repeatable – Select this option to allow the end-user to 
add multiple records for selected Inputs in list format. User 
can click the Add Item button to add additional values for 
the same group of Inputs (e.g., multiple Addresses).

Table Layout – Select this option to allow the end-user to 
add multiple records for selected inputs in tabular format. 
User can click the Add Item button to add additional 
values for the same group of Inputs (e.g. Agreement Line 
Item Products, Quantity, List Price, etc.)

Two Column Layout – Select this option to display 
selected inputs to the end-user in two columns.

The Two Column Layout is only available in the 
Salesforce Lightning mode. You need to configure 
the Two Column Layout option. For more 
information, see Configuring Two Column Layout.
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5.

6.

7.

Step Setting Description

Image Filename Filename of the image located in the Static Resource 
(defined in Wizard Settings) to display in this step to the 
right of the input controls. For information on setting up 
the Static Resource, refer to Configuring Wizard Settings.

Note: You can only add images to steps created within a 
specific Wizard design. You cannot add images to steps 
created from the Component Library.

Drag-and-drop an Input from the Inputs Library to the Inputs pane. If you do not see 
your Input listed, use the type-ahead feature in the Search box to locate the Input you 
want to use.

You can take the following actions on Inputs you have added:
Add more inputs from the Inputs Library in the sequence you want them to appear in 
the step.

Hover over an Input in the list and click Edit to edit the input settings for this 
step only.
Hover over an Input in the list and click Delete to remove an Input from the step.
Click and drag Inputs in the Inputs pane to reorder them.

If you do not find the correct input in the library and need to create a new one to use 
in your step, see Creating Inputs from the Wizard Designer.
To create rules which govern inputs for the current step, click on Input Rules 
(see Configuring Step Input Rules from the Wizard Designer).
Click Save And Use in Wizard to save your changes or click Cancel to discard 
changes and return to the Wizard Design form.

Creating Inputs from the Wizard Designer
Input controls are the primary components of any wizard. They are the questions and 
instructions that you provide to the end users of your wizard. For example, you might create 
an input control that requires users to select picklist options, such as Business Function or 
Agreement Start and End dates. Input controls are reusable, so you can use them in as 
many steps as you want to.

If an Input you want to use in a step does not exist in the Inputs Library, you can create one 
and use it with your step. Inputs created in this way can be saved for use in the current 
Wizard design only.

You cannot add inputs to a step unless the Step Name has been entered.
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To create a new Input from a Step
From the Step Settings form, click New Input. 
 

 

 
The Input Settings page is displayed. 
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2. Enter the following properties into the form:

Input Setting Description

Control Name Enter a name for your Input.

Question/Instruction Enter a question or instruction which the end user will see in 
the runtime wizard.

Description Enter a description for the input which describes its intended 
use (for example, "Use this Wizard to create MSA Agreements 
for Acme."

Keywords Enter a list of keywords which can be used to search for this 
Input.

Category Choose an option from a drop-down list of pre-defined Input 
Categories (define picklist values on the Wizard Input 
Control object).

Sub Category Choose an option from a drop-down list of pre-defined Input 
Sub Categories (define picklist values on the Wizard Input 
Control object).

Runtime Help Text Enter text to display when the user hovers over the help icon 
next to the question/instruction.

Runtime Input Determine how the end user can interact with this Input at 
wizard runtime:
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Input Setting Description

 Allow Comments and Attachments – Select this check box to 
enable the end user to add comments and/or attachments in 
addition to the input control value. Comments are entered 
into a text area field and are limited to 500 characters. 
There is no limit to the number of files a user can attach. For 
an example of how this looks in the Wizard, see Running 
Wizards.

Required – Select this check box if a value is required for the 
input. An end user will not be able to complete the current 
step without entering a value for this input.

Read Only – Select this check box if you plan to have the 
input value set by Step Input rules in all cases. The end user 
will not be able to change the value of this input.

How Comments and Attachments are used in the 
Wizard
For any type of Wizard, all runtime comments and 
attachments are saved in the Wizard Runtime Input 
instance record under Notes & Attachments. You can 
make use of these comments and attachments 
through your own implementations.
If you design a Wizard to create a record, comments 
and attachments are copied to the Notes & 
Attachments list only if the corresponding input uses 
an Object for the same object created by the record 
(e.g., Input defined as 'Field Class = Object Field,' 
'Object = Agreement' when the Wizard creates as 
Agreement record). Notes containing comments are 
named after the Object Field for which they were 
entered (e.g., "Account Notes," or "Agreement Risk 
Rating Notes").





CLM

475
 

Copyright ©2022 Apttus Corporation. All rights reserved.
 

•

•
•
•
•
•
•
•
•

•

3.

Input Setting Description

Field Class The Field Class defines the type of response you expect for 
the input.

Wizard Input Field – Use this field class when 
you want the response to indirectly set other 
Wizard values. Wizard input fields values are 
only used to affect the value or state of other 
input controls using Step Input Rules. When you 
choose this field class, you must specify one of 
the following data types:

Checkbox
Date
Number
Picklist
Picklist Radio Button
Multi Picklist
Text
Text Area

If you choose to make the Wizard Input field a 
Picklist type, you must also enter valid values to 
be used as input responses. 
Object Field – Use this field class when you 
want the response to directly set a field value 
on the Salesforce object which is created from 
the Wizard (e.g., the "Agreement Start Date" 
field on the Agreement object). Use the drop- 
down list under Input Control to choose the 
Object Name, then choose the Field Name 
based on the object chosen.

When you are finished creating your Input, click on the Preview tab to show how the 
input will appear at Wizard runtime.  
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Click Input Settings to return to the Input form.
Click Save and Use in Step to save your new Input or Cancel to discard changes and 
return to the Step Settings form. The new Input is added to the list displayed in 
the Inputs pane for your step. 
 

 

 

Configuring Step Input Rules from the Wizard Designer
Step Input Rules allow you to configure rules and expressions for your Inputs at Wizard 
runtime. These rules apply to Inputs which are part of the same step, and generally trigger 
based on user interaction with the Wizard. Input rule types can be configured to:

Enable or Disable Inputs
Show or Hide Inputs
Determine the Focus Object of the Wizard (e.g., Agreement) 
Determine the Record type for the focus object's record to be created (e.g., SOW, NDA, 
MSA, etc.)
Set the value of one input based on the value(s) of other inputs.
Set the value of a custom field based on the value(s) of inputs in the same step. 
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To configure Input Rules for a Step
From the Step Settings form, click on the Input Rules tab. A graphic representation of 
the list of inputs for the step is displayed. 
 

 

 
Inputs are displayed in the sequence you defined in Step Settings. Each input is 
displayed on the page with each input rule listed below the name of the input.  
 
To create a new rule for an input, click on the   icon next to an input name or hover 
over the list of rules and click New. A dialog is displayed for defining the input rule. 
 

 

 
Choose a rule type to use from the Rule drop-down list.  
 

If you are creating a Wizard Design which will create an object record you must 
include at least one Determine Focus Object and one Determine Record Type rule for 
each object to be determined.
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Rule Type Description

Determine Focus Object Use this rule to allow the user to determine the focus 
object for the runtime record to be created (e.g., Agreement 
object). Note: If this rule is used, there must also be a 
Determine Record Type rule used to create a record from 
the Wizard if record types have been defined for the object.  
 
Important: When using this rule, make sure to select the 
Rule Type before the Object to avoid configuration errors.

Determine Record Type Use this rule to allow the user to determine the record type 
for the focus object's record to be created (e.g., SOW, MSA, 
NDA for Agreement). Note: If this rule is used, there must 
also be a Determine Focus Object rule used to create a 
record from the Wizard.

Enable This Control Use this rule to allow the user to edit the field value for 
this input. This is the default setting for an input in a step. 
You can use this as a rule to conditionally enable the input 
if a previous input rule caused it to be disabled.

Disable This Control Use this rule if you want to prevent the user from editing 
this input's value. You can use this rule to conditionally 
make an input read-only.

Show This Control Use this rule to show the field value for this input at 
runtime. This is the default setting for an input in a step. 
You can use this rule to conditionally show the input if a 
previous input rule caused it to be hidden.
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Rule Type Description

Hide This Control Use this rule to hide the field value for this input at 
runtime. You can use this rule conditionally to allow 
different inputs to be exposed within a step based on 
previous responses in the step.

Set This Control Value Use this rule to set the field value for this input based on 
the response values of one or more other inputs in the 
same step.

 

 
 
To make your rule conditional, click Add Another Rule to add a condition to your rule 
type. 
 

Use the drop-down menus to build a condition expression: 
Choose an input from the list of inputs in the current step

When you set APTS_WizardPersistHiddenValue to 
true and you run a wizard containing a field that 
has a combination of Set this control 
value and Hide this control input rules, the field 
value is set in the object you are creating. For more 
information, see Admin Entries.



Note: If you choose not to add conditions to your rule type, the Input rule you 
create will always trigger regardless of other rules in the step.
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Choose an operator for the expression which is specific to the chosen input's 
data type
Choose a value for the expression which defines the condition

 
 

 
Add more conditions as necessary to complete the rule. By default, all expressions use 
AND logic, meaning all conditions are required for the rule to execute. You can use the 
Advanced Expression field to change condition logic to OR, or create your own custom 
condition (for example, (1 OR 2) AND 3 if you want to make only 1 of the first 2 
conditions required). 
 

Click Save to save your new input rule or Cancel to discard rule changes. The step 
inputs graphic changes to reflect the newly-created rule. 
 

There is no limit to the number of conditions you can create for a single input 
rule.
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From the Input Rules tab you can: 

Click the   icon to create another rule for an input.
Click Edit next to an existing input rule to make changes.
Click Delete next to an existing input rule to delete the rule.
Click Step Settings to return to the step and create or add more inputs or save 
the step.

Previewing Wizard Steps from the Wizard Designer
You can preview what a step will look like at runtime from Step Settings. To preview the 
step, click on the Step Preview tab. The page displays a preview of the step you are 
building:

The Step Preview renders a representation of the step in the Wizard at runtime. You can 
interact with the preview to an extent–it does not show or demonstrate any conditional 
input rules you have defined. For example, if you disable a control based on another input's 
value and choose that value, the input in question will not be disabled within the preview.
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You can also preview how the step will look when you choose an Input Group Option. Use 
the drop-down menu in the upper-right-hand corner of the preview page to switch between 
Input Group views. For example, the above preview rendered in a table layout would look 
as follows.

Configuring Two Column Layout
You need to configure the two-column layout to view the two-column layout as an option 
in Input Group Option in Salesforce Lightning. 

To configure the Two Column Layout
Go to Setup > Object Manager > Wizard Step > Fields & Relationships > Input Group 
Option.
In the Values section, click New.
Enter Two Column Layout.
Click Save.

The Step Name will always be proceeded by a # symbol, which is a placeholder for 
the assigned step number at runtime (dependent on the sequence of steps in the 
Wizard).



Note that if you change the Input Group Option in the Step Preview, the option gets 
changed on the Step Settings form as well. Save the step again after making more 
changes. 
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Configuring Wizard Step Rules
Wizard Step Rules control the flow of Wizard steps at runtime. You can create "Go to" rules 
for your steps which determine step order in the Wizard based on runtime user responses. 
The rules you create can be assigned as default for individual steps and can be made 
conditional based on expressions you create for each rule, using values from Inputs to 
determine whether or not rules are fired for any given step.

Much like Step Input Rules, Wizard Step Rules for any given Wizard are displayed as a 
graphical representation of the Wizard flow. As you add steps to your Wizard and 
configure Go to rules, the flow of the Wizard changes and is visually represented to give 
you an accurate snapshot of Wizard flow.

To configure Wizard Step Rules
From the Wizard Designer Settings page, click on the Wizard Step Rules tab. 
 

 

 
The Wizard Step Rules tab displays a graphical representation of your current 
Wizard, with all steps and any current rules shown as a flow from the first step to the 
Submit step. 
 

To configure Wizard Step Rules, you must have already added steps to the Wizard 
Design.
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By default, steps flow in the Wizard based on their listed sequence in Wizard Settings, 
with the Go to rule defined as "Next Step (no custom rules)."  
 
Click on the   icon next to the step name or hover over the list of rules and click New. 
A dialog is displayed for defining the step rule. 
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3. Choose a Go to Step rule from Step drop-down list. 
 

 

 

Go to Step Rule Description

Go to Step Name Use this rule to define a specific step as the next step in the 
Wizard flow. For example, for the Select Business Function step 
rule, you could choose "Select Business Activity."
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Go to Step Rule Description

Go to Submit Use this rule to make this step the last step in the Wizard. The 
Next button in Wizard runtime will be replaced with the 
Submit button. When Submit is clicked, the user is taken to the 
Wizard acknowledgement screen (or review page) and the 
Wizard is marked submitted (see Running Wizards for more 
information). Optionally, you can configure a URL to take an 
action upon Submit. Form your URL in one of two ways:

If your Wizard creates a record as a result of 
submission (i.e. one of your inputs determines the 
focus Object AND Record Type), you can configure 
the URL to:

take the user to the default 
Salesforce record page for the record 
created (e.g., "%Agreement%").
take the user to a page name with 
parameters (e.g., Submit Request 
Mode for an Agreement 
"Apttus__AgreementSubmitRequest? 
id=%Agreement%"

If your Wizard does not create a record but is 
simply posting information collected as the user 
interacts with the Wizard (for example, as a 
survey), use a REST URL for POST. The user is taken 
to the Wizard acknowledgement screen.

 
Note: Any URL entered for a Go to Submit rule must be relative, 
starting with the page name. For example, if you want to 
redirect the user to the agreement, use "%Agreement%" as the 
URL. The Object name between the % symbols represents the 
Label, not the API name.
If there is NO URL specified for Go to Submit and the Wizard 
creates a record, by default the user will be taken to the 
Salesforce page for the newly-created record.
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Go to Step Rule Description

Go to Abort Use this rule to Abort the runtime Wizard from this step. In 
most cases, a rule will conditionally trigger this Go to Step as 
it will not make sense to always have a step lead to Abort. As 
with the Go to Submit rule, you can optionally add a URL to 
another Salesforce page to Go to Abort, which will redirect the 
user to that page after they abort the Wizard. The URL enter 
for a Go to Abort rule must be relative, starting with page 
name.

 
 
To make your Go to rule conditional, click Add Another Rule to add a condition to 
your rule type. 
 

 

 
Use the drop-down menus to build a condition expression:

Choose an input from the list of inputs which are a part of the current step.
Choose an operator for the expression which is specific to the chosen input's 
data type.
Choose a value for the expression which defines the condition.
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Add more conditions as necessary to complete the rule. By default, all expressions 
use AND logic, meaning all conditions are required for the rule to execute. You can use 
the Advanced Expression field to change condition logic to OR, or create your own 
custom condition (for example, (1 OR 2) AND 3 if you want to make only 1 of the first 2 
conditions required). 
 

 

 
Click Save to save your new step rule. The graphic changes to reflect the new flow 
based on the rule you have created. In the below example, a rule was configured to 
conditionally go to step 2 and a second rule was configured to conditionally abort 
the wizard. 
 

There is no limit to the number of conditions you can create for a single step 
rule.
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From the Wizard Step Rules tab you can:

Click the   icon to create another step rule.
Click Edit next to an existing step rule to make changes.
Click Delete next to an existing step rule to delete the rule.
Click Wizard Settings to return to the Wizard.

Activating a Wizard Design
When you are finished adding Steps, Inputs and creating Step and Input rules for your 
Wizard (along with any other settings), you can activate your Wizard design to make it 
available to users from the Wizards tab. You can also activate a Wizard design which has 
been previously deactivated.

You can activate your Wizard Design from two locations within the Configurable Wizard:

from the Wizard Step Rules tab. 
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from the Wizard Settings page. 
 

 

To activate a Wizard Design
Navigate to the Wizard Designer Wizard Settings page or Wizard Step Rules tab.
Click Activate. A pop-up dialog is displayed to confirm activation. 
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Click Activate to activate your Wizard or click Cancel to return to the Wizard to 
make more edits. 
The new Wizard is now available to be run from the Wizards tab.

Reviewing a Wizard Design following Activation
After the Wizard is activated, the Activate button changes to Activated. 

To review the Wizard design, go to the Wizard Designs tab and click Edit next to the 
Wizard design.
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You can explore the Wizard, but you cannot make any further edits once it has been 
activated. You can take the following actions to review the design:

From the Wizard Design or Step Settings you can hover over a step or input and click 
 View to view the Step or Input Settings.
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From Wizard Step Rules you can hover over a rule to view rule details.

Similarly, from Step Input rules you can hover over an input rule to view rule details.

Deactivating a Wizard Design
You can Deactivate an active Wizard design when you do not want any new runtime 
Wizards to be initiated by users for that particular design. Deactivating a Wizard changes 
its state to "Deactivated," from which state the Wizard can either be re-activated or retired.
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To deactivate a Wizard Design
Go to the Wizard Designs tab.
Click Edit next to the active Wizard design you want to deactivate.
Click Deactivate Wizard on the Wizard Properties screen.
Click OK to confirm deactivation of the Wizard design. The Wizard design changes 
from Activated to Deactivated state. 
 

After a Wizard design has been deactivated, you can take the following actions from the 
Wizard Designs tab:

click Edit to review or reactivate the Wizard design.
click Retire to retire the Wizard design.

Retiring a Wizard Design
You can Retire a Wizard design which has been deactivated when you no longer want any 
Wizards initiated from that design to be run by a user. When a Wizard design is retired, 
users can no longer initiate the Wizard or continue in-progress Wizards associated with 
that design from the Wizards tab.

To retire a Wizard Design
Go to the Wizard Designs tab.
Click Retire next to the Wizard design you want to retire.
Click Retire to confirm retirement of the Wizard design.  
After a Wizard design has been retired, its State is displayed on the Wizard Design 
tab as "Retired." Click Edit next to the Wizard design to open the Wizard designer. You 
can review the retired Wizard design but cannot make any edits.

Cloning a Wizard Design
For auditing purposes and to prevent errors with any in-progress Wizards, you can 
only deactivate or retire an active Wizard design. To edit and repurpose a Wizard design, 

If you deactivate a Wizard design, any in-progress Wizards which have already 
been initiated by users will remain in-progress. These wizards can be completed as 
normal but no new wizards using the deactivated design can be initiated.
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clone the Wizard design and edit the copy. You can also clone a draft Wizard design if you 
choose.

To clone a Wizard Design
Go to the Wizard Design tab.
Under the Actions column, click the Clone link next to the design you want to clone.
In the Clone Wizard Design form, enter a unique design name for the new wizard in 
the Wizard Design Name field.
Click outside the field then click Clone. The new Wizard design is created and 
displayed in the Wizard Design list on a new line with Status = Draft. All information 
is copied from the cloned Wizard. 
 

Using the Wizard Component Library
The Configurable Wizard offers a tab from which you can manage libraries of both Steps 
and Inputs. When you create a step or input from a Wizard Design, that step or input is 
available to that specific wizard design only. In many cases, you will want to create steps 
or inputs which can be used by more than one Wizard. Use the Wizard Component 
Library to create reusable steps and inputs.

The Wizard Component Library is comprised of two tables: Steps and Input Controls.

Information displayed in table columns comes directly from Input or Step Setting details.

You can take the following actions on tables in the Wizard Component Library:

Action Description

New Step Click New Step to create a new step in the Steps Library. 
See Creating Steps for more information.
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Action Description

New Input Control Click New Input Control to create a new input in the Inputs 
Library. See Creating Inputs for more information.

Edit Edit an existing step or input. Edited steps and inputs will 
only apply to newly-created Wizard Designs and do not 
affect steps or inputs for existing Wizard Designs.

Delete Delete an existing step or input. Deleted steps and inputs 
will only apply to newly-created Wizard Designs and do 
not affect steps or inputs for existing Wizard Designs.

Search Use the type-ahead feature to narrow the list of displayed 
inputs or steps you want to edit, delete or view.

Creating Steps
Steps are used to designate the actions that occur when end-users use the Wizard. Steps 
use common elements, like actions and rules, to define the flow of your Wizard. Each step 
represents a screen in the wizard runtime.

When you create a new step in the Wizard Component Library and save it, it becomes 
available for use in Wizard Designs which match the Context Type and Object specified 
when you define it (if any). Please note that any modifications to the step from within a 
Wizard Design will not affect the properties of a step saved in the library.

To create a new Step from the Wizard Component Library
From the Wizard Component Library, click on New Step. 
The Step Settings form is displayed.
Enter the following properties into the form:

Limitation: When a user uses the type-ahead search feature in the Wizard 
Component Library, the resultant text is sometimes deleted as it is being typed.
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Step Setting Description

Step Name Enter a name for your Step. This name can be internal 
but is used in the runtime banner when the user is 
interacting with the Wizard if Banner Statement (below) 
is not defined. Note: You cannot add any inputs to your 
step until you choose a Step Name.

Banner Statement Enter a Banner Statement to display at Wizard runtime 
when the user is interacting with the Wizard. If left blank, 
the Step Name will be used instead.

Description Enter a description for your step which describes its 
intended use (for example, "Define business details in this 
step.")

Keywords Enter a list of keywords which can be used to search for 
this step.

Category Choose an option from a drop-down list of pre-defined 
Step Categories (define picklist values on the Wizard 
Step object).

Sub Category Choose an option from a drop-down list of pre-defined 
Step Sub Categories (define picklist values on the Wizard 
Step object).

Runtime Help Text Enter text to display when the user clicks the help icon at 
the top of the Step page.

Context Type Define whether your Step will apply to All objects or a 
specific Object.

Context Object Choose the specific context Object for your Step. This 
option is only available if you specified "Object" for 
Context Type. (e.g., "Agreement")
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Step Setting Description

Input Group Option Select an option from the drop-down list to choose how 
Inputs will be displayed in the Step (as groups):

None – Select this option to display all 
Inputs for the step in the sequence 
listed in the Inputs pane.
Repeatable – Select this option to 
allow the end user to add multiple 
records for selected Inputs in list 
format. User can click the Add Item 
button to add additional values for 
the same group of Inputs (e.g., multiple 
Addresses).
Table Layout – Select this option to 
allow the end user to add multiple 
records for selected inputs in tabular 
format. User can click the Add Item 
button to add additional values for 
the same group of Inputs (e.g. 
Agreement Line Item Products, 
Quantity, List Price, etc.)

Drag-and-drop an Input from the Inputs Library to the Inputs pane. If you do not see 
your Input listed, use the type-ahead feature in the Search box to locate the Input you 
want to use.

You can take the following actions on Inputs you have added:
Add more inputs from the Inputs Library in the sequence you want them to appear in 
the step.

Hover over an Input in the list and click Edit to edit the input settings for this 
step only.
Hover over an Input in the list and click Delete to remove an Input from the step.
Click and drag Inputs in the Inputs pane to reorder them.

If you do not find the correct input in the library and need to create a new one to use 
in your step, see Creating Inputs from the Wizard Designer.
To create rules which govern inputs for the current step, click on Input 
Rules (see Configuring Step Input Rules from the Wizard Designer).

You cannot add inputs to a step unless the Step Name has been entered.
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Click Save to save your changes or click Cancel to discard changes and return to the 
Wizard Design form. The new step is now available from the Wizard Component 
Library.

Creating Inputs
Input controls are the primary components of any wizard. They are the questions and 
instructions that you provide to the end users of your wizard. For example, you might create 
an input control that requires users to select picklist options, such as Business Function or 
Agreement Start and End dates. Input controls are reusable, so you can use them in as 
many steps as you want to.

Please note that any modifications to the input from within a Wizard Design will not affect 
the properties of an input saved in the library.

To create a new Input from the Wizard Component Library
From the Wizard Component Library, click New Input Control. 
The Input Settings page is displayed. 
Enter the following properties into the form:

Input 
Setting

Description

Control 
Name

Enter a name for your Input.

Questio 
n/ 
Instructi 
on

Enter a question or instruction which the end user will see in the runtime wizard.

Descript 
ion

Enter a description for the input which describes its intended use (for example, 
"Use this Wizard to create MSA Agreements for Acme."

Keywor 
ds

Enter a list of keywords which can be used to search for this Input.

Categor 
y

Choose an option from a drop-down list of pre-defined Input Categories (define 
picklist values on the Wizard Input Control object).
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Input 
Setting

Description

Sub 
Categor 
y

Choose an option from a drop-down list of pre-defined Input Sub Categories 
(define picklist values on the Wizard Input Control object).

Runtime 
Help 
Text

Enter text to display when the user hovers over the help icon next to the question/ 
instruction.

Runtime 
Input

Determine how the end user can interact with this Input at wizard runtime: 
Allow Comments and Attachments – Select this check box to enable the end 
user to add comments and/or attachments in addition to the input control value. 
Comments are entered into a text area field and are limited to 500 characters. 
There is no limit to the number of files a user can attach. 
Required – Select this check box if a value is required for the input. An end user 
will not be able to complete the current step without entering a value for this 
input. 
Read Only – Select this check box if you plan to have the input value set by Step 
Input rules in all cases. The end user will not be able to change the value of this 
input.
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Input 
Setting

Description

Field 
Class

The Field Class defines the type of response you expect for the input.
Wizard Input Field – Use this field class when you want the 
response to indirectly set other Wizard values. Wizard input 
fields values are only used to affect the value or state of 
other input controls using Step Input Rules. When you choose 
this field class, you must specify one of the following data 
types:

Checkbox
Date
Number
Picklist
Picklist Radio Button
Multi Picklist
Text
Text Area

If you choose to make the Wizard Input field a Picklist type, 
you must also enter valid values to be used as input 
responses.
Object Field – Use this field class when you want the response 
to directly set a field value on the Salesforce object which is 
created from the Wizard (e.g., the "Agreement Start Date" field 
on the Agreement object). Use the drop-down list under Input 
Control to choose the Object Name, then choose the Field 
Name based on the object chosen.

When you are finished creating your Input, click on the Preview tab to show how the 
input will appear at Wizard runtime.  
Click Input Settings to return to the Input form.
Click Save to save your new Input or Cancel to discard changes and return to the 
Wizard Component Library.

Running Wizards
The Contract Wizard application allows you to run Wizards created by administrators. 
Wizards are custom, user-friendly step-by-step questionnaires that allow you to create 
records based on any standard or custom Salesforce object (Agreements, Accounts, 
Proposals, Leads, etc.). Using a Wizard, you can quickly create your own records by entering 
responses to criteria-based inputs that follow a logical series of steps. You can easily 
search and select from Wizard designs to create well-formed records, and if enabled, you 
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2.

3.

4.

5.

a.

can preview your responses prior to submission, returning to previous Inputs and Steps to 
make changes or corrections.

To run a Wizard
From the Salesforce application menu, choose Apttus Contract Wizard. The 
application displays the Home tab and the Wizards tab (you will see additional tabs 
if you have permissions to create Wizards). 
Choose a Wizard to run from the drop-down list of designs and click Go. Note: 
Wizards associated with deactivated or retired Wizard designs will not be available 
in this list.

(Optional) Click the pencil icon in the banner to give your Wizard a unique name, so 
you can differentiate it from other Wizards you run using the same Wizard design.  
The new name for your Wizard is shown in the list of In Progress and Submitted 
Wizards on the Wizards tab.
Move through the steps of the Wizard, choosing values for the fields in each step. Click 
Next when you are finished with a step to move to the next step. Click Back to return 
to the previous step. Click Save to save the data on the current wizard page.

When you choose options (or a combination of options) that result in the creation of 
an object record, the Object name or Record Type will be displayed immediately upon 
choosing the option(s). For example, in the following step, when you choose "Sales 
Contract" as the business activity and "Create" as the transaction type, the Wizard 
evaluates a condition that determines that an Agreement record will be created 
when the Wizard is submitted. 
Some Wizard steps may include the option to add comments and/or attachments in 
addition to providing traditional responses. You can add comments in the text area 
provided (500 character limit), and/or click Attach Files to attach files to the Wizard 
step. When you use the Wizard to create a record, the attached files are added to the 
Notes & Attachments Related List of the new record along with the recorded 
comments. To add an attachment:

Click the Attachment(s) link below the Comments box. The Manage 
Attachments window is displayed.

Ensure that you have not blocked pop-ups in your browser because new 
Wizards are always launched in a separate tab.



You must fill in all the required fields on the current wizard page before 
clicking Save; otherwise, the Wizard will throw validation error message.
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6.

7.

8.

9.

10.
11.

•

•

•
•

12.

Click Add Files. Browse for a file on your machine and add it as an attachment. 
The attachment uploads to the Wizard and displays in the Manage 
Attachments window.
Repeat the previous step for each attachment you want to add. Close the 
window when you are finished adding attachments.

 
Click Add Item when there is a repeatable field in the Wizard. These fields are used 
when you need to enter multiple values as certain responses, for example when you 
are adding multiple business addresses, or product line items and prices to a Sales 
Contract. 
Closing the Wizard automatically saves your progress in the Wizard up to the current 
step. You can continue where you left off from the Wizards tab (see Working with the 
Wizards Tab).
When you have answered the final question in the Wizard and clicked Next, the page 
will display a Review of all steps you have completed. 
Click Edit to change your answers for any steps in the Wizard. A dialog is displayed 
warning that you may have to repeat steps of the Wizard that you previously 
completed depending on edits you make.
Click OK to edit the step or Cancel to return to the Review page.
When you are satisfied with your responses, click Submit.  
Depending on the design of the Wizard, one or more of the following will occur:

A record of the type determined by your inputs within the Wizard will be created 
(e.g., a Sales Agreement record).
You will be redirected to the record details page of the record just created by 
the Wizard.
You will be redirected to another page in Salesforce. 
You will remain on the Review page and the Wizard will be shown as 
 Submitted (in this case data from the Wizard has usually been submitted for 
purposes other than creating a record). 

 
Return to the Wizards tab. The Wizard you created and executed now shows its 
Status as Submitted in the list of Wizards. 
 
 
 

Working with the Wizards Tab
You can take several actions from the Wizards tab in addition to creating and running new 
Wizards:
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To search for Wizards
Perform a type-ahead Search to locate an In Progress, Submitted or Aborted Wizard in the 
table.

To continue an In Progress Wizard
Pick up where you left off to complete an In Progress Wizard.

Navigate to the Wizard using the type-ahead feature or page navigation.
Click Continue under the Action column. The Wizard opens in a new tab at the current 
step.

To review a completed Wizard
You can revisit the Review page for a Submitted or Aborted Wizard once it is complete.

Navigate to the Wizard using the type-ahead feature or page navigation
Click Review under the Action column. The Wizard opens in a new tab and displays 
the Review page (you can no longer edit any steps).

Tracking Wizard Activity from a Record
When a Wizard results in the creation of an Object record (such as an Agreement), a note is 
automatically added to the Notes & Attachments Related List of the created record 
identifying which Wizard originated the record.

For example, an Agreement record has been created from a Wizard.

From the Agreement record page, scroll to Notes & Attachments. 
 

 

 

Note: If "No Action" is available for a Wizard in the list, it means that the Wizard 
design associated with the runtime Wizard has been retired by your administrator. 
You can neither initiate nor continue Wizards associated with retired designs.
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Click on the Note Title to view Note details. 
 

 

 
In the Body description, note the Wizard name that created the record. 

Using the Preview Sidebar
To provide more flexibility when running Wizards, a Wizard user can access the Preview 
Sidebar, which tracks the Wizard as steps are completed. The Wizard user can use the 
Preview Sidebar to navigate to other steps in the Wizard freely. Use the Preview Sidebar to:

Preview a future step in the Wizard.
Track overall completion progress.
Return to a previous step in the Wizard to complete responses or correct a mistake.
View a full preview of all completed responses.

To use the Preview Sidebar
Launch a new Wizard from the Wizards tab. The runtime Wizard is displayed with the 
Preview Sidebar in collapsed view.
Click on the sidebar to expand it. You will see one of two possible views: 

If you are running a linear, step-by-step Wizard with no conditionally-shown 
steps, you will be able to see and navigate to any step in the Wizard. 
 

The Notes & Attachments Related List must be added to the record layout to view 
the Wizard notes.
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If the Wizard you are running contains any conditional steps, you will only see 
the current step and the "Preview" step. The preview sidebar will display 
additional steps as you complete the current step and conditions are satisfied 
to include the other steps in the Wizard. 
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Click on any step in the preview sidebar to preview it. Important Note: if you attempt 
to view a future step but the current step contains any required fields, you cannot 
preview that step until you have completed the required fields in the current step. 
 

You can click on the X in the upper-right-hand corner of the sidebar at 
any time to collapse it.
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Click on Preview at any time to go to the Review screen where you can review all 
visible steps in the Wizard, including any completed responses. The Preview screen 
only reflects steps that are present in the sidebar. No conditional steps will be shown 
unless the conditions that trigger them are satisfied.
Click Back to return to the last step you worked with.

Example: Configuring a Sales Contract Wizard
The following section describes an example process for an Agreement record-creation 
Wizard. This Wizard will the step the user through the process of creating an Agreement 
record with a Sales Contract record type. This example demonstrates the use of Wizard 
Step rules and Step Input rules to Determine Focus Object and Determine Record Type for 
the record, in addition to showing how to conditionally Hide, Disable and Set input controls 
based on values entered by the user. Understanding these processes will improve your 
ability to create your own unique Wizard designs. 
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The objective of the Wizard design used as an example on this page is to easily aid users in 
performing a variety of basic business functions, one of which happens to be creating an 
Agreement of record type Sales Contract. Additional logic could be built into both the Steps 
and Inputs to create other outcomes, including posting information to a URL or creating 
different types of records. Here is an example of the completed Wizard Design (hint: click 
the image to enlarge the view):

Example: Wizard Step Rule #1
This first example demonstrates how you can create more than one rule for a single step 
which determines how the Wizard will flow based on conditions.

In our example design, the first step in the Wizard is Select Business Function.

The Select Business Function step was created directly from the Wizard design form and 
contains one Input Control which prompts the user during Wizard runtime to choose a 
business function for their task.

The Step Rule for this example will determine whether or not the user can continue with the 
Wizard. If the user chooses "Sales" and clicks Next the Wizard should continue to the next 
step. However, if the user chooses any other option, the Wizard prompts the user to Abort.

Note: The example provided here does assumes the some steps and inputs have 
already been created and are part of the Wizard Component Library. Similarly, all 
details of the example Wizard design are not included–only specific portions of the 
design process are called out to demonstrate how features function within the 
Wizard.
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Create Step Rules
Because of this, two Go to Step rules must be created:

Go to Select Business Activity if the Input value is equal to "Sales."
Go to Abort if the Input value does not equal "Sales."

From the Wizard Step Rules tab, two rules are created under the Select Business Function 
step.

Rule #1: Go to Next Step

A Go to Step rule is defined to Go to Select Business Activity when a user chooses Sales 
from the Business Function input (see above).
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Rule #2: Go to Abort

Another Go to Step rules is defined to Go to Abort when a user chooses any other option 
than Sales from the Business Function input. 

After both rules have been created, they are graphically represented on the Wizard Step 
Rules tab. Arrows indicate to which step the user is directed when the rule resolves to true. 
Rule #1 takes the user to the next step, whereas Rule #2 takes the user to Abort.
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How it looks in the Wizard
When a user runs the Wizard, the step prompts the user to choose which business function 
they want to work in.

If the user chooses Sales and clicks Next, the step from Rule #1 is displayed next.

If the user makes a different choice and clicks Next, the Wizard displays an 
acknowledgement page, displaying all completed steps and their inputs. The user clicks 
 Abort to abort the Wizard or Back to return to the previous step or Edit to return to a 
specific step and choose a different option.
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Example: Step Input Rule #1 (Determine Focus Object)
The following example demonstrates an Input Rule for determining the focus object for your 
runtime Wizard. In this example, inputs entered by the user will determine the focus object 
of the record to be created (Agreement).

To determine a focus object for the Wizard requires an input rule be created for a specific 
step in the Wizard. In this example, this rule is created for the second step, Select Sales 
Business Activity.

Create Input Rule
The Select Sales Business Activity step is used to determine if the Wizard will be used to 
create an Agreement record. The responses to two Inputs, Determine Business Activity 
and Determine Transaction Type serve as criteria to determine if the focus object of the 
record to be created will be Agreement.

Because responses to both inputs will determine the focus object, an Input rule must be 
created for the second input control, Determine Transaction Type.
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Rule: Determine Focus Object

The Determine Focus Object rule is defined using two separate expressions. The focus 
object will resolve to Agreement if:

Determine Business Activity equals "Sales Contract" AND;
Determine Transaction Type equals "Create"

An Advanced Expression is used which specifies both expressions must resolve to true for the 
rule to be satisfied. Any other combination of responses to the inputs in this step will not 
result in Agreement being determined as the focus object.

After the rule is defined, the rule type and focus object are displayed on the Input Rules 
page for easy reference.
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How it looks in the Wizard
When a user reaches this step in the Wizard, they are prompted to enter a response to both 
questions.

When the user chooses the proper responses to satisfy the input rule, the object being 
created by the Wizard is displayed at the bottom of the page.

Because a focus object has been determined, the Wizard will now create an Agreement 
record when the final step of the Wizard is submitted. However, in the case of this example, 
record type have been determined for the Agreement object, so a Determine Record Type 
rule must also be created. This will be covered in the next example.

Example: Step Input Rule #2 (Determine Record Type)
The following example demonstrates an Input rule for determining the record type of the 
already determine focus object for your runtime Wizard. In this example, inputs entered by 
the user will determine the record type to be used for the record to be created (Primary 
Sales Contract).

To determine a record type for the Wizard requires an input rule be created for a specific 
step in the Wizard. In this example, this rule is created for the fifth step, Define Sales Item 
Types.

Create Input Rule
The Define Sales Item Types step is used to determine the Record Type for the Agreement 
record to be created. The responses to two Inputs, Sales Offering Types and Determine 
Agreement Scope serve as criteria to determine if the record type of the record to be 
created will be Primary Sales Contract.

Because responses to both inputs will determine the record type, an input rule must be 
created for the last input in the step, in this case Determine Agreement Scope.
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Rule: Determine Record Type

The Determine Record Type rule is defined using two separate expressions. The record  will 
resolve to Agreement if:

Sales Offering Types equals "All" AND;
Determine Agreement Scope equals "Full Contract"

An Advanced Expression is used which specifies both expressions must resolve to true for the 
rule to be satisfied. Any other combination of responses to the inputs in this step will not 
result in "SOW" being determined as the record type.

After the rule is defined, the rule type and record type are displayed on the Input Rules 
page for easy reference.



CLM

517
 

Copyright ©2022 Apttus Corporation. All rights reserved.
 

How it looks in the Wizard
When a user reaches this step in the Wizard, they are prompted to enter a response to each 
question.

When the user chooses the proper responses to satisfy the input rule, the record type being 
specified by the Wizard is displayed at the bottom of the page.

Now that a Record Type has been determined by the Wizard, when the Wizard is submitted, 
an Agreement record of the type Primary Sales Contract will be created.

Example: Step Input Rule #3 (Modify Controls)
The following example demonstrates how you can modify the behavior and value of input 
controls for a step using the input rules Hide This Control and Set This Control Value. In this 
example, the user is defining the service level to be used in the contract. If the user chooses 
one option of a certain input, several inputs in the step will be hidden (Hide This Control). 
Similarly, depending on the combination of responses entered by the user for multiple 
inputs, the final value of one input will change (Set This Control Value).

Create Input Rules: Hide This Control
In this example, several input rules are defined for the Determine Service Level step. 

The Extend Service Coverage input will be used as the criteria in expressions for rules 
defined on other inputs to determine whether or not those input controls are hidden.
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If Standard Service Level is chosen, the only input shown will be Service Level Provided (the 
value of this input will also be determined by this choice using a Set This Control value, 
which is described later on this page).

If Extended Service Level is chosen, all inputs will be shown.

Because all input controls for a step are shown by default, an input rule must be created 
for each input which could be hidden.

Rule: Hide This Control
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The Hide This Control rule is defined using a single expression. If Extend Service Coverage is 
not equal to Extended Service Level, then the Service Days input control will be hidden. 
Another way to define this rule could be if Extend Service Coverage equals Standard Service 
Level.

This rule is repeated for the inputs Hours Service Coverage, Response Service 
Coverage and Solution Service Coverage.

How it looks in the Wizard
When a user reaches this step in the Wizard, the first input prompts them to choose either 
 Standard Service Level or Extended Service Level.

When the user chooses Extended Service Level, all remaining inputs remain on the page. 
When the user chooses Standard Service Level, all inputs but the final input are hidden 
because of the Hide This Control rules which were defined.

Create Input Rules: Set This Control Value
In this example, multiple input rules are created for a single input control. The combination 
of user-selected responses to several inputs in the step will set the value of the Service 
Level Provided input.
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It is recommended that when you create a rule which will set the value of an input in a step, 
the input being set should be set to Read Only (when it is originally defined). Alternatively, 
you can create a Disable This Control rule and set criteria which will change the input to 
read only during Wizard runtime.

Rule: Set This Control
Service Level Provided is an input control defined using an object field. This field is a picklist 
on the Agreement record with three possible values:

Standard
Premier
Platinum

The objective in this example is to create a rule which will resolve to each of the three 
possible values based on the responses given by the user during this step. So three rules 
must be created.

The first rule for Service Level Provided defines the criteria for setting the Service Level 
Provided to "Premier." To accomplish this, a Set This Control Value rule is created.
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In the above example, each input listed in the rule must satisfy the exact criteria specified 
for the value of Service Level Provided to be set to "Premier" (note the Advanced Expression 
"1 AND 2 AND 3 AND 4").

Two more rules are created in turn to set the control value to Standard or Platinum.

How it looks in the Wizard
When a user reaches this step in the Wizard, they are prompted to provide responses to all 
questions. Note that the last input, which corresponds to the Service Level Provided input, is 
blank and read only. 

The user responds to questions in the step, matching those of the expression described 
above. The Service Level is defined and displayed in the field below the last input.

You can see all the Hide This Control and Set This Control Value rules for this step resolve 
to true when the user chooses "Standard Service Level" as the first response.

Example: Wizard Step Rule #2
The final example for this wizard demonstrates one of the options for creating a step rule 
which determines the action(s) taken when a user clicks Submit following the last step of a 
Wizard.

Note that the value of "Premier" is entered manually when the rule is configured but 
must match one of the options in the Object Field defined when the input was 
created.
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In this example, the Wizard designer not only wants an Agreement record of type Primary 
Sales Contract created, but also wants the record to be created using Submit 
Request Agreement rules defined for this Agreement type.

Create Step Rule
To accomplish this, a Go to Submit rule must be specified for the last step in the Wizard.

From the Wizard Step Rules tab, a new rule is created under the Sales Line Item Details 
step.

Rule: Go to Submit

The Go to Submit rule is defined with a specific relative URL: "AgreementSubmitRequest? 
id=%Agreement%"

When the user clicks Submit from the review page of the Wizard, the Agreement Primary 
Sales Contract will be created in Submit Request Mode. The %Agreement% is entered here 
so that the user is redirected to the newly-created record as the request is submitted.

How it looks in the Wizard
When a user has finished the last step of the Wizard, clicking Next takes the user to the 
Wizard Review page.

When the user clicks Submit, the request to create an Agreement is processed, following the 
properly defined Agreement Rule for Submit Request Mode. In this example, because the 
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 Service Level specified in the Wizard by the user was "Standard," the auto Submit Request 
Mode Agreement rule is executed.

The Agreement record of type Primary Sales Contract is created and the user is redirected 
to the newly-created record details page.

A number of actions take place as a result of Wizard submission and the Submit Request 
rule:

A note is added to Notes & Attachments related list with details about the Wizard 
which created the record.
The document is automatically generated from the Submit Request and is attached 
to the Document Versions related list (the document is here because Contract 
Document Versioning has been enabled for this org. If it is not enabled, the document 
would be attached to Notes & Attachments instead).
Activity History shows which Wizard created the record (this is the same information 
as the note attached to N&A), the "Generated Agreement" activity, and an Email 
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Template Agreement Rule creates and attaches an automatic email to specified 
recipients.

 

The Wizard is now complete and submitted. This example shows one of many outcomes 
which can occur when the user clicks Submit. Refer to Configuring Wizard Step Rules for 
more information on creating well-formed rules for your Wizards!

Configuring Wizards as Self-Service with 
Salesforce Sites and Communities
When you want to provide the ability for partners or other parties to run existing wizard 
designs created in your organization (or to create Wizards of their own), you must configure 
a method to make your runtime wizards externally facing. The Wizard Designer and Wizard 
Runtime pages are normally only available to users within your organization and for those 
who have proper permission extended to Wizard objects. 

The choice between Salesforce Sites and Communities is mainly a question of how you 
want users to access Wizard functionality. Alternatively, you may want to create and 
design a Salesforce community and give specific users access to design and run Wizards 
while interacting with partners and other users. In either case, both options provide 
authentication solutions and permission sets which identify user access to Contract Wizard 
features.

You can explore self-service options in the following sections. Click Next to learn how to set 
up a Salesforce Site to work with Wizards.

Configuring Sites for a Specific Runtime Wizard
When you configure your site you have the option to choose any Visualforce page as the 
Active Site Home page. However, a case may exist in which you would prefer for the site to 
take the user directly to a runtime wizard, rather than giving the user the option to choose 
it from Wizard tab home page. In this case you will have to configure a URL Redirect for the 
site.

With the Spring ’21 release, Salesforce has removed the View All, Modify All, edit, 
and delete permissions for guest users in all orgs. Hence, Conga CLM does not 
support guest user access. For more information, see Salesforce Documentation.



https://help.salesforce.com/articleView?id=sf.networks_guest_policies_timelines.htm&type=5
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To set up a URL redirect:

Go to the Site Details page.
Click on URL Redirects. 
 

 

 
Enter the following to add a new redirect rule: 

Source URL – This is the relative URL of the original source page. Enter "/" here.
Redirect Type – Choose "Permanent (301)."
Target URL – Enter "http://{siteurl}/apex/Apttus_wizard?wizardid={wizardid}" 
where {siteurl} is the actual site URL and {wizardid} is the ID of the desired 
runtime wizard. For example, if your Site URL is http://clmwizardsite-developer- 
edition.na34.force.com/ and the runtime Wizard id is a0p610000019mTIAAY, you 
would enter your target URL as http://clmwizardsite-developer- 
edition.na34.force.com/apex/Apttus__wizard?wizardid=a0p610000019mTIAAY

 
 

 
Click Save.
Select the rule you just created and click Activate to activate the URL redirect. Now 
when a user visits your site home page they will be redirected to begin the runtime 
wizard. 
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Configuring Self-Service Wizards for Communities
Use Salesforce Communities for your Self-Service Wizards to require authentication for 
customers and external users when they execute run-time wizards. This section provides 
instructions for Creating a Community portal for licensed Community users to access Self- 
Service Wizards.

In Spring 2013, Salesforce introduced Communities, which replaced the Customer and 
Partner portals. Communities combined the functionality of customer and partner portals 
with a way to allow customers and employees to collaborate in the same space. Using 
Communities to provide Self-Service Wizards, you can provide the same functionality but 
give your Wizard experience a completely unique look and feel.  When you create a 
Community, you are still creating a Force.com site, but the site is wrapped in the 
Community, providing authentication options, branding, collaboration and other 
benefits. The most important consideration to use Communities over Customer/Partner 
portals is that Customer/Partner portals are no longer available for new Salesforce 
organizations.

For more information on Salesforce Communities, refer to Salesforce documentation on 
 Getting Started With Communities.

To properly set up Self-Service Wizards using Communities, perform the following steps:

Enable Communities in your org and choose a domain.

The following pages and sections provide instructions for enabling Self-Service 
Wizards by creating a new community and assigning members to the Community. 
While you can create communities for both customers and partners, the instructions 
provided use customer members as an example. The process for partners is almost 
identical, but differs slightly. Where the process differs the documentation will 
provide guidance.



https://help.salesforce.com/articleView?id=networks_resources.htm
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1.
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3.

4.
5.

1.
2.

Create a Community for Self-Service Wizards.
Create/Modify User Profile(s) to be used in the Community.

Add custom object permissions to Wizard-related objects.
Add field-level security privileges for Wizard-related objects.

Create Contacts and Enable as Customer or Partner Users.
Add Members to the Community.
Add Wizard tab to the Community.
Activate the Community. 
 

Creating Your Community

Enabing Communities

Go to Setup > Customize > Communities > Community Settings. 
Select the Enable Communities checkbox.
Enter a unique Domain Name. This domain name will be used in all of your 
communities for this org.
Click Check Availability to confirm that your chosen domain is available.
Click Save.

Creating a Community for Self-Service Wizards

With Communities enabled, you can create a Community for your partners and customers 
to run Wizards.

Go to Setup > Customize > Communities > All Communities.
Click New Community to choose a template for your new community. The Community 
Builder page is displayed. 
 

Hint: Click an image on this page to enlarge the view.

If Communities is already enabled for your org, skip this step.
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Choose the Salesforce Tabs + Visualforce template. This is required for communities 
which expose custom Visualforce pages (like the Contract Wizard).
Choose a Name for your Community and an optional prefix for the URL (in this 
example, "wizards" is used as a prefix). 
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Click Create Community. Your community has been created and is now ready to be 
configured for Self-Service Wizards.

Configuring Users for your Community
In order for users to have access to both your community and Wizards, you must complete 
the following steps:

Create a user profile for your community OR modify an existing user profile
Add custom object permissions to the profile(s) for Wizard-related objects
Add field-level security permissions to the profile(s) for Wizard-related objects
Create customer/partner users as contacts and enable as community users
Add members to your Community

The following sections use a Customer Community profile as an example, but you 
can also create a Partner Community profile. The only major differences are the 
type of license chosen when creating the profile and any users created for the 
profile must be associated with partner accounts.
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Creating a User Profile

Go to Setup > Manage Users > Profiles.
Click New Profile. The Clone Profile page is displayed.
Choose an Existing Profile enabled for Salesforce Communities: Customer Community 
User or Partner Community User (Customer Community User is used in the examples 
on this page).
Enter the name for the user profile you want to create and click Save.

Adding Custom Object Permissions for Wizard-Related Objects
Go to Setup > Manage Users > Profiles and click on the profile you just created.
Click Edit on the Profile Details page.
Under Custom Tab Settings, change the Wizards tab to Default On. 
 

 

 
Under Custom Object Permissions grant Read, Create and Edit permissions to the 
following objects: Wizards, Wizard Input Controls, Wizard Runtime Inputs, and Wizard 
Steps. 
 

The following section provides instructions for creating a user profile for use with 
your Community specifically for the use of running Wizards. If you decide you want 
to clone and/or modify an existing user profile for use with your Community, you can 
skip this step, but make sure the user profile you have chosen is assigned a Partner 
or Community license. 
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Click Save to return to the Profile Details page.

Adding Field-Level Security for Wizard-related Objects
Go to Setup > Manage Users > Profiles and click on the profile you just created.
Under Field-Level Security > Custom Field-Level Security click the View link for 
the Wizard object. 
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Click on each checkbox under the Visible column to enable visibility for all fields in the 
list. 
 

 

 
Click Save to return to the Profile Details page.
Repeat Steps 2 – 4 for the following objects: Wizard Input Control, Wizard Runtime 
Input, Wizard Step.
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Creating Community Users from Contacts
Assuming the customers or partners who will be using Self-Service wizards are customers of 
your organization, you must create or use existing contacts in your org and enable them as 
customer or partner users. Follow these step-by-step instructions to create a new user for 
your community and assign it a Community profile.

Create a new business contact and assign it an account or go to Contacts and 
choose an existing contact.
Click on Manage External User and choose Enable Customer User. 
The New User form is displayed.

Enter all required information for your new Community user, including: 
Email– the actual email of the user who will logging in to your community (if you 
have not yet activated the community, choose an email address controlled by 
your organization–see below)
Username – the Username for this user will be what they use to log in to your 
Community portal (e.g., "wwizard@wizarduser.com").
User License – the "Customer Community" user license (or "Partner Community" if 
you are creating a Partner User).
Profile – he User Profile you created in the previous section.

You can choose the enable the contact as a Partner User only if the account 
assigned to the contact has been enabled as a Partner Account. Also keep in 
mind that when you assign a profile to the user it must use be a Partner profile 
(using a Partner Community license) instead of a Customer profile.





CLM

534 Copyright ©2022 Apttus Corporation. All rights reserved.
 

4.

5.

6.

7.

 
 

 
Click Save to create the new user. An email notification is sent to the email address 
provided in the New User form to complete registration for their account.  
 

Return to the detail page for your contact. Click on Manage External User and 
choose View Customer User.
Scroll to the Managed Packages section and click on Assign Licenses. 
 

 

 
Under Unassigned Packages select the checkbox next to Apttus Contract 
Management package and click Add to assign a license for that package to the user 
(this is required of every customer/partner user).

During initial setup of your community before it is activated, it is recommended 
to create a user password from an email address controlled by you or your 
administrator. After the community has been activated, any new users 
created in this way can complete the registration process from their own 
email address.
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Adding Members to Your Community
Now that you have created/modified user profiles and created users to access your 
Community, you must add those user profiles to the Community itself to allow access. To 
add members to your community:

Go to Setup > Customize > Communities > All Communities.
Click Manage next to your Community.
Go to Administration > Members. 
 

 

 
Search for and select the user profile(s) to add to the Community. In the example 
below, the user profile Test Customer Community User is added to the Community. All 
users with this profile can log in to your community with the proper credentials. 
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Click Save. Users with the selected profile(s) can now access your community.

Configuring and Activating your Community

To complete the process of enabling Self-Service Wizards as a Community, you need to 
complete Community configuration and activate the Community itself. Much of Community 
Management is left up to your organization–how you customize, which Dashboards and 
Reports you expose, how you brand your site, is all handled as part of Community 
Management. 

Adding Tabs to Your Community
To allow users to choose from available Wizard designs and execute a runtime Wizard you 
must add the Wizards tab to your Community.

Go to Setup > Customize > Communities > All Communities.

Hint: Click an image on this page to enlarge the view.
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Click Manage to manage your Community.
Go to Administration > Tabs.
Add the Wizards tab from the list of Available Tabs to Selected Tabs. 
 

 

 
Click Save.

Branding Your Community
Although not required, you can add branding to your Community, including making changes 
to the following:

Use HTML or image files to change the header and footer of your Community site.
Change the color scheme for your Community, including the header and page 
background.
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Activating Your Community
When you have completed configuration and are satisfied with customizations to your 
Community, you can Activate the Community to make it live, allowing your users to access 
Self-Service Wizards.

Go to Administration > Settings.
Click Activate Community to change the status of your Community from Preview to 
Active. 
 

Note that the branding offered in Community Management differs from branding 
added to Wizard designs when they are created. With the Wizard Designer, you can 
add branding to both the Wizard banner and individual Steps of your runtime 
Wizards. For more information on adding branding and logos to your Wizards, refer 
to Creating a New Wizard Design.
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Your Self-Service Wizards Community is now ready for registered users! 
 

Integrating the Contract Wizard with Other 
Applications
When you integrate your own Salesforce applications with the Contract Wizard embedded 
in an iframe container, you can make use of several Javascript event notifications to have 
your container application enable/disable or show/hide items.

The following table shows a list of these events and the parameters passed to them, and 
the Wizard runtime action associated with each event. Events provide a response in the 
form in JSON format; examples are provided below for each event.
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Event Acti 
on

Parameters Example Response

onwizardn 
ext

Next wizardDesignId, 
wizardDesignName, 
wizardId, stepDesignId, 
stepDesignName

{"action":"onwizardnext","data": 
{"wizardDesignId":"a29M0000000rSWVIA2","wiza 
rdDesignName":"SDProposal-1-25","wizardId":"a2 
8M0000001bmd4IAA","stepDesignId":"a2EM0000 
000XZSkMAO","stepDesignName":"SDProposal-1- 
25"}}

When the next page is the Wizard "Review" page 
(in this case, the stepDesignID is "Null" and the 
stepDesignName is "Review" as this is the last 
page of the Wizard and not a design-defined 
step):

{"action":"onwizardnext","data": 
{"wizardDesignId":"a29M0000000rSWVIA2","wiza 
rdDesignName":"SDProposal-1-25","wizardId":"a2 
8M0000001bmdOIAQ","stepDesignId":"","stepDesi 
gnName":"Review"}}

onwizard 
back

Back wizardDesignId, 
wizardDesignName, 
wizardId, stepDesignId, 
stepDesignName

{"action":"onwizardback","data": 
{"wizardDesignId":"a29M0000000rSWVIA2","wiza 
rdDesignName":"SDProposal-1-25","wizardId":"a2 
8M0000001bmd4IAA","stepDesignId":"a2EM0000 
000XZSkMAO","stepDesignName":"SDProposal-1- 
25"}}

onwizards 
ubmit

Sub 
mit

wizardDesignId, 
wizardDesignName, 
wizardId

{"action":"onwizardsubmit","data": 
{"wizardDesignId":"a29M0000000rSWVIA2","wiza 
rdDesignName":"SDProposal-1-25","wizardId":"a2 
8M0000001bmd4IAA"}}

onwizard 
abort

Abor 
t

wizardDesignId, 
wizardDesignName, 
wizardId

{"action":"onwizardabort","data": 
{"wizardDesignId":"a29M0000000rSWVIA2","wiza 
rdDesignName":"SDProposal-1-25","wizardId":"a2 
8M0000001bmd9IAA"}}

onwizards 
tart

Start wizardDesignId, 
wizardDesignName, 
wizardId

{"action":"onwizardstart","data": 
{"wizardDesignId":"a29M0000000rSWVIA2","wiza 
rdDesignName":"SDProposal-1-25","wizardId":"a2 
8M0000001bmd4IAA"}}
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Use the event notification data from your embedded Wizards to drive functionality in your 
application. For example, each "Next" event in the Wizard could trigger your application to 
add or display a new tab to the user.

Configuring Meta Property Field Sets for Set 
Custom Value Rules
The "Set Custom Value" step input rule in the Wizard Designer allows you to set the value 
for special purpose custom fields to permit more conditional logic and date to be captured 
by the Wizard. These custom fields are added to the Wizard using a MetaProperty Fieldset 
on the Wizard Runtime Input object. While other rules created in the designer rely on the 
context object for the agreement or step (e.g., Agreement, Account, Quote/Proposal, etc.), 
meta properties can be considered and evaluated for any step in the Wizard design, 
determined specifically by implementation of the Set Custom Value input rule, allowing 
Wizards to capture additional information at runtime that can be used for a purpose 
beyond manipulating or using Salesforce data. 
Packages which use the wizard typically create the custom fields and implement them as 
these meta properties to be used by the Wizard objects. You can also manually add 
custom fields to the Meta Property Field Set.

Prerequisites
Before you can configure the MetaPropertyFieldSet you must define custom fields on the 
Wizard Runtime Input object to add to the field set. In the steps below, two custom fields, 
Score (Score__c) and Weight (Weight__c) were created to be used as meta properties.

To configure Meta Properties
Go to Setup > Create > Objects > Wizard Runtime Input.
Hover over the Field Sets link and click Edit next to the MetaPropertyFieldSet record.
Drag and drop the fields you want to use in the Wizard into the list below the field set 
pane. You can add the fields to the list in any order. 
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After adding all fields to the Field Set, click Save in the MetaPropertyFieldSet pane. 
The custom fields in the Field Set are now available to Wizard Designers as Fields on 
the Set Custom Value Wizard Step Input Rule. 
 

 

 

Auto-Populating Wizard Fields at Runtime
Occasionally business requirements may require responses in Wizards to be auto- 
populated when the Wizard is first launched. Circumstances may dictate that fields for a 
particular Wizard are always populated for reasons such as the following:

Only one MetaPropertyFieldSet is available for all Wizard designs. Add as 
many meta properties as needed to the field set and use only the ones you 
want for specific input rules. All other fields will be ignored during wizard 
runtime.
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Object field values for the Wizard should always be the same (e.g., an Agreement- 
creation Wizard that will always have the same Account and Opportunity names 
filled in for certain steps).
Wizard Input or Object Field values should always match every new Wizard of the 
same design (e.g., multiple surveys/questionnaires for each line item in a Cart line 
that should share the same responses based on a previously completed survey).

There are two primary methods provided in Wizard Design for auto-populating fields during 
Wizard runtime:

passing record IDs as parameters when the Wizard launches to auto-populate Object 
fields.
implementing a special DataSource callback class that fetches data from one 
runtime Wizard to populate other Wizards of the same design.

Auto-populating Wizard Fields using Record ID
To auto-populate fields based on record ID(s) every time a new instance of the Wizard is 
launched, you need to pass Object record Ids as parameters when the Wizard is launched. 
In most cases, this implementation will use something like a formula field, which captures 
the desired record IDs and includes them in the URL when the Wizard is first launched.

Consider a simple agreement creation Wizard. Your requirement include auto-populating 
the initial steps of the Wizard with details from the associated Account and Opportunity, 
which will be the same for every instance of the Wizard. Rather than having the Wizard 
user enter these values every time the Wizard is run, you want them to be automatically 
filled when the Wizard is launched.

To use this method, the inputs you want to be auto-populated must be Object fields 
that match the types of records you are passing as parameters. In this example, the 
designer creates an input for Account > Account Name.
In the next step, the designer creates an input for Opportunity > Name.
As these are pre-existing objects in the same org, it's easy to retrieve record IDs to 
pass to the Wizard when it is launched. How the record IDs are passed to the Wizard 
depends on your integration with Conga CLM Wizard. Record IDs could be passed as 
parameters using a formula field, for instance.

When the Wizard is first launched through your integration, the URL is constructed in this 
fashion:

Note that while the above functionality exists out-of-the-box, use of this feature 
requires a custom implementation for initiating auto-populated Wizards. Also note 
that compound and read-only fields cannot be auto-populated at this time.
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https://apttus-wizard.na34.visual.force.com/apex/apttus_wizard__wizard? 
wizardid=a11610000016K6fAAE

where "wizardid=a11610000016K6fAAE" is passing the Id of the runtime wizard. Your solution 
should append recordIDs corresponding to the Object where the fields reside and which 
match the Object of the fields you want to auto-populate.

Returning to the above example, you can auto-populate fields in the Wizard using specific 
Account and Opportunity record IDs. To see this in action:

Go to the Wizards tab and launch the Wizard you want to auto-populate. Note the 
Wizard runtime URL.
Open another tab and go to the Account which contains the data you want to 
capture. Copy the Account Record ID from the URL.
Return to the Wizard runtime and append the URL with the Account Record ID, using 
proper syntax to pass it as a parameter (e.g. "&recordIds={Account_Id}).
Repeat steps 2-3 for the Account Opportunity. Comma-separate multiple record IDs.
Press Enter. Fields which have values on the Objects corresponding to the record IDs 
you passed will be automatically populated with data across multiple steps, 
wherever they appear in the Wizard.
Follow this format for your integrations. Using this method, you can easily construct a 
formula field to pass these parameters from your Wizard launch point and auto- 
populate data for your users.

Auto-populating Wizard Fields using a Datasource 
Callback
When you need to build the ability to auto-populate fields in Wizards based on previously 
entered responses for your integration, you should use the Datasource Callback method. 
This method also requires passing data to the Wizard as in the previous section, but in this 
case it is retrieving data from one completed Wizard and using that data to populate 
newly-invoked Wizards that use the same design.

Wizard Runtime JSON Structure
To properly understand the format of the data returned by the callback to auto-populate 
a Wizard, let's take a look at a sample JSON structure created from a Wizard step with 2 
responses:
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Sample JSON: Auto-Populate

{

       "UserResponses": [{

              "Question": "sample question - 1",

              "ObjectName": null,

              "Notes": [],

              "metaPropertyFields": null,

              "inputRepeatSequence": 0,

              "inputControlId": "a0236000002LNlDAAW",

              "FieldName": null,

              "FieldClass": null,

              "Comments": "",

              "Attachments": [],

              "Answer": "sample answer - 1"

       }, {

              "Question": "sample question - 2",

              "ObjectName": null,

              "Notes": [],

              "metaPropertyFields": null,

              "inputRepeatSequence": 0,

              "inputControlId": "a0236000002LNlEAAW",

              "FieldName": null,

              "FieldClass": null,

              "Comments": "",

              "Attachments": [],

              "Answer": "sample answer - 2"

       }],

       "Parameters": null

}

When using the callback method to auto-populate fields in a runtime Wizard, the method 
should return a string using a similar JSON structure as shown in the example above. The 
values in the JSON string auto-populate the fields when the Wizard is invoked.

The parameters described in the following table are relevant for Callback 
implementations to auto-populate questions/responses in the Wizard:

Parameter Value Description

Question Object/Wizard Input field 
name

Provide the name of the field in the Input 
Control as defined (e.g., "AccountName" 
or "OppName")
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Parameter Value Description

inputControlId Id string of Input Control Provide the Id string of the input control 
to be auto-populated (e.g., 
"a1561000001dXHf")

Answer Field or Response value Provide the value to auto-populated as 
in the Wizard field/response (e.g. "Tier 
One Systems")

inputRepeatSequence Numeric sequence for 
repeatable Wizard Input 
Controls

If the Wizard step uses a "Repeatable" 
layout for an input, Provide a numeric 
value to represent each occurrence (e.g., 
first occurrence is "inputRepeatSequence:" 
0, next occurrence is 
"InputRepeatSequence:"1, etc.)

Implementing a Datasource Callback
The data captured from the previously completed wizard can be from Wizard Input Fields 
or Object fields. For your integration, you must create a DataSource Callback class that 
passes this retrieved data to the new Wizard runtime instance. The process works as 
follows:

A custom Data Source callback class is created to implement the DataSource 
Callback interface WizardCustomClass.IDataSourceCallback.
The DataSource Callback class calls a custom getData() method that takes the 
Wizard Design ID as the primary parameter and a map of parameters passed to the 
Wizard design.
The getData() method is used to define values for specific runtime input controls in the 
Wizard design (questions, answers and values) and creates and returns a JSON string 
using the same structure interpreted by the Wizard.
The Wizard Design using the DataSource Callback must have the class name defined 
in the Wizard Settings section of the Wizard Design.
When a new Wizard is invoked, fields specified by the Callback method are auto- 
populated.

Use Case for Contract Wizard
This topic describes the use case for Contract Wizard.
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A Wizard prompts the end user to answer a series of on-screen questions then creates the 
Agreement record. This use case describes how a non-expert user can use on-screen 
Wizards, to quickly create contracts.

In this case, ACME needs to provide Sales Representative with a quick and easy way to 
create Non-Disclosure Agreements. 

Prerequisite: Make sure you have the followings:

Inputs are created.
Steps are created.
All agreements must have the following fields completed: Agreement Name, 
Agreement Category, Account Name, Language, Status Category, Start Date, and 
Primary Contact.    
To create inputs, perform the following steps:

Go to the Apttus Configurable Wizard.
Navigate to the Wizard Component Library tab.
Click New Input Control. Fill in the following fields, then Save.

Field Value

Control Name Account Name

Question/Instruction Please select an Account

Field Class Object Field

Object Name Agreement

Field Name Account

Click New Input Control. Fill in the following fields, then Save.

Field Value

Control Name Start Date

Question/Instruction Please select an Account 

Standard Statement

This use case gives one example on how to create user-friendly on-screen Wizards, 
to quickly create contracts. You might use this functionality differently, depending 
on your business case.
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Field Class Object Field

Object Name Agreement

Field Name Agreement Start Date

You have successfully created all the inputs required to create the steps.

Inputs are placed in Steps. Steps can also contain rules that determine the flow and logic 
of the Wizard.

To create Steps, perform the following steps:

From the Wizard Component Library, click New Step.
Enter Agreement Step 1 as the Step Name.
From the Inputs Library, drag and drop the following Inputs into the Inputs pane: 
Agreement Name, Account Name, Agreement Category.
Click the Input Rules tab at the top of the page.
Next, to Agreement Name click the +.
Select Determine Focus Object as the picklist value under Rule.
In the following picklist, select Agreement.
Click Save.
Click the + next to Agreement Name.
Select Determine Record Type as the picklist value under Rule.
Select Agreement in the following picklist.
Select NDA-yourinitials in the following picklist. Click Save. 
For Agreement Step 1, you should now see two Agreement Name input rules (1.1 and 
1.2).
Click Save.
Repeat steps 1 – 3 to create Agreement Step 2. 
Use the following Inputs: Start Date, Status Category, Language, and Primary 
Contact.
Click Save.
You have successfully created the two steps for the Wizard.

With the Steps created, the Wizard can now be designed. The Wizard determines the 
specific process, the end-user will go through, based on Steps and Inputs.

To create a Contract Wizard, perform the following steps:

Go to the Wizard Designs tab.
Click New Wizard Design.
Enter Agreement-yourinitials as the Design Name.
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From the Steps Library, drag and drop Agreement Step 1 and Agreement Step 2 into 
the Steps in the Wizard pane.
Click Activate twice.
Click Cancel to exit Wizard Designs.

Result:

You have successfully created the Wizard.

Providing Access to Run Wizards
As an administrator, you can provide access to a particular user profile by providing 
required object permissions to the wizard objects. When you provide the below-mentioned 
permissions to a user profile, the users will be able to run wizards, but cannot create or edit 
wizard designs.

To provide access to run wizards
Navigate to Setup > Users > Profiles.
Select a profile.
Click Object Settings.
You need to provide the following permissions to the Wizard objects.

Object Name Object Permissions

Wizard Component Library Read

Wizard Designs Read

Wizard Input Control Runtime Create, Edit

Wizard Input Controls Read

Wizard Input Groups Read

Wizard Launcher Create, Edit

Wizard Lightning Launcher Create, Edit

Wizard Rules Read
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Object Name Object Permissions

Wizard Ruleset Runtime Create, Edit

Wizard Rulesets Read

Wizard Runtime Inputs Create, Edit

Wizard Step Runtime Create, Edit

Wizard Steps Read

Wizards Create, Edit

Configuring Wizard as a Related Tab
You can configure the Wizard as a Related tab in the Account or Opportunity to launch the 
wizard with pre-populated record information in Lightning.

To configure the Wizard as a Related tab
Navigate to the Account or Opportunity Detail page.
Click the Setup icon and select the Edit Page option. 
This displays the Account or Opportunity Object page per your selection in the first 
step.
In the layout, click the Details tab. 
This displays a tabs component in the right panel.
Click the Add Tab button. 
This adds another Details tab in the layout.
 In the tabs component, select the newly added Details tab. 
From the Tab Label, select Custom. 
This displays the Custom Label text field.
In the Custom Label field, enter Wizard.
In the layout click the Wizard tab.
In the left panel, search for Wizard Create action.
Drag Wizard Create action from the left panel and drop in the Add Component(s) 
here section.
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Navigate to the wizard that you need to use to create agreements and copy the 
Wizard Design Id.
Click the Wizard tab and select the Create Wizard button.
In the right panel, enter the Wizard Design Id. 

Click Save. 
If you are configuring the page layout for the first time in your org, then you need to 
activate the page. 
When you navigate to the Account (or Opportunity) Detail page and click Create 
Wizard, the Account Name (or Opportunity Name) is pre-populated in the wizard.

Contract Lifecycle Management with 
Salesforce Lightning
You can use Conga CLM with the Salesforce Lightning Experience and still accomplish the 
same tasks with the same features. The only thing that changes is how you access the 
features, and the process for creating an agreement is slightly different. Follow the 
instructions on this page to get started when you have the Lightning Experience enabled. 
Beyond a few different steps, the flows for most Conga CLM tasks remain the same. You 
can also access Contract Management from the Lightning Console. You can use the 
Lightning Console to Generate, Regenerate, Activate, Amend, Renew, Submit Request, 
Terminate, Expire, and Clone an agreement.

Enabling the Lightning Experience in Salesforce
Enabling the Lightning Experience in your Salesforce org is a very simple process, but 
requires some consideration of your company's needs before you make the switch. Please 
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refer to Salesforce's documentation on enabling the Lightning Experience. The topics on this 
page assume that you have already enabled Lightning in your org.

Accessing Contract Management features in Lightning
One of the main differences you will find when you switch to Lightning is how your apps are 
accessed, like Apttus Contract Management. In Lightning, there is no Force.com app menu, 
and you cannot customize the default Tabs to include Custom Objects or Visualforce tabs. 
Instead, you access all Contract Management features using the App Launcher.

Log in to Salesforce with Lightning enabled.
Click the App Launcher button in the upper left-hand corner of the Home screen.
From the App Launcher, click Apttus Contract Management.
Select a Contract Management feature to work with (e.g., "Agreements" to start the 
agreement creation process.)

Creating an Agreement
The process for creating new agreements is slightly different when you have Lightning 
enabled. There are two ways to create a new agreement.

Go to App Launcher > Apttus Contract Management.
Click Agreements.
From the Agreements List, click New. 
OR 
Click the down arrow   next to Agreements tab and click +New Agreement from 
the drop-down menu.
Select an Agreement Record Type and click Continue.
On the New Agreement page, enter values for required fields and any optional fields 
that are available and click Continue.

Click Edit to make more changes to your agreement record, or the pencil icon   to 
make changes to any editable field. Note that all the field values you had entered on 
the previous page, have already been saved to the record.

It is recommended when using the Lightning Experience to configure the above 
page to contain as many fields as you want specified prior moving to the next 
step. You can configure which Agreement fields are available on this page by 
editing the Agreement New Field Set. For more information, see Drafting an 
Agreement.



https://trailhead.salesforce.com/en/lex_migration_introduction/lex_migration_introduction_administration
http://Force.com
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7. Scroll down the page to find Agreement Actions such as Preview, 
Generate, and Import Offline Agreement. Any Visualforce pages you have added to 
the page layout, such as Document Finder or Master Agreement Clauses are also 
displayed on this page and should work normally.
The agreement actions can also be accessed from the Agreement Actions panel on 
the right side of the Agreement Details page. The panel shows the action buttons 
clustered into three sections. You can change the section labels. For more information, 
see Enabling and Customizing Action Panel. The Agreement Life Cycle Actions group 
contains Submit Request, Send for Review, Send for Teams Review, Send for Signature, 
Activate, Cancel, Renew, Terminate, Amend, Send for Adobe Sign, Send for DocuSign, 
and Expire actions. The Document Actions group contains Generate, Regenerate, 
Import Offline Document, Preview, Merge Documents, Generate Supporting Document, 
Upload Signed Document, Review Offline, and Import Supporting Document actions. 
The additional actions group contains Agreement Hierarchy, In Effect, and custom 
actions. For more information on customizing action panel, see Enabling and 
Customizing Action Panel. The action buttons are displayed according to the 
agreement status and status category. 
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2.
3.

1.
2.
3.

1.
2.

Managing Comply System Properties
From the Lightning Home page, click the Setup icon in the upper right-hand corner and 
select Setup Home.
From the Setup navigation menu, go to Custom Code > Custom Settings.
Click Manage next to Comply System Properties.

Managing Contract Management Admin Properties
Go to the App Launcher.
Click Apttus Contract Management.
Click Admin. Create new admin properties or edit existing properties as needed.

Enabling and Customizing the Action Panel
The Action Panel is a collection of agreement action buttons that could be enabled for the 
Agreement Record page in the Lightning Experience mode in Salesforce. Each button in the 
action panel can be customized to meet your design requirements. The Action Panel is 
created as a Visualforce Page component and you can include it in your page layout from 
the Lightning App Builder.

Adding Action Panel to Lightning Record Page
You can add the Action Panel in your Agreement Record page in two ways:

from the Salesforce Classic Agreement Record page, and
from the Lightning App Builder

The following configurations for enabling the Action Panel in your org are 
documented, considering that you have already enabled My Domain in your 
organization. This step is mandatory for using Lightning Experience in your 
Salesforce org. To know how to enable My Domain in your org, refer to Salesforce 
Help page Enable My Domain.



https://help.salesforce.com/articleView?id=domain_name_overview.htm&type=0
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6.

7.

8.

1.
2.
3.
4.

5.

Adding Action Panel Using Lightning App Builder
To use the Lightning App Builder for configuring Action Panel in your page layout, you have 
to create a Lightning Record Page. To create this;

Go to Setup> Objects and Fields> Object Manager.
On the Object Manager page click Agreement object.
On the Details page, click Lightning Record Pages from the left-hand navigation.
In the Lightning Record Pages, click New and select Record Page.
Complete the steps in the new page creation wizard.
In the Lightning App Builder, from the left-hand navigation, drag and drop 
Visualforce component on your layout. You can reorder the components in the page 
layout, to your liking.
From the right-hand navigation pane, go to Visualforce Page Name field and select 
LightningAgreementActions from the picklist. You will now see the action panel in 
your layout
Click Save and then Activate your page, to make the record page available.

Adding Action Panel from Salesforce Classic
The Action Panel can also be added to the Agreement Record page by editing the page 
layout in Classic Salesforce. To do this:

Go to Agreements and select an agreement record.
In the Agreement Record Details page click Edit Layout.
From the Layout Designer menu, choose Visualforce Pages.
Drag and drop the LightningAgreementActions visualforce component on to the 
Agreement Layout.
Click Save.

If you now switch to the Lightning Experience, the Action Panel would be part of the 
Agreement Record layout.

For more details on how to customize a Lightning Record Page, refer to Salesforce 
Help section Configure Lightning Experience Record Pages.



It is recommended that you enable the Action Panel from the Lightning App Builder 
for a better user experience, as the Action Panel is not designed according to the 
Salesforce Classic design. Using the Action Panel with Salesforce Classic mode may 
lead to an inconsistent user experience.



https://help.salesforce.com/articleView?id=lightning_app_builder_customize_lex_pages.htm&type=0&language=en_US&release=208.14
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7.

Customizing Section Labels in Action Panel
You can change the section labels.

Go to Setup > User Interface > Custom Label.
Click the AdditionalActions hyperlink.
Click New Local Translations / Overrides.
From the Language dropdown, select English.
In the Translation Text, enter the custom label name.

Customizing Action Buttons
All the action buttons which are part of the Action Panel can be made visible and 
configured to suit your needs. For using your own customized buttons in the action panel, 
you must create custom formula fields with the required logic and add them to the 
agreement layout. To create a custom formula field for action, follow the naming 
convention outlined:

Go to Setup> Object Manager> Agreement object.
Click Fields and Relationships from the left navigation panel.
Click New to create a new custom field.
Select Formula data type and click Next.
For Field Label, enter <action_name>_Custom. For example, to create a Generate 
button, enter Generate_Custom
The value in field label is automatically copied as Field Name when you click 
anywhere outside the field.
Select the Formula Return Type as Text and click Next.
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8.

9.

10.

a.

b.
c.
d.

Enter the formula for your action button.

Apply the field's access setting and page layout and click Save. Your action button is 
created.
(Optional) If you do not see the configured custom buttons, you have added many 
custom buttons and you need to perform the following actions:

Go to Setup > Object Manager > Agreement > Page Layouts > Agreement 
Layout.
Click the   icon.
Select the Show scrollbars checkbox.
Click OK.

To learn how to create custom fields, refer to Salesforce Help Custom Fields | Salesforce. 

The following table lists the actions that can be customized in the Lightning mode:

Action Name Field Name

Generate Generate_Custom

Regenerate Regenerate_Custom

Preview Preview_Custom

Generate Supporting Documents Generate_SupportingDocument_Custom

Amend Amend_Custom

Terminate Terminate_Custom

Expire Expire_Custom

Renew Renew_Custom

Activate Activate_Custom

Submit Request SubmitRequest_Custom

To display an action button in the Action Panel, make sure that the formula 
entered for the custom formula field returns a non-null value. If the formula 
returns Null value, the action button or field would be hidden in the Action 
Panel.



https://help.salesforce.com/articleView?id=adding_fields.htm&type=0


CLM

558 Copyright ©2022 Apttus Corporation. All rights reserved.
 

Action Name Field Name

Cancel Request CancelRequest_Custom

Send For Review SendForReview_Custom

Send For Signature SendForSignatures_Custom

Send for DocuSign SendForDocusign_Custom

Send for EchoSign SendForEchosign_Custom

Check Docusign Status CheckDocusignStatus_Custom

Import Offline Document ImportOfflineDocument_Custom

Import Large File ImportLargeFile_Custom

Merge Documents MergeDocument_Custom

Upload Signed Document UploadSignedDocument_Custom

Review Offline Document ReviewOfflineDocument_Custom

View Agreement Hierarchy ViewAgreementHierarchy_Custom

In Effect View InEffectView_Custom

Upload Reviewed Document UploadReviewedDocument_Custom

Send for Conga Sign SendForCongaSign_Custom

Thus, you can create customized links or buttons and then add them to the action panel. 
For information on configuring the availability of the custom buttons, see Configuring the 
Availability of Custom Buttons

Adding Wizard Launcher Tab in Lightning
You can configure the Wizard Launcher tab to appear on the navigation menu.
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•

To add wizard tab
Click the Personalize you nav bar icon ( ).
Click the Add More Items button.
Select All from the Available Items panel.
In the search box, enter Wizard Launcher.
Click the   icon.
Click the Add 1 Nav Item button.
Reorder according to your requirement and click Save.

Appendices
Use these appendices to find the following information:

Agreement Fields
Agreement Actions
Agreement Status Categories and Statuses
Admin Entries
Comply System Properties
Comply Custom Properties
Custom Permissions
CLM Glossary
Frequently Asked Questions
Conga CLM Limitations
Comply User Properties

 

Agreement Fields
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Field 
Label

Description Data Type Required Default 
Value

Reserved

Agreement 
Name

Unique identifier for 
the agreement record. 
This name appears in 
page layouts, related 
lists, lookup dialogs, 
search results, and 
key lists on tab home 
pages. By default, 
this field is added to 
the custom object 
page layout as a 
required field.

Text(80) Yes  Yes

Created By User who created the 
record

Lookup(User) Yes – 
System 
assigned

 Yes

Last 
Modified By

User who most 
recently changed the 
record

Lookup(User) Yes – 
System 
assigned

 Yes

Owner Assigned owner of the 
agreement record

Lookup(User) Yes – 
System 
assigned, 
changeable 
by user

Login User Yes

Record 
Type

The agreement type 
for this record

Record Type Yes Agreement 
Type from 
selection 
screen

Yes

Account The link to the 
account record to 
identify the external 
party to this 
agreement.

Lookup(Account) Yes  Yes
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Field 
Label

Description Data Type Required Default 
Value

Reserved

Activated 
By

Auto-populated with 
the user who 
activates the 
agreement in the 
system. Read-only

Lookup(user)    

Activated 
Date

Auto-populated with 
the date on which the 
agreement was 
activated in the 
system. Read-only.

Date    

Agreement 
Category

Used to categorize 
agreement types. This 
can be agreement 
type specific (add 
appropriate values 
for each agreement 
type) and can also be 
used for template 
filtering.

Picklist    

Agreement 
End Date

The end date for this 
agreement. A required 
field on activation, if 
the agreement is not 
perpetual.

12 months from 
billing 
activation

yes  Yes

Agreement 
Number

The system assigned 
unique agreement 
number. Identifies the 
agreement number, 
including the version 
number.  Use this field 
to display on screens, 
reports, dashboards, 
search filters and 
columns, etc.

Auto Number Yes   Yes. Not 
changeabl 
e by user.
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Field 
Label

Description Data Type Required Default 
Value

Reserved

Agreement 
Start Date

The effective date of 
the agreement. A 
required field on 
activation.

Date yes  Yes

Amendmen 
t Effective 
Date

The date from which 
the amendment is 
effective. If set during 
agreement creation, 
this field is auto- 
populated in the 
amended agreement.

Date    

Auto Renew Indicates whether the 
agreement will auto 
renew

Check box    

Auto 
Renewal 
Terms

Specifies any terms 
associated with auto 
renewal

Long Text Area 
(32000)

   

Business 
Hours

Corporate Business 
Hours associated 
with the agreement; 
used for cycle time 
reporting.

Lookup(Business 
Hours)

   

Company 
Signed By

Link to contact record 
to identify internal 
signatory

Lookup(Contact) Yes    

Company 
Signed 
Date

Date when internal 
signatory signed

Date yes   

Company 
Signed Title

Title of person signing 
on behalf of 
Company

Text(80)    
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Field 
Label

Description Data Type Required Default 
Value

Reserved

Contract 
Duration 
(Days)

The duration from 
Start Date to End 
Date in days. Shown 
when agreement is 'In 
Effect'.

Formula(number 
)

yes   

Contracted 
Days

Days from Contract 
Start Date to Current 
Date if the contract is 
In Effect and Start 
Date is set.

Formula(number 
)

yes   

Description Detailed description 
of this agreement

Long Text 
Area(32000)

yes   

Executed 
Copy 
Mailed Out 
Date

Date the final, 
executed copy was 
mailed out to the 
external party

Date    

Executed 
Date

This is a date field 
that is auto- 
populated when a 
document is eSigned 
(Adobe Sign or 
DocuSign) by all the 
recipients. A user can 
manually enter the 
date when the 
document has wet 
signatures and when 
the signed document 
is uploaded 
manually.

Date    
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Field 
Label

Description Data Type Required Default 
Value

Reserved

Initiation 
Type

To indicate whether 
this record is being 
filed as an executed 
agreement or is being 
negotiated in the 
system

Picklist(Negotiat 
e Contract, 
Store Executed 
Contract)

Yes  Yes. Not 
changeabl 
e by user.

Internal 
Renewal 
Notification 
Days

Notification period 
prior to Renewal 
Notice Date when 
notification is sent 
out internally that 
renewal is 
approaching. Email 
alert needs to be 
setup, if needed.

Number yes   

Internal 
Renewal 
Start Date

Auto populated with 
Date by which 
internal notice of 
internal renewal is 
approaching. Issue 
Renewal Notice Date 
less internal renewal 
notification days.

Date Yes – 
System 
assigned, 
changeable 
by user

  

Non 
Standard 
Legal 
Language?

To indicate whether 
this agreement 
contains non- 
standard language

Checkbox    

Other 
Party 
Returned 
Date

The date on which 
other party returned 
signed agreement

Date    
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Field 
Label

Description Data Type Required Default 
Value

Reserved

Other 
Party Sent 
Date

Auto populated with 
the Date on which 
agreement was first 
sent to other party 
for review/signatures

Date    

Other 
Party 
Signed By

Link to contact record 
to identify external 
signatory

Lookup(Contact)    

Other 
Party 
Signed By 
(Unlisted)

External Signatory 
identifier (when 
signatory is not 
maintained as 
contact (record) in the 
system).

Text Area    

Other 
Party 
Signed 
Date

Date when external 
signatory signed

Date    

Other 
Party 
Signed Title

Title of person signing 
on bahalf of Other 
Party

Text    

Outstandin 
g Days

Shows the number of 
days between date 
agreement was 
today, if not returned 
as yet. Else number of 
days between 
returned and sent.

Formula(number 
)

   

Owner 
Expiration 
Notice

To indicate the 
number of days prior 
to expiration date 
that a notification 
needs to be sent to 
the owner

Picklist(60-45-15 
-1)

 90 Days  
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Field 
Label

Description Data Type Required Default 
Value

Reserved

Parent 
Agreement

Reference to parent 
agreement if current 
agreement was 
created as child or 
assigned manually.

Lookup(Agreeme 
nt) 

   

Perpetual Identifies whether the 
agreement has a 
specified end date or 
if it is open ended

Checkbox    

Primary 
Contact

Primary external 
contact for the 
agreement.

Lookup(Contact)    

Related 
Opportunit 
y

Identifies the 
opportunity related 
to the agreement

Lookup 
(opportunity)

   

Remaining 
Contracted 
Days

If the agreement is In 
Effect, this value is 
calculated as 
Contract Duration 
Days less Contracted 
Days.

Formula(number 
)

   

Renewal 
Consent

Indicates whether 
consent is required to 
extend / renew this 
agreement

Checkbox    

Renewal 
Notice 
Date

Issue Renewal Notice 
Date = End Date - 
Renewal Notice Days

Formula(Date)    

Renewal 
Notice 
Days

The number of days 
before end date when 
renewal notice is due

Number    
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Field 
Label

Description Data Type Required Default 
Value

Reserved

Renewal 
Term 
(Months)

The number of 
months to extend the 
agreement

Number    

Renewal 
Terms

Specifies any terms 
for renewal

Text Area    

Request 
Date

The date the 
agreement was 
requested

Date    

Requestor Agreement Requestor 
(user).

Lookup(user)    

Risk Rating This field allows users 
to track agreement 
risk rating

Number(5, 2)    

Source Source of this 
contract – internal 
paper or third party 
contract

Picklist   Yes. Not 
changeabl 
e by user.

Special 
Terms

Identifies any special 
terms related to 
contract

Text Area    
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Field 
Label

Description Data Type Required Default 
Value

Reserved

Status The substage of an 
agreement – the 
status underneath a 
given status 
category.  These are 
generally modifiable 
by the customer 
except for the 
following values 
which are Conga 
CLM reserved to 
manage agreement 
life cycles: Request, 
Submitted Request, 
Cancelled Request, In 
Amendment, Being 
Amended, 
Superseded, 
Activated, Expired, 
Internal Signatures, 
Author Contract, 
Expired, Terminated,  
Ready for Signatures, 
Fully Signed, 
Signature Declined

Picklist    

Status 
Category

The higher-level state 
of the agreement – In 
Authoring, In Effect, 
Expired, etc.  These 
are Conga 
CLM reserved values

Picklist 
(Request , In 
Authoring,  In 
Signatures,  In 
Filing, In Effect, 
Expired, 
Terminated, 
Amended, 
Cancelled)

Yes – 
System 
Assigned

 Yes. Not 
changeabl 
e by user.

Submit 
Request 
Mode

 Picklist    
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Field 
Label

Description Data Type Required Default 
Value

Reserved

Subtype The subtype of the 
agreement for a given 
agreement type. 
Please specify values 
based on your 
agreement types

Picklist (Default)    

Term 
(Months)

Identifies the term, in 
months, of an 
agreement from the 
agreement start 
date 

Number    

Terminatio 
n Date

Date contract 
terminated

Date    

Terminatio 
n Notice 
Days

Notice period prior to 
termination

Number    

Terminatio 
n Notice 
Issue Date

Date termination 
notice was sent / 
received

Date    

Total 
Agreement 
Value

Total value of 
agreement

Currency (16, 2)    

Version The version number of 
the agreement that is 
incremented each 
time an agreement is 
amended

Number (3,0) Yes – 
System 
Assigned

 Yes
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Field 
Label

Description Data Type Required Default 
Value

Reserved

Version 
Aware

Indicates whether the 
Agreement record is 
Version Aware. If 
checked, versioning is 
enabled for all 
documents belonging 
to the agreement 
record. This field is 
checked by default 
for all new 
agreements when 
Document Versioning 
is enabled (Comply 
System Properties 
Enable Version 
Control and Enable 
Document Versioning).

Checkbox    

Activate Link to activate the 
agreement; Shown 
only in desired 
statuses.

Action    

Amend Link to amend the 
agreement; Shown 
only for active 
agreements.

Action    

Cancel 
Request

     

Expire Link to expire the 
agreement; Shown 
only for active 
agreements.

Action    
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Field 
Label

Description Data Type Required Default 
Value

Reserved

Generate Link to generate 
agreement document 
using one of the 
templates in library. 
Shown only is 
appropriate 
agreement statuses. 
Attaches generated 
doc under Notes & 
Attachment and 
creates 3 tasks. Write 
activity history. 
Changes status from 
"Request" to "In 
Signatures/Ready for 
signatures"

Action    

Generate 
Supporting 
Document

Link to generate 
supporting document 
using one of the 
templates in library. 
Shown only is 
approriate 
agreement statuses.

Action    

Insert 
Offline 
Document

Link to add an 
external/offline 
document to the 
agreement record. 
Shown only is 
appropriate 
agreement statuses.

Action    

Preview  Action    
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Field 
Label

Description Data Type Required Default 
Value

Reserved

Regenerate Regenerate a new 
agreement doc using 
one of the templte in 
the library. The new 
version will not have 
redlines (if any) from 
the earlier versions.

Action    

Renew Start Renewal of an 
active agreement.

Action    

Return To 
Requestor

Return the agreement 
to Requestor.

Action    

Send For 
eSignature

Send document to 
external party using 
EcoSign/Docusign 
integration. Status 
changes to "In 
Signatures/Other 
party Signatures"

Action    

Send For 
Review

Send agreement for 
other party review. 
Status changes to "In 
Authoring/Other 
Party Review"

Action    

Send For 
Signatures

Send document for 
Signatures. Status 
changes to "In 
Signatures/Other 
party Signatures"

Action    

Submit 
Request

 Action    

Terminate  Action    
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Agreement Actions
The Type and the actions vary according to the agreement status. The following table 
describes the Actions available at various stages of the Agreement and their significance:

Preview
 

Action Preview Agreement

Description Generates a Draft version of an agreement document based on 
the template set up for the agreement type. The draft agreement 
is rendered in the MS-Word format. If more than one agreement 
template is set up, you are prompted to pick a specific template.

Availability If Status Category = Request

Post Status N/A

Comments This action does not place the generated document in the Notes & 
Attachments related list.

 

Generate
 

Action Generate Agreement
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•

•

Description Generates the first version of an agreement document and 
attaches a copy of the same to the agreement record.

When you initiate the Generate action, you are navigated to an 
intermediary screen to select additional information about the 
document to be generated. Select DOC for an MS Word document, 
RTF for Rich Text Format, or PDF for a PDF protected document. 
Additionally, if document protection has been enabled for you, you 
can generate a document with the appropriate protection options.

The first draft version of the agreement is generated, rendered on 
the screen the in MS-Word format and attached to the system in 
the Notes & Attachment or Document Versions (if the document is 
Version Aware) related list on the agreement details page. 
You can:

Save it to the desktop, close the MS-Word application, and 
come back to the agreement record later.
Access the agreement document from the Notes & 
Attachments section (click on the View link corresponding to 
the document).

 

Availability If Status Category = Request

Post Status Sets the status for an agreement to Ready for Signatures.

Comments In the version aware agreements, the Document Type of the 
generated document is updated as Agreement Document.

 

Regenerate
 

Action Regenerate Agreement
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Description Regenerates a new version of the agreement document from a 
selected template based on values from the agreement record. 
The regenerated agreement document is attached to the Notes & 
Attachments or Document Versions (if the document is Version 
Aware) related list. Because it is regenerated from template, any 
red lines made in previous version are not be carried into this 
version and must be manually applied.

Availability If Status Category = In Authoring or In Signatures

Post Status N/A

Comments In the version aware agreements, the Document Type of the 
regenerated document is updated as Agreement Document.

 

Generate Supporting Document
 

Action Generate Supporting Document

Description Generates a document from a template of type “Supporting 
Document” and attaches the same to the agreement record. It 
can be used for Agreement Summary, Renewal Letter, 
Termination Letter, etc.

Availability N/A

Post Status N/A

Comments This can be used to generate an agreement summary. In the 
version aware agreements, the Document Type of the generated 
supporting is updated as Supporting Document.

 

Send for Review
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Action Send for Review

Description Allows you to select one or more attachments from the 
Agreement record and from related parent/child agreements, 
select an email template, address the same, and send it out.

Availability If Status Category = In Signatures or In Authoring

Post Status Sets the status for an agreement to Other Party Review.

Comments  

Send for Signatures
 

Action Send for Signatures

Description Allows user to select one or more attachments from the 
Agreement record and from related parent / child agreements, 
select an email template, address the same, and send it out as a 
final copy for Signatures.

Availability If Status Category = In Signatures or In Authoring

Post Status Sets the status for an agreement to Other Party Signatures.

Comments  

 

Import Offline Document
 

Action Import Offline Document
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•

•

•
•

Description Imports a third-party agreement document and 
attaches it to the agreement record.
Allows the user to use the attached document in the 
Apttus Author process.

Availability If Status Category = Request or In Authoring or In Filing

Post Status N/A

Comments In the version aware agreements, the Document Type of the 
imported document is updated as Agreement Document.

 

Activate
 

Action Activate

Description Marks the agreement as a finalized, executed agreement.
Prompts the user to select which attachment is the signed 
copy and records the same in activity history.

Availability If Status Category = In Signatures

Post Status Sets Status Category = In Effect, Status = Activated. If an 
Amendment or Renewal is being Activated, sets Status Category 
of Original Agreement to Amended or Renewed and Status to 
Superseded.

Comments  

 

Amend
 

Action Amend
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Description Creates a new dot version of the Agreement (nnnn.1, nnnn.2, 
and so on) after doing a deep copy of the agreement fields and 
related objects.

Availability If Status Category = In Effect

Post Status Sets Status of Original Agreement to Being Amended, and 
Status Category of New Agreement to Request and Status to 
In Amendment

Comments On amending an agreement, the documents inherit Document 
Type from the original agreement.

 

Renew
 

Action Renew

Description Creates a new dot version of the Agreement (nnnn.1, nnnn.2, and 
so on) after doing a deep copy of the agreement fields and 
related objects.

Availability If Status Category = In Effect

Post Status Sets Status of Original Agreement to Being Renewed, and 
Status Category of New Agreement to Request and Status to In 
Renewal.

Comments Agreement End Date must be in the past. On renewing an 
agreement, the documents inherit Document Type from the 
original agreement.

 

Expire
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Action Expire

Description Sets the Agreement to an Expired or Lapsed Status.

Availability If Status Category = In Effect

Post Status Sets Status Category to Expired and Status to Expired.

Comments  

 

Terminate
 

Action Terminate

Description Sets the Agreement to a Terminated state.

Availability If Status Category = In Effect

Post Status Sets Status Category to Terminated and Status to 
Terminated.

Comments  

 

Cancel Request
 

Action Cancel Request

Description Voids an Agreement Request.

Availability If Status Category = Request or In Authoring or In Signatures 
and Status <> Cancelled Request
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•

Post Status Sets Status to Cancelled Request
If an Amendment is being Cancelled, sets Status 
Category of Original Agreement to In Effect and Status 
to Activated

Comments  

Agreement Status Categories and Statuses
This section describes the purpose of status categories and associates Statuses.

Request
This Status Category indicates that the Contract is in the Request stage.

Stage Description

Request New request

Request Approval Request being approved

Submitted Request Request submitted

Approved Request Request approved

Cancelled Request Contract request cancelled

In Amendment Contract being amended

In Authoring
This Status Category indicates that the contract is in the Authoring stage.

Stage Description

Author Contract Contract being authored

Language Approval Language being approved
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Stage Description

Language Approved Language approved

Internal Review Contract in an internal review

Other Party Review Contract in an other party review

Signature Declined Signature is declined

In Signatures
This Status Category indicates that the contract is in the Signatures stage.

Stage Description

Internal Signatures Contract sent for internal signatures

Other Party Signatures Contract sent for other party signatures

In Reconciliation Terms are being reconciled

Reconciled Terms reconciliation completed

Signature Declined Signature is declined

Ready for Signatures Contract ready for internal or other party signatures

Fully Signed Contract fully signed and ready for activation.

In Filing
This Status Category indicates that the contract is in the Filing stage.

Stage Description

In Reconciliation Terms are being reconciled

Reconciled Terms reconciliation completed
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In Effect
This Status Category indicates that the contract is in the Effect stage.

Stage Description

Activated Active Contract

Being Amended Contract is in the amendment process

Being Renewed Contract is in the renewal process

Superseded Contract is superseded.

Being Terminated Contract is in the termination process

Expired
This Status Category indicates that the contract is in the Expired stage.

Stage Description

Expired Contract expired

Terminated
This Status Category indicates that the contract is in the Terminated stage.

 

Stage Description

Terminated Contract terminated

Amended
This Status Category indicates that the contract is in the Amended stage.
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Stage Description

Amended Contract amended

Cancelled
This Status Category indicates that the contract is in the Cancelled stage.

Stage Description

Cancelled Contract cancelled

Agreement Status Category Map
The Status Category and Status combination determines the actions available for a 
particular agreement. The Status category map provides an idea of various agreement 
status categories during the contract lifecycle. The following table describes the purpose of 
agreement status category maps:

 

Status 
Categor 
y

Requ 
est

In 
Author 
ing

Revi 
ew

In 
Signat 
ures

In 
Filing

In 
Effect

Expi 
red

Termi 
nated

Ame 
nded

Canc 
elled

Status           

Request          

Request 
Approval

         

Submitte 
d Request

         

Approved 
Request

         

Cancelle 
d Request
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Status 
Categor 
y

Requ 
est

In 
Author 
ing

Revi 
ew

In 
Signat 
ures

In 
Filing

In 
Effect

Expi 
red

Termi 
nated

Ame 
nded

Canc 
elled

In 
Amendme 
nt

         

Author 
Contract

         

Languag 
e 
Approval

         

Languag 
e 
Approved

         

Import          

Internal 
Review

         

Other 
Party 
Review

         

Internal 
Signature 
s

         

Other 
Party 
Signature 
s

         

Activated          

Being 
Amended
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Status 
Categor 
y

Requ 
est

In 
Author 
ing

Revi 
ew

In 
Signat 
ures

In 
Filing

In 
Effect

Expi 
red

Termi 
nated

Ame 
nded

Canc 
elled

Being 
Renewed

         

Supersed 
ed

         

Being 
Terminat 
ed

         

Terminat 
ed

         

Expired          

In 
Reconcili 
ation

        

Reconcile 
d

        

Signature 
Declined

        

Ready for 
Signature 
s

         

Fully 
Signed

         

Admin Entries
You must configure admin entries to meet the business objectives of your implementation 
along with Comply System Properties. Admin entries are system properties that have 
different values and you can use them for different purposes. 

https://documentation.conga.com/display/CLM/.Comply+System+Properties+vWinter-20
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1.

2.
3.

 To create admin entries
Click + and click Admin. All the out-of-the-box Admin entries are displayed on the 
Admin home page. Based on your organizations' requirements, you can add or create 
new Admin entries.
To create a new Admin entry, click New.
Type Name, Value, and Code for the Admin entry and click Save. Your new Admin 
entry is saved and added.

Admin Entries in CLM
The following content provides information about various admin entries available in CLM 
along with their values and purposes.

APTS_AccountHierarchyFields
The APTS_AccountHierarchyFields property allows you to add a maximum of 4 fields that 
must be displayed on the Agreement Hierarchy for an account. If no value is provided for 
The property, Account Name, Account Number, and Account Owner fields are displayed. For 
more information, see Viewing Agreement Hierarchy of an Account.

Name APTS_AccountHierarchyFields

Value <Field API Name>:<User defined field label>

Sample Value: AccountNumber:Account Number,OwnerId:Account 
Owner,Owner.Name:Owner Name,AccountSource:Account Source

Code N/A

APTS_AgreementHierarchyFields
The APTS_AgreementHierarchyFields property allows you to add a maximum of 4 fields 
that must be displayed on the Agreement Hierarchy page. If no value is provided for The 
property, the Agreement Number and Status Category fields are displayed. For more 
information, see Viewing Agreement Hierarchy.
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Name APTS_AgreementHierarchyFields

Value <Field API Name>:<User defined field label>

Sample Value: Apttus__Contract_End_Date__c:End 
Date,Apttus__Activated_Date__c,Apttus__Agreement_Number__c:Agreem 
ent Number

Code N/A

APTS_AgreementStatusOnClauseApproval
This property allows you to define the status and status category of an agreement to be 
updated after all clauses are approved, canceled, or rejected in the agreement.

When this property is not configured, the status and status category of an agreement is not 
updated after all clauses are approved, canceled, or rejected in the agreement.

Name APTS_AgreementStatusOnClauseApproval

Value Value: Status Category|Status

Sample value: In Signature|Ready for Signature

Code N/A

APTS_AppendVersionNumberToMergedDocs
When the value of the APTS_AppendVersionNumberToMergedDocs admin entry is true and 
the Document Versioning Properties are enabled, the name of the merged documents will be 
suffixed with a version number. For more information, see Merging Documents in Lightning.

Name APTS_AppendVersionNumberToMergedDocs

Value True

Code N/A

APTS_AsyncMergeCall 
Publishing a template takes the text from any referenced clauses and enters it inline as 
part of the template text. This functionality allows the clause template changes to be 
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reflected in the agreement template and creates a newly published version document in 
the Notes and Attachment section of the Template. Whenever the agreement document 
generation exceeds 60 seconds, users get a timeout message and this is not an error 
message. To make sure the status changes during this scenario, add these Admin entries. 
For more information, see Document Generation Features List.

Name APTS_AsyncMergeCall 

Value True

Code N/A

APTS_AsyncMergeEmail
When the APTS_AsyncMergeEmail property is set to true, you will receive an email 
notification after the signed document is uploaded in an agreement. For more information, 
see Document Generation Features List.

Name APTS_AsyncMergeEmail

Value True

Code N/A

APTS_AutoContentSearchable
The APTS_AutoContentSearchable property automatically enables Content Search on an 
activated agreement. By setting the flag to true, the system skips the prompt to select 
attachments for content search. The attachment already selected as part of the 
activation process will be automatically enabled for content search. For more information, 
see Routing Documents to Content Libraries and Activating an Agreement.

Name APTS_AutoContentSearchable

Value True

Code N/A
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•
•

APTS_ComplyConfig
The APTS_ComplyConfig property allows you to configure the custom objects that need to 
be cloned as part of the agreement clone, amend, and renew operation. 

Name APTS_ComplyConfig

Value XML

Code You need to provide the configuration in the Code field. For more 
information, see Configuring APTS_ComplyConfig.

The APTS_ComplyConfig property along with Enable PDF Security (comply system 
property) allows you to control restrictions for agreement documents:

Generated in PDF format.
Checked-in from X-Author Contracts as Final-to be signed with Create PDF 
attachment option selected. 

Name APTS_ComplyConfig

Value XML

Code You need to provide the configuration in the Code field. For more 
information, see PDF Security for Agreement Documents.

APTS_ContentRecordTypeName
The APTS_ContentRecordTypeName property is used to indicate the content type to 
associate the published documents with. If The property is not specified, no content type 
will be used. For more information, see Routing Documents to Content Libraries.

Name APTS_ContentRecordTypeName

Value <content type name>

Sample value: Agreements

Code N/A
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APTS_ContentRepositoryType
The APTS_ContentRepositoryType property allows you to define which content repository 
must be used for routing documents. The supported setting "content" to use content 
repository settings for routing documents. The default setting is "document," which routes 
all activated documents to an Apttus folder. Changing this setting tells the system to use 
content repository settings for routing documents. For more information, see Routing 
Documents to Content Libraries.

To activate documents that exceed the file size of 40MB, you must set the value to content 
or chatter. For more information, see Activating an Agreement.

Name APTS_ContentRepositoryType

Value <content repository type>

Default value: document

Supported values: content, chatter

Code N/A

 

APTS_CustomLinksforActionPanel
The APTS_CustomLinksforActionPanel property enables you to add and customize the 
action panel. For more information, see Enabling and Customizing the Action Panel.

Name APTS_CustomLinksforActionPanel

Value N/A

Code <API name of button>

Sample 
code 
: 
  
Preview_Custom__c,Generate_Supporting_Document_Custom__c,Generat 
e_Custom__c,Generate_Supporting_Document_Custom__c,Generate_Cust 
om__c,
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APTS_CycleTimeReportingEnabled
The APTS_CycleTimeReportingEnabled property allows to track the time spent in between 
two statuses or status Categories. Entry for the specified status changes under Cycle Time 
Group tab must be created. For more information, see Cycle Time Reporting.

Name APTS_CycleTimeReportingEnabled

Value True

Code N/A

APTS_DefaultContentWorkspaceName
The APTS_DefaultContentWorkspaceName property is used to indicate the default content 
workspace to publish the documents selected by the user during the agreement activation 
process. The user activating the agreement must be a member of the default content 
workspace. For more information, see Using Agreement Rules to Route Content.

Name APTS_DefaultContentWorkspaceName

Value <default workspace name>

Code N/A

APTS_DefaultEmailContactName
The APTS_DefaultEmailContactName property allows you to specify the name of the 
default contact to resolve merge fields in an email template. To specify the name of a 
contact to send emails to, if a contact is not defined for the agreement. If The property is 
not defined and the agreement does not have a primary contact, the merge fields in the 
email would not be resolved to their values. For more information, see Sending an 
Agreement Document for Parallel Review.

Name APTS_DefaultEmailContactName

Value <Name of the contact>
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Code N/A

APTS_DefaultEmailTemplateFolder
The APTS_DefaultEmailTemplateFolder property allows you to add the name of the 
default email template folder. For more information, see Sending an Agreement Document 
for Parallel Review.

Name APTS_DefaultEmailTemplateFolder

Value <email template folder name>

Code N/A

APTS_DefaultHeaderFooterOptionForMerge
The APTS_DefaultHeaderFooterOptionForMerge property allows you to set the Retain 
Header and Footer or Custom Header and Footer checkbox selected by default on the 
Merge Documents page. For more information, see Merging Documents in Lightning.

Name APTS_DefaultHeaderFooterOptionForMerge

Value Retain Header and Footer or Custom Header and Footer

Code N/A

APTS_DEFAULT_PACKAGE
The  APTS_DEFAULT_PACKAGE property allows you to connect X-Author for Contracts to 
both Conga CLM (Contracts for Salesforce) and Conga CLM packages when they are 
installed in the same org. For more information, see Installing Production X-Author for 
Contracts.

Name APTS_DEFAULT_PACKAGE

Value <CLM or CFS>

Code N/A

https://documentation.conga.com/x-author-for-contracts/spring-21/installing-production-x-author-for-contracts-143887561.html
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APTS_DocumentNamingConvention_<RecordType label 
name>
The APTS_DocumentNamingConvention_<RecordType label name> property allows you to 
define a specific naming convention for the generated files based on the record types. If 
there are no naming conventions defined for the record types in the Admin Entry, the 
Document Naming Convention defined in Comply System Properties is used as the naming 
convention for the generated files. For more information, see Contract Document Versioning.

Name APTS_DocumentNamingConvention_<RecordType label name> 
Sample name: APTS_DocumentNamingConvention_NDA

Value <naming convention>

Code N/A

APTS_DocumentSearchBasicFilters
The APTS_DocumentSearchBasicFilters property allows you to add fields that must be 
displayed on the Document Search page in the Basic Filters section. If The property is not 
defined, Agreement Number, Agreement Name, Owner ID, Status, Status Category, 
Agreement Start Date, Agreement End Date, Account, and Record Type fields are 
displayed. If The property is defined, the defined fields along with Account and Record Type 
fields are displayed. The Account and Record Type fields are displayed irrespective of the 
property. For more information, see Searching Agreement Documents.

Name APTS_DocumentSearchBasicFilters

Value N/A

Code <Field API Name>,<Field API Name> 
Sample Code: 
Apttus__Contract_End_Date__c,Apttus__Activated_Date__c,Apttus__Ag 
reement_Number__c

Ensure that you create only one naming convention per record type.
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APTS_DocuSignRetrieveAsCombinedRecordType
The APTS_DocuSignRetrieveAsCombinedRecordType property enables you to combine the 
documents, based on the record type, when you send for signatures using DocuSign. If you 
set to the property to "all;<recordtype>;<recordtype>;<recordtype>", all takes precedence 
over the record types. This admin entry overrides the system 
property RetrieveAsCombinedDocument in DocuSign. For more information, see Retrieving 
DocuSign Certificate of Completion.

Name APTS_DocuSignRetrieveAsCombinedRecordType

Value  semicolon separated record type names or all

Sample value: NDA;sla;MSA

Code N/A

APTS_DoNotCopyOpportunityToAdobeAgreement
Deprecated. For information on the new custom setting, see Configuring Conga-Adobe 
Custom Settings.

APTS_DoNotPrefixCurrency
In the multicurrency enabled orgs, the APTS_DoNotPrefixCurrency property allows you to 
not prefix currency symbols before the currency-related fields in the generated documents 
based on the Enable Formatting value in X-Author for Contracts. For more information, see 
Defining Template Locale.

Name APTS_DoNotPrefixCurrency

Value True

Code N/A

https://documentation.conga.com/dsign/latest/retrieving-docusign-certificate-of-completion-143889340.html
https://documentation.conga.com/esign/latest/configuring-conga-adobe-custom-settings-143904541.html
https://documentation.conga.com/x-author-for-contracts/latest/defining-template-locale-161156368.html
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APTS_DownloadableLinkExpiration
If no value is added, the viable days of the downloadable link are considered as 7 days and 
after 7 days the downloadable link will be inaccessible. For more information, see Emailing 
Multiple Agreement Documents.

Name APTS_DownloadableLinkExpiration

Value <number of days to expire the downloadable link>

Code N/A

APTS_EmailTemplateForReview
The APTS_EmailTemplateForReview property allows you to add the name of the email 
template for Send for Review action. For more information, see Configuring Email 
Templates in Lightning.

Name APTS_EmailTemplateForReview

Value <template name or template unique name>

Code N/A

APTS_EmailTemplateForReviewSignatures
The APTS_EmailTemplateForReviewSignatures property allows you to add the name of the 
email template to use for Send for Review and Send for Signatures actions. The property is 
only used if APTS_EmailTemplateForReview and APTS_EmailTemplateForSignatures are 
not specified. For more information, see Configuring Email Templates in Lightning.

Name APTS_EmailTemplateForReviewSignatures

The property can only specify values for Email Templates with the "Available for 
Use" flag set to true.



The property can only specify values for Email Templates with the "Available for 
Use" flag set to true.
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Value <email template name or email template unique name>

Code N/A

APTS_EmailTemplateForSignatures
The APTS_EmailTemplateForSignatures property allows you to add the name of the email 
template for Send for Signatures action. For more information, see For more information, 
see Configuring Email Templates in Lightning.

Name APTS_EmailTemplateForSignatures

Value <email template name or email template unique name>

Code N/A

APTS_EnableCustomEmailAddressLookup
The APTS_EnableCustomEmailAddressLookup property enables you to launch the custom 
Email Address Lookup pop-up for the Send for Review and Send for Signature functionalities. 
On this page, you can quickly search and select contacts for the Additional To, Cc, and Bcc 
fields, if there is a large number of contacts (for example, more than one million). For more 
details, see Sending an Agreement Document for Review and Finalizing an Agreement.

Name APTS_EnableCustomEmailAddressLookup

Value True

Code N/A

APTS_EnableTermExceptionsInAuthor
The APTS_EnableTermExceptionsInAuthor property associates the Agreement Term 
Exception related list to the Agreement record after you have associated your Term 

The property can only specify values for Email Templates with the "Available for 
Use" flag set to true.
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Exception with the clause and the clause is inserted in your agreement template. For more 
information, see Configuring Agreement Term Exception.

Name APTS_EnableTermExceptionsInAuthor

Value True

Code N/A

APTS_EnableValidationForEmailWithoutUserContact
Setting the APTS_EnableValidationForEmailWithoutUserContact property to true displays 
an error message while sending a document for signatures or review when the email IDs or 
contacts specified in the To or Additional To fields are invalid. For more information, 
see Sending an Agreement Document for Parallel Review.

Name APTS_EnableValidationForEmailWithoutUserContact

Value True

Code N/A

APTS_InEffectViewMetadataFields
The APTS_InEffectViewMetadataFields property allows you to add fields that must be 
displayed on the In-Effect View page in the Agreement Details In Effect section. If The 
property is not defined, Agreement Name, Agreement Start Date, Agreement End Date, 
Term (Months), and Total Agreement Value fields are displayed. If The property is defined, 
only the defined fields are displayed, but not the default fields. For more information, see 
Accessing In-Effect View.

Name APTS_InEffectViewMetadataFields

Value N/A

Code <Field API Name>,<Field API Name>

Sample code: 
Apttus__Contract_End_Date__c,Apttus__Term_Months__c,Apttus__Tota 
l_Contract_Value__c
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APTS_IsRequiredToVerifyApttusMetadata
When you configure this admin entry and check-out an agreement document in X-Author 
Contracts, you can restore the metadata of a corrupted agreement document. For more 
information, see Restoring Document Metadata.

Name APTS_IsRequiredToVerifyApttusMetadata

Value True

Code N/A

APTS_ExcludedNamespaces
This admin entry allows you to add a comma-separated list of namespaces to exclude 
objects from the wizard dropdown.

If you have configured this admin entry multiple times, then the latest configured admin 
entry is considered to exclude objects from the wizard dropdown. If this admin entry is not 
configured, the value provided in the Excluded Namespaces comply system property will be 
considered to exclude objects from the wizard dropdown. 

Name APTS_InEffectViewMetadataFields

Value N/A

Code Code: comma-separated objects

Sample Code: Apttus__OCCAccessMode__c, Apttus__IDE

APTS_KeepSectionBreaks
When you set the APTS_KeepSectionBreaks admin entry to false, page breaks are not 
added between merged documents.

Name APTS_KeepSectionBreaks

Value False

Code N/A

https://documentation.conga.com/x-author-for-contracts-1/restoring-document-metadata-158339719.html
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APTS_LargeDocSObjects
By default, CPQ and CLM consider Proposal Line Item and Agreement Line Item as Large 
Objects for document generation. In case you used any other object in a template, you must 
use the APTS_LargeDocSObjects property to define such objects as Large objects. You can 
specify multiple objects as Large Objects and also provide a batch size for each of these 
objects. 

Name APTS_LargeDocSObjects

Value N/A

Code <Object_API_name=<Batch Size>>

Sample code: 

Apttus_QPConfig__ProposalLocation__c=5 
QTC_Proposal_Related_Line_Item_c=1000

APTS_MergeCallTimeOut
Whenever the agreement document generation exceeds 60 seconds, the timeout message is 
displayed. This is NOT an error message. To make sure the status changes during this 
scenario, add these Admin entries. For more information, see Objects Supporting Document 
Generation.

Name APTS_MergeCallTimeOut

Value True

Code N/A

APTS_MS_EnableNameSort
The APTS_MS_EnableNameSort property allows you to specify whether the related list 
should be sorted by the name field in the generated agreement document. When enabled 
the related lists will be printed in the agreement’s merge documents in the order of the 
name field of the related list. 

Name APTS_MS_EnableNameSort
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Value True

Code N/A

APTS_NoISOCurrencyFieldObjects
Use the APTS_NoISOCurrencyFieldObjects property to add support for custom object 
generation for objects that do not have a CurrencyIsoCode field (e.g., "EventRelation," 
"Task," "TaskRelation"). Separate Object names using a comma or new line. The property is 
only applicable to templates in multi-currency org. 

Name APTS_NoISOCurrencyFieldObjects

Value XML

Code <Object API name>

APTS_NoNameFieldObjects
Use the APTS_NoNameFieldObjects property to add support for custom object generation 
for Objects that do not have a Name field. (e.g., "EventRelation," "Task," "TaskRelation") 
Separate Object names using a comma or new line. 

Name APTS_NoNameFieldObjects

Value XML

Code <Object API name>

APTS_Password
The APTS_Password property allows you to create a password for protecting Microsoft 
Word agreements that are generated by the application. It also allows the application to 
password protect generated Microsoft Word documents. 

Name APTS_Password

Value <password>
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Code N/A

APTS_ProfilePermissions
The APTS_ProfilePermissions property allows you to define custom permissions for user 
profiles.

Name APTS_ProfilePermissions

Value JSON

Code You need to define the access details in this field. For more information, 
see Assigning Custom Permissions to User Profiles.

APTS_Protection
The APTS_Protection property allows you to specify whether protection for Microsoft Word 
agreements that are generated by the application should be on or off. Allows the 
application to specify protection for generated MS-Word documents. The property must be 
configured before configuring the Agreement Protection tab. 

Name APTS_Protection

Value Enter 1 to turn document protection on or 0 to turn it off

Code N/A

APTS_RecordTypeUpdateOnAmend
The APTS_RecordTypeUpdateOnAmend property enables you to update record type while 
amending an agreement. If you set to the property to 
"all;<recordtype>;<recordtype>;<recordtype>", all takes precedence over the record types. 

Name APTS_RecordTypeUpdateOnAmend

Value semicolon separated record type names or all

Sample Value: NDA;SLA;msa

Code N/A
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APTS_RetainFileNameForParallelReviewMergedDocument
When you end a parallel review of an imported document, the reviewed document is 
merged with the latest reviewed document. If the 
APTS_RetainFileNameForParallelReviewMergedDocument property is set to true, the 
merged document will retain the name of the imported document. For more information, see 
Sending an Agreement Document for Parallel Review.

Name APTS_RetainFileNameForParallelReviewMergedDocument

Value True

Code N/A

APTS_SkipEmailTemplateSelection
The APTS_SkipEmailTemplateSelection property allows you to indicate whether the email 
template selection step should be skipped. For more information, see Generating an 
Agreement.

Name APTS_SkipEmailTemplateSelection

Value True

Code N/A

APTS_SkipFileSplitWhileSavingFile
When you are upgrading CLM to Spring '21 or a later version and need to migrate 
Attachments that are greater than 10 MB in size to Files, you must set this property to true. 

 

Name APTS_SkipFileSplitWhileSavingFile

Value True

Post-migration, this property must be set to false.
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Code N/A

APTS_SkipContentSearchForActivation
Prerequisite: The Enable File comply system property must be enabled. 

When the value is true, the Enable Content Search step is skipped during activation. To use 
the APTS_SkipContentSearchForActivation property, the value of the 
APTS_AutoContentSearchable must be False. For more information, see Activating an 
Agreement.

Name APTS_SkipContentSearchForActivation

Value False

Code N/A

APTS_SkipRemoveDraftDocumentOnActivation
Prerequisite: The Enable File comply system property must be enabled.

When the value is true, the remove draft document step is skipped during activation. To use 
the APTS_SkipRemoveDraftDocumentOnActivation property, the value of the 
APTS_AutoContentSearchable must be False. For more information, see Activating an 
Agreement.

Name APTS_SkipRemoveDraftDocumentOnActivation

Value False

Code N/A

APTS_SuppressAutoReviewEmails
When the value of the property is true, you will be unsubscribed from parallel review emails 
(review completion, review error, and review cycle completion). This property is not 
applicable for review cancellation and ending review from CLM as the emails are sent from 
the user's domain.

Name APTS_SuppressAutoReviewEmails
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Value True

Code N/A

APTS_TemplateSelectionGuidance
The APTS_TemplateSelectionGuidance property allows you to add help text in the 
Template Selection page to guide users to select appropriate templates when users 
preview documents, generate documents, regenerate documents, and generate supporting 
documents. The help text is displayed above the template selection section. For more 
information, see Generating an Agreement.

Name APTS_TemplateSelectionGuidance

Value N/A

Code Sample code: Please select an appropriate template.

APTS_TranslatePickValuesInDocs
When you set the APTS_TranslatePickValuesInDocs admin entry to true, the field value gets 
added in the generated document. If a conditional segment is set, the condition takes both 
API and values. You can either use API names or Values but not both.

When an administrator sets the APTS_TranslatePickValuesInDocs admin entry to false or 
does not add the admin entry, the API Name gets added in the generated document by 
default.

Name APTS_TranslatePickValuesInDocs

Value True

Code N/A

APTS_UIPageConfig
The APTS_UIPageConfig property is used to indicate the visual force page to perform the 
publish action. The integration module provides the Visualforce page 
Apttus_Content__PublishContent.
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Name APTS_UIPageConfig

Value XML

Code Sample Code:

<UIPageConfig> 
<UIAction name="publish_document"> 
<CustomPage> <Name>Apttus__PublishDocument</Name> 
</CustomPage> 
</UIAction><UIAction name="publish_content"> 
<CustomPage> 
<Name>Apttus_Content__PublishContent</Name> 
</CustomPage> 
</UIAction> 
<UIAction name="publish_chatter"> 
<CustomPage> <Name>Apttus__PublishChatter</Name> 
</CustomPage> 
<UIAction name="review_offlinedocument"> 
<CustomPage> <Name>Apttus__ReviewOfflineDocumentLightning</Name> 
</CustomPage> 
</UIAction> 
</UIPageConfig>

APTS_UseWizardServer
Apttus merge web service endpoint. For more information, see Contract Wizard in Classic.

Name APTS_UseWizardServer

Value True

Code N/A

APTS_UseWorkflow
The APTS_UseWorkflow property disables the creation of a default set of tasks when an 
agreement is generated. In some cases, the default tasks created to ensure Signing, 
Scanning, and Attaching the scanned image to the agreement record is redundant or is 
taken care of by a different workflow process. In such cases, the default behavior of the 
system needs to be modified to ensure those tasks are not created. For more information, 
see Managing Workflow.
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Name APTS_UseWorkflow

Value True

Code N/A

APTS_WizardPersistHiddenValue
When you set APTS_WizardPersistHiddenValue to true and you run a wizard containing a 
field that has a combination of Set this control value and Hide this control input rules, the 
field value is set in the object you are creating. When you set 
APTS_WizardPersistHiddenValue to false and you run a wizard containing a field that has 
a combination of Set this control value and Hide this control input rules, the field value is 
not set in the object you are creating. For more information, see Configuring Step Input 
Rules from the Wizard Designer.

Name APTS_WizardPersistHiddenValue

Value False

Code N/A

APTS_XAAddInLoadType 
The APTS_XAAddInLoadType property allows you to define the installation approach to 
access the X-Author for Contracts 2.0 add-in. You can use any one of the following 
supported values:

centralized - If you install the X-Author for Contracts 2.0 add-in using Centralized 
Deployment via the Office 365 admin center, set The property value to "centralized". 
Centralized Deployment supports both Windows operating system and Mac 
operating system. For more information on installing X-Author for Contracts 2.0 add- 
in using Centralized Deployment, see Installing Production X-Author for Contracts 2.0.
sideloading - If you are unable to install the X-Author for Contracts 2.0 add-in using 
Centralized Deployment in Office 365, alternatively you can install the add-in on the 
Mac system using the Sideloading approach. If you install the X-Author for Contracts 
2.0 add-in on a Mac system using a manifest file, set The property value to 
"sideloading". For more information, contact Support.

https://documentation.conga.com/x-author-for-contracts/latest/installing-production-x-author-for-contracts-148121703.html


CLM

607
 

Copyright ©2022 Apttus Corporation. All rights reserved.
 

• appsource - If you access the X-Author for Contracts 2.0 add-in using Microsoft Store, 
set The property value to "appsource". For more information, contact Support. 

If The property is not defined, the Centralized Deployment approach is used to access 
the X-Author for Contracts 2.0 add-in. 

Name APTS_XAAddInLoadType

Value Default value: centralized

Supported values: centralized, sideloading, appsource

Code N/A

Comply System Properties
You can enter one or more of the following property details.

Classic Navigation: Setup > Build > Develop > Custom Settings > Comply System Properties 
> Manage > Edit.

Lightning Navigation: Setup > Custom Code > Custom Settings > Comply System Properties 
> Manage > Edit.

Property Description

Admin 
User

The admin user is the default owner of activities created by a user who is not allowed 
to be the owner (for example, customer portal user).

Auto 
Enable 
PDF For 
Final 
Docs

Select this and the Create PDF Attachment checkbox is always selected when you 
choose to save as Final - to be signed from the check-in dialog. You may use this field 
when you want to finalize an agreement document.

Auto 
Enable 
Reconcilia 
tion

Select this and the Reconcile Document option is always selected when you go to 
check-in an agreement document.



CLM

608 Copyright ©2022 Apttus Corporation. All rights reserved.
 

•

•

•

Property Description

Agreemen 
t Number 
Field For 
Imported 
Docs

In this field, specify the API name of the field you want to use. For example, use 
Apttus__Agreement_Number__c. When a new document is imported into the system, it 
will include the agreement number in the top right corner of the header on each page, 
using the field selected above. For more information about when to use this field, 
refer to Agreement Number/Header Configuration.

Allow PDF 
Select 
Override

This is only applicable when Auto Enable PDF For Final Docs is selected.

Allow 
Reconcile 
Selection 
Override

This is only applicable when Auto Enable Reconciliation is selected.

If Auto Enable Reconciliation is True and Allow Reconciliation Selection 
Override is True, the Reconcile checkbox is by default selected on check-in. The 
user can also deselect (override) the Reconcile button.
If Auto Enable Reconciliation is True and Allow Reconciliation Selection 
Override is False, the Reconcile checkbox is by default selected on check-in. The 
user cannot deselect (override) the Reconcile button.
If Auto Enable Reconciliation is False, the user can select or deselect the 
Reconcile checkbox on check-in. However, the Reconcile checkbox is disabled if 
there is no smart field in the agreement document.

Allow 
Regenerat 
e From 
XAC

Select this checkbox to display the Regenerate button on the X-Author toolbar.

Ancestor 
selection 
for Import 
Offline

Select this checkbox to allow users to link an offline document to an existing version 
of a document.

Auto 
Enable 
Private 
Indicator

Select this checkbox if you want to auto-enable private indicator for documents. If 
you select this checkbox, the Make this document private checkbox for any agreement 
document is auto-selected.
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Property Description

Auto 
Insert 
Header 
Footer 
Data

Select this field to automatically insert the Agreement Number Field For Imported 
Docs field value to the header and the latest timestamp to the footer of an 
agreement document. This field is available for Generate, Import and Offline actions. 
For more information about when to use this field, refer to Agreement Number/Header 
Configuration.

The value of the latest timestamp for the footer is taken from the User Account 
Timezone field on Salesforce.

Allow 
Private 
Selection 
Override

Select this checkbox if you want to allow the user to override the private document 
selection. This setting is applicable only when the Auto Enable Private Indicator is 
selected for documents.

Asynchro 
nous 
Checkin 
Recipient

Enter a recipient role (Contract Owner, Logged in XAC user or Both) to receive 
Asynchronous Check-in email notification.

Supported Values: Contract Owner, Logged in XAC user, or Both

Default Value: Both

Auto 
Enable 
Asynchro 
nous 
Checkin

Select the checkbox to auto-select the Asynchronous Check-in checkbox available on 
the X-Author Contracts Check-in pop-up window.

Ancestor 
Selection 
For Import 
Offline

Select the checkbox to allow a user to link an offline document to an existing major 
version of a document.

Auto Sync 
With 
Opportuni 
ty

Indicates whether the agreement will be automatically synchronized with the 
opportunity when the agreement is accepted.

Document 
Versioning 
Naming 
Conventio 
n

Deprecated
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Property Description

Excluded 
Namespa 
ces

Allows you to add a comma-separated list of namespaces to exclude objects from 
the wizard dropdown

Bypass 
Sharing

Indicates whether apex code can bypass record sharing during selective operations 
such as clone and deleting draft attachments.

CLM Lite 
License 
Profile(s)

Allows you to add a comma-separated list of user profiles that will use the Contract 
Management lite license.

Default value: Apttus_Lite

CLM 
Lite 
 License 
Admin 
Email

Allows you to add a list of semicolon-separated email addresses that need to receive 
the Contract Management Lite License usage report.

Sample value: sysadmin@example.com; admin@example.com; exec@example.com

Email Lite 
Monitorin 
g Report 
to 
Apttus?

Select the checkbox to send the Contract Management Lite License usage report to 
Apttus Administrator.

Enable 
document 
permissio 
ns for 
review

Allows users to view the Set field and clause permission toggle in the second step of 
the parallel review and set the field or clause level permissions for each reviewer in 
the third step of the parallel review. 

Inactivate 
Non- 
Complian 
t Lite User

Select the checkbox to deactivate the Lite user after 30 logins.

Intelligent 
Import for 
Signed 
Document

Select the checkbox to view the intelligent import option when you click the Upload 
Signed documents button and intelligently import signed documents.
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Property Description

Contract 
Summary 
Template

This field contains the name of the contract summary template. You may have to 
define a separate template to contain the contract summary details and mention 
the name of the template here.

Default 
Opportuni 
ty 
Agreemen 
t Owner

The default owner for the agreement created from an opportunity. The valid values 
for this field are Opportunity Owner and Current User. If not set, the Opportunity 
Owner will become the owner of the new agreement. If you want to make the current 
logged in user as the Agreement Owner, type Current User in this field.

Default 
Document 
Tags

Enter a comma-separated list of tags to make available for any agreement 
document as it is checked in from X-Author Contracts. Use of these tags requires 
 Contract Document Versioning to be enabled. The Document Finder feature must 
also be configured in your org. For more information, refer to Configuring Document 
Finder.

Document 
Naming 
Conventio 
n

Specify a value to apply a custom naming convention for all agreement documents 
at generation, check-in and signature events.

The following attributes permitted when formulating a document naming convention 
are:

%checkintype%
%action%
%templatename%
%user%
%timestamp%
%version%

Agreement attributes such as %:Name%. Note: any variable prefixed by ':' represents 
a field on the Agreement object. 
If the property contains a null value (i.e., if left blank), the current default naming 
convention will be used: %:Name%_%action%_%templatename%_%timestamp%

Example agreement document name using the default naming convention: 
SOW_Regenerated_SOW ABC_2015-08-07

For more information on using document version in document naming convention, refer 
to Enabling Contract Document Versioning.
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Property Description

Document 
Structure 
FX2 For 
Imported 
Docs

Check this box to make document structure FX2 format for all Offline documents 
(created or imported). If not checked, all offline documents are created in the "pre- 
existing" format. 

Email 
Template 
For 
Checkin 
Notificati 
on

The email template for sending check-in notifications.

Enable 
Clause 
Approvals

This checkbox allows you to set up approval processes on clauses used in your 
document.

Enable 
Document 
Versioning

Check this box to enable Document Versioning. All new agreement records created in 
your org will use Document Versioning after this setting is enabled. Enable Version 
Control must be enabled for Document Versioning to work properly.

Enabling Document Versioning changes the value of the Version Aware Agreement 
field to TRUE for all new agreements after the property is activated. The Version 
Aware field is a flag that tells Conga CLM to use Document Versioning for a specific 
record.

Important Note: It is recommended that once a record is flagged as Version Aware, 
you do not disable this field, as versioning will become undefined for the agreement 
record in question. Instead, ensure that records which should not use Document 
Versioning do not have the field enabled when they are created.

For more information on how you can configure Document Versioning for your org, 
refer to Enabling Contract Document Versioning.

Note

This property only applies to Offline agreements created from the Agreement 
or user Home page links in Salesforce. The format of Offline agreements 
created using X-Author for Contracts will still depend on user-input from X- 
Author.
You can import documents in X-Author for Contracts and Online Contract 
Collaboration when this property is enabled.
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Property Description

Enable 
File

Select Enable File checkbox to enable File Type to be visible in the Notes & 
Attachment section of an agreement.

Enable 
Merge 
Call 
Debug

Enable Merge Service debugging.

Enable 
Multiple 
Checkout

This feature will be functional in later releases. Indicates whether multiple checkouts 
are allowed. Only applicable when version control is in effect.

Enable 
PDF 
Security

Enabling PDF security lets users apply security settings to PDF documents and 
protect them with a password. See Enabling PDF Security for Agreement Documents 
for more information.

Enable 
Submit 
Merge 
Call

Enable to submit merge calls for processing. When enabled, the "Submit" button is 
displayed as a document generation option.

Enable 
Template 
Versioning

Check this box to enable Template Versioning. All new Templates created in your org 
will use Template Versioning after this setting is enabled.

For more information, refer to Template Versioning.

Enable 
Version 
Control

Check this box to enforce a check-in/check-out policy for agreement documents. This 
setting must be enabled when "Enable Document Versioning" is checked. Note: This 
property existed in Contract Management versions prior to 8, so this property may 
already be enabled.

Note

When the Enable Files property is enabled, “Salesforce CRM Content User” 
should be enabled for a user to check in a document from X-Author Contracts.
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Property Description

Filter By 
The 
Primary 
Agreemen 
t Status

Allows filtering of agreements (Related/Sibling/Parent/Child/Amended/Renewed) by 
primary agreement Status Category or Status. When this property is enabled, users 
sending a document for review can only see the agreement documents (Related/ 
Sibling/Parent/Child/Amended/Renewed) that have the same Status or Status 
Category as the primary agreement. When this property is disabled, users sending a 
document for review can see all the agreement documents (Related/Sibling/Parent/ 
Child/Amended/Renewed) irrespective of the primary agreement status category or 
status.

Footer 
Datetime 
Format 
For 
Imported 
Docs

Specify the format in which the date and time will be shown in the generated 
agreement. When a new document is imported into the system, it will include the Date 
in the bottom left corner of the footer on each page, in the format selected above. For 
a list of supported date and time formats, refer to the Setting date and time format 
for the footer.

The value of the latest timestamp for the footer is taken from the User Account 
Timezone field on Salesforce.

Hide 
Content 
Control 
Border

Check this box to hide smart boundaries (for smart fields and clauses) in generated 
documents. Refer to the X-Author Contracts User Guide for more information on 
showing/hiding boundaries as an admin user in the add-in.

Instance 
URL

The Salesforce instance URL for redirecting to custom pages.

Large Doc 
Process 
Batch Size

You can add the number of rows of the large objects (agreement or quote line items 
and objects defined using the APTS_LargeDocSObjects property) to retrieve in each 
batch iteration to build the data source for the template.

The default value of the Large Doc Process Batch Size is 1000 and a maximum 
of 2000. You can define a value lower than 2000, based on template complexity.

Sample value: 500

This property only applies when you send documents for review using the new 
UI.





CLM

615
 

Copyright ©2022 Apttus Corporation. All rights reserved.
 

Property Description

Large Doc 
Threshold

Enter a number of the agreement line items in the contract when exceeded indicates 
that the contract is a large document. This property is applicable only for generating 
documents but not for regenerating or generating supporting documents.

The default and the maximum value of the Large Doc Threshold is 10000. You can 
define a value lower than 10000. Setting a value of -1 for the Large Doc Threshold 
invalidates the setting.

Sample value: 1000

Max Child 
Level

The maximum level of lookups and child objects available from the parent object to 
generate the merge data for. For example, Agreement is the parent 
object, Agreement Fee is the child object of Agreement and Agreement Fee 
Adjustment is the child of Agreement Fee and grandchild of Agreement.

Merge 
Call 
Timeout 
Millis

The timeout in milliseconds for the merge request. Default value = 120000 
milliseconds.

Merge 
Webservic 
e 
Endpoint

Type the merge web service endpoint. For example https://merge.congacloud.com/cgi- 
bin/MergeServer/Bin/mmcgi.exe

Enable 
Online 
Contract 
Collabor 
ation

Deprecated

Organiza 
tion-Wide 
Email 
Address 
Display

Enter the display name that you have entered while configuring organization-wide 
email addresses. Ensure that you have selected the Use Organization-Wide Email 
Address checkbox. For more information about configuring organization-wide email 
addresses, see Setting Up Organization-Wide Email Address.

Override 
Playbook 
default 
filter

Allows you to specify the Playbook filter names separated by commas that should 
inherit filter value from template attributes on clicking the Playbook tab in X-Author. 

Sample value: Category, Subcategory

https://merge.congacloud.com/cgi-bin/MergeServer/Bin/mmcgi.exe
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Property Description

Parallel 
Review

Select the checkbox to allow multiple users to review the document in collaboration. 
The property is disabled by default.

Parallel 
Review for 
related 
agreemen 
ts

Allows you to enable parallel review for related agreements when you send a 
related agreements document in DOCX with the type as Agreement Document. If the 
checkbox is selected and a user sends a related agreement for review, a review cycle 
is created for related agreements. If the checkbox is left unselected and a user sends 
a related agreement for review, a review cycle is not created and the related 
agreement documents are considered as supporting documents.

Ensure that the Parallel Review property is enabled.

PDF 
Owner 
Password

The password required to change the permissions of the PDF document like printing or 
editing.

Publish 
Author 
Events

Indicates whether merge events that occur in X-Author, such as check-in or check-out, 
should be published. If enabled, a record is inserted in the Merge Event table on the 
Agreement record.

Publish 
Merge 
Events

Indicates whether merge events, such as generating an agreement document or 
creating offline document should be published. If enabled, a record is inserted in the 
Merge Event table on the Agreement record. For more information about when to use 
this field, refer To get a template ID for generating an agreement document as an 
example.

Restrict 
Checkin 
of 
Document 
s

List of comma-separated Status category and Statuses for which Check-in and 
Check-out actions will be restricted in X-Author for Contracts.

Sample value: In Authoring, Other Party Signatures, Submitted Request

Note

Note: If this password is not specified, the password configured for the Admin 
object "APTS_Password" is used instead. See Admin Objects.
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Property Description

Temp 
Email 
Template 
Inactive 
Hours

Use this property to set the orphan period of temporary email templates to use in 
conjunction with the CleanupJobScheduler APEX class. The default value of this 
property is set to 4 hours. 

For more information, refer to Temporary Email Template Cleanup.

Unlock 
Smart 
Elements

If this checkbox is selected, the user can delete smart elements from the generated 
document. If this checkbox is deselected, the user cannot delete smart elements from 
the generated document.

Use 
Agreemen 
t Locks for 
Versioning

Check this box to use Agreement locks for versioning instead of document-level 
locking:

If enabled, all agreement documents are locked (by the user checking out) 
when any one of them is checked out. 
If disabled, only checked out documents are locked (by the user checking out)– 
any other agreement documents which have not yet been checked out can be 
checked out for editing.

Use text 
areas for 
wizards

Allows you to have more characters available for questions and answers in your 
wizards

Use 
Organiza 
tion-Wide 
Email 
Address

Select the checkbox to use a common email address for email communication. You 
must configure the Organization-Wide Email Address Display comply system 
property to use an organization-wide email address.

XAJS End 
Point

Allows you to provide X-Author for Contracts 2.0 (XAJS) URL to route the documents 
to intelligent data extraction software via XAJS.

Value: https://xajs.apttuscloud.com

Comply Custom Properties
Classic Navigation: Setup > Build > Develop > Custom Settings > Comply Custom Properties 
> Manage > Edit.

You need to configure the remote site setting of the org before you configure 
XAJS End Point. 



https://xajs.apttuscloud.com/
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Lightning Navigation: Setup > Custom Code > Custom Settings > Comply Custom 
Properties > Manage > Edit.

The following table depicts comply custom properties and their description.

Property Description

Child Object Types Allows you to enter comma-separated values 
identifying the API name of the Child Objects you want 
to support in your Rulesets.

Doc Assembly Rule FieldSet Name Allows you to enter the API name of the fieldset you 
created in the Doc Assembly Rule FieldSet Name field.

Doc Assembly Rule Static FieldSet Name Allows you to enter the API name of the static fieldset 
you created in the Doc Assembly Static FieldSet Name 
field.

Custom Permissions
Custom permissions allow you to give access to certain X-Author Contracts features for a 
user profile.

Classic Navigation: Setup > Build > Develop > Custom Permissions.

Lightning Navigation: Setup > Custom Code > Custom Permissions.

The following table lists the custom permissions available in the Contract Management 
application:

Custom Permission Description

XA_CheckinAsFinal This permission allows users to view the following save 
options on the Check-in document page:

Update Current Version
With Redlines
Without Redlines
Final - to be signed
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Custom Permission Description

XA_CheckInWithoutRedlines This permission allows users to view the following save 
options on the Check-in document page:

Update Current Version
With Redlines
Without Redlines

XA_CheckInWithRedlines This permission allows users to view the following save 
options on the Check-in document page:

Update Current Version
With Redlines

XA_Contracts Allows users to view the Contracts tab in X-Author 
Contracts.

XA_Template Allows users to view the Templates tab in X-Author 
Contracts.

XA_UnlockReadOnlyClause Allows users to modify read-only clauses in X-Author 
Contracts.

XA_UnprotectDocument Provides full access to all the documents irrespective of 
protection type enforced at the document level.

XA_disableautocheckout This permission disables the auto check out option for the 
user. 

XA_hidecheckoutmenu This permission hides the Open and Open and Update 
option for the user.

CLM Glossary
This section lists the terms and their definitions of the Conga CLM application.

A

Irrespective of the user profile permissions, any 
user can check-in a document with redlines using 
X-Author for Contracts 1.0.





CLM

620 Copyright ©2022 Apttus Corporation. All rights reserved.
 

Term Definition

Agreement Is a set of terms and conditions agreed between two or 
more parties.

Agreement Document Protection Conga CLM uses Agreement Document Protection to help 
users protect your documents when they are generated in 
Microsoft Word format.

Agreement Explorer Is a search and reporting feature that allows you to 
search records in the Agreement object through the use of 
configurable and reusable search reports.

Agreement Line Item Represents a product or service line item associated with 
an agreement.

Agreement Lock Represents a lock on the agreement.

Agreement Protection Specifies protection settings for agreements by the 
Contract Wizard.

Agreement Rule Allows you to identify how an agreement request is 
processed when you click the Submit Request action 
button.

Amend The Amend action button enables you to modify the 
contract.

Retention Policy Schema An XML schema describing the policy specification is 
provided as a static resource named Retention Policy 
Schema.

C

Term Definition

Clause Clauses are modular blocks of text that are used 
frequently across multiple templates.

Contract Is an agreement with specific terms between two or more 
entities.
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Term Definition

Contract Document Versions Contract Document Versioning enhances existing version 
control by introducing a solution framework of document 
versioning at the Agreement record level. 

Contract Management Contract Management (CM) or Contract Lifecycle 
Management (CLM) or Comply Management is the process 
of systematically and efficiently managing contract 
creation, execution, and analysis.

Cycle Time Reporting Provides organizations the ability to track the time that 
has elapsed between any two statuses or status 
categories.

D

Term Definition

Document Is generated by merging information stored in a record 
with an existing template. 

Dashboard Organizes key statistics in easy to understand, bottom- 
line format, allowing you to gain the insight you need to 
fulfill your business needs.

Document Finder Helps your contract managers, sales persons, and legal 
teams to easily filter and find agreement documents 
directly from an agreement record.

Dynamic Document Assembly Enables you to preconfigure filter rules that drive a 
sequence of prescribed dynamic clause or attachment 
insertions in a generated document.

E

Term Definition

Expire The Expire action is used to mark the agreement as Expired after the 
agreement term ends.

M
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Term Definition

Merge web Service Thee Merge Web Service APIs are used for generating and 
manipulating documents.

O

Term Definition

Object Is a definition of a specific type of information you can store in 
Salesforce. Some objects are native to Salesforce, such as 
Contacts or Accounts, while others are specific to Conga CLM 
functionality, such as Templates or Agreements.

Organization/Org Is a deployment of Salesforce that has a defined set of licensed 
users. Your organization includes all of your data and 
applications and is separate from all other organizations. 

P

Term Definition

Page layout Allows you to control the layout and organization of detail 
and edit pages.

R

Term Definition

Record A collection of fields that store information about a specific 
item of a specific type (represented by an object), such as a 
Contact, an Account, or an Opportunity.

Record Type Allows you to offer different business processes, picklist values, 
and page layouts to different users.

Renew The Renew action enables users to create a new version of the 
agreement.

Reports Salesforce delivers standard report folders containing reports 
for each record type. For example, Accounts, Opportunities, 
Leads, and so on.
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Term Definition

Retention Policy Determines the length of time a record must be stored.

T

Term Definition

Template Is a blueprint used to generate a wide variety of document 
types when merged with data from agreements or quotes.

Template versioning Template Versioning provides a solution framework of 
document versioning at the Template level to track 
template versions against generated documents.

Terminate Terminate Action enables users to terminate a contract.

W

Term Definition

Wizard A wizard prompts the end user to answer a series of on- 
screen questions then creates the Agreement record.

Wizard Component Library This tab is used to create reusable Inputs and Steps for 
your Wizard Designs.

Frequently Asked Questions
This page lists the frequently asked questions and answers.

Is there API request limit in Salesforce?

There are no limits for outbound calls from Contract Management but Salesforce imposes 
limits for the total API requests (calls) per 24-hour period for an org. For more information, 
see API Request Limits and Allocations.

Does DocuSign have API call rate limit?

There are no limits for outbound calls from Contract Management to DocuSign but 
DocuSign has implemented API Call Rate Limits to balance loads. For more information, see 
API Call Rate Limits.

https://developer.salesforce.com/docs/atlas.en-us.salesforce_app_limits_cheatsheet.meta/salesforce_app_limits_cheatsheet/salesforce_app_limits_platform_api.htm
https://developers.docusign.com/esign-soap-api/reference/introduction-changes/api-call-limits#:~:text=DocuSign%20has%20implemented%20the%20following,calls%20per%20hour%20per%20account
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Conga CLM Limitations
The following features are not supported in Lightning:

Document Assembly Rulesets
Dependent lookups (filtering of a lookup based on other lookups) are not supported in 
Lightning. For more details please refer to Salesforce Documentation.

Comply User Properties
The comply user properties allow you to customize permissions for specific profiles or users.

To configure comply user properties
Go to Setup > Custom Code > Custom Settings > Comply User Properties > Manage.
Click New in the Default Organization Level Value section.
Select Profile or User from the Location dropdown.
According to your selection in the previous step, enter a profile name or user name 
and click the lookup icon ( ) to open the Lookup window.
Select a relevant profile name or user name.
Enable or disable the following property for the selected profile or user and click 
Save.

Property Description

Show Add 
More 
Button 
During 
Review

Select the checkbox to allow users to view the Add more button while sending 
documents for review to add supporting documents from their local or shared drive. 
By default, this property will be enabled for all users. 
By default, if this setting is not configured, the Add more button is visible to all users.

You can repeat the steps from 2 to 6 to customize permissions for other 
profiles or users.



https://developer.salesforce.com/docs/component-library/bundle/lightning-input-field/documentation
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CLM for Users
This section describes how Conga Contract Lifecycle Management (Conga CLM) works and 
how to manage contracts for your organization and your customers.

Topic Description

What's Covered This section walks the Conga CLM user through a set-up of the 
entire contract management process. It covers step-by-step 
instructions, and use cases for the features provided by Conga 
CLM.

Primary Audience Individuals who are working on any aspect of contracts: 
contract managers, contract creators, contract negotiators, 
contract reviewers, contract facilitators, and legal team.

IT Environment Refer to the latest CLM Release Notes for information on 
System Requirements and Supported Platforms.

Updates For a comprehensive list of updates to this section for each 
release, see the What's New in CLM Documentation.

Other Resources Refer to the X-Author for Contracts documentation for detailed 
instructions on setting up templates and editing agreement 
documents.

Before using Conga CLM, you must be familiar with the following:

Basic Salesforce administration
Salesforce and terms and definitions
If you are new to Conga CLM, begin here: get started.

This section describes the following tasks:

Creating an Agreement from an existing Account or Opportunity: You can choose an 
existing Account or Opportunity to create a new agreement.
Generating an Agreement: After creating an Agreement, you can use a template to 
generate a document and preview it.
Import an Offline Agreement or Document: You can create an agreement from a 
third-party paper or import an offline document.
Sending an Agreement for Review: You can send the generated Agreement document 
to the customer for review.
Completing Negotiations: After the review phase, the terms and conditions are 
negotiated and finalized between the engaged parties.
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Activating an Agreement: After an Agreement is finalized and signed, you can 
activate the Agreement to bring it into effect.
Searching Content in Agreement Documents: You can search content in all the 
agreement documents using smart search.
Reporting: You can store the activated agreements in different formats, such as 
reports and dashboards.

Select one of the following topics for more information:

Setting Up CLM
Managing Agreement Lifecycle
Working with Agreements
Contract Document Versioning
Contract Wizard in Classic
Reports and Dashboards
Conga CLM on Salesforce Lightning
Appendix

Setting Up CLM
This section covers the following topics:

Logging in to CLM
Managing User Profiles

Logging in to CLM
This section explains how to log in to Contract Management

Prerequisites
Contract Management package must have been installed.
You must have login credentials.

Note

It is recommended not to use the Back button of your browser during the entire 
Contract Management Lifecycle.
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To log on to Contract Management
Go to http://www.salesforce.com. If your organization is using a sandbox or test 
environment to access Contract Management, for example, as part of your User 
Acceptance Testing (UAT) process, go to http://test.salesforce.com.
Click Login.
Type your User Name and Password, and click Login into Salesforce. 
You are successfully logged into Contract Management.
Navigate to the Salesforce.com App Menu, and select Contract Management to 
access the Contract Management tabs.
Navigate to the Opportunities or Accounts tab.

Managing User Profiles
A profile contains user permissions and access settings. There are four basic profiles used 
with Contract Management:

Profile 
Name

Available Permissions Description

Administr 
ator

Can configure and customize the application. Has access to all Contract 
Management functionality that does not require an additional license.

Contract 
Manager

Can create, edit, execute, and approve contracts. This profile can also delete 
contracts as long as they are not executed. Can manage clause and language 
template library.  Has access to X-Author functionality

Read 
Only

Can view the organization's setup, run and export reports, and view, but not edit other 
records.

Requesto 
r

Can initiate new contract requests and use the Contract Wizard to assemble 
standard contracts, but does not have access to X-Author. Can perform some limited 
searches and reporting

Note

Contract Management enables you to launch community portals and perform all 
operations that you perform in internal environments. You must belong to the Gold 
Partner profile to be able to launch a community portal.



http://www.salesforce.com
http://test.salesforce.com
http://Salesforce.com
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For details on profile settings and related securities, see Appendix: Profile Settings and 
Security.

Contract Management User Roles and Tasks
The following table shows some key Contract Management roles and their descriptions.

Role Description

Legal function Design, creation, maintenance of contract 
template contents
Review, negotiation, and contract legal content 
assurance
Legal admin, Internal counsel, External counsel

Finance function Evaluation and validation of contract’s financial 
impact and risks
Approval of the commitment of resources per the 
contract
Financial analyst, Controller, CFO, Treasurer

SMEs Evaluation and validation of specific areas of 
contract commitments
Approval of their functional area of the contract’s 
deliverables
VP / Director for Products, Procurement, Sales, 
Partner Management

Contract Facilitator Definition of non-standard, complex, or global 
contract components
Assignment of contributors, scoring, approval, and 
strategic aspects
VP Strategic Accounts, CEO, CFO, COO

Admin General definition of process, contributors, 
contract elements
Configuration of applications and tools required 
by the process
Application admin, system analyst, business 
analyst
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Managing Agreement Lifecycle
This section describes how to request an agreement, how to manage it through the 
Agreement Lifecycle, and which actions are available to manage the agreement after it 
goes into effect.

This section covers the following topics:

Creating an Agreement
Use Case for Creating an Agreement
Generating an Agreement
Sending an Agreement Document for Review
Sending an Agreement Document for Parallel Review
Sending an Agreement Document for Microsoft Teams Review
Negotiating an Agreement Document
Finalizing an Agreement
Activating an Agreement
Managing Agreement Lifecycle Post-Activation
Working with Offline Agreements

Creating an Agreement
You can create an agreement from Opportunities, Accounts, Contacts, and Agreements 
tab. When drafting your agreement record, you fill out the mandatory data fields, such as 
Agreement Name and Account for your agreement record. The system automatically 
populates the system fields, such as Status Category and Status fields, which help in 
identifying which step of the agreement process is currently in the agreement lifecycle. For 
details on various Status categories, Statuses, and Agreement Actions, see Apttus Status 
Categories and Statuses and Agreement Actions. To complete the agreement, you must fill 
out various data fields relevant to your agreement. For the complete list of agreement 
fields, see Agreements Fields. 

You can also create an agreement using the Contract Wizard. The Contract Wizard 
enables you to choose from and execute runtime Wizard instances based on pre-configured 
Wizards to create well-formed agreements.

To create an agreement 
On the Home page click  next to the Agreement tab and select New Agreement. 
or 
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Navigate to the Agreements tab and click the New button. 
or  
On the Opportunities Detail page, Contact Detail page, or the Account Detail page, 
navigate to Agreements section and click New.
In the Select a record type section, select a record type and click Next.
In the New Agreement Form, enter the required details. Entering details in the 
Additional Fields section is optional. If no fields are configured for the New Agreement 
Form, the New Agreement Form is not displayed.  
For information on how to configure fields for the New Agreement Form, refer to 
Configuring Intelligent Discovery Fields.
Click Next.
Review and edit the details on the New Agreement Edit Form and click Create. 
A new agreement record is created.

If the Action Panel is enabled by your administrator, you can access action buttons from 
the Agreement Lifecycle Actions panel. For more information, see Enabling and Customizing 
the Action Panel.

Use Case for Creating an Agreement
This topic describes the use case for creating a perpetual Agreement.

This use case describes how to create a contract between two entities to hire a contract 
employee in the company ABC without the need of further renewal required for the 
employee, though he is a contract employee.

In this case, a contract administrator or an authorized HR person creates, manages, and 
finalizes the contract between the company ABC and the contract employee.

Pre-requisite: Make sure you have the following:

An account for the company ABC is created.

For this business, the contract employee must serve the company ABC, for a long term.

To create a perpetual agreement, perform the following steps:

 Go to the Agreement tab and click New. 

Note

This use case gives one example on how to create a perpetual agreement between 
the company and the contract employee. You might use this functionality 
differently, depending on your business case.
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The SelectAgreement Record Type page is displayed.
 Select an option from the Record Type of new record drop-down list, and click 
Continue.
The New Agreement page is displayed.
Click Continue.
The Agreement Edit page is displayed.
Enter agreement name in the Agreement Name field.
Select an account from the Account picklist.
Select Start Date.
Select the Perpetual check box in Terms and Renewals section.
Enter or select values in the required fields (marked in red) which are mandatory to 
complete the agreement record details.
Click Save.

Result:

The perpetual agreement is created.

Next Step:

Similarly, you can create other agreements that do not have an end date and do not 
require further renewal of the contract. 

Generating an Agreement
You can generate an agreement document using an existing template. If a template is long 
and complicated, with many clause references and conditional statements, it may take a 
while to generate the document. In such cases, you can submit the request to generate an 
agreement document and you will receive an email notification after the document is 
generated. Templates can be created using X-Author for Contracts. For each agreement 
record type, a different template can be created in Microsoft Word. For more information on 
using X-Author for Contracts to create a template, see X-Author for Contracts 
documentation. 

Prerequisites
You must have an existing agreement record.
Ensure that there are less than 55k characters in the clause template.
To generate a PDF as an ISO-standardized version, you must configure PDF/A as an 
output format. For more information, see Configuring PDF/A as a Document Output 
Format.
You must have a template ready for the record type of your agreement.

https://documentation.conga.com/x-author-for-contracts/latest/x-author-for-contracts-154927679.html
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User Permissions Needed

To preview an agreement: Agreement: ReadTemplate: ReadAsyncMergeCall: 
Read, Create, Edit (Field Access: Read, Edit)

To generate/regenerate an agreement: Agreement: EditTemplate: ReadAsyncMergeCall: 
Read, Create, Edit (Field Access: Read, Edit)

To generate an agreement document
Navigate to the Agreements tab and select an existing agreement record.
Click Generate to generate an Agreement document.
You will be navigated to the Template selection page. From the Options section, 
select one of the following output formats for your agreement record:

DOC or DOCX: To generate a Microsoft Word document.
RTF: To generate an agreement document in Rich Text Format.
PDF: To generate a protected PDF agreement document.
PDF/A: To generate a PDF as an ISO-standardized version.

From the Document Permission dropdown, select one of the following document 
protection options for the generated document:

Full access: To allow users to read and write. This option is selected by default.
Insert comments and tracked changes only: To allow users to insert comments. 
All the changes made by any user are tracked.
Insert comments only: To allow users to insert comments.
Fill in form fields only: To allow users to fill in the form fields.
Read only: To allow read-only access to users.

To include a watermark across your agreement document, select the Include 
Watermark checkbox.
From the Templates section, select the template to generate your agreement 
document. The first template in the list is selected by default. If only one template is 
available for a record type or only one template is available based on query 
template filter then that template is selected by default.

Click Generate or Submit according to your requirement. 
After the document is generated, the Document Generated window is displayed. If you 

You can configure the template attributes to be displayed in the Template 
Selection section. For more information, see Configuring Columns in the 
Template Selection Page in Lightning.
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had selected Submit, you must stay signed into CLM and you will receive an email 
after the document is generated.
Click the Click here to view your file link to download your document or click OK to 
return to the agreement detail page.
An agreement document is generated using the selected template and can be found 
in the Notes & Attachments related list. Click the Preview button to preview the 
generated document.

Sending an Agreement Document for Review
You can send the generated agreement document to the customer for review. The Send for 
Review button allows you to specify attachments to send to the customer by email. 

Prerequisites
You must have an existing generated Agreement document.
You must ensure that the Status Category for the Agreement record is In Authoring or 
In Signatures.
You must ensure that Track Changes is enabled on the agreement document that you 
send to the customer for review.

Limitation
You cannot send a document with protection for review if your organization has set 
up High-Assurance Session Security at a user profile level. As a result of the security, 
the sessions cannot be generated in asynchronous calls.
After you send an agreement document for review, the activity history does not record 
details for any of the attachments.

Note

When a document is generated or regenerated, all the smart clauses are displayed 
in the Agreement Clauses section with Action as Original. When a document is 
regenerated a new entry is created in the Agreement Clauses section even if the 
same clause already exists. 
In the version aware agreements, the Document Type of the generated and 
regenerated documents are updated as Agreement Document and the generated 
supporting documents are updated as Supporting Document.
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To send an agreement document for review
On the Agreement detail page, click the Send for Review button.
Select documents to send for review and click Next.
(Optional) Select either or both Related Agreements and Child Agreements 
checkboxes to view documents relating to selected agreement types. 

(Optional) Select an appropriate email template for your agreement document and 
click Next.

(Optional) Select a document edit permission to be applied to any documents 
selected in previous steps.

You can see the Choose Related Document(s) page if the current agreement 
has related or child records. If there are both child and related documents, you 
can either select Related Agreements or Child Agreements checkbox to filter 
according to your requirement. You can view Related, Sibling, Parent, or Child 
agreement documents according to the Filter By The Primary Agreement 
Status comply system property. For more information, see Comply System 
Properties.



•

•

•

•

Important Notes on Email Template Selection

If you are using Lightning, you can see the email template folder 
dropdown. You can select an email template from the selected folder.
A default email template is usually configured by your administrator 
(using an Admin property - APTS_EmailTemplateForReview) for the Send 
for Review action. Check with your administrator if you are unsure. For 
more information, see Admin Entries.
If no Email Template is selected and no default email template has 
been configured (using APTS_EmailTemplateForReview), the Email 
Template "Email Template For Review Signature" is used. In most cases, 
this template not configured as "Available for Use" and must be 
manually set to true or an error will occur. In the case of a new 
installation of the package (non-upgrade), this Email Template is 
automatically configured as "Available for Use."
You cannot return to this page after you click Next. If you decide you 
want to use a different email template after this point, you will have to 
cancel the Send for Review and start over from the agreement record.
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In the To field, enter the name or use the Lookup to find the contact you want to send 
the document to.

Enter or use the Lookup icon to add recipients to the Additional To, Cc or Bcc fields.

(Optional) Update the email Subject and Body.
(Optional) If you need to add any supporting document from your local drive:

In the Attached Documents section, click Add More.
Drag and drop or upload documents from your local drive.
On the Upload Files popup, click Done after the documents are uploaded.
Click Add.

Click Send.  
The activity is logged in the Activity History. The Status Category changes to In 
Authoring and the Status changes to Other Party Review for your agreement record.

You can see the Set Document Permissions page if Agreement Document 
Protection rules for "Send to Other Party for Review" are specified and 
properties for document protection are enabled. For more information, see 
Configuring Agreement Document Protection.



Note

At least one recipient must be specified in the To field. If the email IDs or 
contacts specified in the To or Additional To fields are invalid, when the 
APTS_EnableValidationForEmailWithoutUserContact property is set to true, 
an error is displayed.



a.

b.

c.
d.

Note

If there are many contacts (for example, more than one million), you can 
launch a custom pop-up page where you can quickly search and select 
contacts for the Additional To, Cc, and Bcc fields.

Click the Lookup icon next to the Additional To field to launch the Email 
Address Lookup window.
Search for contacts and add them to the Additional To Recipients, CC 
Recipients, and BCC Recipients lists.
Click Save.
The APTS_EnableCustomEmailAddressLookup admin entry must be set 
to True, to view the custom pop-up page; otherwise, the standard 
Salesforce pop-up page is displayed. At least one recipient must be 
specified in the Additional To field.
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According to the Email Attachments configuration, when you send documents for 
review, recipients can view the documents as links or HTML attachments. For more 
information, see Salesforce Documentation.

After the customer receives your email and responds back, you can track the changes made 
by your customer, negotiate for the terms and conditions and finalize the agreement.

Tracking X-Author Reviews
A significant part of the negotiation process for an agreement involves including reviewers– 
internal or external–in the collaboration process. This typically requires the main 
agreement document and any supporting documents to be sent by the contract negotiator 
to reviewers for term changes, additional redlining, clarification of language, or other legal 
or contractual input. Contract Management provides a standard Send for Review process 
from Agreement records in Salesforce, but this may not always be the most ideal solution 
for contract negotiators.

Sending for Review in X-Author Contracts
Customers who have X-Author Contracts and the X-Author Contracts for Outlook add-in 
can manage the entire Send for Review using Microsoft Office applications. This allows 
them to:

Use the X-Author for Microsoft Outlook add-in to send and receive agreement 
documents.
Track and manage review cycles of negotiated documents along with their recipients.
Use review cycles of agreement documents to monitor negotiations at the summary 
and detail level.
Complete the end-to-end negotiation process without leaving Microsoft Office.

Note

The Admin Property APTS_DefaultEmailContactName is required to create an 
"Email: Subject" entry on the Agreement record Activity History Related List 
after the email is sent. If the property is not defined or is invalid, Email details 
are not recorded in the Activity History.



https://help.salesforce.com/articleView?id=000320299&language=en_US&type=1&mode=1
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Tracking Reviews on the Agreement Record
X-Author Review Cycles can be tracked on the Contract Management side, using the Merge 
Events related list on the agreement record. Tracking of review cycles is only enabled for 
Version Aware agreement records.

You can track individual Review Cycles through the Merge Event Details object (child object 
of Merge Event) on the agreement record. To view information on Out for Review and 
Complete Review Cycles, drill down to the Merge Event Details through the Review action 
link, located in the Merge Event related list. You can also review Document Version 
information for any document that is part of a Review Cycle.

Example: Version Aware Agreement Document
Prior to Send for Review, the Merge Event-related list might display the merge events 
already taken on the agreement.
Next, you initiate a review of the main agreement document from X-Author Contracts, 
sending it to 2 recipients. After sending, you refresh the agreement record and view the 
Merge Event list.
You can track status for all Review Cycles by clicking on the Review event link. The 
Merge Event Detail screen is displayed. 
 

 

 
The Merge Event Detail page displays information about the Review. Status indicates 
it is currently in progress. The Merge Event Details list contains a separate record for 
each individual review cycle (a unique combination of recipient and document). Each 
review cycle displays the Reviewer Email and the Review Start Time.
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Click the version number under Sent Version Detail to view the Document Version 
Details for the version of the agreement document under review. The Document 
Version Detail is displayed. You can view information for the document being 
reviewed. The version 1.1.0 indicates that it is the first Negotiator (minor) version, 
checked in by you before being sent for review. 
One of the reviewers replies to your review request and you check in the document on 
behalf of the reviewer. You return to the agreement record to track the review. The 
agreement has been checked in as a new Reviewer (revision) version 1.1.1. 
Click the Review link to view the updated review cycle. 

 

 
You can choose to close all remaining cycles at the next document check-in, rather 
than check the document in on behalf of the second reviewer. This creates a new 
Negotiator (minor) version of the document. The Merge Events related list is updated 
to reflect the Review as complete now that all review cycles are closed.
Click the Review link to drill down into Merge Event Details. Review End Time and 
Version Details information is displayed for all review cycles. View Document Versions 
and download attachments as needed.

Sending an Agreement Document for Parallel 
Review
At any point in the negotiation process, prior to finalizing the document, you can send an 
agreement document for review to your customers or other parties involved in the 
negotiation. After an agreement document is generated, you can send it for internal or 
external review to one or more reviewers. You can also select multiple documents and send 
them for review.

The parallel review is an unordered workflow that allows reviewers to review an 
agreement document without having to wait for another reviewer to approve it. After the 
review cycle has started, you can view the review progress for the document in the 
Document Versions section, whether the review cycle is In Progress, Cancelled, or 
Completed. A reviewer can upload the reviewed document or send the reviewed document 
to the Contract Administrator to upload it. The review cycle is marked as complete when 
all the reviewers have uploaded their reviewed documents. You can track review activity in 
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the Document Version section on the Agreement Detail page when you send the agreement 
for review, add additional reviewers, cancel review, or end review.

When you navigate to the Review Cycle page, you can see all the review cycles for a 
document on the left panel and the latest review cycle details on the right panel. You can 
click any Review Cycle name on the left panel to view that review cycle details.

To use parallel review, you must send documents in the DOCX format with the Document 
Type as Agreement Document. The following conditions apply when you send documents 
for parallel review:

If you send documents for parallel review with any other file format (PDF, PNG, DOC, 
etc.), documents will go through the normal review (not parallel review).
If you send documents with other file formats along with DOCX, documents in other 
file formats will go through the normal review, whereas the document in DOCX file 
format with the Document Type as Agreement Document will go through the parallel 
review.
If you select documents with Document Type as Agreement Document and other file 
formats (PDF, PNG, DOC, etc.), you will see the Send for Review page instead of the 
Parallel Review page.

You can send related agreement documents according to the administrator configurations 
and the parallel review does not impact the status and status category of related 
agreements.

This feature spans X-Author Contracts and CLM. For more information, see Send for 
Parallel Review using X-Author Contracts.

Prerequisites
Your administrator must have configured the settings mentioned in Prerequisites for 
Parallel Review.
You must have a generated agreement document.
You must ensure that the Status Category of the Agreement is In Authoring or In 
Signatures.
You can only send DOCX documents for parallel review. 
You can view the Upload Reviewed Document button after you send a document for 
parallel review. 
You must disable Clickjack Protection if you are using Salesforce Lightning. For more 
information, see Disabling Clickjack Protection.

https://documentation.conga.com/x-author-for-contracts/latest/sending-an-agreement-document-for-parallel-review-143886281.html
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Restrictions
If the reviewed document is less than 25 MB, you can reply to the review email by 
attaching reviewed documents. If the reviewed document exceeds 25 MB, you can 
share the document with the contract owner. The contract owner can upload the 
reviewed document and end the review. For information on supported file sizes, see 
 Supported File Sizes in Lightning and Supported File Sizes in Classic.
If you select related or child agreement documents for parallel review and the 
Parallel Review for related agreements comply system property is disabled, 
documents are considered as supporting documents. You must not reply to the review 
email with related or child agreement documents after review. You can reply to the 
review email with the reviewed document that has your email address in the file 
name.
When you reply to an email with comments or add comments while ending a review, 
you can add only 32k characters.
When you track the review status from X-Author Contracts, the buttons on the Review 
Cycle page are disabled.

To send an agreement document for review
On the Agreement detail page, click the Send For Review button from the Additional 
Actions section. 
The Select Documents page is displayed. You can view the latest version of the 
agreement documents. You can sort the columns to view ascending or descending 
order of data in a column.
From the Agreement Documents section, select agreement documents in DOCX 
format that you need to send for review. From the Related Agreement Documents 
section, select agreement documents in DOCX format that you need to send for 
review.
(Optional) You can use the agreement documents search box to search for agreement 
documents with the document name. You can use the related documents search box 
to search for related documents with document name, agreement name, or 
agreement relationship.

If the agreement has any related or child agreement documents, you can view 
the Related Agreement Documents section and select related or child 
agreement documents in any format that you need to send for review. But only 
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(Optional) To add, remove, or reorder columns:
Click the settings icon ( ) to configure the fields to view the Select Fields to 
Display popup. 
To add a new column, select a field from the Available Fields and click the 
 icon to move the field to Visible Fields.
To remove a column, select a field from the Visible Fields and click the   icon to 
move the field to Available Fields.
To reorder the columns, click   or  . 
Click Save.

After you select a document, the Next button is enabled. Click Next to proceed to the 
next step.
In the Email Detail section, enter contacts or recipient email addresses.

(Optional) If you need to update the email subject, you can enter the new subject in 
the Subject field.
(Optional) If you need to change the email template, click the Select another email 
template hyperlink to change the email template. In the Select Email Template 
popup, select an email template folder from the dropdown and then select an email 
template. Click Save.

documents in DOCX format are considered for parallel review. You can click 
the Show filters icon ( ) to filter Related, Sibling, Parent, or Child agreement 
documents. 

At least one contact must be available in your org. You can add a maximum 
of 150 recipients.



The default email template is based on the value set 
for APTS_EmailTemplateForReview or  
APTS_EmailTemplateForReviewSignatures admin entry. If the admin entries 
are not configured, the default email template is set to the template provided 
by Conga. The default email template folder is based on the value set for 
the APTS_DefaultEmailTemplateFolder admin entry. 
When the APTS_SkipEmailTemplateSelection admin entry is set to true, you 
cannot see the Select another email template hyperlink to change the email 
template. Default Template will be selected. For information on admin entries, 
see Admin Entries.
The APTS_EnableValidationForEmailWithoutUserContact admin entry is not 
applicable in Lightning, the admin entry is still applicable in Classic.
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12.

In the Permission Setting section, you can select one of the following document 
protection level from the Document Permission dropdown.

Full access: To allow users to read and write. This option is selected by default.
Insert comments and tracked changes only: To allow reviewers to insert 
comments. All the changes made by reviewer are tracked.
Insert comments only: To allow reviewers to insert comments.
Fill in form fields only: To allow reviewers to fill in the form fields.
Read only: To allow read-only access to reviewers.
Ignore: To inherit document protection used while generating documents.

(Optional) If you need to add any supporting document from your local drive:
In the Attached Documents section, click Add More.
Drag and drop or upload documents from your local drive.
On the Upload Files popup, click Done after the documents are uploaded.
Click Add.

(Optional) If you need to remove an uploaded document, click the remove icon ( ) 
beside the document name. The remove icon is not available for agreement 
documents If you need to remove agreement or related documents, click Previous and 
unselect the required documents.

Click Send. 
The Status Category changes to In Authoring and the Status changes to Other Party 
Review for your agreement record.

To view Permission Setting, you need to configure agreement protection. 
For more information, see Configuring Agreement Document Protection. 
When you select any of the document protection options except Ignore, 
the document protection selected while sending for review is given 
priority irrespective of the document protection applied while generating 
the document. 



If the comply user property is not configured then you can view the add 
more button by default. 



You can only remove uploaded supporting documents from the Attached 
Documents section. No review cycle or document protection is added for the 
uploaded supporting documents. 
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Click Next to view the Set Document Permission page.
Click Add beside Recipients to add additional recipients and enter an email address, 
contact, or user.
Select or unselect field permissions and click the Clauses tab to select or unselect 
clause permissions.
(Optional) If you are sending multiple documents for review, select a document from 
the agreement name dropdown and repeat steps from 13 to 14 to set permissions.

Click Send. 
The Status Category changes to In Authoring and the Status changes to Other Party 
Review for your agreement record.

To view the review cycle of an agreement
Navigate to the Agreement detail page of an agreement sent for parallel review to 
view the review cycle details in the Review Status section.
Click the refresh icon ( ) to refresh the review status.
Select the document dropdown to view the review status of the selected document.
Click the Review Cycle Details hyperlink to navigate to the Review Cycle page.

(or)

Go to the Document Versions section or the Documents tab.
In the Review Status column, click the In Progress link to open the Review Cycle page.

If the toggle Set field and clause permission is on, you will see the Next button 
instead of Send. You can toggle Set field and clause permission off if you do 
not want to set field and clause permissions.
When you select PDF or documents of type Agreement Document for review or 
the Enable document permissions for review comply system property is 
disabled, you cannot see the Set field and clause permission toggle.



By default, all documents have Full Access permission. When you switch 
between documents, the permissions are retained. 



Note

The Review Status column displays the Not Started link till the notification emails 
are sent to all the recipients. Click the Not Started link to navigate to the Review 
Cycle page and click the Refresh button to refresh the review status.
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To view the review cycle of a document
Navigate to the Review Cycle page.
In the left panel from the document dropdown, you can select the latest version of the 
document if you had sent multiple documents for parallel review.

To add additional reviewers to the review cycle
Navigate to the Review Cycle page.
Click Add Reviewer. This opens the Email Edit page.

Enter Contact or User or Email details.
Click Send. An email notification is sent to the reviewer. 

To end review in a review cycle
Navigate to the Review Cycle page.
For a reviewer, click   and select End Review. 
This opens the End Review window.

(Optional) Click End Review to end the review without uploading the reviewed 
document. A message is displayed and you will receive a notification upon 
completion. 
An email notification is sent to the reviewer that the review was ended without 
uploading the reviewed document.
You can either click Upload Files or drag and drop your file.  
This displays the Upload Files popup. You can upload only one file at a time. If you 
select a document unrelated to the current review cycle, an error is displayed.
Add a comment (optional).
Click End Review. A message is displayed—your request to end the review is being 
processed and you will be notified upon completion.

The Add Reviewer button is not enabled for the review cycles in Completed or 
Canceled status.



When you select the header checkbox to select all the reviewers in the review 
cycle, all the reviewers that have In Progress status are selected. The 
reviewers in other statuses are not selected.
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Click Ok. The review status changes to Completed for the reviewer on the Review 
Cycle page. 
You must end review for each document individually. After the end review request is 
processed, the checkbox, End Review, and Cancel Review are not visible for that 
reviewer. The reviewed document is merged with the latest version of the 
document. When you end the review for all the reviewers, the review cycle status 
changes from In Progress to Completed. If two or more reviewers have reviewed the 
same field or content, the review of the last reviewer is considered as final.

To upload a reviewed document from the Agreement 
Detail page

Navigate to the Agreement Detail page.
In the Agreement Action Panel, click Upload Reviewed Document to view the Upload 
Reviewed Document page.
Click Upload Files to upload the reviewed document from your local drive or drag and 
drop your files to open the Upload Files popup. 

(Optional) Add a comment in the Comments column.
(Optional) If you upload an incorrect document, click the delete icon ( ) to remove 
the uploaded document.
Click End Review. The document review status changes to Completed.

To submit reviewed documents via email
Prerequisite: You must configure the email service and admin entry to submit a reviewed 
document via email. For more information, see Configuring Email Service for Ending Review 
by Email.

Open the email containing review documents.
Download documents and make the required changes.
Reply to the review email by attaching reviewed documents and adding your 
comments in the email body.

You can upload only one reviewed document.

Conga recommends replying to the review email with a single attachment if 
the file size is more than 10 MB.
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To verify if the review has ended for you:
Navigate to the Review Cycle page of the agreement that you have reviewed.
You can see that the Review Status is Completed and the Comments column 
has your review comments.
Activity log has a new entry that the review was ended.

 

To cancel review in a review cycle
Prerequisite: The Review Status must be in In Progress status to view the Cancel Review 
button.

Navigate to the Review Cycle page.
Select a reviewer or multiple reviewers and click the Cancel Review button in the 
header.  
(Or) For a reviewer, click   and select Cancel Review. 
This opens the Cancel Review window.

You can reply to the review email with a single document or multiple 
documents. When you reply to the review email, make sure that the combined 
file size of reviewed documents is not more than 25 MB. The review cycle does 
not end if the file size of reviewed documents exceeds 25 MB or more than 
three reviewers send 25 MB reviewed documents simultaneously. Reviewers 
can encounter errors when the file size of reviewed documents exceeds 25 MB 
and more than 2 reviewers are in the review cycle.
If you do not reply to the review email with a document that belongs to the 
current review cycle, you receive an email notification to attach a valid 
document.
When you reply to the email with the reviewed document and the document 
processing takes time, the review cycle status is updated to Merge In Progress. 
If other reviewers also reply to the email at the same time and a document is 
already being processed, the review cycle status of the remaining documents 
is updated to In Merge Queue.
Documents that are in the review are locked and are not available for sending 
for review and activation.

When you select the header checkbox to select all the reviewers in the review 
cycle, all the reviewers that have In Progress status are selected. The 
reviewers in other statuses are not selected.
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Add a comment (optional) and click Cancel Review.  
The review status for that reviewer changes to Cancelled on the Review Cycle page 
and the reviewer receives a notification email regarding cancellation of the review. 
The review cycle status remains In Progress until all the reviews are completed or 
Cancelled. If you cancel the review for all the reviewers, each reviewer's review status 
and the review cycle status changes to Cancelled and the original document is 
available for activation. If one reviewer has completed the review but other reviews 
are Cancelled in that review cycle, the review cycle status changes to Completed, 
and the reviewed document is considered as the final version. 

Sending an Agreement Document for Microsoft 
Teams Review
You can send the agreement documents to Microsoft Teams (MS Teams) for collaboration 
review. In MS Teams, you can collaboratively edit and review an agreement document with 
all the team members and view live changes. A review cycle is created when you send an 
agreement document in DOCX format for MS Teams review. 

Prerequisites
You must have configured MS Teams Setting to send an agreement document for 
review. For more information, see Configuring MS Teams Setting.
You can only send agreement documents in DOCX format for review.
You must ensure that the Status Category for the Agreement record is In Authoring or 
In Signatures.
You must ensure that Track Changes are enabled on the agreement document that 
you send to the customer for review.
You cannot send related agreements for MS Teams review.
If the document name, channel name, or team name contains special characters, the 
special characters are not displayed in the MS Teams view.
If the document name or channel name exceeds 150 characters or the team name 
exceeds 250 characters, the names are truncated. 

User Permissions Needed

To send a document for review:  Agreement: Edit.
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To send an agreement document for review
On the Agreement detail page, click the Send for Teams Review button.
From the Select Document(s) page, select documents that you need to send for teams 
review and click Next.

Choose the form of document protection to be applied to documents selected in the 
previous step and click Next. 
In the Edit Permissions Level section, the Full Access protection is selected by default.

In the Reviewers field, enter the name or email id of a reviewer from your organization 

in the search bar and click the search icon ( ). After the search results are 

displayed, click the add icon ( ) to add the reviewer. 

The newly added reviewer is displayed in the Added Reviewers section.
After adding all the reviewers, click Send.  
This displays a popup message that your document is being processed. After 
processing, a new MS Team is created. If multiple documents are sent for review, then 
multiple teams are created. The name of the team is according to the Team Name 
Format defined in MS Teams custom setting. For more information, see Configuring MS 
Teams Setting.
Click Ok on the popup message. 
This opens the Agreement Detail page. 

Note

The documents that are in review are not displayed on the Select Document(s) 
page.



Note

This page is shown only if Agreement Document Protection rules for "Send to 
Other Party for Review" are specified and properties for document protection 
are enabled. For more information, see Use Case for Setting Up Agreement 
Document Protection and Admin Entries.



Note

When you send a document for MS Teams review, you cannot check out the 
document. 



https://documentation.conga.com/display/CLM/.Admin+Entries+vWinter-20
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To review a document in MS Teams
Open MS Teams application.
On the left side of Teams, click Teams.
Type the agreement name in the search box at the top right and press Enter.
Expand the team to see the channels in the team.
Click ReviewCycle_<date>. 
The channel name is according to the Channel Name Format in MS Teams' custom 
setting.  For more information, see Configuring MS Teams Setting.
Click the Files tab.
Click More options ( ) next to the file name. 
Select an edit option according to your requirements. For more information, see 
Microsoft Teams documentation. 
After you end the review in Contract Management, the reviewed document is 
available on the Document Version Detail page.

To view the review cycle of an agreement
Navigate to the Agreement detail page.
Go to the Document Versions section.
In the Review Status column, click the In Progress link to open the Review Cycle page.

To add additional reviewers to the review cycle
Navigate to the Review Cycle page.
Click Add Reviewer. This opens the Add Reviewer page.
In the Reviewers field, enter the name or email id of a reviewer from your organization 

in the search bar and click the search button ( ). Once the search results are 

displayed, click the add icon ( ) to add the reviewer.
Click Send. An email notification is sent to the reviewer. 

Note

If you add a new member in MS Teams, the new member can review the 
document, but the new member details are not available in the Review Cycle 
page of Contract Management.
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To end review on the review cycle page
Navigate to the Review Cycle page.
Click the End Review button in the Actions column for a reviewer. This displays a 
popup message stating that the end review is initiated.
Click Ok on the popup message. 
Click Refresh to view the updated status of the review cycle. 
When you end the review for all the reviewers, the review cycle status changes from In 
Progress to Completed. The MS Team is Archived and you cannot edit the document. 
An email notification is sent to all the reviewers that the reviewed document is 
checked-in successfully. 
Click Exit.
To view the reviewed document, navigate to the Document Version Detail page.

To cancel review on the review cycle page
Prerequisite: The review cycle should be In Progress status.

Navigate to the Review Cycle page.
Click the Cancel button in the header.  
The review status changes to Cancelled on the Review Cycle page. The MS Team is 
Archived. If you edit the document, the changes will not be added to the agreement. 
An email notification is sent to all the reviewers that the review has been cancelled.

Negotiating an Agreement Document
In this stage, you can manage the Agreement Negotiation process. You can use the X- 
Author Contracts Word add-in to create and negotiate an agreement, which is designed to 
help streamline the process of maintaining agreements and associated agreement and 
clause templates. As a Contract Negotiator, you coordinate changes to the agreement 
that might occur over the course of agreement negotiation. These changes are generally 
concerned with finalizing the process in accordance with company policies and legal 
requirements. You can perform the following:

Note

An entry is added in the Activity History section when you initiate a review, add 
additional reviewers, cancel review or end review.
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Amend and save contract agreements or proposals in Salesforce
Highlight reconcilable data
Reconcile agreement or proposal records
View chatter feeds from within Microsoft Word
Share content and document to Salesforce chatter
Translate agreements from one language to another
Create reminder tasks or schedule appointment events in relation to the opened 
agreement or proposal document
Redline and store versions of the document during negotiations
Compare different versions of agreements or proposals side by side

For example, if your agreement document contains the Agreement End Date as a smart 
field, and your customer wants to extend the Agreement End Date, you can do one of the 
following:

Accept the change and Reconcile the change back to Salesforce.
Deny the change, save it with or without Redlines and send it back to your customer.

For more details refer to the X-Author Contracts documentation.

Prerequisite
You must have an existing agreement document generated in doc or docx format. The 
generated document must have been sent to the customer for review.

To negotiate an agreement
Next to your Agreement document received from your customer in the Notes & 
Attachments related list, click View.  
 

Open the Agreement document in Microsoft Word. If the document opens in Protected 
View, click Enable Editing to continue with the negotiation phase.
On the toolbar, click X-Author Contracts.
From the Access ribbon group, click Connect and login with your 
 salesforce.com credentials.
Click Check-Out > This document.
Check your customer's redlined changes in the agreement document.

https://documentation.conga.com/x-author-for-contracts/latest/x-author-for-contracts-154927679.html
http://salesforce.com/
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After finalizing the changes, from the Versions ribbon group, click Check-In.
Do one of the following actions from the Save drop-down list:

To save the agreement document with redlines in order to send it to the 
customer again, select With Redlines. 
X-Author Contracts automatically renames the agreement document as 
agreement document name_version number_Redlines.
To save the agreement document without redlines, select Without Redlines. 
X-Author Contracts automatically renames the agreement document as 
agreement document name_version number_Clean.
To save and override the changes of the agreement document and reflect them 
in the same document, select the Final - to be signed option and select the 
Reconcile Document checkbox.
To save the agreement document separately with new changes, select the Final 
- to be signed option. Use Compare to track the changes in the different versions 
of the agreement document. 
X-Author Contracts automatically renames the agreement document as 
agreement document name_version number_Final.

Click Save.
Click Refresh in your browser to see the changes. This action updates the agreement 
version in the repository and activity history.

A new version of the negotiated agreement document is saved in the Notes & 
Attachments related list. The finalized agreement document can now be sent to the 
customer for signature.

Finalizing an Agreement
After you complete the negotiation process with the customer, you can send the finalized 
agreement document to the customer for gathering signatures. When the agreement is 
ready to execute, you can collect the required internal and external signatures. Depending 
on your organization's requirements, you can send the agreement document for a manual 
signature to your customer or if a third-party application, such as Echosign or DocuSign is 
installed in your org, you can send the agreement document for an electronic signature. 
Once you receive the manually signed documents from the customer, you can upload the 

The Include Watermark checkbox remains enabled for With 
Redlines and Without Redlines options and the Create 
PDF attachment checkbox remains enabled for the Final - to be signed option 
of the Save drop-down list.
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signed documents to finalize the agreement. Documents in the review are not available to 
send for signatures or eSignatures. 

User Permissions Needed

To send a document for signature: Agreement: Edit.

Prerequisites
You must have sent a generated Agreement document to the customer for review.
You must ensure that the Status Category for the Agreement record is In Authoring.
You can also upload manually signed documents for the agreement. For more 
information, see Uploading Signed Documents.
For information on supported file sizes, see Supported File Sizes in Lightning 
and Supported File Sizes in Classic.

Limitation
You cannot send a document with protection for signatures if your organization has set up 
High-Assurance Session Security at a user profile level. As a result of the security, the 
sessions cannot be generated in asynchronous calls.

To Send an Agreement for Manual Signature
From the Agreement detail page, click the Send for Signature button.
From the Attachments section, select the file to send for signature and click Next. 
(Optional) Select files to attach to the review email from Parent, Child, or other 
agreement records related to the current agreement. 

Select the type of agreement to show attachments from. 
Select any attachments from the list displayed under "Attachments" to add to 
the review email.

Note

 Before sending the agreement document for signature, you must ensure that a final 
version of the agreement document is present in the Notes & Attachments related 
list.
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Repeat steps a – b for additional agreement types.
Click Next when you are finished.

(Optional) Choose the form of document protection to be applied to any documents 
selected as attachments in the previous steps.

(Optional) Select an appropriate template for your agreement document and click 
 Next.

In the To field, enter the name of the contact you want to send the document to. 

In Version Aware agreements, it is recommended to select a document 
associated with document version for agreement clauses to be marked 
as Final.



The Show Attachments From page is only shown if the current agreement has 
related records.



Note

The Apply Document Protection page is only shown if Agreement Document 
Protection rules for "Send to Other Party for Review" are specified and 
properties for document protection are enabled. For more information, see Use 
Case for Setting Up Agreement Document Protection and Admin Entries.



•

•

•

Important Notes on Email Template Selection
A default email template is usually configured by your administrator 
(using an Admin property) for the Send for Signature action. Check with 
your administrator if you are unsure.
If no Email Template is selected and no default email template has 
been configured (using the above properties), the Email Template "Email 
Template For Review Signature" is used. In most cases, this template not 
configured as "Available for Use" and must be manually set to true or an 
error will occur. In the case of a new installation of the package (non- 
upgrade), this Email Template is automatically configured as "Available 
for Use."
You cannot return to the Select Email Template page after you click 
 Next. If you decide you want to use a different email template after this 
point, you will have to cancel the Send for Signature and start over from 
the agreement record.
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Enter or use the Lookup icon to add recipients to the Additional To, Cc or Bcc fields.

Type a mandatory Subject and Body for your email and click Send.  
This activity is logged in the Activity History. The Status Category and Status of the 
agreement record are updated to In Signature and Other Party Signature 
respectively.

According to the Email Attachments configuration, when you send documents for review, 
recipients can view the documents as links or HTML attachments. For more information, 
see Salesforce Documentation.

After the agreement document is signed, all the clauses are marked as Final in the 
Agreement Clauses section. In version aware agreement, Document Type of the signed 
document is updated as the Executed Document.  An executed document is a finalized 
version of an agreement that is ready for activation.

Note

At least one recipient must be specified in the To field. If the email IDs or 
contacts specified in the To or Additional To fields are invalid, when the 
APTS_EnableValidationForEmailWithoutUserContact property is set to true, 
an error is displayed.



a.

b.

c.

Note

If there are many contacts (for example, more than one million), you can 
launch a custom pop-up page where you can quickly search and select 
contacts for the Additional To, Cc, and Bcc fields.

Click the Lookup icon next to the Additional To field to launch the Email 
Address Lookup window.
Search for contacts and add them to the Additional To Recipients, CC 
Recipients, and BCC Recipients lists.
Click Save.

You must set the admin setting APTS_EnableCustomEmailAddressLookup to 
True-only then is the custom pop-up page is displayed; otherwise, the 
standard Salesforce pop-up page is displayed. At least one recipient must be 
specified in the Additional To field.



Note

https://help.salesforce.com/articleView?id=000320299&language=en_US&type=1&mode=1
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To Send an Agreement for Electronic Signature
You must have sent a generated Agreement document to the customer for review.
You must ensure that the Status Category for the Agreement record is In Authoring.

From the Agreement detail page, click the eSignature button. This action takes you to the 
EchoSign or Docusign wizard. For more information on EchoSign, see Adobe Sign Services 
documentation. For more information on DocuSign, see DocuSign Services documentation.

The following conditions apply when you send documents in Version Aware agreement for 
eSignatures in DocuSign:

The Status Category changes to In Signatures and the Status changes to Other Party 
Signatures for your agreement record.
The signed agreement documents are stored in the Document Version related list.
All the agreement clauses are marked as Final.
The Document Type is updated to Executed Document.

The following conditions apply when you send documents in Version Aware agreement for 
eSignatures in EchoSign:

You can send generated, regenerated, supporting, imported offline, created offline, or 
manually uploaded documents.
You can select any document from Files or Notes and Attachments. You can also 
select the latest document version from the Document Version related list.
The Document Type of the signed document is updated as the Executed Document.
The intermediate signed documents from EchoSign are available in Contract 
Management as a major document version with name as Intermediate Signed 

The Admin Property APTS_DefaultEmailContactName is required to create an 
"Email: Subject" entry on the Agreement record Activity History Related List after the 
email is sent. If the property is not defined or is invalid, details are not recorded in 
the Activity History. After the customer signs the agreement document, you can 
activate the agreement.

Note

After an agreement document is signed, all the smart clauses are marked as Final 
in the Agreement Clauses section. 



https://documentation.conga.com/esign/latest/adobe-sign-services-157581525.html
https://documentation.conga.com/dsign/latest/docusign-services-143889318.html
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Document in the Document Version related list. In version aware agreement, the 
Document Type of the document is updated to Intermediate Document.

Activating an Agreement
After the agreement is finalized and signed between the engaged parties, you can activate 
the agreement to bring it into effect. Activating an agreement record is very important 
because it ensures that key dates and events will be monitored by the system and that all 
in-effect agreements are included in appropriate searches, reports, and views. As a part of 
the activation sequence, CLM ensures that your organization has identified and attached 
the proper, final executed version of the agreement. 

When you activate an agreement, the following documents are selected by default for 
activation:

The latest Document Versions from Document Versions Detail.
All the documents from Notes and Attachments and Files.
All the executed documents.

When you unselect a document during activation:

In version-aware agreements, the unselected documents along with their versions (if 
any) are deleted from the Document Versions Detail.
In non-version-aware agreements, the unselected documents are deleted from Notes 
& Attachments and Files.

You can publish documents to different content repositories when the 
APTS_ContentRepositoryType admin entry is configured. You can turn off the Publish toggle 
button if you do not want to publish a document to a content repository. The following 
table describes the impact of the APTS_ContentRepositoryType admin entry, publish option, 
and document selection during activation.
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APTS_ContentRepositoryTy 
pe value

Document Publish toggle Version- 
Aware 
agreeme 
nt

Non- 
Version- 
Aware 
agreeme 
nt

Content Selected On The 
published 
document 
is moved 
to 
Content. 
The 
document 
is 
removed 
from the 
agreemen 
t 
(Documen 
t 
Versions).

The 
published 
document 
is moved 
to 
Content. 
The 
document 
is removed 
from the 
agreement 
(Notes & 
Attachme 
nts and 
Files).

Off The 
unpublish 
ed 
document 
remains 
in the 
agreemen 
t 
(Documen 
t 
Versions).

The 
unpublishe 
d 
document 
remains in 
the 
agreement 
(Notes & 
Attachme 
nts and 
Files).
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APTS_ContentRepositoryTy 
pe value

Document Publish toggle Version- 
Aware 
agreeme 
nt

Non- 
Version- 
Aware 
agreeme 
nt

Document Selected On The 
published 
document 
is moved 
to 
Agreemen 
t 
Document 
. The 
document 
is 
removed 
from the 
agreemen 
t 
(Documen 
t 
Versions).

The 
published 
document 
is moved 
to 
Agreement 
Document. 
The 
document 
is removed 
from the 
agreement 
(Notes & 
Attachme 
nts and 
Files).

Off The 
unpublish 
ed 
document 
remains 
in 
agreemen 
t 
(Documen 
t 
Versions).

The 
unpublishe 
d 
document 
remains in 
agreement 
(Notes & 
Attachme 
nts and 
Files).
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APTS_ContentRepositoryTy 
pe value

Document Publish toggle Version- 
Aware 
agreeme 
nt

Non- 
Version- 
Aware 
agreeme 
nt

Chatter Selected On The 
published 
document 
is moved 
to 
Chatter 
and 
Notes & 
Attachme 
nts and 
Files.

The 
published 
document 
is moved 
to Chatter 
and Notes 
& 
Attachme 
nts and 
Files.

Off The 
unpublish 
ed 
document 
remains 
in 
Document 
Versions.

The 
unpublishe 
d 
document 
remains in 
agreement 
(Notes & 
Attachme 
nts and 
Files).

None Selected Publish column 
is not visible

The 
document 
remains 
in 
Document 
Versions.

The 
document 
remains in 
the 
agreement 
(Notes & 
Attachme 
nts and 
Files).
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APTS_ContentRepositoryTy 
pe value

Document Publish toggle Version- 
Aware 
agreeme 
nt

Non- 
Version- 
Aware 
agreeme 
nt

The admin entry is not 
configured, deleted, invalid, or 
blank.

 

Selected On The 
published 
document 
is moved 
to 
Agreemen 
t 
Document 
. The 
document 
is 
removed 
from the 
agreemen 
t 
(Documen 
t 
Versions).

The 
published 
document 
is moved 
to 
Agreement 
Document. 
The 
document 
is removed 
from the 
agreement 
(Notes & 
Attachme 
nts and 
Files).

Prerequisites
You cannot activate an agreement if review cycles are In Progress.
You must have an existing reviewed and signed agreement document.
You must ensure that the agreement record's status category is In Signatures or In 
Filing.
You can edit the classic activation email template. For more information, see Editing 
Classic Email Templates.

Restriction
You cannot unselect executed documents during activation.
When the combined size of documents exceeds 5 MB during activation and the 
APTS_ContentRepositoryType admin entry value is set Document, you will encounter 

The content repository 
type is considered 
Document.
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2.

3.

4.

5.

an error. If you need to activate an agreement with large files, ensure that the 
APTS_ContentRepositoryType admin entry value is set to none, content, or chatter.

To activate an agreement 
On the Agreement detail page, from the Agreement Actions section, click Activate.
(Optional) By default, all the agreement documents are selected. Unselect the 
agreement documents that you do not need in the activated agreement. The Publish 
option is toggled off if you unselect a document and you cannot toggle it on. You can 
toggle the Publish option off for a document without unselecting the document if you 
do not want to publish the document.  
The following screenshot shows the Activate page. 

Click Activate. 
This displays the Activate Agreement popup. 
(Optional) Turn on the Notify others toggle to notify other stakeholders. Enter the 
Users, Contact, or email addresses of the stakeholders in the To field. 

Click Activate. 
An email is sent to you after the agreement is activated. The Status Category 
changes to In Effect and the Status changes to Activated.

The activated agreement record can now be amended or renewed or terminated or expired.

If you activate an agreement containing documents larger than 25 MB, you will see an 
intermittent Status Category | Status—In Effect | Being Activated. After the agreement 
activation is processed, Status Category | Status changes to In Effect | Activated.

You will receive an email after the agreement is activated irrespective of the 
Notify others toggle is on or off. The email subject and body are read-only 
fields, but your administrator can change the email template from the classic 
email templates. For more information, see Editing Classic Email Templates.
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Managing Agreement Lifecycle Post-Activation
The contract process goes through typical sequences of events or phases. The following 
phases encompass the various options for managing the Agreement life cycle.

Amendment
Renewal
Termination
Expire

For details, refer to Status Categories and Statuses.

Amendment

User Permissions Needed

To amend an agreement: Agreement: Create, Edit.

During the term of the agreement, you may need to modify the contract. For example, the 
language or terms of the contract. The Amend action is used for this functionality. The 
Amend action creates a new version of the agreement record. The new, amended record 
shares the same base agreement number as the original with the decimal point 
incremented by one. All the data from the original version is copied into the new version. The 
new version can then go through the same agreement process as described above. On 
execution of the amendment, the status category of the original version of the agreement is 
changed to Amended from In Effect.

 
Renewal

User Permissions Needed

To renew an agreement: Agreement: Create, Edit.

Towards the end of the term of the agreement, you may want to renew the agreement for 
a further period of time. In such a scenario, the Renew action would create a new version of 
the agreement. The agreement can then be executed after updating the term of the 
agreement. You can quickly identify contract renewal candidates, allowing plenty of time 
to act and create new contract drafts based on the previous contract.

The APTS_RecordTypeUpdateOnAmend admin object allows you to update the 
record type while amending and agreement.
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Termination

User Permissions Needed

To terminate an agreement: Agreement: Edit.

If you decide to terminate or end a contract, you can click on the Terminate action. The 
agreement status is changed to Terminated.

Expiration

User Permissions Needed

To mark an agreement as expired: Agreement: Edit.

After the agreement term ends, use the Expire action to mark the agreement as Expired.

Working with Offline Agreements
If you have a third-party paper that you want to use as a basis for your contract, Contract 
Management lets you create or import it as an offline agreement document. After an 
offline document is uploaded, Contract Management tags it with metadata so that it can 
be checked out with X-Author for Contracts.

Contract Management along with intelligent data extraction software enables you to 
intelligently discover a third-party paper. The intelligently discovered third-party paper is 
scanned by the optical character recognition method and converted the document to a 
searchable PDF.

Contract Management supports the following use cases:

Creating an Offline Agreement
Importing an Offline Document
Reviewing an Agreement Created by Intelligent Discovery
Storing an Executed Agreement
Status Changes in Offline Agreements

Note

When you clone, amend, or renew an agreement, the notes of the parent agreement 
are copied to the new agreement.
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5.

For information on configuring intelligent discovery settings, refer to the Managing Offline 
Agreements.

Creating an Offline Agreement
Contract Management enables you to create an offline agreement from a third-party 
paper. This feature creates an agreement record in Contract Management and tags with 
metadata so that it can be checked out with X-Author for Contracts.

Prerequisite
You must be logged in to Salesforce.com.
You must have Create and Edit agreement permissions.
For administrator configurations, see Managing Offline Agreements. 

To create an offline agreement
Click Create Offline Agreement link under Links. This displays Select Agreement 
Record Type page.
Select an agreement record type from the Record Type of the new record drop-down 
list and click Continue. This displays the New Offline Agreement page.
Click Continue. In the Select the File section, click Choose File to select a document to 
attach to this agreement. This displays the Open window. 
Navigate to the file you want to upload. Select the file and click Open. In the Click the 
Attach File button section, click Attach File to create the offline agreement with the 
selected document attached to the agreement.
In the Select this option for Intelligent extraction of data and clauses from the 
uploaded file, select the Intelligent Discovery checkbox for intelligent data extraction.

Note

You can upload the offline documents in any file format. When you import an offline 
document through intelligent discovery, an intelligent data extractor (KIRA/Conga 
AI) processes the file formats it supports. When you import an offline document 
without intelligent discovery, the merge server processes the file formats it supports. 
When you import an offline document in a non-supported file format (with or 
without intelligent discovery), the unprocessed document is available in the Notes & 
Attachments related list in the agreement.



http://Salesforce.com
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9.

•

Click Continue. This displays the Agreement Edit page.
Enter values into any required fields (marked in red) and additional fields as needed 
to complete the agreement record details.
Click Save. This displays a message stating that Intelligent Discovery will create a 
batch.  
You will also receive an email notification with the IDEJobProcess status and error 
information.
Click Ok. This displays the Agreement Detail page. 
When an agreement is imported using Intelligent Discovery, the Status Category is set 
to Import and Status is set to Review. When an agreement is imported without using 
intelligent discovery, the Status Category is set to In Authoring and the Status is set 
to <Blank>.    

Importing an Offline Document
You can import third-party or offline documents into CLM and run the document through 
the contract management lifecycle. You can also update the existing document version by 
importing a document so that the document versioning can be tracked as a single 
document version. You can import the document as a major version, minor version, or create 
a custom version. You can also import the document using intelligent discovery to extract 
and organize unstructured text.

Prerequisites

The intelligent discovery settings must be configured to import documents using 
intelligent discovery. For more information, see the Managing Offline Agreements.

Note

You can leave the Intelligent Discovery checkbox unselected if you want to 
import the document without intelligent data extraction. For information on 
checking the intelligent discovery processing status in Lightning, see Reviewing 
an Agreement Created by Intelligent Discovery.



Note

Only Review Offline Document action is available after intelligent discovery 
and other agreement actions are disabled. Other agreement actions are 
enabled after reviewing the agreement.
In the version aware agreements, the document type of the document created 
offline is updated as Agreement Document.
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The XAJS End Point Comply System Property must be enabled. For more information, 
see Comply System Properties.
The maximum recommended file size to upload files is 200MB.

To import an offline document without updating an existing 
document version

On the Agreement Detail page, click Import Offline Document to view the Import 
Document page.
Click the Use Intelligent Discovery toggle button to perform the intelligent 
discovery or leave the toggle button as is to import the document without intelligent 
discovery.
You can either click Upload Files or drag and drop your files. If you had turned on the 
Use Intelligent Discovery toggle, you can upload only one document. 
The Upload Files popup is displayed. 
After the upload completes, click Done. 
A list of files uploaded is displayed. You can also add comments for each uploaded 
file.

(Optional) If you upload an incorrect document, click the delete icon ( ) to remove 
the uploaded document.
(Optional) Add a comment for each file in the Comments column. After you import the 
document, you can view the added comments in the Document Version Detail page.
Click Import. You are navigated to the Agreement Detail page. 
When a document is imported using Intelligent Discovery, the Status Category 
updates to Import and Status updates to Review. When a document is imported 
without using intelligent discovery, the Status Category and the Status do not 
change.

If you upload a single file, you can turn on the Use Intelligent Discovery toggle 
and the uploaded document is intelligently imported. If you upload multiple 
files, you cannot turn on the Use Intelligent Discovery toggle button. 
For information on checking the intelligent discovery processing status in 
Lightning, see Reviewing an Agreement Created by Intelligent Discovery.
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To import an offline document by updating an existing 
document version
Prerequisite: When the Ancestor selection for Import Offline comply system property is 
enabled, you can view the Import Documents popup. For more information, see Comply 
System Properties.

Perform steps 1 to 7 mentioned in the previous section.
On the Import Documents popup, toggle Create Major/Minor Version on.
From the Document Version dropdown, select a document from the list of latest 
document versions.

From the Version Type dropdown, select a version type.

(Optional) Repeat steps 3 and 4 for all documents you had imported.

Click Import to navigate to the Agreement Detail page. According to the document 
version and version type you had selected, a version number is assigned to imported 
documents.

Reviewing an Agreement Created by Intelligent 
Discovery
This section describes how to review an agreement document created or imported by 
intelligent discovery in Classic and Lightning. 

When you complete the review of an offline document (created or imported):

All the clauses in the document are updated to Inserted in the Agreement Clauses 
section
The Agreement Status Category is updated to In Authoring
The Agreement Status is updated to Author Contract.

You can view documents of type Agreement Document in the Document 
Version dropdown.



If you select Custom as version type, you can enter a version number up to 
9999.9999.



Make sure that you do select different existing documents for all imported 
documents. 
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When you complete the review of an executed document (uploaded as a signed document):

All the clauses in the document are updated to Final in the Agreement Clauses 
section
The Agreement Status Category is updated to In Filling. 
The Agreement Status is updated to blank.

 

Reviewing an intelligent discovery agreement document in Lightning (New UI)

Prerequisite
You must configure the APTS_UIPageConfig admin entry to view the new UI. For more 
information, see Admin Entries.
You must configure the intelligent discovery status panel in lightning. For more 
information, see Configuring Intelligent Discovery Status Panel in Lightning.
You can see the Intelligent Discovery Status panel only when intelligent discovery is in 
progress. After the imported document is processed, you can review the document.
You can perform the following actions on the Intelligent Discovery Status panel:

Click the refresh icon ( ) to refresh the intelligent discovery processing status. 

 
Click the info icon ( ) to view the latest information for the intelligent 
discovery status. 
The intelligent discovery will take some time. After the processing is completed 
successfully, you will receive an email.
Click the Ready for Review link to review the imported document.
If the processing fails, you can hover on the  icon to view the error. Click Retry 
Import Document to revert the agreement Status Category and Status to the 
previous status. After the agreement status reverts to the previous status, you 
can click Import Offline Document to restart the Intelligent Discovery. 

To review an intelligent discovery agreement document in 
Lightning

Click the Ready for Review hyperlink on the Intelligent Discovery panel. 
This displays the document viewer. 

Ensure that you do not click the refresh icon multiple times. You must 
wait for the processing to complete.
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iii.
b.

i.

On the Agreement Detail tab, you can review the details extracted from the imported 
document and modify them as required.

On the Clauses tab, you can view all the extracted clauses. When you select a 
clause, you are navigated to the clause location in the document. When you select a 
clause that contains special characters and the system is unable to locate the 
selected clause in the document, you can see a message. When you click Ok, you are 
navigated to the page that contains the clause. You can perform the following tasks 
in the Clauses tab:

To add a new clause:
Click New. 
The New Clause popup is displayed.
Enter the following details:

Clause Name: Enter the clause name.
Clause Text: Enter the clause text. 

Click Add.
To insert a clause from the clause library:

Click Add Clause.  
The Add Clause popup is displayed.

When you review a document that exceeds 10 MB in size, you can view the 
Loading Document progress bar to track the document loading progress. If you 
click Cancel on the Loading Document popup, you cannot view the document 
viewer.
You can click the expand icon ( ) on the document viewer or the right panel 
to expand the view. You can click the collapse icon ( ) on the document 
viewer or the right panel to collapse the expanded view.



When the Use Normalization setting is enabled while configuring intelligent 
discovery settings, the agreement details are extracted as strings and these 
strings are displayed below each agreement field. If the Intelligent Discovery 
encounters any issue, the date and currency watermark is displayed for the 
Date and Currency fields. If you need to modify the extracted field values, you 
can edit the field values and add the required values. If multiple values are 
extracted for a field, you can select the correct value from the dropdown.
The fields in the Agreement Detail tab are configurable and may vary based 
on the administrator settings. For more information, see Configuring Intelligent 
Discovery Fields. 
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ii.
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In the Search Clause Library search box, search for a clause by entering a 
keyword. You can refine your search according to Type, Category, 
Subcategory, Locale, and Language. 
Select a clause from the search results.
(Optional) You can update the clause text.

To modify a clause:
Click the edit icon ( ). The Edit Clause page is displayed. 
Modify the following details:

Clause Name: Modify the name of the clause.
Clause Text: Modify the text of the clause.

Click Save.
To delete a clause:

Click the delete icon ( ). This displays the Confirm Delete window.
Click Yes.

To save the agreement document, click Save.  
You can check out the document with X-Author Contracts and version it.
To save your review and revisit the review screen later:

Click Cancel. The Warning message is displayed prompting you to confirm if you 
want to proceed.
Click Yes. 
If you had added or modified a clause, the new clause or changes to the clause 
are saved.

To download highlighted or unhighlighted documents:
Navigate to IDE Job Section.
Click the KIRA hyperlink.
In the Related tab, select a document you need to download either from the 
Files or Notes & Attachments section. 
This opens the document in preview mode. 
Click the Download button on the top of the page. 
This downloads the document in the default download location of the browser.

Reviewing an intelligent discovery agreement document in Lightning (Old UI)

Prerequisite
You must configure the intelligent discovery status panel in lightning. For more 
information, see Configuring Intelligent Discovery Status Panel in Lightning.

You can select the highlighted and unhighlighted documents from Document 
Version Details while sending for review, signatures, or eSignatures.
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You can see the Intelligent Discovery Status panel only when intelligent discovery is in 
progress. After the imported document is processed, you can review the document.
You can perform the following actions on the Intelligent Discovery Status panel:

Click the refresh icon ( ) to refresh the intelligent discovery processing status. 

 
Click the info icon ( ) to view the latest information for the intelligent 
discovery status. 
The intelligent discovery will take some time. After the processing is completed 
successfully, you will receive an email.
Click the Ready for Review link to review the imported document.
If the processing fails, you can hover on the  icon to view the error. Click Retry 
Import Document to revert the agreement Status Category and Status to the 
previous status. After the agreement status reverts to the previous status, you 
can click Import Offline Document to restart the Intelligent Discovery. 

To review an intelligent discovery agreement document in 
Lightning

Click the Ready for Review hyperlink on the Intelligent Discovery panel. 
This displays the document viewer.  
The Language, Document Search, Page Navigation, and OCR Quality of the document 
are displayed at the top of the document viewer. The OCR quality determines the 
quality of the transcription recognized by OCR.

If the document preview does not load or you need to download the processed 
document, click the Download File Returned From Intelligent Discovery hyperlink from 
the header.

Ensure that you do not click the refresh icon multiple times. You must 
wait for the processing to complete.



When you review a document that exceeds 10 MB in size, you can view the 
Loading Document progress bar to track the document loading progress. If you 
click Cancel on the Loading Document popup, you cannot view the document 
viewer.
You can click the expand icon ( ) on the document viewer or the right panel 
to expand the view. You can click the collapse icon ( ) on the document 
viewer or the right panel to collapse the expanded view.
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c.

On the Agreement Detail tab, you can review the details extracted from the imported 
document and modify them as required.

On the Clauses tab, you can view all the extracted clauses. When you select a 
clause, you are navigated to the clause location in the document. When you select a 
clause that contains special characters and the system is unable to locate the 
selected clause in the document, you can see a message. When you click Ok, you are 
navigated to the page that contains the clause. You can perform the following tasks 
in the Clauses tab:

To add a clause:
Click Add Clause.
Enter the following details:

Clause Name: Enter the clause name.
Clause Text: Enter the clause text. 

Click Add Clause.
To mark a clause from the PDF document:

Select the text in the document, right-click, and select Add Clause. The 
Add Clause window with the following fields is displayed.

Clause Name: Set to a clause name by default. 
Mapped Clause Details: Clause text of the default clause.
Clause Text: Clause text selected from PDF.

Enter the following details:
Clause Name: Select a clause from the dropdown to add to an 
existing clause or click New and enter the name of the clause. 
When you select a clause from the dropdown, the Mapped Clause 
Details change accordingly. When you click New, only clause text is 
displayed.
Clause Text: Displays the selected clause. 

Click Add.
To modify a clause:

When the Use Normalization setting is enabled while configuring intelligent 
discovery settings, the agreement details are extracted as strings and these 
strings are displayed below each agreement field. If the Intelligent Discovery 
encounters any issue, the date and currency watermark is displayed for the 
Date and Currency fields. If you need to modify the extracted field values, you 
can edit the field values and add the required values. If multiple values are 
extracted for a field, you can select the correct value from the dropdown.
The fields in the Agreement Detail tab are configurable and may vary based 
on the administrator settings. For more information, see Configuring Intelligent 
Discovery Fields. 
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Click the  icon. The Edit Clause page is displayed. 
Modify the following details:

Clause Name: Modify the name of the clause.
Clause Text: Modify the text of the clause.

Click Save.
To delete a clause:

Click the   icon. This displays the Confirm Delete window.
Click Yes.

To save the agreement document, click Save.  
You can check out the document with X-Author Contracts and version it.
To save your review and revisit the review screen later:

Click Cancel. The Warning message is displayed prompting you to confirm if you 
want to proceed.
Click Yes. 
If you had added or modified a clause, the new clause or changes to the clause 
are saved.

To download highlighted or unhighlighted documents:
Navigate to IDE Job Section.
Click the KIRA hyperlink.
In the Related tab, select a document you need to download either from the 
Files or Notes & Attachments section. 
This opens the document in preview mode. 
Click the Download button on the top of the page. 
This downloads the document in the default download location of the browser.

Reviewing an intelligent discovery agreement document in Classic

Prerequisites
Ensure that you select Intelligent Discovery when you create an offline document.
The document is successfully processed by the Intelligent server and returned to 
Contract Management.

You can select the highlighted and unhighlighted documents from Document 
Version Details while sending for review, signatures, or eSignatures.
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To review an intelligent discovery agreement document in 
Classic

In the Agreement Action Panel, click Review Offline Document. The Review Offline 
Document screen with the current status of the extraction is displayed.  
You will receive an email notification with the Batch job status for IDE process status 
and error information.
Click Return. This displays the Agreement Detail page.  
You will receive an email notification with the Batch job status for IDE process status 
and error information after the agreement is processed.

Click Review Offline Document. An intermittent page is displayed that checks for 
document status and the document viewer is displayed.
You can review the document, add clauses, update the agreement details and click 
Save. 

Storing an Executed Agreement
An agreement passes through various phases during the agreement lifecycle, from the time 
the agreement is created until the agreement is activated. Sometimes, the agreement is 
managed offline and the contract manager will need to upload the executed document. 
Also while uploading a signed agreement offline, you can upload the executed agreement. 

An executed document is a finalized version of an agreement that is ready for activation in 
the Contract Management application.

Prerequisites
At least one template must exist for the corresponding agreement record type.
Refer to Managing Offline Agreements for admin configurations. 

To store an executed document
Click Store Executed Agreement link under Links. This displays the Select Agreement 
Record Type page.

Note

You can also refresh the page instead of clicking Return > Review Offline 
Document to view the extraction status. The Agreement Detail page is 
displayed after the extraction is complete.



https://documentation.conga.com/display/CLM/.Managing+Offline+Agreements+vWinter-20
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Select an agreement record type from the Record Type of new record drop-down list 
and click Continue. This displays the New Offline Agreement page.
Click Continue.
In the Select the File section, click Choose File to select a document to attach to this 
agreement. This displays the Open window. 
Navigate to the file you want to upload. Select the file and click Open.
In the Click the "Attach File" button section, click Attach File to create the offline 
agreement with the selected document attached to the agreement.
In the Select this option for Intelligent extraction of data and clauses from uploaded 
file, select the Intelligent Discovery checkbox for intelligent data extraction.

Click Continue. This displays the Agreement Edit page. 
Enter values into any required fields (marked in red) and additional fields as needed 
to complete the agreement record details.
Click Save. This displays a message stating that Intelligent Discovery will create a 
batch.  
You will also receive an email notification with the IDEJobProcess status and error 
information.
Click Ok. This displays the Agreement Detail page. 
For the imported agreement with Intelligent Discovery, the Status Category is set to 
Import and Status is set to Review. For the imported agreement without intelligent 
discovery, the Status Category is set to In Filling.  
In the Agreement Clauses section, the clause Action is displayed as Final. When 
Document Versioning is enabled, the document is added to the Document Versions 
related list. When Document Versioning is disabled, the document is added to the 
Notes & Attachments section. 

Note

You can leave the Intelligent Discovery checkbox unselected if you want to 
import the document without intelligent data extraction. For information on 
checking the intelligent discovery processing status in Lightning, see Reviewing 
an Agreement Created by Intelligent Discovery.



In the version aware agreements, the document type of the uploaded executed 
documents is updated as an Executed Document.
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Status Changes in Offline Agreements
The following table provides an overview of changes in the agreement status category and 
status in offline agreements.

Action Status Category | Status 
(without Intelligent 
Discovery)

Status Category | Status 
(with Intelligent Discovery)

Create Offline Agreement In Authoring | <Blank> Import | Review

Import Offline Agreement No change in status Import | Review

Review Offline Document N/A Offline Agreement: In Authoring | 
Author Contract,

Executed Agreement: In Filing | 
<Blank>

Store Executed Agreement In Filing | <Blank> Import | Review

Working with Agreements
This section covers the following topics:

Searching Agreement Documents
Viewing Agreement Hierarchy
Emailing Multiple Agreement Documents
Accessing In-Effect View
Viewing Agreement Hierarchy of an Account
Clause Versioning
Uploading Signed Documents
Merging Documents in Lightning
Importing Supporting Documents
Using Smart Search to Search Content in Agreement Documents in Lightning
Working with Documents
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Searching Agreement Documents
This feature allows you to use keywords, text, or agreement field names to search the 
agreement documents of type - Files that are in PDF, DOC, DOCX, and RTF formats. You 
can preview or download individual documents that match your search criteria. You can 
also select multiple agreement documents from search results and email them as a 
downloadable link to a group of users. 

Contract Management uses:

Salesforce Document search to retrieve search results. For more information, see 
Salesforce Documentation. 
Find Query to retrieve the document matching the search results from the agreement 
attachment. For more information, see Salesforce Documentation. 

You can enter a keyword in the search box and click Search to search across all the 
agreement documents in Contract Management. You can also use the basic search filters 
to narrow down the search results. You can use the operators (" ", AND, OR, AND NOT, and 
( )) to search agreement documents. The following table provides an overview of various use 
cases for searching agreement documents and sample search queries with different 
operators.

Operator Use case Sample search query

NA Search for documents that have two words 
but in different locations.

Confidentiality Obligations

" " Search for documents that have two 
consecutive words.

"Confidentiality Obligations"

OR Search for documents that have either 
Confidentiality or Obligations

Confidentiality OR Obligations

AND Search for documents that have both 
Confidentiality and Obligations

Confidentiality AND 
Obligations

AND NOT Search for documents that have 
Confidentiality but not obligations

Confidentiality AND NOT 
Obligations

https://help.salesforce.com/articleView?id=matching_rules_matching_methods.htm&type=5
https://developer.salesforce.com/docs/atlas.en-us.soql_sosl.meta/soql_sosl/sforce_api_calls_sosl_find.htm
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Operator Use case Sample search query

( ) Search for documents that have 
Confidentiality and either Obligations or 
Privacy

Confidentiality AND 
(Obligations OR Privacy)

The Salesforce document search is based on the fuzzy matching method. This means the 
search results are not exactly the same but similar to the search string. For example, if you 
search for the word Confidentiality, you will see the search results containing the words 
Confident, Confidential, and Confidentiality. You can click the expand icon below a search 
result to view the content snippet. The content snippet displays an excerpt from the 
agreement document that contains the text that exactly matches the search string. The 
first occurrence of the search string is highlighted in the content snippet. For example, if you 
search for the word Confidentiality, you will view the content snippet for the search results 
containing the word Confidentiality. If the search text is an agreement field or there is no 
exact match in the agreement, the content snippet is not displayed.

Restrictions
You can view the content snippet and preview documents for documents less than 10 
MB in size.
You can search agreement documents that are less than 25 MB in size.  
For information on supported file sizes, see Supported File Sizes in Lightning 
and Supported File Sizes in Classic.

Salesforce Limitations
Global Search with the email address does not return RTF type files.
Document Search does not work when the content contains a period in the sentence.
The Owner, CreatedBy, and LastModifiedBy fields are not supported for lookups.

To search agreement documents
Click the Agreement Document Search tab to open the Search Contract Documents 
page.
Enter a keyword or text in the search box.

Note

The keyword should contain more than 2 characters.





CLM

680 Copyright ©2022 Apttus Corporation. All rights reserved.
 

3.
4.

5.

6.

7.

8.

9.

10.

11.
12.

Click the Show Filter link to define search criteria. 
You can use the Basic Filters to define multiple search criteria. 
Basic filters include Agreement Number, Agreement Name, Owner ID, Status, Status 
Category, Agreement Start Date, Agreement End Date, Account, and Record Type.

Click Search to view a list of agreements and their document versions matching the 
search criteria that contain the keyword. 

(Optional) Click the agreement name or agreement number hyperlink to navigate to 
the Agreement Detail page. 
The Agreement Detail page opens in a new tab.
Click the expand icon ( ) to view the content snippet. In the content snippet, the first 
occurrence of the search text is highlighted and the corresponding page number to 
which the content snippet belongs. If the keyword is an agreement field, the content 
snippet is not displayed.
Click the download icon ( ) to download an agreement document containing the 
keyword or text.
Click the preview icon ( ) to view the keyword or text in an agreement document in 
the Document Viewer window.

In the Document Viewer window, click  to go to the previous instance of the 
keyword or click   to go to the next instance of the keyword in the agreement 
document.
Click Cancel to exit the Document Viewer window and return to the search results.
Select multiple documents from the search results and click the email icon ( ) to 
send a downloadable link to download multiple documents of multiple agreements 
through email.  
For more information, see Emailing Multiple Agreement Documents and Scheduling 
Expiration Date for Email Downloadable Link. 

Note

You can use the APTS_DocumentSearchBasicFilters property to add or remove 
search filters according to your requirement. For more information, see Admin 
Entries.



Note

The Search Contract Documents page displays a maximum of 1000 search 
results. 
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Viewing Agreement Hierarchy
You can click the Agreement Hierarchy (New) button on the Agreement Detail page to view 
the agreement hierarchy of an agreement. The agreement hierarchy page displays a 
hierarchical list of agreements related to the current record. Hierarchical relationships to 
the current agreement include:

Parent agreements
Child agreements
Related agreements
Amended and renewed agreements

In the Agreement Hierarchy page as shown in the figure below, the account details of the 
current agreement, parent agreements, current agreement (highlighted in blue), and the 
relationships of the current agreement are displayed.

 

If any section has more than 3 agreements, the first 3 agreements are displayed and the 
remaining agreements are displayed as stacked cards. When you click third agreement, 
you can view the remaining agreements. The fields displayed for the agreements on the 
agreement cards are based on the APTS_AgreementHierarchyFields admin object. For more 

Note

The current agreement refers to the agreement for which you are viewing the 
agreement hierarchy. The Agreement Hierarchy page displays a maximum of 88 
parent agreements in the agreement hierarchy.
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information, see Admin Entries. You can configure the header fields based on your 
requirement. For more information, see Configuring Agreement Hierarchy Page Header.

To return to the agreement, click the Back to Agreement button. 

Prerequisite
You must configure the Agreement Hierarchy button. For more information, see Adding 
Agreement Hierarchy Button.

To view agreement details and related agreements
Click the Agreement Hierarchy (New) button on the Agreement Detail page.
Hover over an agreement card and click  . Select either of the following options: 

Select View Record from the menu to view the details of the agreement. The 
Agreement Detail page of the selected agreement opens in a new tab.
Select Show Related Agreements from the menu. A window containing Child 
Agreements and Related Agreement opens.

To customize agreement hierarchy view
Click the filter icon ( ) in the Agreement Hierarchy page. 
Turn off Child Agreements, Amendment, or Other Related Agreements toggle to 
remove that section from the agreement hierarchy view.

Emailing Multiple Agreement Documents
You can share a downloadable link for downloading multiple documents of multiple 
agreements through email. You can send the email to selected contacts or to a user group 
without downloading the agreement documents and sending them through email 

Note

Except for the related agreements with Is Amendment For, Is Amended By, Is 
Renewed For, and Is Renewed By as relationship types, all the other related 
agreements are displayed below the Related Agreements section in the Agreement 
Hierarchy page.
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a.

individually. You can send multiple documents from the Agreements tab or search results 
from the Smart Search tab. 

Prerequisite
(Optional) You can configure the Email Agreement(s) Document(s) button on the 
Agreements page. For more information, see Adding the Email Agreement(s) 
Document(s) Button.
If you are using Salesforce Lightning, you need to configure CORS to use this feature. 
For more information, see Configuration to Email Multiple Agreement Documents.
Content Delivery must be enabled. 

To email multiple agreements
Navigate to the Agreements tab or navigate to the Smart Search tab and generate 
search results.
Select the checkboxes for the agreements that you want to email.

Click Email Agreement(s) Document(s).  
This displays the Select Agreement(s) Documents(s) To Email page. The related 
documents are nested below the agreement.
Select the header checkbox before the agreement name to select all documents 
belonging to the agreement or select documents from multiple agreements based on 
your requirement. 
The Email Downloadable Link button is enabled.

To email the downloadable link, click Email Downloadable Link. 
This displays a message that the downloadable link is being generated.
To add or remove the selected agreements, click Modify Agreement Selection. This 
opens the Modify Agreement Selection window. 
You can perform the following actions on the Modify Agreement Selection window:

Click the Next or Previous links to navigate to other pages.

Note

You cannot select more than 200 agreements. 



Note

The recommended maximum file size to email agreements is 2 GB PDF or 150 
MB MS Word document and the recommended maximum number of flies to 
email agreements is 100.
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From the List of Unselected Agreements, select the agreements you need to add 
to the selection and click Add Selected.
From the List of Selected Agreements, select the agreements you need to 
remove from the selection and click Remove Selected.
Click Apply. 
The agreements that have documents are displayed on the Select Agreement(s) 
Document(s) To Email page.

When the downloadable link is ready, the Send an Email page is displayed.
Enter or use the lookup icon to add recipients to the Related To, Additional To, Cc or 
Bcc fields.
Click Send. 
An email is sent to all recipients.

To download the agreement documents 
When Password protection is optional and defaults to ON or Password protection is 
required options are selected for content-delivery password protection, you will receive two 
separate emails—one with the download link for agreement documents and one with the 
password to download the agreement document. When Password protection is optional 
and defaults to OFF is selected for content-delivery password protection, you will receive 
only one email containing the download link for agreement documents. If the agreement 
documents size exceeds 50MB, you will receive multiple download links in the email. 

Navigate to your email client and open the email—Notification: Agreement documents 
are ready for download.
Click the Download Agreement Documents hyperlink. 
This opens the link in your default browser and you will be prompted to provide the 
password.
Navigate to your email client and open the email—Notification: Password(s) to 
download agreement document(s).
Copy the document password and navigate back to the browser and paste the 
password in the Password Required field.
Click Go!.
Click the Download button on the top of the page.
This downloads the AgreementDocuments_DD-MM-YYYY HH-MM-SS.zip file. 
Extract the documents from the .zip file. The document name is appended with a 
numeral when the documents have the same name.

Note
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Accessing In-Effect View
You can use the In-Effect View to gather key information and agreement data of the 
agreement that has been In-Effect at least once. You can view the agreement data such as 
agreement details, clauses, and documents that are cumulatively effective and enforced 
by the latest in-effect agreement. You can also track the amendments of the agreement to 
view combined data from the original and amended agreements that are part of the in- 
effect agreement at any given point of time. In-Effect View is available for the agreements 
with Status Category as In Effect and Status as Activated. In Effect View is not supported 
when clauses are copied during amendment.

Prerequisites
You must configure the In-Effect View button. For more information, see Adding In- 
Effect View Button.
You can access In-Effect View for the agreements with Status Category as In Effect 
and Status as Activated.

It is recommended to clean the File Storage of your org regularly.
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The fields available on Agreement Details In Effect are according to the value defined 
for the APTS_InEffectViewMetadataFields admin object. For more information, see 
Admin Entries.
You can configure the header fields. For more information, see Configuring In-Effect 
View Page Header.

To view the In-Effect View
Open an activated agreement.
Click the In Effect View button. 
The In Effect View page opens.

To view the change history of agreement fields
In the Agreement Details In Effect section in the Change History column, click the View 
hyperlink to view all the changes made to the field in chronological order. 
This opens a <field name>Changes popup. You can view in-effect and previous changes. 
The value changes are highlighted.

To view the change history of clauses
On the AGREEMENT DATA pane, click Agreement Clauses.
In the Clauses In Effect section in the Change History column, click the View hyperlink. 
This opens a <clause name> Version History popup. You can view different versions of 
the clause on the left pane and the clause text on the right.

Turn on Show Changes to view changes in clause text.
Select a different version of the clause on the left pane to view the clause text of that 
version.

Note

The View hyperlink is displayed only if the field was updated while amending the 
agreement.



Note

The View hyperlink is displayed only if the clause was updated while 
amending the agreement.
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To view and email in-effect documents
Prerequisite: Content Delivery must be enabled.

On the AGREEMENT DATA pane, click Documents. 
This displays the Documents In Effect section.
Select the required documents and click the email icon ( ). 
This displays the Generating Downloadable Link(s). After processing, the Send an 
Email page opens.
Enter the required details and click Send. 
An email notification is sent to all the recipients with the download link and 
password. For more information on downloading agreement documents, see Emailing 
Multiple Agreement Documents and Scheduling Expiration Date for Email 
Downloadable Link. 

Viewing Agreement Hierarchy of an Account
You can click the Agreement Hierarchy button on the Account Detail page to view all the 
agreements of that account. The agreement hierarchy page displays a hierarchical list of 
agreements related to the current account. The current account refers to the account for 
which you are viewing the agreement hierarchy. Hierarchical relationships to the current 
account include parent agreements, child agreements, related agreements, amended 
agreements, and renewed agreements. Renewed and amended agreements are displayed 
as child cards in the agreement hierarchy.

The fields displayed on the account card (first card) are according to the value set for the 
APTS_AccountHierarchyFields admin object. The fields displayed on the agreement cards 
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are based on the APTS_AgreementHierarchyFields admin object. For more information, 
see Admin Entries. 

Prerequisite
You must configure the Agreement Hierarchy button. For more information, see Adding 
Agreement Hierarchy Button for Accounts.

To view agreement details and related agreements
Navigate to the Accounts tab.
Click an account name.
Click Agreement Hierarchy.
Hover over an account card and click  . Select either of the following options: 

Select View Record from the menu to view the details of the agreement. The 
Agreement Detail page of the selected agreement opens in a new tab.
Select Show Related Agreements from the menu. A window containing Child 
Agreements and Related Agreement opens. 

To view child agreements
If an agreement has child agreements, you can view   before the account card.
Click   to view the child agreements of the agreement.
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Clause Versioning
Clause versioning allows you to view all the versions of a clause along with the modified 
text. You can view the number of times the clause is revised in the version number column of 
the Agreement Clauses section. Each clause has a single entry with the revised number. 

Prerequisite
To access this feature you need to install Contract Management dependent packages— 
DocuSign API (v5.88), Contract DocuSign Integration (v3.38), and EchoSign Integration 
(v7.30).

To view versions of a clause
Navigate to the Agreement Detail page
In the Master Agreement Clauses section, click the number hyperlink in the No. of 
Versions column. 
This opens a <clause name> Version History popup. You can view different versions of 
the clause on the left pane and the clause text on the right.
Turn on Show Changes to view changes in clause text.
Select a different version of the clause on the left pane to view the clause text of that 
version.

A clause status is updated based on the agreement action. The following are the 
agreement actions and their corresponding clause statuses.

Agreement Action Clause Status

Generate or Regenerate Original

Store Executed Agreement, Upload Signed Document, or 
eSign

Final

Create Offline Agreement or Import Offline Document Inserted

A smart clause is modified and checked-in from X-Author 
Contracts

Modified

The Show Changes toggle is not enabled for the first version of the clause.
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Agreement Action Clause Status

A smart clause is deleted and checked-in from X-Author 
Contracts

Deleted

A main clause is replaced with an alternate clause in 
OCC

Swapped

Checking in from X-Author Contracts as Final to be signed No status change

Uploading Signed Documents
You can upload the manually signed document to an agreement in DOC, DOCX, or PDF 
format.

Prerequisite
You can view the Upload Signed Document button after you send a document for 
signatures (manual or wet signatures). 
The Intelligent Import for Signed Document Comply System Property must be 
enabled to view the intelligent import option and intelligently import signed 
documents. The Intelligent Import settings must be configured in your org. For more 
information, see Comply System Properties and Configuring Intelligent Import 
Settings. 

Restriction
You can only upload one signed document when you select the intelligent import option.

To upload signed documents
In the Agreement Action Panel, click Upload Signed Document.
Click the Use Intelligent Discovery toggle button to perform the 
intelligent discovery or leave the toggle button as is to import the document without 
intelligent discovery.
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You can either click Upload Files or drag and drop your files. If you had turned on the 
Use Intelligent Discovery toggle button, you can upload only one document. 
This displays the Upload Files popup. 
After the upload completes, click Done. 
A list of files uploaded is displayed. You can also add comments for each uploaded 
file.

Click Import. 
You are navigated to the Agreement Detail page.

For documents imported without intelligent discovery, the Status Category | Status of the 
Agreement is updated to In Signature | Fully Signed. The Executed Date field is 
updated. When you upload a signed document without intelligent discovery, all the clauses 
are marked as Final in the Agreement Clauses section.

For documents imported with intelligent discovery, the Status Category | Status of the 
Agreement is updated to Import | Review. The Review Offline Document button is enabled 
and you can review the intelligently imported document. The fully signed documents are 
added as a major version with the name - Upload Signed Document in the Document 
Version related list. In the version aware agreements, the Document Type of the uploaded 
executed documents is updated as an Executed Document. When you upload a signed 
document using intelligent discovery, all the clauses recognized by the IDE are marked as 
Final in the Agreement Clauses section. If the APTS_AsyncMergeEmail admin entry is set to 
true, you will receive an email notification after the signed document is uploaded. For more 
information, see Admin Entries.

Merging Documents in Lightning
This feature allows you to combine the latest versions of different agreement documents 
along with the documents uploaded to the version aware agreement in Salesforce 

When the Intelligent Import for Signed Document comply system property is 
enabled, the Use Intelligent Discovery is turned on by default.



If you upload a single file, you can turn on the Use Intelligent Discovery toggle 
button and the uploaded document is intelligently imported. If you upload 
multiple files, you cannot turn on the Use Intelligent Discovery toggle button. 
If you send multiple documents for signatures, you need to upload all the 
signed documents together. If you send multiple documents for signatures and 
upload only one document, the uploaded document is considered as the final 
document. 
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Lightning. You can merge the documents in different formats (DOCX, DOC, and PDF 
formats) into one DOCX or PDF document. 

You can set the following preconditions before generating the merged document:

Document type
Document permission
Watermark
Redlines
Order of the documents 

If all the documents you are merging are in DOC or DOCX format, you can select the output 
format (DOCX or PDF). If the documents you are merging contains at least one PDF, the PDF 
output format is selected by default and the DOCX output format is disabled.

If you have selected DOCX as the output format, you can select any protection type. The 
protection type is only applicable to DOCX documents.

If a DOCX document contains the draft watermark among the DOCX documents you need 
to merge and you select the Remove Draft Watermark option, the merged document will 
not retain the watermark from the original document. The Remove and Apply Draft 
Watermark option is only applicable to DOCX documents but not for PDF documents.

If you have redlines in the documents you need to merge, you can use the Preserve Redlines 
option to retain the redlines in the merged documents.

You can select any document type except for the Executed Document. By default, the 
Agreement Document option is selected.

Prerequisites
You need to set up new agreement protection for merge documents. For more 
information, see the topic Configuring Agreement Document Protection.
You can merge the documents in DOC, DOCX, and PDF format in version-aware 
agreements.
Ensure that you have at least two different documents (documents generated using 
different templates) available in your agreement.
You can use the APTS_AppendVersionNumberToMergedDocs admin entry to suffix the 
name of the merged documents with a version number. For more information, see 
 Admin Entries.
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Restrictions
The Merge button is disabled if the agreement is in the following Status | Status 
Category:

In Signatures | Other Party Signature
In Signatures | Fully Signed
In Effect | Activated

The Document Permission field is not visible when you select PDF as the output 
format.

Limitations
The merge document name must not exceed 250 characters.
The document size of the combined documents must not exceed 25 MB.

To merge documents
On the Agreement Detail page, click Merge Documents. This displays the Merge 
Documents page.
Enter a name for the merged document in the Document Name field.
Select DOCX or PDF as the merged document output type.
Select Retain Header and Footer to retain the header and footer of the original 
documents in the merged documents.  
(Or) 
Select Custom Header and Footer to see Header and Footer fields and add custom 
header and footer.

Select a document type for the merged document.
Select document permission for the merged document.

When you neither select Retain Header and Footer nor Custom Header and 
Footer, the header and footer are removed in the merged document. When the 
APTSKeepSectionBreak admin entry is set to false and you select Retain 
Header and Footer, the documents will be merged together retaining the 
header and footer of the first document without keeping any section break.
When the APTS_DefaultHeaderFooterOptionForMerge admin entry is 
configured, you can see either the Retain Header and Footer or Custom Header 
and Footer checkbox selected by default. For more information, see Admin 
Entries.
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Select a watermark option per your requirement either to apply or remove watermark 
in the merged document.
Select the Preserve Redlines checkbox to retain the redlines in the merged document.
Drag and rearrange the documents in the order you need to merge documents.
Select the documents that you need to merge.
Click the Merge button on the top of the page.  
You are navigated to the Agreement Detail page.
Navigate to the Related tab.
In the Document Versions section, click the Merge Documents hyperlink. This displays 
the Document Versions Detail page.
Click the View hyperlink.  
If you had selected DOCX as the output format, then a new tab and the merged 
document is downloaded to your system. If you had selected PDF as the output 
format, then the document opens in the document viewer online. 
The merged document is now available when you send for review, send for eSignature 
using EchoSign, send for manual signature, and activate an agreement.

Importing Supporting Documents
You can import supporting documents in a version aware agreement. You can also select 
Document Type while importing the supporting document. The Import Supporting Document 
option is available irrespective of the agreement status and status category.

To import supporting documents 
In the Agreement Action Panel, click Import Supporting Document. 
This displays the Import Supporting Document page.
You can either click Upload Files or drag and drop your files.  
This displays the Upload Files popup. 
After the upload completes, click Done. 
A list of files uploaded is displayed. You can add comments for each uploaded file. 
You can also change the Document Type to Other or custom. The default Document 
Type is set to Supporting Document.
Click Import. 
After the import completes, you are navigated to the Agreement Detail page. 
You will receive an email after the documents are imported. The imported documents 
are added as a major version with the name as Supporting Document in the 
Document Version related list. 
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Using Smart Search to Search Content in 
Agreement Documents in Lightning
The Smart Search feature allows you to search for information without the need to 
understand the working of CLM. This feature allows you to find information of any record 
regardless of where the information is stored. Smart Search supports natural language 
search. This means you can search for information in CLM using everyday language. The 
search returns a list of agreement documents that match all your search queries.

You can configure a quick search box on the Home page to initiate your search on the Home 
page without the need to navigate to the Smart Search tab. For more information, see 
Setting Up Quick Search on the Home Page. 

You can use Smart Search in MS Teams, Slack, or Webchat similar to a chatbot.

The Smart Search feature allows you to:

Search information using keywords, queries, semantic, and natural language.
Configure the fields that you can see on the search grid.
View the content snippet that contains the search query.
Preview the document.
Open the document in PDF viewer.
Download the document.
Email the search results.
Apply filters and conditions to narrow down the search results.
Use search operators (AND, OR). 
Save, edit, and delete search queries and make them private or available to the other 
users in your org.

You can perform the following types of search:

Search Type Description Example

Keywords Search with objects within the 
scope

Object name: Agreement 
Name
Name of the document: 
"MSA with Conga"
Clause name: Terms and 
Conditions
Account name: ABC 
corporation
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Search Type Description Example

Search operators Search with search operators 
(AND, OR). You can specify a 
main object as well as a related 
object.

Agreement Start Date 
greater than “1/1/2021” 
AND Agreement End Date 
less than “31/1/2021”
Account equals “ABC 
Corporation” AND Status 
Category equals “Import” 
AND Status equals 
“Review”
Record Type equals “MSA” 
AND Region equals “North 
America” OR Region 
equals “Europe”

Search operator + Keyword  Search with search operators 
and keywords 

Agreement Start Date greater 
than “1/1/2021” AND Agreement 
End Date less than “31/1/2021” + 
Keyword “Force Majeure”

Context-Driven or scope  Narrow down query scope with 
specific inputs 

Agreement Start Date greater 
than “1/1/2021” AND Record Type 
= MSA AND (Account Type 
equals “Customer” OR Account 
Industry equals “Manufacturing”

Natural language   Search in everyday language 
using a main object

Pull up agreements with a 
start date greater than 
1st of January 2021
Pull up agreements over 
100K
Pull up agreements that 
are net due
Contracts with payment 
term net 30

Natural language with 
nested

Search in everyday language 
using a main object and related 
object

Pull up the service clauses for 
agreements over $20k
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Search Type Description Example

Natural language with 
nested and Keywords

Search in everyday language 
using a main object, related 
object, documents, and clause 
text 

Find all agreements over 100K 
which have a Force Majeure 
mentioned in them.

Natural language with 
nested, keywords, and 
boolean expressions

Search in everyday language 
using a main object, related 
object, documents, and clause 
text along with boolean 
expressions 

Find all agreements over 
100K which contains both 
Force Majeure and 
Limitation of Liability.
Find all agreements over 
100K which contains Force 
Majeure and Limitation of 
Liability and 
Indemnification
Find all agreements of 
type MSA over 100K which 
contains both Force 
Majeure and Limitation of 
Liability
Find all agreements over 
100K which contains Force 
Majeure and not Audit 
Rights

Natural language nested, 
keywords, and synonyms

Search in everyday language 
using a main object, related 
object, documents, and clause 
text along with synonyms 

Pull up agreements over 
100K which have the 
mention Act of God
Pull up agreements over 
100K which have the 
mention "Act of God“

Natural language nested, 
keywords, synonyms, and 
boolean expressions

Search in everyday language 
using a main object, related 
object, documents, and clause 
text along with synonyms and 
boolean expressions 

Pull up agreements over 100K 
which contain an Act of God but 
not Indemnification
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Search Type Description Example

Natural language nested, 
keywords, synonyms, 
boolean expressions, and 
scope 

Search in everyday language 
using a main object, related 
object, documents, and clause 
text along with Boolean 
Expressions and scope 

Find all agreements of type MSA 
over 100K which mentions both 
Act of God and Limitation of 
Liability

Basic semantic  Search with keywords along 
with context 

Pull up top 3 agreements from 
last year

Prerequisite
Ensure that you have generated the registration setting to use the smart search feature. 
For more information, see Generating Registration Setting.

Limitations
Email and export options do not work when you search using search operators.
You cannot click the remove icon ( ) for the queries displayed below the search bar.

To search content in agreement documents
Navigate to the Smart Search tab.

Enter a keyword, phrase, or text (natural language) in the search box and press Enter. 
A list of search results is displayed in rows. You can view the number of search results 
below the search box. You can sort the columns alphabetically by clicking the sort 
icons (  or ) on the column headers. You can also expand the column size by 
dragging the column border.
Click the expand icon ( ) to view the content snippet that contains the search query. 
In the content snippet, the first occurrence of the search text is highlighted.

If you have configured the quick search box on the Home page, you can initiate 
the search with a keyword or a query in natural language. When you press 
Enter, you are navigated to the Smart Search tab and you can view your 
query results. 
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iii.

Click a result row to preview the document in the right panel. 

To open the document, click the Open in PDF Viewer hyperlink. 
The document opens in the Conga-provided PDF viewer.

Click the download icon ( ) to download the document.
Click the document name to download the original document associated with the 
record.
Click Close to close the PDF viewer and return to the search results page.
From the header icons, you can perform the following tasks:

Email the search results:
Click the email icon ( ) to share the search results with other users 
through email. 
The Share Search Results popup is displayed.
Enter the following details:

From the Share selected items in the format of dropdown, select 
HTML, Excel (.csv), Excel (.xlsx), or PDF format.
From: Select an email address.
To: Add email addresses of the recipients.
Click CC beside the To field to add CC recipients.
(Optional) Subject: According to your search, the subject is already 
added. You can also edit and customize according to your 
requirement. 
The body of the content contains the search results.
Select HTML, Excel (.csv), Excel (.xlsx), or PDF format according to 
your requirement.

Click Share.

If you search with multiple keywords, all the keywords are highlighted in the 
snippet and you can also view the page number in which the keyword is found. 
If there is no text found matching in a document, the snippet is not displayed.



The preview is not available for documents that are stored in the agreement 
document. To open the document, click PDF Viewer.



If there is a problem in loading the preview screen, an error message is 
displayed. You can click PDF Viewer in the error message to open the 
document in PDF viewer.
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Export the search results:
Click the export icon ( ) to export the search results. 
The Export Selected Files popup is displayed.
Select PDF or XLS according to your requirement.
Enter a file name and click Export.

Configure the search result columns:
Click the settings icon ( ) to configure the fields that must be displayed 
as columns to search results. 
The Select Fields to Display popup is displayed. In the Available Fields 
column, you can see object names. when you select an object, you can see 
primary and secondary-level fields in an object. In the Visible Fields 
column, you can see the fields visible on the search grid. 
Default fields in the Visible Fields column are highlighted in yellow and 
cannot be moved. When you select a field to move, the field is highlighted 
in blue.
In the search bar, type an exact field name to search for a field.
Drag and drop fields from Available Fields to Visible Fields or change the 
position of a field.
To add a new field to the search results, select a field from the Available 
Fields and click the  icon to move the field to Visible Fields.
To remove a field from the search results, select a field from the Visible 
Fields and click the  icon to move the field to Available Fields.
To reorder the fields that must be displayed to search results, click  or 

. You can also drag and drop fields to rearrange the fields.
Click Save. 
The field configuration is automatically applied to future searches.

You can navigate to the Agreement Detail page by clicking the 
agreement name hyperlink in the exported document. You can use 
the org-wide email address while sending an email. For more 
information, see Setting Up Organization-Wide Email Address. You 
can share multiple documents displayed in the search result as a 
downloadable link with a Salesforce Contact or any recipient. For 
more information, see Emailing Multiple Agreement Documents. 



When your search query includes a field that is not configured as a 
search result column, the field included in the search query is 
displayed as a search result column.
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Close the preview panel:
Click the preview icon ( ) to close the document preview.

Click the Agreement Name hyperlink to navigate to the Agreement Detail page.

To apply filters to search results
Click the filter icon ( ) to apply filters to your search results. 
The filter popup is displayed.
Select a Primary Object from the dropdown.
From the Take Action When section, you can select one of the following options:

Option Description

All conditions 
are met 

If one of the conditions is false, the flow evaluates the next outcome’s 
conditions.    

Any condition 
is met    

If one of the conditions is true, the flow immediately takes this outcome’s 
path.

Custom     When you select this option, you can enter the condition logic by entering 
up to 1000 characters in the Custom Logic field. You can use:

Numbers to refer to each condition
AND or OR to identify which combination of conditions must 
true
Parentheses to group parts of the string together

Sample expression: ((1 AND 2 AND 3) OR 4)

Click Add Filters to add additional filters.
Select a field and an operator from the respective dropdowns.
Enter a value for the field.
Click Add Related Objects to add related objects.
You can add conditions and filters similar to the primary objects.
Click Apply. 
You can view the applied search filters below the search box.

To save a search query
Click Save Search. 
The Save Search popup is displayed.
Enter a search name, description, and select the visibility option.
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Click Save.

To use a saved search
Click the  icon to view the saved searches.
Select a saved search. 
The search results are displayed.

To edit a saved search
Click the  icon to view the saved searches.
Click Edit. 
The Edit Saved Search popup is displayed.
Click the edit icon ( ).
Update the required details and click Update.

To delete a saved search
Click the  icon to view the saved searches.
Click Edit. 
The Edit Saved Search popup is displayed.
Click the delete icon ( ). 
The saved search is deleted.
Click Save.

To use smart search as a chatbot
Prerequisite: To configure smart search in MS Teams, Slack, or Webchat, write to 
SmartSearch-Onboarding@conga.com. You will receive a configuration link email from the 
Conga Support team.

Click the link received from the Conga Support team.
Login to salesforce.

If you select Private as the visibility option, only you can see the saved search. 
If you select Public as the visibility option, all the users in your org can view the 
saved search.



mailto:SmartSearch-Onboarding@conga.com
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Enter your query in MS Teams, Slack, or Webchat. 
Sample query: Pull up agreements that contain Force Majeure, Term, Rights, and 
Affiliate. 

You can sort the results and view more details.
Enter show me snippet for #<number> to see the snippet of a search result. 
Sample: show me snippet for #5.
Click Send it to me to share the snippet as an email.
Verify the email id and click Yes! Go ahead to send the email.
(Optional) Click Change recipient to change the email address of the recipient.

Working with Documents
In the Documents tab, you can view all documents available in the agreement. When an 
agreement is version-aware, you can view the latest version of a document and click the 
expand icon to view older versions. You can also delete a document or multiple documents 
based on the user or profile permission. You can configure the columns that are visible on 
the Documents tab.

The following screenshot shows the Documents tab.
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Prerequisite
The Documents tab must be configured by your administrator to view the Documents tab. 
For more information, see Configuring Documents Tab in Lightning. 

To delete a document
Select one or multiple documents to enable the Delete button.

Click Delete.

To configure the columns 
Click the settings icon ( ) to configure the fields to view the Select Fields to Display 
popup. 
To add a new column, select a field from the Available Fields and click the   icon to 
move the field to Visible Fields.
To remove a column, select a field from the Visible Fields and click the   icon to move 
the field to Available Fields.
To reorder the columns, click   or  . 
Click Save.

Contract Document Versioning
Contract Document Versioning enhances existing version control by introducing a solution 
framework of document versioning at the Agreement record level. Without Contract 
Document Versioning, all agreement documents are included in the Notes & Attachments 
related list, requiring that the agreement owner or other parties determine the proper 
document version or versions for review, signature, finalization and activation. Document 
Versioning adds two new child objects with relationships to the Agreement object: Document 
Version (child object to Agreement) and Document Version Detail (child object to Document 
Version).

When an agreement is version-aware, you can select only the latest version of 
a document. When you delete the latest version of a document, all the 
versions of that document are deleted.
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When Document Versioning is enabled for your organization, not every document is 
attached to an agreement's Notes & Attachments Related List. Instead, each major version 
of a document is populated in the Document Versions Related list, with individual version 
information tracked using Document Version Details.

Restriction
Contract document versioning is not supported for the documents uploaded with 
Intelligent Import.
Clause versioning is not supported for wet signatures.

About Document Versions Concepts
Contract Document Versioning divides the version of an Agreement document into three 
parts: Major, Minor and Revision. Each version of an agreement document is represented as 
a period-delimited numeric value in the Document Version Details object (e.g., "1.0.0"). As 
different users perform various actions on the document, version values are numerically 
incremented. The following table describes each version type represented by the version 
value and how it is created.

To take advantage of the full functionality of Contract Document Versioning, your 
organization should also be using X-Author for Contracts.
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Version Type Document Action User Role Example 
Value

Major A major version type is created 
every time a user:

Generates a document.
Regenerates a document.
Creates an Offline 
document.
Imports an Offline 
document.
Generates a supporting 
document.
Checks in a Clean 
document or a document 
without Redlines.
Checks in a document as 
Final.

A MAJOR version can be either a 
new document instance or an 
incremented version of a pre- 
existing document. For further 
explanation, see New Document 
Versus Incremented Version.

Contract Requestor / 
Owner

1.0.0

2.0.0

3.0.0

Minor (Negotiator) A minor version is created every 
time a Negotiator makes changes 
to the document and checks it in 
using X-Author for Contracts with 
the following exceptions:

The Negotiator checks in 
the document as Clean or 
Final (creates a MAJOR 
version).
The Negotiator checks in a 
document on behalf of a 
Reviewer (creates a 
REVISION–see below).

Negotiator 1.1.0

2.1.0

1.2.0
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Version Type Document Action User Role Example 
Value

Revision (Reviewer) A revision is created every time a 
document is returned by a 
reviewer to the Negotiator. The 
document is either returned by the 
reviewer as an email attachment 
and checked in using the X-Author 
Contracts for Outlook plug-in, or 
checked in on their behalf by the 
Negotiator (for both internal and 
external reviewers) using X-Author 
Contracts for Word. For more 
information on Send for Review 
using X-Author, see the X-Author 
Contracts documentation .

Reviewer 1.0.1

2.0.2

 

New Document versus Incremented Version
To understand versioning, it is important to recognize the difference between a MAJOR 
 document (a new Document Versions record) and a new MAJOR document version (a new 
Document Version details record). For generated documents, template use defines the 
document being versioned–that is, when a document is generated or regenerated using a 
different template, a new MAJOR document is created. Likewise, when an offline document 
is created or imported, a UUID (Universally Unique Identifier) is assigned to that document. 
Each newly created or imported offline document is a new MAJOR document.

Alternatively, when an agreement document is Regenerated using the same template, a 
new MAJOR document version is created, meaning the MAJOR value of the document is 
incremented (e.g., 1.0.0 to 2.0.0) instead of a new document instance/record being created. 
The same is true when a generated or offline agreement is checked in as final, or when a 
document is checked in as clean (without redlines). The following example of the Document 
Versions related list shows 3 documents: generated from a template, imported from offline, 
regenerated from a different template. Each is a new MAJOR document (with its own 
versions).

https://documentation.conga.com/x-author-for-contracts/latest/x-author-for-contracts-154927679.html
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Viewing Document Versions on an Agreement 
Record
You can view a snapshot of each agreement document on the Document Versions Related 
List on the Agreement record. Each Document Versions record allows you to drill down into 
Document Version Details, which contains information and the drafts of each individual 
version of the agreement document up to its current stage in the lifecycle. The Document 
Versions Related list displays information for the primary agreement document and an 
imported offline agreement.

Click on the link under Name to View all document version details for the chosen 
agreement document.
Click on the link under Template to View Template record details.
Click on the link under Latest Version Detail to View document version details for 
the latest version of the agreement document.

Viewing Document Version Details
You can use Document Version Details to view all versions of a specific agreement 
document. Versions in the table are listed in ascending order from oldest to newest version 
and break down each version value as Major, Minor or Revision. You can also see the action 
taken to create a specific version of the Agreement document. In the example below, the 

Note

The name of each entry under Document Versions is based on the naming 
convention for Document Versions decided by your administrator. For more 
information, see Enabling Contract Document Versioning.
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user has drilled down into the Document Version Details for the primary agreement 
document (click on the image to enlarge the view).

In this example, the following actions created the listed document versions:

The agreement requestor Generated the original version (version 1.0.0).
The negotiator Checked Out the generated version (remember, this does not create a 
version) and Checked In a new version after some changes (version 1.1.0).
The negotiator Checked Out the checked-in version, made additional changes, 
and Checked In a new version (version 1.2.0).
The contract owner Regenerated the agreement document (version 2.0.0).

To Download a Specific Version of the Agreement 
Document
Click the View link in the appropriate row. The agreement document is downloaded to your 
local drive.

Checking in the Final Version
When the contract owner or negotiator checks in the final version of an agreement 
document using X-Author and selects "Create PDF attachment," two actions occur on the 
Agreement record:

A MAJOR version of the agreement is added to Document Version details for that 
document.
The FINAL PDF agreement document version is added to the Notes & Attachments 
related list.

The final version of the agreement document and any additional final documents can be 
Sent for Review or Sent for Signatures.



CLM

710 Copyright ©2022 Apttus Corporation. All rights reserved.
 

1.
2.
3.

Document Versions and Template Versioning
If your org has Template Versioning enabled, you can also view the version of the Template 
used to generate the document.

To view the template version used to generate the document:

Go to the Agreement Record.
Under Document Versions, click on the Document Versions Name.
Under Document Version Details, click on the version link (e.g., "1.0.0"). The Template 
version is displayed in the Template Version field. 
 

Searching and Viewing Version-Aware Documents
The contract negotiation process for agreements often involves multiple iterations of 
agreement documents for a particular record: primary agreement documents, third-party 
paper, addendums and schedules and any number of other versioned documents. As a 

The Template Version field must be added to the Document Version Detail layout in 
order to view template version information. Follow the standard Salesforce process 
for adding fields to the layout.
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result, it can sometimes be difficult task to find the right document to work with. Document 
Finder extends Contract Document Versioning by providing a Visualforce page on the 
Agreement record to permit Contract Management users to use filters and tags to quickly 
search for and view version-aware agreement documents. 

Use Document Finder to search for version-aware agreement documents by:

Document name
Keywords/tags defined at document check-in
All Versions or the Most Recent Version
Document State: All, Final, Draft, Clean or Redlines (Negotiator or Reviewer version)
Document Owner: All or specific user name

Prerequisites
Before you can use the full features of Document Finder, the following prerequisites must be 
satisfied:

Contract Document Versioning must be enabled.
Document Finder must be added to the Agreement record layout and the Document 
Finder Visualforce Page must be added to user profiles.
One or more version-aware agreement documents must be attached to the record.

Using Document Finder
To begin using Document Finder, open an agreement record with one or more version-aware 
documents and scroll to the section containing Document Finder.

By default, all version-aware documents you have access to are listed in Document Finder.

Note

Refer to the table in the following section for guidance on which filters are available 
only with version-aware documents.
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Searching for Documents by Document Name or 
Keywords
To search for documents by document name or keywords/tags:

Enter a name or keyword into the Document Finder search box. (Note: If there a 
predefined tags set by the Default Document Tags property, or from previous check- 
ins of other agreement documents, they will be displayed in a drop-down). 
 

 

 
Press Enter or type a comma (,) at the end of each name or tag you enter. You can 
enter any number of values. The list of documents updates as you enter each tag. 
 

 

 

 After you enter a name or a tag, click on the 'X' in the tag ( ) to remove it from 
your search. This updates the document list to reflect only the current keywords/tags.
Click View next to any document to download it.

Note: When you enter multiple keywords/tags they are interpreted by Document 
Finder as being joined by the AND operator.
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Refine Your Search
If necessary, you can refine your search in Document Finder by adding additional filters to 
your search. Consult the following table for a list of these filters and how to define 
them. Some filters are only available for Version-Aware records.

Document Filter Version-Aware 
Required

Description

Version Yes Choose from All Versions to list all versions of 
all agreement documents which match the 
current search configuration, or Most Recent 
Version to constrain the current list to only 
the most recent versions.

Document State Yes Choose the Document State to list only 
document versions matching the selected 
Document State for the current configuration: 
All Document States, Final, Clean, Draft, or 
Redlines.

Document Owner (User) No Choose a User type from the drop-down menu 
and use the lookup to search for and choose 
a user to constrain the list of documents to 
only documents owned by the chosen user. 
You can also directly type the name of the 
user and click outside the provided field.

Contract Wizard in Classic
Use the Contract Management Contract Wizard to run custom, user-friendly Wizards 
based on any standard or custom Salesforce object (Agreements, Accounts, Proposals, 
Leads, etc.). These Wizards are intended to be used by sales representatives, purchasing 
agents, HR managers, and other users to quickly create their own records by entering 
responses to criteria-based inputs that follow a logical series of steps. Wizards can also be 
used to collect data from customers to be posted to internal systems or for other business 
use. 
Use the Wizards tab to run Wizards from the existing Wizard Designs. You can easily search 
and select from Wizard designs to create well-formed records. Wizards also contain a 
feature that allows users to review their responses prior to submission, returning to previous 



CLM

714 Copyright ©2022 Apttus Corporation. All rights reserved.
 

1.
2.

steps to make changes or corrections. Users can also use the tab to resume completion of 
in-progress Wizards or review completed or aborted Wizards.

For information on creating Wizards using the Wizard Designer, see Contract Wizard.

Using the Wizards Tab
You can take several actions from the Wizards tab in addition to creating and running new 
Wizards:

To search for Wizards
Perform a type-ahead Search to locate an In Progress, Submitted or Aborted Wizard in the 
table.

To continue an In Progress Wizard
Pick up where you left off to complete an In Progress Wizard.

Navigate to the Wizard using the type-ahead feature or page navigation.
Click Continue under the Action column. The Wizard opens in a new tab at the current 
step.
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To review a completed Wizard
You can revisit the Review page for a Submitted or Aborted Wizard once it is complete.

Navigate to the Wizard using the type-ahead feature or page navigation
Click Review under the Action column. The Wizard opens in a new tab and displays 
the Review page (you can no longer edit any steps).

Running a Wizard
You can use the Wizards tab to run Wizards from the existing Wizard Designs. 

Note

If "No Action" is available for a Wizard in the list, it means that the Wizard design 
associated with the runtime Wizard has been retired by your administrator. You 
can neither initiate nor continue Wizards that are associated with retired designs.
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To run a Wizard
From the Salesforce application menu, choose Apttus Contract Wizard. The 
application displays the Home tab and the Wizards tab (you will see additional tabs 
if you have permissions to create Wizards). 
 

 

 
Choose a Wizard to run from the drop-down list of designs and click Go. Note: 
Wizards associated with deactivated or retired Wizard designs will not be available 
in this list. 
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(Optional) Click the pencil icon in the banner to give your Wizard a unique name, so 
you can differentiate it from other Wizards you run using the same Wizard design.  
 

 
 
The new name for your Wizard is shown in the list of In Progress and Submitted 
Wizards on the Wizards tab. 
 

 

 
Move through the steps of the Wizard, choosing values for the fields in each step. Click 
Next when you are finished with a step to move to the next step. Click Back to return 
to the previous step. Click Save to save the data on the current wizard page.

Ensure that you have not blocked pop-ups in your browser because new 
Wizards are always launched in a separate tab.
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5.

 

 
When you choose options (or a combination of options) that result in the creation of 
an object record, the Object name or Record Type will be displayed immediately upon 
choosing the option(s). For example, in the following step, when you choose "Sales 
Contract" as the business activity and "Create" as the transaction type, the Wizard 
evaluates a condition that determines that an Agreement record will be created 
when the Wizard is submitted. 
 

 

 
Some Wizard steps may include the option to add comments and/or attachments in 
addition to providing traditional responses. You can add comments in the text area 

Note

You must fill in all the required fields on the current wizard page before 
clicking Save; otherwise, the Wizard will throw a validation error.
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a.

b.

c.

6.

provided (500 character limit), click Attach Files to attach files to the Wizard step. 
When you use the Wizard to create a record, the attached files are added to the 
Notes & Attachments Related List of the new record along with the recorded 
comments. To add an attachment:

Click the Attachment(s) link below the Comments box. The Manage 
Attachments window is displayed.
Click Add Files. Browse for a file on your machine and add it as an attachment. 
The attachment uploads to the Wizard and displays in the Manage 
Attachments window.
Repeat the previous step for each attachment you want to add. Close the 
window when you are finished adding attachments.

 
 

 
Click Add Item when there is a repeatable field in the Wizard. These fields are used 
when you need to enter multiple values as certain responses—for example when you 
are adding multiple business addresses, or product line items and prices to a Sales 
Contract, as shown in the example below. 
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7.

8.

9.

 
Closing the Wizard automatically saves your progress in the Wizard up to the current 
step. You can continue where you left off from the Wizards tab (see Using the Wizards 
Tab).
When you have answered the final question in the Wizard and clicked Next, the page 
will display a Review of all steps you have completed. 
 

 

 
Click Edit to change your answers for any steps in the Wizard. A dialog warns that 
you may have to repeat steps of the Wizard that you previously completed 
depending on edits you make. 
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11.

•

•

•
•

12.

 
Click OK to edit the step or Cancel to return to the Review page.
When you are satisfied with your responses, click Submit.  
Depending on the design of the Wizard, one or more of the following will occur:

A record of the type determined by your inputs within the Wizard will be created 
(e.g., a Sales Agreement record).
You will be redirected to the record details page of the record just created by 
the Wizard.
You will be redirected to another page in Salesforce. 
You will remain on the Review page and the Wizard will be shown as 
 Submitted (in this case data from the Wizard has been submitted for purposes 
other than creating a record). 
 

 

 
Return to the Wizards tab. The Wizard you created and executed now shows 
its Status as Submitted in the list of Wizards. 
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Tracking Wizard Activity
When a Wizard results in the creation of an Object record (such as an Agreement), a note is 
automatically added to the Notes & Attachments Related List of the created record 
identifying which Wizard originated the record.

For example, an Agreement record has been created from a Wizard.

To track wizard activity from a record
From the Agreement record page, scroll to Notes & Attachments. 
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2.

•
•
•
•

1.

2.
•

Click on the Note Title to view Note details. 
 

In the Body description, note the Wizard name that created the record. 

Accessing the Preview Sidebar
To provide more flexibility when running Wizards, a Wizard user can access the Preview 
Sidebar, which tracks the Wizard as steps are completed. The Wizard user can use the 
Preview Sidebar to navigate to other steps in the Wizard freely. Use the Preview Sidebar to:

Preview a future step in the Wizard.
Track overall completion progress.
Return to a previous step in the Wizard to complete responses or correct a mistake.
View a full preview of all completed responses.

Using the Preview Sidebar
Launch a new Wizard from the Wizards tab. The runtime Wizard is displayed with the 
Preview Sidebar in collapsed view.
Click the sidebar to expand it. You will see one of two possible views: 

If you are running a linear, step-by-step Wizard with no conditionally-shown 
steps, you will be able to see and navigate to any step in the Wizard. 
 

Add the Notes & Attachments Related List to the record layout to view the Wizard 
notes.
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•

 

 
If the Wizard you are running contains any conditional steps, you will only see 
the current step and the "Preview" step. The preview sidebar will display 
additional steps as you complete the current step and conditions are satisfied 
to include the other steps in the Wizard. 
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4.

5.

•
•

1.

2.

 
Click any step in the preview sidebar to preview it. Important Note: if you attempt to 
view a future step but the current step contains any required fields, you cannot 
preview that step until you have completed the required fields in the current step.
Click Preview at any time to go to the Review screen where you can review all visible 
steps in the Wizard, including any completed responses. The Preview screen only 
reflects steps that are present in the sidebar. No conditional steps will be shown 
unless the conditions that trigger them are satisfied.
Click Back to return to the last step you worked with.

Use Case for Running Contract Wizard
This topic describes the use case for contract wizard.

This use case describes how a Sales Representative creates records based on any standard 
or custom Salesforce object (Agreements, Accounts, Proposals, Leads, etc.).

In this case, a Sales Representative can quickly create their own records by entering 
responses to criteria-based inputs that follow a logical series of steps.

Pre-requisite: Make sure you have the following:

New inputs are created
Steps are created 
 

To Run a Contract Wizard

To run a Contract Wizard, perform the following steps:

From the Salesforce application menu, choose Contract Wizard. The application 
displays the Home tab and the Wizards tab (you will see additional tabs if you have 
permissions to create Wizards). 
Choose a Wizard to run from the drop-down list of designs and click Go. 

This use case gives one example on how to run a contract wizard created by 
Administrator. You might use this functionality differently, depending on your 
business case.



Note

Wizards associated with deactivated or retired Wizard designs will not be 
available in this list. Ensure that you have not blocked pop-ups in your 
browser because new Wizards are always launched in a separate tab.
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4.

5.

(Optional) Click the pencil icon in the displayed banner to give your Wizard a unique 
name, so you can differentiate it from other Wizards you run using the same Wizard 
design.  
The new name for your Wizard is shown in the list of In Progress and Submitted 
Wizards on the Wizards tab.
Move through the steps of the Wizard, choosing values for the fields in each step. Click 
Next when you are finished with a step to move to the next step. Click Back to return 
to the previous step. Click Save to save the data on the current wizard page.

When you choose options (or a combination of options) that result in the creation of 
an object record, the Object name or Record Type will be displayed immediately upon 
choosing the option. For example, in the following step, when you choose Sales 
Contract as the business activity and Create as the transaction type, the Wizard 
evaluates a condition that determines that an Agreement record will be created 
when the Wizard is submitted. 
 

 

 
Some Wizard steps may include the option to add comments and/or attachments in 
addition to providing traditional responses. You can add comments in the text area 
provided (500 character limit), and/or click Attach Files to attach files to the Wizard 
step. When you use the Wizard to create a record, the attached files are added to the 

You must fill in all the required fields on the current wizard page before 
clicking Save; otherwise, the Wizard will throw validation error message.
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b.

c.

6.

7.

8.

9.

10.
11.

•

•

•
•

12.

Notes & Attachments Related List of the new record along with the recorded 
comments. To add an attachment:

Click the Attachment(s) link below the Comments box. The Manage 
Attachments window is displayed.
Click Add Files. Browse for a file on your machine and add it as an attachment. 
The attachment uploads to the Wizard and displays in the Manage 
Attachments window.
Repeat the previous step for each attachment you want to add. Close the 
window when you are finished adding attachments.

Click Add Item when there is a repeatable field in the Wizard. These fields are used 
when you need to enter multiple values as certain responses, for example when you 
are adding multiple business addresses, or product line items and prices to a Sales 
Contract. 
Closing the Wizard automatically saves your progress in the Wizard up to the current 
step. You can continue where you left off from the Wizards tab (see Using the Wizards 
Tab).
When you have answered the final question in the Wizard and clicked Next, the page 
will display a Review of all steps you have completed. 
Click Edit to change your answers for any steps in the Wizard. A dialog box warns 
that you may have to repeat steps of the Wizard that you previously completed 
depending on edits you make.
Click OK to edit the step or Cancel to return to the Review page.
When you are satisfied with your responses, click Submit.  
Depending on the design of the Wizard, one or more of the following will occur:

A record of the type determined by your inputs within the Wizard is created (e.g., 
a Sales Agreement record).
You are redirected to the record details page of the record just created by the 
Wizard.
You are redirected to another page in Salesforce.
You remain on the Review page and the Wizard shows as Submitted (in this 
case data from the Wizard has been submitted for purposes other than 
creating a record). 
 

Return to the Wizards tab. The Wizard you created and executed now shows 
its Status as Submitted in the list of Wizards.
Result: 
You have created and executed the wizard.
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Reports and Dashboards
Salesforce delivers standard report folders containing reports for each record type. For 
example, Accounts, Opportunities, Leads, and more. These reports are used as a starting 
point for your organization's reporting efforts. Salesforce allows all users to run, customize, 
and create reports. For more information on setting up and managing reports within 
Contract Management, see salesforce.com information related to creating and 
customizing reports. provides a set of out-of-the-box reports. You may create new reports 
or customize existing reports. To modify an existing report, run the report and click 
Customize. For more information, see Create a custom report.

Dashboards organize key statistics in an easily understood, bottom-line format, allowing 
you to gain the insight you need to fulfill your business needs. For more information, see 
 Working with Dashboards.

About Agreement Explorer Reports
Agreement Explorer is a powerful search and reporting feature that allows you to use 
configurable and reusable search reports to search for records in the Agreement object. 
This feature complements standard reporting views to satisfy the demands of many 
customers who require more powerful, specific search results and related exports to Excel 
to satisfy their business needs. Agreement Explorer expands your access to agreements by 
providing reusable searches with configurable fieldsets and filtered lists for multiple 
contexts associated with agreements. You can use these reports to discover and expose 
record lists for agreement searches, the hierarchies of agreements and accounts, and a 
combination of account hierarchies and the individual account’s related agreement 
hierarchies. Users can create published lists of available reports, which can then be 
complemented by users creating and saving their own public or private ad hoc reports. The 
resulting reports can be exported to Excel.

Understanding Agreement Explorer Report Types
The key to understanding how to create and use Agreement Explorer reports effectively is 
to understand the application types assigned to each report. When you create an 
Agreement Explorer report as an administrator, you are required to define the context 
(type). The type determines the list of records and hierarchy displayed in the results 
available to the user. There are three types available for reports:

http://salesforce.com/
https://help.salesforce.com/apex/HTViewHelpDoc?id=reports_builder_editing.htm
https://help.salesforce.com/HTViewHelpDoc?id=reports_custom.htm
https://help.salesforce.com/htviewhelpdoc?id=dashboard_builder_editing.htm
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2.

Report Type Report Location Description

Agreement Search Agreement Explorer Tab Returns a filtered list of agreement 
records. For example, return all the 
agreements filtered by Status 
Category and Status. These results do 
NOT display Agreement Hierarchy.

Agreement Agreement Record, 
Agreement Explorer Tab

Returns a filtered, hierarchical list of 
agreements with the current record 
highlighted. Records in this list 
represent a hierarchy of parent and 
child agreements with the current 
record as context.

Agreement Hierarchy by 
Account(s)

Agreement Record, Account 
Record, Agreement Explorer 
tab

Returns a filtered, hierarchical list of 
agreements associated with one or 
more chosen account records. Records 
in this list represent a hierarchy of 
parent and child agreements for all 
specified accounts.

Creating an Agreement Explorer Report

When you create a new Agreement Explorer report, you are creating a public or private 
report to generate a list of agreement records based on one of three contexts: Agreement 
Search, Agreement, or Agreement Hierarchy by Account(s). You use the same form to create 
new reports and edit existing reports. The following section provides instructions for 
creating your own Agreement Explorer reports. To create an ad hoc report from a report 
you have executed, see Managing Report Settings.

To create an agreement explorer report
Navigate to the Agreement Explorer tab.
Click the New Agreement Explorer button to create a new report or click the Edit link 
next to any report in the Saved Reports table to edit an existing report. The Report 

Hint: click on images on this page to enlarge the view.
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Edit page is displayed. 

To define Report Attributes
Use the first section of the Edit Report form to identify the attributes of your report, 
including report type. 

Consult the following table to define or edit the attributes for your Agreement Explorer 
report. Attribute fields in bold are required.

Attribute Description

Report Name Enter a short name for your report that will help you identify it. 
This name is displayed in the Saved Reports table on the main 
Agreement Explorer tab.

Owner Use the lookup field to search for a user to designate as the 
owner of this report. By default, the current user is the report 
owner. Only the report owner or an administrator can modify an 
existing report.
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Attribute Description

Label Enter a label which can be used to provide additional clarity for 
the report's intended use.

Type Use the drop-down menu to specify the context of your report: 
Agreement, Agreement Search or Agreement Hierarchy by 
Account(s). See Agreement Explorer Reports for an explanation 
of report contexts.

Description Enter a description for your report which provides guidance to 
users on using the report. The description is displayed in the 
Saved Reports table on the Agreement Explorer tab.

Make Public Click this checkbox to make your report publicly available to all 
users. Any users with access to Agreement Explorer will be able 
to run this report from the Agreement Explorer tab.

Set as Default Click this checkbox to make your report the Default report for 
the chosen report context. See Running Agreement Explorer 
Reports

To define Report Field Sets
Use the Fields section in the Edit Report form to define the fields (columns) displayed in the 
report and expand or limit the actions that can be taken from report results. When you edit, 
add or remove fields in this way, you are creating a new FieldSet unique to the report you 
are creating. The only field that is always required (and cannot be removed) is Agreement 
Name because reports always display a list or hierarchy of agreement records.  

At this point, you can click Save to save your new Agreement Explorer report without 
any Field or Filter settings. When your report is run, it will return all agreement 
records you have permission to view. Continue to the next section if you want to 
configure Fieldsets for your report.



Fieldsets in Agreement Explorer reports are always defined explicitly for each report 
and change based on the report settings.
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1.

a.

Individual fields are listed in sequence by column number. "Agreement Name" is always the 
first field in the fieldset and cannot be removed or reordered.

Use the drop-down menu to choose or change fields to add to the FieldSet. You can 
add any field that is a part of the Agreement or Account object, including any lookup 
fields from these objects. 

 

 
When you add certain fields to your Field Set, they enable you to take actions 
from the Agreement Explorer report listing, depending on the type of the report. 
The following table describes which actions you can take with these fields and 
defines which contexts use these fields:
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2.

3.

Field Description of Action Report Type

Agreement Name Click on Agreement Name to 
open the corresponding 
agreement record in a new tab.

Agreement, Agreement 
Search, Agreement 
Hierarchy by Account(s)

Account Click on Account name to open 
the corresponding account 
record in a new tab.

Agreement, Agreement 
Search, Agreement 
Hierarchy by Account(s)

Related TO 
Agreement

Click View TO Relations to 
change the report view to a list 
of agreement records related to 
the agreement of context.

Agreement, Agreement 
Search, Agreement 
Hierarchy by Account(s)

Related FROM 
Agreement

Click View FROM Relations to 
change the report view to a list 
of agreement records related 
from the agreement of context.

Agreement, Agreement 
Search, Agreement 
Hierarchy by Account(s)

Agreement 
Hierarchy

Click on  Agreement 
Hierarchies to navigate to the 
default Agreement Hierarchy 
report for the agreement of 
context. 

Agreement Search

Click the Add Field button at the end of the Field Set to add another field. Click the  
 button to remove a field from the FieldSet. Field Sets for Agreement Explorer 

reports can have a maximum of 24 fields.

Save your report or continue to the next section to define Filter settings.

Although Agreement Explorer report Field Sets can have up to 24 fields, only 
the first 12 fields can be displayed in the Agreement Explorer listing when the 
report is run. When you export a report to an Excel spreadsheet, all fields and 
any data they contain are displayed. Keep this in mind when planning the 
sequence of fields in your FieldSet.
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2.

To define Report Filter Settings
Agreement Explorer report results can be constrained through the use of Filter Sets defined 
for any given report. When your report is run, the results are filtered according to the 
expressions you define here.

Define or change Filter Sets to filter the report based on the criteria you specify.

Field Description

Field Choose a field from an alphabetical list of fields available for the 
Object (including lookup fields). For example, if you want to filter 
the agreement records where Agreement Name contains "MSA", 
select Agreement Name from this drop-down list.

Operator Choose an operator based on the data type for the field you 
selected. In the example above, you would choose "contains."

Datatype Operator

Account lookup equal to; not equal to

Date, Number, Currency equal to; not equal to; greater than; 
less than; greater than or equal to; 
less than or equal to

Text starts with; equal to; not equal to; 
contains; does not contain

Value Enter the value to be met for the condition expression. In the 
example above, you would enter "MSA."

Click Add Filter to create additional expressions to add to the Filter set. Click   to 
remove an expression.
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3.

4.

1.
2.

Choose an option from Filter for to define the logic used in the Filter set. 

Filter for Filter logic used

All AND

Any OR

Advanced Advanced expression which can use either logic

By default, all Filter Sets use AND logic. Choose advanced if you want to apply more 
than one type of logic to your filter. For example, if you have 3 Filter Sets and but you 
want to make only 1 of the first 2 required, you would manually change the expression 
to "(1 or 2) AND 3."
When you are finished configuring the Filter Set, click Save to save your report. The 
application refreshes to display the Agreement Explorer tab.

Running Agreement Explorer Reports
Depending on the context of the search, you can use the Agreement Explorer tab to run 
reports to find agreements and their respective hierarchies. Each context has a default 
search defined by an Administrator which can be run from the Agreement Explorer tab (or in 
the case of Agreement hierarchy, from an individual agreement or account record page). 
Individual searches differ based on Field Sets and Filter Sets configured when the search 
was created or modified in an ad hoc fashion at runtime.

Use the following instructions to run the right report to meet your needs. For more 
information on report results and how to use them, see Working with Report Results.

Running Agreement Search Reports
This feature lets you run the default agreement search report.

To run the default agreement search report

Navigate to the Agreement Explorer tab.
Click the Search Agreements button or the Title link in the Saved Reports table 
marked as Default. The report listing all Agreements records that match the default 
Agreement Search report settings (filters and fieldsets) is displayed.  
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1.
2.

3.

1.
2.

 

You can take several actions from the resulting report list. See Using Agreement 
Search Reports for a description of these actions.

To Run a Custom Saved Agreement Search Report
From the Agreement Explorer tab, you can run Agreement Search reports that you own 
(private) or that have been saved as Public (by you or others).

Navigate to the Agreement Explorer tab.
Click on a link in the Saved Reports table with the Agreement Search as context. The 
report listing all Agreement records that match the settings for that specific report is 
displayed.
You can take several actions from the resulting report list. See Using Agreement 
Search Reports for a description of these actions.

Running Agreement Hierarchy Reports
You can run the default agreement hierarchy report for any record.

To run an agreement hierarchy report
Navigate to Agreement Explorer tab.
Click the link in the Saved Reports table marked as Default. The Agreement Search 
screen is displayed. 
No results are displayed initially because no agreement record has been chosen as 
context. All Filter Sets are displayed in the Search Settings and you can preview Field 
Sets by clicking Edit Fields.
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3.

4.
5.

6.

Click on the Agreement Lookup   icon. An agreement Lookup dialog is displayed. 

Search for your agreement record or click on a link to select a record from the list. 
Click Go to run the report. The report listing the Agreement hierarchy for your 
agreement record is displayed, filtered to match the default Agreement report 
settings and display the data according to the defined field sets (columns). Records 
that do not match the filter settings for the report are grayed out (you can still click 
the links). 

 

 
You can take several actions from the resulting report list. See Using Agreement 
Hierarchy Reports for a description of these actions.
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3.

1.
2.
3.

4.
5.

To Run the Default Agreement Hierarchy Report for a Specific Record
Navigate to the desired agreement record.
Click View Agreement Hierarchy. The report listing the Agreement hierarchy for your 
agreement record is displayed, filtered to match the default Agreement report 
settings and display the data according to the fieldset. The agreement record of 
context is highlighted in the list. 

You can take several actions from the resulting report list. See Using Agreement 
Hierarchy Reports for a description of these actions.

To Run a Custom Agreement Hierarchy Report
From the Agreement Explorer tab, you can run Agreement Hierarchy reports that you own 
(private) or that have been saved as Public (by you or others).

Navigate to the Agreement Explorer tab.
Click on a link in the Saved Reports table with Agreement as context. 
Click on the Agreement Lookup  icon. An Agreement Lookup dialog is displayed, 
prompting you to search for a specific record or select one from a list of recent 
agreements.
Search for your agreement record or click on a link to select a record from the list. 
Click Go. The report listing the Agreement hierarchy for your agreement record is 
displayed, filtered to match the report settings and fieldsets specified when the 
report was created or modified. Your agreement is highlighted in the list.
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1.
2.

3.

4.

You can take several actions from the resulting report list. See Using Agreement 
Hierarchy Reports for a description of these actions.

Running Agreement Hierarchy by Accounts Reports
To Run the Default Agreement by Accounts Report for One or More Accounts

Navigate to Agreement Explorer tab.
Click the Title link in the Saved Reports table marked as Default. The Agreement 
Search screen is displayed. 
No results are displayed initially because no account records have been chosen as 
context. All Filter Sets are displayed in the Search Settings and you can preview Field 
Sets by clicking Edit Fields.
Click the Account Lookup   icon. A dialog opens displaying a list of all Accounts you 
have permission to view organized into a hierarchy of parent and child accounts by 
default. 
To view the accounts in alphabetical order click Sort by Name. This opens the 
account list in the alphabetical order. As soon as the alphabetically sorted list is 
displayed, the button toggles to Show Hierarchical. 

 

To view the accounts list again in hierarchical form, you can click Show Hierarchical. 
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6.
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The Sort by Name and Show Hierarchical are toggle buttons.
You can also search a particular account by entering the account name as search 
string in the Search For Account field. The account results displayed are sorted 
alphabetically by default. 

Select the check box next to one or more Accounts in the list and click Add Account 
Context(s). 
Click Go to run the report. The resulting list displays full agreement hierarchies 
organized by the account they are associated with, using the default Agreements by 
Account report settings and field sets. Records that do not match the filter settings 
for the report are grayed out (you can still click the links). Records which match the 
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1.
a.

b.

2.

account record of context are highlighted in blue.  

You can take several actions from the resulting report list. See Using Agreement by 
Accounts Reports for a description of these actions.

To Run the Default Agreement by Account(s) Report for a Specific 
Account

Do one of the following:
Navigate to the Accounts tab. Search for or click the link to view a specific 
Account record. The Account record is displayed. 
(screenshot here)
Navigate to the Agreements tab. Search for or click the link to view a specific 
Agreement record. The Agreement record is displayed.

Click the View Agreement Hierarchy for Account button. The resulting list displays 
full agreement hierarchies associated with the account of context (either the Account 
record from 1a. or the Agreement Account from 1b). The report uses 
the default Agreements by Account report settings and fieldsets. Records which 
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5.
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match the account record of context are highlighted in blue. 

You can take several actions from the resulting report list. See Using Agreement by 
Accounts Reports for a description of these actions.

To Run a Custom Agreement Hierarchy by Account(s) Report
From the Agreement Explorer tab, you can run Agreements by Account reports that you 
own or that have been saved as Public.

Navigate to the Agreement Explorer tab.
Click on a link in the Saved Reports table with Agreements by Account as context. 
Click on the Account Lookup  icon. A dialog displays a list of all Accounts you have 
permission to view organized into a hierarchy of parent and child accounts.
Select the check box next to one or more Accounts in the list and click Add Account 
Context(s). 
Click Go. The report listing the Agreement hierarchies organized by the Accounts 
chosen is displayed, filtered to match the report settings and fieldsets specified when 
the report was created or modified. 
You can take several actions from the resulting report list. See Using Agreement by 
Accounts Reports for a description of these actions.

Working with Report Results
When you run an Agreement Explorer report, listed results are displayed in the Agreement 
Explorer tab. The results are displayed as a list or in a hierarchical format and the columns 
are displayed based on the settings defined when the report was created or modified.
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The following sections describe how report results differ based on context, and the actions 
you can take from report results. All report results can be exported to an Excel spreadsheet 
as needed.

Report Limits
Agreement Explorer report results are subject to the following limits:

Report results can display a maximum of 200 Agreement records. For example, if you 
are a running an Agreement Hierarchy report and your parent agreement has more 
than 200 descendant agreements, to see additional agreements that are not listed, 
you must change the Agreement Lookup focus to one of the child agreements to 
narrow your search. 
 
Agreement Hierarchy Reports can display a maximum of 5 levels both above and 
below the agreement record of context. To return additional agreements that are 
more than 5 levels above or below the agreement of context, change the Agreement 
Lookup focus to one of the parent or child agreements in the hierarchy. 
 

For more information on modifying reports, see Managing Report Settings.

Using Agreement Search Reports
When you run an Agreement Explorer report using the Agreement Search context or type, 
you are returning a list of Agreement records that you have permission to access organized 
into a table from which you can take several actions.
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You execute an Agreement Search report in one of the following ways:

From the Agreement Explorer tab:
the administrator-defined default report for Agreement Search
a public Agreement Search report created by yourself or another user
a private Agreement Search report created by yourself

By editing Search Settings from an existing report.

Taking Actions from Report Results
Actions you can take from Agreement Search report results will vary based on the columns 
that are displayed in the report (fieldsets) and your own security permissions. The following 
table describes actions you can take from report results.

Action Description

View 
Agreement 
Record

Click on a record link under Agreement Name to open the corresponding 
Agreement record page in a new tab.

View Account 
Record

Click on a record link under Account to open the Account record page for the 
Account associated with the corresponding agreement in a new tab.

View 
Agreement 
Hierarchy

Click on a record link under Agreement Hierarchies to navigate to the default 
Agreement Hierarchy report for the corresponding agreement. See Using 
Agreement Hierarchy Reports for more information.
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Action Description

View Related 
To Agreements

Click on a View To Agreements link to view a list of all agreements which are 
Related To the corresponding agreement. All listed agreements are a source or 
reference to create or associate the current record (e.g., renewed from, amended 
from). These results do NOT display Agreement Hierarchy. See Viewing Related 
To Agreement Reports for more information.  

View Related 
From 
Agreements

Click on a View From Agreements link to view a list of all agreements which are 
Related From the corresponding agreement. All listed agreements are created 
or associated from the current record (e.g., renewals, amendments). These 
results do NOT display Agreement Hierarchy. See Viewing Related From 
Agreement Reports for more information.

Click Export to export all report results to a Microsoft Excel spreadsheet. Note: 
Any records which do NOT match Filter Sets (grayed out) will not be included in 
the export.

Click Show Settings/Hide Settings to expand/collapse the Search Settings 
section. You can use Search Settings to edit the filter settings to change the list 
of results based on context type, a saved search (with its own settings) and 
filter expressions. Click Hide Settings to collapse the Search Settings section. See 
Managing Report Settings for detailed instructions on how to use Search 
Settings.

Click Edit Fields to change the fieldset (columns) displayed when the current 
report is executed. When you add Agreement Hierarchy, Related To Agreement 
and Related From Agreement to a fieldset those actions become available for 
records listed in the report. See Managing Report Settings for detailed 
instructions on how to edit fieldsets for a report.

Back to Root 
Report

Click this link to return to the first set of results generated when the report was 
originally executed.

Click this link at the bottom of the report listing to view additional returned 
records. You can also use page navigation to navigate between pages of the 
report.
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Using Agreement Hierarchy Reports
When you run an Agreement Explorer report using the Agreement context or type, you are 
returning a list of agreement records organized into a hierarchy in relation to a specified 
agreement record that you have permission to access. 

The hierarchy displayed in the report represents the entire agreement hierarchy with 
respect to the specified agreement record. Indented agreement records represent parent- 
child relationships.

You execute an Agreement Hierarchy report in one of the following ways:

From the Agreement Explorer tab:
the administrator-defined default report for Agreement Hierarchy
a public Agreement Hierarchy report created by yourself or another user
a private Agreement Hierarchy report created by yourself

clicking on the View Agreement Hierarchy button on an agreement record (default 
settings)
clicking on the Agreement Hierarchies link in an Agreement Search report (default 
settings).
editing Search Settings from an existing report.

Any agreement records in the hierarchy that do not meet the requirements of the 
report filter are presented as gray text. 
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Taking Actions from Report Results
Actions you can take from Agreement Hierarchy report results will vary based on the 
columns which are displayed in the report (fieldsets) and your own security permissions. The 
following table describes actions you can take from report results.

Action Description

View Agreement Record Click a record link in the hierarchy to open the corresponding 
Agreement record page in a new tab.

View Account Record Click a record link under Account to open the Account record 
page for the Account associated with the corresponding 
agreement in a new tab.

View Related To Agreements Click a View To Agreements link to view a list of all 
agreements which are Related To the corresponding 
agreement. All listed agreements are a source or reference to 
create or associate the current record (e.g., renewed from, 
amended from). These results do NOT display Agreement 
Hierarchy. See Viewing Related To Agreement Reports for 
more information. 

View Related From Agreements Click a View From Agreements link to view a list of all 
agreements which are Related From the corresponding 
agreement. All listed agreements are created or associated 
from the current record (e.g., renewals, amendments). These 
results do NOT display Agreement Hierarchy. See Viewing 
Related From Agreement Reports for more information.

Export Click Export to export all report results to a Microsoft Excel 
spreadsheet. Note: Any records which do NOT match Filter 
Sets (grayed out) will not be included in the export.

Show Settings / Hide Settings Click Show Settings/Hide Settings to expand or collapse the 
Search Settings section. You can use Search Settings to edit 
the filter settings to change the list of results based on 
context type, a saved search (with its own settings) and filter 
expressions. Click Hide Settings to collapse the Search 
Settings section. See Managing Report Settings for detailed 
instructions on how to use Search Settings.
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Edit Fields Click Edit Fields to change the fieldset (columns) displayed 
when the current report is executed. When you add Account, 
Related To Agreement and Related From Agreement to a 
fieldset those actions become available for records listed in 
the report. See Managing Report Settings for detailed 
instructions on how to edit field sets for a report.

Back to Root Report Click this link to return to the first set of results generated 
when the report was originally executed.

Show 5 more Click this link at the bottom of the report listing to view 
additional returned records. You can also use page 
navigation to navigate between pages of the report.

Using Agreement by Accounts Reports
When you use the Agreement Hierarchy by Accounts type to run an Agreement Explorer 
report, you are returning a list of agreement records that are organized into hierarchies by 
associated Account record.
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The above image represents a default Agreement Hierarchy by Account(s) report run from 
the Agreement Explorer tab. In this case, the report returns a filtered list of hierarchies for 
more than one account record (selected at the time the report was run). If you run an 
Agreement Hierarchy by Account(s) report from an agreement or account record it will 
always return a list of hierarchies associated with a single account.

You execute an Agreement Hierarchy by Account(s) report in one of the following ways:

from the Agreement Explorer tab:
the administrator-defined default report for Agreement Hierarchy by Account(s)
a public Agreement Hierarchy by Account(s) report created by yourself or 
another user
a private Agreement Hierarchy by Account(s) report created by yourself

by clicking View Agreement Hierarchy for Account from an agreement record (default 
settings).
by clicking View Agreement Hierarchy for Account from an account record (default 
settings).
by editing Search Settings from an existing report.

Taking Actions from Report Results
Actions you can take from Agreement Hierarchy by Account(s) report results will vary 
based on the columns that are displayed in the report (fieldsets) and your own security 
permissions. The following table describes actions you can take from report results.

Action Description

View Agreement 
Record

Click a record link in the hierarchy to open the corresponding Agreement 
record page in a new tab.

View Account Record Click a record link under Account to open the Account record page for the 
Account associated with the corresponding agreement in a new tab.

View Related To 
Agreements

Click a View To Agreements link to view a list of all agreements which are 
Related To the corresponding agreement. All listed agreements are a 
source or reference to create or associate the current record (e.g., renewed 
from, amended from). These results do NOT display Agreement Hierarchy. 
See Viewing Related To Agreement Reports for more information.
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Action Description

View Related From 
Agreements

Click a View From Agreements link to view a list of all agreements which 
are Related From the corresponding agreement. All listed agreements are 
created or associated from the current record (e.g., renewals, 
amendments). These results do NOT display Agreement Hierarchy. See 
Viewing Related From Agreement Reports for more information.

Export Click Export to export all report results to a Microsoft Excel spreadsheet. 
Note: Any records which do NOT match Filter Sets (grayed out) will not be 
included in the export.

Show Settings/Hide 
Settings

Click Show Settings/Hide Settings to expand or collapse the Search 
Settings section. 

You can use Search Settings to edit the filter settings to change the list of 
results based on context type, a saved search 
(with its own settings) and filter expressions.Click Hide Settings to collapse 
the Search Settings section.See Managing Report Settings for detailed 
instructions on how to use Search Settings.

Edit Fields Click Edit Fields to change the fieldset (columns) displayed when the 
current report is executed. When you add Account, Related To Agreement 
and Related From Agreement to a fieldset those actions become 
available for records listed in the report. See Managing Report Settings for 
detailed instructions on how to edit field sets for a report.

Back to Root Report Click this link to return to the first set of results generated when the report 
was originally executed.

Show 5 more Click this link at the bottom of the report to view additional returned 
records. You can also use page navigation to navigate between pages of 
the report.
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Managing Report Settings
For any Agreement Explorer report (Agreement Search, Agreement Hierarchy or Agreement 
Hierarchy by Account(s)), the report results are determined by three main parameters:

the Search Type (e.g., Agreement Search, Agreement Hierarchy or Agreement 
Hierarchy by Account(s))
the individual Agreement Explorer report's Field Sets (sequenced columns displayed in 
the report)
Agreement Explorer Filter Settings (displays report results based on simple or 
advanced expressions)

The following topic describes how to edit report settings after running any report for which 
you have access. 

To edit the settings for any report
Run the report. 
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Click Show Settings to expand the report settings section. 

Use the following links to quickly jump to a task:

To edit the settings for any report
To Change the Saved Report Type

To Change the Report Type to Agreement Search
To Change the Report Type to Agreement
To change the report type to Agreement Hierarchy by Account(s)

To run a saved Agreement Explorer report
To Edit Fields Displayed in a Report
To Change Filter Settings for a Report
To Refresh Agreement Data for a Report

To save Edits to report settings

To Change the Saved Report Type
You can change the search settings to display results based on a different report type. 

To Change the Report Type to Agreement Search
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Click on the Type drop-down menu and choose Agreement Search. 

Click Go. The report listing is refreshed to display a list of agreements according to 
the current filter settings and fieldsets defined for the report. Any agreement or 
account lookup field is removed from the settings view.

To Change the Report Type to Agreement

Click on the Type drop-down menu and choose Agreement.  
 

Search Settings are refreshed to display the Agreement Lookup field.
Click on the Agreement Lookup   icon to display a lookup dialog for agreement 
records. 

Search for and click on an Agreement Name.
Click Go. The report listing is refreshed to display a list of agreement records 
organized into a hierarchy according to the filter settings and fieldsets defined for the 
report. The specific record chosen in the previous step is highlighted in the list. 

To change the report type to Agreement Hierarchy by Account(s)

Click the Type drop-down menu and choose Agreement by Account(s).  
 

Search Settings are refreshed to display an Account lookup field.
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Click the Account Lookup  icon to display a lookup dialog of accounts organized in 
a hierarchy.  

 
Click Sort By Name toggle button (shown above), to view the alphabetical list of 
accounts in the Account Hierarchy window. To switch back to the hierarchy view, click 
 Show Hierarchical button (shown below.) 

You can also search Agreement Accounts by searching the account name as a search 
string in the Search For Account field in the Account Hierarchy window. The result 
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displays account names sorted alphabetically. 

Select one or more Accounts from the list and click Add Account Context(s). 
Click Go. The report listing is refreshed to display a hierarchy of agreements 
organized by the account(s) specified using the current filter and fieldsets defined for 
the report.

To run a saved Agreement Explorer report
You can edit report settings to change the type and choose an already saved report for 
that context. You have access to the following saved reports for any type:

Public Agreement Explorer reports available to all users.
Private Agreement Explorer reports you have created.

Change the current Agreement Explorer context type as described in the previous 
section.
Click the Saved Reports drop-down menu and choose a saved public or private report. 
Filters and fieldsets are changed based on saved settings for the selected report. 

Click Go. The report listing is refreshed to display an Agreement Explorer report that 
matches the chosen saved report.

To Edit Fields Displayed in a Report

You can Edit Fields from Agreement Explorer reports to modify the fields (columns) 
displayed in the report and expand or limit the actions that can be taken from report 
results. When you edit, add or remove fields in this way, you are creating a new FieldSet 
unique to the report which is displayed. The only field that is always required (and cannot 
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be removed) is Agreement Name, because reports always display a list or hierarchy of 
agreement records.  

From any report listing, click the Edit Fields button at the top of the page. The Edit 
Fields dialog is displayed, showing the current fieldset used for this report.  

 

Individual fields are listed in sequence by column number. "Agreement Name" is 
always the first field in the fieldset and cannot be removed or reordered.
Use the drop-down menu to choose or change fields to add to the Fieldset. You can 
add any field which is a part of the Agreement or Account object, including any 
lookup fields from these objects. 

 

When you add certain fields to your Field Set, they enable you to take actions 
from the Agreement Explorer report listing, depending on the type of the report. 
The following table describes which actions you can take with these fields and 
defines which contexts use these fields:

 FieldSets in Agreement Explorer reports are always defined explicitly for each 
report and change depending on settings for a specific report.
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Field Description of Action Agreement Explorer 
Context Type

Agreement Name Click on Agreement Name to 
open the corresponding 
agreement record in a new tab.

Agreement, Agreement 
Search, Agreement 
Hierarchy by Account(s)

Account Click on Account name to open 
the corresponding account 
record in a new tab.

Agreement, Agreement 
Search, Agreement 
Hierarchy by Account(s)

Related TO 
Agreement

Click View To Agreements to 
change the report view to a list 
of agreement records related to 
the agreement of context.

Agreement, Agreement 
Search, Agreement 
Hierarchy by Account(s)

Related FROM 
Agreement

Click View From Agreements to 
change the report view to a list 
of agreement records related 
from the agreement of context.

Agreement, Agreement 
Search, Agreement 
Hierarchy by Account(s)

Agreement 
Hierarchy

Click on  Agreement 
Hierarchies to navigate to the 
default Agreement Hierarchy 
report for the agreement of 
context. 

Agreement Search

Click Add Field at the end of the Field Set to add another field. Click the   button to 
remove a field from the FieldSet. Field Sets for Agreement Explorer reports can have a 
maximum of 24 fields.

Click Apply to save the changes to your report Fieldset.
Click Go to execute the report using your modified Fieldset.

To Change Filter Settings for a Report

Although Agreement Explorer report FieldSets can have up to 24 fields, only 
the first 12 fields can be displayed in the Agreement Explorer listing. When you 
export a report to an Excel spreadsheet, all fields and any data they contain 
are displayed. Keep this in mind when planning the sequence of fields in your 
Fieldset.
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Agreement Explorer report results can be constrained through the use of Filter Sets defined 
for any given report. When you first run an Agreement Explorer report, the report listing is 
displayed based on the defined Filter Set. You can change these Filter settings to return 
specific results based on a set of expressions you build.

Click Show Settings if the Search Settings are not already visible. 
 

Any already existing Filter Sets are displayed in this section.
Define or change Filter Sets to filter the report based on the criteria you specify.

Field Description

Field Choose a field from an alphabetical list of fields available for the Object 
(including lookup fields). For example, if you want to filter the agreement records 
where Agreement Name contains "MSA," select Agreement Name from this drop- 
down list.

Operato 
r

Choose an operator based on the data type for the field you selected. In the 
example above, you would choose "contains."

Datatype Operator

Account lookup equal to; not equal to

Date, Number, Currency equal to; not equal to; greater than; less 
than; greater than or equal to; less than or 
equal to

Text starts with; equal to; not equal to; contains; 
does not contain

Value Enter the value to be met for the condition expression. In the example above, you 
would enter "MSA."

Click Add Filter to create additional expressions to add to the Filter set. Click   to 
remove an expression.
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Choose an option from Filter for to define the logic used in the Filter set. 

Filter for Filter logic used

All AND

Any OR

Advanced Advanced expression which can use either logic

By default, all Filter Sets use AND logic. Choose Advanced if you want to apply more 
than one type of logic to your filter. For example, if you have 3 Filter Sets and but you 
want to make only 1 of the first 2 required, you would manually change the expression 
to "(1 or 2) AND 3."
When you are finished configuring the Filter Set, click Go to run the report using your 
modified Filter conditions.

To Refresh Agreement Data for a Report

Because the Agreement Explorer uses data stored in the most recent cache for the 
Agreement object, you may find that more recently created agreement records are not 
listed in your reports. If you are uncertain how recently agreement data was updated from 
the backend or want to include agreement records that were just created, use the Refresh 
Data button in Report Settings to refresh the data pool extracted from object tables in the 
database.

Click Show Settings to display Search Settings.
Click Refresh Data. 

Return to the Agreement Explorer tab or Agreement or Account record and run the 
report.

Alternatively, the Contract Management administrator can schedule a job 
using the Apex Scheduler to refresh data such as agreement hierarchy and 
account hierarchy. For more information, see Schedule Jobs to Refresh 
Agreement Data.
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To save Edits to report settings
When you edit report settings, you can run reports in an ad hoc fashion without saving any 
changes to the existing report by changing settings as described in the previous sections. 
Agreement Explorer also gives you the option to save edits you have made to an existing 
report, or to save edits as a new report.

Add, remove or change Filter settings for the report, including changing the context 
type of the report.
Add, remove or change the order of Field Sets for the report.
Click Go to run the report using any new Filter or Field Set settings.  
Click Save to save your changes. Settings are changed for the existing report. You can 
only save changes to an existing report if you own the report (private).
Click Save as to save your changes as a new Agreement Explorer report. 

Make changes as needed in the Save Report dialog box. 

Click Save. A new Agreement Explorer report is created using the new report 
settings and the details you specified.

Viewing Related To Agreement Reports
When you run an Agreement Explorer report, if you have the "Related To Agreement" field 
as part of the report Field Set, you have the option to view a filtered report of agreements 
related to agreement records in your report (if any exist).
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To view this list, click View To Agreements from the Agreement Explorer report listing. All 
listed agreements are a source or reference to create or associate the current record (e.g., 
renewed from, amended from) These results do NOT display Agreement Hierarchy.

In the above example, the agreement record Related To "AD XYZ Sales 11.3.15.1 Amended" is 
the original contract from which the agreement was amended (Relationship = Is Amended 
By).

The Agreements Related To report displays without any applied Filter set. You cannot 
modify the Field Set used for this type of report. The following table describes which fields 
are displayed for Related To Agreement reports.

Field Description

Agreement Name Click the Agreement Name to open the corresponding 
related agreement record in a new tab.

Agreement Number The agreement number of the related agreement record.

Agreement Hierarchy Click View Hierarchy to run display a hierarchy report for 
the related agreement record using administrator-defined 
default report settings.
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Field Description

Account Click the Account name to open the related agreement's 
account record in a new tab.

Relationship The relationship of the related record with the original 
agreement record.

Status Category The Status Category of the related agreement record.

Status The Status of the related agreement record.

Click Export to export the Related To Agreements report to an Excel spreadsheet. You 
 cannot save a Related To Agreement report as an Agreement Explorer report.

Viewing Related From Agreement Reports
When you run an Agreement Explorer report, if you have the "Related From Agreement" field 
as part of the report Field Set, you have the option to view a filtered report of agreements 
related from agreement records in your report (if any exist).

 

To view the related agreements list, click on View From Agreements from an Agreement 
Explorer listing. All listed agreements are created or associated with the current record 
(e.g., renewals, amendments). These results do NOT display Agreement Hierarchy.
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In the above example, the agreement records Related From "AD XYZ Sales 11.3.15.1" are three 
separate pending amendments for the same contract (Relationship = Is Amendment For)

The Agreements Related From report displays without any applied Filter set. 
 You cannot modify the Field Set used for this type of report. The following table describes 
which fields are displayed for Related From Agreement reports.

Field Description

Agreement Name Click on the Agreement Name to open the corresponding 
related agreement record in a new tab.

Agreement Number The agreement number of the related agreement record.

Agreement Hierarchy Click View Hierarchy to run display a hierarchy report for 
the related agreement record using administrator-defined 
default report settings.

Account Click on the Account name to open the related agreement's 
account record in a new tab.

Relationship The relationship of the related record with the original 
agreement record.

Status Category The Status Category of the related agreement record.

Status The Status of the related agreement record.

Click Export to export the Related From Agreements report to an Excel spreadsheet. You 
 cannot save a Related From Agreement report as an Agreement Explorer report.
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Deleting an Agreement Explorer Report

If you have the correct permissions, you can delete an Agreement Explorer report from the 
Agreement Explorer tab.

Navigate to the Agreement Explorer tab.
Click the Del link (Delete) next to the corresponding report to delete it. A confirmation 
dialog appears.
Click OK to confirm deletion of the report.

 

Conga CLM on Salesforce Lightning
You can use Conga CLM with the Salesforce Lightning Experience and still accomplish the 
same tasks with the same features that are available in the Classic Experience. The 
change that you will observe is in accessing the features and the process for creating an 
agreement. Beyond a few different steps, the flows for most Contract Management tasks 
remain the same as in the Classic Experience. You can also access Contract Management 
from the Lightning Console. You can use the Lightning Console to Generate, Regenerate, 
Activate, Amend, Renew, Submit Request, Terminate, Expire, and Clone an agreement.

Enabling the Lightning Experience in Salesforce
Enabling the Lightning Experience in your Salesforce org is simple, but requires some 
consideration of your company's needs before you make the switch. Refer to Salesforce's 
documentation on enabling the Lightning Experience. 

Accessing Features in Lightning
One of the main differences you will find when you switch to Lightning is how your apps are 
accessed, like Contract Management. In Lightning, there is no Force.com app menu, and you 

Hint: click on images on this page to enlarge the view.

If you delete a default Agreement Explorer report, the most recently modified public 
report will automatically be assigned as the default report for that report type.



https://trailhead.salesforce.com/en/lex_migration_introduction/lex_migration_introduction_administration
http://Force.com
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cannot customize the default Tabs to include Custom Objects or Visualforce tabs. Instead, 
you access all Contract Management features by using the App Launcher.

Log in to Salesforce with Lightning enabled.
Click the App Launcher button in the upper left-hand corner of the Home screen.
From the App Launcher, click on Contract Management.
Select a Contract Management feature to work with (e.g., "Agreements" to start the 
agreement creation process.)

Creating an Agreement in Lightning
There are two ways to create a new agreement in the Lightning experience.

Go to App Launcher > Contract Management.
Click on Agreements.
From the Agreements List, click New. 
OR 
Click the down arrow  next to the Agreements tab and click +New Agreement from 
the drop-down menu.
Select an Agreement Record Type and click Continue.
On the New Agreement page, enter values for required fields and any optional fields 
that are available and click Continue.

Click Edit to make more changes to your agreement record, or the pencil icon  to 
make changes to any editable field. Note that all the field values you had entered on 
the previous page, have already been saved to the record.
Scroll down the page to find Agreement Actions such as Preview, 
Generate, and Import Offline Agreement. Any Visualforce pages you have added to 
the page layout, such as Document Finder or Master Agreement Clauses are also 
displayed on this page.
The agreement actions can also be accessed from the Agreement Actions panel on 
the right side of the Agreement Details page. The panel shows the action buttons 
clustered into three groups. The Agreement Life Cycle Actions group contains Submit 
Request, Send for Review, Send for Teams Review, Send for Signature, Activate, 
Cancel, Renew, Terminate, Amend, Send for Adobe Sign, Send for DocuSign, and Expire 
actions. The Document Actions group contains Generate, Regenerate, Import Offline 

It is recommended when using the Lightning Experience to configure the above 
page to contain as many fields as you want specified prior moving to the next 
step. You can configure which Agreement fields are available on this page by 
editing the Agreement New Field Set. For more information, see Creating an 
Agreement.





CLM

766 Copyright ©2022 Apttus Corporation. All rights reserved.
 

1.
2.

Document, Preview, Merge Documents, Generate Supporting Document, Upload Signed 
Document, Review Offline, and Import Supporting Document actions. The additional 
actions group contains Agreement Hierarchy, In Effect, and custom actions. For more 
information on customizing action panel, see Enabling and Customizing the Action 
Panel. The action buttons are displayed according to the agreement status and 
status category. 

Contract Wizard in Lightning
Use the Contract Management Contract Wizard to run custom, user-friendly Wizards 
based on any standard or custom Salesforce object (Agreements, Accounts, Proposals, 
Leads, etc.). These Wizards are intended to be used by sales representatives, purchasing 
agents, HR managers, and other users to quickly create their own records by entering 
responses to criteria-based inputs that follow a logical series of steps. Wizards can also be 
used to collect data from customers to be posted to internal systems or for other business 
use. 
Use the Wizards tab to run Wizards from the existing Wizard Designs. You can easily search 
and select from Wizard designs to create well-formed records. Wizards also contain a 
feature that allows users to review their responses prior to submission, returning to previous 
steps to make changes or corrections. Users can also use the tab to resume completion of 
in-progress Wizards or review completed or aborted Wizards.

For information on creating Wizards using the Wizard Designer, see Contract Wizard.

Running Wizards in Lightning
You can use the Run Wizard tab within the Wizard Launcher tab to run Wizards from the 
existing Wizard Designs. 

To run a Wizard
Navigate to the Wizard Launcher tab.
Click  . 
This launches the wizard. 

Note

Document Search and User Filter are unavailable on the Salesforce Lightning 
Document Finder page component.
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3.

4.

5.

a.

b.

c.
d.
e.

(Optional) Click the pencil icon ( ) to give your Wizard a unique name, so you can 
differentiate it from other Wizards you run using the same Wizard design.  
 

 
The new name for your Wizard is displayed in the In Progress tab of the Wizard 
Launcher tab.
Move through the steps of the Wizard, choosing values for the fields in each step. Click 
Next when you are finished with a step to move to the next step. Click Previous to 
return to the previous step. Click Save to save the data on the current wizard page.

Some Wizard steps may include the option to add attachments in addition to 
providing traditional responses. To add an attachment:

Click the Add/Remove Attachments link. This displays the Add Attachments 
window.
Click Add Files. Browse for a file on your machine and add it as an attachment. 
The attachment uploads to the Wizard and displays in the Upload window.
After the attachment is uploaded, click Done.
Repeat the previous steps for each attachment you need to add.
Click Save. 
The attached files are added to the Notes & Attachments Related List of the 
new agreement record and a new document version is created for each 
attachment. The attachments are added to Document version if the object 
record is agreement and document type is Supporting Document. In the version 
aware agreements, the document type of the attached files is updated as 

Note

You must fill in all the required fields on the current wizard page before 
clicking Save. If a lookup field is configured in the wizard design, it will appear 
as a search field in the wizard.
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6.

a.
b.

7.

Supporting Document.  

Some Wizard steps may include the option to add comments in addition to providing 
traditional responses. To add a comment:

Click the Comments link. This displays Comments window.
Enter a comment and click Save. 

 

 
Click Add Item when there is a repeatable field in the Wizard. These fields are used 
when you need to enter multiple values as certain responses—for example when you 
are adding multiple business addresses, or product line items and prices to a Sales 
Contract, as shown in the example below. 
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8.

9.
10.

•

•
•

•
•
•

•

 

When you have answered the final question in the Wizard and clicked Next, the page 
will display a Preview of all steps you have completed. 
 

 

 
Click Edit to change your answers for any steps in the Wizard.
When you are satisfied with your responses, click Submit. Depending on the design of 
the Wizard, one or more of the following will occur:

A record is created according to the Input Rules configured during designing a 
wizard.
You will be redirected to another page in Salesforce.
Depending on the rule configured for Submit in Wizard Design:

You will be navigated to the visual force page.
You will be navigated to the record detail page.
You will be redirected to the created focus object on the record detail 
page.
You will stay on the submitted wizard page:
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•
11.

1.
2.

1.
2.

If there are more than 2 focus objects defined and the submit rule is 
not defined. 
If the wizard was not configured to create a record. 

Return to the Wizard Launcher tab. The Wizard you created and executed now 
displayed in the Completed tab.

Limitations
You cannot launch Wizard with a static resource (image or CSS).
Salesforce Lightning limitation: The dependent picklist is displayed below the 
controlling picklist and not as per the order configured in the wizard design. 

Working with Wizard Launcher in Lightning
You can take several actions from the Wizards tab in addition to running new Wizards:

Prerequisite
You must configure the Wizard Launcher tab to appear on the navigation menu. For more 
information see Adding Wizard Launcher Tab in Lightning.

To search for Wizards
Navigate to the Wizard Launcher tab.
Perform a type-ahead Search to locate an In Progress, Completed or Aborted Wizard 
in the table. 
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1.
2.

1.
2.

•
•
•
•

1.
2.

•

To continue an In Progress Wizard
Pick up where you left off to complete an In Progress Wizard.

Go to the Wizard Launcher tab > In-Progress subtab.
Click the Resume hyperlink. 
This opens the Wizard and you can continue adding the required information.

To review a completed Wizard
You can revisit the Review page for a Completed Wizard.

Go to the Wizard Launcher tab > Complete subtab
Click the Review hyperlink. 
This opens the Wizard and you can view the wizard in read-only mode.

Previewing Wizards in Lightning
To provide more flexibility when running Wizards, a Wizard user can access the Preview 
Progress Bar, which tracks the Wizard as steps are completed. The Wizard user can use the 
Preview Progress Bar to navigate to other steps in the Wizard freely. Use the Preview 
Progress Bar to:

Preview a future step in the Wizard if you had previously navigated to that step.
Track overall completion progress.
Return to a previous step in the Wizard to complete responses or correct a mistake.
View a full preview of all completed responses.

Using the Preview Progress Bar
Launch a new Wizard from the Wizard Launcher tab. 
On the Progress Bar, you will see one of two possible views: 

If you are running a linear, step-by-step Wizard with no conditionally-shown 
steps, you will be able to see and navigate to any step in the Wizard. 
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•

3.
4.

1.
2.

If the Wizard you are running contains any conditional steps, you will only see 
the current step and the "Preview" step. The preview Progress Bar will display 
additional steps as you complete the current step and conditions are satisfied 
to include the other steps in the Wizard.

Click Previous to return to the last step you worked with.
After you have completed all the steps, the Preview page is displayed. Click the Edit 
button to navigate back to that step and update the required details.

Limitation
If a step has a two-column layout then that step is not displayed on the Preview page. For 
more information on how to configure a two-column layout in the wizard, see Creating 
Steps from the Wizard Designer.

Tracking Wizard Activity in Lightning
When a Wizard results in the creation of an Object record (such as an Agreement), a note is 
automatically added to the Notes & Attachments Related List of the created record 
identifying which Wizard originated the record.

For example, an Agreement record has been created from a Wizard.

To view wizard details in an agreement
From the Agreement record page, scroll to Notes & Attachments.
Click the Title hyperlink to view details. 

 

In the Body description, note the Wizard name that created the record. 
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Appendix
Select one of the following topics for more information:

Profile Settings
Fields
Actions
Status and Status Categories
Supported File Sizes in Lightning
Supported File Sizes in Classic
Supported File Formats
Microsoft Teams Dataflow Diagram
Frequently Asked Questions in CLM

Profile Settings
Use the following settings to make sure the profile settings correspond to the custom 
profile.

Profile Requestor/ 
Approver

Contract 
Creator/  
Negotiator

Contract 
Manager

Administrator

Custom App Settings

Contract 
Management

Yes Yes Yes Yes

Enabled Apex Class Access

Contract 
Management

Yes Yes Yes Yes

Enabled Visualforce Page Access

Contract 
Management

Yes Yes Yes Yes
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Profile Requestor/ 
Approver

Contract 
Creator/  
Negotiator

Contract 
Manager

Administrator

Standard Tab Settings

Accounts Use Existing 
Setting

Use Existing 
Setting

Use Existing 
Setting

Use Existing 
Setting

Contacts Use Existing 
Setting

Use Existing 
Setting

Use Existing 
Setting

Use Existing 
Setting

Dashboards Use Existing 
Setting

Use Existing 
Setting

Use Existing 
Setting

Use Existing 
Setting

Reports Use Existing 
Setting

Use Existing 
Setting

Use Existing 
Setting

Use Existing 
Setting

Custom Tab Settings

Admin Tab Hidden Tab Hidden Tab Hidden Tab Hidden

Agreement Protection Tab Hidden Tab Hidden Tab Hidden Tab Hidden

Agreement Rules Tab Hidden Tab Hidden Tab Hidden Tab Hidden

Agreements Default On Default On Default On Default On

Cycle Time Groups Tab Hidden Tab Hidden Tab Hidden Tab Hidden

Document Output 
Formats

Tab Hidden Tab Hidden Tab Hidden Tab Hidden

Query Templates Tab Hidden Tab Hidden Tab Hidden Tab Hidden

Retention Policies Tab Hidden Tab Hidden Tab Hidden Tab Hidden

Templates Tab Hidden Tab Hidden Default On Default On

Term Exceptions Tab Hidden Tab Hidden Tab Hidden Tab Hidden
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Profile Requestor/ 
Approver

Contract 
Creator/  
Negotiator

Contract 
Manager

Administrator

Administrative Permissions

Manage Users No (Use Existing 
Setting)

No (Use Existing 
Setting)

No (Use Existing 
Setting)

Yes

Customize Application No (Use Existing 
Setting)

No (Use Existing 
Setting)

No (Use Existing 
Setting)

Yes

View Setup & 
Configuration

Yes Yes Yes Yes

Manage Public 
Reports

No (Use Existing 
Setting)

No (Use Existing 
Setting)

No (Use Existing 
Setting)

Yes

Manage Dashboards No (Use Existing 
Setting)

No (Use Existing 
Setting)

No (Use Existing 
Setting)

Yes

Edit HTML Templates No (Use Existing 
Setting)

No (Use Existing 
Setting)

No (Use Existing 
Setting)

Yes

General User Permissions

Create and Customize 
Reports

Use Existing 
Setting

Use Existing 
Setting

Yes Yes

Edit Events Yes Yes Yes Yes

Edit Tasks Yes Yes Yes Yes

Export Reports Use Existing 
Setting

Use Existing 
Setting

Yes Yes

Run Reports Use Existing 
Setting

Use Existing 
Setting

Yes Yes
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Profile Requestor/ 
Approver

Contract 
Creator/  
Negotiator

Contract 
Manager

Administrator

Send email Use Existing 
Setting

Yes Yes Yes

Custom Object Permissions

Admin Read Read Read Read, Create, 
Edit, Delete

Agreement Read, Create, 
Edit

Read, Create, 
Edit

Read, Create, 
Edit

Read, Create, 
Edit, Delete

Agreement Clause Read, Create, 
Edit

Read, Create, 
Edit

Read, Create, 
Edit, Delete

Read, Create, 
Edit, Delete

Agreement Document Read, Create, 
Edit

Read, Create, 
Edit

Read, Create, 
Edit, Delete

Read, Create, 
Edit, Delete

Agreement Document 
Output Format

Read, Create, 
Edit

Read, Create, 
Edit

Read, Create, 
Edit

Read, Create, 
Edit, Delete

Agreement Line Item Read Read Read, Create, 
Edit, Delete

Read, Create, 
Edit, Delete

Agreement Lock Read Read Read, Create, 
Edit, Delete

Read, Create, 
Edit, Delete

Agreement Protection Read Read Read Read, Create, 
Edit, Delete

Agreement Rule Read Read Read Read, Create, 
Edit, Delete

Agreement Rule 
Condition

Read Read Read Read, Create, 
Edit, Delete

Agreement Term 
Exception

Read Read Read, Create, 
Edit

Read, Create, 
Edit, Delete
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Profile Requestor/ 
Approver

Contract 
Creator/  
Negotiator

Contract 
Manager

Administrator

AsyncMergeCall Read, Create, 
Edit

Read, Create, 
Edit

Read, Create, 
Edit

Read, Create, 
Edit, Delete

Content Event Read, Create, 
Edit

Read, Create, 
Edit

Read, Create, 
Edit

Read, Create, 
Edit, Delete

Cycle Time Field Read Read Read, Create, 
Edit

Read, Create, 
Edit, Delete

Cycle Time Field Data Read, Create, 
Edit

Read, Create, 
Edit

Read, Create, 
Edit

Read, Create, 
Edit, Delete

Cycle Time Group Read Read Read, Create, 
Edit

Read, Create, 
Edit, Delete

Cycle Time Group 
Data

Read, Create, 
Edit

Read, Create, 
Edit

Read, Create, 
Edit

Read, Create, 
Edit, Delete

Formula Field 
(Comply)

Read Read Read, Create, 
Edit, Delete

Read, Create, 
Edit, Delete

Merge Event Read Read Read, Create, 
Edit, Delete

Read, Create, 
Edit, Delete

Query Template Read Read Read Read, Create, 
Edit, Delete

Query Template Filter Read Read Read, Create, 
Edit

Read, Create, 
Edit, Delete

Query Template 
Qualifier

Read Read Read, Create, 
Edit

Read, Create, 
Edit, Delete

Related Agreement Read Read Read, Create, 
Edit, Delete

Read, Create, 
Edit, Delete
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Profile Requestor/ 
Approver

Contract 
Creator/  
Negotiator

Contract 
Manager

Administrator

Retention Policy Read, Create, 
Edit

Read, Create, 
Edit

Read, Create, 
Edit

Read, Create, 
Edit, Delete

Search Filter (Comply) Read Read Read, Create, 
Edit, Delete

Read, Create, 
Edit, Delete

Temp Object (Comply) Read, Create, 
Edit, Delete

Read, Create, 
Edit, Delete

Read, Create, 
Edit, Delete

Read, Create, 
Edit, Delete

Template Read Read Read, Create, 
Edit

Read, Create, 
Edit, Delete

Template Clause 
Reference

Read Read Read, Create, 
Edit

Read, Create, 
Edit, Delete

Template Datasource 
Filter

Read Read Read, Create, 
Edit

Read, Create, 
Edit, Delete

Template Dynamic 
Section

Read Read Read, Create, 
Edit

Read, Create, 
Edit, Delete

Term Exception Read Read Read, Create, 
Edit

Read, Create, 
Edit, Delete

Custom Record Type Settings for Agreements

Record Types (Create 
Permission) Permission 
for the Record Types 
needs to be provided.

Yes Yes Yes Yes

 

 

Fields
The following table contains a list of agreement fields along with its detailed description.
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Field Label Description Data 
Type

Required Default 
Value

Reserved

Account The link to the account 
record to identify the 
external party to this 
agreement.

Lookup(Ac 
count)

Yes  Yes

Activated By Auto populated with 
the user who activates 
the agreement in the 
system. Read-only.

 Lookup(user)   

Activated 
Date

Auto populated with 
the date on which the 
agreement was 
activated in the 
system. Read-only.

Date    

Agreement 
Category

Used to categorize 
agreement types. This 
can be agreement type 
specific (add 
appropriate values for 
each agreement type) 
and can also be used 
for template filtering.

Picklist    

Agreement 
End Date

The end date for an 
agreement. A required 
field on activation, if 
the agreement is not 
perpetual.

Date Yes  Yes
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Field Label Description Data 
Type

Required Default 
Value

Reserved

Agreement 
Name

Unique identifier for the 
agreement record. This 
name appears in page 
layouts, related lists, 
lookup dialogs, search 
results, and key lists on 
tab home pages. By 
default, this field is 
added to the custom 
object page layout as 
a required field.

Text(80) Yes  Yes

Agreement 
Number

The system assigned 
unique agreement 
number. Identifies the 
agreement number, 
including the version 
number.  Use this field 
to display on screens, 
reports, dashboards, 
search filters and 
columns, and more.

Auto 
Number

Yes   Yes. Not 
changeable 
by user.

Agreement 
Start Date

The effective date of 
the agreement. A 
required field on 
activation.

Date Yes  Yes

Amendment 
Effective 
Date

The date from which 
the amendment is 
effective. If set during 
agreement creation, 
this field is auto- 
populated in the 
amended agreement.

Date    

Auto Renew Indicates whether the 
agreement will auto 
renew.

Check box    
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Field Label Description Data 
Type

Required Default 
Value

Reserved

Auto 
Renewal 
Terms

Specifies any terms 
associated with auto 
renewal.

Long Text 
Area 
(32000)

   

Business 
Hours

Corporate Business 
Hours associated with 
the agreement; used for 
cycle time reporting.

Lookup(Bu 
siness 
Hours)

   

Company 
Signed By

Link to contact record 
to identify internal 
signatory.

Lookup(Co 
ntact)

Yes    

Company 
Signed Date

Date when internal 
signatory signed.

Date Yes   

Company 
Signed Title

Title of person signing 
on the behalf of 
Company.

Text(80)    

Contract 
Duration 
(Days)

The duration from Start 
Date to End Date in 
days. Shown when 
agreement is 'In Effect'.

Formula(n 
umber)

Yes   

Contracted 
Days

Days from Contract 
Start Date to Current 
Date if the contract is 
In Effect and Start 
Date is set.

Formula(n 
umber)

Yes   

Created By User who created the 
record

Lookup(Us 
er)

Yes – System 
assigned

 Yes

Description Detailed description of 
an agreement.

Long Text 
Area(3200 
0)

Yes   
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Field Label Description Data 
Type

Required Default 
Value

Reserved

Executed 
Copy Mailed 
Out Date

Date on which the final, 
executed copy was 
mailed out to the 
external party.

Date    

Executed 
Date

This is a date field that 
is auto-populated 
when a document is 
eSigned (Adobe Sign or 
DocuSign) by all the 
recipients. A user can 
manually enter the 
date when the 
document has wet 
signatures and when 
the signed document is 
uploaded manually.

Date    

Initiation 
Type

To indicate whether 
this record is being filed 
as an executed 
agreement or is being 
negotiated in the 
system.

Picklist Yes - System 
assigned

Negotiate 
Contract 

Yes. Not 
changeable 
by user.

Internal 
Renewal 
Notification 
Days

Notification period prior 
to Renewal Notice Date 
when notification is 
sent out internally to 
indicate that renewal is 
approaching. Email 
alert needs to be setup, 
if needed.

Number Yes   
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Field Label Description Data 
Type

Required Default 
Value

Reserved

Internal 
Renewal 
Start Date

Auto populated with 
Date by which internal 
notice of internal 
renewal is 
approaching. It is 
calculated as Issue 
Renewal Notice Date 
minus Internal Renewal 
Notification days.

Date Yes – System 
assigned, 
changeable 
by user

  

Last 
Modified By

User who most recently 
changed the record

Lookup(Us 
er)

Yes – System 
assigned

 Yes

Non 
Standard 
Legal 
Language?

To indicate whether 
this agreement 
contains non-standard 
language.

Checkbox    

Other Party 
Returned 
Date

The date on which 
other party returned 
the signed agreement.

Date    

Other Party 
Sent Date

Auto populated with 
the Date on which 
agreement was first 
sent to other parties for 
review or signatures.

Date    

Other Party 
Signed By

Link to contact record 
to identify external 
signatory.

Lookup(Co 
ntact)

   

Other Party 
Signed By 
(Unlisted)

External signatory 
identifier (when 
signatory is not 
maintained as contact 
(record) in the system).

Text Area    
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Field Label Description Data 
Type

Required Default 
Value

Reserved

Other Party 
Signed Date

Date when external 
signatory signed.

Date    

Other Party 
Signed Title

Title of person signing 
on behalf of Other 
Party.

Text    

Outstanding 
Days

Shows the number of 
days between date 
agreement was today, 
if not returned. Else 
number of days 
between returned and 
sent.

Formula(n 
umber)

   

Owner Assigned owner of the 
agreement record

Lookup(Us 
er)

Yes – System 
assigned, 
changeable 
by user

Login User Yes

Owner 
Expiration 
Notice

To indicate the number 
of days prior to the 
expiration date that a 
notification needs to be 
sent to the owner.

Picklist  90 Days  

Parent 
Agreement

Reference to the parent 
agreement if the 
current agreement was 
created as a child or 
assigned manually.

Lookup(Ag 
reement) 

   

Perpetual Identifies whether the 
agreement has a 
specified end date or if 
it is open-ended.

Checkbox    
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Field Label Description Data 
Type

Required Default 
Value

Reserved

Primary 
Contact

Primary external 
contact for the 
agreement.

Lookup(Co 
ntact)

   

Record Type The agreement type for 
this record

Record 
Type

Yes Agreement 
Type from 
selection 
screen

Yes

Related 
Opportunity

Identifies the 
opportunity related to 
the agreement.

Lookup(Op 
portunity)

   

Remaining 
Contracted 
Days

If the agreement is In 
Effect, this value is 
calculated as Contract 
Duration Days less 
Contracted Days.

Formula(n 
umber)

   

Renewal 
Consent

Indicates whether 
consent is required to 
extend or renew the 
agreement.

Checkbox    

Renewal 
Notice Date

It is calculated as 
Agreement End Date 
less Renewal Notice 
Days.

Formula(D 
ate)

   

Renewal 
Notice Days

The number of days 
before Agreement End 
Date when renewal 
notice is due.

Number    

Renewal 
Term 
(Months)

The number of months 
to extend the 
agreement.

Number    



CLM

787
 

Copyright ©2022 Apttus Corporation. All rights reserved.
 

Field Label Description Data 
Type

Required Default 
Value

Reserved

Renewal 
Terms

Specifies any terms for 
renewal.

Text Area    

Request 
Date

The date when the 
agreement was 
requested.

Date    

Requestor Agreement Requestor 
(user).

Lookup(us 
er)

   

Risk Rating This field allows users 
to track agreement risk 
rating.

Number(5, 
2)

   

Source Specifies the source of 
the agreement— 
Internal Paper or Other 
Party Paper.

Picklist  Internal 
Paper

Yes. Not 
changeable 
by user.

Special 
Terms

Identifies any special 
terms related to the 
agreement.

Text Area    



CLM

788 Copyright ©2022 Apttus Corporation. All rights reserved.
 

Field Label Description Data 
Type

Required Default 
Value

Reserved

Status The sub stage of an 
agreement—the status 
underneath a given 
status category. These 
are generally 
modifiable by the 
customer except for the 
following values which 
are reserved to 
manage agreement life 
cycles: Request, 
Submitted Request, 
Cancelled Request, In 
Amendment, Being 
Amended, Superseded, 
Activated, Expired, 
Internal Signatures, 
Author Contract, 
Expired, Terminated,  
Ready for Signatures, 
Fully Signed, Signature 
Declined.

Picklist    

Status 
Category

The higher level state 
of the agreement-In 
Authoring, In Effect, 
Expired, and 
more. These are 
reserved values.

Picklist  Request Yes. Not 
changeable 
by user.

Subtype The subtype of the 
agreement for a given 
agreement type. The 
user specifies the 
values based on their 
agreement types.

Picklist 
(Default)
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Field Label Description Data 
Type

Required Default 
Value

Reserved

Term 
(Months)

Identifies the term of an 
agreement, in months, 
from the Agreement 
Start Date.

Number    

Termination 
Comments

Comments for the 
termination of an 
agreement.

Long Text 
Area(3200 
0)

   

Termination 
Date

Date when the 
agreement was 
terminated.

Date    

Termination 
Notice Days

Notice period, in days, 
prior to the termination 
of agreement.

Number    

Termination 
Notice Issue 
Date

Date when the 
termination notice for 
an agreement was sent 
or received.

Date    

Total 
Agreement 
Value

Total value of an 
agreement.

Currency 
(16, 2)

   

Version The version number of 
the agreement that is 
incremented each time 
an agreement is 
amended.

Number 
(3,0)

Yes – System 
Assigned

 Yes

Actions
The Type and the actions vary according to the agreement status. The following table 
describes the Actions available at various stages of the Agreement and their significance:
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Preview
 

Action Preview Agreement

Description Generates a Draft version of an agreement document based on 
the template set up for the agreement type. The draft agreement 
is rendered in the MS-Word format. If more than one agreement 
template is set up, you are prompted to pick a specific template.

Availability If Status Category = Request

Post Status N/A

Comments This action does not place the generated document in the Notes & 
Attachments related list.

 

Generate
 

Action Generate Agreement
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•

•

Description Generates the first version of an agreement document and 
attaches a copy of the same to the agreement record.

When you initiate the Generate action, you are navigated to an 
intermediary screen to select additional information about the 
document to be generated. Select DOC for an MS Word document, 
RTF for Rich Text Format, or PDF for a PDF protected document. 
Additionally, if document protection has been enabled for you, you 
can generate a document with the appropriate protection options.

The first draft version of the agreement is generated, rendered on 
the screen the in MS-Word format and attached to the system in 
the Notes & Attachment or Document Versions (if the document is 
Version Aware) related list on the agreement details page.

You can:
Save it to the desktop, close the MS-Word application, and 
come back to the agreement record later.
Access the agreement document from the Notes & 
Attachments section (click on the View link corresponding to 
the document).

Availability If Status Category = Request

Post Status Sets the status for an agreement to Ready for Signatures.

Comments  

 

Regenerate
 

Action Regenerate Agreement

Description Regenerates a new version of the agreement document from a 
selected template based on values from the agreement record. 
The regenerated agreement document is attached to the Notes & 
Attachments or Document Versions (if the document is Version 
Aware) related list. Because it is regenerated from template, any 
red lines made in previous version are not be carried into this 
version and must be manually applied.
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Availability If Status Category = In Authoring or In Signatures

Post Status N/A

Comments  

 

Generate Supporting Document
 

Action Generate Supporting Document

Description Generates a document from a template of type “Supporting 
Document” and attaches the same to the agreement record. It 
can be used for Agreement Summary, Renewal Letter, 
Termination Letter, etc.

Availability N/A

Post Status N/A

Comments This can be used to generate an agreement summary. 

 

Send for Review
 

Action Send for Review

Description Allows you to select one or more attachments from the 
Agreement record and from related parent/child agreements, 
select an email template, address the same, and send it out.

Availability If Status Category = In Signatures or In Authoring

Post Status Sets the status for an agreement to Other Party Review.
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Comments  

Send for Signatures
 

Action Send for Signatures

Description Allows user to select one or more attachments from the 
Agreement record and from related parent / child agreements, 
select an email template, address the same, and send it out as a 
final copy for Signatures.

Availability If Status Category = In Signatures or In Authoring

Post Status Sets the status for an agreement to Other Party Signatures.

Comments  

 

Import Offline Document
 

Action Import Offline Document

Description Imports a third-party agreement document and 
attaches it to the agreement record.
Allows the user to use the attached document in the 
Author process.

Availability If Status Category = Request or In Authoring or In Filing

Post Status N/A

Comments  
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Activate
 

Action Activate

Description Marks the agreement as a finalized, executed agreement.
Prompts the user to select which attachment is the signed 
copy and records the same in activity history.

Availability If Status Category = In Signatures

Post Status Sets Status Category = In Effect, Status = Activated. If an 
Amendment or Renewal is being Activated, sets Status Category 
of Original Agreement to Amended or Renewed and Status to 
Superseded.

Comments  

 

Amend
 

Action Amend

Description Creates a new dot version of the Agreement (nnnn.1, nnnn.2, 
and so on) after doing a deep copy of the agreement fields and 
related objects.

Availability If Status Category = In Effect

Post Status Sets Status of Original Agreement to Being Amended, and 
Status Category of New Agreement to Request and Status to 
In Amendment

Comments  
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Renew
 

Action Renew

Description Creates a new dot version of the Agreement (nnnn.1, nnnn.2, 
and so on) after doing a deep copy of the agreement fields and 
related objects.

Availability If Status Category = In Effect

Post Status Sets Status of Original Agreement to Being Renewed, and 
Status Category of New Agreement to Request and Status to 
In Renewal.

Comments Agreement End Date must be in the past. 

 

Expire
 

Action Expire

Description Sets the Agreement to an Expired or Lapsed Status.

Availability If Status Category = In Effect

Post Status Sets Status Category to Expired and Status to Expired.

Comments  

Initiate Termination
 

Action Initiate Termination
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Description Initiates the agreement termination process.

Availability This is not a standard action. You must configure the Initiate 
Termination button in the Agreement Detail page layout and 
add the required customization.

Post Status Sets Status Category to In Effect and Status to Being 
Terminated.

Comments  

 

Terminate
 

Action Terminate

Description Sets the Agreement to a Terminated state.

Availability If Status Category = In Effect

Post Status Sets Status Category to Terminated and Status to 
Terminated.

Comments  

 

Cancel Request
 

Action Cancel Request

Description Voids an Agreement Request.

Availability If Status Category = Request or In Authoring or In Signatures 
and Status <> Cancelled Request



CLM

797
 

Copyright ©2022 Apttus Corporation. All rights reserved.
 

•
•

1.

2.

Post Status Sets Status to Cancelled Request
If an Amendment is being Cancelled, sets Status 
Category of Original Agreement to In Effect and Status 
to Activated

Comments  

Status and Status Categories
This section describes the purpose of status categories and associates statuses.

Request:  
This Status Category indicates that the Agreement is in the Request stage.
 

Stage Description

Request New request

Request Approval Request being approved

Submitted Request Request submitted

Approved Request Request approved

In Amendment Contract being amended

In Authoring:  
This Status Category indicates that the contract is in the Authoring stage.
 

Stage Description

Author Contract Contract being authored

Language Approval Language being approved

Submitted Request Request submitted

Approved Request Request approved
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5.

Stage Description

In Amendment Contract being amended

In Clause Approval Clauses are being approved

 
 

In Signatures:  
This Status Category indicates that the contract is in the Signatures stage.
 

Stage Description

Internal Signatures Contract sent for internal signatures

Third Party Signatures Contract sent for other party signatures

In Reconciliation Terms are being reconciled

Reconciled Terms reconciliation completed

In Filing:  
This Status Category indicates that the contract is in the Filing stage.
 

Stage Description

In Reconciliation Terms are being reconciled

Reconciled Terms reconciliation completed

In Effect:  
This Status Category indicates that the contract is in the Effect stage.
 

Clause approval is triggered from Online 
Contract Collaboration. For more information, 
see Working with Clause Approvals.



https://documentation.conga.com/occ/latest/working-with-clause-approvals-158338152.html


CLM

799
 

Copyright ©2022 Apttus Corporation. All rights reserved.
 

6.

7.

8.

9.

Stage Description

Activated Active Contract

Being Activated Contract is in the activation process

Being Amended Contract is in the amendment process

Being Renewed Contract is in the renewal process

Superseded Contract is amended

Being Terminated Contract is in the termination process

Expired:  
This Status Category indicates that the contract is in the Expired stage.
 

Stage Description

Expired Contract expired

Terminated:  
This Status Category indicates that the contract is in the Terminated stage.
 

Stage Description

Terminated Contract terminated

Amended:  
This Status Category indicates that the contract is in the Amended stage.
 

Stage Description

Superseded Contract superseded

Cancelled:  
This Status Category indicates that the contract is in the Cancelled stage.
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Stage Description

Cancelled Request Contract request cancelled

Supported File Sizes in Lightning
The following table lists the maximum file sizes you can upload for each use case when the 
Enable Files Comply System Property is enabled: 
 

Use Case File Size Limit

Add Attachments and Files 2 GB

Import Offline Document  DOCX - 150 MB (with or without Intelligent 
Discovery)
DOCX - 10 MB (with Intelligent Discovery using 
Conga AI)

PDF - 200 MB (with Intelligent Discovery)
PDF - 1.8 GB (multiple files and without 
Intelligent Discovery)
PDF - 500 MB (single file and without Intelligent 
Discovery)
PDF - 10 MB (with Intelligent Discovery using 
Conga AI)

Extraction of large files is supported 
using Conga AI but the files take a long 
time during data extraction.



Extraction of large files is supported 
using Conga AI but the files take a long 
time during data extraction.



Refer send for review or parallel review 
supported file size for further processing the 
imported document.
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Use Case File Size Limit

Import Supporting Document PDF - 1.8 GB (multiple files)
PDF - 500 MB (single file)
DOCX - 150 MB 

Send for Review or Parallel Review Sending for review

DOCX - 150 MB or 400 pages (whichever is the 
greater)

Reply to the review email with a single reviewed 
document

DOCX - 10 MB 

Reply to the review email with multiple reviewed 
documents

DOCX - 25 MB (combined file size of reviewed 
documents)

Upload Reviewed Document

DOCX - 150 MB 

Send for Signature Sending for signature

DOCX - 150 MB 
PDF - 1.8 GB (multiple files)

Upload Signed Document 

DOCX - 150 MB (with or without Intelligent 
Discovery)
PDF - 200 MB (with Intelligent Discovery)
PDF - 1.8 GB (multiple files and without 
Intelligent Discovery)

Email agreement attachments or email 
in-effect view documents

2 GB

Merged documents 25 MB

Refer send for review or parallel review 
supported file size for further processing the 
imported document.
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Use Case File Size Limit

Search agreement documents DOCX - 150 MB
PDF - 2 GB

Send for MS Team Review 10 MB (Limited by MS Teams)

Activate DOCX - 150 MB
PDF - 2 GB (multiple files) 
PDF - 500 MB (single File)

Clone, Amend, Renew  DOCX - 150 MB
PDF - 2 GB (multiple files) 
PDF - 500 MB (single File)

Supported File Sizes in Classic
The following table lists the maximum file sizes you can upload for each use case:

Use Case File Size Limit

Uploading large files while importing or 
creating offline documents 

10 MB (Limited by Force.com / Classic-Apex)

Importing an agreement document 
through Intelligent Import

200 MB (Limited by Kira)

Sending agreement documents for 
review, wet signature, or parallel review

10 MB (Limited by Email template object)

Emailing agreement attachments or 
emailing in-effect view documents

300 MB

Sending an agreement document for 
Microsoft Teams Review 

10 MB (Limited by MS Teams)

Cloning, amending, or renewing agreements 
with large files impacts the storage space as 
duplicate copies of the large files are created.



http://Force.com
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Use Case File Size Limit

Activating an agreement  15 MB (Limited by Force.com governor limits while 
copying a file)

Merging documents 25 MB

Searching agreement documents 10 MB

Uploading a document to Contract 
Management from KIRA (XAJS API)

25 MB

Supported File Formats
The following table lists the file formats supported for each feature in Contract 
Management

Feature Supported File Formats

Generating or Regenerating an Agreement DOC, DOCX, RTF, PDF, and PDF/A

Generating Supporting Documents DOC, DOCX, RTF, PDF, and PDF/A

Sending an Agreement Document for Review DOC, DOCX, RTF, PDF, and all file types that the 
Salesforce platform supports

Sending an Agreement Document for Parallel 
Review

DOCX

Sending an Agreement Document for 
Microsoft Teams Review

DOCX

Sending Agreement Documents for 
Signatures

DOC, DOCX, RTF, PDF, and all file formats that 
the Salesforce platform supports

Activating an Agreement DOC, DOCX, RTF, PDF, and all file formats that 
the Salesforce platform supports

Importing an Offline Agreement DOC, DOCX, RTF, PDF, and all file formats that 
the Salesforce platform supports

http://Force.com
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Feature Supported File Formats

Storing an Executed Agreement DOC, DOCX, RTF, PDF, and all file formats that 
the Salesforce platform supports

Searching Agreement Documents DOC, DOCX, and PDF

Emailing Multiple Agreement Documents DOC, DOCX, RTF, PDF, and all file formats that 
the Salesforce platform supports

Uploading Signed Documents in Lightning DOC, DOCX, and PDF

Intelligently Importing Large Files in 
Lightning

DOC, DOCX, PDF, RTF, JPG, JPEG, PNG, and TIF

Merging Documents in Lightning DOC, DOCX, and PDF

Online Contract Collaboration DOCX

Microsoft Teams Dataflow Diagram
The following diagram shows the dataflow between CLM and Microsoft Teams.
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Frequently Asked Questions in CLM
This topic provides information about the frequently asked questions in CLM.

Which special characters are not supported in the file name?

The unsupported characters in the file name include: \, /, :, *, ?, ", <, >, and |. If you add 
unsupported characters in the document generation workflow, the unsupported characters 
are automatically removed from the final document filename.
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CLM for SOAP API Developers
This section describes the SOAP APIs provided by Conga CLM.

Topic Description

What's Covered This section walks an API user through the list of SOAP APIs 
provided by Conga.

Primary Audience API developers.

IT Environment Refer to the latest Conga CLMRelease Notes for information 
on System Requirements and Supported Platforms.

Updates For a comprehensive list of updates to this section for each 
release, see the What's New in CLM Documentation topic.

This section describes the following topics:

Agreement Web Service
Merge Web Service
Author Web Service
Callback Classes

Before using Conga CLM, you must be familiar with the following:

Basic knowledge of Salesforce
Basic knowledge of SOAP APIs
Salesforce and Apttus terms and definitions

If you are new to Apttus Contract Management, begin here: Getting Started with CLM APIs.

Getting Started with CLM APIs
Select one of the following topics for more information:

API Supported Packages
Document Setup
API Standards and Development Platforms
Field Types
Integrating Conga CLM with External Systems
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API Supported Packages
Refer to the Conga CLM Release Notes for the package details of the latest release.

Document Setup
The Conga CLM API Reference section details the APIs that you can use to manipulate 
Conga CLM objects through API calls and passing parameters:

 

API Reference The API reference section details the APIs that you can use to 
manipulate Conga CLM objects through API calls and passing 
parameters. The API reference section also includes some code 
samples.

API Standards and Development Platforms
Conga CLM APIs are based on Salesforce APIs and use the same standards and platforms.

Standards
 

Name Reference

Simple Object Access Protocol (SOAP) 1.1 http://www.w3.org/TR/2000/NOTE- 
SOAP-20000508

Web Service Description Language (WDSL) 1.1 http://www.w3.org/TR/2001/NOTE-wsdl-20010315

WS-I Basic Profile 1.1 http://www.ws-i.org/Profiles/ 
BasicProfile-1.1-2004-08-24.html

 

http://www.w3.org/TR/2000/NOTE-SOAP-20000508/
http://www.w3.org/TR/2001/NOTE-wsdl-20010315
http://www.ws-i.org/Profiles/BasicProfile-1.1-2004-08-24.html
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Development Platforms
Apttus SOAP API works with standard SOAP development environments. For a list of 
compatible development platforms, see Salesforce Developer Force API details.

Field Types
Conga CLM APIs use a subset of the supported data and field types on Salesforce.

The following table lists the APIs that Conga CLM provides. For a comprehensive list of all 
field types supported by Salesforce, see Salesforce Data Types.

 

Type Description

Boolean The Boolean field has atrue(or 1) orfalse(or 0) value.

Data object The Data Object field is an ID type and is represented byCPQ.nnDOin 
this document.

Date The Date field contains date values only and do not contain 
relevant time values. Time in a date field is always set to midnight 
in the UTC time zone. If you want a timestamp you must use a 
dateTime field.

Decimal The Decimal field provides an exact numeric value and you can 
arbitrarily size the precision and scale of the value.

ID The ID field is an alphanumeric field that acts like the primary key 
for a specific record associated with an object. The ID value includes 
a three-character code that identifies which object the record is 
associated with. The ID for a specific record does not change.

For some objects, this field may also be areferencetype value, which 
contains the ID value for a related record. They are identified by 
field names ending in 'Id', such aspriceListId. The ID field acts like 
foreign keys and their values can be changed using anupdate()call.

Integer The Integer field contains whole numbers only. There are no digits 
after the decimal.

http://wiki.developerforce.com/page/Web_Services_API
http://www.salesforce.com/us/developer/docs/api/Content/primitive_data_types.htm
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1.

2.

3.

Type Description

List The List field includes a fixed set of values from which you must 
select a single value. Picklists are available as drop-down lists. If a 
picklist is unrestricted, the API does not limit entries to only currently 
active values.

String The String field contains text and may have differing length 
restrictions based on the data you store in the specific field. For 
instance,Citymay be limited to 50 characters, whileAddressLine1is 
limited to 255 characters.

Integrating Conga CLM with External Systems
Additional steps are required when you choose to integrate Conga CLM with external 
applications, customer portals, or other critical business systems. Because Contract 
Management Web Services are hosted on Salesforce, you should familiarize yourself with 
the Salesforce SOAP API and processes surrounding integration and best practices detailed 
here: https://developer.salesforce.com/docs/atlas.en-us.api.meta/api/ 
sforce_api_quickstart_intro.htm

The following basic steps are required to get started using the Conga CLM Web Services 
API.

Generate the Enterprise or Partner WSDL – Integration with data stored in Salesforce 
requires you to first point your browser to the Salesforce Enterprise or Partner WSDL. 
This WSDL is generally provided by Apttus Professional Services. Refer to Salesforce 
Documentation for complete instructions on generating the Web Service WSDL.
Generate the Apttus Web Services WSDL – After you have connected to Apttus Web 
Service, go to your organization and download the WSDL for the appropriate Web 
Service (Contract Management Web Service, Batch Update, Proposal Web Service, 
and so on).
Import the WSDL Files Into Your Development Platform – After you have generated 
the WSDL files, you can import them into your development platform. Apttus does not 

Best Practices

Apttus recommends that you work with Apttus Professional Services to design and 
implement your integration. Use this documentation for basic integration steps and 
to reference Contract Management Web Service calls.



https://developer.salesforce.com/docs/atlas.en-us.api.meta/api/sforce_api_quickstart_intro.htm
https://developer.salesforce.com/docs/atlas.en-us.api.meta/api/sforce_api_quickstart_steps_generate_wsdl.htm
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1.

2.

provide instructions for the import process. Refer to Salesforce documentation or 
documentation related to your development platform.
Connect to Apttus – Before you can begin using Contract Management Web Services, 
you must first authenticate to Apttus using the login() API.

Generating the Conga CLM Web Services WSDL
To generate the Apttus Web Services WSDL

Connecting to Conga CLM
To connect to Apttus Web Service using SoapUI

Generating the Conga CLM Web Services WSDL
Before you can import Conga CLM SOAP Web Service into your development or testing 
platform, you must generate and download the Conga CLM WSDL for the appropriate Web 
Service. 

The example provided here uses SoapUI.

To generate the Apttus Web Services WSDL
Log in to the Salesforce organization that contains you Apttus records and data 
(sandbox or production).
Go to Setup > Develop > Apex Classes (on Lightning, go to Setup > Custom Code > 
Apex Classes.

•

•

There a known bug in the WSDL Generator on Salesforce that does not include 
several field types, so it is recommended to update the WSDL file after you have 
generated it but before importing it into your development platform. You can find 
the details for any workaround tasks here: 

https://success.salesforce.com/issues_view? 
id=a1p3A000000eatxQAA&title=generated-wsdl-for-apex-webservices-is- 
malformed
https://success.salesforce.com/issues_view?id=a1p300000008XKUAA2

When updating generated WSDL, make sure that the target namespace for any 
schema you add points to the correct Web Service (for example, schemas/class/ 
Apttus/AgreementWebService). If you are still having trouble, please ask Apttus 
Professional Services for a modified WSDL for the Web Services you are using.



https://success.salesforce.com/issues_view?id=a1p3A000000eatxQAA&title=generated-wsdl-for-apex-webservices-is-malformed
https://success.salesforce.com/issues_view?id=a1p300000008XKUAA2
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3.

4.

5.

6.
7.
8.

1.
2.
3.

4.

Find the Web Service you want to generate the WSDL for (for example, Contract 
ManagementWebService).
Click the WSDL link to generate the WSDL. The WSDL XML is generated and displayed 
in a new tab. 
 

 

 
Right-click on the page and select View Page Source. Copy the XML content to any 
text editor.
Save the file with the extension .wsdl.
Open SoapUI (or wherever is required on your development platform).
Create a new SOAP project and import the Apttus Web Services WSDL. All methods 
under that Web Service are now available to call.

Connecting to Conga CLM
After you have downloaded the Enterprise or Partner WSDL, call the login() method to 
obtain a session ID from your org that you can use when calling Contract Management 
Web Services. After authenticating, you can use the same session ID until it either expires or 
your logout or login again.

The example provided here uses SoapUI, an API testing tool which can be downloaded for 
free here: https://www.soapui.org/.

Prerequisite: To authenticate with Apttus, please make sure to have your production or test 
org credentials on hand (username and password).

To connect to Apttus Web Service using SoapUI
Open SoapUI. Go to File > New SOAP Project.
Enter a name for the project.
Click Browse. Navigate to the saved Enterprise or Partner WSDL file that you 
downloaded and click Open.
Click OK to close the project window.

Refer to the Request/Response XML section for any API in this reference to get 
the structure of the request and any prerequisite calls required for any API.



https://www.soapui.org/
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6.

7.

8.

9.

10.

11.

•

From the Navigation panel to the left, highlight the project folder and click to expand. 
Click to expand the SoapBinding. The list of methods that comprise the Enterprise or 
Partner services are displayed.
Scroll down and right-click on login. Double-click on an existing Request. The request 
window opens in the SoapUI interface. 
 

Select and delete all content following the <soapenv:Header> tag and the </ 
soapenv:Header> tag. 
Enter the username for your org (must have appropriate privileges) between the 
 <urn:username> and </urn:username> tags.
Enter the username for your org (must have appropriate privileges) between the 
 <urn:password> and </urn:password> tags. 
 
The request should look like the following:

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 

 xmlns:urn="urn:partner.soap.sforce.com">

   <soapenv:Header>

   </soapenv:Header>

   <soapenv:Body>

      <urn:login>

         <urn:username>username@example.com</urn:username>

         <urn:password>password</urn:password>

      </urn:login>

   </soapenv:Body>

</soapenv:Envelope>

From the upper-left corner of the window, click the Run ( ) icon. The response is 
generated in the right-hand window.
Make note of the serverURL and the sessionId returned by the server. You will use the 
information to make Apttus Web Service calls.

API Reference
Agreement Web Service 
The Agreement Web Service APIs are used for activating, selecting and publishing 

If you are doing this for the first time, you need to right-click on the login 
method and select New Request.
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agreements. Once an agreement has been activated and associated with a template 
it can be published to Salesforce.com – either to Chatter files or Documents - or 
published to an external repository.
Merge Web Service 
The Merge Web Service APIs are used for generating and manipulating documents. 
Both agreements and supporting documents can be generated, while text can be 
added to document headers and footers. Word documents can be converted into PDF 
documents and security rules can be applied to PDF documents.
Author Web Service 
The Author Web Service API contains all the services related to files or documents and 
can be used with various operations related to X-Author. 
Callback Classes 
The callback classes are used to create and register a custom code.

Agreement Web Service
The Agreement Web Service APIs are used for activating, selecting and publishing 
agreements. Once an agreement has been activated and associated with a template it 
can be published to Salesforce.com – either to Chatter files or Documents - or published to 
an external repository.

You can invoke APIs in Agreement Web Service using the following command:

Apttus.AgreementWebService.<Name of the Function> 
where the name of the function is API Name and its parameters.

You can use the Agreement web service APIs to complete the following tasks:

Activating Agreements
Publishing Document Outside of Salesforce
Publishing the Document to Chatter
Publishing the Document to Files and Attachments
Selecting a Template for the Agreement Document
Terminating Agreements
Updating Smart Fields
Sending a Document for Signatures

http://salesforce.com/
http://Salesforce.com
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•• publishToChatterRepositorypublishToDocumentRepository

Activating Agreements
This API activates an agreement and deletes draft documents. This API only updates the 
Status Category to In Effect and the Status to Activated but does not publish the activated 
agreement document to multiple channels. You must call one of the following APIs to 
publish the document:

publishToExternalRepository

Prerequisite
You must ensure that the Status Category for the Agreement record is In Signatures or In 
Filing.

 

API Signature

activateAgreement webService static Boolean activateAgreement(Id 
agreementId, List selectedDocIds, List removableDocIds)

 

 

Request Parameters

Name Type Description

agreementId ID The id of the agreement.

selectedDocIds List<ID> List of fully signed document ids.

removableDocIds List<ID> List of draft document ids that can be 
deleted.
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Response Parameter

Name Type Description

result Boolean Indicates whether the agreement was activated 
successfully.

 

Code Sample 

Integration Details
Use the following information in your integrations with Apttus Contract Management Web 
Services API. For information on how to get started, refer to Integrating Conga CLM with 
External Systems.

API Prerequisites
None.

Request/Response XML

Example Request

<soapenv:Envelope

    xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/"

    xmlns:agr="http://soap.sforce.com/schemas/class/Apttus/AgreementWebService">

    <soapenv:Header>

        <agr:SessionHeader>

            <agr:sessionId>00D020000008lUh! 

AQYAQEEW..3lVJKVa9atZ.0B6NtzfwyA.27WJEfZds4IqJX8uzm8O7.VdNoOTWwjGFxgbrF03ylztaIg6VvFl 

_EeKVGaQccY</agr:sessionId>

Id agreementId = agreement.Id;1
String[] activateDocIds = new String[1];2
String[] remDocIds = new String[]{};        3
Boolean response = 

Apttus.AgreementWebService.activateAgreement(agreementId, activateDocIds, 

remDocIds);

4
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        </agr:SessionHeader>

    </soapenv:Header>

    <soapenv:Body>

        <agr:activateAgreement>

            <agr:agreementId>a07020000008w9BAAQ</agr:agreementId>

            <agr:selectedDocIds>00P02000000IYA7EAO</agr:selectedDocIds>

            <agr:removableDocIds>0002000000Cc0LAAS</agr:removableDocIds>

            <agr:removableDocIds>0760000000Cc0GAAS</agr:removableDocIds>

        </agr:activateAgreement>

    </soapenv:Body>

</soapenv:Envelope>

Example Response

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns="ht 

tp://soap.sforce.com/schemas/class/Apttus/AgreementWebService">

   <soapenv:Body>

      <activateAgreementResponse>

         <result>true</result>

      </activateAgreementResponse>

   </soapenv:Body>

</soapenv:Envelope>

Publishing Document Outside of Salesforce
This API publishes the agreement document for the activated agreement to an external 
location. This method will write the data into an integration object. A trigger should be 
written to send the document to the external location.

Prerequisite
Ensure that the APTS_ContentRepositoryType admin object value is set to External. For 
more information, see Admin Entries.
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API Signature

publishToExternalRepository webService static Boolean 
publishToExternalRepository(Id agreementId, Id 
attachmentId)

 

 

Request Parameters

Name Type Description

agreementId ID The id of the agreement

attachmentId ID The id of the document that is to be published.

 

 

Response Parameter

Name Type Description

result Boolean Indicates whether the document was published 
successfully.

 

Code Sample

Id agreementId = agreement.Id;1
Id attachmentId = attachment.Id;    2
Boolean response = 

Apttus.AgreementWebService.publishToExternalRepository(Id agreementId, Id 

attachmentId); 

3
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Integration Details
Use the following information in your integrations with Apttus Contract Management Web 
Services API. For information on how to get started, refer to Integrating Conga CLM with 
External Systems.

API Prerequisites
Activating Agreements

Request/Response XML

Example Request

<soapenv:Envelope

    xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/"

    xmlns:agr="http://soap.sforce.com/schemas/class/Apttus/AgreementWebService">

    <soapenv:Header>

        <agr:SessionHeader>

            <agr:sessionId>00D020000008lUh! 

AQYAQEEW..3lVJKVa9atZ.0B6NtzfwyA.27WJEfZds4IqJX8uzm8O7.VdNoOTWwjGFxgbrF03ylztaIg6VvFl 

_EeKVGaQccY</agr:sessionId>

        </agr:SessionHeader>

    </soapenv:Header>

    <soapenv:Body>

        <agr:publishToExternalRepository>

            <agr:agreementId>a07020000008w9BAAQ</agr:agreementId>

            <agr:attachmentId>a070S000002aDcuQAE</agr:attachmentId>

        </agr:publishToExternalRepository>

    </soapenv:Body>

</soapenv:Envelope>

Example Response

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns="ht 

tp://soap.sforce.com/schemas/class/Apttus/AgreementWebService">

   <soapenv:Body>

      <publishToExternalRepositoryResponse>



CLM

819
 

Copyright ©2022 Apttus Corporation. All rights reserved.
 

         <result>true</result>

      </publishToExternalRepositoryResponse>

   </soapenv:Body>

</soapenv:Envelope>

Publishing the Document to Chatter
This publishes the agreement document for the activated agreement to Chatter > Files for 
the Salesforce object the agreement is associated with.

Prerequisite
Ensure that the APTS_ContentRepositoryType admin object value is set to Chatter. For 
more information, see Admin Entries.

 

API Signature

publishToChatterRepository webService static Boolean 
publishToChatterRepository(Id agreementId, Id 
attachmentId)

 

 

 

Request Parameters

Name Type Description

agreementId ID The id of the agreement

attachmentId ID The id of the document that is to be published and 
uploaded to Chatter > Files.
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Response Parameter

Name Type Description

result Boolean Indicates whether the document was published to 
Chatter successfully.

 

Code Sample

Integration Details
Use the following information in your integrations with Apttus Contract Management Web 
Services API. For information on how to get started, refer to Integrating Conga CLM with 
External Systems.

API Prerequisites
Activating Agreements

Request/Response XML

Example Request

<soapenv:Envelope

    xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/"

    xmlns:agr="http://soap.sforce.com/schemas/class/Apttus/AgreementWebService">

    <soapenv:Header>

        <agr:SessionHeader>

            <agr:sessionId>00D020000008lUh! 

AQYAQEEW..3lVJKVa9atZ.0B6NtzfwyA.27WJEfZds4IqJX8uzm8O7.VdNoOTWwjGFxgbrF03ylztaIg6VvFl 

_EeKVGaQccY</agr:sessionId>

        </agr:SessionHeader>

Id agreementId = agreement.Id;1
Id attachmentId = AttachmentId;2
Boolean response = Apttus.AgreementWebService.publishToChatterRepository 

(agreementId, attachmentId);  

3
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    </soapenv:Header>

    <soapenv:Body>

        <agr:publishToChatterRepository>

            <agr:agreementId>a07020000008w9BAAQ</agr:agreementId>

            <agr:attachmentId>a070S000002aDcuQAE</agr:attachmentId>

        </agr:publishToChatterRepository>

    </soapenv:Body>

</soapenv:Envelope>

Example Response

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns="ht 

tp://soap.sforce.com/schemas/class/Apttus/AgreementWebService">

   <soapenv:Body>

      <publishToChatterRepositoryResponse>

         <result>true</result>

      </publishToChatterRepositoryResponse>

   </soapenv:Body>

</soapenv:Envelope>

Publishing the Document to Files and Attachments
This publishes the agreement document for the activated agreement to Files and 
Attachments for the Salesforce object the agreement is associated with.

Prerequisite
Ensure that the APTS_ContentRepositoryType admin object value is set to Document. For 
more information, see Admin Entries.

 

API Signature

publishToDocumentRepository webService static Boolean 
publishToDocumentRepository(Id agreementId, Id 
attachmentId)
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Request Parameters

Name Type Description

agreementId ID The id of the agreement

attachmentId ID The id of the document that is to be published and 
uploaded to Files and Attachments.

 

 

 

Response Parameter

Name Type Description

result Boolean Indicates whether the document was published to 
Files and Attachments successfully.

 

Code Sample

Integration Details
Use the following information in your integrations with Apttus Contract Management Web 
Services API. For information on how to get started, refer to Integrating Conga CLM with 
External Systems.

API Prerequisites
Activating Agreements

Id agreementId = agreement.Id;1
Id attachmentId = attachment.Id;    2
Boolean response = 

Apttus.AgreementWebService.publishToDocumentRepository(Id agreementId, Id 

attachmentId); 

3
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Request/Response XML

Example Request

<soapenv:Envelope

    xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/"

    xmlns:agr="http://soap.sforce.com/schemas/class/Apttus/AgreementWebService">

    <soapenv:Header>

        <agr:SessionHeader>

            <agr:sessionId>00D020000008lUh! 

AQYAQEEW..3lVJKVa9atZ.0B6NtzfwyA.27WJEfZds4IqJX8uzm8O7.VdNoOTWwjGFxgbrF03ylztaIg6VvFl 

_EeKVGaQccY</agr:sessionId>

        </agr:SessionHeader>

    </soapenv:Header>

    <soapenv:Body>

        <agr:publishToDocumentRepository>

            <agr:agreementId>a07020000008w9BAAQ</agr:agreementId>

            <agr:attachmentId>a070S000002aDcuQAE</agr:attachmentId>

        </agr:publishToDocumentRepository>

    </soapenv:Body>

</soapenv:Envelope>

Example Response

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns="ht 

tp://soap.sforce.com/schemas/class/Apttus/AgreementWebService">

   <soapenv:Body>

      <publishToDocumentRepositoryResponse>

         <result>true</result>

      </publishToDocumentRepositoryResponse>

   </soapenv:Body>

</soapenv:Envelope>

Selecting a Template for the Agreement Document
This associates a template with the agreement, enabling the agreement document to be 
published.
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API Signature

selectFirstTemplateIdForAgreement webService static Id 
selectFirstTemplateIdForAgreement(Id agreementId)

Parameters

Name Type Description

agreementId ID The id of the agreement

 

Response

Name Type Description

result ID The id of the template that is used to generate the 
agreement document

Integration Details
Use the following information in your integrations with Apttus Contract Management Web 
Services API. For information on how to get started, refer to Integrating Conga CLM with 
External Systems.

API Prerequisites
None.

Request/Response XML

Example Request

<soapenv:Envelope

    xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/"

    xmlns:agr="http://soap.sforce.com/schemas/class/Apttus/AgreementWebService">

    <soapenv:Header>

        <agr:SessionHeader>
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            <agr:sessionId>00D020000008lUh! 

AQYAQEEW..3lVJKVa9atZ.0B6NtzfwyA.27WJEfZds4IqJX8uzm8O7.VdNoOTWwjGFxgbrF03ylztaIg6VvFl 

_EeKVGaQccY

</agr:sessionId>

        </agr:SessionHeader>

    </soapenv:Header>

    <soapenv:Body>

        <agr:selectFirstTemplateIdForAgreement>

            <agr:agreementId>a07020000008w9GAAQ</agr:agreementId>

        </agr:selectFirstTemplateIdForAgreement>

    </soapenv:Body>

</soapenv:Envelope>

Example Response

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns="ht 

tp://soap.sforce.com/schemas/class/Apttus/AgreementWebService">

   <soapenv:Body>

      <selectFirstTemplateIdForAgreementResponse>

         <result>a09R000000Alm7iIAB</result>

      </selectFirstTemplateIdForAgreementResponse>

   </soapenv:Body>

</soapenv:Envelope>

Terminating Agreements
The terminateAgreementsAsync API allows you to bulk terminate agreements based on the 
agreement status.

API Signature

terminateAgreementsAsync webService static Id terminateAgreementsAsync(List 
agreementIds)

Request Parameters

Name Type Description Required?

agreementIds List<ID> List of agreement Ids Yes
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1.
2.
3.
4.
5.
6.
7.
8.

Code Sample

List<ID> agreementIdList = new List<ID> ();

Boolean response = 

Apttus.AgreementWebService.terminateAgreementsAsync(agreementIdList);

Use Case

Bulk terminate agreements and their related agreements with the same agreement 
number.

Order of Execution

Check permissions.
Get the agreement object.
Register the terminate indicator.
Terminate the agreement.
Save the terminated agreement.
Reset the terminate indicator.
Refresh the original agreement.
Post-termination updates.

Integration Details
Use the following information in your integrations with Apttus Contract Management Web 
Services API. For information on how to get started, refer to Integrating Conga CLM with 
External Systems.

API Prerequisites
None.

Request/Response XML

Example Request

<?xml version="1.0" encoding="UTF-8"?>

<soapenv:Envelope

    xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/"

    xmlns:agr="http://soap.sforce.com/schemas/class/Apttus/AgreementWebService">
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    <soapenv:Header>

        <agr:SessionHeader>

            <agr:sessionId>00D020000008lUh! 

AQYAQEEW..3lVJKVa9atZ.0B6NtzfwyA.27WJEfZds4IqJX8uzm8O7.VdNoOTWwjGFxgbrF03ylztaIg6VvFl 

_EeKVGaQccY</agr:sessionId>

        </agr:SessionHeader>

    </soapenv:Header>

    <soapenv:Body>

        <agr:terminateAgreement>

            <agr:agreementId>a07020000008w9GAAQ</agr:agreementId>

        </agr:terminateAgreement>

    </soapenv:Body>

</soapenv:Envelope>

Example Response

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns="ht 

tp://soap.sforce.com/schemas/class/Apttus/AgreementWebService">

   <soapenv:Body>

      <terminateAgreement>

         <result>a09R000000Alm7iIAB</result>

      </terminateAgreement>

   </soapenv:Body>

</soapenv:Envelope>

Updating Smart Fields
This updates multiple smart fields in a document with the latest values and creates a new 
check-in with the redlined version without manual intervention. 

API Signature

updateSmartFieldsOnAgreementDocumen 
t

webService static String 
updateSmartFieldsOnAgreementDocument(Id 
agreementId, Id documentId)

Prerequisite: You need to configure the Comply System Property—XAJS Endpoint. For more 
information, see Comply System Properties.
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Request Parameters

Name Type Required Description

agreementId ID Yes The id of the agreement

documentId ID Yes The id of the document that is to be 
published.

Response

This API returns documentId of the newly created document after updating all the smart 
fields.

Code Sample

ID agreementId = 'a03123123123';

ID documentId = '069123123123'; //attachment or file id

Apttus.AgreementWebService.updateSmartFieldsOnAgreementDocument(agreementId, 

documentId);

Use case

Consider an agreement A1 contains document D1. Create an agreement A2 and clone the 
document D1. This creates document D2. Attach D2 to A2. As D2 contains metadata from A1, 
you will not be able to call updateSmartFieldsOnAgreementDocument to update D2. To 
update D2, you need to call enableAuthoring API and then 
call updateSmartFieldsOnAgreementDocument.

Integration Details
Use the following information in your integrations with Apttus Contract Management Web 
Services API. For information on how to get started, refer to Integrating Conga CLM with 
External Systems.

API Prerequisites
None.
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Request/Response XML

Example Request

<soapenv:Envelope

    xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/"

    xmlns:agr="http://soap.sforce.com/schemas/class/Apttus/AgreementWebService">

    <soapenv:Header>

        <agr:SessionHeader>

            <agr:sessionId>00D020000008lUh! 

AQYAQEEW..3lVJKVa9atZ.0B6NtzfwyA.27WJEfZds4IqJX8uzm8O7.VdNoOTWwjGFxgbrF03ylztaIg6VvFl 

_EeKVGaQccY

</agr:sessionId>

        </agr:SessionHeader>

    </soapenv:Header>

    <soapenv:Body>

        <agr:updateSmartFieldsOnAgreementDocument>

            <agr:agreementId>a07020000008w9GAAQ</agr:agreementId>

            <agr:documentId>a07020000008w9BAAQ</agr:documentId>

        </agr:updateSmartFieldsOnAgreementDocument>

    </soapenv:Body>

</soapenv:Envelope>

Example Response

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns="ht 

tp://soap.sforce.com/schemas/class/Apttus/AgreementWebService">

   <soapenv:Body>

      <updateSmartFieldsOnAgreementDocument>

         <result>a070S000002I4J4QAK</result>

      </updateSmartFieldsOnAgreementDocument>

   </soapenv:Body>

</soapenv:Envelope>

Sending a Document for Signatures
This API allows you to send the agreement document for manual signatures.
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API Signature

sendForSignature webService static Boolean sendForSignature(Id 
primaryContactID, List emailCc, List emailBcc, List 
emailAdditionalTo, Id emailTemplateId, Id agreementId, List 
attachmentIds)

Request Parameters

Name Type Description Required

primaryContact 
ID

ID The id of the primary contact. Yes

emailCc list  The email ids of the recipients you need to CC in the 
email.

Optional

emailBcc list  The email ids of the recipients you need to BCC in the 
email.

Optional

emailAdditional 
To

list  The email ids of the recipients you need to send the 
email.

Yes

emailTemplateI 
d

ID The id of the email template that you need to use to 
send the email.

Yes

agreementId ID The id of the document that is to be signed. Yes

attachmentIds list  The ids of the documents that are to be signed. Yes

Response Parameter

Name Type Description

result Boolean Indicates whether the agreement was sent for 
signatures successfully.

Code Sample 
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Integration Details
Use the following information in your integrations with Apttus Contract Management Web 
Services API. For information on how to get started, refer to Integrating Conga CLM with 
External Systems.

API Prerequisites
None.

Request/Response XML

Example Request

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:agr=" 

http://soap.sforce.com/schemas/class/Apttus/AgreementWebService">

   <soapenv:Header>

      <agr:SessionHeader>

         <agr:sessionId>00D0S0000000Pa8! 

ARUAQMbFkHvnVLwOoAiCDHaWEz0Bkjf6uEcSsGd4853e7wLfvv88oUmBtR0xy2BYEgdcP6IrMA1b9qJ7N3uDy 

PC31sNPlfjs</agr:sessionId>

      </agr:SessionHeader>

   </soapenv:Header>

   <soapenv:Body>

      <agr:sendForSignature>

         <agr:primaryContactID>0030S00000MxYfbQAF</agr:primaryContactID>

List<String> addto = new list<String>{'test1@abc.com','test2@abc.com','tes 

t3@abc.com','test4@apttus.com'};

1

List<String> cc = new list<String>{'test5@abc.com','test6@abc.com','test7@ 

abc.com','test8@abc.com'};

2

List<String> bcc = new list<String>{'test9@abc.com','test10@abc.com','test 

11@abc.com','test12@abc.com'};

3

List<id> attmentids = new list<String>{'00P0S000002nzJg','00P0S000002nzJb'} 

;

4

id primaryContactID = '0030S00000MxYfb';5
id emailTemplateId = '00XA0000000h9eQ';6
id agreementId = 'a070S000002I3I4';7
Boolean response = 

apttus.AgreementWebService.sendForSignature(primaryContactID,cc,bcc,addto, 

emailTemplateId,agreementId,attmentids);

8
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         <agr:emailCc>test1@abc.com</agr:emailCc>

         <agr:emailCc>test2@abc.com</agr:emailCc>

         <agr:emailBcc>test3@abc.com</agr:emailBcc>

         <agr:emailBcc>test4@abc.com</agr:emailBcc>

         <agr:emailAdditionalTo>test5@abc.com</agr:emailAdditionalTo>

         <agr:emailAdditionalTo>test6@abc.com</agr:emailAdditionalTo>

         <agr:emailTemplateId>00XA0000000h9eQ</agr:emailTemplateId>

         <agr:agreementId>a070S000002I4J4QAK</agr:agreementId>

         <agr:attachmentIds>a1z0S000000u1hqQAA</agr:attachmentIds>

      </agr:sendForSignature>

   </soapenv:Body>

</soapenv:Envelope>

Example Response

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns="ht 

tp://soap.sforce.com/schemas/class/Apttus/AgreementWebService">

   <soapenv:Body>

      <sendForSignatureResponse>

         <result>true</result>

      </sendForSignatureResponse>

   </soapenv:Body>

</soapenv:Envelope>

Merge Web Service
The Merge Web Service APIs are used for generating and manipulating documents. Both 
agreements and supporting documents can be generated, while text can be added to 
document headers and footers. Word documents can be converted into PDF documents and 
security rules can be applied to PDF documents.

You can invoke APIs in Merge Web Service using the following commands:

 

Apttus.MergeWebService.<Name of the Function> 
where the name of the function is API Name and its parameters.

Apttus_Proposal.MergeWebService.<Name of the Function> 
where the name of the function is API Name and its parameters.
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•
•
•
•
•
•

•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

You can use the Merge web service APIs to complete the following tasks:

Adding Header and Footer Text without Document Protection
Adding Header and Footer Text with Document Protection
Applying Security Parameters to a PDF
Converting a Word Document into a given output format
Converting a Word Document into a given output format (Deprecated)
Converting a Word Document into a given output format for Standard Object 
(Deprecated)
Converting a Word Document into a PDF
Converting a Word Document into a PDF for Standard Objects
Enabling Authoring for Agreement Documents
Generating a Document
Generating a Document for a Standard Object
Generating a Document on Submit Request
Generating a Document on Submit Request for a Standard Object
Generating a Supporting Document
Generating a Supporting Document on Submit Request
Merging Multiple Documents to a PDF without PDF Protection
Merging Multiple Documents to a PDF with PDF Protection
Creating PDF
Merging Proposal Documents into a single PDF Document
Package Multiple Documents
Merging Documents
Regenerate Documents with Redlines

Adding Header and Footer Text without Document 
Protection
This API allows you to append the given text to the header and footer for a given 
document. 

Note

appendToHeaderFooter does not support protection levels for FX1 documents (FX2 
documents do support document protection). Document protection levels are reset 
when header and footer are added. To retain protection levels for FX1 documents, 
use appendToHeaderFooter2instead.
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API Signature

appendToHeaderFooter webService static Boolean appendToHeaderFooter(Id docId, 
String headerText, String footerText, String sessionId, String 
serverUrl)

Request Parameters

Name Type Description Required?

docId ID The id of the document which will 
have header and footer content 
added to it.

Yes

headerText String The header text to be appended to 
the document.

Yes

footerText String The footer text to be appended to the 
document.

Yes

sessionId String The Salesforce session id. Yes

serverUrl String The Salesforce server Url. Yes

Response Parameter

Name Type Description

result Boolean Indicates whether the header and footer are 
added successfully.

Code Sample

ID docId= AttachmentId;

String headerText = 'This is Header';

String footerText = 'This is Footer'; 

String apiServerURL = System.Url.getSalesforceBaseUrl().toExternalForm() + '/ 

services/Soap/u/50.0/' +

UserInfo.getOrganizationId();

String SessionId = sessionId; //This is the session Id.
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String generatedDocId = Apttus_Proposal.MergeWebService.appendToHeaderFooter(docId, 

headerText, footerText, sessionId, serverUrl);

Integration Details
Use the following information in your integrations with Apttus Contract Management Web 
Services API. For information on how to get started, refer to Integrating Conga CLM with 
External Systems.

API Prerequisites
None.

Request/Response XML

Example Request

<soapenv:Envelope

    xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/"

    xmlns:mer="http://soap.sforce.com/schemas/class/Apttus/MergeWebService">

    <soapenv:Header>

        <mer:sessionId>00D020000008lUh! 

AQYAQBDMUfqKvlqcVtqEnsqWZ3CvH_9PAn553rGgepU1CKttbRUAm4C8FFgTHrzkd6juez5FF4NEryvZ8ibJC 

__d7TM.vxCY</mer:sessionId>

    </soapenv:Header>

    <soapenv:Body>

        <mer:appendToHeaderFooter>

            <mer:docId>068R0000001Z56SIAS</mer:docId>

            <mer:headerText>Care Company</mer:headerText>

            <mer:footerText>Copyright 2020</mer:footerText>

            <mer:sessionId>00D020000008lUh! 

AQYAQBDMUfqKvlqcVtqEnsqWZ3CvH_9PAn553rGgepU1CKttbRUAm4C8FFgTHrzkd6juez5FF4NEryvZ8ibJC 

__d7TM.vxCY</mer:sessionId>

            <mer:serverUrl>https://testmanaged--5s20minor.my.salesforce.com/services/ 

Soap/u/50.0/00D020000008lUh</mer:serverUrl>

        </mer:appendToHeaderFooter>

    </soapenv:Body>

</soapenv:Envelope>
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Example Response

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/">

   <soapenv:Body>

      <appendToHeaderFooter>

         <result>true</result>

      </appendToHeaderFooter>

   </soapenv:Body>

</soapenv:Envelope>

Adding Header and Footer Text with Document 
Protection
This API allows you to add header and footer text in a document. In FX1 documents, the 
document protection levels are reset when the header and footer are added. This API 
retains protection levels for FX1 documents.

API Signature

appendToHeaderFooter2 webService static Boolean appendToHeaderFooter2(Id 
docId, String headerText, String footerText, String pLevel, 
String sessionId, String serverUrl)

Request Parameters

Name Type Description Required?

docId ID The id of the document which will 
have header and/or footer content 
add to it.

Yes

headerText String The header text to append to the 
document.

Yes

footerText String The footer text to append to the 
document.

Yes
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•
•
•

•
•

Request Parameters

Name Type Description Required?

pLevel String The protection level to apply to the 
document. Valid values are:

Full access
Insert comments only
Insert comments and tracked 
changes only
Read only
Fill in form fields only

Yes

sessionId String The Salesforce session id. Yes

serverUrl String The Salesforce server Url. Yes

Response Parameter

Name Type Description

result Boolean Indicates whether the header and footer were 
added successfully.

Code Sample

ID docId = 'a0Y61000002K6IR';

String headerText = 'Agreement Id: 0123456789';

String footerText = 'Date Created: 11/27/2018 7:23:15 PM';

String pLevel = 'Full access';

String sessionId = sessionId; //This is the session Id.

String serverUrl = System.Url.getSalesforceBaseUrl().toExternalForm() + '/services/ 

Soap/u/50.0/' + UserInfo.getOrganizationId();

Boolean result = Apttus.MergeWebService.appendToHeaderFooter2(docId, headerText, 

footerText, pLevel, sessionId, serverUrl);
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Integration Details
Use the following information in your integrations with Apttus Contract Management Web 
Services API. For information on how to get started, refer to Integrating Conga CLM with 
External Systems.

API Prerequisites
None.

Request/Response XML

Example Request

<soapenv:Envelope

    xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/"

    xmlns:mer="http://soap.sforce.com/schemas/class/Apttus/MergeWebService">

    <soapenv:Header>

        <mer:sessionId>00D020000008lUh! 

AQYAQBDMUfqKvlqcVtqEnsqWZ3CvH_9PAn553rGgepU1CKttbRUAm4C8FFgTHrzkd6juez5FF4NEryvZ8ibJC 

__d7TM.vxCY</mer:sessionId>

    </soapenv:Header>

    <soapenv:Body>

        <mer:appendToHeaderFooter2>

            <mer:docId>a0Z61000052AFIR</mer:docId>

            <mer:headerText>Company</mer:headerText>

            <mer:footerText>Copyright</mer:footerText>

            <mer:pLevel>Full Access</mer:pLevel>

            <mer:sessionId>00D020000008lUh! 

AQYAQBDMUfqKvlqcVtqEnsqWZ3CvH_9PAn553rGgepU1CKttbRUAm4C8FFgTHrzkd6juez5FF4NEryvZ8ibJC 

__d7TM.vxCY</mer:sessionId>

            <mer:serverUrl>https://testmanaged--5s20minor.my.salesforce.com/services/ 

Soap/u/50.0/00D020000008lUh</mer:serverUrl>

        </mer:appendToHeaderFooter2>

    </soapenv:Body>

</soapenv:Envelope>
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Example Response

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/">

   <soapenv:Body>

      <appendToHeaderFooter2>

         <result>true</result>

      </appendToHeaderFooter2>

   </soapenv:Body>

</soapenv:Envelope>

Applying Security Parameters to a PDF
This API applies Adobe PDF security parameters to the PDF document. Ensure that you have 
set an admin entry with the PDFSecurityDefault tags. For more information, see CLM for 
Administrators.

TheapplyPDFSecurity()function provides a great way to handle document security. Using this 
function is fairly complex, and what we want is a simple way to quickly apply security. The 
function provides us with just such an option. The actual parameters in the policy could be 
 docId,session Id,serverUrland so on. This API controls the security properties of a PDF 
document, such as Content Copying, Filling of form fields, and Printing. 
 

API Signature

applyPDFSecurity webService static Boolean applyPDFSecurity(Id docId, String 
sessionId, String serverUrl)

 
 

Request Parameters

Name Type Description Required?

docId ID The id of the PDF document to apply 
security parameters to.

Yes

session Id String The Salesforce session id. Yes

serverUrl String The Salesforce server Url. Yes
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Response Parameter

Name Type Description

result Boolean Indicates if the security parameters were applied 
successfully to the PDF.

 

Code Sample 

Integration Details
Use the following information in your integrations with Apttus Contract Management Web 
Services API. For information on how to get started, refer to Integrating Conga CLM with 
External Systems.

API Prerequisites
None.

Request/Response XML

Example Request

<soapenv:Envelope

    xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/"

    xmlns:mer="http://soap.sforce.com/schemas/class/Apttus/MergeWebService">

ID docId = 'a0Y61000002K6IR';1
String sessionId = sessionId; //This is the session Id.2
String serverUrl = System.Url.getSalesforceBaseUrl().toExternalForm() + '/ 

services/Soap/u/50.0/' + UserInfo.getOrganizationId();

3

Boolean result = 

Apttus.MergeWebService.applyPDFSecurity(docId,sessionId,serverUrl);

4
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    <soapenv:Header>

        <mer:sessionId>00D020000008lUh! 

AQYAQBDMUfqKvlqcVtqEnsqWZ3CvH_9PAn553rGgepU1CKttbRUAm4C8FFgTHrzkd6juez5FF4NEryvZ8ibJC 

__d7TM.vxCY</mer:sessionId>

    </soapenv:Header>

    <soapenv:Body>

        <mer:applyPDFSecurity>

            <mer:docId>068R0000001Z56SIAS</mer:docId>

            <mer:sessionId>00D020000008lUh! 

AQYAQBDMUfqKvlqcVtqEnsqWZ3CvH_9PAn553rGgepU1CKttbRUAm4C8FFgTHrzkd6juez5FF4NEryvZ8ibJC 

__d7TM.vxCY</mer:sessionId>

            <mer:serverUrl>https://testmanaged--5s20minor.my.salesforce.com/services/ 

Soap/u/50.0/00D020000008lUh</mer:serverUrl>

        </mer:applyPDFSecurity>

    </soapenv:Body>

</soapenv:Envelope>

Example Response

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/">

   <soapenv:Body>

      <applyPDFSecurity>

         <result>true</result>

      </applyPDFSecurity>

   </soapenv:Body>

</soapenv:Envelope>

Converting a Word Document into a given output 
format
This API converts an agreement Word document, specified in docFileName into a specific 
output format using the parameters, such as agreementId and docFormat. This API 
internally checks if the header and footer are added to the generated document.

•

•

Note

If the output document format is DOC or DOCX, the Id returned is that of the 
updated input document.
If the output document format is PDF, the Id returned is that of the newly 
created document.
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•
•
•
•

•
•
•

•
•

API Signature

convertWordDocForAgreement webService static Id convertWordDocForAgreement(Id 
agreementId, Id docId, String docFileName, String 
docFormat, String pLevel, Boolean addWatermark, Boolean 
removeWatermark, String sessionId, String serverUrl)

Request Parameters

Name Type Description Required?

agreementId ID The id of the agreement providing the 
content of the document.

Yes

docId ID The id of the agreement document to 
convert in a different output format.

Yes

docFileName String The file name for the Word document. Yes

docFormat String Indicates whether the document will 
be:

DOC
DOCX
RTF
PDF

Yes

pLevel String The protection level to apply to the 
document. Valid values are:

Full access
Insert comments only
Insert comments and tracked 
changes only
Read only
Fill in form fields only

Yes

addWatermark Boolean Indicates whether a draft watermark 
should be added to the output 
document.

Yes
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Request Parameters

Name Type Description Required?

removeWatermark Boolean Indicates whether a draft watermark 
on the source word document should 
be removed from the resulting 
document.

Yes

sessionId String The Salesforce session id. Yes

serverUrl String The Salesforce server URL. Yes

Response Parameter

Name Type Description

docId ID The id of the converted document.

Code Sample

String apiServerURL = System.Url.getSalesforceBaseUrl().toExternalForm() + '/ 

services/Soap/u/50.0/' + UserInfo.getOrganizationId();

ID attachmentID = 'a036F00000urlTX';

Id agreementId = 'a016F00001V5HZA';

String pLevel = 'Read only';

String docFormat = 'PDF';

Boolean addWatermark = true;

Boolean removeWatermark = true;

ID docId = 

Apttus.MergeWebService.convertWordDocForAgreement(agreementId,attachmentID,null 

,docFormat,pLevel,addWatermark,removeWatermark,ServerInfo.getSessionId(),apiServerURL 

);

Integration Details
Use the following information in your integrations with Apttus Contract Management Web 
Services API. For information on how to get started, refer to Integrating Conga CLM with 
External Systems.
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API Prerequisites
None.

Request/Response XML

Example Request

<soapenv:Envelope

    xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/"

    xmlns:mer="http://soap.sforce.com/schemas/class/Apttus/MergeWebService">

    <soapenv:Header>

        <mer:SessionHeader>

            <mer:sessionId>00D020000008lUh! 

AQYAQBDMUfqKvlqcVtqEnsqWZ3CvH_9PAn553rGgepU1CKttbRUAm4C8FFgTHrzkd6juez5FF4NEryvZ8ibJC 

__d7TM.vxCY</mer:sessionId>

        </mer:SessionHeader>

    </soapenv:Header>

    <soapenv:Body>

        <mer:convertAgreementWordDoc>

            <mer:agreementId>a07R000000AwP93IAF</mer:agreementId>

            <mer:docId>a20R00000025o1FIAQ</mer:docId>

            <mer:docFileName>MS-Original_TemplateWithOrgClause</mer:docFileName>

            <mer:docFormat>PDF</mer:docFormat>

            <mer:pLevel>Insert comments only</mer:pLevel>

            <mer:addWatermark>True</mer:addWatermark>

            <mer:removeWatermark>False</mer:removeWatermark>

            <mer:agreementNbr>00026745.0</mer:agreementNbr>

            <mer:dateFormat>YYYY-MM-DD</mer:dateFormat>

            <mer:sessionId>00D020000008lUh! 

AQYAQBDMUfqKvlqcVtqEnsqWZ3CvH_9PAn553rGgepU1CKttbRUAm4C8FFgTHrzkd6juez5FF4NEryvZ8ibJC 

__d7TM.vxCY</mer:sessionId>

            <mer:serverUrl>https://testmanaged--5s20minor.my.salesforce.com/services/ 

Soap/u/50.0/00D020000008lUh</mer:serverUrl>

        </mer:convertAgreementWordDoc>

    </soapenv:Body>

</soapenv:Envelope>
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Example Response

<soapenv:Envelope

    xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/">

    <soapenv:Body>

        <convertAgreementWordDoc>

            <result>a070S000002aDcuQAE</result>

        </convertAgreementWordDoc>

    </soapenv:Body>

</soapenv:Envelope>

Converting a Word Document into a given output 
format (Deprecated)
This API converts an agreement Word document into a specific output format using the 
parameters, such as agreementId and docFormat. This API is deprecated. 
 

 

API Signature

convertAgreementWordDoc webService static Id convertAgreementWordDoc(Id 
agreementId, Id docId, String docFileName, String docFormat, 
String pLevel, Boolean addWatermark, Boolean 
removeWatermark, String agreementNbr, String dateFormat, 
String sessionId, String serverUrl)

Request Parameters

Name Type Description Required?

agreementId ID The id of the agreement providing the 
content for the document.

Yes

docId ID The id of the agreement document to 
convert in a different output format.

Yes

docFileName String The file name for the Word document. Yes
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•
•
•

•
•
•

•
•

Request Parameters

Name Type Description Required?

docFormat String Indicates whether the document will 
be:

DOC
DOCX
RTF

Yes

pLevel String The protection level to apply to the 
document. Valid values are:

Full access
Insert comments only
Insert comments and tracked 
changes only
Read only
Fill in form fields only

Yes

addWatermark Boolean Indicates whether a draft watermark 
should be added to the output 
document.

Yes

removeWatermark Boolean Indicates whether a draft watermark 
on the source word document should 
be removed from the resulting 
document.

Yes

agreementNbr String The agreement number of the 
document, upserted in the header.

Yes

dateFormat String The date format for the footer of the 
document.

Yes

sessionId String The Salesforce session id. Yes

serverUrl String The Salesforce server URL. Yes
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Response Parameter

Name Type Description

result ID The id of the converted document.

 
Code Sample

Converting a Word Document into a given output 
format for Standard Object (Deprecated)
For any standard object, this API converts a generated Word document into a specific 
output format, specified in docFormat using the parameters, such as, docId, docFileName. 
This API is deprecated.

 

ID agreementId = 'a016100000Che3D';1
ID docId = 'a0Y61000002K6IR';2
String docFileName = 'Agreement';3
String docFormat = 'PDF';4
String pLevel = 'Full access';5
Boolean addWatermark = true;6
Boolean removeWatermark = false;7
String agreementNbr = '1234';8
String dateFormat = 'M/d/yyyy HH:mm:ss';9
String sessionId = sessionId; //This is the session Id.10
String serverUrl = System.Url.getSalesforceBaseUrl().toExternalForm() + '/ 

services/Soap/u/50.0/' + UserInfo.getOrganizationId();

11

ID ConvertedDocId = 

Apttus.MergeWebService.convertAgreementWordDoc(agreementId,docId,docFileNa 

me,docFormat,pLevel,addWatermark,removeWatermark,agreementNbr,dateFormat,s 

essionId,serverUrl);

12
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•
•
•

•
•
•

•
•

API Signature

convertWordDoc webService static Id convertWordDoc(Id docId, String 
docFileName, String docFormat, Id sObjectId, String pLevel, 
Boolean addWatermark, Boolean removeWatermark, String 
headerText, String footerText, String sessionId, String serverUrl)

 
 

Request Parameters

Name Type Description Required?

docId ID The id of the agreement document to 
be converted in a different output 
format.

Yes

docFileName String The file name for the Word document. Yes

docFormat String Indicates whether the document will 
be:

DOC
DOCX
RTF

Yes

sObjectId ID The sObject id for which you want to 
update the document.

Yes

pLevel String The protection level to apply to the 
document. Valid values are:

Full access
Insert comments only
Insert comments and tracked 
changes only
Read only
Fill in form fields only

Yes
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Request Parameters

Name Type Description Required?

addWatermark Boolean Indicates whether a draft watermark 
should be added to the output 
document.

Yes

removeWatermark Boolean Indicates whether a draft watermark 
on the source word document should 
be removed from the resulting 
document.

Yes

headerText String The header text to be appended to the 
document.

Yes

footerText String The footer text to be appended to the 
document.

Yes

sessionId String The Salesforce session id. Yes

serverUrl String The Salesforce server URL. Yes

 

 

Response Parameter

Name Type Description

result ID The id of the converted document.

 
Code Sample

ID docId = 'a0Y61000002K6IR';1
String docFileName = 'Agreement';2
String docFormat = 'PDF';3
ID sObjectId = '0016100000KvBHi';4
String pLevel = 'Full access';5
Boolean addWatermark = true;6
Boolean removeWatermark = false;7
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Converting a Word Document into a PDF
This converts a Word document into a PDF document. It can be any Word document and 
does not have to be created using generateDoc or generateSupportingDoc. The protection 
level applicable to the Word document is not applicable to the PDF document.

 

API Signature

convertWordDocToPDF webService static Id convertWordDocToPDF(Id docId, String 
docFileName, Boolean addWatermark, Boolean 
removeWatermark, String headerText, String footerText, 
String sessionId, String serverUrl)

Request Parameters

Name Type Description Required?

docId ID The id of the word document to be 
converted to PDF.

Yes

docFileName String The filename for the newly created 
PDF.

Yes

addWatermark Boolean Indicates whether a draft watermark 
should be added to the PDF.

Yes

String headerText = 'Agreement Id: 0123456789';8
String footerText = 'Date Created: 11/27/2018 7:23:15 PM';9
String sessionId = sessionId; //This is the session Id.10
String serverUrl = System.Url.getSalesforceBaseUrl().toExternalForm() + '/ 

services/Soap/u/50.0/' + UserInfo.getOrganizationId();

11

 12
ID ConvertedDocId= 

Apttus.MergeSupport.convertWordDoc(docId,docFileName,docFormat,sObjectId,p 

Level,addWatermark,removeWatermark,headerText,footerText,sessionId,serverU 

rl) ; 

13
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Request Parameters

Name Type Description Required?

removeWatermark Boolean Indicates whether a draft watermark 
on the source word document should 
be removed from the resulting PDF.

Yes

headerText String The header text to append to the 
document.

Yes

footerText String The footer text to append to the 
document.

Yes

sessionId String The Salesforce session id. Yes

serverUrl String The Salesforce server URL. Yes

Response Parameter

Name Type Description

result ID The id of the generated document.

Code Sample

Id docId = attachmentId;

String filename = 'newPDFFile.pdf';

Boolean addWatermark = 'true';

Boolean removeWatermark = 'false';

String headerText = 'This is Header';

String footerText = 'This is Footer';

String apiServerURL = System.Url.getSalesforceBaseUrl().toExternalForm() + '/ 

services/Soap/u/50.0/' + UserInfo.getOrganizationId();

String SessionId = sessionId;  

Id convertedDocId = Apttus.MergeWebService.convertWordDocToPDF(docId, fileName,

addWatermark, removeWatermark, headerText, footerText, apiSessionId, apiServerURL);
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Integration Details
Use the following information in your integrations with Apttus Contract Management Web 
Services API. For information on how to get started, refer to Integrating Conga CLM with 
External Systems.

API Prerequisites
None.

Request/Response XML

Example Request

<soapenv:Envelope

    xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/"

    xmlns:mer="http://soap.sforce.com/schemas/class/Apttus/MergeWebService">

    <soapenv:Header>

        <mer:SessionHeader>

            <mer:sessionId>00D020000008lUh! 

AQYAQBDMUfqKvlqcVtqEnsqWZ3CvH_9PAn553rGgepU1CKttbRUAm4C8FFgTHrzkd6juez5FF4NEryvZ8ibJC 

__d7TM.vxCY</mer:sessionId>

        </mer:SessionHeader>

    </soapenv:Header>

    <soapenv:Body>

        <mer:convertWordDocToPDF>

            <mer:docId>068R0000001Z56SIAS</mer:docId>

            <mer:docFileName>MSA</mer:docFileName>

            <mer:addWatermark>True</mer:addWatermark>

            <mer:removeWatermark>False</mer:removeWatermark>

            <mer:headerText>Company</mer:headerText>

            <mer:footerText>Copyright 2020</mer:footerText>

            <mer:sessionId>00D020000008lUh! 

AQYAQBDMUfqKvlqcVtqEnsqWZ3CvH_9PAn553rGgepU1CKttbRUAm4C8FFgTHrzkd6juez5FF4NEryvZ8ibJC 

__d7TM.vxCY</mer:sessionId>

            <mer:serverUrl>https://testmanaged--5s20minor.my.salesforce.com/services/ 

Soap/u/50.0/00D020000008lUh</mer:serverUrl>

        </mer:convertWordDocToPDF>

    </soapenv:Body>

</soapenv:Envelope>
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Example Response

<soapenv:Envelope

    xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/">

    <soapenv:Body>

        <convertWordDocToPDF>

            <result>a070S000002aDcuQAE</result>

        </convertWordDocToPDF>

    </soapenv:Body>

</soapenv:Envelope>

Converting a Word Document into a PDF for Standard 
Objects
This converts a Word document into a PDF document for a standard object. It can be any 
Word document and does not have to be created using generateDoc or 
generateSupportingDoc. The protection level applicable to the Word document is not 
applicable to the PDF document.

 

API Signature

convertWordDocToPDF2 webService static Id convertWordDocToPDF2(Id docId, String 
docFileName, Id sObjectId, String pLevel, Boolean 
addWatermark, Boolean removeWatermark, String 
headerText, String footerText, String sessionId, String 
serverUrl)

Request Parameters

Name Type Description Required?

docId ID The id of the word document to be 
converted to PDF.

Yes

docFileName String The filename for the newly created 
PDF.

Yes

sObjectId Id The id of the standard object. Yes
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•
•
•

•
•

Request Parameters

Name Type Description Required?

pLevel String The protection level to apply to the 
document. Valid values are:

Full access
Insert comments only
Insert comments and tracked 
changes only
Read only
Fill in form fields only

Yes

addWatermark Boolean Indicates whether a draft watermark 
should be added to the PDF.

Yes

removeWatermark Boolean Indicates whether a draft watermark 
on the source word document should 
be removed from the resulting PDF.

Yes

headerText String The header text to append to the 
document.

Yes

footerText String The footer text to append to the 
document.

Yes

sessionId String The Salesforce session id. Yes

serverUrl String The Salesforce server URL. Yes

 

 

Response Parameter

Name Type Description

result ID The id of the generated document.
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Code Sample

Integration Details
Use the following information in your integrations with Apttus Contract Management Web 
Services API. For information on how to get started, refer to Integrating Conga CLM with 
External Systems.

API Prerequisites
None.

Request/Response XML

Example Request

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:mer=" 

http://soap.sforce.com/schemas/class/Apttus/MergeWebService">

   <soapenv:Header>

          <mer:SessionHeader>

ID docId = 'a0Y61000002K6IR';1
String docFileName = 'Agreement';2
ID sObjectId = null;3
String pLevel = null;4
Boolean addWatermark = true;5
Boolean removeWatermark = false;6
String headerText = 'Agreement Id: 0123456789';7
String footerText = 'Date Created: 11/27/2018 7:23:15 PM';8
String sessionId = sessionId; //This is the session Id.9
String serverUrl = System.Url.getSalesforceBaseUrl().toExternalForm() + '/ 

services/Soap/u/50.0/' + UserInfo.getOrganizationId();

10

 11
ID ConvertedDocId = 

Apttus.MergeWebService.convertWordDocToPDF2(docId,docFileName,sObjectId,pL 

evel,addWatermark,removeWatermark,headerText,footerText,sessionId,serverUr 

l);

12
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         <mer:sessionId>00D020000008lUh! 

AQYAQPYE.vw_Vh7FI.cV871nm9WWqIdhVINQJIl7PDNzr3fLVNdGjwk9qTJbDYIRoxbfpa44bpuIyeyVxEepP 

xdubr_AWjOv</mer:sessionId>

      </mer:SessionHeader>

   </soapenv:Header>

   <soapenv:Body>

      <mer:convertWordDocToPDF2>

         <mer:docId>00P02000000IY8p</mer:docId>

         <mer:docFileName>MS-NDA-Regenerated_TemplateWithOrgClause_ct__.docx</mer:doc 

FileName>

         <mer:sObjectId>a07020000008w91</mer:sObjectId>

         <mer:pLevel>Full Access</mer:pLevel>

         <mer:addWatermark>False</mer:addWatermark>

         <mer:removeWatermark>False</mer:removeWatermark>

         <mer:headerText>Company</mer:headerText>

         <mer:footerText>Copyright 2020</mer:footerText>

        <mer:sessionId>00D020000008lUh! 

AQYAQPYE.vw_Vh7FI.cV871nm9WWqIdhVINQJIl7PDNzr3fLVNdGjwk9qTJbDYIRoxbfpa44bpuIyeyVxEepP 

xdubr_AWjOv</mer:sessionId>

         <mer:serverUrl>https://testmanaged--5s20minor.my.salesforce.com/services/ 

Soap/u/50.0/00D020000008lUh</mer:serverUrl>

      </mer:convertWordDocToPDF2>

   </soapenv:Body>

</soapenv:Envelope>

Example Response

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns="ht 

tp://soap.sforce.com/schemas/class/Apttus/MergeWebService">

   <soapenv:Body>

      <convertWordDocToPDF2Response>

         <result>00P02000000IayZEAS</result>

      </convertWordDocToPDF2Response>

   </soapenv:Body>

</soapenv:Envelope>

Enabling Authoring for Agreement Documents
This API enables redlining capability for a list of documents, specified in the docIds, by using 
the parameters, such as sObjectID and pLevel.
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•
•
•

•
•

 

API Signature

enableAuthoring webService static Boolean enableAuthoring(Id sObjectId, 
String pLevel, List docIds, String sessionId, String serverUrl)

 

 

Request Parameters

Name Type Description Required?

sObjectId ID The ID of the standard object for which 
authoring is to be enabled.

Yes

pLevel String The protection level to apply to the 
document. Valid values are

Full access
Insert comments only
Insert comments and tracked 
changes only
Read only
Fill in form fields only

Yes

docIds List The ids of the documents for which you 
want to enable authoring. If the value is 
null, all the documents associated with the 
sObject are enabled. You can list comma 
separated docIds.

Yes

sessionId String The Salesforce session id. Yes

serverUrl String The Salesforce server id. Yes
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Response Parameter

Name Type Description

result Boolean Indicates if the authoring was enabled successfully 
for the listed documents.

 

Code Sample

Integration Details
Use the following information in your integrations with Apttus Contract Management Web 
Services API. For information on how to get started, refer to Integrating Conga CLM with 
External Systems.

API Prerequisites
None.

Request/Response XML

Example Request

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:mer=" 

http://soap.sforce.com/schemas/class/Apttus/MergeWebService">

ID sObjectId = 'a016100000Che3D';1
String pLevel = 'Full access';2
ID[] docIds = new ID[]3
{'a0Y61000002K6IR','a0Y61000003K7jR'};4
String sessionId = sessionId; //This is the session Id.5
String serverUrl = System.Url.getSalesforceBaseUrl().toExternalForm() + '/ 

services/Soap/u/50.0/' + UserInfo.getOrganizationId();

6

 7
Boolean success = 

Apttus.MergeWebService.enableAuthoring(sObjectId,pLevel,docIds,sessionId,s 

erverUrl);

8
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   <soapenv:Header>

           <mer:SessionHeader>

         <mer:sessionId>00D020000008lUh! 

AQYAQPYE.vw_Vh7FI.cV871nm9WWqIdhVINQJIl7PDNzr3fLVNdGjwk9qTJbDYIRoxbfpa44bpuIyeyVxEepP 

xdubr_AWjOv</mer:sessionId>

      </mer:SessionHeader>

   </soapenv:Header>

   <soapenv:Body>

      <mer:enableAuthoring>

         <mer:sObjectId>a07020000008w91</mer:sObjectId>

         <mer:pLevel>Full Access</mer:pLevel>

          <mer:docIds>00P02000000IY8Q</mer:docIds>

          <mer:docIds>00P02000000IY8p</mer:docIds>

         <mer:sessionId>00D020000008lUh! 

AQYAQPYE.vw_Vh7FI.cV871nm9WWqIdhVINQJIl7PDNzr3fLVNdGjwk9qTJbDYIRoxbfpa44bpuIyeyVxEepP 

xdubr_AWjOv</mer:sessionId>

         <mer:serverUrl>https://testmanaged--5s20minor.my.salesforce.com/services/ 

Soap/u/50.0/00D020000008lUh</mer:serverUrl>

      </mer:enableAuthoring>

   </soapenv:Body>

</soapenv:Envelope>

Example Response

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns="ht 

tp://soap.sforce.com/schemas/class/Apttus/MergeWebService">

   <soapenv:Body>

      <enableAuthoringResponse>

         <result>true</result>

      </enableAuthoringResponse>

   </soapenv:Body>

</soapenv:Envelope>

Generating a Document
Generates a Word agreement document by using the template specified by the templateId 
parameter and the agreement indicated by the agreementId. The document is added to the 
Files and Attachments section for the Agreement object.

The document can subsequently be converted to a PDF, using convertWordDocToPDF.
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API Signature

generateDoc webService static Id generateDoc(Id templateId, Id agreementId, 
String pLevel, String docFormat, String sessionId, String serverUrl)

 

 

Request Parameters

Name Type Description Required?

templateId ID The id of the template used to 
generate the word document.

Yes

agreementId ID The id of the agreement providing the 
content for the document.

Yes

pLevel String The protection level to apply to the 
document. Valid values are:

Full access
Insert comments only
Insert comments and tracked 
changes only
Read only
Fill in form fields only

Yes

docFormat String Indicates whether the document will 
be:

DOC
DOCX
PDF
RTF

Yes

sessionId String The Salesforce session id. Yes

serverUrl String The Salesforce server id. Yes
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Response Parameter

Name Type Description

generatedDocId ID The id of the generated document.

 

Code Sample 

This API is the same as the generateDoc API and additionally enables you to add a draft 
watermark to the generated document.

API Signature

generateDoc2 webService static Id generateDoc2(Id templateId, Id 
agreementId, String pLevel, String docFormat, Boolean isDraft, 
String sessionId, String serverUrl)

 

 

Request Parameters

Name Type Description Required?

templateId ID The id of the template used to 
generate the word doc.

Yes

agreementId ID The id of the agreement providing the 
content for the document.

Yes

ID templateId= 'a036F00000urlTX';1
Id agreementId = 'a016F00001V5HZA';2
String pLevel = 'Read only';3
String docFormat = 'DOC';4
String apiServerURL = System.Url.getSalesforceBaseUrl().toExternalForm() + 

'/services/Soap/u/50.0/' + UserInfo.getOrganizationId();

5

String SessionId = UserInfo.getSessionId();  //This is the session Id.6
String generatedDocId = Apttus.MergeWebService.generateDoc(templateId, 

agreementId, pLevel, docFormat, SessionId, apiServerURL);

7
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Request Parameters

Name Type Description Required?

pLevel String The protection level to apply to the 
document. Valid values are:

Full access
Insert comments only
Insert comments and tracked 
changes only
Read only
Fill in form fields only

Yes

docFormat String Indicates whether the document will 
be:

DOC
DOCX
PDF
RTF

Yes

isDraft Boolean Indicates whether a draft watermark 
should be added to the document.

Yes

sessionId String The Salesforce session id. Yes

serverUrl String The Salesforce server id. Yes

 

 

Response Parameter

Name Type Description

generatedDocId ID The id of the generated document.

 

Code Sample
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Integration Details
Use the following information in your integrations with Apttus Contract Management Web 
Services API. For information on how to get started, refer to Integrating Conga CLM with 
External Systems.

API Prerequisites
None.

Request/Response XML

Example Request

<?xml version="1.0" encoding="UTF-8"?>

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:mer=" 

http://soap.sforce.com/schemas/class/Apttus/MergeWebService">

   <soapenv:Header>

      <mer:SessionHeader>

         <mer:sessionId>00D020000008lUh! 

AQYAQPYE.vw_Vh7FI.cV871nm9WWqIdhVINQJIl7PDNzr3fLVNdGjwk9qTJbDYIRoxbfpa44bpuIyeyVxEepP 

xdubr_AWjOv</mer:sessionId>

      </mer:SessionHeader>

   </soapenv:Header>

   <soapenv:Body>

      <mer:generateDoc>

         <mer:templateId>a09R000000AjMCy</mer:templateId>

         <mer:agreementId>a07020000008w91</mer:agreementId>

         <mer:pLevel>Full Access</mer:pLevel>

         <mer:docFormat>DOCX</mer:docFormat>

ID templateId= 'a036F00000urlTX';1
Id agreementId = 'a016F00001V5K6C';2
String pLevel = 'Read only';3
String docFormat = 'DOC';4
Boolean isDraft = true;5
String apiServerURL = System.Url.getSalesforceBaseUrl().toExternalForm() + 

'/services/Soap/u/50.0/' + UserInfo.getOrganizationId();

6

String SessionId = UserInfo.getSessionId();  //This is the session Id.7
String generatedDocId = Apttus.MergeWebService.generateDoc2(templateId, 

agreementId, pLevel, docFormat, isDraft, SessionId, apiServerURL);

8
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         <mer:sessionId>00D020000008lUh! 

AQYAQPYE.vw_Vh7FI.cV871nm9WWqIdhVINQJIl7PDNzr3fLVNdGjwk9qTJbDYIRoxbfpa44bpuIyeyVxEepP 

xdubr_AWjOv</mer:sessionId>

         <mer:serverUrl>https://testmanaged--5s20minor.my.salesforce.com/services/ 

Soap/u/50.0/00D020000008lUh</mer:serverUrl>

      </mer:generateDoc>

   </soapenv:Body>

</soapenv:Envelope>

Example Response

<?xml version="1.0" encoding="UTF-8"?>

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns="ht 

tp://soap.sforce.com/schemas/class/Apttus/MergeWebService">

   <soapenv:Body>

      <generateDocResponse>

         <result>00P02000000IazXEAS</result>

      </generateDocResponse>

   </soapenv:Body>

</soapenv:Envelope>

Generating a Document for a Standard Object
This API generates a Word agreement document for a standard object, using the template 
selected by the templateId parameter and the object indicated by sObjectId and 
sObjectType.

 

API Signature

generateCustomDoc webService static Id generateCustomDoc(Id templateId, Id 
sObjectId, String sObjectType, String pLevel, String 
docFormat, Boolean isDraft, String sessionId, String serverUrl)
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Request Parameters

Name Type Description Required?

templateId ID The id of the template used to 
generate the word doc.

Yes

sObjectId ID The id of the sObject holding the 
data for the merge fields.

Yes

sObjectType String The type of the sObject. Yes

pLevel String The protection level to apply to the 
document. Valid values are:

Full access
Insert comments only
Insert comments and tracked 
changes only
Read only
Fill in form fields only

Yes

docFormat String Indicates whether the document will 
be:

DOC
DOCX
PDF
RTF

Yes

isDraft Boolean Indicates whether a draft watermark 
should be added to the document.

Yes

sessionId String The Salesforce session id. Yes

serverUrl String The Salesforce server id. Yes

Response Parameter

Name Type Description

docID ID The id of the generated document.
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Code Sample

ID templateId = 'a036100000Fha5D';

ID sObjectId = '0016100000KvBHi';

String sObjectType = 'Account';

String pLevel = 'Full access';

String docFormat = 'DOCX';

Boolean isDraft = true;

String sessionId = UserInfo.getSessionId(); 

String serverUrl = System.Url.getSalesforceBaseUrl().toExternalForm() + '/services/ 

Soap/u/50.0/' + UserInfo.getOrganizationId();

ID docId =  

Apttus.MergeWebService.generateCustomDoc(templateId,sObjectId,sObjectType,pLevel,docF 

ormat,isDraft,sessionId,serverUrl);

Integration Details
Use the following information in your integrations with Apttus Contract Management Web 
Services API. For information on how to get started, refer to Integrating Conga CLM with 
External Systems.

API Prerequisites
None.

Request/Response XML

Example Request

<?xml version="1.0" encoding="UTF-8"?>

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:mer=" 

http://soap.sforce.com/schemas/class/Apttus/MergeWebService">

   <soapenv:Header>

      <mer:SessionHeader>

         <mer:sessionId>00D020000008lUh! 

AQYAQPYE.vw_Vh7FI.cV871nm9WWqIdhVINQJIl7PDNzr3fLVNdGjwk9qTJbDYIRoxbfpa44bpuIyeyVxEepP 

xdubr_AWjOv</mer:sessionId>

      </mer:SessionHeader>

   </soapenv:Header>
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   <soapenv:Body>

      <mer:generateCustomDoc>

         <mer:templateId>a09R000000AjMCy</mer:templateId>

         <mer:sObjectId>0015500000YAdXR</mer:sObjectId>

         <mer:sObjectType>Account</mer:sObjectType>

         <mer:pLevel>Read only</mer:pLevel>

         <mer:docFormat>PDF</mer:docFormat>

         <mer:isDraft>True</mer:isDraft>

         <mer:sessionId>00D020000008lUh! 

AQYAQPYE.vw_Vh7FI.cV871nm9WWqIdhVINQJIl7PDNzr3fLVNdGjwk9qTJbDYIRoxbfpa44bpuIyeyVxEepP 

xdubr_AWjOv</mer:sessionId>

         <mer:serverUrl>https://testmanaged--5s20minor.my.salesforce.com/services/ 

Soap/u/50.0/00D020000008lUh</mer:serverUrl>

      </mer:generateCustomDoc>

   </soapenv:Body>

</soapenv:Envelope>

Example Response

<?xml version="1.0" encoding="UTF-8"?>

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns="ht 

tp://soap.sforce.com/schemas/class/Apttus/MergeWebService">

   <soapenv:Body>

      <generateCustomDocResponse>

         <result>00P02000000IazhEAC</result>

      </generateCustomDocResponse>

   </soapenv:Body>

</soapenv:Envelope>

Generating a Document on Submit Request
This API submits the generate document action using the given template from templateId 
and agreement from agreementId. The output format of the generated document is of the 
type specified in the docFormat parameter.

 

API Signature

submitGenerateDoc webService static Id submitGenerateDoc(Id templateId, Id 
agreementId, String pLevel, String docFormat, Boolean 
isDraft, String sessionId, String serverUrl)
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Request Parameters

Name Type Description Required?

templateId ID The id of the template used to 
generate the word doc.

Yes

agreementId ID The id of the agreement providing the 
content for the document.

Yes

pLevel String The protection level to apply to the 
document. Valid values are:

Full access
Insert comments only
Insert comments and tracked 
changes only
Read only
Fill in form fields only

Yes

docFormat String Indicates whether the document will 
be:

DOC
DOCX
PDF
RTF

Yes

isDraft Boolean Indicates whether a draft watermark 
should be added to the document.

Yes

sessionId String The Salesforce session id. Yes

serverUrl String The Salesforce server id. Yes
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Response Parameter

Name Type Description

result ID The id of the generated document.

 

Code Sample

Integration Details
Use the following information in your integrations with Apttus Contract Management Web 
Services API. For information on how to get started, refer to Integrating Conga CLM with 
External Systems.

API Prerequisites
None.

Request/Response XML

Example Request

<?xml version="1.0" encoding="UTF-8"?>

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:mer=" 

http://soap.sforce.com/schemas/class/Apttus/MergeWebService">

ID templateId = 'a036100000Fha5D';1
ID agreementId = 'a016100000Che3D';2
String pLevel = 'Full access';3
String docFormat = 'DOC';4
Boolean isDraft = false;5
String sessionId = sessionId; //This is the session Id.6
String serverUrl = System.Url.getSalesforceBaseUrl().toExternalForm() + '/ 

services/Soap/u/50.0/' + UserInfo.getOrganizationId();

7

 8
ID callId = 

Apttus.MergeWebService.submitGenerateDoc(templateId,agreementId,pLevel,doc 

Format,isDraft,sessionId,serverUrl); 

9
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   <soapenv:Header>

      <mer:SessionHeader>

         <mer:sessionId>00D020000008lUh! 

AQYAQPYE.vw_Vh7FI.cV871nm9WWqIdhVINQJIl7PDNzr3fLVNdGjwk9qTJbDYIRoxbfpa44bpuIyeyVxEepP 

xdubr_AWjOv</mer:sessionId>

      </mer:SessionHeader>

   </soapenv:Header>

   <soapenv:Body>

      <mer:submitGenerateDoc>

         <mer:templateId>a09R000000AjMCy</mer:templateId>

         <mer:agreementId>a07020000008w91</mer:agreementId>

         <mer:pLevel>Insert comments only</mer:pLevel>

         <mer:docFormat>DOC</mer:docFormat>

         <mer:isDraft>False</mer:isDraft>

         <mer:sessionId>00D020000008lUh! 

AQYAQPYE.vw_Vh7FI.cV871nm9WWqIdhVINQJIl7PDNzr3fLVNdGjwk9qTJbDYIRoxbfpa44bpuIyeyVxEepP 

xdubr_AWjOv</mer:sessionId>

         <mer:serverUrl>https://testmanaged--5s20minor.my.salesforce.com/services/ 

Soap/u/50.0/00D020000008lUh</mer:serverUrl>

      </mer:submitGenerateDoc>

   </soapenv:Body>

</soapenv:Envelope>

Example Response

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns="ht 

tp://soap.sforce.com/schemas/class/Apttus/MergeWebService">

   <soapenv:Body>

      <submitGenerateDocResponse>

         <result>a0G020000009fMbEAI</result>

      </submitGenerateDocResponse>

   </soapenv:Body>

</soapenv:Envelope>

Generating a Document on Submit Request for a 
Standard Object
For a standard object, this API submits the generate document action using the given 
template from templateId and for a sObject from sObjectId and sObjectType. The output 
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format of the generated document is of the type specified in the docFormat parameter. 
 

 

API Signature

submitGenerateCustomDoc webService static Id submitGenerateCustomDoc(Id 
templateId, Id sObjectId, String sObjectType, String pLevel, 
String docFormat, Boolean isDraft, String sessionId, String 
serverUrl)

 

 

 

Request Parameters

Name Type Description Required?

templateId ID The id of the template used to 
generate the word doc.

Yes

sObjectId ID The sObject id which comprises the 
data for the merge fields.

Yes

sObjectType String The type of the sObject. Yes

pLevel String The protection level to apply to the 
document. Valid values are:

Full access
Insert comments only
Insert comments and tracked 
changes only
Read only
Fill in form fields only

Yes
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Request Parameters

Name Type Description Required?

docFormat String Indicates whether the document will 
be:

DOC
DOCX
PDF
RTF

Yes

isDraft Boolean Indicates whether a draft watermark 
should be added to the document.

Yes

sessionId String The Salesforce session id. Yes

serverUrl String The Salesforce server id. Yes

 

 

Response Parameter

Name Type Description

result ID The id of the generated document.

 

Code Sample

ID templateId = 'a036100000Fha5D'1
ID sObjectId = '0016100000KvBHi';2
String sObjectType = 'Account';3
String pLevel = 'Full access';4
String docFormat = 'DOC';5
Boolean isDraft= false;6
String sessionId = sessionId; //This is the session Id.7
String serverUrl = System.Url.getSalesforceBaseUrl().toExternalForm() + '/ 

services/Soap/u/50.0/' + UserInfo.getOrganizationId();

8

 9
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Integration Details
Use the following information in your integrations with Apttus Contract Management Web 
Services API. For information on how to get started, refer to Integrating Conga CLM with 
External Systems.

API Prerequisites
None.

Request/Response XML

Example Request

<?xml version="1.0" encoding="UTF-8"?>

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:mer=" 

http://soap.sforce.com/schemas/class/Apttus/MergeWebService">

   <soapenv:Header>

      <mer:SessionHeader>

         <mer:sessionId>00D020000008lUh! 

AQYAQPYE.vw_Vh7FI.cV871nm9WWqIdhVINQJIl7PDNzr3fLVNdGjwk9qTJbDYIRoxbfpa44bpuIyeyVxEepP 

xdubr_AWjOv</mer:sessionId>

      </mer:SessionHeader>

   </soapenv:Header>

   <soapenv:Body>

      <mer:submitGenerateCustomDoc>

         <mer:templateId>a09R000000AjMCy</mer:templateId>

         <mer:sObjectId>0015500000YAdXR</mer:sObjectId>

         <mer:sObjectType>Account</mer:sObjectType>

         <mer:pLevel>Full Access</mer:pLevel>

         <mer:docFormat>PDF</mer:docFormat>

         <mer:isDraft>False</mer:isDraft>

         <mer:sessionId>00D020000008lUh! 

AQYAQPYE.vw_Vh7FI.cV871nm9WWqIdhVINQJIl7PDNzr3fLVNdGjwk9qTJbDYIRoxbfpa44bpuIyeyVxEepP 

xdubr_AWjOv</mer:sessionId>

         <mer:serverUrl>https://testmanaged--5s20minor.my.salesforce.com/services/ 

Soap/u/50.0/00D020000008lUh</mer:serverUrl>

ID callId = 

Apttus.MergeWebService.submitGenerateCustomDoc(templateId,sObjectId,sObjec 

tType,pLevel,docFormat,isDraft,sessionId,serverUrl);

10
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      </mer:submitGenerateCustomDoc>

   </soapenv:Body>

</soapenv:Envelope>

Example Response

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns="ht 

tp://soap.sforce.com/schemas/class/Apttus/MergeWebService">

   <soapenv:Body>

      <submitGenerateCustomDocResponse>

         <result>a0G020000009fMlEAI</result>

      </submitGenerateCustomDocResponse>

   </soapenv:Body>

</soapenv:Envelope>

Generating a Supporting Document
Generates a supporting document, such as Contract Summary, Renewal Letter, and 
Termination Letter, using the template specified by the templateId and is associated with 
the agreement record represented by the agreementId.

 

API Signature

generateSupportingDoc webService static Id generateSupportingDoc(Id templateId, 
Id agreementId, String pLevel, String docFormat, String 
sessionId, String serverUrl)

 

 

Request Parameters

Name Type Description Required?

templateId ID The id of the template used to 
generate the word document.

Yes
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Request Parameters

Name Type Description Required?

agreementId ID The id of the agreement providing the 
content for the document.

Yes

pLevel String The protection level to apply to the 
document. Valid values are:

Full access
Insert comments only
Insert comments and tracked 
changes only
Read only
Fill in form fields only

Yes

docFormat String Indicates whether the document will 
be:

DOC
DOCX
PDF
RTF

Yes

sessionId String The Salesforce session id. Yes

serverUrl String The Salesforce server id. Yes

 

 

Response Parameter

Name Type Description

result ID The id of the generated document.

 

Code Sample 

ID templateId = 'a036100000Fha5D';1
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Integration Details
Use the following information in your integrations with Apttus Contract Management Web 
Services API. For information on how to get started, refer to Integrating Conga CLM with 
External Systems.

API Prerequisites
None.

Request/Response XML

Example Request

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:mer=" 

http://soap.sforce.com/schemas/class/Apttus/MergeWebService">

   <soapenv:Header>

      <mer:SessionHeader>

         <mer:sessionId>00D020000008lUh! 

AQYAQPYE.vw_Vh7FI.cV871nm9WWqIdhVINQJIl7PDNzr3fLVNdGjwk9qTJbDYIRoxbfpa44bpuIyeyVxEepP 

xdubr_AWjOv</mer:sessionId>

      </mer:SessionHeader>

   </soapenv:Header>

   <soapenv:Body>

      <mer:generateSupportingDoc>

         <mer:templateId>a09R000000AjMCy</mer:templateId>

         <mer:agreementId>a07020000008w91</mer:agreementId>

         <mer:pLevel>Insert Comments Only</mer:pLevel>

         <mer:docFormat>DOCX</mer:docFormat>

ID agreementId = 'a016100000Che3D';2
String pLevel = 'Full access';3
String docFormat = 'DOC';4
String sessionId = sessionId; //This is the session Id.5
String serverUrl = System.Url.getSalesforceBaseUrl().toExternalForm() + '/ 

services/Soap/u/50.0/' + UserInfo.getOrganizationId();

6

ID docId = 

Apttus.MergeWebService.generateSupportingDoc(templateId,agreementId,pLevel 

,docFormat,sessionId,serverUrl);

7
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         <mer:sessionId>00D020000008lUh! 

AQYAQPYE.vw_Vh7FI.cV871nm9WWqIdhVINQJIl7PDNzr3fLVNdGjwk9qTJbDYIRoxbfpa44bpuIyeyVxEepP 

xdubr_AWjOv</mer:sessionId>

         <mer:serverUrl>https://testmanaged--5s20minor.my.salesforce.com/services/ 

Soap/u/50.0/00D020000008lUh</mer:serverUrl>

      </mer:generateSupportingDoc>

   </soapenv:Body>

</soapenv:Envelope>

Example Response

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns="ht 

tp://soap.sforce.com/schemas/class/Apttus/MergeWebService">

   <soapenv:Body>

      <generateSupportingDocResponse>

         <result>00P02000000Ib0GEAS</result>

      </generateSupportingDocResponse>

   </soapenv:Body>

</soapenv:Envelope>

 

This API is the same as the generateSupportingDoc API and additionally enables you to 
add a draft watermark to the generated document.

 

API Signature

generateSupportingDoc2 webService static Id generateSupportingDoc2(Id templateId, 
Id agreementId, String pLevel, String docFormat, Boolean 
isDraft, String sessionId, String serverUrl)

Request Parameters

Name Type Description Required?

templateId ID The id of the template used to generate 
the word doc.

Yes

agreementId ID The id of the agreement providing the 
content for the document.

Yes
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Request Parameters

Name Type Description Required?

pLevel String The protection level to apply to the 
document. Valid values are: 'Full access', 
'Insert comments only', 'Insert comments 
and tracked changes only', 'Read only', 
and 'Fill in form fields only'.

Yes

docFormat String Indicates whether the document will be 
'DOC', 'DOCX', 'PDF', or 'RTF'.

Yes

isDraft Boolean Indicates whether a draft watermark 
should be added to the document.

Yes

sessionId String The Salesforce session id. Yes

serverUrl String The Salesforce server id. Yes

 

 

Response Parameter

Name Type Description

result ID The id of the generated document.

 
Code Sample 

ID templateId = 'a036100000Fha5D';1
ID agreementId = 'a016100000Che3D';2
String pLevel = 'Full access';3
String docFormat = 'DOC';4
isDraft= true;5
String sessionId = sessionId; //This is the session Id.6
String serverUrl = System.Url.getSalesforceBaseUrl().toExternalForm() + '/ 

services/Soap/u/50.0/' + UserInfo.getOrganizationId();

7
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Integration Details
Use the following information in your integrations with Apttus Contract Management Web 
Services API. For information on how to get started, refer to Integrating Conga CLM with 
External Systems.

API Prerequisites
None.

Request/Response XML

Example Request

<?xml version="1.0" encoding="UTF-8"?>

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:mer=" 

http://soap.sforce.com/schemas/class/Apttus/MergeWebService">

   <soapenv:Header>

      <mer:SessionHeader>

         <mer:sessionId>00D020000008lUh! 

AQYAQPYE.vw_Vh7FI.cV871nm9WWqIdhVINQJIl7PDNzr3fLVNdGjwk9qTJbDYIRoxbfpa44bpuIyeyVxEepP 

xdubr_AWjOv</mer:sessionId>

      </mer:SessionHeader>

   </soapenv:Header>

   <soapenv:Body>

      <mer:generateSupportingDoc2>

         <mer:templateId>a09R000000AjMCy</mer:templateId>

         <mer:agreementId>a07020000008w91</mer:agreementId>

         <mer:pLevel>Insert Comments Only</mer:pLevel>

         <mer:docFormat>DOCX</mer:docFormat>

         <mer:isDraft>True</mer:isDraft>

         <mer:sessionId>00D020000008lUh! 

AQYAQPYE.vw_Vh7FI.cV871nm9WWqIdhVINQJIl7PDNzr3fLVNdGjwk9qTJbDYIRoxbfpa44bpuIyeyVxEepP 

xdubr_AWjOv</mer:sessionId>

         <mer:serverUrl>https://testmanaged--5s20minor.my.salesforce.com/services/ 

Soap/u/50.0/00D020000008lUh</mer:serverUrl>

      </mer:generateSupportingDoc2>

ID docId = 

Apttus.MergeWebService.generateSupportingDoc2(templateId,agreementId,pLeve 

l,docFormat,isDraft,sessionId,serverUrl);

8
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   </soapenv:Body>

</soapenv:Envelope>

Example Response

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns="ht 

tp://soap.sforce.com/schemas/class/Apttus/MergeWebService">

   <soapenv:Body>

      <generateSupportingDoc2Response>

         <result>00P02000000Ib0aEAC</result>

      </generateSupportingDoc2Response>

   </soapenv:Body>

</soapenv:Envelope>

Generating a Supporting Document on Submit Request
This API submits the generate supporting document action using the given template from 
templateId and for an agreement from agreementId. The output format of the generated 
supporting document is of the type specified in the docFormat parameter.

 

API Signature

submitGenerateSupportingDoc webService static Id submitGenerateSupportingDoc(Id 
templateId, Id agreementId, String pLevel, String 
docFormat, Boolean isDraft, String sessionId, String 
serverUrl)

 

 

 

Request Parameters

Name Type Description

templateId ID The id of the template used to generate the 
word document.
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•

•
•

•
•
•
•

Request Parameters

Name Type Description

agreementId ID The id of the agreement providing the content 
for the document.

pLevel String The protection level to apply to the document. 
Valid values are:

Full access
Insert comments only
Insert comments and tracked changes 
only
Read only
Fill in form fields only

docFormat String Indicates whether the document will be:

DOC
DOCX
PDF
RTF

isDraft Boolean Indicates whether a draft watermark should be 
added to the document.

sessionId String The Salesforce session id.

serverUrl String The Salesforce server id.

 

 

 

Response Parameter

Name Type Description

result ID The id of the generated document.
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Code Sample

Integration Details
Use the following information in your integrations with Apttus Contract Management Web 
Services API. For information on how to get started, refer to Integrating Conga CLM with 
External Systems.

API Prerequisites
None.

Request/Response XML

Example Request

<?xml version="1.0" encoding="UTF-8"?>

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:mer=" 

http://soap.sforce.com/schemas/class/Apttus/MergeWebService">

   <soapenv:Header>

      <mer:SessionHeader>

         <mer:sessionId>00D020000008lUh! 

AQYAQPYE.vw_Vh7FI.cV871nm9WWqIdhVINQJIl7PDNzr3fLVNdGjwk9qTJbDYIRoxbfpa44bpuIyeyVxEepP 

xdubr_AWjOv</mer:sessionId>

      </mer:SessionHeader>

   </soapenv:Header>

ID templateId = 'a036100000Fha5D';1
ID agreementId = '0016100000KvBHi';2
String pLevel = 'Full access';3
String docFormat = 'DOC';4
Boolean isDraft= false;5
String sessionId = sessionId; //This is the session Id.6
String serverUrl = System.Url.getSalesforceBaseUrl().toExternalForm() + '/ 

services/Soap/u/50.0/' + UserInfo.getOrganizationId();

7

 8
ID callId = 

Apttus.MergeWebService.submitGenerateSupportingDoc(templateId,agreementId, 

pLevel,docFormat,isDraft,sessionId,serverUrl);

9
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•

   <soapenv:Body>

      <mer:submitGenerateSupportingDoc>

         <mer:templateId>a09R000000AjMCy</mer:templateId>

         <mer:agreementId>a07020000008w91</mer:agreementId>

         <mer:pLevel>Insert Comments Only</mer:pLevel>

         <mer:docFormat>DOCX</mer:docFormat>

         <mer:isDraft>True</mer:isDraft>

         <mer:sessionId>00D020000008lUh! 

AQYAQPYE.vw_Vh7FI.cV871nm9WWqIdhVINQJIl7PDNzr3fLVNdGjwk9qTJbDYIRoxbfpa44bpuIyeyVxEepP 

xdubr_AWjOv</mer:sessionId>

         <mer:serverUrl>https://testmanaged--5s20minor.my.salesforce.com/services/ 

Soap/u/50.0/00D020000008lUh</mer:serverUrl>

      </mer:submitGenerateSupportingDoc>

   </soapenv:Body>

</soapenv:Envelope>

Example Response

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns="ht 

tp://soap.sforce.com/schemas/class/Apttus/MergeWebService">

   <soapenv:Body>

      <submitGenerateSupportingDocResponse>

         <result>a0G020000009fMqEAI</result>

      </submitGenerateSupportingDocResponse>

   </soapenv:Body>

</soapenv:Envelope>

Merging Multiple Documents to a PDF without PDF 
Protection
You can use any of the following Merge Webservice APIs to merge multiple documents into 
a single PDF. The supported file types are DOC, DOCX, XLS, XLSX, PPT, PPTX, and PDF. 
Choose the API that best suits your needs (note limitations for each):

mergeDocsToPDF
mergeDocsToPDF2
createPDF
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API Signature

mergeDocsToPDF webService static Id mergeDocsToPDF(Id parentId, List docIds, 
String docFileName, String sessionId, String serverUrl)

This API merges multiple documents using the values specified in the docIds parameter into 
a single PDF document with the name docFileName.

Request Parameters

Name Type Description Required?

parentId ID The id of the parent object to 
associate with the result document.

Yes

docIds List A collection of the ids of the 
documents to merge into a PDF 
document.

Yes

docFileName String The file name for the PDF document. Yes

sessionId String The Salesforce session id. Yes

serverUrl String The Salesforce server id. Yes

Response Parameter

Name Type Description

result ID The id of the generated document.

Note

You cannot use Apttus-generated PDFs with document protection enabled as input 
documents.



Note

Footers in the final PDF will always list the original filename of the input document 
for the collated page.
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Code Sample

Integration Details
Use the following information in your integrations with Apttus Contract Management Web 
Services API. For information on how to get started, refer to Integrating Conga CLM with 
External Systems.

API Prerequisites
None.

Request/Response XML

Example Request

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:mer=" 

http://soap.sforce.com/schemas/class/Apttus/MergeWebService">

   <soapenv:Header>

      <mer:SessionHeader>

         <mer:sessionId>00D0S0000000Pa8! 

ARUAQGAA1VTGcAG1zxylmAb1RJmiUnspuO5dzL53Xsx3jVhYI3oWTqB2dqzdBeswmwj_I49aI6BgIM4veO1At 

3rLd9z6BjXv</mer:sessionId>

      </mer:SessionHeader>

   </soapenv:Header>

   <soapenv:Body>

      <mer:mergeDocsToPDF>

         <mer:parentId>a070S000002bSFzQAM</mer:parentId>

         <mer:docIds>0690S000000SvnfQAC</mer:docIds>

         <mer:docIds>0690S000000SvnkQAC</mer:docIds>

ID parentId = '0016100000KvBHi'1
ID[] docIds = new ID[]{'a0Y61000002K6IR','a0Y61000003K7jR'};2
String docFileName = 'Agreement-Merged.pdf';3
String sessionId = sessionId; 4
String serverUrl = System.Url.getSalesforceBaseUrl().toExternalForm() + '/ 

services/Soap/u/50.0/' + UserInfo.getOrganizationId();

5

ID docId = 

Apttus.MergeWebService.mergeDocsToPDF(parentId,docIds,docFileName,sessionI 

d,serverUrl);

6
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         <mer:docFileName>Merged.PDF</mer:docFileName>

         <mer:sessionId>00D0S0000000Pa8! 

ARUAQGAA1VTGcAG1zxylmAb1RJmiUnspuO5dzL53Xsx3jVhYI3oWTqB2dqzdBeswmwj_I49aI6BgIM4veO1At 

3rLd9z6BjXv</mer:sessionId>

         <mer:serverUrl>https://testmanagedclm--tbox.my.salesforce.com/services/Soap/ 

u/50.0/00D0S0000000Pa8</mer:serverUrl>

      </mer:mergeDocsToPDF>

   </soapenv:Body>

</soapenv:Envelope>

Example Response

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns="ht 

tp://soap.sforce.com/schemas/class/Apttus/MergeWebService">

   <soapenv:Body>

      <mergeDocsToPDFResponse>

         <result>0690S000000SvwcQAC</result>

      </mergeDocsToPDFResponse>

   </soapenv:Body>

</soapenv:Envelope>

Merging Multiple Documents to a PDF with PDF 
Protection
The API is an enhancement of the existing mergeDocsToPDF API. The mergeDocsToPDF2 
merges multiple documents using the values specified in the docIds parameter into a single 
PDF document with the name docFileName and adds a flag to specify whether PDF 
document protection should be carried over to the collated PDF. The supported file types 
are DOC, DOCX, XLS, XLSX, PPT, PPTX, and PDF.

Before invoking this API, CustomClass.ActionParams must be instantiated by passing the 
parameters described below. The parameters are then passed to the API when it is invoked.

API Signature

mergeDocsToPDF2 webService static Id 
mergeDocsToPDF2(Apttus.CustomClass.ActionParams 
mergeParams)
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Request Parameters

Name Type Description Required?

parentId Id The Id of the parent object to 
associate with the result (merged) 
document.

Yes

docIds List A collection of the Ids of the 
documents to merge into a PDF 
document.

Yes

docFileName String The file name for the PDF document. Yes

sessionId String The Salesforce session Id. Yes

sessionUrl String The Salesforce server Id. Yes

ProtectOutputDoc Boolean If true, protect the output document 
with PDF security as defined in 
Comply properties.

Yes
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•

Request Parameters

Name Type Description Required?

addAutoHeaderFooter Boolean If true:

The agreement number is 
added as the header on the 
generated agreement.
The timestamp as defined in 
comply system property is 
added as the footer on the 
generated agreement.

If false, you need to define the 
following parameters. 

Request Parameters

S. 
N 
o

Na 
me

T 
y 
p 
e

Description Req 
uire 
d?

1 Ad 
dHe 
ade 
r

B 
o 
ol 
e 
a 
n

If true, you 
need to 
define 
parameters 
from 2-6.

Opti 
ona 
l

Yes
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Request Parameters

Name Type Description Required?

Request Parameters

S. 
N 
o

Na 
me

T 
y 
p 
e

Description Req 
uire 
d?

2 He 
ade 
rMo 
de

St 
ri 
n 
g

The existing 
footer 
values are 
customized 
based on 
the values 
provided for 
parameters 
3-6.

Supported 
value: 
Overwrite

Yes 
if 
Add 
Hea 
der 
is 
true

3 He 
ade 
rTe 
xt

St 
ri 
n 
g

The text 
that should 
be 
displayed 
at the 
header of 
the 
generated 
document.

Yes 
if 
Add 
Hea 
der 
is 
true

4 He 
ade 
rFo 
nt

St 
ri 
n 
g

The system 
font for the 
header text.

Sample 
value: Arial, 
Tahoma

Yes 
if 
Add 
Hea 
der 
is 
true
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Request Parameters

Name Type Description Required?

Request Parameters

S. 
N 
o

Na 
me

T 
y 
p 
e

Description Req 
uire 
d?

5 He 
ade 
rFo 
ntSi 
ze

In 
te 
g 
er

The font size 
of the 
header text.

Yes 
if 
Add 
Hea 
der 
is 
true

6 He 
ade 
rAli 
gn 
me 
nt

St 
ri 
n 
g

The 
alignment 
of the 
header text.  
Supported 
values: Left, 
Right, 
Center

Yes 
if 
Add 
Hea 
der 
is 
true

7 Ad 
dFo 
ote 
r

B 
o 
ol 
e 
a 
n

If true, you 
need to 
define 
parameters 
from 8-12.

Opti 
ona 
l
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Request Parameters

Name Type Description Required?

Request Parameters

S. 
N 
o

Na 
me

T 
y 
p 
e

Description Req 
uire 
d?

8 Foo 
ter 
Mo 
de

St 
ri 
n 
g

The existing 
footer 
values are 
customized 
based on 
the values 
provided for 
parameters 
9-12.

Supported 
value: 
Overwrite

Yes 
if 
Add 
Foo 
ter 
is 
true

9 Foo 
ter 
Tex 
t

St 
ri 
n 
g

The text 
that should 
be 
displayed 
at the 
footer of the 
generated 
document.

Yes 
if 
Add 
Foo 
ter 
is 
true

10 Foo 
ter 
Fon 
t

St 
ri 
n 
g

The system 
font for the 
footer text.

Sample 
value: Arial, 
Tahoma

Yes 
if 
Add 
Foo 
ter 
is 
true
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Request Parameters

Name Type Description Required?

Request Parameters

S. 
N 
o

Na 
me

T 
y 
p 
e

Description Req 
uire 
d?

11 Foo 
ter 
Fon 
tSiz 
e

In 
te 
g 
er

The font size 
of the footer 
text.

Yes 
if 
Add 
Foo 
ter 
is 
true

12 Foo 
ter 
Alig 
nm 
ent

St 
ri 
n 
g

The 
alignment 
of the footer 
text.  
Supported 
values: Left, 
Right, 
Center

Yes 
if 
Add 
Foo 
ter 
is 
true

Response Parameter

Name Type Description

docId ID The id of the generated PDF document.

Code Sample

public String docFormat { get; set; }1
public String outputDocFileBasename { get; set; }2
private Boolean protectOutputDocStatus;3
public String protectOutputDocFlag { get; set; }4
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private Boolean preserveRedlinesStatus;5
public String preserveRedlinesFlag { get; set; }6
public List<SelectOption> listOfDocxAttachmentsRelated2Agreement_Selected 

{ get; set; }

7

public List<SelectOption> listOfPDFAttachmentsRelated2Agreement_Selected 

{ get; set; }

8

public String apiServerURL = '';9
private String servicesSOAPInfo = '/services/Soap/u/50.0/';10
 11
...12
...13
 14
private void init() {15
 16
docFormat = 'PDF';17
protectOutputDocFlag = 'True';18
protectOutputDocStatus = true;19
preserveRedlinesFlag = 'True';20
preserveRedlinesStatus = true;21
outputDocFileBasename = 'Agreement_outputDocFilename_mergeDocsToPDF2';22
sessionId = UserInfo.getSessionId();23
apiServerURL = System.Url.getSalesforceBaseUrl().toExternalForm() + 

servicesSOAPInfo + UserInfo.getOrganizationId();

24

}25
 26
 27
public void mergeDocsToPDF2_ControllerAction() {28
 29
String outputDocFilename = outputDocFileBasename + '.' + docFormat;30
 31
List<Apttus.CustomClass.AttachmentInfo> attachmentsInfoList = new 

 List<Apttus.CustomClass.AttachmentInfo>();

32

List<Id> attachmentsIdList = new List<Id>();33
 34
// Attachments: Docx35
if (listOfDocxAttachmentsRelated2Agreement_Selected != null) {36
 37
if (!listOfDocxAttachmentsRelated2Agreement_Selected.isEmpty()) {38
 39
for (selectoption so : listOfDocxAttachmentsRelated2Agreement_Selected) {40
 41
Apttus.CustomClass.AttachmentInfo attachmentInfo = new 

 Apttus.CustomClass.AttachmentInfo();

42

 43
Attachment attachmentDetails = getAttachmentDetails(so.getValue());44
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attachmentInfo.Title = attachmentDetails.Name;45
attachmentInfo.RecordId = attachmentDetails.Id;46
attachmentsInfoList.add(attachmentInfo);47
}48
}49
}50
 51
// Attachments: PDF52
if (listOfPDFAttachmentsRelated2Agreement_Selected != null) {53
 54
if (!listOfPDFAttachmentsRelated2Agreement_Selected.isEmpty()) {55
 56
for (selectoption so : listOfPDFAttachmentsRelated2Agreement_Selected) {57
 58
Apttus.CustomClass.AttachmentInfo attachmentInfo = new 

 Apttus.CustomClass.AttachmentInfo();

59

 60
Attachment attachmentDetails = getAttachmentDetails(so.getValue());61
attachmentInfo.Title = attachmentDetails.Name;62
attachmentInfo.RecordId = attachmentDetails.Id;63
attachmentsInfoList.add(attachmentInfo);64
}65
}66
}67
 68
//69
// Attachments70
// DocIds is all that is needed by this API - mergeDocsToPDF271
//72
for (Apttus.CustomClass.AttachmentInfo info : attachmentsInfoList) {73
 74
attachmentsIdList.add(info.RecordId);75
}76
 77
if (getAgreement!= null &&78
!string.isBlank(outputDocFilename) &&79
(docFormat.equalsIgnoreCase('PDF')) &&80
(attachmentsInfoList.size() != 0) &&81
apiServerURL != null && apiServerURL != '' &&82
sessionId != null && sessionId != '') {83
 84
//Agreement__c is self lookup field on Agreement85



CLM

895
 

Copyright ©2022 Apttus Corporation. All rights reserved.
 

System.debug(apiName + ': getAgreement.Agreement__c: ' + 

getAgreement.Agreement__c);

86

Apttus__APTS_Agreement__c myAgreement = [SELECT Id, Name FROM 

Apttus__APTS_Agreement__c WHERE Id = :getAgreement.Agreement__c];

87

 88
// API Parameters89
Apttus.CustomClass.ActionParams apiParameters = new 

 Apttus.CustomClass.ActionParams();

90

 91
apiParameters.ParentId = myAgreement.Id;92
apiParameters.DocIds = attachmentsIdList;93
apiParameters.DocFileName = outputDocFilename;94
apiParameters.PreserveRedlines = getBooleanStatus(preserveRedlinesFlag);95
apiParameters.ProtectOutputDoc = getBooleanStatus(protectOutputDocFlag);96
apiParameters.SessionId = sessionId;97
apiParameters.SessionUrl = apiServerURL;98
 99
apiParameters.addAutoHeaderFooter = false;100
apiParameters.AddHeader = true;101
apiParameters.HeaderMode = 'Overwrite';102
apiParameters.HeaderText= 'Contract Management';103
apiParameters.HeaderFont = 'Arial';104
apiParameters.HeaderFontSize = '12';105
apiParameters.HeaderAlignment = 'Left';106
apiParameters.AddFooter = false;107
apiParameters.FooterMode = 'Overwrite';108
apiParameters.FooterText= 'Apttus';109
apiParameters.FooterFont = 'Arial';110
apiParameters.FooterFontSize = '12';111
apiParameters.FooterAlignment = 'Left';112
 113
 114
System.debug(apiParameters);115
 116
try {117
 118
//submit request119
Id myDocId = Apttus.MergeWebService.mergeDocsToPDF2(apiParameters);120
 121
if (myDocId != null) {122
 123
// Get details of the corresponding word document.124
String pdfFilename = '%' + outputDocFileBasename + '%.pdf';125
System.debug(' ' + apiName + ': Querying for: ' + pdfFilename);126
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List<Attachment> myDocIds = [SELECT Id, Name, CreatedDate FROM Attachment 

WHERE ParentID = :myAgreement.Id AND Name like :pdfFilename ORDER BY 

CreatedDate DESC];

127

Attachment myAttachment = myDocIds.get(0);128
getGeneratedDocumentDetails(myAttachment.Id, 'PDF');129
 130
} else {131
 132
ApexPages.addMessage(new ApexPages.Message(ApexPages.Severity.ERROR, 'API 

mergeDocsToPDF2() returned null. Please try again.'));

133

}134
 135
} catch (Exception ex) {136
 137
System.debug('Apttus.MergeWebService.mergeDocsToPDF2: Oops!!! Caught an 

Exception 1: ' + ex.getMessage());

138

}139
 140
} else {141
ApexPages.addMessage(new ApexPages.Message(ApexPages.Severity.ERROR, 

'Argument(s) was not set. Please try again'));

142

}143
}144
 145
 146
private Boolean getBooleanStatus(String flagValue) {147
 148
If ( flagValue.equalsIgnoreCase('True')) {149
return true;150
} else {151
return false;152
}153
}154

Note

ProtectOutputDoc only enforces document protection in the target PDF when Enable 
PDF Security was properly configured at the time of PDF generated in the Org 
corresponding to the input document. For more information, see .Merging Multiple 
Documents to a PDF with PDF Protection vWinter-20.
All redlines that are present in input documents are accepted prior to collation.
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Integration Details
Use the following information in your integrations with Apttus Contract Management Web 
Services API. For information on how to get started, refer to Integrating Conga CLM with 
External Systems.

API Prerequisites
None.

Request/Response XML

Example Request

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:mer=" 

http://soap.sforce.com/schemas/class/Apttus/MergeWebService" xmlns:cus="http:// 

soap.sforce.com/schemas/class/Apttus/CustomClass">

   <soapenv:Header>

      <mer:SessionHeader>

         <mer:sessionId>00D0S0000000Pa8! 

ARUAQGAA1VTGcAG1zxylmAb1RJmiUnspuO5dzL53Xsx3jVhYI3oWTqB2dqzdBeswmwj_I49aI6BgIM4veO1At 

3rLd9z6BjXv</mer:sessionId>

      </mer:SessionHeader>

   </soapenv:Header>

   <soapenv:Body>

      <mer:mergeDocsToPDF2>

         <mer:mergeParams>

            <cus:AddAutoHeaderFooter>False</cus:AddAutoHeaderFooter>

            <cus:AddFooter>True</cus:AddFooter>

            <cus:AddHeader>True</cus:AddHeader>

            <cus:AddWatermark>True</cus:AddWatermark>

            <cus:DocFileName>Merged.PDF</cus:DocFileName>

            <cus:DocIds>0690S000000SvnkQAC</cus:DocIds>

            <cus:DocIds>0690S000000SvwIQAS</cus:DocIds>

            <cus:FooterAlignment>Center</cus:FooterAlignment>

            <cus:FooterFont>Tahoma</cus:FooterFont>

            <cus:FooterFontSize>8</cus:FooterFontSize>

            <cus:FooterMode>Overwrite</cus:FooterMode>

            <cus:FooterText>Copyright 2020</cus:FooterText>

            <cus:HeaderAlignment>Center</cus:HeaderAlignment>

            <cus:HeaderFont>Tahoma</cus:HeaderFont>
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            <cus:HeaderFontSize>8</cus:HeaderFontSize>

            <cus:HeaderMode>Overwrite</cus:HeaderMode>

            <cus:HeaderText>Apttus</cus:HeaderText>

            <cus:ParentId>a070S000002bSFzQAM</cus:ParentId>

            <cus:PreserveRedlines>False</cus:PreserveRedlines>

            <cus:ProtectionLevel>Full Access</cus:ProtectionLevel>

            <cus:ProtectOutputDoc>True</cus:ProtectOutputDoc>

            <cus:RemoveWatermark>False</cus:RemoveWatermark>

            <cus:RetainInputHeaderFooter>False</cus:RetainInputHeaderFooter>

            <cus:SessionId>00D0S0000000Pa8! 

ARUAQGAA1VTGcAG1zxylmAb1RJmiUnspuO5dzL53Xsx3jVhYI3oWTqB2dqzdBeswmwj_I49aI6BgIM4veO1At 

3rLd9z6BjXv</cus:SessionId>

            <cus:SessionUrl>https://testmanagedclm--tbox.my.salesforce.com/services/ 

Soap/u/50.0/00D0S0000000Pa8</cus:SessionUrl>

            <cus:SObjectId>a070S000002bSFzQAM</cus:SObjectId>

         </mer:mergeParams>

      </mer:mergeDocsToPDF2>

   </soapenv:Body>

</soapenv:Envelope>

Example Response

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns="ht 

tp://soap.sforce.com/schemas/class/Apttus/MergeWebService">

   <soapenv:Body>

      <mergeDocsToPDF2Response>

         <result>0690S000000SvzCQAS</result>

      </mergeDocsToPDF2Response>

   </soapenv:Body>

</soapenv:Envelope>

Creating PDF
This API merges multiple documents using the values specified in the docIds parameter into 
a single PDF document with the name docFileName. This API enhances mergeDocsToPDF by 
providing the ability to automatically display or hide the footer in the merged PDF.

Before invoking this API, CustomClass.ActionParams must be instantiated by passing the 
parameters described below. The parameters are then passed to the API when it is invoked.
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API Signature

createPDF webService static Id 
createPDF(Apttus.CustomClass.ActionParams params)

Request Parameters

Name Type Description

parentId Id The Id of the parent object to associate with 
the result (merged) document.

docIds List A collection of the Ids of the documents to 
merge into a PDF document.

docFileName String The file name for the PDF document.

sessionId String The Salesforce session Id.

sessionUrl String The Salesforce server Id.

addFooter Boolean Display/hide the footer in the merged PDF.

Response Parameter

Name Type Description

result Id The Id of the generated (merged) PDF.

Code Sample

Note

Footers in the final PDF will always list the original filename of the input document 
for the collated page.
All redlines that are present in input documents are accepted prior to collation.



CustomClass.ActionParams objParam = new CustomClass.ActionParams();1
objParam.SessionId = ServerInfo.getSessionId();2
objParam.SessionUrl = ServerInfo.getServerUrl();3
objParam.ParentId = '{parentID}';4
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Integration Details
Use the following information in your integrations with Apttus Contract Management Web 
Services API. For information on how to get started, refer to Integrating Conga CLM with 
External Systems.

API Prerequisites
None.

Request/Response XML

Example Request

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:mer=" 

http://soap.sforce.com/schemas/class/Apttus/MergeWebService" xmlns:cus="http:// 

soap.sforce.com/schemas/class/Apttus/CustomClass">

   <soapenv:Header>

      <mer:SessionHeader>

         <mer:sessionId>00D0S0000000Pa8! 

ARUAQGAA1VTGcAG1zxylmAb1RJmiUnspuO5dzL53Xsx3jVhYI3oWTqB2dqzdBeswmwj_I49aI6BgIM4veO1At 

3rLd9z6BjXv</mer:sessionId>

      </mer:SessionHeader>

   </soapenv:Header>

   <soapenv:Body>

      <mer:createPDF>

         <mer:params>

            <cus:DocFileName>Merged.PDF</cus:DocFileName>

            <cus:DocIds>0690S000000SvjOQAS</cus:DocIds>

            <cus:DocIds>0690S000000SvnkQAC</cus:DocIds>

objParam.DocIds = new ID[]{ID.valueOf('{docId}'),5
ID.valueOf('{docId}')};6
objParam.DocFileName = 'My_Merged_PDF.pdf';7
objParam.AddFooter = true;8
ID mergedPDF = MergeWebService.createPDF(objParam);9

Note

Values inside '{ }' in the above code sample denote an Id is required.
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            <cus:ParentId>a070S000002bSFzQAM</cus:ParentId>

            <cus:SessionId>00D0S0000000Pa8! 

ARUAQGAA1VTGcAG1zxylmAb1RJmiUnspuO5dzL53Xsx3jVhYI3oWTqB2dqzdBeswmwj_I49aI6BgIM4veO1At 

3rLd9z6BjXv</cus:SessionId>

            <cus:SessionUrl>https://testmanagedclm--tbox.my.salesforce.com/services/ 

Soap/u/50.0/00D0S0000000Pa8</cus:SessionUrl>

         </mer:params>

      </mer:createPDF>

   </soapenv:Body>

</soapenv:Envelope>

Example Response

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns="ht 

tp://soap.sforce.com/schemas/class/Apttus/MergeWebService">

   <soapenv:Body>

      <createPDFResponse>

         <result>0690S000000SvzWQAS</result>

      </createPDFResponse>

   </soapenv:Body>

</soapenv:Envelope>

Merging Proposal Documents into a single PDF 
Document
Use this API to package multiple proposal documents together into a singled merged PDF 
document. Implementation requires creation of a custom Visualforce page to make use of 
the API for document packaging purposes.

API Signature

createPDFPackage webService static Id 
createPDFPackage(Apttus_Proposal.CustomClass.ActionPa 
rams params) 
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Parameters

Name Type Description

parentId ID The ID of the parent object 
associated with the result.

attachments List<Apttus.CustomClass.Attach 
mentInfo>

List of all documents in the order to 
be packaged.

externalLinks List<Apttus.CustomClass.Externa 
lLink>

List of external links to be embedded 
in document.

docFileName String Name of the packaged document 
file (PDF).

sessionId ID The Session ID to use for callback.

sessionURL String The Server URL to use for callback.

 

 

Response

Name Type Description

result ID Returns the ID of the merged PDF document.

 

 

Code Sample

  // Attachments1
        //2
        List<Apttus_Proposal.CustomClass.AttachmentInfo> 

attachmentsInfoList = new 

 List<Apttus_Proposal.CustomClass.AttachmentInfo>();

3

        // Attachment: Primary4
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        Apttus_Proposal.CustomClass.AttachmentInfo attachmentInfo = new 

 Apttus_Proposal.CustomClass.AttachmentInfo();                    

5

        ...6
        ...7
        attachmentInfo.Title            = attachmentDetails.Name;8
        attachmentInfo.RecordId         = attachmentDetails.Id;9
        attachmentsInfoList.add(attachmentInfo);10
 11
        // Attachments: Docx12
        for (selectoption so : 

listOfDocxAttachmentsRelated2Proposal_Selected) {

13

                  14
            Apttus_Proposal.CustomClass.AttachmentInfo attachmentInfo = 

new Apttus_Proposal.CustomClass.AttachmentInfo();

15

            ...16
            ...                    17
            attachmentInfo.Title            = attachmentDetails.Name;18
            attachmentInfo.RecordId         = attachmentDetails.Id;19
            attachmentsInfoList.add(attachmentInfo);20
                    21
        }22
        // Attachments: PDFs23
        for (selectoption so : 

listOfPDFAttachmentsRelated2Proposal_Selected) {

24

                  25
            Apttus_Proposal.CustomClass.AttachmentInfo attachmentInfo = 

new Apttus_Proposal.CustomClass.AttachmentInfo();

26

            ...27
            ...                    28
            attachmentInfo.Title            = attachmentDetails.Name;29
            attachmentInfo.RecordId         = attachmentDetails.Id;30
            attachmentsInfoList.add(attachmentInfo);31
                    32
        }33
        //34
        // External Links35
        //36
        List<Apttus_Proposal.CustomClass.ExternalLink> 

externalLinksInfoList = new 

 List<Apttus_Proposal.CustomClass.ExternalLink>();

37

        if ( !string.isBlank(externalLinks) ) {38
            39
            String[] arrayOfURLs = parseURLsCSV(externalLinks);40
            41
            for (String str : arrayOfURLs) {42
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Integration Details
Use the following information in your integrations with Apttus Contract Management Web 
Services API. For information on how to get started, refer to Integrating Conga CLM with 
External Systems.

API Prerequisites
None.

                43
                String url      = str.trim();44
                String filename = getFilenameFromURL(url);45
                46
                Apttus_Proposal.CustomClass.ExternalLink externalLinkInfo 

= new Apttus_Proposal.CustomClass.ExternalLink();

47

                externalLinkInfo.Title  = filename;48
                externalLinkInfo.Url    = url;49
                externalLinksInfoList.add(externalLinkInfo);50
            }51
        }            52
        // API Parameters53
        Apttus_Proposal.CustomClass.ActionParams apiParameters  = new 

 Apttus_Proposal.CustomClass.ActionParams();

54

        apiParameters.ParentId          = myProposal.Id;55
        apiParameters.Attachments       = attachmentsInfoList;56
        apiParameters.ExternalLinks     = externalLinksInfoList;57
        apiParameters.DocFileName       = 'outputCollatedPDFFilename.pdf';58
        apiParameters.SessionId         = sessionId;59
        apiParameters.SessionUrl        = apiServerURL;60
        try {61
    62
            //submit request63
            Id myDocId = 

Apttus_Proposal.MergeWebService.createPDFPackage(apiParameters);

64

                        65
        } catch (Exception ex) {66
    67
            System.debug('Apttus.MergeWebService.createPDFPackage: Oops!!! 

Caught an Exception: ' + ex);  

68

        }69
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Request/Response XML

Example Request

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:mer=" 

http://soap.sforce.com/schemas/class/Apttus/MergeWebService" xmlns:cus="http:// 

soap.sforce.com/schemas/class/Apttus/CustomClass">

   <soapenv:Header>

      <mer:SessionHeader>

         <mer:sessionId>00D0S0000000Pa8! 

ARUAQJ53E09loYXezDoz9WVOJugDkLwI58ibwr3Iefz8bY7_HNQ5j3jV302ejFtvD2n1wEI_VL_78sOCL76iV 

Z5ywpCZaAJs</mer:sessionId>

      </mer:SessionHeader>

   </soapenv:Header>

   <soapenv:Body>

      <mer:createPDF>

         <mer:params>

            <cus:Attachments>

               <cus:RecordId>0690S000000SxbRQAS</cus:RecordId>

               <cus:Title>Test_DemoTemplate-KK_2020-07-17_1.0.0.doc</cus:Title>

            </cus:Attachments>

            <cus:Attachments>

               <cus:RecordId>0690S000000SxYhQAK</cus:RecordId>

               <cus:Title>Test_00AJ_Template with Clause_2020-07-17_1.0.0.doc</cus:Ti 

tle>

            </cus:Attachments>

            <cus:DocFileName>PDF_Package.PDF</cus:DocFileName>

            <cus:DocIds>0690S000000SvjOQAS</cus:DocIds>

            <cus:DocIds>0690S000000SvnkQAC</cus:DocIds>

            <cus:ParentId>a070S000002bSFzQAM</cus:ParentId>

            <cus:SessionId>00D0S0000000Pa8! 

ARUAQJ53E09loYXezDoz9WVOJugDkLwI58ibwr3Iefz8bY7_HNQ5j3jV302ejFtvD2n1wEI_VL_78sOCL76iV 

Z5ywpCZaAJs</cus:SessionId>

            <cus:SessionUrl>https://testmanagedclm--tbox.my.salesforce.com/services/ 

Soap/u/50.0/00D0S0000000Pa8</cus:SessionUrl>

         </mer:params>

      </mer:createPDF>

   </soapenv:Body>

</soapenv:Envelope>
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Example Response

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns="ht 

tp://soap.sforce.com/schemas/class/Apttus/MergeWebService">

   <soapenv:Body>

      <createPDFResponse>

         <result>0690S000000T0XIQA0</result>

      </createPDFResponse>

   </soapenv:Body>

</soapenv:Envelope>

Package Multiple Documents
This API can be used to package multiple documents (such as a Quote and Agreement 
document) together into a single merged DOCX document. Implementation requires 
creation of a custom Visualforce page to make use of the API for document packing 
purposes.

API Signature

createWordPackage webService static Id 
createWordPackage(Apttus.CustomClass.ActionParams 
params)

 

 

Request Parameters

Name Type Description Requi 
red?

ParentId ID The ID of the parent object associated with the result. Yes

Attachmen 
ts

List<Apttus.Custom 
Class.AttachmentI 
nfo>

List of all documents in the order to be packaged. Yes
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Request Parameters

Name Type Description Requi 
red?

ExternalLin 
ks

List<Apttus.Custom 
Class.ExternalLink 
>

List of external links to be embedded in document. 
(not currently supported)

Yes

DocFileNa 
me

String Name of the packaged document file (.doc or .docx). Yes

ProtectionL 
evel

String Protection level of the document generated. Yes

AddWater 
mark

Boolean Indicates whether to add a watermark to the 
document.

Yes

RemoveWa 
termark

Boolean Indicates whether to remove a watermark from the 
document.

Yes

AddAutoHe 
aderFooter

Boolean Indicates whether to use the configured header and 
footer format located in Comply System Properties.

If AddAutoHeaderFooter=true, the API uses the 
Comply System Properties defined for header 
and footer data.
If AddAutoHeaderFooter=false, the API uses 
values from the headerText and footerText 
parameters.

Yes

HeaderTex 
t

String Text to include in the document header. Yes

FooterText String Text to include in the document footer. Yes

PreserveRe 
dlines

Boolean Indicates whether the redlines in the input document 
will be preserved/ accepted in the packaged 
document. The default value is false.

Yes

SessionId ID The Session ID to use for callback. Yes
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Request Parameters

Name Type Description Requi 
red?

SessionUrl String The Server URL to use for callback. Yes

RetainInpu 
tHeaderFo 
oter

Boolean Indicates whether the merged document retains the 
existing header and footer of the original documents 
and page numbers are cumulative.

Optio 
nal

Cumulativ 
ePageNum 
ber

Boolean Indicates whether the merged document page 
numbers are cumulative.

Optio 
nal

When RetainInputHeaderFooter is set to True, the remaining parameters 
(CumulativePageNumber, and AddAutoHeaderFooter) are not evaluated. When 
CumulativePageNumber is set to True, the combined document has cumulative page 
numbers. When AddAutoHeaderFooter is set to True, then the header and footer are 
inserted according to the input provided. The following table provides a combination of 
inputs and their results.

Header text will always be right-aligned and footer text will always be left-aligned 
by default. Also, any page numbers in the input documents will not be present in the 
final combined document.
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Scenario RetainInputHe 
aderFooter

CumulativeP 
ageNumber

AddAutoHea 
derFooter

Result

Documents with 
header and footer

True True False The existing 
header and 
footer of the 
documents are 
retained.
The default 
footer is not 
added as the 
RetainInputHead 
erFooter 
parameter is set 
to True.

Documents 
without header 
and footer

True True False The default 
footer is not 
added as the 
RetainInputHead 
erFooter 
parameter is set 
to True.

Documents with 
header and footer

False True False The existing 
header and 
footer of the 
documents are 
removed.
The default 
footer is inserted 
and the footer 
has cumulative 
page numbers. 

Documents 
without header 
and footer

False True False The default 
footer is inserted 
and the footer 
has cumulative 
page numbers. 
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Scenario RetainInputHe 
aderFooter

CumulativeP 
ageNumber

AddAutoHea 
derFooter

Result

Documents with 
header and footer

True False False The existing 
header and 
footer of the 
documents are 
retained.
The default 
footer is not 
added as the 
RetainInputHead 
erFooter 
parameter is set 
to True.

Documents 
without header 
and footer

True False False The existing 
header and 
footer of the 
documents are 
retained.
The default 
footer is not 
added as the 
RetainInputHead 
erFooter 
parameter is set 
to True.

Documents with 
header and footer

False False True The existing 
header and 
footer of the 
documents are 
removed.
The header and 
footer are 
inserted with the 
default page 
number format.
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Scenario RetainInputHe 
aderFooter

CumulativeP 
ageNumber

AddAutoHea 
derFooter

Result

Documents 
without header 
and footer

False False True The existing 
header and 
footer of the 
documents are 
removed.
The header and 
footer are 
inserted with the 
default page 
number format.

 

 

Response Parameter

Name Type Description

result ID Returns the ID of the merged DOCX document.

 

Code Sample

 

// attachments1
List<Apttus.CustomClass.AttachmentInfo> attachments = new 

 List<Apttus.CustomClass.AttachmentInfo>();

2

Apttus.CustomClass.AttachmentInfo attInfo = new 

 Apttus.CustomClass.AttachmentInfo();

3

attInfo.Title = 'Agreement-1';4
attInfo.RecordId = attSO.Id;5
           6
attachments.add(attInfo);7
           8
Apttus.CustomClass.AttachmentInfo attInfo2 = new 

 Apttus.CustomClass.AttachmentInfo();

9

attInfo2.Title = 'Agreement-2';10
attInfo2.RecordId = attSO2.Id;11
           12
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attachments.add(attInfo);13
           14
// external links (not supported)15
List<Apttus.CustomClass.ExternalLink> links = new 

 List<Apttus.CustomClass.ExternalLink>();

16

           17
Apttus.CustomClass.ExternalLink linkInfo = new 

 Apttus.CustomClass.ExternalLink();

18

linkInfo.Title = 'Drawing-1';19
linkInfo.Url = 'https://drive.google.com/doc1.docx';20
           21
links.add(linkInfo);22
           23
Apttus.CustomClass.ExternalLink linkInfo2 = new 

 Apttus.CustomClass.ExternalLink();

24

linkInfo2.Title = 'Drawing-2';25
linkInfo2.Url = 'https://drive.google.com/doc2.docx';26
           27
links.add(linkInfo2);28
           29
// create action parameters30
Apttus.CustomClass.ActionParams  params = new 

 Apttus.CustomClass.ActionParams();

31

           32
params.ParentId = agreementSO.Id;33
params.Attachments = attachments;34
params.ExternalLinks = links;35
params.AddAutoHeaderFooter = true;36
params.ProtectionLevel = AgreementProtection.LEVEL_FULL_ACCESS;37
params.DocFileName = 'Agreement-Merged.docx';38
params.AddWatermark = true;39
params.RemoveWatermark = false;40
params.HeaderText = 'Agreement Id: 0123456789';41
params.FooterText = 'Date Created: 11/27/2011 7:23:15 PM';42
params.PreserveRedlines = true;43
params.SessionId = ServerInfo.getSessionId();44
params.SessionUrl = ServerInfo.getServerUrl();45
params.RetainInputHeaderFooter = true;46
params.CumulativePageNumber = true;47
           48
ID docId = Apttus.MergeWebService.createWordPackage(params);49
           50
System.debug('Merged Doc ID=' + docId);51
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Integration Details
Use the following information in your integrations with Apttus Contract Management Web 
Services API. For information on how to get started, refer to Integrating Conga CLM with 
External Systems.

API Prerequisites
None.

Request/Response XML

Example Request

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:mer=" 

http://soap.sforce.com/schemas/class/Apttus/MergeWebService" xmlns:cus="http:// 

soap.sforce.com/schemas/class/Apttus/CustomClass">

   <soapenv:Header>

      <mer:SessionHeader>

         <mer:sessionId>00D0S0000000Pa8! 

ARUAQJ53E09loYXezDoz9WVOJugDkLwI58ibwr3Iefz8bY7_HNQ5j3jV302ejFtvD2n1wEI_VL_78sOCL76iV 

Z5ywpCZaAJs</mer:sessionId>

      </mer:SessionHeader>

   </soapenv:Header>

   <soapenv:Body>

      <mer:createWordPackage>

         <mer:params>

            <cus:AddAutoHeaderFooter>True</cus:AddAutoHeaderFooter>

            <cus:AddFooter>False</cus:AddFooter>

            <cus:AddHeader>False</cus:AddHeader>

            <cus:AddWatermark>False</cus:AddWatermark>

            <cus:Attachments>

               <cus:RecordId>0690S000000SxbRQAS</cus:RecordId>

               <cus:Title>Test_DemoTemplate-KK_2020-07-17_1.0.0.doc</cus:Title>

            </cus:Attachments>

            <cus:Attachments>

               <cus:RecordId>0690S000000SxYhQAK</cus:RecordId>

               <cus:Title>Test_00AJ_Template with Clause_2020-07-17_1.0.0.doc</cus:Ti 

tle>

            </cus:Attachments>

            <cus:CumulativePageNumber>True</cus:CumulativePageNumber>
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            <cus:DocFileName>Package.docx</cus:DocFileName>

            <cus:FooterText>Copyright 2020</cus:FooterText>

            <cus:HeaderText>Apttus</cus:HeaderText>

            <cus:ParentId>a070S000002bVP7QAM</cus:ParentId>

            <cus:PreserveRedlines>False</cus:PreserveRedlines>

            <cus:ProtectionLevel>Full Access</cus:ProtectionLevel>

            <cus:ProtectOutputDoc>True</cus:ProtectOutputDoc>

            <cus:RemoveWatermark>False</cus:RemoveWatermark>

            <cus:RetainInputHeaderFooter>True</cus:RetainInputHeaderFooter>

            <cus:SessionId>00D0S0000000Pa8! 

ARUAQJ53E09loYXezDoz9WVOJugDkLwI58ibwr3Iefz8bY7_HNQ5j3jV302ejFtvD2n1wEI_VL_78sOCL76iV 

Z5ywpCZaAJs</cus:SessionId>

            <cus:SessionUrl>https://testmanagedclm--tbox.my.salesforce.com/services/ 

Soap/u/50.0/00D0S0000000Pa8</cus:SessionUrl>

         </mer:params>

      </mer:createWordPackage>

   </soapenv:Body>

</soapenv:Envelope>

Example Response

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns="ht 

tp://soap.sforce.com/schemas/class/Apttus/MergeWebService">

   <soapenv:Body>

      <createWordPackageResponse>

         <result>0690S000000T1GIQA0</result>

      </createWordPackageResponse>

   </soapenv:Body>

</soapenv:Envelope>

Merging Documents
This API allows you to merge multiple documents into a single document. The supported file 
types are DOC, DOCX, XLS, XLSX, PPT, PPTX, and PDF.
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API Signature

mergeDocuments webService static Id 
mergeDocuments(Apttus.CustomClass.ActionParams 
params)

Request Parameters

Name Type Description Requir 
ed?

ParentId ID The ID of the parent object associated with the 
result.

Yes

sObjectId ID The ID of the standard object Yes

Attachment 
s

List<Apttus.Custom 
Class.AttachmentInf 
o>

List of all documents in the order to be merged. Yes

ExternalLink 
s

List<Apttus.Custom 
Class.ExternalLink>

List of external links to be embedded in the 
document. 

Option 
al

DocFileNam 
e

String Name of the packaged document file (.doc 
or .docx).

Yes

ProtectionL 
evel

String Protection level of the document generated. Yes

AddWaterm 
ark

Boolean Indicates whether to add a watermark to the 
document.

Yes

RemoveWat 
ermark

Boolean Indicates whether to remove a watermark from the 
document.

Yes
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Request Parameters

Name Type Description Requir 
ed?

AddAutoHe 
aderFooter

Boolean Indicates whether to use the configured header 
and footer format located in Comply System 
Properties.

If AddAutoHeaderFooter=true, the API uses 
the Comply System Properties defined for 
header and footer data.
If AddAutoHeaderFooter=false, the API uses 
values from 
the headerText and footerText parameters.

Yes

HeaderText String Text to include in the document header. Yes

FooterText String Text to include in the document footer. Yes

PreserveRed 
lines

Boolean Indicates whether the redlines in the input 
document will be preserved/ accepted in the 
packaged document. The default value is false.

Yes

SessionId ID The Salesforce Session ID. Yes

SessionUrl String The Salesforce Server URL. Yes

RetainInput 
HeaderFoot 
er

Boolean Indicates whether the merged document retains 
the existing header and footer of the original 
documents and page numbers are cumulative.

Option 
al

Cumulative 
PageNumbe 
r

Boolean Indicates whether the merged document page 
numbers are cumulative.

Option 
al

Response Parameter

Name Type Description

docId ID The id of the generated PDF document.
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Code Sample

Integration Details
Use the following information in your integrations with Apttus Contract Management Web 
Services API. For information on how to get started, refer to Integrating Conga CLM with 
External Systems.

API Prerequisites
None.

{"SessionId":"00D0b000000DwSP! 

AQcAQOVWzYqVxU8jtOXxaQJe43sDdhLe4fsuRXsVri9ztEp8huD1u8ugJ3XI02CwbVssgtPdwm 

A4cQWuRnvJHJAFjWJZYZiX",

1

"SessionUrl":"https://yogi-dev2-dev-ed--c.na57.visual.force.com/services/ 

Soap/u/50.0/00D0b000000DwSP",

2

"ParentId":"a010b00000k3f69AAA",3
"sObjectId":"a010b00000k3f69AAA",4
"Attachments":[{"RecordId":"0690b00000CBrXVAA1",5
"Title":"test333.docx",6
"docType":"application/vnd.openxmlformats- 

officedocument.wordprocessingml.document"},

7

{"RecordId":"0690b00000CBrXBAA1",8
"Title":"test345.docx",9
"docType":"application/vnd.openxmlformats- 

officedocument.wordprocessingml.document"}],

10

"ExternalLinks":[],11
"DocFileName":"MergedDocument",12
"AddWatermark":true,13
"RemoveWatermark":false,14
"AddAutoHeaderFooter":false,15
"HeaderText":"Apttus",16
"FooterText":"2020 Copyright",17
"PreserveRedlines":true,18
"RetainInputHeaderFooter":false,19
"CumulativePageNumber":false}"20
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Request/Response XML

Example Request

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:mer=" 

http://soap.sforce.com/schemas/class/Apttus/MergeWebService" xmlns:cus="http:// 

soap.sforce.com/schemas/class/Apttus/CustomClass">

   <soapenv:Header>

      <mer:SessionHeader>

         <mer:sessionId>00D0S0000000Pa8! 

ARUAQGAA1VTGcAG1zxylmAb1RJmiUnspuO5dzL53Xsx3jVhYI3oWTqB2dqzdBeswmwj_I49aI6BgIM4veO1At 

3rLd9z6BjXv</mer:sessionId>

      </mer:SessionHeader>

   </soapenv:Header>

   <soapenv:Body>

      <mer:mergeDocuments>

         <mer:Params>

            <cus:AddAutoHeaderFooter>False</cus:AddAutoHeaderFooter>

            <cus:AddFooter>True</cus:AddFooter>

            <cus:AddHeader>True</cus:AddHeader>

            <cus:AddWatermark>True</cus:AddWatermark>

           <cus:Attachments>

               <cus:RecordId>0690S000000SxbRQAS</cus:RecordId>

               <cus:Title>Test_DemoTemplate-KK_2020-07-17_1.0.0.doc</cus:Title>

            </cus:Attachments>

            <cus:Attachments>

               <cus:RecordId>0690S000000SxYhQAK</cus:RecordId>

               <cus:Title>Test_00AJ_Template with Clause_2020-07-17_1.0.0.doc</cus:Ti 

tle>

            </cus:Attachments>

            <cus:DocFileName>Merged.PDF</cus:DocFileName>

            <cus:DocIds>0690S000000SvnkQAC</cus:DocIds>

            <cus:DocIds>0690S000000SvwIQAS</cus:DocIds>

            <cus:FooterAlignment>Center</cus:FooterAlignment>

            <cus:FooterFont>Tahoma</cus:FooterFont>

            <cus:FooterFontSize>8</cus:FooterFontSize>

            <cus:FooterMode>Overwrite</cus:FooterMode>

            <cus:FooterText>Copyright 2020</cus:FooterText>

            <cus:HeaderAlignment>Center</cus:HeaderAlignment>

            <cus:HeaderFont>Tahoma</cus:HeaderFont>
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            <cus:HeaderFontSize>8</cus:HeaderFontSize>

            <cus:HeaderMode>Overwrite</cus:HeaderMode>

            <cus:HeaderText>Apttus</cus:HeaderText>

            <cus:ParentId>a070S000002bSFzQAM</cus:ParentId>

            <cus:PreserveRedlines>False</cus:PreserveRedlines>

            <cus:ProtectionLevel>Full Access</cus:ProtectionLevel>

            <cus:ProtectOutputDoc>True</cus:ProtectOutputDoc>

            <cus:RemoveWatermark>False</cus:RemoveWatermark>

            <cus:RetainInputHeaderFooter>False</cus:RetainInputHeaderFooter>

            <cus:SessionId>00D0S0000000Pa8! 

ARUAQGAA1VTGcAG1zxylmAb1RJmiUnspuO5dzL53Xsx3jVhYI3oWTqB2dqzdBeswmwj_I49aI6BgIM4veO1At 

3rLd9z6BjXv</cus:SessionId>

            <cus:SessionUrl>https://testmanagedclm--tbox.my.salesforce.com/services/ 

Soap/u/50.0/00D0S0000000Pa8</cus:SessionUrl>

            <cus:SObjectId>a070S000002bSFzQAM</cus:SObjectId>

         </mer:Params>

      </mer:mergeDocuments>

   </soapenv:Body>

</soapenv:Envelope>

Example Response

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns="ht 

tp://soap.sforce.com/schemas/class/Apttus/MergeWebService">

   <soapenv:Body>

      <mergeDocumentsResponse>

         <result>0690S000000RvzCWRS</result>

      </mergeDocumentsResponse>

   </soapenv:Body>

</soapenv:Envelope>

Regenerate Documents with Redlines
This API allows you to regenerate agreement documents with redlines.

API Signature

regenerateDocWithRedlines webService static Id 
regenerateDocWithRedlines(Apttus.CustomClass.DocGe 
nParam params)
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•

•
•

•
•
•
•

Request Parameters

Name Type Description Required?

templateId ID The ID of the template Yes

versionDetailId ID The Id of the document version     Yes

pLevel String The protection level to apply to the 
document. Valid values are:

Full access
Insert comments only
Insert comments and tracked 
changes only
Read only
Fill in form fields only

Yes

docFormat String Indicates whether the document will 
be:

DOC
DOCX
PDF
RTF

Yes

isDraft Boolean Indicates whether a draft watermark 
should be added to the document.

Yes

SObjectId ID The Id of the object which holds data 
for merge fields.

 

sourceDocumentId ID The Id of the document to 
regenerate. The document is used to 
compare for redlines.

Yes

sessionid String The Salesforce session ID. Yes

sessionUrl String The Salesforce server Url. Yes
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Response Parameter

Name Type Description

result Boolean Indicates whether the document was regenerated 
successfully.

Code Sample

ID templateId = 'a090x00000oiMeoAAE';

ID agreementId = 'a070x000007Fed0AAC';

ID versionDetailId = 'a0h0x000003HYXUAA4';

String pLevel = '0';

String docFormat = 'DOCX';

Boolean isDraft = false;

ID sourceDocumentId = '0690x0000021Hy4AAE';

CustomClass.DocGenParam docGenParam = New CustomClass.DocGenParam(templateId, 

versionDetailId, pLevel, docFormat, isDraft, SObjectId, sourceDocumentId, sessionid, 

sessionUrl);

Integration Details
Use the following information in your integrations with Apttus Contract Management Web 
Services API. For information on how to get started, refer to Integrating Conga CLM with 
External Systems.

API Prerequisites
None.

Request/Response XML

Example Request

<soapenv:Envelope

    xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/"

    xmlns:mer="http://soap.sforce.com/schemas/class/Apttus/MergeWebService"

    xmlns:cus="http://soap.sforce.com/schemas/class/Apttus/CustomClass">

    <soapenv:Header>

                <mer:SessionHeader>

https://documentation.conga.com/display/CLMSPR21/Integrating+Conga+CLM+with+External+Systems
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            <mer:sessionId>?</mer:sessionId>

        </mer:SessionHeader>

    </soapenv:Header>

    <soapenv:Body>

        <mer:regenerateDocWithRedlines>

            <mer:params>

                <cus:AcceptRedlines>False</cus:AcceptRedlines>

                <cus:DocFormat>PDF</cus:DocFormat>

                <cus:IsDraft>True</cus:IsDraft>

                <cus:ProtectionLevel>Full Access</cus:ProtectionLevel>

                <cus:ReviewerName>Conga</cus:ReviewerName>

                <cus:SessionId>00D0S0000000Pa8! 

ARUAQMLgPIx6FwqD3DCEs9oBPnTI2Gx9k0jH5wIL7WLW1sR1vNq1dI7oAxxG4EKbk5XBzRZlP5TQivHyO5biv 

we.toaF9MrQ</cus:SessionId>

                <cus:SessionUrl>https://testmanaged--5s20minor.my.salesforce.com/ 

services/Soap/u/50.0/00D020000008lUh</cus:SessionUrl>

                <cus:SObjectId>0015500000YAdXR</cus:SObjectId>

                <cus:SourceDocumentId>a07020000008w91</cus:SourceDocumentId>

                <cus:TemplateId>a09R000000AjMCy</cus:TemplateId>

                <cus:VersionDetailId>a6v0S0000009DEY</cus:VersionDetailId>

            </mer:params>

        </mer:regenerateDocWithRedlines>

    </soapenv:Body>

</soapenv:Envelope>

Example Response

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns="ht 

tp://soap.sforce.com/schemas/class/Apttus/AuthorWebService">

   <soapenv:Body>

      <regenerateDocWithRedlines>

         <result>true</result>

      </regenerateDocWithRedlines>

   </soapenv:Body>

</soapenv:Envelope>

Author Web Service
The Author Web Service API contains all the services related to files or documents and can 
be used with various operations related to X-Author.
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•
•

You can invoke APIs in Author Web Service using the following command:

Apttus.AuthorWebService.<Name of the Function> 
where the name of the function is API Name and its parameters.

You can use the Author web service APIs to complete the following tasks:

Initiating Parallel Review
Ending Parallel Review
Getting Word Document Information for Parent with Files
Subscribing to Document Lock Release Notification

Initiating Parallel Review
This initiates the parallel review for a document that is part of an Agreement. The 
document must be part of the agreement document version object and document versioning 
must be enabled.

API Signature

initiateParallelReview webService static void initiateParallelReview(Id 
attachmentId, Id agreementId, Id documentVersionDetailId, 
String emailSubject, String emailBody, List reviewersInfo)

Request Parameters

Name Type Description Required?

attachmentId ID Id of the document that is to be 
reviewed.

Yes

agreementId ID Id of the agreement. Yes

documentVersionDetailId ID Id of the document version. Yes

emailSubject String Subject of the review email. Yes

emailBody String Body of the review email. Yes

List<ReviewerWrapper> 
reviewersInfo

List List of reviewers. Yes



CLM

924 Copyright ©2022 Apttus Corporation. All rights reserved.
 

Code Sample

Id attachmentId = '0691l000001qT6kAAE'; //attachment or fileId to sent for review

Id agreementId = 'a0G1l000004ENBsEAO'; //agreementId

Id documentVersionDetailId = 'a0m1l000007aCKGAA2'; 

List<Apttus.ReviewerWrapper> reviewersList = new List<Apttus.ReviewerWrapper>();

List<Apttus.ReviewerWrapper.ContentControls> contentControls = null;    

Apttus.ReviewerWrapper reviewerWrapper = new Apttus.ReviewerWrapper('0051l000006MJuvA 

AG', 'recipientname', 'uthakkar@conga.com', contentControls);

reviewersList.add(reviewerWrapper);

Apttus.AuthorWebService.initiateParallelReview(attachmentId, agreementId, 

documentVersionDetailId, 'Email Subject', 'Email Body in HTML', reviewersList);

Integration Details
Use the following information in your integrations with Apttus Contract Management Web 
Services API. For information on how to get started, refer to Integrating Conga CLM with 
External Systems.

API Prerequisites
None.

Request/Response XML

Example Request

<?xml version="1.0" encoding="UTF-8"?>

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:aut=" 

http://soap.sforce.com/schemas/class/Apttus/AuthorWebService" xmlns:rev="http:// 

soap.sforce.com/schemas/class/Apttus/ReviewerWrapper">

   <soapenv:Header>

      <aut:SessionHeader>

         <aut:sessionId>00D0S0000000Pa8! 

ARUAQMLgPIx6FwqD3DCEs9oBPnTI2Gx9k0jH5wIL7WLW1sR1vNq1dI7oAxxG4EKbk5XBzRZlP5TQivHyO5biv 

we.toaF9MrQ</aut:sessionId>

      </aut:SessionHeader>

   </soapenv:Header>

   <soapenv:Body>
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      <aut:initiateParallelReview>

         <aut:attachmentId>00P0S000002S0kY</aut:attachmentId>

         <aut:agreementId>a070S000002bSKV</aut:agreementId>

         <aut:documentVersionDetailId>a1y0S000000K2aN</aut:documentVersionDetailId>

         <aut:emailSubject>Request for review</aut:emailSubject>

         <aut:emailBody>Please review and approve the attached document.</aut:emailBo 

dy>

         <aut:reviewersInfo>

            <rev:reviewerEmail>abc@test.com</rev:reviewerEmail>

            <rev:reviewerName>abc</rev:reviewerName>

         </aut:reviewersInfo>

         <aut:reviewersInfo>

            <rev:reviewerEmail>xyz@test.com</rev:reviewerEmail>

            <rev:reviewerName>xyz</rev:reviewerName>

         </aut:reviewersInfo>

      </aut:initiateParallelReview>

   </soapenv:Body>

</soapenv:Envelope>

Example Response

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns="ht 

tp://soap.sforce.com/schemas/class/Apttus/AuthorWebService">

   <soapenv:Body>

      <initiateParallelReviewResponse/>

   </soapenv:Body>

</soapenv:Envelope>

Ending Parallel Review
This ends the parallel review for a document belonging to a particular review cycle.

API Signature

endParallelReview webService static void endParallelReview(Id reviewCycleId, 
String emailId, Id documentVersionDetailId, String comment)
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Request Parameters

Name Type Description Required?

reviewCycleId ID Id of the review cycle. Yes

emailId String Email Id of the reviewer. Yes

documentVersionDetailId ID Id of the document version. Yes

comment String Reviewer comment. Optional

Code Sample

ID reviewCycleId = 'a2a4N000000X86gQAC';

String emailId = 'recipientemail@email.com';

ID documentVersionDetailId = 'a1y0S000000TsvxQAC' ;

String comment = 'Review done Please incorporate changes ';

emailId

documentVersionDetailId

documentVersionDetailId );

AuthorWebService.endParallelReview(reviewCycleId ,

Integration Details
Use the following information in your integrations with Apttus Contract Management Web 
Services API. For information on how to get started, refer to Integrating Conga CLM with 
External Systems.

API Prerequisites
None.

Request/Response XML

Example Request

<?xml version="1.0" encoding="UTF-8"?>
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<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:aut=" 

http://soap.sforce.com/schemas/class/Apttus/AuthorWebService">

   <soapenv:Header>

      <aut:SessionHeader>

         <aut:sessionId>00D0S0000000Pa8! 

ARUAQMLgPIx6FwqD3DCEs9oBPnTI2Gx9k0jH5wIL7WLW1sR1vNq1dI7oAxxG4EKbk5XBzRZlP5TQivHyO5biv 

we.toaF9MrQ</aut:sessionId>

      </aut:SessionHeader>

   </soapenv:Header>

   <soapenv:Body>

      <aut:endParallelReview>

         <aut:reviewCycleId>a6v0S0000009DEY</aut:reviewCycleId>

         <aut:emailId>msuthrave@apttus.com</aut:emailId>

         <aut:documentVersionDetailId>a1y0S000000K2bB</aut:documentVersionDetailId>

         <aut:comment>End review</aut:comment>

      </aut:endParallelReview>

   </soapenv:Body>

</soapenv:Envelope>

Example Response

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns="ht 

tp://soap.sforce.com/schemas/class/Apttus/AuthorWebService">

   <soapenv:Body>

      <endParallelReviewResponse/>

   </soapenv:Body>

</soapenv:Envelope>

Getting Word Document Information for Parent with 
Files
This method returns the list of word documents of type files, based on parent id passed in 
parameter.

API Signature

getWordDocumentInfosForParentWithFiles webService static List 
getWordDocumentInfosForParentWithFiles(Id 
parentId)
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Parameters

Name Type Description

parentId ID The id of the parent agreement.

 

Response

Name Type Description

List ContentDocumentLink Returns the list of content document link.

 

 

Code Sample 

Integration Details
Use the following information in your integrations with Apttus Contract Management Web 
Services API. For information on how to get started, refer to Integrating Conga CLM with 
External Systems.

API Prerequisites
None.

ID agreementId = 'a0Y61000002K6IR';1
List<ContentDocumentLink> lstContentDocumentLink = 

Apttus.AuthorWebService.getWordDocumentInfosForParentWithFiles(agreementId 

);

2
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Request/Response XML

Example Request

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:aut=" 

http://soap.sforce.com/schemas/class/Apttus/AuthorWebService">

   <soapenv:Header>

      <aut:SessionHeader>

         <aut:sessionId>00D0S0000000Pa8! 

ARUAQGAA1VTGcAG1zxylmAb1RJmiUnspuO5dzL53Xsx3jVhYI3oWTqB2dqzdBeswmwj_I49aI6BgIM4veO1At 

3rLd9z6BjXv</aut:sessionId>

      </aut:SessionHeader>

   </soapenv:Header>

   <soapenv:Body>

      <aut:getWordDocumentInfosForParentWithFiles>

         <aut:parentId>a070S000002bUEyQAM</aut:parentId>

      </aut:getWordDocumentInfosForParentWithFiles>

   </soapenv:Body>

</soapenv:Envelope>

Example Response

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns="ht 

tp://soap.sforce.com/schemas/class/Apttus/AuthorWebService" xmlns:xsi="http:// 

www.w3.org/2001/XMLSchema-instance">

   <soapenv:Body>

      <getWordDocumentInfosForParentWithFilesResponse>

            <result xsi:type="ContentDocumentLink">

            <Id>06A0S000000lhTHUAY</Id>

            <ContentDocument xsi:type="ContentDocument">

               <Id>0690S000000SviVQAS</Id>

               <CreatedById>0050S000001GAHMQA4</CreatedById>

               <FileExtension>doc</FileExtension>

               <FileType>WORD</FileType>

               <LastModifiedById>0050S000001GAHMQA4</LastModifiedById>

               <LastModifiedDate>2020-07-16T09:56:19.000Z</LastModifiedDate>

               <LatestPublishedVersion xsi:type="ContentVersion">

                  <Id>0680S000000SzTGQA0</Id>

                  <ContentSize>73929</ContentSize>

               </LatestPublishedVersion>
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               <LatestPublishedVersionId>0680S000000SzTGQA0</LatestPublishedVersionId>

               <OwnerId>0050S000001GAHMQA4</OwnerId>

               <SystemModstamp>2020-07-16T09:56:37.000Z</SystemModstamp>

               <Title>Corporate-Original_Template with 2 Smart Clauses</Title>

            </ContentDocument>

            <ContentDocumentId>0690S000000SviVQAS</ContentDocumentId>

            <LinkedEntityId>a070S000002bUEyQAM</LinkedEntityId>

         </result>

         <result xsi:type="ContentDocumentLink">

            <Id>06A0S000000lhTJUAY</Id>

            <ContentDocument xsi:type="ContentDocument">

               <Id>0690S000000SviWQAS</Id>

               <CreatedById>0050S000001GAHMQA4</CreatedById>

               <FileExtension>doc</FileExtension>

               <FileType>WORD</FileType>

               <LastModifiedById>0050S000001GAHMQA4</LastModifiedById>

               <LastModifiedDate>2020-07-16T09:56:21.000Z</LastModifiedDate>

               <LatestPublishedVersion xsi:type="ContentVersion">

                  <Id>0680S000000SzTHQA0</Id>

                  <ContentSize>14391</ContentSize>

               </LatestPublishedVersion>

               <LatestPublishedVersionId>0680S000000SzTHQA0</LatestPublishedVersionId>

               <OwnerId>0050S000001GAHMQA4</OwnerId>

               <SystemModstamp>2020-07-16T09:56:38.000Z</SystemModstamp>

               <Title>Corporate-NR_Test_001_Regenerated_ct_2.0_2020-01-27</Title>

            </ContentDocument>

            <ContentDocumentId>0690S000000SviWQAS</ContentDocumentId>

            <LinkedEntityId>a070S000002bUEyQAM</LinkedEntityId>

         </result>

         <result xsi:type="ContentDocumentLink">

            <Id>06A0S000000lhTMUAY</Id>

            <ContentDocument xsi:type="ContentDocument">

               <Id>0690S000000SviaQAC</Id>

               <CreatedById>0050S000001GAHMQA4</CreatedById>

               <FileExtension>docx</FileExtension>

               <FileType>WORD_X</FileType>

               <LastModifiedById>0050S000001GAHMQA4</LastModifiedById>

               <LastModifiedDate>2020-07-16T09:56:20.000Z</LastModifiedDate>

               <LatestPublishedVersion xsi:type="ContentVersion">

                  <Id>0680S000000SzTLQA0</Id>

                  <ContentSize>39544</ContentSize>

               </LatestPublishedVersion>

               <LatestPublishedVersionId>0680S000000SzTLQA0</LatestPublishedVersionId>
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               <OwnerId>0050S000001GAHMQA4</OwnerId>

               <SystemModstamp>2020-07-16T09:56:30.000Z</SystemModstamp>

               <Title>RS 11 Mar 02_Redlines_Web OL Font Template_2020-03-11</Title>

            </ContentDocument>

            <ContentDocumentId>0690S000000SviaQAC</ContentDocumentId>

            <LinkedEntityId>a070S000002bUEyQAM</LinkedEntityId>

         </result>

      </getWordDocumentInfosForParentWithFilesResponse>

   </soapenv:Body>

</soapenv:Envelope>

Subscribing to Document Lock Release Notification
This API allows you to subscribe to document lock release notification during online 
contract collaboration. 

 

API Signature

subscribeToDocumentLock webService static Boolean subscribeToDocumentLock(Id 
documentVersionId, Id agreementId, Id userId)

Request Parameters

Name Type Description Required?

documentversionId ID Id of the document version Yes

agreementId ID Id of the document Yes

userID ID User ID of the subscriber Yes

Response Parameter

Name Type Description

result Boolean Indicates whether the subscription to document lock 
release notification was successful.
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Code Sample

id documentversionId ='a6v0S0000009DEY';

id agreementId = 'a07020000008w9BAAQ';

id CurrentUserID = getCurrentUser().Id;

Apttus.AuthorWebservice.subscribeToDocumentLock(documentversionId, agreementId, 

CurrentUserID);

Integration Details
Use the following information in your integrations with Apttus Contract Management Web 
Services API. For information on how to get started, refer to Integrating Conga CLM with 
External Systems.

API Prerequisites
None.

Request/Response XML

Example Request

<?xml version="1.0" encoding="UTF-8"?>

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:aut=" 

http://soap.sforce.com/schemas/class/Apttus/AuthorWebService">

   <soapenv:Header>

      <aut:SessionHeader>

         <aut:sessionId>00D0S0000000Pa8! 

ARUAQMLgPIx6FwqD3DCEs9oBPnTI2Gx9k0jH5wIL7WLW1sR1vNq1dI7oAxxG4EKbk5XBzRZlP5TQivHyO5biv 

we.toaF9MrQ</aut:sessionId>

      </aut:SessionHeader>

   </soapenv:Header>

   <soapenv:Body>

      <aut:subscribeToDocumentLock>

         <aut:documentversionId>a6v0S0000009DEY</aut:reviewCycleId>

         <aut:agreementId>a07020000008w9BAAQ</aut:emailId>

         <aut:CurrentUserID>0050S000002KSZwQAO</aut:documentVersionDetailId>

      </aut:subscribeToDocumentLock>

   </soapenv:Body>
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</soapenv:Envelope>

Example Response

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns="ht 

tp://soap.sforce.com/schemas/class/Apttus/AuthorWebService">

   <soapenv:Body>

      <subscribeToDocumentLockResponse>

         <result>true</result>

      </subscribeToDocumentLockResponse>

   </soapenv:Body>

</soapenv:Envelope>

Callback Classes
Apttus Contract Management allows you to create and register custom code in the form of 
callback class for the following operations:

IAgreementLifecycleCallback2 and IDynamicSectionCallback2

IAgreementLifecycleCallback2 and 
IDynamicSectionCallback2
Contract Management on salesforce provides the following callback interfaces:

IAgreementLifecycleCallback2
The administrator can use this callback class to handle the Agreement lifecycle specific 
actions like afterCreate , afterClone, afterTerminate, afterAmend, and so on.

IDynamicSectionCallback2
The administrator can use this callback class to handle the dynamic section when an 
agreement document is generated.
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1.
2.
3.
4.
5.
6.

To enable the callback interface 
for IAgreementLifecycleCallback2

Write a class implementing the Interface. 
Overwrite the methods and write what you want to add in a specific action method.
Go to Setup > Custom Settings > Comply Custom Classes.
Create a New Entry.
Execute actual Action and check the log.
Create Apex Class implementing the Callback Interface.

Callback Methods Invoked

S.No Callback Method When is the callback method invoked

01 afterActivate After Agreement is Activated

02 afterAmend After Agreement is amended

03 afterCancel After Agreement is canceled

04 afterClone After Agreement is Cloned

05 afterComplete Called After Every Action (ActionType is Sent 
as Parameter to the method)

06 afterCreate After New Agreement is created

07 afterCreateChild After New Child Agreement is Created  

08 afterCreateExecuted After create of Store Executed Agreement

09 afterCreateFromOpportunity After New Agreement is created for 
Opportunity

10 afterCreateOffline After offline Agreement is created

11 afterExpire After Agreement is expired

12 afterRenew After Agreement is Renewed
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S.No Callback Method When is the callback method invoked

13 afterTerminate After Agreement is Terminated

IAgreementLifecycleCallback2

global class APTS_CustomAgreementLifecycleCallback implements 

 CustomClass.IAgreementLifecycleCallback2 {

 
    global void afterActivate(APTS_Agreement__c originalSO, 

CustomClass.ActivationType activationType){

        logMessage('Action after Activate' , 'After Activate');

    }

                

    global void afterAmend(APTS_Agreement__c originalSO, APTS_Agreement__c 

amendmentSO){

        logMessage('Action after Amend' , 'After Amend');

    }

    global void afterCancel(APTS_Agreement__c agreementSO){

        logMessage('Action after Cancel' , 'After Cancel');

    }

    global void afterClone(APTS_Agreement__c originalSO, APTS_Agreement__c cloneSO){

        logMessage('Action after Clone' , 'After Clone');

    }

    global void afterComplete(APTS_Agreement__c agreementSO, CustomClass.ActionType 

actionType){

       logMessage('Action after Complete' , ''+actionType);

    }

    global void afterCreate(APTS_Agreement__c agreementSO){

        logMessage('Action after Create' , 'After Create');

    }

    global void afterCreateChild(APTS_Agreement__c parentSO, APTS_Agreement__c 

childSO){

         logMessage('Action after Create Child ' , 'After Create '+childSo);

    }

    global void afterCreateExecuted(APTS_Agreement__c agreementSO){

        logMessage('Action after Executed' , 'After Execute '+agreementSO);

    }

    global void afterCreateFromOpportunity(APTS_Agreement__c agreementSO){

        logMessage('Action after Create agreement from Opp' , 'After Create');

    }

    global void afterCreateOffline(APTS_Agreement__c agreementSO){ 



CLM

936 Copyright ©2022 Apttus Corporation. All rights reserved.
 

•

1.
2.
3.

4.
5.

            logMessage('Action after Create offline' , 'After Create');

    }

    global void afterExpire(APTS_Agreement__c agreementSO){ 

            logMessage('Action after Expire' , 'After Expire');

    } 

    global void afterRenew(APTS_Agreement__c originalSO, APTS_Agreement__c renewalSO) 

{

             logMessage('Action after Renew' , 'After Renew');

   

    }

    global void afterTerminate(APTS_Agreement__c agreementSO){ 

            logMessage('Action after Terminate' , 'After Terminate');

    }

    

    private void logMessage(String message , String action){

        System.debug('[LifecycleCallback ('+action+')] :'+message);

    }

}

Scenarios
This section covers the following scenarios:

Making an Agreement Effective

Making an Agreement Effective
After an agreement is finalized and signed between the engaged parties, you can activate 
the agreement to bring it into effect. 

To make an agreement effective
Generate an agreement document using Generating a Document.
Send the generated document for parallel review using Initiating Parallel Review.
After all the reviewers have reviewed the document, end the review using Ending 
Parallel Review.
Send the reviewed document for signatures using Sending a Document for Signatures.
After the document is signed, activate the document to make it effective using 
Activating Agreements.
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Troubleshooting
Refer to this topic for descriptions of API error messages thrown by Salesforce and 
suggested actions to take. An exception is an error caused during code execution. There are 
a number of built-in Apex exceptions as well as custom exceptions provided by Conga.

The following exceptions thrown by Salesforce that can be handled by Conga and 
converted to custom error messages:

System.Exception: Exception thrown under most circumstances.
System.CalloutException: Exception thrown when communicating with external 
systems.
DMLException: Exception thrown when performing CRUD ('Create', 'Read', 'Update', 
'Delete') actions.

Refer to the following table for a list of custom error messages provided by Conga for some 
SOAP APIs, included suggested actions to take to resolve the exception.

API Error Message Suggested Action

Apttus_Proposal.MergeWe 
bService.convertWordDocT 
oPDF

Invalid attachment docId. Ensure that you have provided 
the correct docId of the 
attachment. 

Apttus_Proposal.MergeWe 
bService.mergeDocsToPDF

Invalid Merge Webservice 
Endpoint.

Ensure that you have provided 
the correct endpoint in 
the Merge Webservice Endpoint 
comply system property.

Apttus.AgreementWebServ 
ice.activateAgreement

No attachment(s) selected for 
activation. 

Ensure that you have provided 
the correct docId of the 
attachment.

You do not have the level of 
access necessary to perform the 
operation you requested. Please 
contact the owner of the record or 
your administrator if access is 
necessary.

Authentication or access 
(system permissions) issue. 
Contact an administrator or 
check the appropriate topic for 
authentication instructions.
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API Error Message Suggested Action

No document or attachment 
found. This agreement must have 
a document or attachment to 
continue

Ensure that you have provided 
the correct docId of the 
attachment.

Invalid attachment {0} Ensure that you have provided 
the correct docId of the 
attachment.

Apttus.AgreementWebServ 
ice.publishToExternalRepo 
sitory

External repository is not enabled. Authentication or access 
(system permissions) issue. 
Contact an administrator or 
check the appropriate topic for 
authentication instructions.

Apttus.AgreementWebServ 
ice.publishToChatterRepos 
itory

Chatter repository is not enabled. Authentication or access 
(system permissions) issue. 
Contact an administrator or 
check the appropriate topic for 
authentication instructions.

Apttus.AgreementWebServ 
ice.publishToDocumentRep 
ository

Document repository is not 
enabled.

Authentication or access 
(system permissions) issue. 
Contact an administrator or 
check the appropriate topic for 
authentication instructions.

Apttus.AgreementWebServ 
ice.selectFirstTemplateIdF 
orAgreement

You do not have the level of 
access necessary to perform the 
operation you requested. Please 
contact the owner of the record or 
your administrator if access is 
necessary. ({0})

Authentication or access 
(system permissions) issue. 
Contact an administrator or 
check the appropriate topic for 
authentication instructions.

Apttus.MergeWebService.c 
onvertWordDoc

Invalid attachment {0} Ensure that you have provided 
the correct docId of the 
attachment.
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API Error Message Suggested Action

Apttus.MergeWebService.c 
onvertWordDocToPDF

Invalid attachment {0} Ensure that you have provided 
the correct docId of the 
attachment.

Apttus.MergeWebService.c 
onvertWordDocToPDF2

Invalid attachment {0} Ensure that you have provided 
the correct docId of the 
attachment.

Apttus.MergeWebService.g 
enerateCustomDoc

Insufficient Privileges. Authentication or access 
(system permissions) issue. 
Contact an administrator or 
check the appropriate topic for 
authentication instructions.

Apttus.MergeWebService.s 
ubmitGenerateCustomDoc

Insufficient Privileges. Authentication or access 
(system permissions) issue. 
Contact an administrator or 
check the appropriate topic for 
authentication instructions.

Apttus.AuthorWebService. 
getWordDocumentInfosFor 
ParentWithFiles

You do not have the level of 
access necessary to perform the 
operation you requested. Please 
contact the owner of the record or 
your administrator if access is 
necessary. 

Authentication or access 
(system permissions) issue. 
Contact an administrator or 
check the appropriate topic for 
authentication instructions.

Apttus.AgreementWebServ 
ice.sendForSignature

Maximum of 150 Recipients can be 
added.

Ensure that you do not add 
more than 150 email addresses 
of recipients.

Duplicate email address 
identified.

Review the email addresses you 
have entered and remove any 
duplicate email addresses.

Please specify at least one 
recipient.

Ensure that you have provided 
at least one valid email 
address of a recipient. 



CLM

940 Copyright ©2022 Apttus Corporation. All rights reserved.
 

•
•
•
•

API Error Message Suggested Action

Invalid email address found. 
Kindly verify and provide valid 
email address separated by ;

Ensure that you have provided 
valid email addresses of the 
recipients separated by a 
semicolon.

Missing Template ID: The send for 
signature email can't be triggered 
as the email template Id is 
missing.

Ensure that you have provided 
an email template Id. 

Missing Agreement ID: The send for 
signature email can't be triggered 
as the agreement Id is missing.

Ensure that you have provided 
an agreement Id. 

Missing Attachments: The send for 
signature email can't be triggered 
as there are no documents 
attached.

Ensure that at least one 
reviewed document is available 
in the agreement.

Apttus.AuthorWebService.s 
ubscribeToDocumentLock

You do not have the level of 
access necessary to perform the 
operation you requested. Please 
contact the owner of the record or 
your administrator if access is 
necessary. ({0})

Authentication or access 
(system permissions) issue. 
Contact an administrator or 
check the appropriate topic for 
authentication instructions.

Apttus.MergeWebService. 
mergeDocuments

Merge operation is only 
applicable for doc, docx and pdf 
file types.

Ensure that the documents you 
are trying to merge are in DOC, 
DOCX, or PDF format.

Selected documents cannot be 
merged as the combined file size 
of the documents exceeds 25 MB.

Ensure that the file size of the 
documents you are trying to 
merge is less than 25 MB.

The following are standard Salesforce exceptions that cannot be handled or changed:

LimitException
UnexpectedException
AssertException
NoAccessException
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NoDataFoundException
SerializationException
VisualforceException

You can learn more about these exceptions and recommended actions to take by 
consulting Salesforce documentation. For additional guidance, please refer to the article. 

https://developer.salesforce.com/docs/atlas.en-us.apexcode.meta/apexcode/apex_classes_exception_methods.htm
https://www.mstsolutions.com/technical/errors-in-salesforce/
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CLM for REST API Developers
This section describes the REST APIs provided by Conga CLM.

Topic Description

What's Covered This section walks an API user through the list of REST APIs 
provided by Conga.

Primary Audience API developers.

IT Environment Refer to the latest Conga CLMRelease Notes for information 
on System Requirements and Supported Platforms.

Updates For a comprehensive list of updates to this section for each 
release, see the What's New in CLM Documentation topic.

Before using Conga CLM, you must be familiar with the following:

Basic knowledge of Salesforce
Basic knowledge of REST APIs
Salesforce and Apttus terms and definitions

This section describes the following topics:

Authenticating Agreement Services APIs
Agreement REST API Services Version 1

Authenticating Agreement Services APIs

Basics
The Agreement Services API follows a microservice architecture that enables CLM into any 
part of an application and is built on the JSON API specification, follows 
predictable REST URLs and supports cross-origin resource sharing.

https://jsonapi.org/
https://en.wikipedia.org/wiki/Representational_state_transfer
https://en.wikipedia.org/wiki/Cross-origin_resource_sharing
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Endpoint
The Agreement Services API is installed with the CLM managed package and can be 
exposed to external applications via a Salesforce site or community. 

https://myorg.force.com/services/apexrest/Apttus/clm/:version/:API

Versions
The Agreement Services API ensures backward compatibility by properly versioning any 
changes to the APIs. Should changes to the API structure need to be made, it will occur 
within a new version and older functionality will be preserved.

Content Type
Requests made to the API must be encoded as JSON and contain the header

Content-Type: application/json

Includes
You can easily include resource relationships on most top-level resources. Multiple includes 
are defined using comma-delimited values.

Caching
Server side caching is used and can be configured per request using the cacheStrategy 
query parameter.

Errors
Any request that returns an error follows a standard format. The Agreement Services API 
will return an array of errors that contains objects containing the status, title, and data 
with the error details.

Code Response

201 Created Successfully
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Code Response

200 Updated Successfully

204 Deleted Successfully

400 Invalid JSON

422 Validation Error

500 Something went wrong on our end

Agreement REST API Services Version 1
(Open API documentation is only available to view online)
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CLM Features by Release
Review the latest CLM Features by Release document.

Features by Release

Features by Release
This document contains an overview of features introduced in each major release of CLM. 
For more information, see CLM Features by Release.

https://documentation.conga.com/features-by-release/clm-features-by-release-165937520.html
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Conga Customer Community & Learning 
Center Resources
The Conga Customer Community is your one-stop shop for success! 

After registering as a new member, you’ll gain access to a wide variety of resources, from a 
personalized onboarding checklist to free expert-led webinars, to our thought-leadership 
blog! It’s also your portal to manage your Conga account, access the Install Center, and 
submit support tickets. 

You can also access the Conga Learning Center. All customers get access to a limited 
catalog of getting started courses. Consider upgrading to the Conga Learning Pass to 
unlock the premium training subscription.

Ready to get started?
Log into the Conga Customer Community with your credentials.

Not yet registered? No problem. Set up an account to receive your login credentials via our 
registration page.

After you log in, there are 2 ways to access the Conga Learning Center:

On the main page, click the Learning Center tile.
Navigate to the “Resources” dropdown menu at the top, then click the “Learning 
Center” option.

https://community.conga.com/s/get-started
https://community.conga.com/s/webinars
https://community.conga.com/s/blog
https://community.conga.com/s/learning-center
https://community.conga.com/
http://community.conga.com/s/registration


CLM|02/15/2023

 

Conga Copyright Disclaimer
Copyright © 2023 Apttus Corporation (“Conga”) and/or its affiliates. All rights reserved.
No part of this document, or any information linked to or referenced herein, may be reproduced, distributed, or 
transmitted in any form or by any means, including photocopying, recording, or other electronic or 
mechanical methods, without the prior written consent of Conga. All information contained herein is subject 
to change without notice and is not warranted to be error free.
This document may describe certain features and functionality of software that Conga makes available for 
use under a license agreement containing restrictions on use and disclosure and are protected by intellectual 
property laws. Except as expressly permitted in your license agreement or allowed by law, you may not, in 
any form, or by any means, use, copy, reproduce, translate, broadcast, modify, license, transmit, distribute, 
exhibit, perform, publish, or display any part of the software. Reverse engineering, disassembly, decompilation 
of, or the creation of derivative work(s) from, the software is strictly prohibited. Additionally, this document 
may contain descriptions of software modules that are optional and for which you may not have purchased 
a license. As a result, your specific software solution and/or implementation may differ from those described 
in this document.
U.S. GOVERNMENT END USERS: Conga software, including any operating system(s), integrated software, any 
programs installed on the hardware, and/or documentation, delivered to U.S. Government end users are 
“commercial computer software” pursuant to the applicable Federal Acquisition Regulation and agency- 
specific supplemental regulations. As such, use, duplication, disclosure, modification, and adaptation of the 
programs, including any operating system, integrated software, any programs installed on the hardware, 
and/or documentation, shall be subject to license terms and license restrictions applicable to the programs. 
No other rights are granted to the U.S. Government.
Neither the software nor the documentation were developed or intended for use in any inherently dangerous 
applications, including applications that may create a risk of personal injury. If you use this software or 
hardware in dangerous applications, then you shall be responsible to take all appropriate fail-safe, backup, 
redundancy, and other measures to ensure its safe use. Conga and its affiliates disclaim any liability for any 
damages caused by use of this software or hardware in dangerous applications.
Apttus, AI Analyze, Conga, Conga AI, Conga AI Discover, Conga Batch, Conga Collaborate, Conga Composer, 
Conga Conductor, Conga Connect, Conga Courier, Conga Grid, Conga Mail Merge, Conga Merge, Conga 
Orchestrate, Conga Sign, Conga Trigger, Digital Document Transformation, True-Up, and X-Author are 
registered trademarks of Conga and/or its affiliates.
The documentation and/or software may provide links to web sites and access to content, products, and 
services from third parties. Conga is not responsible for the availability of, or any content provided by third 
parties. You bear all risks associated with the use of such content. If you choose to purchase any products or 
services from a third party, the relationship is directly between you and the third party. Conga is not 
responsible for: (a) the quality of third-party products or services; or (b) fulfilling any of the terms of the 
agreement with the third party, including delivery of products or services and warranty obligations related to 
purchased products or services. Conga is not responsible for any loss or damage of any sort that you may 
incur from dealing with any third party.
For additional resources and support, please visit https://community.conga.com.
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